
What’s New in FLOW-3D Version 10.0 

New Models and Features 
Fluid-structure interaction (FSI) model The model describes fully-coupled interaction between fluid and solid using an FE approach to model stresses and deformations in solid components in response to pressure forces from the surrounding fluid, thermal gradients, and specified constraints. Currently, the model is limited to small deformations. Resources: TN 90: Fluid-Structure Interaction and Thermal Stress Evolution Models in FLOW-3D How Do I Model Fluid-Structure Interaction & Thermal Stress Evolution? Development Focus: Fluid Structure Interaction 
Thermal stress evolution (TSE) model The model describes the evolution of stresses and deformations in solidified fluid region in response to temperature gradients. Stresses can be simultaneously computed in solid geometry components and in solidifying metal with simple options for the interaction between them. Resources: TN 90: Fluid-Structure Interaction and Thermal Stress Evolution Models in FLOW-3D How Do I Model Fluid-Structure Interaction & Thermal Stress Evolution? Development Focus: Fluid Structure Interaction 
Optional solid properties database An optional materials database contains temperature-dependent properties for a vast array of solid materials, complementing the FSI and TSE models. 
Solidification shrinkage models The Simple Solidification Shrinkage model (formerly Rapid Solidification Shrinkage model) has been extended to work with multi-block meshes. It can also be applied to tilt pour and centrifugal castings. The Dynamic Shrinkage model has been reinstated, thanks to improvements in its accuracy and convergence. 

http://www.flow3d.com/pdfs/tn/FloSci-TN90.pdf
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Iron solidification model The model describes eutectic and near-eutectic solidification of cast irons, coupled with the Simple Solidification Shrinkage model. The formation of austenite, graphite and carbide phases is also predicted. Resources: TN 89: Modeling Volume Changes and High Temperature Microstructure in Cast Iron 
Granular flow model (including sand core blowing) The model describes the behavior of granular media. In particular, it allows users to model the sand core shooting process. Resources: TN 88: A Continuum Model for High Concentration Granular Media: Illustrated by Application to Sand Core Blowing How Do I Model Granular Flow? Development Focus: A Continuum Model for High Concentration Granular Media 
Permeable mold model A new ‘Permeable Mold’ property of a geometry component, in combination with the adiabatic bubble model, allows users to include the escape of air through porous sand molds during filling without the need to use the porous media flow model. This addition complements the existing valve model, often used when modeling the high pressure die casting filling. 
Surface wave generator additions Several additions went into the surface wave generator model. A solution based on Fourier series extends the wave generation capability to all periodic non-linear waves. Tsunami waves can be simulated using a solitary wave model, and a random wave generator creates realistic wave conditions at open sea. Finally, a periodic wave profile can be used to define fluid initial conditions to speed up the approach to a steady-state wave pattern. Resources: How Do I Model Wave Boundaries? Development Focus: New Wave Generators 
Wind The definition of the wind shear at the surface of a reservoir has been extended to include time-dependent conditions. 

http://www.flow3d.com/pdfs/tn/FloSci-TN89.pdf
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Resources: How Do I Model Wind Shear Stress? 
Shallow water model additions The shallow water model now includes separate models for laminar and turbulent flows, and a way to define Earth rotation by simply defining the latitude. The additions extend the use of the model to large scale flows. Resources: How Do I Model Shallow Water Flows? 
Redesign of mass and mass/momentum source models The mass and mass/momentum source models have been redesigned so that properties, such as fluid type, density and temperature, mass or volume flow rate, can be defined for individual sources, greatly enhancing the capabilities of the model. 
Moisture drying model Two models are now available to describe the evolution of moisture in porous components. A simpler, isothermal model is suitable for sand molds and cores during filling and solidification. The second option uses a more sophisticated two-phase liquid/gas model and is designed to simulate the drying process of porous materials such as paper, fabric and sand cores. Resources: Application Note: How Paper Drying Became Sand Core Drying 
Solid solute dissolution model The model describes the dissolution of solid solute, such as rock salt or crystals of a medication, in the surrounding liquid. The density of the brine is altered according to the local solute concentration to include buoyancy effects. Resources: TN 92: Salt Dissolution Model in FLOW-3D Development Focus: Sweet Application using the Salt Dissolution CFD Model in FLOW-3D 
Van Genuchten model for unsaturated flow in porous media The Van Genuchten model enhances the capabilities of the unsaturated porous media model by expanding the pressure-saturation functions available to the user. 
Baffle definition using STL files STL files can now be used to define baffles, providing the means to create complex, and thin, geometry. The STL data is converted to the standard stair-step representation of baffles. 

http://www.flow3d.com/resources/news_11/winter/general-purpose-applications.html
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Contact line pinning Droplets sitting on a rough surface may have the contact line ‘pinned’ due to surface imperfections, instead of moving in response to external forces. This can be achieved in a simulation by using a special type of phantom component, IFOB(n)=1. 
Temperature slip at liquid/gas interface FLOW-3D uses a one-temperature approach to modeling two-fluid problems. This may result in excessive numerical diffusion of temperature at the interface between the two fluids, especially when the thermal boundary layer is not resolved by the mesh. The new temperature slip model (similar to the existing velocity slip model) greatly reduces numerical diffusion, improving the accuracy which is particularly important in liquid/gas sloshing problem with phase change. 
Improvements 
SMP parallelization SMP parallelization of the solver, based on OpenMP technology, has been extended to most physical and numerical models, including the GMO and all VOF models. Resources: Development Focus: Parallelizing FLOW-3D using OpenMP 
Simplified definition of cooling channels Cooling channels can now be defined using a special type of geometry subcomponents called ‘Cooling channel’, simplifying the set up process by eliminating the use of void pointers. Three types of cooling channels can be defined, identified by the heat transfer coefficient to the die. Each subcomponent can defined multiple cooling channels of the same type. 
Reduced pressure noise at curved wall surfaces The parameter that controls the cutoff value for the FAVOR quantities such as area and volume fractions, EPS, is now an input parameter in the namelist LIMITS. The default value is 0.01 meaning that any cell volume or face blocked less than 1% is assumed fully open. Conversely, any cell volume or face blocked more than 99% is assumed fully blocked. Reducing the value of EPS may help achieve more accurate pressure solution near walls, which is useful when accurate evaluation of forces acting on solid objects is of primary importance. EPS is accessible from the GUI's Numerics tab, under Stability factors and is called FAVOR tolerance. 
Ability to change the number of SMP threads at runtime The ability to change some numerical parameters at runtime has been available in FLOW-3D for a while now. In this release we have added the number of parallel threads to the list of these parameters. As long as a parallel token has been checked out at the beginning of a simulation, 

http://www.flow3d.com/resources/news_10/FLOW-3D-newsletter-SMP-parallel-CFD-fall-2010.html


the user can change the number of cores used by the solver without even pausing it, proving more flexibility in the use of the computer resources. 
Viewing initial conditions for restart simulations The prpgrf file for restart simulations, created by running the pre-processor now contains the data extracted from the restart source file rather than from the prepin file, making it easier to view the actual initial conditions for restarts. 
Switched to Intel FORTRAN compiler version 11.1 on Linux and Windows Users involved in solver customizations should update their compilers accordingly. 
New Output 
Flow tracers Flow tracers can be introduced at flux surface to enhance flow visualization. Each flux surface can introduce a unique tracer, while a combined tracer provides a view of all tracers at the same time. 
Tecplot® output from FSI/TSE model The user can request to save the solution from FSI/TSE model in Tecplot® compatible finite element mesh and data file format. The data is written out at the same time intervals as the general restart data. 
Graphical Users Interface (GUI) 
Object names All objects in Meshing & Geometry, e.g., components, mesh blocks and baffles, can be given names for easier identification during setup. 
Disabling geometry components Components and subcomponents can be disabled during setup without the need to completely delete them from the input. This allows users to easily temporarily remove and then add geometric features without having to reenter all the related data. 
Removal of initial and boundaries tabs The Initial and Boundaries tabs were removed and their functionalities integrated into the Meshing & Geometry tab. 
Help links added to all physics dialogs Help links to on-line documentation have been added to all Physics dialogs.  



Capability to determine what makes a control active (or inactive) By selecting a control (radio button, edit box, etc.) with <ctrl>left-click, it can be determined the requirements needed to make the control active (or selectable). 
Capability to import CSV files The capability has been added to import CSV files for both time and temperature dependent tables. 
Re-organization of the prepin file The prepin file is now rewritten into a more logical and readable format. 
Capability to specify temperature units Temperature units can now be specified in Model Setup and for analyzing results. 
Capability to save probe points Probe points are saved to the clipboard and can be used to create Valves, History Probes, Fluid Pointers and Void Pointers. 
Saving simulations It is no longer required to save a simulation before editing the simulation or before switching to another simulation. 
Tree structure enhancements The state of all tree structures are now saved and restored for each simulation. To enhance tree traversal, Expand and Collapse functions have been implemented in all tree structures. 
Graphics settings saved in Model Setup Camera angles, colors, and transparency settings are now saved and restored for each simulation on the Meshing & Geometry tab. 
Visualization enhancements in Model Setup The capability was added to view the finite element mesh used for the FSI and TSE models.  Mass momentum sources, valves, history probes, and sampling volumes can now be visualized on the Meshing & Geometry tab. 
Perspective view In addition to orthographic view, perspective view is now available on both the Meshing & Geometry and Display tabs. 



Postprocessing 
Ability to process output from FLOW-3D and FLOW-3D/MP Output files created by both SMP and MPI parallel version of the FLOW-3D solver can now be postprocessed using the same interface and postprocessor. 
Multiple color variable selection In 3D visualization, it is now possible to select more than one color variable on the Analyze tab.  Then, on the Display tab, any of those color variables can be displayed without having to return to re-render from the Analyze tab. 
FSI/TSE tab A new FSI/TSE tab has been added to the Analyze tab for FSI/TSE visualization. In addition to displaying the components themselves, there are also options for displaying cross-sections and deformation. 



Modeling Options in Version 10.0 
Incompatible with 9.4 Input There are changes to some existing capabilities in FLOW-3D that make the prepin files created for these models in earlier versions incompatible with version 10.0. The affected modeling options and the required actions to update the prepin files created in version 9.4 are outlined below. The document does not cover the additions to version 10.0 that do not conflict with existing models. Fluid #1 initialization using initial fluid height or volume Cooling channels Core gas model Porous media model ADI pressure solver Tabular input for energy vs. temperature for the solidification latent heat release Shallow water model Wind shear Moisture in sand mold model Pressure iteration convergence control Active mentor mode Mass and mass/momentum sources Heat sources in components Sand core blowing model Thermal buoyancy with volume changes Lost foam model Thermal stress model 



Fluid #1 Initialization Version 9.4 Input variables: FLHT – initial fluid height in +z-direction; VLIN – initial fluid volume. Behavior: VLIN is used if > 0.0, otherwise, FLHT is used. By default, no fluid #1 is initialized in the domain. Version 10.0 Changes to the input: IFLINITTYP – new input variable in namelist FL. Behavior: IFLINITTYP  =0, do not use FLHT or VLIN (default), =1, use FLHT, =2, use VLIN. Actions to update 9.4 prepin files to version 10.0: In Meshing & Geometry, expand the Global branch under Initial and make your selection under Fluid initialization. 
Defining Cooling Channels Version 9.4 There are two ways to define a cooling channel: 
� Use void pointers; this works the same way in version 10.0. 
� Use IVR(n) variable  in namelist OBS to associate a cooling channel subcomponent #n with void properties defined in namelist FL Input variables:  IVR(n) – void number subcomponent #n is associated with; Behavior: Subcomponent #n must be a negative region, i.e. IOH(n)=0. The void properties are defined with IVHT(k) and TVRD(k), where k=IVR(n). Version 10.0 Changes to the input: CCTEMP(n) and ICCTYPE(n) – new input variables in namelist OBS. Behavior: The old logic using IVR(n) is no longer used. IVR(n) is now a binary flag to designate subcomponent #n as a cooling channel. If the subcomponent is defined as a solid it is automatically converted to a negative region. CCTEMP(n) defines the temperature of the cooling channel and ICCTYPE(n) defines its type. The type has the same meaning as the void region type: a cooling channel can be of type 1, 2 or 3, which, as before, is related to the heat transfer coefficients between the component #m and the cooling channel, HOBV1(m), HOBV2(m) and HOBV3(m). 



Actions to update 9.4 prepin files to version 10.0: In Meshing & Geometry, expand the branch for the subcomponent that defines the cooling channel. Expand the branch Cooling Channel, activate the option, and fill in the temperature and the cooling channel type. 
Core Gas Model Defining Permeability of Sand Core Version 9.4 Input variables: OADRGCG(m) and OBDRGCG(m) – linear and quadratic drag coefficients for sand core component #m. Behavior: OADRGCG(m) must be positive. The two coefficients are used directly in the solution for binder gas flow in porous sand. Version 10.0 Changes to the input: GRAINDIAM – new input variable in namelist OBS.  OADRGCG and OBDRGCG have been removed from input. Behavior: GRAINDIAM(m) is the average sand grain diameter for core gas component #m and must be positive. It is converted in the pre-processor to the linear and quadratic drag coefficients for a given sand core component according to:    Actions to update 9.4 prepin files to version 10.0: Open the prepin file in the GUI’s text editor by pressing CTRL+E and remove all occurrences of the variables OADRGCG and OBDRGCG. Save the file and close the editor.  In Meshing & Geometry, expand the branch Component Properties for the components that define the sand cores. Expand the branch Core Gas Model Properties and fill in the edit box titled Average Sand Grain Diameter. 
Defining Sand Core Components Version 9.4 Input variables: PORCG(m) – porosity of core gas component #m. Behavior: When the core gas model is active, IFCOR=1, the type core gas is assigned to component #m if PORCG(m) > 0.0. 



Version 10.0 Changes to the input: new value for the existing input variable IFOB(m) to designate component #m as a core gas component. Behavior: IFOB(m)=-2 is required for a core gas component. As before, PORCG(m) must also be positive. Actions to update 9.4 prepin files to version 10.0: In Meshing & Geometry, expand the branch for the component in question and under Component Type change its type to Core gas. 
Porous Media Flow  Defining Porous Components Version 9.4 Input variables: OPOR(m) – porosity of a porous component #m. Behavior: Component #m is of type porous when OPOR(m) > 0.0. Version 10.0 Changes to the input: New value for the existing input variable IFOB(m) to designate component #m as porous. Behavior: IFOB(m)=-1 is required to define component #m as porous. As before, OPOR(m) must be positive. Actions to update 9.4 prepin files to version 10.0: In Meshing & Geometry, expand the branch for the component in question and under Component Type change it to the type Porous. 
Volume Fraction Dependent Drag Model, IDRG=1 Version 9.4 Input variables: IDRG=1 – activates the volume fraction dependent drag model; OADRG(n), OBDRG(n) –coefficients for the calculation of flow resistance in porous component #n. Behavior: The constant drag coefficient K for flow inside porous component #n is computed as a function of the component porosity OPOR(n):    Version 10.0 Changes to the input: The coefficient OBDRG(n) is no longer used in the linear drag model. Behavior: The drag coefficient K is simply equal to OADRG(n). 



Actions to update 9.4 prepin files to version 10.0: If both OADRG(n) and OBDRG(n) were used in version 9.4, then adjust the value of OADRG(n) in the new version to be equal to the expression for K in version 9.4 above. In Meshing & Geometry, expand the branch for the component in question and under Component Properties > Porous Properties type the new value of OADRG(n) into the edit box titled Drag Coefficient A. 
Fluid Fraction Dependent Drag Model, IDRG=2 Version 9.4 Input variables: IDRG=2 – activates the fluid fraction dependent drag model; OADRG(n), OBDRG(n) –coefficients for the calculation of flow resistance in porous component #n. Behavior: The drag coefficient K for flow inside porous component #n is computed as a function of fluid fraction F:  Version 10.0 Changes to the input: This model has been removed from the new version. Behavior: A fatal error will occur in the pre-processor if this option, IDRG=2, is selected in the input file. 
Pressure Solver: Selecting the Line-implicit (ADI) Solver Version 9.4 Input variables: IADIX, IADIY, IADIZ. Behavior: The line implicit solver is activated if IGMRES=0 and any of IADIX, IADIY and IADIZ is equal to 1. Version 10.0 Changes to the input: New value for the existing input variable IGMRES. Behavior: The line-implicit solver is selected by setting IGMRES=2. If IADIX=IADIY=IADIZ=0, then they are reset by the pre-processor to IADIX=IADIY=IADIZ=1.  IGMRES=0 corresponds to the SOR solver, irrespective of the values of IADIX, IADIY and OADIZ. Finally, and as before, IGMRES=1 activates the GMRES solver which is the default selection. Actions to update 9.4 prepin files to version 10.0: Go to the Numerics tab and click on Line implicit radio button. Activate directional options as needed. 



Solidification Model: Defining Tabular Input for Latent Heat Release Version 9.4 Input variables: CLHT(i) and CLTP(i) – fluid energy vs. temperature table. This input is used when IFST=1. Behavior: If the last entry in the table is greater than the liquidus temperature, then TL1 is reset equal to the last entry in the CLTP array. The first entry can be below the solidus temperature, but one of the values in the table must be equal to TS1. Version 10.0 Changes to the input: No changes to the input, but a new rule for setting solidus and liquidus temperatures for the tabular input of energy vs. temperature. Behavior: The solidus temperature TS1 is set equal to the first temperature in the table, and the liquidus temperature TL1 is set equal to the last entry, overwriting the user-defined input for TS1 and TL1. Actions to update 9.4 prepin files to version 10.0: If the new behavior in version 10.0 conflicts with the intentions of the user, the tabular input needs to be adjusted to match the user-defined solidus and liquidus temperatures. 
Shallow Water Model: Viscous Shear Stress Version 9.4 Input variables: ISWAT, MU1, RMVISZ. Behavior: A laminar model is used in the shallow water model to compute the viscous shear stress in the fluid in the horizontal direction and between fluid and the bottom of the reservoir. RMVISZ is used to enhance friction in the vertical direction to account for the difference in vertical and horizontal scales. The default value for RMVISZ is 1.0. RMVISZ can be used in both shallow water and 3D flow models. Version 10.0 Changes to the input: New input variables IFVISWAT and BTMSHR in namelist XPUT. They are used to define viscous friction in the shallow water model. Behavior: IFVISWAT = 0, inviscid flow, = 1, laminar flow, = 2, turbulent flow. Shear stresses in the shallow water model are computed only between fluid and the bottom of the reservoir; shear stresses in the fluid are neglected compared to the friction at the bottom. RMVISZ is used only in the laminar shallow water model, ISWAT=1 and IFVISWAT=1, and not in the 3D flow model.  The default value for RMVISZ is 



1.5, corresponding to the theoretical steady-state laminar flow over a flat surface. Fluid viscosity MU1 should be set equal to the molecular value. The new option for turbulent flow, IFVISWAT=2, uses the following equation for the shear stress 
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ρτ =  where ρ is the fluid density, u – velocity and CD is the drag coefficient defined by the new input variable BTMSHR that defaults to 0.0026. The fluid viscosity coefficient MU1 is not used in the turbulent shallow water model. Actions to update 9.4 prepin files to version 10.0: Go to the Physics tab, click on Shallow water button and select the required options. 
Wind Shear Version 9.4 Input variables: WNDSHR, UBCT(:,6), VBCT(:,6). Behavior: The wind velocity U is defined using the variables for the x- and y-direction fluid velocity components at the top mesh boundary. The wind shear stress is computed as: 
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=τ  WNDSHR is the drag coefficient with the default value of 0.0. Version 10.0 Changes to the input: New input variables IWND, UWND, VWND and FWNDNAM in namelist FL and RHOAIR in namelist XPUT. Behavior: IWND = 0, no wind shear, = 1, constant wind, = 2, time-dependent wind defined in a tabular fashion in the file which name is stored in the character variable FWNDNAM. UWND, VWND – constant wind velocity components in the x- and y-directions, respectively. Both default to 0.0. Used when IWND=1. RHOAIR – air density, defaults to the air density in the same unit system as the simulation units. If the latter is not defined, defaults to a negative number which would result in a fatal error if not reset by the user.  The wind shear stress is computed as: 
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⋅=τ  where U is the current wind speed. WNDSHR is the drag coefficient with the default value equal to 0.003. Note that, unlike the formulation in version 9.4, the air density RHOAIR is used in the expression. 



UBCT and VBCT are no longer used for wind shear. Actions to update 9.4 prepin files to version 10.0: Go to the Physics tab, click on Wind button and select the required options. 
Moisture in Sand Model Version 9.4 Input variables: Input variables:  OBSM(m), OBSMRC(m), OBSMRL(m), OBSMT(m) – moisture properties for geometry component #m Behavior: The model is automatically activated for any geometry component, for which all of the above variables are positive. Version 10.0 Changes to the input: Variables OBSM, OBSMRC and OBSMRL have been removed. The new variable IFDRYING in namelist XPUT is used to activate the model. The new variable IFOBSMST(m) in namelist OBS is used to activate the moisture model for component #m. The new variable RHOBS(m) in namelist OBS defines the density of the dry component. Moisture properties are defined using new variables RHOMST, CVMST, TVMST and CLHVMST in namelist PROPS. Behavior: This moisture model is activated by setting IFDRYING=1. IFOBSMST(m)=1 activates the model for component #m. Actions to update 9.4 prepin files to version 10.0: Open the prepin file in the GUI’s text editor by pressing CTRL+E and remove all occurrences of the variables OBSM, OBSMRC and OBSMRL. Save the file and close the editor.  In Physics open the dialog called Moisture. Activate Isothermal moisture drying model and fill in the edit boxes within Moisture Properties group box. Make a selection for Moisture Content on the right. In Meshing & Geometry, expand the branch Component Properties for the component with moisture. Expand the branch Moisture Properties and select Yes for the Contains Moisture dropdown box. Fill in the edit boxes for the initial moisture content and dry density. 
Pressure Iteration Convergence Version 9.4 Input variables: EPSADJ, EPSI Behavior: The automatic convergence control EPSADJ is used when EPSI is not defined (default). Otherwise, the constant convergence criterion EPSI is used. Version 10.0 Changes to the input: New input variable IFDYNCONV. 



Behavior: When IFDYNCONV=1, the automatic convergence control EPSADJ is used (default). Otherwise, the constant convergence criterion EPSI is used. Actions to update 9.4 prepin files to version 10.0: The default behavior in version 10.0 is the same as in version 9.4. If the constant convergence criterion EPSI is desired, then in Numerics open Convergence controls dialog in the Pressure solver options group of buttons. Select Constant convergence criterion at the top of the dialog. Fill in the edit box next to it with a positive value. 
Active Mentor Mode Version 9.4 Input variables: IHELP Behavior: The active mentor mode is selected when IHELP=2, in which case the mentor may make adjustments to the numerical parameters during the simulation. Version 10.0 Changes to the input: IHELP=2 setting is no longer available. Behavior: Only passive, IHELP=1, and off, IHELP=0, mentor modes are available. In passive mode, the mentor offers suggestions but will not make any changes. Actions to update 9.4 prepin files to version 10.0: None 
Mass and Mass/Momentum Sources Version 9.4 Input variables: IQSR, TQSR and RHOQSR in namelist XPUT, QSROBS in namelist OBS, NVNTS, TVFR and others in namelist PARTS. Behavior: The mass and mass/momentum source models are activated by setting IQSR=1 or IQSR=2 for fluid #1 or fluid #2 source respectively. The same fluid is generated at all sources. TQSR and RHOQSR define fluid temperature and density at all sources. Version 10.0 Changes to the input: TQSR and RHOQSR have been removed. An array of new variables has been added to namelists OBS and PARTS. Behavior: The mass and mass/momentum source models are activated by setting IQSR=1. The new variables in namelists OBS and PARTS are used to define individual properties of each source. 



Actions to update 9.4 prepin files to version 10.0: Open the prepin file in the GUI’s text editor by pressing CTRL+E and remove the variables TQSR and RHOQSR. Save the file and close the editor.  In Physics open the Mass Sources dialog and activate the model. In Meshing & Geometry, expand the branch Component Properties for the component with source. Enable and expand the branch Enable fluid source/sink.  Make your selections for the source properties within the branch. In Meshing & Geometry, right-click on Mass/momentum sources/sinks and select Add a mass/momentum source/sink. Make your selections for the source properties within the branches that appear. Repeat the steps for additional mass/momentum sources. 
Heat Sources in Components Version 9.4 Input variables: POBS, SPOBS Behavior: Heat sources for a component #m are defined using the total power POBS(t,m) or specific energy, SPOBS(t,m), where t is the time index. If both are defined, SPOBS takes precedence. If RCOBS(m) > 0.0, then SPOBS(t,m) is interpreted as energy per unit volume, otherwise, it is energy per unit area. Version 10.0 Changes to the input: New input variable ITPOBS in namelist OBS. Behavior: ITPOBS(m) = 0, no heat is generated at component #m (default) = 1, heat is generated using total power input POBS(t,m) = 2, heat is generated using specific energy input SPOBS(t,m) Actions to update 9.4 prepin files to version 10.0: In Meshing & Geometry, expand the branch Component Properties for the component with power source. Expand the branch Solid Properties.  Expand the branch Heat source type. Make your selections for the heat source input. 
Sand Core Blowing Model Version 9.4 Input variables: ISAND1 I namelist SCALAR Behavior: The old sand core blowing model is inaccessible through the GUI, but it is still part of the solver and could be added to prepin by the user in a text editor. Version 10.0 Changes to the input: The old sand core blowing model has been removed, replaced by a new 



granular flow model. All variables associated with the old model have been removed. Actions to update 9.4 prepin files to version 10.0: Open the prepin file in the GUI’s text editor by pressing CTRL+E and remove all variables associated with the old sand core blowing model, e.g., ISAND1, CMSND, RMSND in namelist SCALAR . Save the file and close the editor.  In Physics open the dialog called Granular flow and activate the model. Fill in the edit boxes in this dialog accordingly. 
Thermal Buoyancy with Volume Changes Version 9.4 Input variables: IQSR Behavior: To add volumetric changes in fluid due to changes in density as a function of temperature, IQSR needs to be set equal to 1. Version 10.0 Changes to the input: New input variable IFTHEXP in namelist XPUT. Behavior: IFTHEXP = 0, no volume changes (default), = 1, add volume source due to thermal expansion to the continuity equation. IQSR is no longer used for this purpose. Actions to update 9.4 prepin files to version 10.0: If the mass or mass/momentum source model is not used, go to Physics tab, open Mass sources dialog and deactivate the source model.  In Physics open the dialog called Granular flow and activate the model. Fill in the edit boxes in this dialog accordingly. Close the dialog by clicking OK. Open Density evaluation dialog in Physics and select Include volumetric thermal expansion. 
Activating the Lost Foam Model Version 9.4 Input variables: IFOB Behavior: Presence of a Lost foam geometry component, IFOB(m)=1 for a component #m, activates the lost foam model. Version 10.0 Changes to the input: New input variable IFLFOAM in namelist XPUT. 



Behavior: IFLFOAM = 0, the lost foam model is off (default), = 1, activate the full lost foam model, = 2, activate the simplified lost foam model. Components if type Lost foam, IFOB(m)=1, can still be present in the model when IFLFOAM=0, but there will be no heat transfer with it and hence no decomposition of the foam. Actions to update 9.4 prepin files to version 10.0: In Physics open the Lost Foam dialog and activate the full or the simplified lost foam model. Make other selections in the dialog as needed. 
Thermally Induced Stresses and Deformations Version 9.4 Input variables: IELAST, IFSLD, IGAP in namelist XPUT Behavior: The thermal stress model is activated by activating the elastic stress and solidification models, IELAST=1 and IFSLD=1. IGAP is used to activate the gap formation between solidified metal and mold. Version 10.0 Changes to the input: The thermal stress model has been replaced by a new model. IELAST=1 activates the Elasto-viscoplatic model for fluids, as before, but is not coupled to the solidification model. IGAP has been removed from input. New input variable ITHRMST in namelist XPUT to activate the thermal stress model. Behavior: ITHRMST = 0, the thermal stress model is off (default), = 1, activate the thermal stress model. As before, the activation of the thermal stress model requires the activation of the solidification model. Actions to update 9.4 prepin files to version 10.0: Open the prepin file in the GUI’s text editor by pressing CTRL+E and remove the variable IGAP from namelist XPUT. Save the file and close the editor.  In Physics open the dialog called Solidification and activate the thermal stress model. Fill in the edit boxes in this dialog accordingly.  The properties of the solidified fluid for the stress model are defined in Fluids, under Fluid 1 > Solidification Model > Solidified Fluid 1 Properties. 



Changes to the Graphical Users Interface 
in FLOW-3D Version 10.0 
General 1. The main window has been reworked: a. It no longer has controls (in the upper, right-hand corner in previous versions) or shortcuts (Ctrl-W) that cause the contents to disappear. b. The tabs are visually clearer, and it is easier to tell which tab is active. There are no pushpins in the tabs in the new setup. c. The main window and sub-windows have been reworked to correctly implement fitting in the minimum required monitor size of 1024 x 768 pixels, with window layouts correctly adjusting to the window size. Some screens are such a tight fit that they may not look good on some computers at this resolution. d. The title bar now correctly displays the tab or sub-tab name. The title bar now displays the "dirty" status (an asterisk under Windows and Linux) of the Simulation or Workspace when the Navigator, Model Setup or Simulation tabs are active. 2. The contents of the Model Setup/Physics tab are now also available in a menu to solicit feedback on this idea. The Physics menu is only enabled when there is a Simulation selected in the Navigator. Ctrl-Right-click opens the Dependencies dialog for Physics choices that are enabled depending on other Simulation settings. 3. The old parser has been completely removed. The file F3D_HOME\gui\variable.txt is no longer used or needed. 4. All dialogs and screens have improved, more consistent layout. 5. “Force Window” has been renamed “Sampling Volume” to better reflect its modern usage. 6. Dependencies Dialog: Control-right click on most properties opens a dialog box describing properties on which the clicked-on property depends to become enabled. Shift-click on a checkbox brings up the dependencies for the feature value of 0 (useful for checkboxes). Within the dialog, a. A tool-tip indicates current value of a feature, b. Red indicates that the current value doesn’t match the value of this feature, c. Green indicates a circular dependency. 
Navigator 1. The paths in the "SelectedSimulation" group box can now become narrower than their full display lengths by being elided. When FLOW-3D is made wider or narrower, or when the splitter between the Portfolio and the rest of the Navigator is moved, the path text is re-elided. When they contain a path, they now show a "Pointing Hand Cursor" when the cursor is over the contents, and, under 



Windows, left-clicking will open a Windows Explorer window with the file selected. Right-clicking no longer does anything. The full, un-elided path will be shown as a tool tip. The width of these paths no longer determines the minimum size of the window or the maximum size of the Portfolio. 2. File/Revert Simulation to Saved. 
Model Setup - General 1. Group box contents have changed prompting rearrangement to make better use of the space. 2. Version Options – "Use parallel token" has been added. a. Checking this causes the solver to use a parallel token even though only one processors is requested, thereby allowing the number of processors to be changed during a simulation using the Runtime Options feature. b. Is enabled all the time. c. Should keep its value even when disabled. d. If "Run serial ..." is also checked, then the solver will use a serial token if a parallel token is unavailable regardless of the state of "Use parallel token". e. "Use parallel token" is also available in Preference/"Default Version Options", and as a preference, is not dependent on the number of processors. 3. "Activate Solver wall clock timers" added 4. Mentor option "Offer Suggestions and take action" removed. 5. Temperature units added a. SI and CGS simulation units allow only Kelvin, Centigrade or Unspecified temperature units. b. Engineering simulation units only allows Fahrenheit, Rankin or Unspecified. c. Custom simulation units allow any temperature unit. 6. The maximum number of items (Components, Subcomponents, Springs, Baffles, Valves, etc.) is now enforced. The "add" menu items are disabled when no more items of a certain type can be added. Deleting an item will make room for the user to add a new item. 
Model Setup - Physics 1. The look of the buttons has changed, but the function has not. 2. All dialog boxes in Physics have help buttons. Help buttons with an arrow have multiple help topics listed in a pop-up menu. Help topics are opened in the default web browser. 3. Air Entrainment: The two options buttons open groups of related settings, making it easier to set up various kinds of air entrainment problems without having to go to other dialogs. 4. Bubble and Phase Change a. Radio button choices have been rearranged for clarity. b. Specific heat can now have a temperature dependent table. c. Various settings are duplicated here for convenience. 



5. Density Evaluation a. Choices were rearranged for clarity. b. Volumetric thermal expansion was added. 6. Elastico-viscoplasticity replaces Elastic stress 7. Mass Sources a. Mass sources have been moved to The Meshing & Geometry tab and are found in the Component Parameters branch of the tree list. b. Momentum Sources have been moved to The Meshing & Geometry tab and have their own main branch in the tree list. 8. Non-inertial Reference Frame a. Geophysical fluid flow has been added. b. Acceleration type has been renamed to Motion type. c. All motion types are now listed in the dialog. d. The tabular input dialog box's table now uses the insert and delete keyboard keys to add and remove table rows. Rows are inserted before the selected row. 9. Particles a. Settings have been rearranged. b. The particle list has been moved to a separate dialog box. c. Particle definitions are now made in three separate tables, one for each particle type. The individual tables now use a pop-up menu (right-click) to add and remove table rows. Rows are inserted before the clicked-on row, or at the bottom if the user clicks below the last row. 10. Porous Media a. Removed ADRG and BDRG. Media properties are now specified in Component Properties. b. Added Van Genuchten model. c. Replaced all previous saturated drag options with “Saturated drag”, which corresponds to the Reynolds number dependent drag option. 11. Shallow Water a. Added turbulent flow. b. Moved “Wind shear coefficient” to the new Wind dialog. 12. Solidification a. Segregation model changed to “Binary alloy segregation model”. b. Addition of Gap formation model. c. Addition of Iron solidification. d. Addition of Thermal stress analysis. 



13. Thermal Die Cycling a. Addition of Segment Name. b. Addition of “Number of segments in each cycle”. c. Addition of total duration. 14. Viscosity and Turbulence a. Removed the “Turbulent” radio button. b. Removed “Special options for horizontal flow”. “Wind shear coefficient” has been moved to the new Wind dialog, “Vertical viscosity multiplier” is set in the Shallow Water dialog.  15. New Dialogs Added a. Dissolving Objects b. Granular Flow c. Lost Foam d. Moisture e. Wind 
Model Setup - Meshing & Geometry 1. General a. Perspective view has been added. b. Camera angle and projection type (orthogonal or perspective) is retained when switching between Simulations or when closing and reopening FLOW-3D. c. History Probes (History points) can now be added in the GUI. d. Valves, Sampling Volumes (Force windows), History Probes, Mass Momentum sources, Fluid Regions, Temperature regions, Fluid Pointers, Void Pointers, and global initial conditions have been moved to Meshing and Geometry. e. Springs and Ropes, Valves, Sampling Volumes, History Probes, Mass Momentum sources are now represented in the graphical view. f. Components, subcomponents, Mesh Blocks, Baffles, Springs and Ropes, Fluid Regions, Temperature Regions, Fluid Pointers, Void Pointers, Mass Momentum Sources, Valves, History Probes, and Sampling Volumes can all now have names. g. Branches retain their “expandedness” when switching between Simulations or when closing and reopening FLOW-3D. h. Pop-up menu items for expanding and collapsing groups of branches have been added. i. Numerous context sensitive pop-up menu items have been added. j. Multiple items of a type (e.g. subcomponents, Mesh Blocks) can be selected. Pop-up menus are available for multiple selections of some types. k. Probe Points 



i. Probe Points continue to be created by holding down the control key while clicking in the graphics view. ii. Probe Points are now displayed in the “status bar” at the bottom of the window instead of at the bottom of the graphical view. iii. The last Probe Point is copied to the clipboard, and can be pasted into other applications such as a text editor. iv. Probe points are now added to a list (maximum of 20, first in - first thrown away) if the control key is also held down.  v. Probe points can be used to create Valves, History Probes, Void Pointers and Fluid Pointers. These can be created individually or in a group by right clicking on the Valves, History Probes, or Pointers branch and choosing either the Add At or Add Group menu item. If the group add is chosen, then one item for each Probe point will be added. If the Add At menu item is chosen, then the first Probe point in the list will be created. vi. By selecting the View/Probe Point List menu item, one can see the coordinates of the points currently in the list, and edit them. l. In the TimeEditDialogs where multiple columns of data are editable, such as the Velocity Boundary condition, the column headings and the graph data-lines are shown in different colors. 2. Components and subcomponents a. Component colors are now generated in a way intended to maximize the difference between colors. The file F3D_HOME\gui\colortable.ini is no longer used or needed.  b. Subcomponents are now listed in a Subcomponents branch, and Component Properties are listed in a Component Properties branch in the tree. c. Subcomponent type restrictions (when a subcomponent can be a complement or hole) has been improved to only show valid choices. When a subcomponent is moved (reassigned) or copied, choices incompatible with the new location are resolved with the help of dialog boxes. d. Components and Subcomponents can be individually enabled or disabled to make them not be considered in a Simulation, without permanently removing them from a Simulation. This allows, for example, alternative geometries to be conveniently tested. e. Transformation Center has been added to the Transformations branch. f. Torus now has its own limiters and can be edited in the tree. Old torus definitions are not converted. g. Subcomponents can be cooling channels. h. Subcomponent transparency has been implemented with a slider control in the pop-up menu. i. Subcomponent reassign and copy work correctly now. j. Components can be copied in their entirety including copying all subcomponents. Right click on a component, and select “Copy” k. Components and subcomponents are renumbered when a project is saved. l. All documented Component types are now represented. m. Thermal stress analysis has been added. See also Fluid-Structure Interaction. 



3. Mesh Blocks a. Boundary conditions can now be visualized in Meshing & Geometry, by right clicking on the Mesh branch in the tree display, and choosing Boundary from the list shown under "Mesh View Mode". Likewise, other Mesh View Modes can be selected in this manner. Individual Mesh Blocks' View Modes can be individually set by right clicking the individual Mesh Blocks, and selecting "Mesh View Mode". b. Mesh Block colors can be set by clicking on the MeshBlock color buttons. c. The colors on the color buttons indicate the Mesh Plane and Grid Line colors on the right and left sides. d. The color button on the main Mesh branch specifies the default colors for all Mesh Blocks subsequently created. Menu items accessible from this button allow resetting the colors to the preset default values of cyan and white, applying the chosen default colors to all Mesh Blocks, or applying the preset default colors of cyan and white to all MeshBlocks without changing the set default colors for subsequently created Mesh Blocks. e. Mesh planes are automatically sorted according to location when added or changed. f. View mode (Outline, Mesh Planes, Grid Lines, Boundaries) can be set for all Mesh Blocks or individually. 4. Baffles a. Baffle region has been added to be more consistent with the documentation. b. Flux Surfaces can generate tracers. c. Branches have been organized. d. Baffle regions can now be defined with STL files. 5. Springs and Ropes are now displayed graphically as a cylinder. 6. Initial Conditions a. Contents of the Initial tab have been moved to the Meshing & Geometry tab because many of the items are or will be visualized.  b. Pointers can be created from Probe Points. 7. Mass-momentum sources a. Mass-momentum sources have been moved to Meshing & Geometry and are now displayed graphically in the fixed color Blue with a yellow arrow. The size of the arrow is related to the area of the source. b. The illustration has been removed. c. Numerous properties have been added. 8. Valves a. Valves are now displayed graphically, in the fixed color green, and are automatically sized based on the size of the Simulation domain. b. Valves can be created from Probe Points. 



9. History Probes a. History Probes are now supported in the GUI, and displayed graphically, in the fixed color Dark Blue, and are automatically sized based on the size of the Simulation domain. b. History Probes can be created from Probe Points. 10. Sampling Volumes are now displayed graphically, in the fixed color green, and are automatically sized based on the size of the Simulation domain. 
Model Setup - Output 1. Enabling tracer output has been added. 
Model Setup - Numerics 1. Third-order momentum advection has been removed. 
Analyze Tab 1. 3D sub-tab: The ability to specify some additional color variables has been added. 2. Probe sub-tab: For General History and Mesh-dependent History, the ability to request integrals, derivatives and moving averages has been added in graphics plot. 3. An additional tab has been added for specifying parameters for Fluid-Structure Interaction analysis. 4. Temperature units added: By clicking the Units button at the bottom of the Analyze tab, the user can view the units that are used in the results, and specify the units that will be used in plots. Temperature units have been added to this dialog box. 
Display Tab 1. 3D and Fluid-Structure Interaction a. Probe Points b. Probe Points continue to be created by holding down the control key while clicking in the graphics view. c. Probe Points are now displayed in the “status bar” at the bottom of the window instead of at the bottom of the graphical view, and include the value at the probed point. d. The last Probe Point and value are copied to the clipboard, and can be pasted into other applications such as a text editor. e. Operations on items in the Object List are now accessed by right-clicking. f. The desired color variable (of those selected in the Analyze tab) can be selected from a drop-down list. 



Individual Models and Parameters 1. Mold Vent - Gas venting model 2. Van Genuchten saturated flow in porous media 3. Fluid-Structure Interaction 4. Additional types of wave boundary conditions. 
Materials Database 1. Temperature units can be specified in materials database files. Temperature data will be converted on import if temperature units are specified in both the database file and simulation. 2. A comment is now allowed in materials database files. There is one comment allowed, after the name, units and temperature units lines, and is delimited by /* and */. At this time, the comment is not displayed in FLOW-3D, but displaying the comment is anticipated. 3. Temperature-dependent data in CSV files can now have a comment. There is one comment allowed, at the beginning of the file, and is delimited by /* and */. At this time, the comment is not displayed in FLOW-3D, but displaying the comment is anticipated. 
Prepin file 1. Parameters are grouped, sorted and indented automatically. 2. Remarks are kept with parameters. 
Material Property Database (MPDB) 1. The Material Property Database (MPDB) solid materials database is available as an extra option. If installed, it is accessible from the Materials menu, if not present, the menu item is disabled. 2. MPDB can export materials files directly to the user materials database. The materials are then available for import into FLOW-3D. 1. MPDB can export data into Comma Separated Values (CSV) files, which can be imported into FLOW-3D in individual temperature-dependent property editing dialogs. 



Chapter 1 - Introduction 
License Agreement This License Agreement (the “Agreement”) is between You and Flow Science, Inc., a New Mexico corporation ("Licensor"). This Agreement authorizes You, on a nonexclusive and nontransferable basis, to use a copy of FLOW-3D (the "Code") and related documentation subject to the terms and conditions set out in this Agreement. By installing the Code, you are signifying Your agreement to the terms of this Agreement. 1. The Code is licensed to You on the basis of commercial terms specified in an agreement between Licensor and You (or the entity that has authorized Your use of FLOW-3D for your work, research or study). Said agreement governs such terms as number of licenses for the FLOW-3D solver, price, license term, right to technical support and upgrades, and so on. IF YOU ARE AN ACADEMIC USER, YOU AGREE TO RESTRICT YOUR USE OF THE CODE STRICTLY TO TEACHING, TO ACADEMIC AND/OR UNSPONSORED RESEARCH, OR TO SPONSORED RESEARCH THAT CAN AND WILL BE FREELY PUBLISHED WITH NO PROPRIETARY RESTRICTIONS. 2. In connection with the License granted herein, Licensor shall license to You a user authorization device, such as a hardware key or a license file (hereinafter referred to as "Key"), to be shared by all processors that can access the Code on Your network. You agree that the number of simultaneous simulations using the Code’s solver module shall not exceed the number of Keys licensed to You in accordance with the FLOW-3D Purchase Agreement. Title to each Key will remain with Licensor, and You shall assist Licensor in reclaiming such Keys in the event of Your breach of this Agreement. If Your copy of the Code must be replaced for any reason, except for the replacement of defective media or software errors, there shall be a replacement fee not to exceed $500.00. If a Key is lost, Licensor will provide a replacement Key at Licensor’s then current fee for a replacement Key. Additional Keys may be provided to You at Licensor’s then current fees. 3. If arrangements for technical support have been made, only a person designated as a “Registered User,” or persons who have attended a FLOW-3D Training Class, will be entitled to contact Licensor to seek technical support. Licensor may provide technical support via telephone, e-mail, fax, and/or mail to You during the License period. 4. If You are an academic user, technical support is limited to the following: (a) Licensor will provide User with software upgrades when they become available; (b) Licensor will assist in installation of the code and will answer questions about how to use the input variables to implement the various models in the Code; (c) at its option, Licensor will analyze results that appear obviously incorrect because they don’t seem to reproduce simple analytical results or expected conservation laws; (d) Licensor will also provide access to a number of subroutines to allow users to implement small changes to the Code, including boundary conditions and material properties; (e) Licensor will not assist in the making of revisions or customizations to the Code. 5. This Code, FLOW-3D, and its documentation are the property of Flow Science, Inc. You recognize that the Code is subject to the copyright laws of the United States of America and embodies technology, methods, algorithms, trade secrets, trademarks, and service marks that are proprietary to the Licensor. No title to or ownership of the Code or any part thereof is hereby transferred to You. You acknowledge that, by virtue of this Agreement, You acquire only the right to use the Code pursuant to the terms of this Agreement. You agree to take all necessary action to protect the confidential and proprietary information in the Code, including appropriate instruction and agreement with its employees, to avoid 



the disclosure of the contents of the Code to any other person, firm, or corporation, and to treat the Code with the same degree of care that it provides its own confidential information. You agree to credit FLOW-3D when presenting results derived from the Code. 6. You, your employees, agents or representatives: (i) shall not sell, assign, distribute, nor market the Code or any portions thereof without prior written consent of Licensor; (ii) shall not copy the Code (except for one archival copy for backup purposes), but You may reproduce related documentation; or (iii) shall not decompile, disassemble, or otherwise reverse engineer the Code. Use, duplication, or disclosure of the Code is restricted under the conditions of this Agreement and/or the provisions of FAR 52.227 and DFARS 252.227-7013, as may be amended or superseded. 7. No sublicensing, assignments of rights or interest, or delegation of duties under this agreement shall be made or become effective without the prior written consent of Licensor. This prohibition of sublicensing, assignment, and delegation extends to all sublicensing, assignments and delegations that may be lawfully prohibited by this Agreement. Any attempt at sublicensing, assignment, or delegation without the prior written consent of Licensor shall be wholly void and ineffective for all purposes. 8. At the termination of the license, You will return or destroy all copies of the Code, in any form, in its possession. If You elect to destroy all copies of the Code, You shall provide Licensor with a certificate attesting to the destruction. 9. The Licensor warrants that it has the right to grant to You a license and warrants that the Code does not infringe third party intellectual property rights. Licensor shall indemnify and hold You harmless from and against any claim of infringement of a United States patent or copyright based upon the Code, provided You gives Licensor prompt notice of and the opportunity to defend any such claim. Licensor shall have the right to settle such claim or, at Licensor’s option, provide You: (i) a paid-up license; (ii) substitute functionally equivalent software; or (iii) a refund of a pro rata portion of the license fee paid for the Code. 10. The warranty and the obligation and liability of Licensor expressed in the Agreement are in lieu of, and YOU HEREBY WAIVE, ALL OTHER GUARANTEES AND WARRANTIES OR OBLIGATIONS AND LIABILITIES OF LICENSOR HEREUNDER, EXPRESSED OR IMPLIED, ARISING BY LAW OR OTHERWISE, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY AND ALL OBLIGATIONS AND LIABILITIES WITH RESPECT TO USE OF THE CODE OR USE OF RESULTS AND DATA DERIVED FROM SUCH USE, LOSS OF USE, DATA, REVENUE, OR PROFIT, OR INDIRECT, SPECIAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES. You agree that the obligations of Licensor as set forth herein shall constitute the sole remedy for a claim relating in any way to the Code provided under this Agreement. The liability of Licensor shall in all cases be limited to the purchase price of the Code. 11. The parties’ exercise of, or failure to exercise, any right, remedy or privilege under this Agreement will not constitute a waiver of any rights of that party under this Agreement. 12. A determination that any provision of this Agreement is invalid, illegal, or unenforceable shall not affect the enforceability of any other provision. 13. This Agreement shall terminate immediately upon Your failure to conform to any term, condition, or restriction of this Agreement; and Licensor shall have the immediate right, without notice, to repossess the Code, any copies thereof and all related documentation. All sums paid pursuant to the Agreement shall be retained by Licensor as liquidated damages as damages cannot be reasonably ascertained. In addition, Licensor shall have all other remedies and damages available to it in law or equity. Licensor is entitled to reimbursement from You for any expenses, legal fees, and/or court costs incurred in the enforcement of its rights hereunder or in the collection of damages. 



14. Licensor reserves the right, without limitation, and without obtaining prior approval from or notice to You, to make changes in and to the Code. 15. This Agreement shall be governed by and construed in accordance with the laws of the United States and the State of New Mexico, as applied to agreements entered into and to be performed entirely within New Mexico between New Mexico residents without reference to conflict of laws. This Agreement and the performance of the Parties required hereunder shall not be governed by or otherwise subject to the United Nations Convention for the International Sale of Goods. Any civil suit or proceeding relating to this agreement shall be brought only in U.S. Federal District Court or State District Court within the State of New Mexico, and each of the Parties consent to the personal jurisdiction and venue of such courts. Judgment upon any award made in such proceeding may be entered and enforced in any court of competent jurisdiction. 16. Licensor shall not be liable or in default under this Agreement for failing to perform if such failure results from acts of God or other reasonable causes beyond the control of Licensor. 17. Absent Licensor’s express written acceptance thereof, terms and conditions contained in any purchase order or other communication—whether oral or written—issued by You for the Code, other than the quantity or classification of the Code ordered, shall not be binding on Licensor to the extent that such terms and conditions are additional to or inconsistent with those contained in this Agreement. Any modifications to this Agreement must be in writing and signed by authorized representatives of both parties. In the event of any conflict between the terms stated herein and the terms of a written, executed License Agreement between You and Licensor, the terms of the written, executed License Agreement shall prevail. 
Installation Detailed information on the installation of FLOW-3D is given below in the Installation Instructions section. Instructions for installing a new or replacement license file is contained in the Installing a New/Replacement License File section. 
General Licensing Terminology 
License Technology and Terms FLOW-3D uses the licensing package FlexNet Publisher, by Flexera Software. FlexNet enables FLOW-3D licenses to be shared across a network. More information about FlexNet and its tools can be found below under the FlexNet License Administration Tools section. A FlexNet License Administration Guide is available in the “utilities” subdirectory of the FLOW-3D installation. Flow Science will provide you with a FLOW-3D license file, named flow3d.lic. License Files and Servers A valid license file from Flow Science is required to use FLOW-3D. This license file will be sent to you as an email attachment from licenses@flow3d.com, Flow Science’s License Administrator. As described later on, this license file must be saved in the licenses directory of the FLOW-3D installation on a computer you choose to be your "license server." FLOW-3D can be used on multiple computers on your network. However, one computer must be selected to be the license server. If the computer you choose to be the license server will not actually be used to run FLOW-3D, then only the FlexNet license server needs to be installed on it.  

mailto:licenses@flow3d.com


If you plan to install the FlexNet license server on a Windows computer, a dongle that attaches to the USB port of your computer will be provided by Flow Science. This key should have been enclosed in your FLOW-3D package.  Tokens The total number of FLOW-3D solver processes that you can run concurrently is determined by the number of "tokens" contained in your license file. The number of tokens available depends on how many were purchased. The license server checks tokens out to client computers on your network, and then checks them back in when the application has completed. In this process, tokens are counted by the license server and when all of the tokens you have purchased have been checked out, no more tokens can be checked out until a token which is in use has been checked in. There are essentially an unlimited number of tokens available to run FLOW-3D’s auxiliary programs such as the preprocessor, the postprocessor, and the various visualization options. There are several different types of solver tokens. The most important distinction is between "serial" solver tokens and "parallel" solver tokens. Flow Science offers multi-processor versions of FLOW-3D for both shared-memory (SMP) and distributed-memory (cluster) environments. A shared memory parallel solver token (shown in your license file as “hydr3dp”) enables you to run FLOW-3D simulations using more than one processor on a multiprocessor computer. For the distributed-memory version (FLOW-3D/MP), a hydr3d or hydr3dp instance token is required as well as hydr3dmpi rank tokens. For example, to run a simulation on 16 processors using FLOW-3D/MP, the license file must have a hydr3d token and 15 hydr3dmpi tokens. Unless you have purchased tokens for one of the multi-processor versions, your license file will contain one or more serial solver tokens (“hydr3d”). These serial solver tokens can be used on computers running any supported operating system. Definition of Client and License Server Any computer running FLOW-3D is referred to as a “client.” The computer on which the FlexNet license server is installed will be referred to as the “license server.” A computer that runs both FLOW-3D and the license server is called a “client/server.”  “Software Package” and “Software Distribution” The terms “software package” and “software distribution” will be used to refer to the directory structure containing all of the data files and executables needed to run FLOW-3D on a particular computer. 
Floating vs. Node-Locked Licenses There are two general types of licenses used to enable FLOW-3D: "floating" and "node-locked." A floating license is the most common type of license and is available to any computer on your network. You can also ask for your license to be a node-locked license. Node-locked licenses can only be used on the designated computer.  Both floating and node-locked licensing schemes require that one computer be designated as the license server.  



Floating Licenses To use floating licenses, it is important that both the computer you intend to use as your license server and your network are reliable. The TCP/IP protocol must be loaded and functional, and all intended clients must be able to access the license server. Floating licenses may also be accessed through a VPN tunnel. The computer that is acting as your license server may be any computer on your network, and does not need to have FLOW-3D installed on it. The license server may be a Windows or a Linux computer. You may load FLOW-3D on any client running a supported Linux or Windows computer on your network. A hardware key is not needed on a client computer unless it utilizes a node-locked license. Running FLOW-3D on a stand-alone computer To employ a floating license on a single computer, FLOW-3D should be installed with the client/server option.  Running FLOW-3D over a network The license server and the clients may reside on the same local area network, over a WAN, or across VPN. FLOW-3D must be installed locally on each client. 

 Node-Locked Licenses Users may choose to have their solver tokens locked to a particular computer so that only that computer can run the solver.  Advantages and Disadvantages of Floating and Node-Locked Licenses Both floating and node-locked licensing schemes have their advantages and disadvantages. A floating license is advised if several people are sharing a license, or if you want to be able to run FLOW-3D on a different computer if a particular computer is busy. With a floating license, you can also set up a problem on one computer while using another to run the FLOW-3D solver on a second problem. Of course, if others are using all available tokens, the solver won't run until a token becomes available. The main advantage of a node-locked license is the ability to ensure that your token(s) are always available to you and not available to others on your network.  NOTE: ALL LICENSES ARE FLOATING LICENSES UNLESS SPECIFICALLY REQUESTED AS NODE-LOCKED. 
FlexNet License Administration Tools Flexera Software provides utilities for you (or your license administrator) to help manage FlexNet licensing activities. The FlexNet End User Manual is available in the "utilities" subdirectory of the FLOW-3D installation. This manual is available in both PDF and html format. The PDF file can be read using Adobe 



Acrobat. For Windows computers, a program (lmtools.exe) is provided with all installations. With LMTOOLS, you can start, stop and configure FlexNet license servers, get system information, get server information, and more. For more information, see Chapter 12 of FlexNet End User Manual. On Windows computers, the license manager daemon (lmgrd) will restart automatically whenever the computer is rebooted. On Linux computers, however, you will have to start the license manager each time the computer is rebooted. To have the license manager start automatically on Linux requires editing the appropriate boot script and inserting the appropriate startup commands. See Section 6.2 of the FlexNet End User Manual for more information. A summary of commonly used administration tools on Linux is included here. Full descriptions of these and other available utilities can be found in Chapter 12 of the FlexNet manual. lmdiag – diagnoses license checkout problems. (Useful debugging command: lmutil lmdiag –n –c “full_license_file_path” ) lmdown – gracefully shuts down all license daemons on the license server node. lmgrd – the main daemon program for FlexNet. lmhostid – reports the HOSTID of a system. lmreread – causes the license daemon to reread the license file and start any new vendor daemons. lmstat – helps you monitor the status of all network licensing activities. (Useful debugging command: lmutil lmstat -a -c “full_license_file_path”) lmver – reports the FlexNet version of a library or binary file.  NOTE: IT IS NOT RECOMMENDED TO USE "KILL –9" TO SHUT DOWN THE LICENSE SERVER ON LINUX COMPUTERS. USE EITHER "LMDOWN" OR USE THE "KILL" COMMAND WITHOUT THE "-9" PARAMETER. 
Moving License Servers When a floating license is locked to a fixed host ID, such as an Ethernet address or host ID, it is recommended that users choose a server which is likely to be used for the duration of the license. Changing license servers can be done once a year without incurring a re-licensing fee. Re-licensing fees are not necessary (maximum one change per year) when users utilize a USB or parallel port hardware key (dongle) as their host ID. To move the dongle (and hence license server) to a different computer, the user simply needs to change the first line in their license file to reflect the computer name change. For example, if the license server was previously running on a server named Celsius and you wish to move it to Kelvin, you would change the first line in the license file from: 

SERVER Celsius FLEXID= “your ID” to 
SERVER Kelvin FLEXID= “your ID” 



Installations Instructions FLOW-3D is supported on the Microsoft Windows and Linux operating systems. This section provides detailed instructions for installing FLOW-3D. 
Windows Installations NOTE: YOU MUST HAVE ADMINISTRATOR PRIVILEGES TO INSTALL FLOW-3D UNDER WINDOWS XP/VISTA/WIN 7. BEFORE INSTALLING FLOW-3D, YOU SHOULD CLOSE ALL OTHER PROGRAMS THAT MIGHT BE RUNNING ON YOUR COMPUTER. Step One—The installation of FLOW-3D on a computer running Windows is a relatively automated process. If Autorun is enabled on your CD-ROM drive, the installation should begin when the CD is inserted. If Autorun is not enabled or if, for some reason, the installation process does not begin on its own, simply run the setup.exe program in the root directory of the CD. This can be done by either running it from the Run command under the Start button or by double-clicking on setup.exe in Windows Explorer. Once you have started setup.exe, you will see the Preparing to Install dialog displayed on the screen. This dialog requires no user input and will disappear after several seconds. Step Two—The next dialog you will see is the Welcome dialog. Click Next to move to the next step. Step Three—The next dialog is the FLOW-3D License Agreement. Please read it carefully. If you agree to all the terms, click the Next button to signify your agreement and move to the next dialog. Step Four—The next dialog is the User Information dialog Enter your name and the company name here, and then click Next to move to the next step.  Step Five—On the next dialog, choose a destination location for FLOW-3D on your computer. The default location for FLOW-3D is c:\flow3d\“version” where “version” represents the version being installed. If a license server is currently running on this computer, a dialog will appear which will assist you in terminating this license server easily. If the license server is not terminated, a reboot will be required to complete the installation. Step Six—Next, the Choose an Installation Option dialog box appears: 



 Option 1—"Client/Server (FLOW-3D + License Server)"—Choose the first option if you intend to run FLOW-3D on this computer and you want this computer to control your FLOW-3D licenses (that is, act as the license server) for use on other computers across a network. This situation is reflected below: 

 Be sure to copy your FLOW-3D license file (flow3d.lic) to your “licenses” directory once installation is complete. Your computer will be acting as a license server, and can issue tokens to any FLOW-3D clients on the network.  NOTE:  CHOOSE THE SERVER FOR YOUR FLOW-3D ENVIRONMENT CAREFULLY. THE LICENSE SERVER REQUIRES A STABLE COMPUTER. MOVING THE FLOW-3D LICENSE TO A NEW COMPUTER BEFORE YOUR LICENSE PERIOD EXPIRES MAY ENTAIL A RE-LICENSING FEE. 



Option 2—“Client (FLOW-3D)”—Choose this option if you intend to only run FLOW-3D on your computer, and the computer is not going be used as the license server (i.e., this computer is a client only and another computer is the license server). Be sure to copy the license file from the server to your licenses directory and also make sure the server name for your license server computer is listed in your FLOW-3D license file. Alternatively, the environment variable F3DTKNUX_LICENSE_FILE can be set to the license server name, eliminating the need for a license file or clients. No FlexNet license server components are installed. Option 3—“Server (license server)”—Choose Option 3 if you wish to have your computer function only as a license server and you do not intend to run FLOW-3D simulations on it. This choice will only install the FlexNet server on your computer. FLOW-3D itself will not be installed, and thus cannot be run on this computer. After making your selection in the Choose an Installation Option dialog box, click OK.  Step Seven—If you chose Option 1 or 3 in Step Six, a dialog will appear asking you to choose the type of key to which your license will be locked. The most common key type is a USB key and looks very similar to a USB memory stick. If your license will be locked to your Ethernet address (uncommon), then choose this option. If you are not sure what your license will be locked to, select the last option, “Don’t know.” All possible drivers will be installed. Select Next to continue. 

 At this point, the installation displays the following screen which will assist you in shutting down currently running FLOW-3D license servers. 



 Step Eight—At this point, installation of FLOW-3D and all required drivers is ready to begin. Click Install to complete the installation.  Step Nine—At this point, FLOW-3D should be installed and the final step is to install your license file. If you have already received your license file, simply copy it to the "licenses" directory and proceed to Step Eleven to start your license server. If you have not received your license file, follow the instructions in Step Ten to obtain a license file. Step Ten—In order to issue a license file, Flow Science needs both the host name and the host ID of your server. To obtain this information from your server, double-click on the LMTOOLS icon on your desktop and select the System Settings tab (see the following dialog box). If you are using a USB hardware key, provide the FLEXID and the Computer/Hostname to Flow Science. If you are not using a hardware key, provide Flow Science the Ethernet address and the Computer/Hostname. If two Ethernet addresses are displayed on the System Settings tab, provide the first one to Flow Science. The easiest way to provide the necessary licensing information is to select the “Save HOSTID Info to a File button” and email the file to licenses@flow3d.com. 
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 Once your Hostname and Ethernet or FLEXID have been received, the License Administrator at Flow Science will send you a license file ("flow3d.lic"), which will come in the form of an attachment to an email. It is an ASCII file with encryption codes that allow it to be used only on the HOSTID. Check the license file to be sure that it contains the Hostname and HOSTID that matches your license server. Now copy the attachment to the "licenses" folder in your FLOW-3D installation directory. Step Eleven—Start the license server (Client/Server and Server installations only). In LMTOOLS, click on the Start/Stop/Reread tab to display the Start Server, Stop Server, and ReRead License File buttons. Click on the Start Server button to start the license server. If the message in the lower left corner reads, “Server Started” then the license server successfully started. If “Server Start Failed” is displayed, select the Stop Server button and then select the Start Server button again. You should see the message, “Server started.” If the license server fails to start, email the file FLOW3D.LOG, located in the “licenses” directory to Flow Science, Inc., at support@flow3d.com or call 505-982-0088. 
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 If you chose Option 1 or 3 in Step Six of New Computer Installations, then, in order to ensure that the license server will be started each time you reboot your computer, you should go to the Config Services tab and make sure that the Start Server at Powerup and Use Services boxes are checked. At this point, you should be ready to run FLOW-3D. 
Linux Installations Installation Overview To run FLOW-3D on a Linux computer, you will need to do the following: 1. Install FLOW-3D from the CD-ROM onto your hard disk using the graphic-based “install” program or alternatively, use the command line-based “install_flow3d” script; 2. Copy your license file into the "licenses" subdirectory and start the license server (if it is not already running); 3. Execute the flow3dvars.sh (or flow3dvars.csh for c-shells) script to set the environment variables required to run FLOW-3D.  Step-by-Step Procedure Step One—Insert the FLOW-3D Installation CD into your CD drive.  Step Two—Open a command prompt and set the current working directory to the CD mount directory and then to the "unix" subdirectory. For example, if the mount directory is "/cdrom," then: 

cd /cdrom/unix NOTE: RHEL 5.0 AND SUSE 11.0 MAY NEED TO MOUNT THE CD AS AN ISO9660-TYPE CD. 



Step Three—There are two installers available. One is graphical (install) and the other is command line approach (install_flow3d). Both installers are in the unix subdirectory: To run the graphical installer, either double-click on the “install” executable from a file explorer or type 
./install_flow3d from the command line. Step Four—The next dialog is the FLOW-3D License Agreement. Please read it carefully. If you agree to all the terms, click the Accept button to signify your agreement. Step Five – This dialog contains a default file location for FLOW-3D. If you wish for FLOW-3D to be installed in another location, modify the path and then click the Next button. Step Six – The next dialog displays the installation types as shown here.  

 NOTE:  IF THIS COMPUTER IS ONLY GOING TO SERVE AS YOUR LICENSE SERVER AND YOU DO NOT INTEND TO RUN FLOW-3D ON IT, THEN YOU CAN CHOOSE TO INSTALL “FLEXNET LICENSE SERVER ONLY.” ON THE OTHER HAND, IF THIS COMPUTER IS ONLY A CLIENT, YOU SHOULD INSTALL ONLY THE FLOW-3D FILES. Click on the Install button and the installation will begin. Once the install completes successfully, proceed to Step Seven. Step Seven—Determine the "HOSTID" information. In order to receive your license file, you must first send your computer’s HOSTIDto Flow Science’s License Administrator. If you are a new user, Flow Science will send you a "Customer License Issuance/Renewal Form" to fill out and return, and on this form you provide the necessary information. 



If you are an existing user, send an email to Flow Science at licenses@flow3d.com stating your name, the registered user’s name, your company name, and your telephone number. Include the file "host_id.txt" as an attachment. If you do not know your computer’s HOSTID, you can find it by running the script "get_host_id" located in the licenses directory. Log on to the license server. Set your working directory to the "licenses" subdirectory in the distribution directory. For example, if the distribution directory is "/home/flow3d," then type: 
cd /home/flow3d/licenses 

./get_host_id Email the resulting output file host_id.txt to licenses@flow3d.com. Step Eight—Install the license file: "flow3d.lic."  Once Flow Science receives your "HOSTID" information, the license administrator will send you an email with your license file as an attachment. The FLOW-3D license file is named "flow3d.lic" and should be copied into the "licenses" subdirectory on your license server. Step Nine—Start the license daemon (Server and client/server installations only) To start the license server, first log onto the computer that will run the license server. Set your current working directory to the "licenses" subdirectory in the distribution directory. The license manager daemon is named lmgrd. To start the license daemon, type: 

./lmgrd -c flow3d.lic -l lmgrd.log & The output will be redirected to the log file "lmgrd.log." Be sure to include the "&" at the end so that the daemon will run in the background. If you examine the contents of the "lmgrd.log," you will find a record of all license transactions. If you encounter any problems with FLOW-3D licensing, the problem can often be determined by examining the contents of this file. NOTE: IF YOU INTEND TO RUN FLOW-3D ON CLIENT COMPUTERS, CONTINUE TO STEP TEN. OTEHRWISE, SKIP TO STEP 12. Step Ten —Install FLOW-3D on client(s). At this point, you have either installed the client/server or just the server components on your license server.  For each installation on a client computer running a supported Linux operating system, run the installation as was done previously in Steps One-Six, but select “FLOW-3D only” under ‘Type of Installation’ in Step Six. Step Eleven —Copy the license file "flow3d.lic" into the client distribution directories. If you installed FLOW-3D on any clients, you will need to copy the FLOW-3D license file (flow3d.lic) from your license server into the "licenses" subdirectory on each of those clients. Step Twelve—Set the FLOW-3D environment variables 
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During installation, a file named flow3dvars.sh (and flow3dvars.csh for cshells) was created in the installation directory. These files contain the appropriate setting for environment variables needed to run FLOW-3D. These variables include: VARIABLE BASH SHELL F3D_HOME export F3D_HOME=”install directory F3D_VERSION export F3D_VERSION=double PATH export PATH=$F3D_HOME/local:$PATH Stacksize ulimit –s unlimited LD_LIBRARY_PATH export LD_LIBRARY_PATH=$F3D_HOME/gui/lib To set the required environment variables for your session, it is advisable to source the flow3dvars.sh script from your .bashrc file if you are using a bash shell. If you are using a c shell, source flow3dvars.csh from your .cshrc file. For example, if you intend to run FLOW-3D from a bash shell, add the line 
source “FLOW-3D installation directory”/flow3dvars.sh to your .bashrc file. If you intend to run FLOW-3D from a c shell, add the line 
source “FLOW-3D installation directory”/flow3dvars.csh 

to your .cshrc file. Step Thirteen —Additional license server considerations. If you wish to install the license file in a directory other than "$F3D_HOME/licenses," you will need to set the environment variable "F3DTKNUX_LICENSE_FILE" to the full path where the license file resides. 
Multiple Installations of FLOW-3D Previous FLOW-3D installations are not removed. If an older version is installed on your computer, it will not be disturbed. However, the environment variables will be changed to the current installation. 
Running Previous Versions  When new versions of FLOW-3D are installed, previous installations are not removed. In order to run a simulation using a previous version of FLOW-3D, you will need to change the value of the environment variable "f3d_home" to the path of the old version and change the “path” environment variable to point to the local directory of the old version. A simple script works well for this. For example on Windows, create a batch file on the desktop that contains the following:  

set f3d_home=c:\flow3d\v9.x.x 

set path=%f3d_home%\local;%path% Alternatively, the system environment variables can be modified. Windows To change the value of "f3d_home" on Windows, right-click on the My Computer icon on your desktop and open Properties. Then, under the Advanced tab, click on the Environment Variables button and choose Edit under User Variables. Change the value of f3d_home to the path of the old version. To complete this process, click on Apply and then reboot your computer.  



Linux There a number of ways to change the value of your FLOW-3D environment variables on Linux. You may modify the flow3dvars.sh file (for Bash shells) or the flow3dvars.csh file (for C shells), or you may set the environment variables directly in your .bashrc or .cshrc files. The flow3dvars.sh and flow3dvars.csh files are located in the {FLOW-3D installation directory}/local directory. Using a text editor, change the value of F3D_HOME to point to the location of the installation you wish to run. For example, if FLOW-3D Version 10.0 is located in /home/user/flow3d/v10.0, change the export statement for F3D_HOME to read 
export F3D_HOME=/home/user/flow3d/v10.0 The PATH variable is set using F3D_HOME and so does not need to be set. You will need to source flow3dvars.sh or flow3dvars.csh in order for the changes to take effect. To source these files, type 
source flow3dvars.sh (Bash shell) or source flow3dvars.csh (C shell) To set the environment variables in the .bashrc or .cshrc files simply add the definitions shown in flow3dvars.sh or flow3dvars.csh so they point to the installation you wish to run. 

Installing a New/Replacement License File If you have been issued a new license file, follow these simple steps to replace your license file. Your FLOW-3D license file (flow3d.lic) is typically sent as an email attachment. The license file is a text file with encryption codes that lock your license to a USB dongle or Ethernet address. The license file contains tokens which authorize the use of the FLOW-3D suite of programs.  There are two steps to installing the license file: copy the license file to the appropriate location on your hard drive, and then start or reread the license file. Step 1—Save the FLOW-3D license file (flow3d.lic) into the “licenses” subdirectory of the FLOW-3D installation directory on the computer acting as the FLOW-3D license server. The license file also needs to be saved to the licenses directory on any computers acting as FLOW-3D clients. Windows - If FLOW-3D is installed in C:\FLOW3D\v10.0, copy flow3d.lic to 
C:\FLOW3D\v10.0\licenses Linux - If FLOW-3D is installed in \home\FLOW3D\v10.0, copy flow3d.lic to 
\home\FLOW3D\v10.0\licenses On FLOW-3D client computers, it is sufficient to set the environment variable F3DTKNUX_LICENSE_FILE to the IP address of the license server rather than copy the license file to each client. On Linux clients, for example, if the IP address of the license server is 192.168.1.14, the following line should be added to the .bashrc (for BASH shells): 
export F3DTKNUX_LICENSE_FILE=@192.168.1.14 Step 2—Start the license server or reread the license file. For new installations, or if the license server has been stopped, follow the instructions for Starting the License Server. If the license server is running, follow the instructions for Rereading the License File. 



Starting the License Server Windows: Double-click the LMTOOLS desktop icon. The LMTOOLS utility will open. In the Service/License File tab, select FLOW-3D FlexNet License Manager. Then change to the Start/Stop/Reread tab. Click the Start Server button. A message indicating “Server Started” should appear in the status bar at the bottom of the LMTOOLS window. Change to the Server Status tab and click the Perform Status Enquiry button. Messages should appear in the window indicating that the server is running. Linux: Open a terminal window and change to the “licenses” directory in the FLOW-3D installation directory. Start the license server by typing: 
./lmgrd –c flow3d.lic –l flow3d.log & Check the status of the server by typing  
./lmutil lmdiag –c flow3d.lic Rereading a License File If the license server is already running, the license file simply needs to be reread.  Windows: Double-click the LMTOOLS desktop icon. The LMTOOLS utility will open. On the Service/License File tab, select FLOW-3D FlexNet Manager. Then change to the Start/Stop/Reread tab. Click the ReRead License File button. A message indicating “Reread Server License File Completed” should appear in the status bar at the bottom of the LMTOOLS window.  Linux: Open a terminal window and change to the “licenses” directory in the FLOW-3D installation directory. Reread the license file by typing 
./lmutil lmreread –c flow3d.lic Check the status of the server by typing  
./lmutil lmdiag –c flow3d.lic 

Licensing Portability License files locked to USB dongles provide the most portability since the dongle can be moved between computers easily. The only change necessary is the SERVER line in the license file. For example, to move a USB dongle from a server named “Kelvin” to a server named “Celsius,” open the flow3d.lic license file in an editor such as Notepad and change the first line to read 
SERVER Celsius FLEXID= “your USB key ID” Then start the license server using the methods described above in Starting the License Server. Moving license files locked to Ethernet addresses require special arrangements with Flow Science. To request a license be moved from an Ethernet address, please email licenses@flow3d.com. 

Uninstalling FLOW-3D Uninstall instructions vary depending on whether you are running FLOW-3D on Windows or on a Linux workstation. 
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Windows Installations Uninstalling FLOW-3D is fairly simple. If the FLOW-3D license server is currently running, it is recommended that it be shut down. Double-click on the LMTOOLS icon on the desktop, open the Start/Stop/Reread tab and click on the Stop button. You should see a message "Server Stopped" under the Status button.  Click on the Config services tab and select the FLOW-3D FLEXm Manager in the Service Name dropdown list. Click the Remove Service button. Next, run the Add/Remove Programs (XP) or Programs and Features applet from the Control Panel. Double-click on FLOW-3D in the Install/Uninstall list. This will remove FLOW-3D from your system. 
Linux Installations Delete the FLOW-3D home directory, e.g., rm –f  /home/flow3d/v9.x.x. If boot-up scripts were modified to start the license server at boot time, then remove those modifications. 
Special Notes for Users with SMP Parallel Licenses  FLOW-3D is capable of running in either multi-processor mode or in single-processor mode. In order to run FLOW-3D in SMP parallel mode (for shared memory workstations—“SMP”), a parallel token, “hydr3p” must be available in your license file. If you have acquired a parallel token from Flow Science, you will have been sent a license file that includes one or more parallel tokens (hydr3dp).  To run the parallel version from the FLOW-3D GUI, select the number of processors to run the simulation or from the Version Options on the Model Setup, General tab. By default, all available processors will be used if a parallel token is available. To set the number of processors for all simulations, set the number of processors under the Preferences, Runtime Defaults menu. In the Number of Processors dropdown, you may choose whether to run in serial mode (1 processor) or in parallel mode (2 or more). The number of processors on your computer will be displayed in the dropdown list under Parallel code if your license file contains parallel tokens. To run in parallel mode, you must decide how many processors you wish to use. Your choices will be limited to the maximum number of processors detected by FLOW-3D when the GUI was started (on Windows the number of processors is limited to 8). NOTE: IF YOU ARE RUNNING FLOW-3D ON A SINGLE-PROCESSOR COMPUTER, YOU WILL ONLY BE ABLE TO SELECT THE 1 PROCESSOR OPTION; THE PARALLEL OPTIONS WILL BE INACTIVE EVEN IF A PARALLEL TOKEN IS AVAILABLE If you have chosen to run in parallel mode, the solver will not run if no parallel token is available when you click Run Solver (for example, if other users have checked out all available parallel tokens). If you wish, you may choose to run FLOW-3D in serial mode if no parallel tokens are available. Make this choice by selecting “Run Serial Code if Parallel Tokens in Use” checkbox. If you do not select this option, your solution will not proceed unless and until a parallel token becomes available. Make your selections and click OK. 
Automatic Updates Users with active maintenance contracts can choose to have FLOW-3D automatically notify them when updates are available. This section reviews the steps required to enable the automatic updates feature. 



Activating Automatic Updates The auto update feature can be activated from the main menu of the FLOW-3D user interface. Select Utilities > Auto Update > Activate. A FLOW-3D Connect settings dialog will appear. 

 Enter the login information you have received for the FLOW-3D Users Site (1 & 2). Only users with a active maintenance agreement with Flow Science are entitled to access to the users site at http://users.flow3d.com, and to updates to FLOW-3D. To request a user ID and password to the Users Site, send an email to licenses@flow3d.com. If you use a proxy server to connect to the internet, be sure to enable the Use proxy check box (3) and enter your proxy server information and port number. If you are using a proxy server, enter the IP address of your proxy server in the fields (4) and the port number that your proxy server uses to connect to the internet (5). The default port number is usually 80. To determine if your settings will allow you to connect to Flow Science's server, click on the Test button (6). Once you have tested your connections, the Check for updates button (7) will become enabled. You can click this button to see if there are any updates. Click the Close button to close the FLOW-3D Connect settings dialog. 
Managing Updates After activating the automatic updates, updates will be checked every time the FLOW-3D GUI is launched. You can also manually check for updates by selecting Auto Update > Check Now from the Utilities menu. If there are no updates, a notification appears as follows: 
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When an update is available, it will be automatically downloaded. You can continue using FLOW-3D during the download. Upon completion, you will be given the option to update your FLOW-3D installation or not: 

 Click Yes to install the update. If any FLOW-3D components are running, you will need to close FLOW-3D. When you accept an update, a progress dialog will appear showing the progress of the download and installation of the patch: 

 If FLOW-3D is currently running, a dialog will appear as shown below, warning that it should be shutdown before installation can proceed. After the installation is finished, the following dialog will appear. Click the view log button to view details of the update. 

 



 

 The first line (1) contains the date and time of when the update was made. The date and time, and the name of the patch that was installed, is given in the second line (2). A list of the files that have been updated as a result of installing the patch is given next (3). The end line contains the patch name again (4).  If a previous update has been downloaded but not installed, the auto updater will first prompt you that an update is available the next time FLOW-3D is launched, and then will check for new updates from the FLOW-3D server. 
Deactivating Automatic Updates The auto update can be deactivated by selecting Auto Update from the Utilities menu in the main menu of the FLOW-3D user interface and selecting Deactivate.  NOTE: WHEN YOU DEACTIVATE THE AUTO UPDATE FEATURE, ALL USER SETTINGS WILL BE DELETED.  



Directory Structure and Environment Variables There are two primary elements in the FLOW-3D installation: the FLOW-3D installation and the FlexNet license server installation. The FlexNet license server is only required for client/server and server installations. All of the components of FLOW-3D itself are installed in the F3D_HOME directory, where F3D_HOME is an environment variable that represents the root directory you have chosen during installation. This directory tree contains all the executables, runscripts, supporting files, and examples. Both single precision and double precision versions are included. Customizable versions are contained under the prehyd (double precision) and prehyd_s (single precision) sub-directories. The components of FlexNet are installed in the licenses sub-directory. The license file, flow3d.lic, and the daemons lmgrd and F3DTKNUX are always required on the license server. 

 
Environment Variables There are a number of environment variables are required for FLOW-3D to run. On Windows, all required environment variables are set by the installation. On Linux, the environment variables are set by sourcing the flow3dvars.sh and flow3dvars.csh files.  The F3D_HOME environment variable represents the installation directory. For example, on Windows (if FLOW-3D is installed in c:\flow3d), it would be: 

F3D_HOME  =  c:\flow3d On Linux, an example might be: 



F3D_HOME = /usr/people/flow3d The F3D_VERSION environment variable, represents the version which is to be run (i.e., double precision, single precision, etc.). F3D_VERSION should be set to one of the following. 
 where,  double (double precision – release version) single (single precision – release version) prehyd (double precision – customized) prehyd_s (single precision – customized) The PATH environment variable must be modified to include the F3D_HOME/local directory. For example, on Windows: 

PATH=%F3D_HOME%\local;%PATH% And, on Linux: 
PATH=$F3D_HOME/local:$PATH The F3DTKNUX_LICENSE_FILE environment variable points to the location of the FLOW-3D license file. On the server, this environment variable must point to the actual license file. For example, if the license file is located on a Windows computer in c:\flow3d\licenses,  
F3DTKNUX_LICENSE_FILE=C:\flow3d\licenses On client computers, it is sufficient to simply point to the server by name or IP address. For example, if the license server is named Celsius, then 
F3DTKNUX_LICENSE_FILE=@Celsius enables clients to check out licenses from the server Celsius. 

Hardware and Software Requirements FLOW-3D can be installed and run on numerous operating systems.  
Operating Systems and Compilers 
Linux PROCESSOR: OPERATING SYSTEM FLOW-3D VERSIONS COMPILERS: (required only if customizing) x86-32 processors:  RedHat Enterprise 4.0 10.0 Serial and SMP Intel Fortran 11 



and 5.0 and SUSE 10.0 and 11.0 (32-bit) Parallel x86-64 processors: Xeons and Opterons RedHat Enterprise 4.0 and 5.0 and SUSE 10.0 and 11.0 (64-bit) 10.0 Serial and SMP Parallel Intel Fortran 11 
Windows PROCESSOR: OPERATING SYSTEM FLOW-3D VERSIONS COMPILERS: (required only if customizing) x86-32 processors:  Windows XP 32-bit (all versions) Windows Server 2003 32-bit Vista 32-bit (all versions) Windows 7 32-bit (all versions) 

10.0 Serial and SMP Parallel Intel Fortran 11 and Visual Studio 2008 Professional Edition 
x86-64 processors:  Windows XP Pro (64-bit) Windows Server 2003 and 2008(64-bit) Windows Vista 64-bit (all versions) Windows 7 (all versions) 

10.0 Serial and SMP Parallel Intel Fortran 11 and Visual Studio 2008 Professional Edition 
Minimum Hardware Requirements The minimum hardware requirements necessary to run FLOW-3D depend to a great degree on the type of simulation. For large metal casting simulations or medium sized hydraulics simulations, a 2.4 GHz or faster Core 2 or Opteron processor, 4 GB of memory, and a 64-bit operating system is recommended. This configuration would allow simulations with approximately 8 million cells. Activating additional physical models such as turbulence, heat transfer, scalars, etc. reduces maximum simulation size from this number. Please see the FLOW-3D website (http://www.flow3d.com/flow3d/flow3d_req.html) for the latest recommendations.  
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Chapter 2 - Tutorial 
Tutorial Overview This chapter is intended to familiarize new users with each component of the FLOW-3D Graphical User Interface (GUI) and to walk through the setup and running of various simulations. Following this overview is an explanation of five tabs on the GUI that are used for controls of various operations within the software: Navigator, Model Setup, Simulate, Analyze, and Display. After that section follows a discussion of how to preprocess and postprocess simulations. At the end of this chapter, three application-specific example problems are given, to walk the user through problem setup and results visualization. The problems in this chapter are intended to cover the basics of using FLOW-3D. New users are advised to work through all of the problems and the variations. The tutorial problems were chosen to illustrate a variety of topics and address a number of questions that might be encountered. This tutorial should be used while you’re sitting at your computer running FLOW-3D. 
Philosophy for Using CFD Computational Fluid Dynamics (CFD) is a method of simulating a flow process in which standard flow equations such as the Navier-Stokes and continuity equation are discretized and solved for each computational cell. Using CFD software is in many ways similar to setting up an experiment. If the experiment is not set up correctly to simulate a real-life situation, then the results will not reflect the real-life situation. In the same way, if the numerical model does not accurately represent the real-life situation, then the results will not reflect the real-life situation. The user must decide what things are important and how they should be represented. It is essential to ask a series of questions, including: 
� What do I want to learn from the calculation? 
� What is the scale and how should the mesh be designed to capture important phenomena?  
� What kinds of boundary conditions best represent the actual physical situation?  
� What kinds of fluids should be used? 
� What fluid properties are important for this problem?  
� What other physical phenomena are important? 
� What should the initial fluid state be? 
� What system of units should be used?  It is important to ensure that the problem being modeled represents the actual physical situation as closely as possible. We recommend that users try to break down their complex simulation efforts into digestible pieces. Start with a relatively simple, easily understandable model of your process and work it through before moving on to add more complicating physical effects on an incremental basis. Simple hand calculations (Bernoulli's equation, energy balance, wave speed propagation, boundary layer growth, etc.) can give the user confidence that the model is set up correctly and that the program is running accurately. 



 

 

FLOW-3D Simulation Filenames The FLOW-3D input or "simulation" file is generally called prepin."ext" where "ext" can be any character string which allows you to easily identify the input file. The prepin file contains all of the information necessary to describe a unique FLOW-3D problem. If you are curious about the contents of the prepin file, see Input Variable Summary chapter, which contains a general description of the prepin file and its variables. Most FLOW-3D variables have default values, so the number of variables that need to be set by the user to describe a problem are often minimal. The default name for the simulation input file is prepin.inp. When the prepin file has this default name, all output files will have the suffix ".dat.” When you give the prepin file an extension different than “.inp,” all of the output files will have the same extension as the input file, allowing you to keep track of which output files and input file go together.  The main output file that contains solution results that are saved at various times during the simulation is called flsgrf. Users should be careful not to delete prepin and flsgrf files. Plots can be generated from any flsgrf file at any time during or after a simulation.  For a restart simulation, the flsgrf file from a previous run must be available for data initialization in the solver.  NOTE: STARTING FROM A PREPIN FILE SIMILAR TO THE PROBLEM YOU INTEND TO MODEL CAN GREATLY SIMPLIFY SETUP AND IS RECOMMENDED WHENEVER POSSIBLE. JUST OPEN AN EXISTING INPUT FILE AND THEN SAVE IT TO ANOTHER DIRECTORY AND START WORKING. The prepin file for a simulation can be recovered from its flsgrf file. The prepin file is written at the end of the file g_flsgrf which is created after the flsgrf is processed by the postprocessor or opened in the GUI’s Analyze tab. 
Running FLOW-3D There are two ways to run FLOW-3D: (1) from the graphical user interface (GUI) and (2) from the command line (or batch mode). Running simulations from the command line may be useful during debugging and in other special cases. See also: Customized Postprocessing. A brief, high-level introduction to running FLOW-3D is given here. A detailed description of the GUI is provided in the User Interface chapter. 
Running FLOW-3D from the Graphical User Interface This section shows how to use the GUI to open a simulation file and execute FLOW-3D. To start the GUI on a Windows machine, click on the FLOW-3D icon on the desktop or find FLOW-3D in the program listing in the Start menu. To start the GUI on a Linux machine, type, “flow3d” at the command prompt and hit the enter key. The picture below shows the opening screen of FLOW-3D. 



 

 

 
GUI Overview All programs are integrated into a single graphical user interface, or GUI. At the very top of the GUI is a Menu Bar which includes the following menu headings: File, Diagnostics, Preference, Physics, Utilities, Simulate, Materials and Help. Below the menu bar is a row of tabs: Navigator, Model Setup, Simulation, Analyze, and Display. Each of these tabs corresponds to specific steps in a FLOW-3D simulation.  When FLOW-3D is opened, the Navigator tab is presented. This is where the use can create, save, copy and delete simulations. Simulations can be grouped into Workspaces based on their relationship to each other or by other criteria. For example, simulations related to the same design project can be organized into one workspace for ease of their setup. All simulations in a workspace can be run sequentially at a click of the mouse. When a simulation is selected in Navigator, the Model Setup tab becomes active. The Model Setup tab has another row of tabs corresponding to various input sections for a FLOW-3D simulation. All of these menu items and all of the functionalities behind each tab will be discussed in more detail in the User Interface chapter, Model Setup. 



 

 

Adding Simulations to a Workspace When FLOW-3D is opened, a default workspace is automatically created. To start a simulation from scratch, go to File menu and select Add New Simulation. If the user is going to work with an existing simulation, then select Add Existing Simulation instead from the following drop-down box: 

 A standard Open Simulation File dialog box appears: 



 

 

 New or existing simulations can be added to a highlighted workspace containing other simulation using the File menu. A simulation can be removed from the workspace by selecting Remove Simulation from the File menu or by right-clicking on the simulation in Navigator and selecting Remove Simulation from the pop-up menu or by selecting the simulation in Navigator and pressing the Delete key. NOTE: ALTHOUGH IT IS POSSIBLE TO LOCATE AND OPEN FILES LOCATED ON OTHER MACHINES ON THE NETWORK, THE USER WILL NOT BE ABLE TO RUN THEM WITH FLOW-3D ON THEIR OWN MACHINE. TO RUN A SIMULATION THAT HAS BEEN SET UP ON ANOTHER MACHINE, THE USER MUST FIRST COPY THE INPUT FILE AND ANY ASSOCIATED GEOMETRY FILES TO THE HARD DISK. 
Setting Up a New Simulation or Modifying an Existing Simulation Whether starting a new simulation or modifying an existing one, all of the selections or entries the user needs to make are executed in the Model Setup tab. The selections made in the Model Setup tab are recorded in an "input file," which drives the FLOW-3D solver. 
Running a Simulation The menu selections for running simulations are located in the Simulate menu at the top of the GUI window: 



 

 

 These commands are used to execute different aspects of FLOW-3D.  Clicking Preprocess Simulation runs the preprocessor in the preview mode. It verifies the problem specifications, creates the grid and geometry, and produces both printed and plotted output. Running preprocessor helps to ensure that the problem is set up correctly before the solver is run, which can save time. The user can examine the preprocessor output files in the Diagnostics menu and visualize the geometry and initial conditions by loading the prpgrf file into the Analyze tab. Click on Run Simulation to execute all necessary steps for a simulation. When Run Simulation is clicked, the GUI switches to the Simulation tab. The Simulation tab provides information about the progress of the preprocessor and solver. It also allows the user to monitor and interact with the solver. The FLOW-3D solver monitor in the Simulation tab is shown below. The Terminate button will shut down either the preprocessor or solver. When the solver is terminated, it will write a final data dump to the output file before shutting down. Progress Bar, Runtime Messages, Runtime Plots The status of a FLOW-3D simulation, as well as any warning or error messages generated, will appear in the Runtime Messages window (the lower portion of the Simulation tab below). For a complete description of the items on the Simulation tab, see the User Interface chapter, Simulate section. 



 

 

 
Viewing Results The results of a newly-run or previously-run simulation can be viewed by clicking on the Analyze tab. The FLOW-3D Results dialog box will appear:  



 

 

 Here the user can choose to view the results of plots generated automatically by FLOW-3D (select the Existing radio button) or create new plots (select the Custom radio button).  
Viewing Existing Plots When the Existing radio button is selected in the FLOW-3D Results dialog box, two types of files will be shown in the data file path box, if they exist. Files with the name "prpplt.*" contain plots created by the preprocessor, while files with the name "flsplt.*" contain plots automatically created by the postprocessor as well as plots pre-specified in the input file. After a file is selected, click OK (or double-click on the file name). This will cause the Display tab to open automatically.  A list of available plots appears at the right. A particular plot may be viewed by clicking on the name of that plot in the list. The function of the buttons and menus is described in the User Interface chapter. 



 

 

 
Viewing Custom Plots When the Custom radio button is selected in the FLOW-3D Results dialog box, files with the name "flsgrf.*" will be shown in the data file path box. Each of these files contains complete results of a simulation. After a file is selected, click OK (or double-click on the file name). The Analyze tab now appears with all its own tabs populated with the data from the simulation. This panel allows the user to select what types of plots or output are desired.  



 

 

 See the User Interface chapter for a description of the various plotting options. After the plot options have been selected, click Render and the plot will appear in the Display tab (for 1-D, 2-D or 3-D plots) or in a text box (for other results options). 
Running Restarts A restart is a continuation from a previous FLOW-3D simulation. A user might choose to run a restart to continue a simulation or to change certain parameters of the problem, such as the mesh, physical models, or properties. The restart simulation uses the solution data at a certain time taken from a completed simulation. The available times are shown as “restart and spatial …” data edits in the solver messages file hd3msg.* of that run. To create a restart simulation from an existing simulation, first create a copy of the original simulation to restart from using Add Restart Simulation in the File menu on the Navigator tab (or by right-clicking on the simulation in Navigator). Then, open the Model Setup > General tab > Restart dialog to define the restart parameters (see the image below). To perform a restart, the flsgrf file from the previous simulation must be available to extract the solution data from. The name and location of this file is also defined in the Restart window. To run the problem, click on Simulate.  



 

 

 
Running an Example Problem In this exercise, you will learn how to create a new workspace, add an existing project file from the Examples directory. The example problem represents flow over a sharp-crested weir. You will learn how to view the setup, run the simulation, and then visualize the simulation results. Finally you will learn to create a simulation copy and perform a restart. 
Create a Workspace and Add an Example Simulation 1. Launch FLOW-3D by double-clicking the FLOW-3D icon on your desktop. 2. On the Navigator tab, create a new workspace by selecting File > New Workspace.  



 

 

3. Enter a name for your workspace. Type in “Hydraulics Examples.” It is recommended that the Create subdirectory using workspace name checkbox be selected so that all the files associated with this project are in their own directory. This makes file management easier. 

 4. Add an existing project file from the Examples directory to this workspace by selecting File > Add Example from the menu bar. The dialog below will appear. Select Flow Over a Weir from the FLOW-3D Examples list. Select the Open button to import the project and click OK to accept the default creation options. 



 

 

 
Mouse Modes and Display Functions in the Meshing & Geometry Mouse Modes: Select Model Setup > Meshing & Geometry tab. Familiarize yourself with the three functions of the mouse buttons: 

 Left-button – Rotate. Click and hold the left-mouse button and move the mouse in the Meshing_Geometry window. The model will rotate accordingly. 
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Middle-button – Zoom. Click and hold the middle-mouse button while moving the mouse vertically in the window. Moving the mouse toward the top of the screen zooms in and moving the mouse downward zooms out. Right-button – Move. Click and hold the right-mouse button and move the mouse in the window. The model will move with the mouse. Global Transparency: The Transparency slider in the toolbar controls the transparency of ALL objects in the Meshing & Geometry display window. 
 Move the slider from left to right and you will observe that the weir structure becomes more transparent as you continue to move the slider to the right. Later you will learn how to select transparency for individual objects in the display. View Model Along Axes: Due to the complexity of three dimensional simulations, it is often necessary to view objects in 2-D. This can be accomplished by selecting one of the axes from the toolbar:  Selecting the +X icon switches the view so that the object is viewed from +X ∞. Clicking the +X icon again changes the view to –X ∞. Mesh Viewing Options: The full mesh (with gridlines) is displayed by default. The level of mesh details displayed can be selected from the Mesh menu item. The Show option is checked so the full mesh is displayed. 

 To display only the outline of the mesh, select Mesh > View Mode > Outline. 

Increasing transparency 



 

 

 Left: Selecting Gridlines displays mesh box and cells. Right: Selecting Outline displays extents only. 
Assessing Mesh Resolution One of the most important aspects of simulation setup is choosing an appropriate computational mesh. If the mesh is too coarse, portions of the geometry may not be resolved and the simulation will not represent the actual problem. If the mesh is too fine, the runtime may be unnecessarily long. The goal of mesh setup is to use just enough cells to resolve the geometry and the flow features of interest. There are two ways of judging how well a computational mesh resolves the geometry. One way is to run the preprocessor but this can be time-consuming. A quicker way is to FAVORize the geometry. FAVORize embeds the geometry in the current computational mesh and displays the result in the Display window. The resulting geometry is called the FAVORized geometry. To FAVORize the geometry, click the  icon in the Meshing & Geometry window toolbar. The FAVOR dialog will appear. To display the solid geometry, select the Solid radio button. 



 

 

 Right: Select Solid to display the solid geometry. Left: After clicking Render, the solid geometry is displayed. The image above on the right shows the weir structure. The sharp crest of the weir is visible and it appears to be adequately resolved. In later exercises you will use the FAVORize function to evaluate mesh resolution.  Select Return to Model Building to close the FAVORized view. 
Preprocess the Simulation Portions of the geometry may be hidden from view in simulations with complex geometries and may require more information than what is provided by FAVORize in order to be assessed. For example, if there were some internal structure within the weir, 2-D plots would be required to assess mesh resolution. Preprocessing a simulation generates more information than FAVORize and allows a user to determine essential information such as adequacy of mesh resolution. Select Simulate > Preprocess Simulation from the menu bar.  



 

 

The interface will now switch to the Simulation tab and the preprocessor will run. It should complete within a few seconds. A message will appear in the message box in the lower portion of the Simulation window indicating the preprocessor is done. The next step is to display the preprocessor results. 
Display the Preprocessed Results The preprocessor generates a results file named prpgrf.”project extension” In this case, the project extension is Flow Over A Weir. To display the results contained in the prpgrf.dat file, select the Analyze tab > Open Results File button > Custom radio button and then select the prpgrf.dat from the dialog box. 

 The Analyze panel will now be displayed. Although the full capabilities (Probe, 1-D, 2-D, and 3-D) of the Analyze panel are available, typically only 2-D and 3-D plots are necessary to validate the model setup. The 3-D tab will be displayed initially when the Analyze tab is selected. First, you will generate the same display that was generated by the FAVORize function. On the 3-D tab, select Complement of Volume Fraction in the Iso-surface dropdown and select none from the Color Variable dropdown. 
 



 

 

Select Render. You will see the same image in the Display window as you saw in the FAVORize display. 

 A 3-D display of Complement of Volume Fraction shows the same image as FAVORize. The next step will be to generate 2-D plots with the mesh overlayed. Select the 2-D sub-tab on the Analyze tab. The object will be to generate a 2-D display of pressure in the X-Z plane at Y=0. To do this, choose the X-Z radio button and move both Y-direction limits sliders to the left-most position (Y=0.25). Select the Mesh checkbox to overlay the mesh on the results. 



 

 

 Click Render to generate the graphics. You will see the image shown below. 

 The display provides information about the initial state of the simulation. The sharp crest of the weir can be seen indicating the mesh resolution is probably adequate for capturing the geometry features of interest. The initial fluid configuration, including the initial velocity, is shown allowing the user to determine the correctness of the setup before running the simulation. If other flow quantities such as density or scalar concentration had been initialized, they could be checked here as well by selecting them in the Contour Variable dropdown list. Before running the simulation, you need to: 
� Specify the Simulation Units as CGS 
� Request Hydraulic Data  
� Specify Selected Data Output 1. Specify the Simulation Units: Select the Model Setup > General tab. On the right-hand side of the General tab you will see a group box named Units. Select CGS from the dropdown box. 



 

 

 2. Request Hydraulic Data: Select the Model Setup > Output tab. In the Additional Output section, select the checkbox for Hydraulic Data as shown below. This will cause the fluid elevation, fluid depth, Froude number, and depth-averaged velocity to be computed and stored in the results file. Additional Output data will not be computed unless it is selected on the Output tab before running the simulation. 

 3. Specify Selected Data Output: Selected data represents data that is selected by the user and is output more frequently than Restart and Spatial data. Selected data is output at default intervals of 1/100th of the simulation time whereas Restart and Spatial data is output at default intervals of 1/10th of the simulation time. Selected data is useful for creating smooth animations without creating excessively large output files. 4. On the Output tab, select the following data: Fluid Fraction, Fluid Velocities, Hydraulic data, and Pressure as shown below. 
 



 

 

Selected data output should be chosen with care since only the specified variables will be written to the results file during the simulation. If you determine later that you need a variable which was not specified in the Selected Data list, the simulation will need to be re-run with this output specified. 
Run the Simulation Start the simulation by selecting Run Simulation from the Simulate menu bar. The simulation must be saved before running, so select Yes when prompted to save. The view in the interface will automatically switch to the Simulation tab as shown below. 

 The Simulation tab can be thought of as a dashboard for the simulation. The efficiency and accuracy of the simulation are indicated by the runtime diagnostics plots and the runtime messages. Familiarize yourself with the various runtime diagnostic plots available in the list at the left side of the tab. Stability limit vs dt: Provides a comparison of the time step stability limit (largest time step allowable) and dt, the actual time step being used. Ideally the time step dt would be the same as the stability limit but it may be smaller due to various factors such as excessive pressure iteration and splashing. Time-step size: the solver time step Epsi & max residual: Epsi represents the pressure iteration convergence criteria Epsi = ∇ •Ū. The max residual represents the actual value of ∇ ∇ ∇  ∇ •Ū after the pressure iteration has either converged or the iteration count has reached the maximum allowable value. If a pressure iteration failure occurs, the max residual plot will be above the Epsi plot. Pressure iteration count: the number of pressure iterations. Low values indicate good pressure convergence. 



 

 

Conv. volume error (% lost): Represents the amount of fluid gained (negative value) or lost (positive value) due to advection errors. Typically much less than 1%, values larger than 1%-3% may indicate problems with the simulation. Volume of fluid 1: the fluid volume within the domain over time. Indicates if the domain is filling or draining, and can be used to estimate if a simulation has reached steady state. Fluid 1 surface area: the free-surface area of Fluid #1 is the domain. Scattered values indicate sloshing, waves, droplets, or filling/draining. Mean kinetic energy: Provides a measure of the average mean kinetic energy of flow. This is a good indicator of the steadiness of the flow. Particle count: the number of Lagrangian particles in the domain, not used in this example. 
Analyze the Results The results of a simulation can be viewed while the simulation is running or after the simulation is complete. It is often useful to visualize the results while a simulation is running to ensure that it is running correctly. To visualize the results, click on the Analyze tab. A message may appear indicating that the prpgrf file no longer exists. The prpgrf file, which was generated during the Preprocess phase, is deleted when the simulation is run. Select Continue and a file selector dialog will be presented. Select the flsgrf file from the file selector dialog and click OK. 



 

 

 The results of a FLOW-3D simulation are stored in a file named flsgrf.* The Analyze tab will now be displayed. There a number of ways in which to visualize the results of a simulation. The available plot types are: Custom: Can be used to write an output file using the output codes in the Customized Postprocessing section of this manual. Probe: Displays output data for individual computational cells, boundaries, components, and domain-wide parameters. 1-D: Cell data can be viewed along a line of cells in the X, Y, or Z direction. Plot limits can be applied both spatially and in time. 2-D: Cell data can be viewed in X-Y, Y-Z, or X-Z planes. Plot limits can be applied both spatially and in time. Velocity vectors and particles can be added. 3-D: Surface plots of both fluid and solid can be generated and colored by cell data. Additional information such as velocity vectors, particles (if present), and streamlines can be added. Plot limits can be applied both spatially and in time. Text Output: Restart, Selected, and Solidification data can be written to text files. 



 

 

Neutral File: Restart and Selected Data can be output for user-specified interpolation points. Once a plot type has been selected, the next step is to choose the data source. There are six sources of data in FLOW-3D: Restart: All flow variables. Output frequency = 1/10th of the simulation time. Selected: Only user selected flow variables. Output frequency = 1/100th of the simulation time. General History: Time-dependent data such as time step and kinetic energy. Mesh Dependent: Boundary quantities such as flow rate at right boundary and boundary conditions. Solidification: Only available if the solidification model is active. FSI TSE: Additional output options for deformable solids. Examples of some of the available plot types will be generated in the next section. 
3-D Graphics and Animation Select the Analyze > 3-D tab. There are three primary choices which typically need to be made on the Analyze tab. Iso-surface type: Fraction of fluid will show the fluid surface. 

 Color variable: The selection here will determine which variable is used to color the fluid surface. 
 Iso-surface options: Solid Volume will display the solid components along with the fluid. 

 



 

 

Click the Render button to generate a series of 11 plots between t = 0.0 and 1.25 seconds which show the weir structure along with fluid surfaces colored by pressure. The images appear on the Display tab and should look like the following: 

 Right: Fluid surface colored by pressure at t=0. Left: Fluid surface colored by pressure at t=1.25s. The default data source for all plots is Restart data. To access the Selected data which was specified earlier in the exercise, select the Analyze > 3-D tab and choose the Selected data radio button from the Data Source group. 

 Notice that both sliders in the Time Frame selector are at the right now so that only the last time frame will be generated. This is done automatically by the interface when Selected data is chosen since there are so many (101) time frames available.  Move the left-hand slider to Time Frame Min=0 to render all available time frames.  



 

 

Now click the Render button. Within a few seconds the view will switch to the Display window and 101 plots will be listed in the Available Time Frames list. Click Next repeatedly to step between the time frames. Since the simulation was set up with a symmetry plane down the center of the weir, only half of the weir structure is being simulated and displayed. For presentation purposes, it is often more useful to show both halves of a symmetric model. Go back to the Analyze > 3-D tab and select the Open Symmetry Boundaries checkbox, as shown below. 
 Click Render. The fluid surface should now appear open at the symmetry boundary. To mirror the results across the Y=0 plane, select Tools from the submenu and then select Symmetry. Select the Y direction checkbox in the dialog which appears, then Apply and Close. 
 The display will now show a full weir structure as shown below. 

 



 

 

The next step will be to create an animation of the 3-D fluid surface. Animations are movies created from the frames in the Available Time Frames list. When the frames are played back in an animation, the viewer has the illusion that the motion is continuous rather than individual frames. To improve the visual effect of animations, it is recommended that a common color scale be applied to all frames. This can be done by selecting the Global radio buttons in the Contour Limits group box on the Analyze > 3-D tab. 
 Click Render. Again, select the Y direction checkbox on the Display menu > Tools menu > Symmetry dialog to mirror the results across the Y=0 plane. To create the animation, select Tools > Animation > Rubberband Capture as shown below. 

 Click and hold the left mouse button while dragging to select the portion of the screen to animate. A selection box will appear around the region you selected. The selected region can be adjusted by entering values in the X, Y, Width, and Height boxes above the display window. Click Update to apply the typed changes to the selection.  Select the Capture button. A dialog will appear to start the animation. The default name for animations is out.avi. A more descriptive name is recommended as shown below. The default frame rate is 10 frames per second. This may be too fast for some simulations, so enter 5 instead and press OK. 



 

 

 Each time frame will be rendered to the Display window and bitmap files will be written in the simulation directory. Once this process is complete, the following dialog will appear. 
 Click the OK button to begin the next step of the process. The default compression for animations is uncompressed. This is not recommended for most animations since the file size can be quite large. It is recommended that a simple compressor such as Microsoft Video 1 or Cinepak be selected. Unselect the Data Rate checkbox so that the quality of animations is not limited by the data rate. 

 Click OK to begin the compression process. When the compression is complete, the following dialog will appear. 
 



 

 

To play the animation, open Windows Explorer and browse to the directory where the simulation is located. Remember, you can determine the location of the simulation file on the Navigator tab. You can play the animation by double clicking on it. 
2-D Graphics Switch back to the Analyze tab and select the 2-D tab. The most useful plane to view results for this simulation is the X-Z plane at Y=0.0. Choose the X-Z plane radio button and drag both Y limit sliders to Y=0.25 (the cell center coordinate closest to Y=0.0). The default selection for contour variable is pressure. The geometry will be displayed automatically with all 2-D plots. Click Render to generate a time sequence of 2-D plots of pressure in the Y=0 plane. Graphics similar to following will appear. 

 Left: T = 0.0 seconds; middle: T = 0.125 seconds; and right: T = 1.25 seconds Familiarize yourself with the various formatting options available under the Format button. Select the   button in the upper right-hand corner of the Display screen.  The following dialog will appear: 



 

 

 Experiment with the various options such as changing line colors, vector lengths and arrowhead sizes. If there is a set of options you prefer for all plots, you may save them by selecting the Save button. 
1-D Graphics Click on the Analyze tab and then select the 1-D tab. The types of graphics available on the tab are plots of spatial quantities such as pressure, fluid depth, fluid elevation, and velocity along a particular direction at the available times. Pick Selected as the Data Source and select free surface elevation as the Data Variable. 



 

 

 Selected data available for 1-D graphics. NOTE: HYDRAULIC DATA IS AVAILABLE SINCE IT WAS SELECTED ON THE OUTPUT TAB. 
 The flow direction in this simulation is primarily parallel to the x-axis. Create a plot of fluid elevation along the X-direction near the Y=0 plane. By default the entire X range will be displayed. You may move the sliders in the X-direction if you wish to limit the extents of the plot. Move the Y-direction slider to 0.75 so that the second cell in the Y-direction is displayed. The location of the Z-direction slider will not matter since this the fluid elevation is the same in all z-cells in a given x,y location. 

 



 

 

Click Render. A series plots from t=0.0 to t=1.25s will be listed in the plot list on the Display tab. There are a number of modes in which to view these plots. The default mode is the Single mode and is shown in the dropdown box below the Format button. 
 To compare plots of fluid surface elevation at various times, select the Overlay mode from the dropdown box. The example below shows an overlay of plots #1 (t=0.0), #13 (t=0.15s) and #101 (t=1.25 s). 

 To save this plot to a bitmap or Postscript file, select the Output button. Check the Plots on Screen checkbox to capture the overlay plot. Select the Write button to create the image file and No to use the default resolution. The resulting image file will be located in the simulation directory and will be named plots_on_screen.bmp. 



 

 

 
Time History Plots Select the Probe tab. Time history plots are created on the Probe tab. Time history plots represent a display of a particular time-dependent quantity vs. time. There are three types of time-dependent data in FLOW-3D, which are selected from the Data Source group. Spatial data: Can be selected from either Restart or Selected data sources and varies in the x, y, and z directions as well as time. General history data: Represents quantities which vary only with time. Typical quantities are mean kinetic energy, time step, and convective volume error. Mesh-dependent data: Represents time-dependent quantities computed at mesh boundaries. Typical quantities are flow rate at a boundary and specified fluid height at a boundary. Values can be integrated with respect to time, differentiated with respect to time, or consolidated with a moving average (in time). Create a time history plot of estimated mean kinetic energy. Select the General History radio button under Data Source and then select Estimated Mean Kinetic Energy from the list. 



 

 

 Select Render to generate a graphical output of the data. Text data can be written to a file by selecting Text in the Output Form group, selecting Render and then the Save As button.  
 

Text Output Text output is very similar the data which can be output from the Probe sub-tab except that 3-D blocks of data can be output whereas Probe data is limited to data at a single point or a global quantity such as total fluid volume. Only spatial data (Restart or Selected) can be output on the Text Output sub-tab. The default spatial extents are set to the entire domain. Up to 10 quantities can be output at a time. 
Modify a Copy of a Simulation This next example problem shows the process of copying the simulation just run and adding an additional downstream structure. 
Add Simulation Copy On the Navigator tab, highlight the simulation “Flow Over a Weir” in the workspace “Hydraulics Examples.” Right click on the simulation and choose the option Add Simulation Copy in the pop-up menu. 



 

 

 Enter the name “Weir Structure” for simulation in the next dialog as shown below, and click OK. It is recommended that the “Create subdirectory using simulation name” and “Default to Workspace directory” checkboxes be selected so that the simulation copy has its own directory and is under the same workspace as the original simulation “Flow Over a Weir,” which helps simulations organized. 



 

 

 The simulation copy has now been imported into the workspace “Hydraulics Examples.”  
Add Additional Elliptical Downstream Structure Select the Model Setup > Meshing & Geometry tab. The weir is exactly the same as in the original simulation. Click the menu bar heading Subcomponent and select the option Cylinder. This opens the Cylinder subcomponent dialog box. 



 

 

 Select New Component 2. Enter the dimensions of the cylinder: Radius=2.0, Z low=-20.0 and Z high=20.0, as shown in the figure below. 

 Click Transform to open the Transformation dialog box as shown below. By default, the cylinder object is created parallel to the z-axis. 



 

 

 Put 90° in the X Rotate box so that the cylinder becomes parallel to the Y axis, 10 in the X Translate box so that the cylinder is centered downstream at x=10 cm, and then 2.5 in the X Magnification box so that the cylinder is stretched in the X direction and becomes elliptical. Click OK to apply the transformation to the cylinder object, click OK again to accept the subcomponent and click OK one more time in the next Add component dialog to accept the structure as a standard solid. A new elliptical structure should now be created at the downstream of the weir and displayed as below. Save the simulation. 

 
Run the Simulation Start the simulation by selecting Simulation > Run Simulation from the menu bar. The interface view will automatically switch to the Simulation tab. 



 

 

Analyze the Old and New Results Simultaneously Dual results displays help users compare the simulations of two similar cases by plotting the results of both cases in the same display window. Assume the pressure contour at all restart time frames from the original simulation “weir” has already been rendered with the display option “Display 1” and the component iso-surface overlay option “Solid volume” chosen. Go to the Analyze > 3-D tab and click the Open Results File button. Select the flsgrf file from the FLOW-3D Results dialog. 

 Set the display option to Display 2 and the component iso-surface overlay option to Solid volume. Slide the time-frame min slider all the way to the left end so that it is set to t=0.0s. Click Render. 



 

 

 The view in the interface will automatically switch to the Display tab. Only the pressure contour from the simulation copy will now be shown in the graphic window, as Display 2, and the one from the original simulation is hidden. Repeat the process on the Analyze tab, but this time load the original flsgrf.Flow Over A Weir output and Render it as Display 1. 

 



 

 

Click the toolbar button Side by side display to compare the two simulations. 

 In this case, the most obvious consequence of the change is that more water is trapped downstream next to the weir, due to the existence of the elliptical obstruction. 
Perform a Restart Simulation Simulations that start from the results of a previous simulation are often useful. Examples include if the original simulation terminated before it was able to reach the finish time due to hardware failure and if a simulation needs to have a different boundary condition at a certain time in order to mimic the real situation. A third example of when a restart simulation is useful is when a detailed (high-resolution) solution of a steady-state problem is required. After the original simulation reaches steady state, a restart simulation is created with a finer mesh. This gives the required detail while saving on runtime to reach steady state. The example below demonstrates the use of a restart simulation to mimic the change of the boundary condition after a certain time. It is based on the example simulation “Flow Over A Weir” and has a different type of upstream boundary to mimic the gate closing after t=1.25s. 
Add Restart Simulation On the Navigator tab, highlight the simulation “Flow Over A Weir” in the workspace “Hydraulics Examples.” Right click on the simulation and choose the option “Add Restart Simulation” in the pop-up menu. 



 

 

 Name the simulation “Weir Gate.” Select the new simulation to begin setting up the problem. On Model Setup > General change the Finish Time to 2.5 seconds. 

 Click on the Restart button, which is checked to indicate that the initial configuration of the fluid will come from a previous results file. This opens the Restart options dialog box, where the restart source file and restart time are set. Click OK to close the dialog box. 



 

 

 
Change Upstream Boundary Condition Click the Model Setup > Meshing & Geometry tab and open the Mesh – Cartesian > Mesh Block 1 > Boundaries tree. Previously a pressure boundary with a fluid height was applied, and it needs to be changed to a wall boundary as an upstream gate closes after t=1.25s. Click the button next to X Min. This opens the X Min Boundary dialog box. Switch to the Wall boundary type and click OK to close the dialog box. 



 

 

 
Run the Simulation Run the simulation as before. Click the Save button when prompted. 
Concatenate and Analyze the Results This section explains the steps to concatenate the two results files to create continuous animations of both 2-D and 3-D displays. 
Concatenate 2-D Graphics Go to the Analyze > 2-D tab and click the Open results file button. Select the flsgrf file from the FLOW-3D Results dialog. Switch to X-Z plane view and slide both Y Limit sliders to the left. Click Render to plot the pressure contours in the Y=0.25 plane. 



 

 

 The pressure contours at all available restart time frames will be listed on the Display tab. 

 Click the Files button to open the File options dialog box. 



 

 

 Click the Create button in the dialog box and give the name “gate.plt” in the next Create plot file dialog box. Click the Write button to write the list of plots to the file “gate.plt” in the simulation directory, and click Quit Create and then Close to close the dialog boxes. 

 Go back to the Analyze > 2-D tab and click the Open Results File button. Browse to the directory where the original simulation “Flow Over A Weir” is stored and select the original flsgrf.Flow_Over_A_Weir file in the FLOW-3D Results dialog. Again, switch to X-Z plane view and select only the Y=0.25 plane. Click Render to plot the pressure contours.  Now click the Files button and then Open (append) in the next File options dialog box. Browse to the directory where the restart simulation is stored and Open the file “gate.plt.” 



 

 

 Click Close to close the File options dialog box. The Display should now have the list of all available restart time frames from 0.0s to 2.5s, which includes the transitional moment t=1.25s when the upstream gate is closed. 



 

 

 
Concatenate 3-D Graphics To concatenate the results files for 3-D display purposes, it is required that both files are stored in the same directory. Copy the restart simulation results file flsgrf.Weir_Gate to the directory where the original simulation flsgrf.Flow_Over_A_Weir is stored. Select the Analyze > 3-D tab > Open results file button. Browse to the directory where the original simulation “Flow Over A Weir” is stored, and select the file “flsgrf.Flow_Over_A_Weir.”  



 

 

 Select the component iso-surface overlay option Solid volume and the checkbox Render frames to disk, and make sure that the time range is 0.0 – 1.25 seconds. Click Render. 



 

 

 The pressure contours from the original simulation will now be shown on the Display tab. 



 

 

 Select the Analyze > 3-D tab > Open results file button and choose the file “flsgrf.Weir_Gate” from the FLOW-3D results dialog. Remember that you must have copied the restart output into the same folder as the original output. 



 

 

 Select the component iso-surface overlay option Solid volume and the checkbox Render frames to disk, and slide the left-hand time-frame slider all the way to the left end so that it is set to t=1.25s. Also, select the checkbox Append to existing output and then OK to accept the current folder. Click Render. The Display should now have the list of all available restart time frames from 0.0s to 2.5s, which includes the transitional moment t=1.25s when the upstream gate is closed. 
Sample Problems Three application-specific tutorials are provided in the online Help version of this manual. Casting Hydraulics Microfluidics  



  

Casting Tutorial - Sand Casting Filling 
Simulation 
Problem Description & Objectives In this tutorial, you will learn how to set up and run a gravity-fed sand casting simulation with steel chills. The mold will be built using .stl files from a CAD package and FLOW-3D geometry primitives. The part is shown in Fig. 1 below. The objectives are to: 
� Predict the temperature distribution in the melt. 
� Predict the temperature distribution in the mold. 

 Figure 1: Ring casting in a sand mold. 
FLOW-3D Learning Objectives 
� Build geometry to represent the mold and chills 
� Create a computational mesh 
� Specify boundary conditions 
� Load properties for the melt and mold 
� Activate physical models necessary to simulate filling and temperature in the melt. 
� Run the simulation 
� Analyze the simulation results 
Problem Specification Material Specifications Process Specifications Cast Material AISI 1086 Carbon Steel Cast Material AISI 1086 Carbon Steel Mold Material Olivine Sand, 5.9% Bentonite Mold Material Olivine Sand, 5.9% Bentonite 



Chill Material H13 Steel Chill Material H13 Steel  Geometry Files Location of files c:\flow3d\v9.4\examples\stl Units of geometry files CGS Simulation unit system CGS STL CAD used to define the mold: stlf01.inp – ring stlf02.inp – runners stlf03.inp – sprue tlf04.inp - chill stlf05.inp - chill stlf06.inp - chill stlf07.inp - chill  
Create Workspace and Simulation File  Open the FLOW-3D interface by double-clicking the FLOW-3D icon on your desktop.  Create a new workspace. 
� Select File > New Workspace. Enter "Ring Casting" as the workspace name. 
� Accept the default settings on this dialog and select OK. 

 Create a new simulation 
� Select File and Add New Simulation. 
� Enter "Filling" as the simulation name 
� Select OK. 



 At this point a workspace named Ring Casting has been created to contain simulations pertaining to the casting of the ring and an empty simulation named Filling has been added to it.  
Build Geometry  The first step in setting up a simulation is usually the geometry building step. Geometry building consists of building the mold and inserting the steel chills. The geometry files which will be used to build the mold are contained in the directory named STL which is located in the FLOW-3D Examples directory. The steps to build the mold are: 
� Create the mold. 
� Cut the shapes of the various casting components from the mold. 
� Cut the shapes of the chills from the mold. 
� Add the chills to the mold. There are two ways the mold can be created. One is to create a solid with the dimensions of the actual mold and then cut away the components to be cast. An easier method is to create the mold as a geometric complement of one of the casting components. This eliminates one step in the geometry building process. The methods are contrasted below. 

 The mold will be created using the procedure of Method 2: Geometric Complement. What is a geometric complement? 



A geometric complement, usually referred to simply as a complement, fills the computational mesh from the surface of the specified component out to the extent of the computational domain. The ability to define geometry using a geometric complement is particularly useful for simulating filling processes since the solid geometry of the container being filled is usually easier to obtain than the mold. RULE OF THUMB: SINCE A COMPLEMENT FILLS THE COMPUTATIONAL DOMAIN FROM THE SURFACE OF THE SPECIFIED PART OUT TO THE EXTENT OF THE COMPUTATIONAL DOMAIN, IT IS TYPICAL TO DEFINE THE FIRST GEOMETRY SUBCOMPONENT AS A SOLID INITIALLY AND THEN SWITCH IT TO A COMPLEMENT AFTER THE MESHING HAS BEEN COMPLETED.  Build the Mold: 
� Import the Ring: Select the Model Setup > Meshing & Geometry tab. The first step will be to import the geometry for the ring. According to the problem specification, the ring is defined by the file stlf01.inp. 

� Select the  button from the toolbar. This opens the “Geometry Files” dialog. 
� Click the Add button and browse to the c:\flow3d\v10.0\examples\stl\ directory. 
� Select the file stlf01.inp. 

 
� Click Open. The stlf01.inp file will now appear in the Geometry File(s) dialog. At this point it is possible to apply transformations to the geometry to convert from mm to cm if necessary. The geometry files are already defined in CGS units so no transformation need be applied. 
� Name the subcomponent Ring. 
� Click OK on the Geometry Files dialog. A dialog will appear allowing the type of component to be defined. Choose Standard (solid), name the component Ring, and click OK. 



 The ring should now appear in the Meshing & Geometry window as shown in Fig. 2. 

 Figure 1. The ring geometry is the first subcomponent imported into the model. In the Geometry tree at the left of the Meshing & Geometry window, rename Component 1 Mold (instead of Ring) as shown below. 



 
� Add runners and sprue: The next step will be to import the runners and the sprue into the simulation. They will be added as holes so that they will be cut from the mold. 

� Select the  button from the toolbar on the Model Setup > Meshing & Geometry tab. 
� Click the Add button and browse to the c:\flow3d\v10.0\examples\stl\ directory. 
� Hold the CTRL key and select stlf02.inp and stlf03.inp and click Open. The files selected above will appear in the Geometry Files dialog. Notice that these files will be added as part of component 1 by default. This is appropriate since they comprise the same component (the mold). Select OK to add the pieces to the Component 1 tree. 
� The runners and sprue will be cut from the mold so they should be made Holes. Open the Component 1 tree, and under Subcomponent 2 and Subcomponent 3, change Subcomponent Type to Hole. 

 



 
� Name Subcomponent 2 Runner and Subcomponent 3 Sprue. 
� Save the simulation. 

� Import the chills. The chills will be added in two steps. The first step will add the chills as Holes to Component 1 to create openings in the mold. The second step will be to add the chills as solids to Component 2. 
� In this step the chills will be cut from the mold. Select the  button from the toolbar. 



� Click the Add button and browse to the c:\flow3d\v10.0\examples\stl directory. Hold the CTRL key, and select files stlf04.inp, stlf05.inp, stlf06.inp, and stlf07.inp. Click Open. Click OK. The geometry should now appear as shown in Fig. 3. 
� The chills should be cut from the mold so, as with the previous two subcomponents, change the Subcomponent Type to Hole in the geometry tree.  
� Name subcomponents 4 through 7 as Chill Opening 1, Chill Opening 2, Chill Opening 3, and Chill Opening 4, respectively. 
� Save your work. 

 Figure 2. The mold consists of the ring, the runners, the sprue, and the openings for the chills. Now that the mold has been built, the final step is to add the chills as solids into the holes created in the mold for them. The chills will be added as a new component (Component 2), rather than as part of Component 1 since they have different material properties than the mold. 
� Click the  button from the toolbar. Click the Add button and browse to the c:\flow3d\v10.0\examples\stl directory. 
� Select the file stlf04.inp. Click Open. 
� On the Geometry Files dialog, select New Component 2 from the Add to Component dropdown list. Click OK. 
� Select Standard as the Component Type on the Add Component dialog. This will create a new component, allowing unique properties to be specified for the chills. The STL files added in this step will be added to Component 2 as subcomponents 8, 9, 10, and 11. 
� Name Component 2 Chill, and select OK. 
� Repeat steps a through d for files stlf05.inp, stlf06.inp, and stlf07.inp, making sure to add all three files to the newly created Component 2. 
� Name Subcomponents 8, 9, 10, and 11 as Chill 1, Chill 2, Chill 3, and Chill 4, respectively. 
� Save your work. At this point all the geometric features of the casting have been imported and the next step will be to create a computational mesh. REMINDER: RECALL THAT THE FIRST SUBCOMPONENT, THE RING, IS STILL DEFINED AS A SOLID SO THE MOLD ITSELF DOES NOT EXIST IN THE SIMULATION. AFTER THE COMPUTATIONAL MESH HAS BEEN CREATED, THE RING WILL BE SWITCHED TO A COMPLEMENT. THIS CREATES A SOLID FROM THE SURFACE OF THE RING OUT TO THE EDGES OF THE COMPUTATIONAL MESH, CREATING THE MOLD. 



 
Create the Mesh The extents of the computational mesh can be defined by using the Fit to Geometry feature. Once the mesh extents have been defined, its size will be adjusted outward from the geometry to represent the mold. The size of the computation cells in the mesh will be specified during this step. RULE OF THUMB: WHAT SIZE MESH CELLS SHOULD BE USED IN THE COMPUTATIONAL MESH? AT MINIMUM, THE GEOMETRIC FEATURES SUCH AS THE RING, RUNNERS, AND SPRUE MUST BE RESOLVED. MOST SIMPLE GEOMETRIC FEATURES CAN BE RESOLVED WITH 3 TO 4 MESH CELLS. THE NEXT CONSIDERATION IS WHETHER OR NOT FLOW DETAILS NEED TO BE CAPTURED, AND THIS VARIES BY SIMULATION.  Measure the Geometry to Determine a Good Cell Size The smallest geometric feature in the casting is the width of the runners. The probe feature will be used to measure their width. To accurately measure geometry, it is highly recommended that the geometry be viewed and measured in 2D, as shown in the next step. 
� On the Model Setup > Meshing & Geometry tab, click on the  icon in the tool bar. This will display the geometry in plane view. 
� From the tool bar, select View > Probe Point List. 
� Hold CTRL, place the target-cursor exactly on the edge of a runner, and left-click to add x,y,z values to the table. Zoom in to get the most accurate values. Repeat for the opposite side of a runner, and subtract in the direction measured to find the width. 
� The measured size of the runners determined in the previous step should be about 5.0 cm. Since the runners are curved, more than 3 cells will probably be necessary to capture them accurately. Try 5 cells across the runners, so the size of the mesh cells will be set to 1.0 cm. 



 Fit the Mesh Extents to the Geometry and Apply a Uniform Cell Size 
� On the Model Setup > Meshing & Geometry tab, right-click on the Mesh-Cartesian tree and select Add a Mesh Block. Select Yes to create Mesh Block 1. 
� Right-click the Mesh block 1 branch and select Fit to Geometry. 

 
� Create a uniform mesh in all three directions by selecting the X, Y, and Z direction checkboxes. Enter 1.0 as the Size of Cells, and 10 cm as the Offset distance. This moves the edges of the mesh 10 cm away from the edges of the part, so that heat transfer can be adequately simulated. 



 
� If the new mesh is not visible, select Mesh > View mode > Grid Lines from the toolbar. 

 The mesh and the geometry should now appear as shown below. 



 Adjust the Mesh to Accommodate the Mold 
� In the Mesh-Cartesian tree on the Meshing & Geometry tab select Block 1 and right-click on it. Select Adjust Mesh Block. The Mesh Adjustment dialog will appear. 
� Move the edges of the mesh to define the mold. The distance the mesh edge will be moved is controlled by the value of Step. The default value is 1.0. 

� Change Step to 0.1 cm. 
� Move the Maximum Z edge of the mesh down 10.1 cm, so that the edge coordinate is 129.9. This is done to ensure that the mesh lies slightly within the top of the sprue so a boundary condition can be used to introduce fluid into the casting. 



 
� After moving the edge of the Z mesh, the updated mesh tree should appear as follows: 

 
Change the Ring Subcomponent to a Complement Now that the mesh has been specified, Subcomponent 1 will be switched to a Complement to define the mold. 
� Open Geometry > Component 1 > Subcomponents > Subcomponent 1 tree. 
� Set Subcomponent Type to Complement. 
� Save your work. The mold definition is now complete. The next step will be to verify that the geometry has been defined correctly and that the mesh resolves the geometry adequately. 
Check the Geometry Setup Using FAVOR and the Preprocessor Check the geometry using FAVOR™. 



� On the Meshing & Geometry tab, select  from the toolbar. The FAVOR™ dialog will appear. 

 
� Select the Open radio button on the FAVOR™ dialog. 
� Click Render. A FAVORized view of the mold cavity will be displayed. 
� Turn off Mesh > Show on the toolbar to view the part without the mesh as shown below. 

 The FAVORized view of the geometry indicates that the ring, runners, and sprue are reasonably well resolved by the grid size of 1.0 cm and no adjustments to the mesh are required at this stage. Notice that only the open regions of the mesh are displayed. To determine if the chills are defined correctly, the preprocessor will be run and 2D plots through the mold will be analyzed. Check the geometry using the preprocessor: 
� Select Return to Model Building on the FAVOR™ dialog to close the FAVORized view. 
� Select Preprocess Simulation from the Simulate menu of the top toolbar. 



� When the message “Preprocessor Done” appears, click on the Analyze tab and select the prpgrf.filling file from the FLOW-3D Results dialog. If this dialog does not appear, click the Open Results button at the bottom of the Analyze panel and open prpgrf.filling. 
� Select the 2D tab. 
� Select the X-Y radio button and select Component Number from the contour variable dropdown. 
� Move the Z-Limits sliders to the min/max limits as shown below and click Render. The view will automatically switch to the Display tab. 

 
� Click the Next button until the display shows a cross section through the ring and the runners (shown as open regions) as shown in Fig. 4. The mold will be displayed in blue which corresponds to component 1 (the mold) and the chills will be displayed as red, corresponding to component 2. 

 Figure 3. A cross-section through the ring and runners at z=99.5 cm shows that the mold is represented as component 1 and the chills are represented as Component 2. NOTE: IF THE DISPLAY AT Z = 99.5 CM DOES NOT APPEAR EXACTLY AS SHOWN IN FIG. 4, CHECK THE GEOMETRY DEFINITIONS TO ENSURE THAT COMPONENT 1 CONSISTS OF 7 SUBCOMPONENTS, THE FIRST BEING DEFINED AS A COMPLEMENT AND THE REMAINING SUBCOMPONENTS SHOULD BE DEFINED AS HOLES. COMPONENT 2 SHOULD BE DEFINED BY 4 SUBCOMPONENTS WHICH ARE ALL SOLIDS. 



Assign Material Properties to the Mold and Chills According to the problem specification, the mold consists of olivine sand with 5.9% Bentonite and the chills consist of H13 steel. In this step, the material properties will be assigned to these components. Assign properties for olivine sand with 5.9% Bentonite to the mold. 
� From the Materials menu on the upper toolbar, select Solids Database. 
� In the dropdown box ensure that Component 1 (the mold) is selected. 

 
� Scroll down to Sand, Olivine in the list of materials and click on it to select it. 
� Click the Load button. 
� Since the part unit system is centimeters (CGS) and the values for olivine sand are stored in the database with CGS units, no unit conversion is necessary. We need to remember that the temperature units are Celsius. Select OK to load the properties into the simulation. 
� A dialog box will appear indicating that the simulation units are being set to CGS, and temperature units to Celsius. Click OK to accept this action, and OK again to acknowledge that the sand properties have been assigned to Component 1. Assign properties for H13 steel to the chills. 
� In the dropdown box make sure that Component 2 (the chills) is selected. 



 
� Scroll down to Steel H13 in the list of materials and click on it to select it. 
� Click the Load button. 
� Because the length/mass/time unit system and temperature units were specified when the sand was loaded, this time the dialog box will only allow CGS and Celsius units to be selected. Click OK, and OK again to accept the change to Component 2, and Close the Solids Database dialog. Verify that the material properties have been set for the mold and chills. 
� On the Model Setup > Meshing & Geometry tab, open the Geometry > Component 1 tree. 
� Open the Component Properties > Solid Properties sub-tree. Properties for thermal conductivity and density*specific heat, in grayed-out boxes should appear. The boxes are grayed out since the physical models which use them have not been activated yet. 
� Also check the properties for Component 2 and make sure they are loaded. 
Assign Material Properties to the Melt (Fluid) From the problem specification the material to be cast is AISI 1086 Steel at 1800° K. The properties will be loaded from the Fluids database. Load properties for AISI 1086 steel from the fluids database. 
� Select Fluids Database from the Materials menu. 
� Select Steel, AISI 1086 (carbon steel) from the Material Name list. 



 
� Click the Load Fluid 1 button. No conversion options are available since the simulation units have already been set to CGS so the material properties will be loaded in CGS. 
� Click OK to load the properties into the simulation, OK to accept the changes, and Close. Verify the material properties for the melt. 
� Click the Model Setup > Fluids tab. 
� Open the tree for Fluid 1. 
� Open the trees for Viscosity and Density. The material name is now set to Steel AISI 1086, the density is set to 6.74 (g/cm3), and the viscosity is set to 0.06 (g/cm/s) as shown below. Viscosity is grayed out until the Viscous Flow physics model is activated. 
� Save your work. 

 
Specify Boundary and Initial Conditions According to the problem specification, the mold and chills are at room temperature (373º K) initially and the melt will be poured at 1800 K. The pour basin will be maintained at a depth of 10 cm throughout the pour. Since the flow inside the basin is usually not of interest, there is no need to model it. However, if the flow in the basin is also of interest (e.g. to model oxidation potential) it should also be included in the model. In this simulation, the pouring basin will be replaced by a pressure boundary condition representing the pressure at the bottom of the basin to minimize the computational cost. 



The pressure at the top of the sprue is roughly equal to the hydrostatic pressure ρgh at the bottom of the basin. The density of the melt is 6.7 gm/cm3 so the pressure at the bottom of the basin is 
3 2 2

basinP  6.7gm / cm  *  981cm / s  *  10cm  65,727 dynes / cm= =  

 Set the top boundary (Z Max) to a pressure-type boundary. 
� Select the Model Setup > Meshing & Geometry tab. 
� Open the Mesh – Cartesian > Mesh Block 1 > Boundaries tree. 
� Click on the  button next to the Z max boundary. 
� Select the Specified Pressure radio button. 
� In the Pressure box enter 65727.0, and keep the default Stagnation pressure. 
� Select the Thermal Information button. 
� Set the boundary pour Temperature to 1527 °C (1800 K) 
� Click OK. 
� Save your work. 



 

 By default, all remaining boundaries are set to symmetry-type boundaries representing insulated boundaries. Since the mold is relatively thick and sand is an insulator, a symmetry boundary represents the physical situation well. 
Activate Physical Models Before setting the initial conditions such as temperatures in the simulation, the physical models required to simulate the casting must be activated. Deciding which physical models should be activated is an important step. Gravity is clearly important so the Gravity model should be activated. Heat transfer is necessary in order to predict the temperature distributions. Viscosity usually affects the flow patterns in a gravity casting so the Viscosity and Turbulence model needs to be activated. Select the Model Setup > Physics tab to display the available physical models. Activate the gravity model. 



� Click the Gravity model button. 
� Enter -981.0 in the Z component box, making sure to include the negative sign. 
� Click OK. Activate a heat transfer model. 
� Click the Heat Transfer button. 
� Select First order under fluid internal energy advection and Full energy equation for fluid to solid heat transfer. The first order selection enables heat transfer and temperature calculation within the fluid and from the mold to the fluid, but not in reverse. The full energy equation option allows the temperature and heat flux in the solid mold and chills to be calculated dynamically in every time step, and enables heat transfer from the fluid to the solid. 
� Click OK. Activate the viscous flow model. 
� Click the Viscosity and Turbulence button. 
� Select the Viscous Flow radio button, which adds the effects of wall shear and internal shearing to the simulation. The default assumption is that the flow is Laminar, and we will assume that this is the case for the current simulation. 
� Click OK. 
� Save your work. 



 
Specify Initial Conditions Initial conditions refer to conditions in the mold before pouring begins. For example, the initial temperatures of the mold and chills need to be specified. From the problem specification, the temperatures of the mold and chills are 373 K: the unit system we have selected though (for demonstration purposes) is in Celsius: 100° C 
� Select the Model Setup > Meshing & Geometry tab. 
� Set the mold temperature to 100° C. 

� Open the Geometry > Component 1 > Component Properties > Initial Conditions tree. 
� Enter 100 in the Temperature input. 



 Set the Chills temperature to 100° C. 
� Repeat the process for Component 2. 
� Save your work. 

 
Check Initial Conditions with Preprocessor Preprocess the simulation to verify that the initial component temperatures have been set up correctly. 



� Select Preprocess Simulation from the Simulate menu. 
� Select the Analyze tab, click on Open Results and open the prpgrf.filling results file. 
� Create a 2-D plot of wall temperature at z=99.5 cm. 

� Select the 2-D tab 
� Select Wall Temperature in the Contour Variable dropdown.  
� Move the z-direction sliders so that the cross-section is at z = 99.5. 
� Select Render. The wall temperature plot should appear as below. The temperature plot, which includes the mold and the chills, are all displayed at 100° C. 

 
Specify Finish Time and Finish Condition The simulation finish time, i.e., the time required to fill the casting, is difficult to estimate when the fill condition is a pressure boundary condition. As long as the finish time is longer than the actual fill time, the simulation can be terminated automatically by specifying the termination condition as Fill Fraction. Assume that 2.0 seconds is enough time to fill the casting. Set the Finish Time to 2 seconds and set the Finish Condition to Fill Fraction. 



� Select the Model Setup > General tab. Enter 2.0 in the Finish time box. 
� Click the Finish Condition button. The Finish Condition dialog will appear. 
� Select the Fill Fraction radio button. The simulation will terminate when the casting’s fill fraction (total cell volume filled with fluid divided by the total non-solid cell volume) reaches the value specified in the Finish Fraction box. 
� The default Finish Fraction is 1.0 meaning completely full. Accept this value and click OK. 

 
Specify Desired Output Data The default data output settings in FLOW-3D will generate Restart data at intervals of 0.1*Finish time. Restart data is used to create various graphics including 2-D contour plots and 3-D surface plots, and also includes a complete solution of the necessary equations to describe the flow field. To create interesting animations of your simulation, data at more frequent intervals is necessary: Selected data. This output has a default interval of 0.01*Finish time, which will produce 100 data dumps. Using Selected data to get more frequent output is preferable to specifying a more frequent Restart data interval, because Restart data sets are very large. In this step, we will set fluid fraction, velocity, temperature and wall temperature as Selected data. 
� Select the Model Setup > Output tab. 



� Select Fill Fraction in the Basis for Output group box.  
� In the Selected data list, check the boxes shown below: 

 
Specify Numerical Options Default numerical options work well in most cases and so we will keep the numerical settings as defaults. 
Run the Simulation 
� Save the simulation. 
� Select Simulate > Run Simulation from the top menu bar. The interface will automatically switch to the Simulation tab. The preprocessor should complete quickly and then the solver will start. The simulation will terminate at about t=1.57 seconds. 
Analyze Simulation Results One of the goals of the simulation is to determine the temperature distribution in the melt. A good way to visualize this is a 3-D display of the fluid surface colored by temperature. Next a 2-D display of the wall temperature will be created. Open the results file 
� Select the Analyze tab. A file dialog should appear with the results file flsgrf.filling displayed. If it does not, select Open Results File from the lower left. 
� Select flsgrf.filling and then click OK.  Create a 3-D display of the fluid surface colored by temperature using Selected Data. 
� Select the Analyze > 3-D tab. 



� Select the Selected radio button in the Data Source group box.  
� The Iso-surface is set to Fraction of Fluid by default so the fluid surface will be displayed automatically. In the Color Variable dropdown, select Temperature. 
� To display the mold along with the fluid surface, select the Open Volume radio box under Component Iso-Surface Overlay. 

 
� Move the Time sliders so that the entire set of available times are selected. 
� Click Render to generate the graphics. 
� The Display tab will appear with all available Selected Data time frames.  
� The mold needs to be slightly transparent in order for the fluid surface to be visible. In the Object List at the left side of the screen, right-click Component 1, select Transparency, and set the slider to about 50%. Click on a blank spot in the Object List to deselect the component and remove the green outline. 
� The fluid surface can be seen better when it is opaque. Double-click a later time under Available Time Frames so that there is fluid in the simulation, then select Fluid Surface in the Component List at the left side of the screen and right-click Fluid Surface. Select Transparency and move the slider all the way to the left. The fluid surface will now be opaque.  Create a 2-D display of the mold temperature at z=99.5cm. 
� Select the Analyze > 2-D tab.  
� Select the X-Y radio button from the Plane group box. 
� Select Wall Temperature from the Contour Variable dropdown list 
� Move both Z-direction sliders to about z=99.5. 
� Choose Selected as the Data Source, and make sure all Time Frames are selected. 
� Click Render. Step through the time sequence of wall temperature plots. Notice the wall temperature gradients are confined to a local region around the casting, confirming the assumption that the entire mold does not need to be modeled. 
Summary of Filling Simulation A simulation of the filling of a gravity fed sand casting has been set up and run. The simulation included heat transfer so that the temperature distribution in the melt could be determined. Heat transfer within the mold was also computed. The heat transfer coefficient between the melt and the wall was not specified so FLOW-3D computed it. No solidification was considered.  



 



  

Hydraulics Tutorial - Energy Dissipation in 
a Drop-Structure Flow 
Problem Description & Objectives The flow of water over a vertical drop structure will be simulated where the only known flow characteristic is the upstream depth. The purpose of this exercise is to determine and validate the energy loss of the flow over the drop. To do this, we will simulate the problem and use the results to identify:  
� the volumetric flow rate over the drop 
� the location, depth, and velocity of critical flow without assuming an a priori flow regime 
� the depth and length of the drop pool 
� the downstream depth of flow 
� the energy loss of the flow over the drop, and 
� empirical results in the literature, compared to the model results for validation It would be much easier to determine the objectives if the flow rate was known already; it makes a better learning problem to assume only an upstream depth. 
FLOW-3D Learning Objectives In this exercise we will learn techniques to: 
� create the drop structure geometry 
� create the computational domain 
� specify appropriate boundary conditions 
� input fluid properties 
� activate required physical models 
� run the simulation 
� analyze the simulation results 
� compute drop characteristics from results 



 Figure 1: Rectangular vertical drop structure  
Problem Specification Unit System 
� Simulation units – SI Geometry Specifications  
� Drop height: 0.62 m 
� Drop length upstream of the brink: 0.7 m 
� Channel length downstream of the brink: 2.0 m Flow Conditions 
� Upstream flow depth = 0.24 m 
� Fluid Properties (Water) 
� Viscosity = 0.001 Pa-s 
� Density = 1000 kg/m3 Simulation Specifications 
� 2D in x and z 
� Free surface with sharp interface 
� Incompressible fluid 
Create Workspace and Simulation File  Open the FLOW-3D interface by double-clicking the FLOW-3D icon on your desktop.  Create a new workspace 
� Select the Navigator tab from the tab menu at the top of the screen. 
� Select File and New Workspace. 
� Enter "Energy Dissipater Simulations" in the workspace. 



� Leave the defaults and select OK. Create a new simulation 
� Select File and Add New Simulation. 
� Enter "Vertical Drop." 
� Select OK.  

 Figure 2: The newly created workspace and simulation in the Navigator view. 
Create the Drop Structure Geometry The geometry of the drop structure is very simple and can be built using the FLOW-3D geometry modeler. The drop structure is rectangular with the dimensions shown in the problem specification. A Box Primitive will be used to create the drop. Note that all units are SI in accordance with the Problem Specification statement. As shown in Fig. 1, the origin of the coordinate system should be located at the bottom right-hand corner of the drop structure. Therefore, the box structure should be defined so that it extends from  x = -0.7 to 0.0 and from z = 0.0 to 0.62. The default dimensions in the Y direction (0.0 to 1.0) can be accepted. Create a Box for the Drop. 
� Select the Model Setup, Meshing_Geometry tab. 
� Select subcomponent from the menu. 
� Select Box, a Box subcomponent window will appear. 

 



Figure 3: Use Box Primitive to create the drop structure 
� Enter X, Y and Z dimensions of the geometry as shown in Fig. 4 below. 

 Figure 4: Dimensions of the geometry 
� Click OK. 
� The box is a solid, so select Standard as the Component Type.  
� Name the component Drop, like the subcomponent, and click OK. You should now see a cube in the Meshing and Geometry windows as shown in Fig. 5. This block is the drop structure. A mesh block will be added in the next step to specify the computational domain. 



 Figure 5: Dimensions of the geometry 
Specify the Computational Domain (Mesh) Limits At this point the geometry of the drop structure is specified and the next step is to specify the computational domain and apply a mesh to it. A computational mesh will be added so that it encompasses the drop structure and also extends downstream 2.0 m from the end of the drop. The upstream and downstream flow characteristics will be represented by mesh boundaries. Since the cross-stream flow variations are negligible, a 2-D mesh with one cell and unit length (1.0 m) in the Y direction is appropriate. According to the sketch in Fig. 1, the computational domain should be defined from x =-0.7 m to x = 2.0 m. The decision on how far upstream and downstream the computational domain should extend from the brink is based on two criteria: 
� Minimize the size of the computational domain to avoid unnecessary computations. 
� Do not minimize the size of the computational domain to the point where the boundary conditions are too close to regions of high flow gradients as this can affect the results. In the Model Setup > Meshing and Geometry tab, add a mesh block by right-clicking on Mesh – Cartesian and selecting Add a mesh block.  Change the definitions of Fixed Pt.s (1) and (2) (the mesh boundaries) to -0.7 and 2.0, respectively, so the mesh is defined as shown in Fig. 6. Name the block 2-D Domain. 



 Figure 6: Default mesh block included in all simulations RULE OF THUMB: PLACING ADDITIONAL FIXED POINTS IN REGIONS OF THE COMPUTATIONAL DOMAIN WHERE SOLID/FLUID FLOW INTERFACES OCCUR OFTEN PRODUCES BETTER MODEL RESULTS. ALSO, FIXED POINTS CAN BE USEFUL FOR RESOLVING SOLID SURFACES MORE ACCURATELY WITHOUT USING AN UNNECESSARILY FINE MESH FOR THE ENTIRE PROBLEM. IT IS RECOMMENDED THAT FIXED POINTS BE SPECIFIED ALONG FLAT SURFACES OF GEOMETRY, BUT NEVER ALONG FREE SURFACES OF FLUID. 

 



Figure 7: Automatic and recommended fixed points around the drop structure Add Fixed Points to the Mesh The next step is to add fixed points into the mesh at the locations of the drop structure surfaces in both the X and Z directions. 
� Right click on Fixed Pt.(1) in the X Direction of the mesh Block 1 as shown in Fig. 8. 

 Figure 8: Add a fixed point in the X Direction 
� Select Add. 
� In the Add Mesh Points pop-up window add a New Point 0.0, as shown in Fig. 9. 

 Figure 9: Add a fixed point at X = 0.0 
� Select Add, then Close. 
� Right click on Fixed Pt.(1) in the Z Direction of mesh Block 1 as shown in Fig. 10. 



 Figure 10: Add a fixed point in the Z Direction 
� Select Add. 
� In the Add Mesh Points pop-up window, add a New Point 0.62 in the Z Direction, as shown in Fig. 11. 

 Figure 11: Add a fixed point at Z = 0.62 
� Select Add, then Close. 
� Save your work. 
Resolving Flow Features The choice of mesh cell size is an important one. The computational mesh should be only fine enough to resolve the geometry and capture the flow features of interest. An excessively fine mesh will needlessly increase the simulation runtime and may require more hardware (memory, video).  Without knowing the flow characteristics beforehand, it can be difficult to specify the mesh resolution with great precision. One solution is to run the simulation several times with decreasing mesh resolutions until no significant change in results is observed. A better approach, when possible, is to determine the critical flow feature using general characteristics such as flow depth or rate, and select the necessary mesh size to resolve it. If it is noticed after running the simulation that some flow features are still not well resolved, the simulation can be re-run or restarted with a smaller mesh resolution. Restarting simulations at a midway point in the run will be covered as a later topic in this class. 



RULE OF THUMB: A RULE OF THUMB FOR MESH RESOLUTION IS THAT AT LEAST 3 CELLS ARE REQUIRED TO RESOLVE A FLOW FEATURE SUCH AS A FREE-SURFACE JET.  

 Figure 12: Critical Flow Feature to Determine Optimal Mesh Size. In order to follow the rule of thumb, we need to determine the size of the cells necessary to adequately resolve the free-surface jet. To do that we need to determine the minimum thickness of the nappe. As the water flows over the drop and forms the nappe, it accelerates under gravity and becomes thinner, so the minimum thickness occurs at the impact between the nappe and the receiving pool, as shown in Fig. 12.Let's estimate the thickness of the nappe: 
� Empirical relations by Rand (1955) will be used to estimate the nappe thickness dnappe at the pool impact. 
� The depth of the flow at the inlet (Hupstream) = 0.24 m as defined in the Problem Specification, above. 
� From Rand (1955), . 
� Critical flow depth for a rectangular channel is defined as . The upstream discharge per unit width (qW) is unknown, so we must take intermediate steps to determine the flow rate. This simulation runs quickly, so we will run the simulation with an assumed (coarse) mesh size and use a feature of FLOW-3D called Probe along with a set of generated simulation data called Mesh Dependent History to determine the volumetric flow rate. Before we can run the simulation, we need to define the boundary conditions and fluid properties, as well as physical parameters like gravity. 
Specify Boundary Conditions Boundaries conditions define what happens at the edges of the mesh. They can be used to add fluid to the boundary over time, act as sinks for the fluid, maintain pressure, act as walls, and for other functions. A Pressure boundary condition with specified fluid height will be specified at the upstream (minimum X) boundary since the depth of the flow is known there. Downstream conditions are not known except for the fact that the flow leaves the computational domain at the maximum X boundary so we will use outflow boundary condition downstream. Specify a Pressure Boundary Condition A pressure boundary condition with a fluid depth needs to be specified at the X-minimum boundary (the upstream boundary). 



� Select the Model Setup > Meshing & Geometry > Mesh – Cartesian > Mesh Block 1 > Boundaries tree, and then select the X-min boundary by expanding the tree at the left. The dialog box shown in Fig. 13 will appear. 
� Select the Specified pressure radio button. 
� Enter 0.86 in the Fluid height box. (Fluid depth upstream is 0.24m and height of the drop is 0.62m from the x-axis so the Fluid height, in the Z coordinate, = 0.24 + 0.62 = 0.86 m). 
� Keep the Pressure box entry blank which means a value of zero will be used as reference to set hydrostatic pressure at the boundary. Set F Fraction = 1.0 (all fluid entering the simulation is 100% water) and leave Stagnation Pressure active (flow enters at zero velocity, as from a reservoir. This means that steady-state flow velocity is computed within the mesh, which will give the most accurate result, assuming the boundary is far enough away from the drop structure edge). 
�  Click OK. 

 Figure 13: Pressure boundary condition Specify Outflow Boundary Condition An outflow boundary condition will be specified at X-maximum boundary (the downstream boundary). Fluid is permitted to leave the boundary, but not to enter. This option assumes that the flow through the boundary is super-critical (Froude number greater than 1). 
� Select the X-max boundary. 
� Select the Outflow radio button. 
� Click OK. Set Wall Boundary Condition Boundary condition at Z-minimum boundary (the downstream channel bottom) to be set to Wall boundary condition. For this problem, friction losses from the channel bottom are assumed to be negligible, so no roughness will be assigned to the wall boundary.  
� Select the Boundaries tab and then select the Z-min boundary. 
� Select the Wall radio button. 



� Click OK. 
� Save your work. Symmetry Boundary Conditions The remaining boundaries are pre-set as Symmetry boundary conditions. This means that the boundaries will be treated as if conditions outside of the boundary were identical to conditions inside the boundary. For the Y boundaries, this implies that the drop structure is much wider than the mesh. For the Z-maximum boundary, the void above the flow extends infinitely. If the model were poorly designed and flow reached the Z-maximum boundary, it would be reflect downward unphysically. 
Specify Fluid Properties From the Problem Specification in the beginning of the exercise, the working fluid in the simulation is water. The viscosity is 0.001 Pa-s and the density is 1000 Kg/m3. The properties can either be entered manually or loaded from the materials database. The properties will be loaded from the materials database for demonstration purposes. Add Fluid Properties 
�  Select the Model Setup > Fluids tab. 
� From the menu bar at the top of the screen, select Materials > Fluids Database. 
� In the Fluid database under Material Name select Water at 293 K with SI units. 
� Select the Load Fluid 1 button, and then select Convert units to SI (this sets the simulation to SI units, which can also be set on the General tab). Properties for water in SI system will be loaded. 
� Expand the Properties tree as shown in Fig. 14. Verify that the values for viscosity and density have been loaded. Note that the viscosity values are grayed out, because we have not activated viscous flow on the Physics tab. 
� Save your work. 

 



Figure 14: Fluid properties for water in SI units as loaded from the material database. 
Specify Initial Conditions The initialization of fluid in the domain is often a desirable option to help a simulation reach a steady-state solution more quickly. Examples of problems where initial fluid regions are useful include tank-filling simulation and river models. An initial fluid region is not recommended for this problem since the depth and velocity of the steady state flow are not known, and errors in estimating the steady-state depth on top of the drop structure could produce unphysical results. We will still specify an initial pressure distribution which will apply to the inflow boundary. 
� Select the Model Setup > Meshing & Geometry tab, Initial > Global > Pressure tree. 
� Select Hydrostatic pressure in the Z Direction as the initial Pressure field. Selecting Hydrostatic pressure in the Z direction sets up a hydrostatic pressure in any initial fluid regions and more importantly sets up a hydrostatic pressure on the inflow boundary. Without setting this condition, the pressure on the inflow boundary would be uniform, although it will adjust very quickly under the effect of gravity in the domain. 

 Figure 15: Configuration of initial fluid pressure 
Activate Appropriate Physical Models By default, all physical models are inactive. To minimize unnecessary computations, it is important to only activate physical models which are absolutely required to simulate the desired behavior. Questions like 



“Should I treat the simulation is inviscid?” and “Do I need to model surface tension effects?” should be answered early in the modeling process.  The flow below the drop structure is likely highly turbulent so the flow will be modeled as Turbulent with Newtonian viscosity. The only other model which needs to be activated is Gravity. Surface tension effects are insignificant due to the size of the problem, so the Surface Tension model can be left inactive. This can be demonstrated by calculating the Weber number ( 2We V L / sρ= )where ρ  is the fluid density, V is a characteristic velocity, L is a length scale, and σ  is the surface tension coefficient. If We >> 1, surface tension effects can be ignored. Since we do not know the velocity yet, we will have to make a safe assumption that surface tension does not contribute significantly to the flow effects. In the next step, the appropriate physical models will be activated. Activate the Gravity Model 
� Select the Model Setup > Physics tab. 
� Select the Gravity button. 
� Set the value of Gravity component in the Z Direction to -9.81 as shown below. 

 Figure 16. Gravity Definition 
� Click OK. There are a number of choices for Turbulence models in FLOW-3D. The most robust and widely applicable turbulence model is the RNG (Renormalized Group) model. That model requires a maximum turbulent mixing length, which represents the upper limit of the size of an expected turbulent eddy in the simulation and is used to limit the amount of turbulent energy created by the turbulence models. RULE OF THUMB: A GOOD ESTIMATE OF THE TURBULENT LENGTH SCALE IS 7% OF THE HYDRAULIC DIAMETER (FLOW DEPTH) IN A HIGHLY TURBULENT REGION WHICH IS LIKELY TO CONTROL THE FLOW. AN ESTIMATE OF THE MAXIMUM TURBULENT MIXING LENGTH USED IN FLOW-3D IS 7% - 13% OF THE CONTROLLING DEPTH. One of the problem objectives for this simulation is to determine the depth of the pool. This depth is just upstream of the point where the nappe impinges on the bottom of the channel. This impingement point is the most turbulent region in the domain and also controls significant flow features. Therefore, the thickness of the nappe could be used to estimate the turbulent length scale. Since we do not know the thickness yet, we will ask FLOW-3D to determine the turbulent length scale for us. Specifying your own turbulent mixing 



length scale is sometimes preferable to letting FLOW-3D determine the scale automatically, but it can be difficult to estimate. Activate Viscosity and Turbulence Activate Newtonian viscosity and RNG turbulence with dynamically-computed max mixing length. 
� Select the Model Setup > Physics tab. 
� Select the Viscosity and turbulence button. The dialog shown in Fig. 17 will appear. 
� Under the Viscosity options, activate the Viscous flow option. 
� Under Turbulence options, select Renormalized group (RNG) model. 
� Under Maximum turbulent mixing length, activate Dynamically computed.  
� Click OK. 

  Figure 17: Select the RNG turbulence model and set dynamically computed turbulent length scale. 



Specify Simulation Finish Time Although it can be difficult to estimate the time at which steady state is reached, a Finish time always needs to be specified so that the simulation knows when to terminate. RULE OF THUMB: A REASONABLE MEASURE OF THE TIME FOR A FLUID DYNAMIC SYSTEM TO REACH STEADY STATE IS 10 TO 20 CHARACTERISTIC TIME SCALES. THE CHARACTERISTIC TIME SCALE REPRESENTS THE TIME REQUIRED FOR A FLUID PACKET TO PASS THROUGH THE SYSTEM. A CHARACTERISTIC VELOCITY IN THE DOMAIN NEEDS TO BE ESTIMATED TO DETERMINE THE CHARACTERISTIC TIME. Without experimental or simulation data we can only estimate the characteristic velocity. The velocity of the water falling under gravity though a distance of 0.62 m (drop height) is (2*9.81 m/s2*0.62 m)1/2 = 3.5 m/s. The total length of the domain is 2.7 m, so the characteristic time scale is about 0.77 seconds (2.7 / 3.5) and 20 time scales is then about 15 seconds (0.77 * 20). Specify Finish Time  
� Select the Model Setup > General tab. Notice that the box for Finish time contains a value of 1.0. This is the default Finish time for all simulations.  
� Change this value to 15.0 as shown in Fig. 18. 

 Figure 18: Set Finish time to 15.0 sec. It is also possible to change the Finish time "on the fly" while a simulation is in progress using Runtime Options in the Simulation tab. 
Specify Numerical Options Numerical options allow you to adjust the calculation methods, precision, and tolerance of the Solver. Use the Model Setup > Numerics tab to work with these settings. The default numerical options work well in most cases and so we will keep the numerical settings as defaults. 
Run the Simulation: Coarse Mesh Estimate We will now run the first iteration of the simulation without selecting any additional data to be output. This is a first try because we have not applied an ideal mesh size to the simulation. 
� Save the simulation by selecting File > Save Simulation from the top menu or by pressing CTRL+S. 
� Run the simulation by selecting Simulate (not the Simulation tab) from the top menu 
� Select Run Simulation.  



The interface will automatically switch to the Simulate tab. The preprocessor should complete quickly and then the solver will start. The simulation should run in less than 1 minute. Select Mean kinetic energy at the left and note that the MKE begins to oscillate around a mean value as the simulation progresses. This tells us that our estimate of characteristic time (t = 0.77 s) was reasonable since we expect the flow to be steady within 10 to 20 time scales. Once the simulation finishes it will post-process the data. When the text readout at the screen bottom displays the message 'Postprocessor Done', the simulation is complete. 

 Figure 19: Oscillation of steady-state mean kinetic energy (MKE) with coarse mesh 
Probing Mesh Dependent History to Determine the Flow Rate We are now able to determine the volumetric flow rate across the upstream boundary. Open the Results File 
� Select the Model Setup > Analyze tab. A file dialog will appear with the results file flsgrf.Vertical_Drop.  
� Select this file and then click OK. Visually Check the Results for Physicality 
� Among the tabs at the top of the screen, select 2-D. 
� Select Render at the bottom of the screen. 
� Step through the eleven data restart plots by selecting Next from the buttons on the right of the screen. At the final (steady-state) time step, the view should match that shown in Fig. 20. Notice that the free-surface jet over the drop structure is too thin to be resolved and that the free surface of the visible water is “blocky” at this preliminary mesh resolution. 



 Figure 20: Poorly resolved preliminary steady-state solution Determine the Volumetric Flow Rate Graphically 
� Select the Model Setup > Analyze tab. 
� Among the tabs at the top of the screen, select Probe. 
� Under Data source, select the Mesh dependent history radio button. 
� In the Data variables selection pane, click the Select check boxes for left boundary fluid 1 volume flow rate and right boundary fluid 1 volume flow rate. 
� Under Output form, select Graphical. 
� Make sure that under Time frame the left and right slider bars are extended to the minimum and maximum simulation times. The screen should appear as in Fig. 21. 
� Select Render at the bottom of the screen. The tab switches to Display. 
� Above the frame selection pane, change the dropdown from Single to Overlay. 
� Select both frames (1 and 2) by clicking on their names. The screen should appear as in Fig. 22. Because of the poor mesh resolution, the outgoing flow rate is oscillating about the mean. The incoming flow rate, however, is fairly steady, and we will use this rate as our estimate. 



 Figure 21: Probe Analysis Selection Screen 



  Figure 22: Probe Analysis Results Determine the Volumetric Flow Rate Numerically 
� Return to the Analyze > Probe tab. 
� Select Text output instead of Graphical output. 
� Deselect right boundary fluid 1 volume flow rate, since we only want the steady-state rate at the inlet. Select Render. 
� A text report appears as shown in Fig. 23. Next to each time entry in the simulation is listed a time and a value for vfb1, which is the x-minimum volumetric flow rate at that time. Note that the flow rate increases from zero at the beginning of the simulation and oscillates around a mean at the end. This indicates that the simulation is reaching steady state, but our mesh is too coarse to reach a numerically stable result. Nonetheless, for this first pass, the results are reasonably accurate, and so to determine the steady-state flow rate, we will average the last 10 values in the output file. The steady state flow into the simulation Q is approximately 0.243 m3/second. Select Continue to exit the dialog. 



 Figure 23: Text Output of Volumetric Flow Rate 
Using the Coarse Flow Rate to Estimate the Nappe Width Now we are ready to adjust the mesh to the minimum necessary to resolve our problem. First, we return to the equations of Rand (1955) to estimate the nappe width. 
� From Rand (1955), . 
� The drop height Hdrop = 0.62 meters as defined in the Problem Specification, above. 
� Critical flow depth for a rectangular channel is defined as . 
� qW is the flow rate per unit width. Since our simulation is 1 meter wide (the mesh extents in the y-coordinate are 0,1), qW = 0.243 m2/s. 
� Gravity was previously defined on the Physics tab as g = 9.81 m/s2 in the downward direction. 
�  
�  We can estimate the thickness of the nappe is about 0.069 m. Therefore, a mesh size of 0.069/3 = 0.023 m is probably adequate to resolve the flow. Rounding down, we will use a mesh resolution of 0.02 m. 
Refine the Mesh Using the Nappe Width Refine the Mesh to Resolve the Flow at the Nappe. 
� Select the Model Setup > Meshing and Geometry tab.  
� Expand the Mesh - Cartesian > Mesh Block 1 tree at the left. 
� Right click on Mesh Block 1 (as shown in Fig. 23) and select Auto mesh. 



 Figure 23: Use Auto Mesh to generate mesh cells 
� In the Auto Mesh pop-up window select X Direction and Z Direction. 
� Select Size of Cells and enter the cell lengths as 0.02. 

 Figure 24: Specify a cell size of 0.02 m in the X and Z Directions 
� Click OK. 
� Save your work. 
Apply a Constant Maximum Turbulent Mixing Length As previously discussed, it is usually more appropriate to use a dynamically calculated maximum turbulent mixing length. This is somewhat a matter of taste and experience, and there are situations (like sediment scour simulations) where a manually selected length is more effective. We will now select a manual length for demonstration purposes. Normally this step would only be applied if there was a problem with the turbulence modeling. The nappe was estimated to have a thickness of 0.07 m, and the depth of the flow in the impingement region is probably about twice the nappe thickness (this is a rough estimate). This gives an estimate of the turbulent length scale of 2 * 0.07 m * 7% = 0.0098 m. 



Change the Turbulent Mixing Length Method 
� Select the Model Setup > Physics tab.  
� Select the Viscosity and turbulence button. The dialog shown in Fig. 25 will appear. 
� Under Maximum turbulent mixing length, change the method to select Constant, and enter 0.0098 as the constant turbulent mixing length.  
� Click OK. 

  Figure 25: Switch to a manually calculated turbulent length scale. 
Add Flux Surfaces to Analysis We are interested in the depth of flow db at the edge of the drop. Because the edge of the drop is a precise location we would rather not use a cell-centered average value. We will use a flux surface to find the flow depth directly. Flux surfaces, also called flux planes, are a diagnostic feature in FLOW-3D for recording time-dependent fluid and energy flow rates and other hydraulic parameters as well as counting particles and scalar concentrations. Although they can have any porosity, flux surfaces that are used as sampling points are represented as 100% porous baffles so they do not affect the flow in any way. 



Set up a Flux Surface at the Drop Edge. 
� Select the Model Setup > Meshing & Geometry tab. 
� Since the edge of the drop structure is at x = -0.0, we will place our first flux surface there. Note that baffles, including flux surfaces, occur by definition at the interface between cell planes. Because of this constraint, flux surfaces will be moved during pre-processing to the nearest cell face, and this means that baffles that are slanted relative to the mesh will become stepped. 
� In the meshing tree on the left, right-click Baffles, and select Add. 
� Expand the newly added Baffle 1 tree and activate Define as Flux Surface. 
� Expand the Definitions portion of the Baffle 1 > Baffle Region 1 tree and enter 0.0 as the X Coordinate. This creates a flux plane across the entire Y-Z plane at x = 0. Note that we could also use the Limiters portion of the tree to create a flux surface that is like a window within the mesh. 
� Expand the Porosity Properties for Baffle 1 and set Porosity to 1.0. 
� Give the Baffle Name as Edge and Save your work. The tree should appear as in Fig. 26. 

 Figure 26: Adding a Flux Plane Baffle 
� Check your work using FAVORize. FAVORize is a tool that allows you to see your geometry and initial fluid regions the way the FLOW-3D solver will see it. It is a useful tool for checking the resolution of meshes, as well as data that is not visible in the normal Meshing & Geometry view, such as the location of baffles and initialized fluid. Select the FAVORize button above the display; it looks like this: . 
� Use the radio buttons to View Component Volume as Solid. 
� Select Render. 



� Note the flux plane is now visible. When you are done viewing the FAVORized geometry, select Return To Model Building to exit the FAVORize tool. 

 Figure 27: FAVORized geometry showing flux planes. 
Select Output Data The default data output settings in FLOW-3D will generate Restart data at intervals of 0.1*Finish time, or every 1.5 seconds for this case. Restart data is used to create various graphics including 2-D contour plots and 3-D surface plots, and also includes a complete solution of the necessary equations to describe the flow field. To create interesting animations of your simulation, data at more frequent intervals is necessary: Selected data. This output has a default interval of 0.01*Finish time, which will produce 100 data dumps: one every 0.15 seconds, in this case. Using Selected data to get more frequent output is preferable to specifying a more frequent Restart data interval, because Restart data sets are very large. Specifying Selected Data 
� Select the Model Setup > Output tab. 
� Under Additional output, select Hydraulic data (useful for hydraulics applications), Fluid residence time (to check our estimate of characteristic time) and Total hydraulic head (to estimate energy loss over the drop). These values will now be included in the Restart data. They are secondary data, that is, developed from other parameters, so they are not included by default. 
� In the Selected Data field, select Fluid Fraction, Pressure, Fluid velocities, Hydraulic data, Fluid residence time, and Total hydraulic head, as shown in Fig. 28, to output these values more frequently. 



 Figure 28: Choose selected data for output Throughout the simulation these selected flow quantities will be written out at intervals of 0.01*the Finish time. In this case, Selected data will be written at t = 0.00, 0.15, 0.30, 0.45 ... 15.00 seconds. 
Run the Simulation: Refined Mesh We will now run the second iteration of the simulation with our additional output data selected. 
� Save the new simulation by selecting File > Save Simulation from the top menu or by pressing CTRL+S. 
� Select the menu bar dropdown Simulate (not the Simulation tab) from the top menu bar. Select Run Simulation. 
� When notified that the output file flsgrf.Vertical_Drop already exists, select Overwrite. Note that if the goal were to compare the model results with the coarse mesh and the refined mesh, we would want to save the new results file with a different name. The simulation run time will vary depending on many factors: the type and number of processors available and used for the simulation, the number and type of other programs running (including operating system processor use), available memory, hard disk space available, and others. 
� Select Mean kinetic energy at the left. Note that this time, with the refined mesh, the MKE comes to steady state without oscillating. This is one indicator that our mesh size is reasonable. 
� Click on the red Warnings and Errors button to get a readout of notable moments in the simulation. There is one convective flux error at the beginning of the simulation: convective flux iterations (by the explicit solver) do not affect accuracy, and can safely be ignored when they do not cause excessively small time steps, and especially when they occur at the beginning of the simulation. There is one Mentor Tip that the fluid volume error exceeds 5%. Looking at the output plot on the Simulation tab for Conv. volume error (% lost) shows an erroneous fluid gain of about 14% before the first second of the simulation elapsed. This indicates that mass conservation is negatively affected, and implies an incorrect solution at that time. However, by the beginning of the quasi-



steady state solution at t = 8 seconds, the total error is less than 2% and improves from there, so we have confidence in our results. There are several Mentor Tips that the flow is nearly steady: these confirm that we selected an adequate Finish time, and let us know that the flow is nearly steady by 8.7 seconds (we will use this later to derive time-averaged values). Once the simulation finishes it will post-process the data. When the text readout at the screen bottom displays the message 'Postprocessor Done,' the simulation is complete. 

 Figure 29: No oscillation of steady-state mean kinetic energy (MKE) with resolved mesh 
Analyze Simulation Results The ultimate goal of the simulation is to determine the flow characteristics such as flow depths and energy losses. The results of the simulation can be analyzed while the simulation is running or after the simulation has completed.  Open the Results File and Check for Physicality 
� Select the Analyze tab.  
� Note that the option Reload results file is highlighted in red. Select this to reload the newly overwritten flsgrf.Vertical_Drop results file. 
� Among the tabs at the top of the screen, select 2-D. Accept the default contour variable (pressure) and vector type (plain velocity vectors). 
� Select the Vector Options box and a vector spacing of one per every two cells by entering 2 for X and Z.Select OK to close the dialog. 
� Expand the X Limits Sliders and Z Limits Sliders to display the entire domain. 
� Expand the Time Frame Sliders to cover all available Restart data time steps (t = 0 to t = 15 seconds). 



 Figure 30: Select vector spacing 
� Select Render at the bottom of the screen. 
� Step through the eleven data restart plots by selecting Next from the buttons on the right of the screen. At the final (steady-state) time step, the view should match that shown in Fig. 31. Notice that the free-surface jet over the drop structure is now well-resolved and that the free surface of the visible water is smooth at this refined mesh resolution. Also note that the flux plane is visible at the drop edge. 

 Figure 31: Well-resolved steady-state solution at t = 15 seconds The interesting downstream features of the drop are the depth of the pool hp, the downstream depth yp, and the pool length, L, which are defined in Fig. 32. It is also important to estimate the energy loss E over the drop. The height of the drop structure is defined here as H = 0.62 m. The downstream depth is the steady-state depth of flow just downstream of the pool, and is typically less than the depth in the impact pool. The pool length is defined as the length of flow between the drop structure and point where the downstream (steady) depth is reached. We will now determine these parameters from the simulation results. 



 Figure 32: Characteristics of flow over the drop structure. Determine Pool Length L The pool length L is the distance from the drop surface to the point where the angle of the nappe entering the pool coincides with the floor. Because the angle of the nappe varies after entering the pool, it can be difficult to define the location of the downstream end of the pool. We will estimate this point as the point at which the vertical component of velocity approaches zero. 
� Select the Analyze > Text Output tab.  
� Select Selected as the Data source. This selects the output data that was written every hundredth of the simulation time (every 0.15 seconds).  
� Select z-velocity in the Data variable list. 
� Select the X Limits sliders to output values for the cells between x = 0.51 m and x = 1.99 m (the locations listed are the cell centers). 
� Move the Z Limits sliders together to output the component velocity at cell center z = 0.01. 
� Move both sliders in Time frame to the last time frame, t = 15 seconds, as this is the only time frame we're interested in currently. 
� Click the Render button. 
� The results will appear as shown in Fig. 33 below. 
� The z-magnitude velocity is very negative where the pool entry occurs, quickly leveling out by x = 0.91 m, and then slightly positive as the flow thickens downstream of the nappe. We can interpolate the inflection point where z-velocity = 0 to be the end of the pool at x = L = 0.913 m at the final time step. 
� We might expect that the location of the inflection point will vary with time, even though the simulation has reached steady state. For many problems, it would be sufficient to use the final time step value as our steady-state estimate. We can check this assumption by moving the X Limits sliders to plot only x = 0.81 to x = 0.97, and extending the Time frame sliders to cover the time period from t = 8.7 seconds to t = 15 seconds (the time period during which the solver reported the flow as nearly steady). Select Render to see the output as shown in Fig. 34. 
� Copying this data to a spreadsheet program for manipulation allows us to take the time average of the interpolated inflection points to compare to the final time step. This gives a more accurate estimate 



than in the previous step, as it shows the oscillation of the pool length due to turbulence. The pool length L varies between 0.841 and 0.938 m, and the average pool length L is 0.883 m. 

  Figure 33: Text output of Z-Velocity showing inflection point at last time-step 



 Figure 34: Text output of Z-Velocity showing inflection point varying with time Determine the Downstream Depth y1 Now that we have determined the location of downstream depth y1 in the x-direction (coinciding with the pool length), we can take a time average of the depth at that location. If we are confident with our spreadsheet approach to analyzing the data, we can continue with that method. If we would like FLOW-3D to interpolate the data for us, we can use a Neutral File. To do this, we must write a transf.in file, which is described in more detail later in this manual. 
� Select the Navigator tab. If you are using Windows, look on the right under Selected Simulation and right-click the path listed for Simulation Input File. The folder containing the simulation will open with the prepin file for the simulation highlighted. If you are using a version of Linux, navigate to the simulation manually. 
� Create a text file called transf.in using a text editor. Write the file as shown in Fig. 35. The first three lines are optional title lines, the -1 and 0 lines are required placeholders, and the -0.7 0.0 0.0 line gives the x, y, and z coordinates of the minimum domain boundaries, respectively. After that a single point is given with x, y, z coordinates where we wish to interpolate data. The x point is our average pool length L, the y point is the cell center since it is a 2-D simulation, and the z point is also a cell center, since Fluid Depth output is the same for all z-values at a given x and y. We could list as many points as we are 



interested in, and get interpolated output for all of them, but we are only interested in one point currently. 

 Figure 35: Text output of Z-Velocity showing inflection point varying with time 
� Note that some operating systems (Windows) will attempt to append .txt to the file name. You must remove the added characters by unselecting Hide Extensions for Known File Types under Folder and Search Options and then renaming the file (see your operating system help for more detail). 
� Once the file is saved, return to the user interface and select Analyze > Neutral File. 
� Under Data Source choose Selected. 
� In the Data variables window select Fluid Depth and deselect any other variables that are highlighted. 
� Move the X Limits and Z Limits Sliders to cover the entire domain. 
� Move the Time-frame sliders to cover the range of times from t = 8.7 seconds to t = 15.0 seconds, as before. 
� Click the Render button. 
� As shown in Fig. 36, the output (which is also written to a text file called transf.out in the simulation folder) follows the same format as the input file, with time, title, and placeholder lines followed by the number of output variables (1), the name of the variables (fldpt), a line with the minimum mesh coordinates for reference, and then a line with the interpolation coordinates and variable value(s). 
� The depth oscillates less than 2 mm at the average inflection point. Taking the time average of the interpolated values shows the downstream depth y1 varies between 0.0562 and 0.0579 m, and averages 0.0572 m. 



  Figure 36: Interpolated neutral file output showing fluid depth at average pool end location. Determine the Pool Depth yp From Fig. 32 it can be seen that the pool depth yp must be measured at a location where two free surfaces exist in the vertical direction (the flow over the drop structure and the pool below it both have free surfaces). Using fluid depth as an output variable, as we did to find the downstream depth, will not work for the pool depth since the output only indicates the depth of the uppermost fluid surface. Instead, fraction of fluid will be used to locate the lower free surface. We will determine the lowest elevation at which the fluid fraction (per cell) transitions from nearly 100% to nearly 0%. This is the free surface transition. The location h1 is just slightly downstream of the drop face which is located at x = 0.0. A text output of fraction of fluid in the vertical row of cells just downstream of the drop will tell us the location of yp. 
� Select the Analyze > Text Output tab 
� Move both X sliders in the Limits group box to x = 1.0e-2 (sliders move from cell center to cell center, and our cell size is 0.02 in the x-direction, so 0.01 is the center of the cell adjacent to the x=0 axis, which is also the face of the drop structure).  
� Select Fraction of Fluid in the Data variables list and deselect any other variables. 
� We want to look at these values in the first column of cells downstream from the drop structure, which is 0.62 m high. Slide the Z sliders in the Limits group box to include the z-range from 1.0e-2 to 6.1e-1. 
� Move both Time-frame sliders to the last time frame, 15 sec. By doing this, we will only plot the fluid fractions in the column of cells adjacent to the drop structure face at the final time step. We are assuming that the pool depth is at steady state at this time. If the pool depth is oscillating, then we 



would want to include the time average of the steady-state period of the simulation. The selections should appear as in Fig. 37. 
� Click Render button. 
� The results will appear as shown in Fig. 38. 

 Figure 37: Limits for using fraction of fluid to determine pool depth 



  Figure 38: Locating the pool depth water-air transition 
� In the displayed results you will see that X, Y and Z points are arranged with Z in ascending order. The fluid fraction is displayed for each cell starting at the bottom of the pool and proceeding to the top, cell by cell. Each z-coordinate corresponds to the center of a cell (rounding shows that the cell centers are spaced every 0.02 m, with the lowest cell center at 0.01 m, following our mesh specifications). In the cell with center z = 0.31, the fluid fraction is 0.671 (67.1%). The cell above this, with center z = 0.33, has a fluid fraction of zero (air), and the cell below this (center z = 0.29) has a fluid fraction of 0.99 (wet), so it is in the cell with center 0.31 that the free surface is found. Interpolating using the cell edges: z = 0.30 + 0.671*(0.32 - 0.30) = 0.3134 gives the precise elevation of the free surface at the final time step. 
� As an optional step, choose Selected data, select z limits = 0.28 to 0.32 m, open the time sliders to cover the steady-state period from t = 8.7 to 15 seconds to the finish, and take the average of the pool depth using fluid fraction as explained above. This is best accomplished in a spreadsheet, although it is helpful to plot it graphically from the Probe tab as shown in Fig. 39. The pool depth ranges between 0.301 and 0.303, and the average pool depth yp is 0.302 m. 

Fluid fraction is greater than 0 and less than 1 (0.627) at this location.  This indicates the pool free surface is located 62.7% of the distance between 0.30 and 0.32 m. 

Increasing Z 



 Figure 39: Quasi-steady-state fluctuation of pool depth yp at z = 0.31 (z = 0.29 not shown) Determine Critical Depth yc and Critical Flow Location xc on the Drop Structure 

 Figure 40: Energy loss parameter definition between sections 1 and 2 The energy loss across the drop structure is the difference between the flow energy at Section 1 (the critical flow point) and 2 (the end of the pool), as shown in Fig. 40. The energy at section 1 (E1) is the hydraulic head 



of the fluid at xc, where subscript c indicates the critical flow section. We will locate the critical flow transition and the hydraulic head of the critical flow point and pool end using FLOW-3D's output. We must first determine the location xc of the critical transition and the depth yc. The definition of critical flow is flow with Froude number Fr equal to 1, so we need to determine the X location on the drop structure where the Froude number changes from subcritical (Fr < 1.0) to critical (Fr = 1.0). This can be done by creating Text Output of Froude number above the drop structure. 
� Select the Analyze > Text Output tab. 
� We want to look at Froude number and fluid depth along the X Direction. Choose Selected from the Data source box on the left. 
� Select (only) Froude Number and Fluid Depth in the Data variable list. 
� Check the sliders in the Limits box: time and z should be maximum only. Fluid depth and Froude number are reported by FLOW-3D for each column of z-cells, rather than separately for each cell in the column. Using only the top-most z-cell as the reporting criteria prevents repeating the same data over and over for each layer of z-coordinates. The X limit sliders should include the domain from x = -0.69 to x = -0.01 m (upstream of the drop face). 
� Click Render button. 
� The results will appear as shown in Fig. 41 below. 



  Figure 41: Identifying critical depth yc  Critical depth can be determined at the point where the Froude number = 1.0. Interpolating the fluid depths and X-direction cell centers between the points where Fr = 0.9975 and 1.0218 in Fig. 39 gives the exact result for the final time step, which if we check does not vary (to four significant digits) during the steady-state period from t = 8.1 to t=15 seconds. The minimum, maximum, and average critical depth yc is 0.1576 m, and occurs at xc = - 0.448 m. Use the Flux Surface to find Flow Rate Q at the Drop Edge 
� Select the Analyze > Probe tab, and under Data source select General history (this is where flux surface output is found). In Output form, select Graphical. 
� In the Data variables window select fluid1 flowrate at Edge. 
� Select Render. The plot will appear as in Fig. 42. 
� To determine the flow rate Q more accurately, re-render the plots in Text mode. Flow rate Q ranges from 0.1952 to 0.1965 m3/s, with average flow rate Q of 0.1958 m3/s. 
� Note that this differs significantly from our original estimate of 0.243 m3/s, although probably not significantly enough to warrant recalculating the nappe width and readjusting the turbulent mixing 



length and mesh resolution. You can check this by using a finer mesh and seeing if the flow rate or other parameters change. 

 Figure 42: Flow rate at Flux Plane Determine Energy Loss Determine the energy loss between the critical point and the downstream end of the pool using the Neutral File. 
� Edit the neutral file transf.in you created in a previous step as shown in Fig. 43. Note that the two points we are now going to look at interpolated information for are the upstream critical depth location and the downstream average end of the pool length. Save the file when you are done. 



 Figure 43: Neutral File to interpolate hydraulic head 
� Select the Analyze > Neutral File tab. 
� Choose Selected under Data source. 
� Separate the Min and Max sliders of the Time frame to 8.7 and 15 seconds. 
� Separate the X and Z Limits Sliders to cover the entire domain. 
� Select Total Hydraulic Head under Data Variables. 
� Click on the Render button. The output variable is listed in the output file as thead. 
� Subtract the first value (E1) from the second value (E2) to find the head loss ∆E.  Note that the total hydraulic head includes the velocity component and elevation component of each cell center. It is not a depth-averaged value. The time average of the head loss shows that the head loss ∆E = E1 - E2 varies between 0.1888 and 0.2050 m, with average head loss ∆E = 0.1980 m. The average upstream head E1 = 0.8571 m. 
Estimate Drop Characteristics with Empirical Equations Rand (1955) and Rajaratnam & Chamani (1995) provided the following equations that best fit their experimental data:   (Rand, 1955) 

  (Rand, 1955)   (Rand, 1955) 
  (Rajaratnam & Chamani, 1995) 



Where h1 = pool depth, h2 = downstream depth, L = pool length, yc = critical depth (0.1576 m), and H = the drop height (0.62 m). 
Compare FLOW-3D Results with Empirical Equation Results The following table shows the comparison between FLOW-3D results and the results from empirical equations.  FLOW-3D average results Fitted experimental results Percent difference Downstream depth y1 0.057 0.058 2% Pool depth yp 0.302 0.251 -20% Pool length L 0.883 0.879 -0.4% Relative Energy Loss ∆E/E1 0.231 0.314 26% Table 1: Results of the 2-D FLOW-3D simulation compared to the results computed from experimental fit equations by Rand (1955) and Rajaratnam and Chamani (1995). 
Discussion of 2-D Results While the downstream depth and pool length matched the experiments almost exactly, the pool depth and energy losses were 20% - 30% different from the experimental values. Both the pool depth and the relative energy loss are sensitive to the effects of turbulence and involve rotating flows in the recirculating pool. There are several parameters that could be experimented with to determine if a better result is possible, and should at least be included in estimating the uncertainty of the results: 
� Try letting FLOW-3D calculate the maximum turbulent mixing length (TLEN) dynamically instead of setting it on the Model Setup > Physics tab. Our initial guess assumed that the nappe width is the controlling hydraulic diameter, and at the impact point it probably is. But what about in the pool, and downstream? There are multiple controlling diameters, and the dynamic computation allows for this to be taken into account by assigning each cell a unique maximum turbulent mixing length. This option is often equivalent to assigning an arbitrarily high TLEN. 
� Experiment with reducing the cell size on the Model Setup > Meshing & Geometry tab: does this change the results? This is called a mesh-dependency or mesh-sensitivity study, and is often part of hydraulic projects to get an understanding of how sensitive the results are to the size. 
� Try using the 2nd-order, monotonicity-preserving momentum advection on the Model Setup > Numerics tab: this is more accurate but slower than the default 1st-order. 
� Adjust the values on the Model Setup > Fluids tab to include more a precise density and viscosity: the default FLOW-3D values for water are approximations only. An equation-of-state relating pressure and temperature to these parameters can be used. 
� Add 'limited compressibility' (RCSQL) to the water on the Model Setup > Fluids tab. This value is physically the inverse of the bulk modulus of elasticity, or 1/(RHOF * w2) where RHOF is the fluid density, and w is the adiabatic speed of sound in the fluid. Limited compressibility allows the model to propagate pressure waves in a physical way, and this eases the stiffness of the problem (increasing solver efficiency) and also provides a more physical result. 



� The actual flume experiment by Rajaratnam and Chamani took place in a 0.46-m wide flume with Plexiglas sides. The wall effects are probably not negligible, and the turbulent mixing in the recirculation zone takes place in three dimensions. Simplifying this problem to a 2-D case as we have ignores these, and so probably is contributing to an insufficient energy loss (and therefore an exaggerated pool depth). A 3-D case should be run to investigate whether this supposition is true. 
� The flow are upstream of the drop structure appears to be short, and it is unlikely that a boundary layer is forming sufficiently before the drop occurs: this might affect the drop turbulence characteristics. This discrepancy may be affecting the results, which are being compared to an experiment that took place in a much longer flume. 
References Chanson, H. (1996). Energy Loss at Drops - Discussion. Journal of Hydraulic Research, IAHR, Vol. 34, No. 2, pp. 273-278 (ISSN 0022-1686). Rajaratnam, N. and M.R. Chamani (1995), Energy loss at drops, Journal of Hydraulic Research, IAHR, Vol. 33, No. 3, pp. 373-384. Rand, W. (1955), Flow Geometry at straight drop spillway, Proc ASCE., Vol. 81, No. 791, pp. 1-13. 
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Microfluidics Tutorial - Capillary Filling 
Simulation 
Problem Description & Objectives Capillary filling is often used to direct liquid into microchannels. Trapping of air bubbles during capillary fill is undesirable and so it is important to know if air bubbles will be trapped for a particular design. It is also of interest to know the filling time for a particular geometry. In this exercise we will learn how to set up a simulation of capillary filling. 

 Figure 1: Microchannel geometry 
Problem Specification Geometry Specifications: 50µmx50µm cross section microchannel as shown in Fig. 1. Flow conditions: 
� Inlet in contact with a micro-reservoir open to atmosphere. 
� Outlets open to atmosphere. 
� Free surface with sharp interface. 



� Use a 3-D domain (three-dimensional Navier-Stokes solutions). Fluid properties (Water) 
� Viscosity = 0.001 Pa-s. 
� Density = 1000 kg/m3. 
� Surface tension coefficient = 0.073 kg/s2. 
� Contact angle between water and solid = 60°. 
� Treat water as an incompressible fluid. 
� Unit system: SI (meters, kilograms, seconds). 
FLOW-3D Learning Objectives 
� Practice geometry building for the microchannel 
� Practice meshing a computational domain  
� Specify appropriate boundary conditions 
� Input fluid properties 
� Activate required physical models 
� Run the simulation 
� Analyze the simulation results 
Create Workspace and Simulation File  Please open the FLOW-3D interface by double-clicking the FLOW-3D icon on your desktop.  Create a New Workspace Select File > New Workspace. Enter "Microchannel" as the workspace name. Accept the default settings on this dialog and select OK. 

 Figure 2: Add a new workspace 



Create a New Simulation 
� Select File and Add New Simulation. 
� Enter "Capillary Filling" as the simulation name 
� Select OK. 
Create the Microchannel Geometry We will create the geometry of the microchannel in FLOW-3D by importing a STL file of the microchannel. Note that all units are SI in accordance with the problem specification statement, so the microchannel geometry file should be scaled in CAD so that it has lengths in meters. To import the STL file, click on Subcomponent menu and select Geometry File(s). This brings up the Geometry File(s) dialog box (Fig. 3). Add the STL File to a New Component 
� Select the Model Setup > Meshing & Geometry tab. 
� Select the  button from the toolbar. This opens the Geometry File(s) dialog. 
� Click the Add button and browse to the c:\flow3d\v10.x\gui\stl_lib\ directory. 
� Select the file microchannel.stl, then Open and OK. 
� Name the component Channel, and select OK to make the component Standard (solid). 

 Figure 3: Add the geometry .STL Create Geometry Create the rest of the geometry using solid boxes and a hole to cut the entrance channel 



� Open the tree: Geometry > Component 1: Channel > Subcomponents > Subcomponent 1 > Min/Max to see the extents of the geometry. These extents are not editable, but can be changed by applying Transformations under that branch of the tree. 
� Rounding a bit due to the accuracy of the CAD export we see that Min Y = 0 m and Max Y = 0.00025 m. 
� Add a new subcomponent to Component 1: Channel by selecting the Subcomponent > Box option from the dropdown menu above the display pane. Make sure the Add to Component dropdown selects Component 1. 
� Name the new subcomponent Left Edge, and fill in values as shown in Fig. 4 below. These are determined from the geometry specification given in Fig. 1. 
� Add three more solid boxes, both to Component 1, named Right Edge, Left Edge, and Back Edge, following Fig.s 4, 5, and 6 below. 

 Figure 4: Create the left side 



 Figure 5: Create the right side 

 Figure 6: Create the back side 
� Add one more box named Entrance, also to Component 1, as a Hole (under Subcomponent Type in the Add Box Subcomponent dialog). Use Fig. 7 as a guide. 



 Figure 7: Create the entrance as a hole 
� The geometry should now appear as in Fig. 8, with the final hole highlighted by selecting Subcomponent 5: Entrance in the Geometry > Component 1 > Subcomponents tree at the left. If your geometry does not match, open the Subcomponent > Limiters tree for the incorrect part and correct any mistakes so the values for X Low, X High, Y Low, Y High, and Z Low, Z High match those given above. 
� Save your work. 



 Figure 8: Final geometry with the entrance selected to highlight it 



 Figure 9: Use the Limiters branch of each subcomponent to fix mistakes 
Create the Mesh 
� Create the mesh. On the Model Setup > Meshing & Geometry tab, right-click on the Mesh-Cartesian tree and select Add a Mesh Block. Select Yes to create Mesh Block 1.  
� Fit the mesh. Right-click the Mesh block 1 branch and select Fit to Geometry. 



 Figure 10: Fit the mesh block to the geometry automatically 
� Create a uniform mesh in all three directions by selecting the X, Y, and Z direction checkboxes. Enter 5000 as the number of Total Cells. Select OK. 

 Figure 11: Mesh automatically in three dimensions for a total of 5000 cells  
� If the new mesh is not visible, select Mesh > View mode > Grid Lines from the toolbar above the display, and move the Transparency slider to adjust the opacity of the subcomponents. 
� The mesh and the geometry should now appear as shown below. 
� Save your work. 



 Figure 12: Final mesh  
Refine the Mesh At this point the geometry of the microchannel is specified and we have created a mesh block and modified it to fit to the geometry. The next step is to refine the mesh. When creating computational mesh always keep in mind the following two considerations: 
� Minimize the size of the computational domain to avoid unnecessary computations.  
� Do not minimize the size of the computational domain to the point where the boundary conditions are too close to regions of high flow gradients as this can affect the results. In this case the modified mesh block satisfies the second consideration, but the size of the computational domain can be reduced. Observe that there is symmetry in the geometry along the center Y-Z plane as shown in Fig. 13. In this case, we can assume that the flow pattern will be symmetrical about this center plane. If we make this center plane as a mesh boundary and specify symmetry boundary condition for this plane we can model only one half of the geometry, which will reduce the computational time.  



 Figure 13: Plane of symmetry  Adjust the Mesh Block to Halve the Domain. 
� In the Model Setup > Meshing_Geometry tab expand the Mesh -Cartesian tree so that you see the mesh tree as shown in Fig. 14.  
� Modify X direction Mesh Plane 1 from 0.0 to 3.5e-05.  
� Click on the Update mesh  icon to see the new mesh configuration. 

 Figure 14: Mesh Block Specifications  It is often beneficial to place fixed points in regions of the computational domain where additional meshing constraints are needed. Also, fixed points can be useful for resolving solid surfaces more accurately. NOTE: IT IS RECOMMENDED THAT FIXED POINTS BE SPECIFIED AT FLAT SURFACES OF THE GEOMETRY. 



 Figure 15: Use fixed points to match flat surfaces  Add Fixed Points into the Mesh The next step will be to add fixed points into the mesh at the locations that match solid surfaces of the microchannel in all three directions. 
� Right click on Mesh Plane 1 in the Z Direction branch of the Mesh – Cartesian > Mesh Block 1 tree. 
� Select Add. 
� In the Add Mesh Plane pop-up window add a New Mesh Plane at -5e-5 (-50 microns), as shown in Fig. 16. 

 Figure 16: Add a mesh plane  
� Select Add. 
� A Mesh Plane (2) = 150 e-6 will appear in X direction branch. 
� Repeat the steps above to add fixed points in all three directions as shown in Fig. 17. The mesh will appear as in Fig. 18. 



 Figure 17: Enter all fixed points manually 



  Figure 18: Mesh showing all fixed points Select Mesh Cell Size The choice of mesh cell size is an important one. The computational mesh should be only fine enough to resolve the geometry and capture the flow features of interest. An excessively fine mesh will needlessly increase the simulation runtime and may require more hardware (memory, video). For microfluidics simulations, surface tension is an important force. The accuracy of the surface tension force calculated by the solver depends on how accurately the curvature of the free surface is resolved. Accuracy of the curvature depends on how fine the mesh is. For simulations where surface tension force is dominant it is recommended to have cells with aspect ratio 1:1:1 (cubic cells), as these provide the best performance for the surface tension solution. RULE OF THUMB: AT LEAST 10 CELLS ARE REQUIRED TO RESOLVE A FREE SURFACE CURVATURE CORRECTLY WHEN USING THE SURFACE TENSION MODEL.  The microchannel cross section is 50 x 50 µm. In this case the curvature will form across the microchannel width. Therefore, a mesh size of 5µm (50 µm/10) or 5e-6 m is probably necessary to adequately resolve the curvature correctly. 



� Right-click the Mesh block 1 branch and select Auto mesh... 

 Figure 19: Fit the mesh block to the geometry automatically 
� Create a uniform mesh in all three directions by selecting the X, Y, and Z direction checkboxes. Enter 5e-6 as the number of Size of Cells. Select OK. 
� Save your work. 

 Figure 20: Mesh automatically in three dimensions for surface curvature resolution  



Set Boundary Conditions We will specify a pressure boundary condition at the inlet (minimum Z) boundary assuming that the upstream end is in contact with a water reservoir which is at atmospheric pressure. At the outlet end we will assume that the microchannel is open to atmosphere. At the X Max boundary (at x = 6e-5 m), we will define the boundary as a wall-type. We could also do this with another component: one difference between a wall and a component is that wall boundaries cannot have surface roughness (they are always hydraulically smooth). Since we are not using surface roughness, this is okay. Note that the default boundary condition is symmetry so we need not define the symmetry condition at X Min = 3.5e-5 m. Define a Wall-Type Boundary at the X Max Boundary 
� Select the Mesh – Cartesian > Mesh Block 1 > Boundaries branch and then select the X Max boundary. The boundary dialog box will appear. 
� Select the Wall radio button, then OK. Define a Boundary Condition A pressure boundary condition in contact with a water reservoir at atmospheric pressure is to be defined at the Z minimum boundary. 
� Select the Mesh – Cartesian > Mesh Block 1 > Boundaries branch and then select the Z Min boundary. The dialog box shown in Fig. 21 will appear. 
� Select the Pressure radio button. 
� Enter a value of 1.013e5 Pa in the Pressure box entry, which means we have set atmospheric pressure in absolute terms (as opposed to gauge pressure, where atmospheric is zero). 
� The default F fraction (Fluid fraction) value is 1.0, which means this end is in contact with a reservoir of Fluid 1 (which we will define shortly). No entry is needed to keep this default. 
� Click OK. 

 Figure 21: Z Min wetted pressure boundary at atmospheric pressure  



Define Pressure Boundary Condition Define pressure boundary condition open to atmosphere at Z maximum boundary. 
� Select the Boundaries tab and then select the Z Max boundary. The dialog box shown in Fig. 22 will appear. 
� Select the Pressure radio button. 
� Enter a value of 1.013e5 Pa in the Pressure box entry, which means we have used pressure in absolute terms. 
� Set F fraction (Fluid fraction) to 0.0, which means this end is open to atmosphere. Fluid that contacts this boundary will be removed. 
� Click OK. 
� Save your work. 

 Figure 22: Z Max dry pressure boundary at atmospheric pressure  
Specify Fluid Properties From the Problem Specification at the beginning of the tutorial, the working fluid in the simulation is water. The viscosity is 0.001 Pa-s, the density is 1000 kg/m3 and the surface tension coefficient is 0.073 kg/s2. The properties can either be entered manually or loaded from the material database. The properties will be loaded from the material database for demonstration purposes. Add Fluid Properties 
� Select the Model Setup > Fluids tab. 
� From the menu bar at the top of the screen, select Materials > Fluids Database. 
� In the Fluid database under Material Name select Water at 293 K with SI units. 
� Select the Load Fluid 1 button, and then select Convert units to SI (this sets the simulation to SI units, which can also be set on the General tab). Properties for water in SI system will be loaded. 



� Expand the Properties tree as shown in Fig. 14. Verify that the values for density, viscosity and surface tension coefficient have been loaded. Note that the viscosity and surface tension values are grayed out, because we have not activated viscous flow or surface tension on the Physics tab. 
� Save your work. 

 Figure 23: Fluid properties for water in SI units as loaded from the material database. 
Specify Initial Conditions For this simulation we will start with a domain that is completely filled with air and no liquid (water) initially in the microchannels. We are running this simulation as a one fluid sharp interface case. This means Fluid 1 will represent water and empty or void region will represent air. The default initial condition is that the domain is empty or void, so there is no need to define any fluid region. Since we are representing air with a void region the solver will not solve for air velocities but will only consider air pressure so we should define initial air/void pressure. Define An Initial Void Pressure 
� Open the Model Setup > Meshing and Geometry tab. 
� Open the Initial > Global > Void Initial State branches of the tree. 
� Under Pressure enter 1.013e5 Pa. 
� Save your work. 



 Figure 24: Initializing a uniform void (air) pressure. 
Activate Appropriate Physics Models By default, all physical models are inactive. To minimize unnecessary computations, it is important to only activate physical models which are required to simulate the desired behavior. The typical procedure for determining which physical model needs to be activated is to compute non-dimensional parameters such as Reynolds number Re (ratio of momentum to viscosity) and Weber number We (ratio of momentum to surface tension forces). For this capillary filling simulation the flow is not turbulent and the effects of gravity are negligible. The effects that are important are the viscous effects and the surface tension effect, so the flow will be modeled using Newtonian Viscosity and Surface Tension models. An important phenomenon that we want to model in this simulation is trapping of air (void) bubbles. For this, we will use the Adiabatic Bubble model. Activate the Newtonian Viscosity Model 
� Select the Model Setup > Physics tab. 
� Select the Viscosity and Turbulence button. 
� Under the Viscosity Options, select the Viscous Flow check box. 
� Under the Turbulence Options, select the Laminar radio button. 
� Click OK. 



 Figure 25: Activate the Newtonian viscosity model. Activate the Surface Tension Model 
� Still on the Model Setup > Physics tab, select the Surface Tension button. 
� Select the Activate Surface Tension Model check box. 
� Set Contact Angle to 60 degrees. This is the global fluid/solid contact angle which applies to wall-type boundaries and any components that do not have separately specified contact angles. 
� Click OK. 



 Figure 26: Activate the surface tension model. Define a Component-Specific Contact Angle for the Microchannel Geometry 
� Select the Model Setup > Meshing & Geometry tab. 
� Open the Geometry > Component 1: Channel > Component Properties > Surface Properties tree as shown in Fig. 27 and define Component Contact Angle as 60 (degrees). 



 Figure 27: Define the contact angle. Activate the Adiabatic Bubble Model 
� Select the Model Setup > Physics tab. 
� Select the Bubble and Phase Change button. 
� Under Bubble Models select the Adiabatic Bubbles radio button. 
� Set the isentropic exponent γ (Gamma) for air to 1.4. This value is the ratio of specific heats of the gas or vapor represented by void, and will also appear on the Fluids tab. 
� Click OK. 
� Save your work. 



 Figure 28: Treat voids as adiabatic bubbles with gamma = 1.4. RULE OF THUMB: THE ADIABATIC BUBBLE MODEL TREATS ANY VOID REGION THAT GETS ENCLOSED BY FLUID OR SOLID OBJECTS AS A BUBBLE. ONCE A VOID REGION IS IDENTIFIED AS A BUBBLE, THE ADIABATIC BUBBLE MODEL EVALUATES THE PRESSURE P IN EACH VOID REGION BASED ON THE VOID REGION VOLUME V USING THE ISENTROPIC MODEL OF EXPANSION OR COMPRESSION IN WHICH PVΓ IS CONSTANT. HERE Γ IS THE ISENTROPIC EXPONENT DEFINED AS THE RATIO OF SPECIFIC HEATS, Γ=CP/CV. 
Specify Simulation Finish Time A Finish Time always needs to be specified so that the simulation knows when to terminate. It is possible to change the finish time during the solver run by using Runtime Options on the Simulation tab. In this case we will start with a value of 3.4e-3 sec (3.4 ms) as finish time. Specify Finish Time  
� Select the Model Setup > General tab.  
� Notice that the box for Finish Time contains a value of 1.0. This is the default finish time for all simulations.  
� Change this value to 3.4e-3 as shown in Fig. 29. 

 Figure 29: Specify the finish time. 



Specify Output Data for Post Processing The default data output settings in FLOW-3D will generate spatial (Restart) data at intervals of 0.1*Finish Time. Restart Data contains values for all variables required for the solution to the flow field, and can also contain additional derived values. Often, greater resolution of the flow at more frequent intervals is necessary. Selected Data is an option that outputs selected variables only at a default 0.01*Finish Time, or 101 data dumps.  Specify Selected Data 
� Select the Model Setup > Output tab. 
� Under Additional Output, select Filling time. 
� In the Selected Data field, select Filling time, Fluid Fraction, Fluid velocities and Pressure. 

 Figure 30: Select more frequent output of desired variables. 
Specify Numerical Options For this simulation we will use implicit surface tension method which allows the FLOW-3D solver to compute surface tension using larger time steps. The danger with implicit solvers is that they can go unstable and produce specious results or crash the solver. The benefit is that they allow much larger time steps, and so speed up many simulations. In general, the default settings are best, but we will use the implicit option for demonstration. 
� Select the Model Setup > Numerics tab. 
� Under Other Explicit / Implicit Solver Options select Implicit for Surface Tension Pressure. 
� For the rest of the numerical options we will use the default numerical settings. 
� Save your work. 
Run the Simulation Launch the Preprocessor and Solver Together 
� Select Simulate (not the Simulation tab) from the top menu. 
� Select Run Simulation. 



� The interface will automatically switch to the Simulation tab. The preprocessor should complete quickly and then the solver will start. The simulation should run in about 5 minutes on a single processor. 
� Check the Warnings & Errors output: there are several convective flux errors. Convection failures do not affect the accuracy of the simulation. They only result in a smaller time step. In extreme cases where the time step falls below the minimum time step they can cause solver termination, but not a loss of accuracy. If there are relatively few of these errors, and especially if they occur early in the simulation, then they can be safely ignored. 
Analyze Simulation Results The goal of the simulation is to determine if any air bubbles get trapped in the microchannel and to find the filling time. The results of the simulation can be analyzed while the simulation is running or after the simulation has completed. Open the Results File 
� Select the Analyze tab. A file dialog may appear with the results file flsgrf.Capillary_Filling displayed. If it does not, select Open at the bottom of the screen. 
� Select the flsgrf output file and then click OK. Determine if Air Bubbles Get Trapped 
� Select the Analyze tab. 
� On the 2-D tab select Pressure under Contour Variable. 
� Under Vector Type select No Velocity Vectors. 
� Select Y-Z under Plane options. 
� Move both the X sliders all the way to the left at X minimum (X = 3.75e-5), which is the symmetry plane. 
� Make sure the Y Minimum and Maximum Limits and Z Minimum and Maximum Limits sliders are fully extended to include the entire Y and Z domain. 
� Also make sure the Time Frame Min and Max sliders are fully extended. 
� Activate the Selected radio button under Data source. 
� Click the Render button at the bottom of the screen. In the Display tab a 2-D plot of the microchannel will appear as shown in Fig. 31. You can click through different time frames using Next/Previous buttons or you can directly click on a particular time frame. 



 Figure 31: 2-D pressure plot along the plane of symmetry shows a bubble. Figure 31 illustrates that an air bubble will likely be trapped in the deeper slot. The time series also illustrates that the surface tension effects will cause the arm with the deeper slot to fill more slowly than the arm with the shallower slot. Observe filling times for different sections of the microchannel 
� Select the Analyze > 2-D tab. 
� On the 2-D tab select Time of First Fluid Arrival under Contour Variable. 
� Move both the sliders under Time frame to the last time: 3.4e-3 seconds. 
� Keep remaining selections the same as for the previous pressure plot. 
� Click the Render button. 



The results will appear as shown in Figure 32. 

 Figure 32: plot of fluid time of first arrival. The plot indicates the time when fluid first reached different sections of the channel. This is a useful guide to sectional filling times and filling patterns. As can be seen flow pattern is same for both the arms of the microchannel until the flow front reaches the slots. 



Chapter 3 - Theory 
Theory Overview FLOW-3D is a general-purpose computational fluid dynamics (CFD) software. It employs specially developed numerical techniques to solve the equations of motion for fluids to obtain transient, three-dimensional solutions to multi-scale, multi-physics flow problems. An array of physical and numerical options allows users to apply FLOW-3D to a wide variety of fluid flow and heat transfer phenomena. Fluid motion is described with non-linear, transient, second-order differential equations. The fluid equations of motion must be employed to solve these equations. The science (and often art) of developing these methods is called computational fluid dynamics. A numerical solution of these equations involves approximating the various terms with algebraic expressions. The resulting equations are then solved to yield an approximate solution to the original problem. The process is called simulation. An outline of the numerical solution algorithms available in FLOW-3D follows the section on the equations of motion. Typically, a numerical model starts with a computational mesh, or grid. It consists of a number of interconnected elements, or cells. These cells subdivide the physical space into small volumes with several nodes associated with each such volume. The nodes are used to store values of the unknowns, such as pressure, temperature and velocity. The mesh is effectively the numerical space that replaces the original physical one. It provides the means for defining the flow parameters at discrete locations, setting boundary conditions and, of course, for developing numerical approximations of the fluid motion equations. The FLOW-3D approach is to subdivide the flow domain into a grid of rectangular cells, sometimes called brick elements. A computational mesh effectively discretizes the physical space. Each fluid parameter is represented in a mesh by an array of values at discrete points. Since the actual physical parameters vary continuously in space, a mesh with a fine spacing between nodes provides a better representation to the reality than a coarser one. We arrive then at a fundamental property of a numerical approximation: any valid numerical approximation approaches the original equations as the grid spacing is reduced. If an approximation does not satisfy this condition, then it must be deemed incorrect. Reducing the grid spacing, or refining the mesh, for the same physical space results in more elements and nodes and, therefore, increases the size of the numerical model. But apart from the physical reality of fluid flow and heat transfer, there is also the reality of design cycles, computer hardware and deadlines, which combine in forcing the simulation engineers to choose a reasonable size of the mesh. Reaching a compromise between satisfying these constraints and obtaining accurate solutions by the user is a balancing act that is a no lesser art than the CFD model development itself. Rectangular grids are very easy to generate and store because of their regular, or structured, nature. A non-uniform grid spacing adds flexibility when meshing complex flow domains. The computational cells are numbered in a consecutive manner using three indices: i in the x-direction, j in the y-direction and k in the z-direction. This way each cell in a three-dimensional mesh can be identified by a unique address (i, j, k), similar to coordinates of a point in the physical space. Structured rectangular grids carry additional benefits of the relative ease of the development of numerical methods, transparency of the latter with respect to their relationship to the original physical problem and, 



finally, accuracy and stability of the numerical solutions. The oldest numerical algorithms based on the finite difference and finite volume methods have been originally developed on such meshes. They form the core of the numerical approach in FLOW-3D. The finite difference method is based on the properties of the Taylor expansion and on the straightforward application of the definition of derivatives. It is the oldest of the methods applied to obtain numerical solutions to differential equations, and the first application is considered to have been developed by Euler in 1768. The finite volume method derives directly from the integral form of the conservation laws for fluid motion and, therefore, naturally possesses the conservation properties. FLOW-3D can be operated in several modes corresponding to different limiting cases of the general fluid equations. For instance, one mode is for compressible flows, while another is for purely incompressible flow situations. In the latter case, the fluid density and energy may be assumed constant and do not need to be computed. Additionally, there are one fluid and two fluid modes. Free surface can be included in the one-fluid incompressible mode. These modes of operations correspond to different choices for the governing equations of motion. Free surface exists in many simulations carried out with FLOW-3D. It is challenging to model free surfaces in any computational environment because flow parameters and materials properties, such as density, velocity and pressure experience a discontinuity at it. In FLOW-3D, the inertia of the gas adjacent to the liquid is neglected, and the volume occupied by the gas is replaced with an empty space, void of mass, represented only by uniform pressure and temperature. This approach has an advantage of reducing the computational effort since in most cases the details of the gas motion are unimportant for the motion of much heavier liquid. Free surface becomes one of the liquid’s external boundaries. A proper definition of the boundary conditions at the free surface is important for an accurate capture of the free-surface dynamics. The Volume of Fluid (VOF) method is employed in FLOW-3D for this purpose. It consists of three main components: the definition of the volume of fluid function, a method to solve the VOF transport equation and setting the boundary conditions at the free surface. Some physical and numerical models are described in more detail in Flow Science’s Technical Notes, which also include examples. 
Equations of Motion 
Coordinate Systems The differential equations to be solved are written in terms of Cartesian coordinates (x, y, z). For cylindrical coordinates (r, θ, z) the x-coordinate is interpreted as the radial direction, the y-coordinate is transformed to the azimuthal coordinate, θ, and z is the axial coordinate. For cylindrical geometry, additional terms must be added to the Cartesian equations of motion. These terms are included with a coefficient ξ, such that ξ=0 corresponds to Cartesian geometry, while ξ=1 corresponds to cylindrical geometry. All equations are formulated with area and volume porosity functions. This formulation, called FAVOR™ for Fractional Area/Volume Obstacle Representation Method (C.W. Hirt and J.M. Sicilian, September 1985) is used to model complex geometric regions. 

http://www.flow3d.com/resources/res_tn_1.html


For example, zero-volume porosity regions are used to define obstacles, while area porosities may be used to model thin porous baffles. Porosity functions also introduce some simplifications in the specification of free-surface and wall boundary conditions. Generally, in FLOW-3D, area and volume fractions are time independent. However, these quantities may vary with time when the moving obstacle model is employed. 



 

 

Mass Continuity Equation and Its Variations The general mass continuity equation is: 
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∂ ∂ ∂ ∂  (0.1) where VF is the fractional volume open to flow, ρ is the fluid density, RDIF is a turbulent diffusion term, and RSOR is a mass source. The velocity components (u, v, w) are in the coordinate directions (x, y, z) or (r, θ, z). Ax is the fractional area open to flow in the x-direction, Ay and Az are similar area fractions for flow in the y and z directions, respectively. The coefficient R depends on the choice of coordinate system in the following way. When cylindrical coordinates are used, y derivatives must be converted to azimuthal derivatives, 
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∂ ∂ ∂ ∂ ∂ ∂      (0.4) where the coefficient νp is equal to cp μ/ρ, in which μ is the coefficient of momentum diffusion (i.e., the viscosity) and cp is a constant whose reciprocal is usually referred to as the turbulent Schmidt number. This type of mass diffusion only makes sense for turbulent mixing processes in fluids having a non-uniform density. The last term, RSOR, on the right side of Eq. (0.1) is a density source term that can be used, for example, to model mass injection through porous obstacle surfaces. Compressible flow problems require solution of the full density transport equation as stated in Eq. (0.1). For incompressible fluids, ρ is a constant and Eq. (0.1) reduces to the incompressibility condition 
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Momentum Equations The equations of motion for the fluid velocity components (u, v, w) in the three coordinate directions are the Navier-Stokes equations with some additional terms 
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In these equations, (Gx,Gy,Gz) are body accelerations, (fx, fy, fz) are viscous accelerations, (bx, by, bz) are flow losses in porous media or across porous baffle plates, and the final terms account for the injection of mass at a source represented by a geometry component. The term 
wU =(uw,vw,ww) in Eq. (3.8) is the velocity of the source component, which will generally be non-zero for a mass source at a General Moving Object (GMO). The term 
sU =(us,vs,ws) is the velocity of the fluid at the surface of the source relative to the source itself. It is computed in each control volume as 
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Q
ρ  is the fluid source density, dA is the area of the source surface in the cell and n the outward normal to the surface. When δ=0.0 in Eq. (3.8) the source is of the stagnation pressure type. If δ=1.0, the source is of the static pressure type. At a stagnation pressure source, fluid is assumed to enter the domain at zero velocity. As a result, pressure must build up at the source to move the fluid away from the source. Such sources are designed to model fluid emerging at the end of a rocket or a deflating balloon. In general, stagnation pressure sources apply to 



 

 

cases when the momentum of the emerging fluid is created inside the source component, like in a rocket engine. At a static pressure source the fluid velocity is computed from the mass flow rate and the surface area of the source. In this case, no extra pressure is required to propel the fluid away from the source. An example of such source is fluid emerging from a long straight pipe.  NOTE: IN THIS CASE THE FLUID MOMENTUM IS CREATED FAR FROM WHERE THE SOURCE IS LOCATED. The distinction between those two types of mass sources is important when the force acting from the fluid on the source component must be computed accurately. This is the case with coupled-motion GMO components. Note that the static or stagnation pressure property does not apply to negative mass source, i.e., sinks. For a variable dynamic viscosity μ, the viscous accelerations are   
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Wall-Shear Stress In the above expressions, the terms wsx, wsy and wsz are wall shear stresses. If these terms are omitted, there is no wall shear stress because the remaining terms contain the fractional flow areas (Ax, Ay, Az) which vanish at walls. The wall stresses are modeled by assuming a zero tangential velocity on the portion of any area closed to flow. Mesh and moving obstacle boundaries are an exception because they can be assigned non-zero tangential velocities. In this case, the allowed boundary motion corresponds to a rigid body 



 

 

translation of the boundary parallel to its surface. For turbulent flows, a law-of-the-wall velocity profile is assumed near the wall, which modifies the wall shear stress magnitude. These details are more fully explained in Turbulence Models. 
Viscosity Evaluation The dynamic viscosity, μ, can be assigned constant molecular values for each fluid in a one or two fluid problem. In mesh cells containing a mixture, the viscosity is evaluated as a volume fraction weighted average of the constant values. In the single-fluid model the fluid can consist of two components, each with its own constant density and viscosity. In this case, the mixture fluid viscosity is evaluated as a volume fraction weighted average of the two constants. Furthermore, fluid viscosity can be a function of solid fraction for partially solidified fluids (see Solidification). When the turbulence option is used, the viscosity is a sum of the molecular and turbulent values. For non-Newtonian fluids the viscosity can be a function of the strain rate and/or temperature. A generic expression based on the "Carreau" model is used in FLOW-3D for the strain rate-dependent viscosity: 
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−    (0.13) and T*, a, b and c are also constants, and T is fluid temperature. Expressions given by Eqs. (0.11) and (0.13) can be specified using input variables according to the following correspondence table: μ0 = MU1 a=MUTMP1 T*=TSTAR λ0 =MUC0 b=MUTMP2  λ1 = MUC1 c=MUTMP3  λ2= MUC4 n = MUC2 μ
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The quantity TSTAR serves as a reference temperature. Note that TSTAR and the constant b have dimensions of a temperature. A temperature-dependent viscosity can be defined even when there is no shear dependence. Because the viscosity is evaluated in a separate subroutine (MUCAL), the user should find it relatively easy to customize other FLOW-3D non-Newtonian and temperature-dependent viscosity models. If the viscosity, μ, is zero, no viscous stresses are computed. Furthermore, wall shear stress evaluation may be turned off by the user in the input data file (see IWSH). 
Baffle Flow Losses Flow losses across porous baffle plates have the form (e.g., in the x-direction),  
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L  (0.14) where KBAF1 is an input constant having dimensions of velocity, KBAF2 is a dimensionless input constant, L is the length over which the loss occurs, and u is the microscopic fluid velocity inside the porous baffle. It is important to distinguish the latter from the bulk velocity, which is smaller than u by the factor of 1/PBAF. The microscopic velocity is the one computed in the flow Eqs. (3.1) and (3.8), and displayed on 2D and 3D plots. The length L is set equal to the distance between pressure values located on either side of the baffle. At constant flow speed, u, this form ensures a fixed pressure drop, p∆ , across the baffle independent of mesh spacing: 
p= ( 1  + 0.5 2 |)ρ∆ ⋅ ⋅ ⋅ ⋅KBAF u KBAF u u  (0.15) The y and z direction losses are defined in a similar manner with the velocity and length in the corresponding direction. If KBAF1 and KBAF2 are zero, no flow loss calculations are performed. 

Non-Inertial Reference Frame For applications to fluid sloshing in moving containers, for example, it is useful to modify the equations of motion to have a formulation for general non-inertial accelerations. The form of such accelerations on a fluid element at r and moving with velocity u is 
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U is the translational acceleration of point R in the mesh coordinate system with respect to an inertial reference frame. ΩΩΩΩ  and ••••

ΩΩΩΩ  are the rotation rate (rad/s) and rotation rate of change (rad/s2) of the mesh coordinate system about point R with respect to an inertial frame (G.K. Batchelor, 1983).  Eq. (0.16) is easily derived from Eq. (3.2.9) in Reference (G.K. Batchelor, 1983) by a translation of origins. 



 

 

Inclusion of the vector R is useful in applications to rigid bodies where R is often chosen to be the center of mass of the body. If this choice is made and no external forces act on the system, then 0
•

=U . Often the origin of the body-fixed (mesh) coordinate system is at the center of gravity, in which case R=0. The user can specify constant gravitational accelerations through the g term or time-dependent translational accelerations through the •

U term. To use this last option, or for more general accelerations, the user must specify the quantities •

U , ΩΩΩΩ  and ••••

ΩΩΩΩ   in the subroutine reserved for this purpose (MOTION). Furthermore, these quantities must be expressed in terms of the mesh coordinate system (i.e., body-fixed system). They are always specified in Cartesian coordinates regardless of whether Cartesian or cylindrical mesh coordinates are used. For cylindrical coordinates, the accelerations are automatically transformed to the proper local components. The components of the local accelerations experienced by the fluid are automatically calculated by the program from the nine reference frame motion components through Eq. (0.16). This is a completely general computation and does not require intervention by the user. For special cases, the user must supply a (MOTION) routine for each new application. The standard version of MOTION can handle a limited number of situations via input data. These include harmonic variations of the acceleration components and tabular specification, including impulses. Another special case of the non-inertial reference frame is handled by the coupled rigid body dynamics model in FLOW-3D. This model solves the dynamic equations for the movement of a rigid body in which the computational reference frame is embedded. Use of this model usually involves specification of control and environmental forces and torques experienced by the body through input parameters or by modifications to the two subroutines RBCTRL and RBENVR. See Coupled Rigid Body Dynamics for a more detailed description. 
Fluid Interfaces and Free-Surfaces Fluid configurations are defined in terms of a volume of fluid (VOF) function, F (x,y,z,t) (C.W. Hirt and B.D. Nichols, 1981). This function represents the volume of fluid #1 per unit volume and satisfies the equation 
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 (0.18) The diffusion coefficient is defined as νF = cFμ/ρ where cF is a constant whose reciprocal is sometimes referred to as a turbulent Schmidt number. This diffusion term only makes sense for the turbulent mixing of two fluids whose distribution is defined by the F function. The term FSOR corresponds to the density source RSOR in Eq.(0.1); FSOR is the time rate of change of the volume fraction of fluid #1 associated with the mass source for fluid #1. 



 

 

The interpretation of F depends on the type of problem being solved. Incompressible problems must involve either a single fluid with a free-surface or two fluids and no free-surfaces. For a single fluid, F represents the volume fraction occupied by the fluid. Thus, fluid exists where F=1, and void regions correspond to locations where F=0. "Voids" are regions without fluid mass that have a uniform pressure assigned to them. Physically, they represent regions filled with a vapor or gas whose density is insignificant with respect to the fluid density. Two-fluid problems may be composed of either two incompressible fluids or one incompressible and one compressible fluid. F represents the volume fraction of the incompressible fluid component in either case, which is referred to as fluid #1. The complementary region with volume fraction, 1-F, represents fluid #2 and may have either a constant density or its density is computed from the compressible fluid equation-of-state. 
Fluid Energy Equations For compressible or thermal flow problems, the internal energy equation is  
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 (0.19) 
where I is the macroscopic mixture internal energy. For two-fluid problems  

1 1 2 2(1 )I F I F Iρ ρ ρ= + −  (0.20) where F is the volume fraction of fluid #1 and indexes indicate quantities related to fluid #1 or fluid #2. 
Heat of Transformation Energy is assumed to be a linear function of temperature, 
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I CV T f CLHT= ⋅ + − ⋅  (0.21) where CV1 is the specific heat at constant volume of fluid #1, fs is solid fraction, and CLHT1 the latent heat. Latent heat associated with the melting or freezing of fluid #1 can be defined in one of two ways. The simplest method consists of specifying the solidus temperature, TS1, the liquidus temperature, TL1, and the specific energy of the phase transformation occurring between these two temperatures, CLHT1. In this case the latent heat is removed linearly with temperature between TL1 to TS1. In many real materials, however, this is not the case. Furthermore, it is possible for some materials to exhibit solid-state phase changes; that is, as they cool, they assume more stable crystalline states releasing heats-of-transformation with each change. The second method of defining phase changes consists of inputting a specific-energy-versus-temperature table for the material. The table consists of pairs of numbers CLTP(L) and CLHT(L), where CLTP(L) is the temperature of point L and CLHT(L) is the total energy between temperature CLTP(L-1) and CLTP(L) as shown in the figure below. CLHT(1) is the specific energy at CLTP(1). The temperatures CLTP(L) must be monotonically increasing with increasing L, although it is permissible to have phase change discontinuities by assigning the same value to two successive temperatures in the table. The last temperature in the table must be equivalent to the liquidus temperature TL1 or else TL1 must be 



 

 

input explicitly and must be greater than the last CLTP(L) temperature. The value of TS1 must agree with one of the CLTP(L) values. The specific heat CVS1 is used between a temperature of absolute zero and the first value of CLTP(L). At temperatures above TL1 or above the last CLTP(L) value, the specific heat is constant and equal to CV1. Only fluid #1 can undergo a liquid/solid or solid/solid phase change. Both solidification and melting are allowed. Solidification shrinkage is a separate option that can be activated (see Solidification). It is permitted to have TS1=TL1, which implies a discontinuity in the energy-versus-temperature relation. 

 Example of energy vs. temperature input table with phase transformation both in liquid and solid 
Macro-Segregation Model The macro-segregation model describes the evolution of binary alloy composition due to phase transformation, diffusion in both liquid and solid phases and convection in the liquid metal. The transport equation for the liquid-solid mixture composition, Cm, is 
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 (0.22) 
where Cl and Cs are the liquid and solid phase compositions, and Dl and Ds the mass diffusion coefficients in the liquid and solid phases. Composition can be described as solute mass per unit metal volume or as weight percentage. In this equation, the solid phase is assumed to be at rest with respect to the computational domain. The mixture composition Cm is obtained by averaging the liquid and solid phase compositions over the control volume. Assuming that Cl and Cs are constant within the control volume, i.e., using the lever rule, we have 
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s l
C PCOEF C= ⋅  (0.24) where PCOEF is the partition coefficient (M.C. Flemings, 1974). PCOEF is constant, therefore, the liquidus and solidus lines of the phase diagram are straight lines 
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= − − ⋅  (0.26) where TS1 and TL1 are the solidus and liquidus temperatures at C=CSTAR. If composition and temperature in a control volume are known, then the solid fraction can be computed using Eqs. (0.23), (0.24), (0.25) and (0.26). 
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 (0.27) Eutectic reaction is included in the phase diagram. In a eutectic reaction, phase transformation proceeds isothermally at the eutectic temperature T=TEUT. Then the mass fraction of the eutectic in the solidified casting is given by 
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 (0.28) Liquid metal density variation due to the changes in the composition are taken into account by using a linear expression for the liquid mixture density 
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 (0.31) if the composition is defined as mass per unit volume; ρ1 and ρ2 are the densities of the solvent and solute, respectively. Liquid metal density can also include a temperature-dependent term, as described in Buoyant Flow. Finally, the liquid/solid mixture density is computed as the straight average of the liquid density given by Eq. (0.29)and the solid phase density RHOFS. 
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Thermal Diffusion and Sources Two diffusion processes are included in the above expression: one (RIDIF) for the turbulent diffusion of I and the other (TDIF) for heat conduction. These terms are defined as 
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 (0.34) The coefficient νI is equal to cI μ/ρ, where cI is a reciprocal turbulent Prandtl number. In the thermal conduction term, the thermal conductivity k can be directly specified or the Prandtl number CT can be specified, in which case the conductivity is k = μCv/CT. For two-fluid problems the conductivities for each fluid are locally weighted by the fluid volume fraction F. The last term, RISOR, on the right side of Eq. (0.19) is an energy source term. Sources can be associated with the mass source RSOR, with heat transfer mechanisms at solid boundaries, distributed heat sources within the fluid or viscous heating. A detailed discussion of wall heat transfer is given in Wall Heat Transfer. The viscous heating source term is 
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Structure Temperature Equation If the heat transfer option is selected (IHTC  > 0) in the input, dynamic temperatures of heat structures may be evaluated by FLOW-3D. Heat structures can be either mesh wall boundaries or obstacles. The most general equation solved for dynamic structure temperatures is 
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1 1 1  (0.36) where Tw is the solid structure temperature, ρw, Cw, and kw are the solid material values of density, specific heat, and thermal conductivity, and TSOR is a specific energy source term composed of contributions from specified external sources and solid-liquid heat transfer. Evaluation of heat transfer is discussed in Wall Heat Transfer. Some obstacles or wall boundaries may be treated by a lumped temperature model. In this case the entire structure is assumed to be at a uniform temperature, which eliminates the conduction term and results in 
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=  (0.37) where now Mw is the mass of the structure, and ITSOR is the volume and/or area integrated energy source term. 



 

 

Equation-of-State Compressible equations of state are assumed to have the form 
w

w w SOR

dT
M C IT

dt
=  (0.38) A single-mixture energy is generally not sufficient to determine separate fluid states for two-material problems. Therefore, we assume that the two materials have the same temperature, which partitions energy between the materials. A perfect gas equation-of-state is the default available in FLOW-3D for compressible fluids. For thermally buoyant flows the fluid densities are functions of temperature only, as described in Buoyant Flow. Incompressible fluids generally have a constant and uniform density. However, one can also define a non-uniform density in an incompressible fluid. 

Auxiliary Models 
Bubble and Void Region Models Many calculations that involve the flow of both liquids and gases can be idealized as "free-surface" flows. This type of flow is analyzed by treating the gas as a region of uniform pressure and temperature, which frees one from determining the dynamics of the gas. In free-surface calculations, FLOW-3D identifies the region occupied by fluid as regions where the fluid fraction function is non-zero. Free-surface calculations must have domains in which the fluid fraction is zero. Each such region is called a “void region” (or sometimes a "bubble"). Void regions may be separated from one another by fluid cells, obstacles, or baffles. These regions physically represent volumes that are occupied by gas. The VOF solution algorithm does not solve for the dynamics of the gas in these regions; instead, it treats them as regions of uniform pressure, which is normally an excellent approximation. The pressure is used as a boundary condition on the liquid/gas interface. Evaluation of the pressure (and possibly temperature) of void regions depends on the void region model. There are four kinds of void regions used in FLOW-3D: 
� Fixed Pressure Regions 
� Cavitation Regions 
� Adiabatic Bubbles 
� Homogeneous Bubbles Some calculations may combine different models for different regions or even for the same void region at different times. The use of a single pressure for each connected void region presupposes that sound waves traverse the region in much shorter times than those associated with changes in the configuration of the surrounding incompressible fluid. These assumptions are, however, sufficiently accurate for many interesting problems. 



 

 

Bubbles that impinge upon the mesh boundary may be affected by the boundary conditions. For example, any void region adjacent to a fixed pressure boundary will automatically take on the prescribed boundary pressure regardless of volume changes, coalescence, or breakup. Void regions adjacent to fixed velocity boundaries will gain (or lose) enthalpy. If the flow is into the computational region, the enthalpy gain is computed from the specified boundary conditions. For an outflow boundary, it is the enthalpy in the bubble that is fluxed out. Reference (B.D. Nichols and C.W. Hirt, 1980) describes the theoretical basis for this bubble model. 
Constant Pressure Void Regions When densities of the fluid and gas differ significantly, then small variations of pressure within the gas and gas inertia can be neglected compared to those in the fluid. For example, the ratio of water to air densities is about 1000. In these cases each void region can be treated as a uniform pressure region. In FLOW-3D such flows are described with the one-fluid model with gas boundaries treated as free-surfaces. If the gas does not undergo volumetric changes (i.e., compression or expansion), then it can be further assumed that the pressure of the void regions is constant in time. The constant pressure void region model works well, for example, for open channel flows where the gas is air at atmospheric pressure. Another example is filling of a sand mold with liquid metal where the sand porosity ensures that air in the mold escapes without getting trapped. If the void is connected to a specified pressure boundary, then the void will assume the pressure specified at that boundary, which may be a function of time. 
Homogeneous Bubble Model In this section we describe an extension of the adiabatic bubble model that adds non-adiabatic mass and energy changes (see Flow Science Technical Note #57). Solid-to-void heat transfer provides for heat exchange between the gas in a bubble and solid obstacles exposed to the bubble. Mass and energy exchanges resulting from phase changes at the bubble’s surface can be included in cases where the bubble gas consists of liquid vapor. Homogeneous bubbles have a simple and robust formulation that is consistent with the liquid thermodynamic properties used in FLOW-3D. The model is referred to as the Homogeneous Bubble Model. The nomenclature is meant to emphasize the fact that the pressure and temperature of gas in a bubble are spatially uniform (i.e., homogeneous), but these values can vary with time. There can be many such bubbles in a calculation, each having its own temperature and pressure. The equation-of-state for a bubble is the ideal gas equation, 
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If there are no sources of mass or energy for a bubble it will behave as though it is adiabatic, changing pressure from some initial state (p0,V0) to a new state (p,V) according to 
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 (0.40) When phase changes occur it is necessary to have an analytical relation that expresses the saturation pressure of a vapor in terms of its temperature. In FLOW-3D the default for this relation is the Clapeyron equation that gives Psat as a function of temperature T, 
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 (0.41) where (PV1,TV1) is a point on the saturation curve, and TVEXP is an exponent constant given by  
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=  (0.42) where CLHV1 is the heat of transformation (latent heat) of evaporation. The rate of phase change is typically modeled as proportional to something that measures the deviation from saturation conditions. A typical formulation (T. Theofanous, L. Biasi, and H.S. Isbin, 1969) that is based on kinetic theory is net mass transfer =

2

sat

l v

vap con

l v

P PM
a a

R T Tπ

 
− 

 
 

 (0.43) where M is the molecular weight of the vapor, R the vapor gas constant, T is temperature, and subscripts l and v refer to liquid and vapor states. The superscript sat on Pl indicates the saturation pressure corresponding to liquid temperature Tl. Finally, the coefficients avap and acon are the "accommodation coefficients" for evaporation and condensation, respectively. The origin of this expression is that the mass flux (for example, condensation on a liquid surface) must be proportional to the local vapor density and local velocity of the molecules at the surface. Assuming a Maxwellian velocity distribution the local velocity into the surface is (M.S. Plesset, 1976), 
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=  (0.44) Combining this result with the vapor equation-of-state gives the second (condensation) term in the mass transfer expression Eq.(0.43). The evaporation term is arrived at in a similar way. The accommodation coefficient, say acon, is the probability that vapor molecules striking the liquid surface are captured. With this interpretation, the accommodation coefficients should generally be less than or equal to unity. Most often the evaporation and condensation accommodation coefficients are assumed to be equal, but there is no theoretical reason why this must be so. Furthermore, there are no theoretical predictions for these values. It is worth noting here that this expression is for the "net" mass transfer from liquid to vapor. It 



 

 

says nothing about the possibility of molecular exchanges between the liquid and vapor that transfer energy without a net mass exchange. For present purposes we have chosen to simplify the phase change rate to net mass transfer = ( )
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−  (0.45) where RSIZE is a net "accommodation coefficient" and Tbdy is the average liquid temperature along the surface of the bubble. 

Cavitating Void Regions Cavitating void regions open up in the fluid when the local pressure drops below a critical value, Pcav. The initial rate of void creation can be controlled by the input parameter CAVRT. The new void region is treated as a fixed pressure bubble with pressure equal to the cavitation pressure. The latter is a fixed parameter and at present does not depend on temperature. Cavitating bubbles can coexist with other types of void regions in a single calculation. 
Variable Pressure Void Regions In situations when a volume of gas gets trapped in a confined region, the gas pressure can no longer be considered constant. For example, a submerged air bubble rising in water may have a variable pressure. FLOW-3D can treat one or more void regions in its incompressible, one-fluid mode. The bubble model evaluates the pressure P in each void region based on the void region volume V using the isentropic model of expansion or compression in which PVγ is constant. Here γ is normally the isentropic exponent defined as the ratio of specific heats, 

Vp
γ=C /C .  Strictly speaking, this model of the bubble pressure is only valid if the void region behaves as a perfect gas undergoing reversible adiabatic changes.  Void regions can behave in more complex ways than simple expansions and contractions. They may break up or coalesce, and they may receive or lose mass and energy at the mesh boundaries. All of these processes are approximated by the bubble pressure model in FLOW-3D. The pressure of a coalesced bubble is determined by volume weighting the pressures of the previous isolated bubbles. A bubble that breaks up creates new bubbles at its old pressure. These processes violate the constant PVγ condition, but as they only occur at discrete times, the accumulated error is expected to remain small.  If a bubble neither coalesces nor breaks up, the PVγ relation determines the new pressure.  

Vaporization Residue Fluids at free surfaces in a one-fluid problem can either evaporate or condense when a phase change model is used. This holds true for both cases where the gas side of the interface is a constant pressure or when it is a homogenous bubble region. If the fluid contains one or more solutes, the concentration of the solutes must change in response to the gain or loss of liquid. Typically, the solutes become more concentrated due to liquid evaporation. 



 

 

In either the evaporation or condensation case, any scalar concentration that is associated with the fluid will have its concentration altered by the phase change. If a surface element is less than half filled with liquid, then the concentration change is spread into the principal neighbor of the surface element to the extent that the concentration region equals half the thickness of the surface element. If enough evaporation occurs and the solute concentration becomes high enough, it may result in a surface skin or a residue may form on a solid surface if the liquid is completely evaporated. For this to be simulated in FLOW-3D, the residue model must be selected. Activation of this model causes the solute to form a non-moving residue once its concentration reaches a user-defined maximum packing density. If more than one solute is present the residue model will record the total of all solute contributions to the residue. 
Buoyant Flow Model Many flow situations can be approximated using incompressible fluids but require evaluation of the influence of buoyant forces associated with small density variations. In such cases the density is usually represented as a function of temperature only. Solidification and macro-segregation can also be taken into account in the buoyant flow model (see Unsaturated Flow in Porous Media). FLOW-3D permits a solution of these flows by coupling its incompressible flow solution algorithm with the solution of the energy transport equation and with a local evaluation of the density as a function of temperature. The model will work with single-fluid calculations, with or without a free-surface, and for two-incompressible-fluid problems. Additionally, the limited compressibility model may be employed with the buoyant flow model. Buoyant forces are automatically included in compressible fluids. The Flow Science Technical Note #58 has details on the approximations and limitations of the model. When the buoyant flow option is used, the continuity equation, Eqs. (0.1) or (0.5), the momentum-transport equations, Eq. (3.8), and the internal-energy-transport equation, Eq.(0.19), are solved. For free-surface or two-incompressible-fluid problems the fluid fraction equation, Eq.(0.17), is also solved. Fluid density is determined in the buoyant flow model from the local fluid fraction F and temperature as 

1 2( ) (1 ) ( )F T F Tρ ρ ρ= ⋅ + − ⋅   (0.46) where 
[ ]

[ ]

1

2

( ) 1 1 ( *)

( ) 1 2 ( *)

T RHOF THEXF T T

T RHOFC THEXF T T

ρ

ρ

= ⋅ − ⋅ −

= ⋅ − ⋅ −  (0.47) In Eq. (0.47), T* is a reference temperature at which fluid #1 has the input density RHOF and fluid #2 density RHOFC. The volumetric thermal expansion coefficients for these fluids are constants THEFX1 and THEXF2, respectively. Buoyant forces arise from imbalances of the pressure gradient and body forces in Eq. (0.8), which include non-inertial as well as gravitational accelerations. The fluid temperature is determined from the transport equation for the internal energy with the assumption of equal local temperatures in two-fluid cases. 
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Core Gas Generation and Flow in Sand Cores and Molds Gas defects are often found in sand cast parts that arise from gas generated by thermal decomposition of the sand binder in the sand. A computational model is available to predict the generation of gas and its transport within cores. The gas is treated as compressible to account for poor core venting scenarios and for transport across core regions of steep temperature gradients. The model considers true molding geometry and actual core venting locations and can be used to predict the amount of gas that would enter liquid metal from any location on the surface of the core. A core is treated as a solid object in the program with no porosity, so that no liquid metal can flow into its interior. The core gas model then treats the core object as though it is a porous material in which gas can be generated, flow and pass in or out of its boundaries using special boundary conditions as described below. The core gas model assumes that the sand binder is converted completely into gas when the binder reaches a high enough temperature. The gas is thought to be ideal and have a fixed composition with the gas constant, Rg. The gas constant can be deduced from the experiments in which the gas is collected in a fixed volume apparatus and the gas pressure is measured. From the measured total collected standard volume, Vstd, and the initial mass of the binder, mb, the gas constant is 
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� , is governed by the equation for flow in porous media. 
cg cg

K
u p

µ
= − ∇

�  (0.49) where K is the sand permeability, μ is core gas viscosity and pcg is the core gas pressure. The macroscopic inertial terms are found to be small for the typical conditions of the core gas flow and are not included in (0.49). The drag coefficient K-1 has a linear Darcy term and a quadratic Forschheimer term: 
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= +  Here, φ is the core porosity, μcg is the core gas viscosity, ρcg is the core gas density and a, b are sand specific linear and quadratic flow loss coefficients. The density of the core gas is governed by the mass transport equation: 
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�  (0.50) Where ρcg and ρb are the microscopic core gas and macroscopic core binder densities. Since the core gas is compressible, even in the absence of gas sources there can be a thermal expansion and flow of the initial air in the core as the core heats up. The core gas density is further constrained by the ideal gas law: 
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p R Tρ=  (0.51) where the temperature of the gas is assumed to be equal to the local core temperature. This is a good approximation because of the high heat content of the solid core material compared to that of the gas. Since it is assumed that the core and gas temperatures are equal, and the core temperature T is already computed by the heat transfer solver, the ideal gas law can be used to compute gas pressure with its density is defined by Eq. (0.50). The conversion of the solid binder to gas is described by an Arrhenius equation, 
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   (0.52) where ρb is the solid binder density, Cb is the reaction rate constant the value of which is obtained empirically, Eb is a component binding energy, R is the universal gas constant and T is the core temperature. The gas source can exhibit an unphysical oscillatory behavior associated with the discrete size of the computational elements. To alleviate this problem a simple subdivision scheme is used in each computational cell. The solid binder density is stored at the sub-cells nodes, while the sub-cell temperature is obtained through a linear interpolation of the temperature field from the nodes of the main mesh. Because the core-gas model is used concurrently with a mold filling model, it is possible that gas flow in cores may become sufficiently fast to limit the computational time-step size (by the Courant stability condition for an explicit advection approximation) to a value smaller than what is needed for the filling simulation, resulting in longer calculation times. To counter this possibility, a sub-time-stepping scheme has been incorporated into the core-gas model. This is possible because the model is coupled to the metal filling simulation through the boundary conditions at the outer surface of the core (see below). If it is found that the time-step size for the core-gas model must be smaller than that for the filling simulation, then the time-step size for the core-gas computations is reduced to a stable value and the model is run for several sub-time steps with the fixed thermal and flow solution in the metal. The size of the sub-time step is an integer fraction of the main time step size, so that the gas computations can be repeated for that integer number of steps to bring the gas solution forward to the correct time. There may be a flow of gas either in or out of the core at boundaries of the core material. This exchange is treated as a boundary condition for the core-gas model. The passage of the gas through the core boundary depends on what is located outside the core. For instance, if the core surface is exposed to air, then gas may flow across the boundary in either direction depending on the pressure difference. If there is liquid metal at the core surface, then gas is allowed to pass out of the core when its pressure is greater than the pressure of the metal at that location, but no metal is allowed to enter the core. If the metal has already solidified at the surface of the core, then no gas is allowed to flow across the boundary at that location. Another boundary condition occurs at core print surfaces, that is, where a core surface is in contact with another solid part of the mold. At these surface locations, gas does not normally flow unless channels have 



 

 

been cut into the mold to allow for venting. The core-gas model has an option for allowing venting at print surfaces. 
Permeable Mold Model Sand is a common material for making casting molds. It is easily “molded” into any shape, recyclable and has suitable structural and thermal properties.  In addition, a sand mold is permeable which allows the air initially residing in the cavity to escape during pouring. However, the escape of the air occurs at a certain rate which, if too low, may result in a significant buildup of back pressure thus slowing down the filling process. There is a simple model for the escape of air through a permeable mold in FLOW-3D that provides the means to account for the buildup of the back pressure.  The volume flow rate Q of the air through the mold is computed using a linear formulation: 
Q AKdP=  (0.53) where A is the surface area of mold that is exposed to the air, K – the mold permeability, and dP is the pressure drop between the air inside and outside of the mold. The mold permeability K is estimated from the mold porosity, POR, average sand grain size d, average mold thickness L, and air viscosity μ: 
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 (0.54) The permeable mold model is used together the adiabatic bubble model, in which each air region, or bubble, has a uniform pressure that is a function of the bubble volume. The flow rate Q is evaluated for each air region using the bubble pressure and its surface area with the mold. The ambient pressure is assumed to be the constant and the same for all air regions.  Over a small increment of time, dt, the back pressure in an air region, Pair, changes due to the compression by the incoming metal, dV, and to venting through the mold, Qdt: 
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 (0.55) where γ is the ratio of the gas specific heats (1.4 for air) and Vair is the air region volume. Mold coating is currently not taken into account. 

Defect Tracking Mechanical properties of a casting may strongly depend on the "cleanness" of the metal with regards to oxide films, air and other foreign inclusions that are likely to get trapped inside the metal during the filling process. In this section, a defect source and tracking scheme is described that gives a qualitative prediction of casting defects originating from surface turbulence (M.R. Barkhudarov and C.W. Hirt, 1998). The defect 



 

 

model has also been coupled with a lost foam casting model to predict possible defects arising from carbon residue remaining on metal surfaces after the foam has been decomposed. Surface inclusions are represented by a scalar variable with index IDFCT that is initially zero everywhere. In the oxide-tracking model, the scalar quantity accumulates at free-surfaces at a constant rate DFTSRF. When coupled to the lost foam model, the scalar quantity in a numerical control volume is incremented by an amount proportional to the mass of degraded foam in that volume (the coefficient of proportionality is defined with DRTFOB). This scalar is then allowed to advect with the flow. A transport equation similar to the one given by Eq. (0.22) is solved numerically using a second-order, monotonicity-preserving scheme for increased accuracy. Diffusion of the oxide and air inclusions is usually small and, therefore, is ignored in the transport equation. The scalar may be interpreted as proportional to the mass of contamination material per unit volume. At this point no buoyancy or oxide film strength effects are included in the model. Also not included are such phenomena as oxide film sticking to mold walls and foam residue escape through a porous sand mold. The wicking of the liquid products of foam decomposition in the lost foam casting process can be included (see the Model Reference chapter for details). At the conclusion of a simulation, the distribution of the scalar indicates locations where inclusions are likely to be. In most cases the majority of scalar tracked inclusions are found at the last place to fill, as would be expected. In other words, contaminants accumulate at the metal front and are pushed along until there is nowhere else for them to go. More interesting, however, are situations two fronts meet, trapping surface inclusions in the interior of the metal, or near corners where flow recirculation regions may develop. Even the circulation remaining in metal after a mold has filled can redistribute surface generated contaminants. Without detailed experimental comparisons to correlate predictions from this type of model with actual defects, it is impossible to assign any significance to the absolute values of the scalar. Therefore, coefficients DFTSRF and DFTFOB can have arbitrary positive values. However, qualitative results from even the simplest of test cases reveals a considerable amount of useful insight into the processes responsible for defect generation and their final distribution in a cast part. 
Drift-Flux Model In fluids composed of multiple components, e.g., fluid/particles, fluid/bubbles, fluid/fluid mixtures, where the components have different densities, it is observed that the components can assume different flow velocities. Velocity differences arise because the density differences result in non-uniform body forces. Often the differences in velocities can be very pronounced, for example, large raindrops falling through air or gravel sinking in water. Under many conditions, however, the relative velocities are small enough to be described as a “drift” of one component through the other. Examples are dust in air and silt in water. The “drift” distinction has to do with whether or not the inertia of a dispersed component moving in a continuous component is significant. If the inertia of relative motion can be ignored, and the relative velocity reduced to a balance between a driving force (e.g., gravity or a pressure gradient) and an opposing drag force between the components, then we can speak of a “drift-flux” approximation. Drift velocities are primarily responsible for the transport of mass and energy. Some momentum may be transported as well, but this is usually quite small and has been neglected in the FLOW-3D drift model. 



 

 

The idea behind the drift model is that the relative motion between components can be approximated as a continuum, rather than by discrete elements (e.g., particles). This enhances computational efficiency, as the need for tracking the motion and interaction of discrete elements do not need to be computed. There are four different physical situations in which a drift velocity can be employed in FLOW-3D:  
� One fluid, variable density flows, where the fluid is a mixture of two components having densities ρ1 and ρ2. 
� One fluid with solidification, where the fluid is a mixture of liquid and solid having densities ρ1 and ρ2. 
� Two incompressible fluids having densities ρ1 and ρ2. 
� A compressible gas with an incompressible component. In this case the density of the compressible gas is given by an equation-of-state, while the incompressible material has density ρ1, which is always assumed to be much larger than the gas density. The formulation of the relative velocity in the drift approximation proceeds as follows. Suppose a flow is composed of two discrete components or phases, one the continuous phase, and the other the dispersed phase, which is discontinuous and surrounded by the continuous phase. Note that the same system of fluids can have opposite configurations: for the case of a small quantity of water contaminating a large volume of diesel fuel, the water is the dispersed phase; conversely, when small amounts of diesel fuel are present in water, the diesel fuel is the dispersed phase. Define u = f1 u 1+ f2 u 2 such that = 0⋅∇∇∇∇ u  for the incompressible flow of a two-component fluid.  The volume fractions of the two components making up a mixture are denoted by f1 and f2, where 

1 2 1f f+ =  (0.56) If we presume that the two phases are incompressible, the momentum balance for the continuous phase is 
1 1

1 K
P

t fρ ρ

∂
+ ⋅∇ = − ∇ + +

∂

1
1 1 r

u
u u F u  (0.57) while for the dispersed phase it is  2

2 2

2 2

1

(1 )

K
P

t fρ ρ

∂
+ ⋅∇ = − ∇ + −

∂ −
r

u
u u F u  (0.58) where u1 and u2 represent the microscopic velocities of the continuous and dispersed phases, respectively, and f is the volume fraction of the continuous phase. The microscopic velocity refers to the velocity of each phase about a small but finite volume of fluid. F is the body force, K is a drag coefficient that relates the interaction of the two phases, and ur is the relative velocity difference between the dispersed and continuous phases: 

= −r 2 1u u u  (0.59) The goal of the drift-flux model is to compute the motion of the two phases relative to the volume-averaged velocity, u . The volume-weighted average velocity is 



 

 

(1 )f f= + −1 2u u u  (0.60) The volume-weighted average velocity is chosen rather than the mass-weighted average because mass continuity is automatically enforced, without alteration, 
0∇ • =u  (0.61) as is momentum conservation. Subtracting Eq. (0.57) from Eq. (0.58) produces an equation for the relative velocity where K is the drag coefficient per unit volume, 
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u u u u u  (0.62) The goal is to determine the relative velocity, ur. If we employ Eq. (0.62) in its entirety, this would constitute a two-velocity-field model for two-component flow. For simplicity, however, we have chosen to make the drift-flux approximation, i.e., we assume that the relative velocity is nearly steady and the advective terms cancel (i.e., for small relative velocity ur). Under these assumptions we have 
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ru  (0.63) Since the relative velocity ur is based on the microscopic velocities of each phase, then the drag force must contain some information about the volume fraction of the suspended phase. For example, a suspension with an infinitesimally small amount of the suspended phase will produce an infinitesimally small momentum exchange between the components. If we presume that the suspended phase is composed of particles that are the same size, and there are n of them in a unit volume, then 
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u  (0.64) where Vp=(1-f)/n is the volume of a particle and Kp is the drag coefficient for a single particle moving with velocity magnitude ׀ur ׀  through the continuous fluid, and 
1 2(1 )f fρ ρ ρ= + −  (0.65) is the volume-weighted average density. A quadratic dependence between the drift coefficient and the relative flow velocity is used in the model. If U is the magnitude of relative velocity of the particle moving in a continuous fluid, then 
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where Cd is a drag coefficient, Rp is the average particle radius and Ap is the cross sectional area of the particle, which is assumed to be spherical. Because of the appearance of U in expression (3.60) an iterative solution is required to solve for the relative velocity U, but the iteration is quite efficient and does not require much time. When the volume fraction of dispersed material is not vanishing small, the use of a single particle drag force for computing the momentum exchange between components is not quite correct. The most frequently used correction to account for particle/particle interactions is an experimentally determined relation referred to as the Richardson-Zaki correlation. Richardson-Zaki’s correlation is dependent on the particle Reynolds number, Re=(2ρcRpU/μc). The correlation consists of replacing the drift velocity by multiplying the computed value, ur, by the dispersed component volume fraction raised to a power ζ, 
( )1eff

r r
f

ξ

= −u u  (0.67) The exponent ζ is the product of the Richardson-Zaki coefficient rzmlt and ζ0, that is, ζ =rzmlt* ζ0 where Re < 1.0 ζ 0 =4.35/Re0.03 1.0 < Re < 500 ζ 0  =4.45/Re0.1 500 < Re ζ 0  =2.39 The adjusted, or effective value, is used for the computation of all drift fluxes. This correlation is only used in connection with the quadratic particle drag model. 
Electric Field Model To simulate physical processes such as movement of charged mass particles, particle and liquid dielectrophoresis, and electro-osmosis, an electric field distribution is needed. In FLOW-3D, the electric potential is solved for using the following equation. 
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∇ ⋅ ∇ = −  (0.68) with the electric field calculated by 

φ= −∇E  (0.69) where ρe, ε0 are free charge density (i.e., electric charge per unit volume) and permittivity of vacuum or void (defined by elperm in FLOW-3D) respectively while K is the spatially-varying dielectric constant. At open boundaries (i.e., boundaries through which fluid flow can occur), either an insulation condition (i.e., 
0 φ⋅∇ =n where n is a normal vector on the boundary in question) or a specified value of the electric field can be specified. Solid objects can be assigned time-dependent potentials if they are conductors. Alternatively, an object can be a dielectric material with an assigned dielectric constant. In this case, the electric potential is computed within the object. Also, solid dielectrics may have non-zero conductivities that support free charges and currents. 



 

 

Optionally, a charge density equation that includes charge convection, charge relaxation and charge sources associated with non-uniform electric properties is solved simultaneously with the electric potential. Please refer to Electrostatic in the Model Reference chapter and the Technical Notes listed at the end of this section for more information. Most people use the SI system of units for electrostatic and electromagnetic problems. In the SI system the standard unit of charge is the coulomb and the unit of potential is the volt. Electric field intensities are measured in Newton/coulomb in the SI system. When using the CGS system of units, it is customary to express charge and potential in the "electrostatic" units of statvolt and statcoulomb, where 1 coulomb = 2.998 x 109 statcoulomb 1 volt = 3.336 x 10-8 statvolt Electric forces are then, 1 Newton = 1 coulomb volt/m = 105 dyne 1 dyne = 1 statcoulomb statvolt/cm = 10-5 Newton If the fluid or solid regions are conducting then charges may develop in response to the applied field and to changes in conductivity and dielectric properties. If a thermal model is activated then Joule heating due to these currents will be computed in all conducting fluids and solids. Solution of the Poisson equation that governs the potential is done by either an ADI or GMRES iteration method. More details are given in Flow Science Technical Notes #52, #56, #69 and #70. Follow these links to find and download a copy of these technical notes.  
High Concentration Granular Media Model The designation of high concentration granular flow here means the volume fraction of the granular material is 50% or greater. At high concentrations a strong coupling exists between the solid particles and surrounding gas so their mixture can be well approximated as a single, composite fluid. This mixture is treated as an incompressible fluid that may contain free surfaces separating it from regions of pure gas. Two-phase effects within the mixture resulting from differences in the velocities of the two materials are accounted for using a Drift-Flux approximation. The composite fluid, in general, has a non-uniform density. Density of the fluid mixture cannot change with the bulk mixture flow because of the assumption of incompressibility. However, density variations do develop because of the relative flow between solid and gas within the mixture as described by the Drift-Flux model. Solid packing requires the removal of gas displaced when the particles are squeezed together. In the model this loss of mixture volume is treated as a loss of gas at the free surface of the mixture. Gas may escape from a free surface because of the relative motion between solid and gas. In addition, the assumption that the volume fraction of the solid material is always greater than or equal to 50% is used to remove gas at the 
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surface to restore the solid volume fraction to 50%. In effect, this is the definition of the free surface. In either case all removed gas is transferred to an adjacent gas bubble. Discrete solids can only be packed to a specified close packing limit whose density is less than the density of the pure solid. A typical value for the solid volume fraction of close packed spherical particles, of uniform size, is fspk=0.63. In the Drift-Flux model an option is available that defines the maximum solid fraction that can occur. This limit is imposed by forcing the drift velocity to zero when the limiting volume fraction is reached. This treatment is similar to the limiting of the drift-velocity by the Richardson-Zaki correlation, which is an empirical accounting for particle-particle interactions occurring at higher volume fractions of dispersed material. Shear stress in granular materials at high concentrations is well known to be much larger than the viscous shear stress of the fluid carrying the dispersed solid. Extensive work, beginning with the 1941 work of Bagnold has been summarized and further extended to a larger range of experimental conditions by (Mih, Walter C., 1999). At high concentrations the principal contribution to the shear stress arises from impact forces (i.e., collision) between grains. A second, and generally, smaller contribution arises from the distributed solid affecting the fluid. Mih’s expression for the effective dynamic viscosity (adapted from Mih’s equation 39) is, 
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 (0.70) Here µ and ρ are the gas viscosity and density, ρs is the sand density, e is the coefficient of restitution associated with grain impacts, d is the grain diameter and λ is a function of the maximum solid volume fraction fsmx=0.63 divided by the solid volume fraction fs, 
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 (0.71) Physically, λ=d/S where S is defined as the average distance between grain centers minus their diameter d. When the grain touch (i.e., are packed), S=0 and λ becomes infinite.  For our purposes, the simple shear rate du/dy is replaced by the magnitude of the rate of strain eij and a typical coefficient of restitution for sand of 0.7 is assumed as a good general value. With these changes, Eq. (0.70) is reduced to 
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 (0.72) This expression is a “shear thickening” viscosity. The thickening character arises from the impact mechanism between grains, a process referred to as saltation. That is, fast moving grains flowing over a bed of settled or slow moving grains will strike one another causing the slow moving grains to be knocked upwards into the moving stream where they absorb momentum from the stream through further collisions. 



 

 

The impact viscosity term (the second term in Eq. (0.72)) has the generic form of a Large-Eddy-Simulation (LES) viscosity. Since the empirically derived expression in Eq. (0.72) involves turbulent flow conditions it is not necessary (and perhaps not consistent) to use a turbulence transport model with the granular flow model.  An important element in modeling two-phase flow of sand/air is to have a mechanism for sand to pack and resist motion under applied pressures and body forces. A type of flow resistance model is used for this purpose that is based on observations of blowing sand. As solid material packs to a density where individual grains begin to touch one another, it becomes more difficult for the solid/gas mixture to flow. This state is sometimes referred to as one of mechanical jamming and has a typical volume fraction of fsjam=0.61. At still higher solid densities, corresponding to solid packing, grains remain in contact with their neighbors and are not able to flow at all. According to (Bagnold, R.A., 1941; reprinted 2005) gains that have settled and packed on a bed can only be dislodged or knocked up into a region of flowing sand if the flowing sand has a velocity that exceeds a threshold value, uthrs. Based on empirical studies and an approximate theory, which includes the magnitude of the gravity g and grain diameter d, the threshold velocity is 
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u C d ρ ρ ρ= −g  (0.73) where Cdrg is equal to 1.0. The inclusion of Cdrg in this expression is to allow for future adjustment to the threshold velocity to possibly account for cohesion effects between grains. The packing resistance in a mesh element containing fluid is assumed to be zero if the fluid velocity in the element is larger than this threshold value or if the volume fraction of the solid material is less than that necessary for mechanical jamming. For volume fractions larger than the jamming value and velocities less than the threshold value a flow resistance is added to the right side of the fluid momentum equation as a negative acceleration given by 
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�gggg  (0.74)  where Sdrg is a non-dimensional coefficient of order unity. This resistance is proportional to the flow velocity in excess of the threshold speed and also proportional to the volume fraction of sand.  When the volume fraction of solid material reaches or exceeds a value of about 0.99fspk the flow velocity is set to zero and the material is considered to be fully packed. An exception to this rule is in surface elements having a slope greater than an angle of repose defined as the angle between the inward surface normal and the direction of the body force (e.g., gravity). In such elements there is no flow resistance. There are exceptions to the angle of repose and close packing limits that give the present model more realism for granular flow. One exception is the inclusion of an angle of motion chosen as 2 degrees larger than the angle of repose. When a surface is packed, and at rest, it cannot flow until the surface slope is greater than the angle of motion, but then it will continue to flow only as long at the slope remains greater 



 

 

than the angle of repose. The angle of motion acts as a kind of static friction that must be overcome before flow can occur. A similar “static friction” concept is used in the interior of the composite fluid to unpack a previously packed region. At a solid wall boundary where granular material may be falling (drifting) away from the boundary resulting in a solid volume fraction of less than 50%, a special treatment is necessary. In this case there is initially no free surface so one must be created by a kind of “cavitation” process. When a solid fraction less than 50% is found at a location that is not identified as a free surface, the pressure at that grid element location is allowed to relax toward the external gas pressure and the grid element is flagged as a special element in which the pressure is defined and incompressibility is not enforced. This action allows the element to open up and become a new pure gas region. The maximum packing volume fraction fspk =0.63 is an input variable that can be changed. If a change is made then the corresponding solid fractions fsjam and fsmx are automatically adjusted to have the same proportional values with the changed fspk as they did with fspk =0.63. The granular flow model described here has some limitations, such as not allowing for a detailed flow of gas through packed solids. Nevertheless, it produces useful results with many realistic features. For example, in applications to the making of sand cores for metal casting, very good qualitative agreement has been obtained with experimental data. 
Sand Core Blowing Model The generation of sand cores for metal casting applications is typically done by blowing a sand/air mixture into a box containing a cavity with the desired shape of the core. Multiple air vents are usually provided in the box in an effort to achieve a uniform sand fill over the entire volume of the core. These vents are also used in many cases to allow hot air or a catalyst gas to be blown through the sand to affect a thermal or chemical cure of a bonding agent coated on the sand particles. The sand core model is an application of the model for granular flow supplemented with specially defined air vents. Output from the model includes not only a history of the filling patterns within a core box, but also provides information about the effectiveness, number, location and size of air vents used in the box. Additional output includes density variations that may exist within the finished core. Details of the basic flow model can be found in the description of the granular flow model. Vents necessary for sand core blowing are of two types; regular vents that directly exchange air between trapped bubbles of air in a die and air external to the die, and venting that is the result of an indirect air flow from bubbles through sand to vents that have been covered over by sand. The latter venting is referred to as “global venting.” Regular vents are similar to valves as both are mechanisms for exchanging gas between pure gas regions (bubbles) within a computational grid and pressure regions external to the grid. A vent is characterized by a location, valx, valy and valz, an external pressure, valp, and a loss coefficient, Vc, that includes the flow area of the vent and a flow loss factor. If a pure gas region encompasses a vent it will either gain or lose gas with the external pressure source depending on the pressure difference. The volume flow rate through a vent is defined as, 
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= ∗ ∗  (0.75) The square root factor is a Bernoulli approximation for the flow velocity passing through the vent because of a pressure drop. The variables p and ρ are the pressure and density of the gas adjacent to the vent. For simplicity this is rewritten as, 

FlowRate valc p valp= ∗ −  (0.76) where the vent coefficient, vent flow area, factors of 2 and the gas density ρ under the root sign have all been combined into the vent coefficient valc. For typical sand core blowing applications, sand screens are placed over vent channels having openings that are holes or slots with sharp edges. A reasonable estimate for the flow loss through these openings is ½. Thus, the vent coefficient is given by, 
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=  (0.77) where Area is the actual open flow area of the vent (e.g., the screen). Any number of vents can be defined. If the mixture fluid fraction in a computational grid cell containing a vent location is greater than 0.5 it is assumed that the vent is blocked by the fluid and no further gas flow is allowed through the vent. In sand core blowing even packed sand is porous to the flow of gas. A simple representation of this gas flow that allows all air bubbles in a core box to be vented whether or not they contain a vent is referred to as a global vent. The global vent has the same formulation as an individual vent except that the external pressure for the global vent valpg is replaced by the average of all the regular valp values and the global vent coefficient valcg is replaced by the sum of all the regular valc values. In addition, the flow coefficient of the global vent is further multiplied by a factor valcgx that represents the average flow loss through sand plus the reduction in area of the vents because of blockage by sand. A simple estimate can be made for the global vent coefficient multiplier valcgx. In a standard vent the flow velocity passing through the vent is estimated using a Bernoulli approximation together with a flow loss factor. For the global vent the air must flow through the porous sand. We shall assume the permeability of the sand is dominated by form losses, an assumption that is probably not quite correct but allows a more direct comparison with the Bernoulli expression for a normal vent. Using this assumption the air velocity passing through the sand to the vents can be estimated by the expression, 
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 (0.78) In this expression p is the air pressure in the die, po is the exit pressure, ρa is the density of air, d is the diameter of the sand grains and L is the average distance between the air pocket and the vents and fspk is the 



 

 

volume fraction of fully packed sand. The factors involving the packed solid fraction account for the porosity in the sand. The volume of air vented through this global vent per unit time is the product of the number of normal vents times the vent area, reduced by sand blockage and times the above velocity,  
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VolumeflowRate Number of Vents A f u= −  (0.79) Comparing this rate with a normal vent rate, Eqs..(0.76)-(0.77), gives the effective additional loss coefficient associated with flow through sand that must multiply the sum of the normal vent loss coefficients, 
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 (0.80) For a maximum sand packing fraction of fspk =0.63, a nominal grain diameter of 0.02cm and an estimate of L=1.0 cm this expression gives VALCGX=0.02. This value has been found computationally to give good results. 
Particle Movement and Fluid Flow Due to Electric Field An electric charge or charge dipoles can be carried by molecules, small droplets, and particles which are called charge, or charge dipole carriers, or mass particles in FLOW-3D. If the charge of a mass particle, i, is ei, the electric force (called coulomb force) acting on this particle is 

i i
e=f E  (0.81) where E is the electric field intensity and its calculation is described above. If a mass particle, i, carries charge dipoles and the corresponding dipole moment is pi, the electric force (called polarization force) imposed on this mass particle is 
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= ⋅∇f p E  (0.82) If all energy losses in the carriers are neglected, the dipole moment is calculated by 
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p E  (0.83)  where Kp, rp and ε0 are the particle dielectric constant, particle radius, and Permittivity at vacuum, respectively. Then, the electric force imposed on mass particle, i, carrying the charge dipoles can be cast into 
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f  (0.84) Instead of paying attention to the carriers mentioned above, we consider fluid where these charges or charge dipole carriers are distributed. According to Newton’s law, the fluid will experience some body forces due to existence of charge or charge dipoles. The body force due to free charge is 
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ρ= −F E  (0.85) where ρe is the free charge density. The body force due to charge dipoles is 

( )= ⋅∇F P E  (0.86) where P is the density of the dipole moment. For dilute dipoles in fluid, this density can be calculated by 
0 ( 1)Kε= −P E  (0.87) The body force is then calculated by 
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K Eε= − ∇F  (0.88) In FLOW-3D, users can provide a charge density distribution and this density is assumed to be "frozen" into the fluid. This distributed charge density is defined using the FLOW-3D scalar variable having index iechrg (a FLOW-3D input parameter). Movement of particles carrying induced charge dipoles due to polarization is called particle Dielectrophoresis (DEP) while fluid flow due to existence of charge dipoles from polarization is called liquid Dielectrophoresis. With the aforementioned equations included in FLOW-3D, users can simulate both particle and liquid Dielectrophoresis. Please refer to Dielectric to get related information on how to use the models. 

Electro-osmosis Generally, most substances such as silica and glass will acquire a surface electric charge when brought into contact with an aqueous (polar) medium (electrolyte solution), as shown in the figure below. 

 A layer called the electric double layer (EDL) is formed close to the charged surface in which there is an excess of counter-ions over co-ions to neutralize the surface charge. There are more counter-ions than co-ions in the region near the fluid/solid interface. The electric potential created due to the EDL is called the ξ–potential and is assumed to be imposed at the solid surface. The ξ–potential is a property of the solid-liquid 



 

 

pair and can be measured experimentally. The thickness of the EDL is indicated by the following parameter, called the Debye shielding distance or Debye length. 
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 (0.89) where ε = liquid permittivity R = gas constant T = temperature F = Faraday’s constant c0 = ion concentration z = valence More details on EDL and related physics can be found in the textbook by Probstein (Physicochemical Hydrodynamics, Wiley and Sons, New York, 1994). Electro-osmotic flow or electro-osmosis refers to the fluid motion that occurs when an electric field is applied to an electrolyte solution in the vicinity of a charged surface. The process can be described by the following equations 
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∇ =  (0.92) where ψ is the ξ–potential. An insulation-like boundary condition is imposed for the ξ -potential on all mesh boundaries with a symmetry condition. On solid (obstacle) surfaces, the ξ -potential is imposed. Here Boltzmann charge density distribution for liquid with single valence is assumed. But the user can easily provide other different charge density distributions in two simple functions named psi.F and dfdpfi.F released to users. How to do this customization is described in these two functions. Please refer to Electro-osmosis in Model Reference to get related information on how to use the model.  
Elastic and Thermoelastic Stress Model The elastic stress model in FLOW-3D is implemented with the elastic stress tensor separated into two parts: the deviatoric and isotropic. The isotropic part is the stress associated with uniform expansion or contraction of the material. It can be thought of as a pressure. Conversely, the deviatoric part is the stress associated with shearing and stretching of the material. The isotropic part of stress is solved much like pressure for incompressible materials; it is solved implicitly for all cases to avoid the small time steps 



 

 

associated with the high bulk modulus of most materials. The deviatoric part of stress is solved separately, either implicitly or explicitly. 
Model Formulation The incremental elastic stress model incorporated into FLOW-3D computes the elastic stress using linear Hookean theory. Although this constitutive equation predicts linear responses to stress, implementation as an incremental model allows the prediction of highly nonlinear responses because the response within each small time step can be well approximated as linear. The figure below shows visually how the total stress is a summation of the viscous stress and the elastic stress. Thus the model predicts that the total state of stress is a summation of the viscous stress and the elastic stress; one of these dominates, depending on the local strain and strain rate. Suppose a rod of viscoplastic material, as described by this model, undergoes a fixed amount of strain, imposed over a very short time. This model would predict a corresponding rise in elastic stress that is linearly proportional to the strain. 

 Pictorial view of viscoplastic model, showing the relationship between the elastic and viscous stresses. Also, during the short time of the strain imposition, the viscous stress would become significant, only to fall to zero the instant the strain imposition ceased. If further strain were to be imposed to a point such that the elastic stress surpasses the yield stress, the material would yield and begin to flow as a liquid with viscosity η. For small deformations (i.e., the Hookean assumption), the state of stress τE for an elastic solid (in three dimensions) undergoing thermal expansion is 
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K G e G K T Tα= − + − −τ I E I  (0.93) where E is the strain tensor, I is the unit isotropic tensor, G is the shear modulus, K is the bulk modulus, α is the linear thermal expansion coefficient, T is the local temperature, and T0 is the reference temperature. e is the volume strain; this characterizes the isotropic expansion or contraction of the material and is equal to  tr(E). Although Eq. (0.93) is a linear model, if computed incrementally over small enough time periods such that each incremental deformation is small enough to obey the linear assumptions, non-linear processes can be predicted. Eq. (0.93) can be written for both the deviatoric and isotropic parts of τE (by definition, τE is symmetric). The deviatoric part is 
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where τE′ is the deviatoric part of τE and E′ is the deviatoric part of E. In three dimensions E′ is 
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3 e′ = −E E I  (0.95) The isotropic part of Eq. (0.93) is 
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p Ke K T Tα= − + −  (0.96) where p is negative of the mean isotropic stress, or “pressure,” and is equal to -tr(τE)/3. For the incremental stress model, Eqs. (0.94)  and (0.96) must be related to existing quantities in FLOW-3D. In terms of the strain rate tensor, Eq. (0.94) can be written as a differential equation; it is 
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 (0.97) where Ė′ is the deviatoric part of the strain rate tensor. In three dimensions, it is 
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E u u Iɺ ɺ  (0.98) where ė is the volume strain rate, equal to ∇⋅u . Eq. (0.97) is solved in FLOW-3D by using scalar arrays to store the components of the elastic stress tensor; these components are already advected with the motion of the material, and the incremental strain is added to the stress tensor components at each time step. Similarly, Eq. (0.96) can be rewritten as 
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u uɺ  (0.99) The advection term in Eq.(0.99) (second term on left side) is assumed to be small, relative to the time derivative of p because pressure waves, especially within solids, move far faster than the material advects (in all subsonic simulations). Therefore, this term is assumed to be zero. The current value of stress is a function of the past history of a material element. Material that enters the domain has a null state of stress, unless specified otherwise at the domain boundaries. Also, the initial condition at the beginning of the simulation has a null state of stress, unless specified otherwise by the initial conditions. In order to predict yielding effects, the Mises yield condition is used. This condition is 
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=  (0.100) where IIτ′E is the second invariant of the deviatoric part of the elastic stress tensor and Y is the yield stress limit, a user-defined parameter. In regions of the material where the elastic stress (measured by IIτ′E) exceeds the yield criterion, the elastic stress is relaxed such that the condition in Eq. (0.100) is met:  
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Eτ  (0.101) where τE′* is the yield-limited elastic stress tensor. Eq. (0.97) can be solved either implicitly or explicitly and Eq. (0.99) is solved implicitly for p at each time step. The resulting values are included in the momentum equation: 
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Solution Method The solution of the strain rate tensor, Ė, is similar to that used in the viscous stress algorithm. The normal components of Ė are computed at the cell center, while the shear components are calculated at the cell edges. The figure below shows a typical computational cell and the stress component calculation locations. The shear components are computed on the cell edges for computational convenience and numerical stability. 
 Computational cell showing locations of components of strain rate tensor At free-surfaces, the external fluid is presumed to be a gas vapor which exerts negligible stress on the fluid surface. Therefore, n·τ′E=0 at such interfaces. In FLOW-3D, the principal directions in which free-surfaces and the status of neighboring cells are known. From this information, the appropriate components of τ′E are set to zero at free-surface to ensure that the aforementioned condition is met. At interfaces with solid walls or obstacles, the fluid velocity in the cell neighboring the wall (or obstacle) and the velocity of the wall (or obstacle) are used to compute the strain rate using Eq.(0.98). If the explicit method is chosen, the elastic stress is updated with Eq. (0.97) during the previous time step, and the resulting value of τ′E * is used in Eq. (0.102) to compute the new velocity for the current time step. This method has the advantage of simplicity and rapid computation during each time step. However, for materials whose elastic effects dominate other effects, the numerical stability limit can be very small. Therefore, the implicit method can be selected to eliminate this time-step limit for such problems. The disadvantages of this method are that the computational effort required during each time step is much greater and it can dampen out oscillations that may physically occur. 



 

 

If the implicit algorithm is chosen, a prediction of the velocity is computed in the same way as the explicit method. However, the velocity is updated based on the remainder of the momentum equation, along with the equation of isotropic stress Eq.(0.99): 
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u  (0.103) where the value of τ′E * is the most up-to-date value.  The method used to solve Eq.(0.103) is the Jacobi method; in this method, all of the updated elastic stress tensor components throughout the domain are solved based on the velocity computed from the previous iteration; components from neighboring recently computed cells are not included until the next iteration. This is repeated until the change in velocity from one iteration to the next is smaller than a preset tolerance. If desired, this method can be used in conjunction with the Jacobi implicit viscous stress method for materials whose viscous effects are also very large. Currently, the implicit elastic stress model cannot be used with the ADI (Alternating Direction Implicit) or GMRES (Generalized Minimum Residual Solver) implicit viscous stress algorithms. The negative of the mean isotropic elastic stress (i.e., pressure), p, is computed separately, using Eq.(0.99), and the solution algorithm is exactly the same as that for liquid pressure. The pressure and velocity components are updated for each iteration until the residual of Eq. (0.99) falls below a preset tolerance. The numerical method can be SOR, ADI or GMRES. The SOR algorithm is very similar to the aforementioned Jacobi method, except that the most up-to-date values, including neighbor values computed in the current iteration, are used. The ADI algorithm solves simultaneously an entire row of cells in the direction chosen, while the GMRES algorithm solves the fully coupled system of equations. 
Computation of Elastic Modulus, G The elastic modulus G can be uniform, or vary spatially as a function of fluid fraction (for a two-fluid model) or temperature (for a model with energy transport). It is defined as 
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G F T scl G f G f G f G f T Tρ = + − − + − −  (0.104) where G1 and G2 are the elastic moduli at the reference temperature for materials 1 and 2 (referred to as fluids 1 and 2 in the GUI, but are not necessarily fluids in this instance), respectively, and GT1 and GT2 are the linear sensitivity to temperature for materials 1 and 2, respectively. At least one of these values must be set, otherwise G will be assumed to be zero everywhere. Note that in the normal situation, in which the elastic modulus falls with rising temperature, the values of GT1 and GT2 are positive. Furthermore, G can be a function of scalar concentration (when scalar quantities are used) and density (when the variable density model is activated); refer to the Model Reference chapter for details. 
Computation of Yield Stress Limit, Y Just like the elastic modulus, the yield stress limit Y can be uniform, or vary spatially as a function of fluid fraction (for a two-fluid model) or temperature (for a model with energy transport); it is defined as 
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where Y1 and Y2 are the yield stress limits at the reference temperature for materials 1 and 2, respectively, and YT1 and YT2 are the linear sensitivity to temperature for materials 1 and 2, respectively. At least one of these values must be set, otherwise Y will be assumed to be zero everywhere. Note that in the normal situation, in which the yield stress limit falls with rising temperature, the values of YT1 and YT2 are positive. Furthermore, Y can be a function of scalar concentration (when scalar quantities are used) and density (when the variable density model is activated); refer to the Model Reference chapter for details. 
Elastic Membrane and Elastic Wall Model A limited Fluid-Structure interaction (FSI) capability is available in FLOW-3D with the elastic membrane and wall model. In this model, deformation of an elastic membrane or an elastic wall impacts the adjacent fluid flow, while fluid pressure, in turn, affects the deformation. These interactions are described in the code in a fully coupled fashion.  The main limitation of the model is that the deformation is assumed to be small, i.e., for each membrane and elastic wall, its deflection is much smaller than its size. This allows useful simplifications for the model. The geometries of membranes and elastic walls are thus assumed to be time-invariant throughout calculation, while effects of their deformation on fluid flow are described with volume source or sink distributed on the fluid-structure interface. With the further assumption that the pressure force is uniformly distributed on the membrane surface, analytical solutions rather than structural analysis algorithms are used to determine membrane deformation for a better computational efficiency.  Elastic Membrane An elastic membrane in FLOW-3D is a rectangular or circular thin plate which undergoes a small elastic deformation under action of external forces. Its thickness and material properties are assumed to be uniform. Its edge can be either simply supported or clamped. By simply supported edge we mean an edge with both zero deflection and zero net force moment. At a clamped edge, however, both deflection and its first order derivatives are zero, but the force moment is generally non-zero. In any case, the model requires that a membrane has the same condition all along its edges. There is no restriction on location of a membrane in the mesh grid, but the membrane’s surface must be perpendicular to x, y, or z axis.  The model considers two external forces acting on the membrane: the hydraulic pressure force and an actuator force. The hydraulic pressure force is obtained by integration of pressure over both sides of the membrane. It is then converted into a uniformly distributed force over the whole membrane.  An actuator force is present in many applications such as micro-pump flow and inkjet droplet formation. One example is about a piezoelectric actuator attached on a membrane. When an electric voltage is applied, the piezoelectric actuator exerts a force on the membrane in the surface normal direction, which is the so called actuator force. Users can prescribe the actuator force either as a sinusoidal or piecewise linear function of time. In the model, the actuator is always assumed to be centered on one side of the membrane, and the shape (but not necessarily the size) of the contact area of the actuator with the membrane is the same as that of the membrane. In other words, both membrane and the actuator must be either rectangular or circular and have the same symmetric axis. Because the actuator itself usually has much lower rigidity than the membrane, it is further assumed the actuator force always acts uniformly over the contact area. If a zero contact area is given, then the actuator force is treated as a concentrated force at the membrane’s center.  



 

 

To achieve a better computational efficiency, analytical solutions rather than structural analysis algorithms are used for the deflection calculation. At any point in time the membrane is assumed to be in an equilibrium state, defined by balance of the hydraulic force, actuator force and the membrane’s rigidity. Analytical solutions are obtained by solving the equilibrium equation for a thin plate with small deformation, 
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∇ ∇ =  (0.106) where w is deflection, f is the net external force per unit area on the membrane, D is flexural rigidity, 
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 (0.107) where E is Young’s modulus, ν is Poisson’s ratio, and h is the membrane’s thickness.  Consider a rectangular membrane with its surface perpendicular to the z axis. In a Cartesian coordinate system Eq. (0.106) is then written as 
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 (0.108) For convenience, we place the coordinates’ origin at the membrane center. Let a and b represent the membrane’s lengths in x and y directions, respectively. The boundary conditions for the membrane with the simply supported edges are 
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 (0.109) With a denoting the membrane’s radius, the boundary condition for the simply supported edge is 
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  for r a=   All the analytical solutions for the membrane’s deflection used in the model satisfy the above equations. Some of these solutions are found in Timoshenko (1959), while the others are derived from Timoshenko’s solutions using the supposition method. Please refer to Flow Science Technical Note #79 for the details of these solutions. To account for effects of the membrane motion on fluid flow, the continuity equation is modified with a volume source (or sink) term S added to its right hand side, 
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�  (0.111) Other transport equations for momentum, energy, turbulence and scalars remain unchanged because in FLOW-3D these equations are used in their non-conservative forms. When they are derived from their conservation forms with consideration of the continuity equation, the source terms due to membrane motion are cancelled out.  Elastic Wall An elastic wall in FLOW-3D is an elastic object of arbitrary shape, and its surface deformation is small and proportional to hydraulic pressure, namely 
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= −  (0.112) where w is local deflection in surface normal direction, p is local pressure, pref is a reference pressure, K is coefficient of rigidity per unit area. Such kind of elastic deformation occurs if the Poisson’s ratio for the wall material is zero, which means the normal stress causes no lateral strain. It is a good approximation for 
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elastic wall deformation if the Poisson’s ratio is not zero but small. With the lateral strain term neglected, the Hooke’s law is reduced to 
E

σ
ε =  (0.113) where ε is the strain, σ is the normal stress, and E is Young’s modulus. K in Eq. (0.112) is a user-prescribed parameter. To determine the value of K, consider a plate at equilibrium with one side fixed and the other side under a normal force. Assume the Poisson’s ratio is negligible and the normal stress is σ at a location on its surface. From force balance, the normal stress inside the plate has the same value σ along the vertical line through that location. Denote the plate’s thickness as h and the deflection as w. The strain is then w/h, and the Hooke’s law in Eq. (0.113) gives 
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=  (0.116) where L is a length scale comparable to the depth of the elastic wall. It may also be obtained from other means such as experimental measurement or full structural analysis.  Effects of the elastic wall motion on fluid flow are described by adding a volume source (or sink) at the wall surface. The continuity and the transport equations for VOF are modified in the same way as described in the section for elastic membranes. Model Limitations The model allows for multiple elastic membrane and elastic wall objects with different shape, size, orientation and physical quantities. It is compatible with most other models of FLOW-3D. For example, heat transfer across membranes and elastic walls can be included. However, restrictions and limitations exist. The model requires that both elastic membranes and elastic walls have small deflections. A small deflection for a membrane means the deflection is less than the membrane’s size. For an elastic wall, its deformation needs be small compared to the computational cell size. This assumption allows us to ignore the actual change in the position of the deforming surfaces. In other words, the shape of the membranes and deforming walls are fixed throughout the calculations, as defined by their initial setup. As shown above, effects of surface deformation on fluid motion are modeled through the fluid source distribution on the deforming surface. When computational results are displayed, deformation can be visualized by plotting the contours of deflection. It is also noted that an elastic membrane/wall cannot be porous or a moving object at the same time. If a moving object collides with a membrane or elastic wall, the latter is treated as a non-moving rigid object in collision simulation, thus the impact will only affect motion of the moving object. 



 

 

Fan and Impeller Model The fan and impeller model used in FLOW-3D can be used when the rotation rate of the blades is such that many revolutions are required before a steady flow is established in the fluid. This model induces both swirl and axial velocity components. The definition of a fan or impeller is done in terms of a "phantom" obstacle that defines a region but does not have any real obstacle blockage effects. Generally, these obstacles are assumed to be right-circular cylinders of outer radius R, inner radius r and thickness L, which defines the region swept out by the rotating blades. Aside from the geometry, the remaining parameters that determine the performance of a fan or impeller are its rotation rate Sd, an accommodation coefficient Ad that controls how effective the blades are in setting fluid into motion, and a coefficient Bd that controls the amount of axial flow induced. It is best to determine the values of Ad and Bd from empirical data because the performance of a fan or impeller depends on details of the blade sizes and shapes and on the number of blades. The manufacturers of these devices often characterize them by so called "performance curves," which are plots of pressure drop across the device versus the average flow rate passing through it. The figure below shows a typical (made up) example of a performance curve. 
 Typical performance curve (solid line) and FLOW-3D approximation (dashed) A performance curve for the model used in FLOW-3D can be derived by relating the rotating momentum source to an equivalent pressure drop across the thickness of the device and averaging the flow rate over the entire cross section. The result is: 
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 (0.117) In this expression ρ is the fluid density and Q is the net flow rate. This relationship gives a linear performance curve with y-intercept 
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 (0.118) Using these relations and a given rotation rate OSPIN = Sd, the OADRG = Ad  and OBDRG = Bd parameters can be computed to give a linear approximation to any desired performance curve.  



 

 

Fluid-Structure Interaction (FSI) and Thermal Stress Evolution (TSE) Models The Fluid-Structure Interaction (FSI) and Thermal Stress Evolution (TSE) models are based on the same approach: solving the fully coupled solid-dynamics and fluid flow within FLOW-3D.  The approach used for this model is unlike any other module in FLOW-3D. The original structured finite-difference mesh used for the fluid and heat transfer computations is not used with the new module. Instead, a conforming and unstructured finite element (FE) grid is used which deforms along with the solid. This is because solving the solid mechanics equations is far more convenient and accurate with a conforming FE mesh than with a non-conforming finite difference mesh. The standard FLOW-3D mesh is used to generate the new finite-element (FE) mesh for solid components (for FSI) or solidified fluid regions (for TSE). Throughout the bulk of the solid regions, the standard hexahedral mesh is used without alteration. At the interface of the solid region, the nearest node points are moved onto the surface of the solid region along the normal to the surface. In some instances, nearby nodes are eliminated or merged with neighbors. The figure below shows a simplified two-dimensional example of this process. Therefore, the creation of the FE mesh is completely automatic and requires no additional input from the user. Elements away from the interface always have 8 nodes. Due to the merging of nodes near the solid interface, elements at the surface can have 7, 6, 5, or even 4 nodes. 

 In the Model Reference section, there are discussions on how to control the resolution of the finite element meshes. 
Equation of motion and stress The FSI and TSE models solve the standard equation of motion in solid regions (solidified fluid for the TSE model, and solid components for the FSI model: 
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σ b  (0.119) where ρ is the density of the material, t is time, x is the coordinate of a point in the material, σ is the Cauchy stress tensor, and b is the body force vector. The Cauchy stress tensor is a measure of the state of stress in 



 

 

the material. It is related to the strain of the material, as well as thermal and other internal stresses. The strain is the amount of physical deformation undergone by the material, and is also a tensor. The approach used in this work is based on small, incremental deformations. That is, from one time step to the next, the strain increment is computed: 
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i jE x x e e  (0.120) Here E’ is the strain increment, the subscripts i and j refer to the Cartesian coordinate directions (x,y,z), and ei refer to the unit normal vectors in x,y, z. δx refers to the displacement vector, and is equal to: 
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x x x  (0.121) where xn is the position of a material point in the previously computed time cycle, and xn+1 is the position of the same point in the current time cycle.  The Cauchy stress tensor for the current time-level, σn+1, is computed from the linear Hookean model for each time-step increment, and is: 
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n 1 nσ σ E E  (0.122) Here again, the n and n+1 superscripts refer to the previous and current time cycles. K and G are the bulk and shear moduli, respectively, tr(E´) refers to the trace of the strain tensor E´ and is the sum of its diagonal components. The bulk modulus K is a user-defined parameter that describes the material resistance to isotropic expansion or contraction. The shear modulus G describes the material resistance to shearing. The bulk and shear moduli, K and G, can be obtained from specifying the Young’s modulus (E) and the Poisson’s ratio (ν).The model works with any combination of two out of four elastic properties. The relationships are: 
,

3(1 2 ) 2(1 )

E E
K G

ν ν
= =

− +
 (0.123) Note that when the Poisson’s ratio approaches ½, then K approaches infinity, meaning that the material approaches the incompressible limit. All these properties can be defined as functions of temperature. The acceleration term in Eq. (0.119) is solved from the positions of the points at different times. Therefore, 
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Finite element method (FEM) Equation (0.119) comprises a three-dimensional partial differential equation, solved during each time-step, whose unknowns are xn+1 (σn+1 are computed directly from xn+1 and earlier time level values of σ in Eq. 



 

 

(0.122)). The finite element method (FEM) uses the method of weighted residuals to solve Eq. (0.119). The weighted residual form of Eq. (0.119) is: 
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n 1 x x xσ b  (0.125) Here, Ψ represents the weighting function, and Ω the domain. To keep the order of derivatives to a minimum in the formulation, the following identity is used: 
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n 1 n 1x x xσ b n σ	  (0.128) Here n is the outward pointing normal on the surface of the domain Ω. dΓ is the area of a infinitesimal portion of the solid region interface. The superscripts n-1, n, and n+1 refer to the time-level of each variable. The last term on the right-hand side is non-zero only at the interface of the domain. The weighting function Ψ is comprised of a series of basis functions, which are defined as non-zero only around the node point they correspond to and are zero at all other nodes. Therefore, 
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 The concept of the element helps when thinking about the basis functions ψi. An element is a small volume of the domain whose vertices correspond to the nodes. The figure above shows the 8 nodes within a standard element. The basis functions ψi corresponding to these nodes are all non-zero within this space. The basis functions for nodes which are not part of the current element are all zero. Therefore, considering Eq. (0.129), when Eq. (0.128) is re-written, the result: 
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n 1 n 1x x xσ b n σ	  (0.130) is a series of terms, of which only a few are non-zero within a particular element. Then, Eq. (0.130) is assembled element-by-element. Because the ψk in Eq. (0.130) are non-zero only in the elements shared by node k, Eq. (0.130) is in fact a set of nnodes equations, one for each node. Furthermore, because there are three Cartesian directions, there are a total of 3×nnodes scalar equations. The individual basis functions, ψk, are repeated for each element. Within each element, these basis functions are computed using the computational coordinates of each element (ξ,η,ζ), regardless of the element orientation (see above figure). These are: 
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(0.131) 

Here the subscript refers to the local (i.e., element-level) node. Note that each basis function is equal to 1 at its local node, and 0 at all other nodes. The basis functions are used as both the weighting function for the weighted residual equation, as well as representing the position and displacement: 
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= ∑ kx x  (0.132) Here x refers to the position of a point in the physical domain, and xk refers to the value of the positions stored at each global node k, and ψk is the basis function at node k. Note that although Eq. (0.132) is written in general form for a point anywhere in the domain, it can be used within an individual element considering only nodes within the local element. This is because the values of ψk for all nodes outside of the element are zero by definition. With Eq. (0.132), Eq. (0.130) can be written as a series of 3×nnodes scalar equations with 3×nnodes unknowns: the three coordinates of the position xk at each node. The integral is solved numerically with the method of Gaussian quadrature and the resulting system of linear equations is solved iteratively with a generalized minimum residual (GMRES) solver, similar to the one used to solve the coupled momentum and continuity equations in the fluid. 
Boundary conditions on solid regions The fluid-structure interaction and thermal stress evolution models automatically determine the boundary conditions on each element face of the solid component.  Where such faces contact fluid regions, the local fluid pressure determines the traction (n·σn+1) in Eq. (0.130). Therefore, 
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n 1n σ n  (0.133) The negative sign is present because in the convention of solid stresses, compression is negative. Where the boundary faces are adjacent to the (fluid) domain boundary, the boundary type determines the condition to impose on the solid. Adjacent to wall boundaries, the solid regions are fixed; i.e., the nodes are attached to the boundary and cannot move. At symmetry boundaries, the nodes can slide freely along the boundary, but cannot penetrate nor pull away. At other boundaries, the pressure in the neighboring boundary cell is used to compute the traction, based on Eq. (0.133). 



 

 

When an FSI component is in contact with another component (standard or FSI), the interface is always assumed to be fixed; i.e., the nodes at the interface do not move during the course of the simulation. Therefore, there is no full coupling between two FSI components.  When a solidified fluid region is in contact with another component (standard or FSI), the solidified fluid region can pull away freely and form a gap. When the heat transport properties of the gas in the gap are supplied (gas conductivity and/or emissivity), the heat transfer coefficient is automatically computed in the gap (wider gaps will reduce heat transport). If the opposite situation occurs and the solidified fluid region pushes into a component, a restraining force is applied to the region to prevent interference into the component. Alternatively, if the component is chosen to be a non-constraining component, then only a minimal force is applied to maintain the position of the solidified region. This is useful to simulate thermal stress development in sand molds. 
General Moving Objects Model A general moving object (GMO) is a rigid body under any type of physical motion which is either dynamically coupled with fluid flow or user-prescribed. It can move with six degrees of freedom (DOF) or rotate about a fixed point or a fixed axis. The GMO model allows users to have multiple moving objects in one problem, and each moving object can have any independently defined type of motion. GMO components can be of a mixed motion type, namely have translational and/or rotational velocities that are coupled in some coordinate directions and prescribed in the other directions. A body-fixed reference system (“body system”), defined for each moving object, and the space reference system (“space system”) are employed. At each time step, the hydraulic force and torque due to pressure and shear stress are calculated, and equations of motion are solved for the moving objects under coupled motion with consideration of hydraulic, gravitational and control forces and torques. Non-inertial force and torque are also considered if the space system is non-inertial. Area and volume fractions are recalculated at each time step based on updated object locations and orientations. Source terms are added in the continuity equation and the VOF transport equation to account for the effect of moving objects to displace fluid. The tangential velocity of the moving object boundaries is introduced into shear stress terms in the momentum equation. Two options for the coupling of fluid flow and GMO motion are available: an explicit and an implicit method. In the former, fluid and GMO motions of each time step are calculated using the force and velocity data from the previous time step. In the implicit method these are calculated iteratively. The explicit method only works well for problems of heavy objects (i.e., object density is larger than that of fluid) and problems with small added mass. The implicit method does not have such limitation but is recommended only for light moving object problems (mass density of objects is smaller than that of fluid) or for large added mass problems and other problems where the explicit method fails, as the computational efficiency of the implicit method is usually lower than that of the explicit method. The GMO model also includes the capability for rigid body collisions. Collisions are assumed to be instantaneous. Collisions may occur between rigid bodies (one of which must be moving) and of the rigid bodies and wall/symmetry boundaries of the computational domain. The collision model has two parts to it: collision detection and collision integration. At each time step, once a collision is detected, a set of impact equations are integrated with the Stronge’s energetic coefficient of restitution. Depending on the value of the restitution coefficient, a collision can be perfectly elastic, partially elastic or completely plastic. Friction at the point of contact is also allowed during collision. There can be relative sliding between two colliding bodies at their contact point and the speed and direction of sliding can vary throughout the collision 



 

 

process. If the sliding stops before completion of the collision, the two bodies can either resume sliding immediately or keep sticking till their separation. Continuous contact between moving objects, such as sliding, rolling and resting of one body on the other, is modeled through a series of rapid, low-amplitude collisions called micro-collisions. The GMO model works in both Cartesian and cylindrical coordinate systems and is compatible with most physical models and numerical methods of FLOW-3D, but limitations exist. All moving objects must be solid with no porosity. For fixed axis rotation, the axis must be parallel to one of the three coordinate axes of the space system. A simultaneous collision between multiple objects is approximated with a sequence of single collisions. The order in which these collisions are processed may affect the final result to a degree. If one moving object sits on another object or wall, overlap between the objects or with the wall may occur as a result of energy loss due to friction with fluid or due to the non-elastic collisions. See Flow Science Technical Notes #75 and #76 for more details. 
Equations of Motion for Rigid Body For convenience of computation, a body system (x', y', z') is set up for each moving object with its coordinate axes parallel to those of the space system at time t=0. If an object motion has six DOF, the origin of the body system is set at the object mass center G. Coordinate transformation between the space system (x, y, z) and the body system (x', y', z') is 

[ ]s b G
R= ⋅ +x x x  (0.134) where xs and xb are position vectors of a point in space and body systems, respectively, xG is position vector of mass center in space system, and [R] is an orthogonal coordinate transformation tensor, 
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δ  is the Kronecker δ symbol. It is a property of [R] that its inverse and transposed matrices are identical. For a space vector A, transformation between space and body systems is 
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R= ⋅A A  (0.136)  where As and Ab denote expressions of A in space and body systems, respectively. [R] is calculated by solving  
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Ωx, Ωy and Ωz are x, y and z components, respectively, of the object’s angular velocity in space system.  
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According to kinematics, general motion of a rigid body can be divided into a translational motion and a rotational motion. Velocity of any point on a rigid body is equal to the velocity of an arbitrarily selected base point on the object plus velocity due to rotation about the base point. It is convenient to select the object mass center as the base point for an object with six-DOF motion. Denoting P as any point on the object, its velocity is related to the mass center velocity VG and angular velocity ω of the rigid body by 
P G

P G
= + ×V V rωωωω  (0.139) where RP/G is the distance vector from G to P. The first term on the right-hand side of Eq. Error! Reference source not found. represents translation of the mass center, and the second term represents rotation about the mass center. It is noted that ω is a property of the moving object and independent of the choice of the base point. Equations of motion governing the two separate motions are  
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ω ωω ωω ωω ω  (0.141) respectively, where F is the total force, m is rigid body mass, TG is the total torque about G, [J] is moment of inertia tensor in the body system (“inertia tensor”), 
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 (0.142) The elements J11, J22 and J33 are moments of inertia while the other elements products of inertia, 
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12 21 13 31 23 32' ' ,  ' ' ,  ' 'J J x y dm J J x z dm J J y z dm= = − = = − = = −∫ ∫ ∫  (0.144) If the x’, y’ and z’ coordinate axes coincide with the principle axes of the object, products of inertia vanish. To simplify calculation, Eqs. (0.140) and (0.141) are solved in space and body systems, respectively. The total force and the total torque may include hydraulic, gravitational and control forces and torques. If an object’s motion is about a fixed point, it has three DOF. It is convenient that the body system is set up with its origin located at the fixed point. The coordinate axes of the body system, as described previously, are parallel to those of the space system at t=0. Let C denote the fixed point and xC its position vector in space system, coordinate transformation between space and body systems can be performed using Eq. (0.134) with substitution of xG by xC. For any point P on rigid body, its motion is 3-D rotation about the fixed point and its velocity is written 
P P C

= ×V rωωωω  (0.145) 



 

 

where rP/C denotes distance from C to P, and ω is obtained by solving Eq.(0.141)  in the body system with [J] in respect to C. Rotation about a fixed axis is a planar motion, which has one DOF only. In this case, it is required that the rotation axis be parallel to one of the space coordinate axes. The body system is set up with one of its three coordinate axes coinciding with the rotation axis and the other two parallel to those of space system. Two of the three coordinates of the body system origin are thus the same as those of the rotation axis, and the third coordinate is set zero. For example, if the rotation axis is parallel to y and the x and z coordinates of the rotation axis are x0 and z0, respectively, then the body system (x', y', z') are set up with the y' axis coinciding with y while x' and z' parallel to x and z, respectively, and the body system origin is set at (x0, 0, z0). Angular velocity of the rotating body has one non-zero component only and can be calculated by solving the corresponding component Eq. of (0.141), or, 
T Jω= ɺ  (0.146) where T, J and ωɺ are total torque, moment of inertia and angular acceleration about the fixed axis in body system. Equation (0.145) is used to calculate the velocity of any point P on the rigid body with C representing any point at the rotation axis. 
Source Terms in Conservation Equations The general form of the continuity equation based on the FAVOR™ method is 
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u  (0.147) where Sm is a physical mass source term of fluid, Vf and A are volume and area fractions, respectively. In contrast to stationary obstacle problems, Vf and A vary with time in moving object problems, thus their effects on fluid flow must be considered. Equation (0.147) can be rewritten 
( )

1
.

f f m
V V S

A
t t

ρ
ρ

ρ ρ ρ

∂∂
+ ∇ ⋅ = − +

∂ ∂
u  (0.148) For incompressible flow, it is reduced to 

( ) .
f m

V S
A

t ρ

∂
∇ ⋅ = − +

∂
u  (0.149) Comparing with the continuity equation for stationary obstacle problems, it is seen that f

V

t

∂
−

∂
 is equivalent to an additional volume source term. When using the control volume method, this source term exists only in mesh cells around the moving object boundary. The term f

V

t

∂
−

∂
is calculated using 

f obj

obj

cell

V S

t V

∂
− = ⋅

∂
V n  (0.150) 



 

 

where Vcell is volume of a mesh cell, Sobj , n and Vobj are respectively surface area, unit normal vector and velocity of the moving object in the mesh cell. Equation (0.150) has a good mass conservation property because the net generation of fluid mass over all mesh cells around the moving object boundary is close to zero. It is also exact in time and there are no major difficulties to calculate it.  It is noted a non-conservative form of the momentum equation is used in FLOW-3D. This is obtained by subtracting the continuity equation from the conservative form of the momentum equation. The terms due to time-change of VF are found cancelled thus momentum equations in the non-conservative form keep the same form as those for stationary object problems. Since all the transport equations for scalars (k, ε, energy, etc.) are also in non-conservative form, no additional terms due to VF change appear in these equations for the same reason. For momentum equations, non-zero tangential velocity of moving object boundary is considered in the shear stress terms, wsx, wsy, and wsz. 
Dynamic Equations for Rigid-Body Collision Coulomb’s Law of friction Assume body B collides on body B’ and their contact point (or collision point) is respectively denoted as C on body B and C’ on body B’. A collision reference system (collision system) is set up with its origin located at the contact point with n1, n2, n3 denoting the unit vectors of its three coordinate axes. n3 is along the normal direction of the common tangential plane of the two bodies at the contact point and directs from body B’ to body B. Let v� represent the relative velocity of point C to C’, and p

� the impulse of contact force on body B. In vector form, they are 
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�          (0.151) where the lower index represents the corresponding component in n1, n2, or n3. We now simply denote n for normal direction n3 and p for normal impulse p3, Coulomb’s law of friction is then written 
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1 >+ vv  (0.153) Equation (0.153) can also be written 
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1 >+ vv  (0.154) where φ is the angle of sliding direction measured from n1 about n. Stronge’s energetic coefficient of restitution As generally understood, a collision process is divided into compression and restitution phases. Stronge’s hypothesis is to relate the work done by normal impulse during restitution to that during compression. Stronge’s energetic coefficient of restitution e* is defined 
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−=  (0.155) where W3 is work done by normal impulse, pc is the normal impulse when collision reaches maximum compression, and pf is the total impulse of collision. In Eq. (0.155), the numerator is the total work by normal impulse during restitution and always non-negative, and the denominator is that during compression and always negative. Value of e*   is between 0 and 1. W3 is calculated by 
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33 )(  (0.156) Dynamic equations in general form Assume the two bodies B and B’ have mass M and M’, and their mass centers are located at G and G’, respectively. In the collision system, the relative velocity v� at the contact point satisfies the equations of motion, 
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′ are elements of inverses of inertia tensor about mass center for the two bodies in the collision system, respectively, ri and ri’ are components of distance vectors from the mass center to the collision point respectively for the two bodies. Expressions for 
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− for fixed-axis and fixed-point motions can be found in Flow Science Technical Note #76. Dynamic equations in terms of normal impulse If two bodies in collision slide initially at their contact point, friction may bring slip to a halt when collision is eccentric and initial speed of sliding is small enough. After that, they either stick at the contact point (called slip-stick) or renew sliding immediately (called slip reversal) in a new direction until they are separated, depending on inertia property of the two objects and the friction coefficient. The sliding before halt occurs is called the first phase of sliding, and that in slip reversal is called the second phase of sliding. If friction does not cause halt of slip or the collision is frictionless, only the first phase of sliding can exist throughout collision.  
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When two objects slide during collision, the tangential velocity components are  
φcos1 sv = , φsin2 sv = ,                  (0.161) where s is sliding speed,  
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1 vvs +=  (0.162) and φis sliding direction which varies during collision. Introducing Coulomb’s Law of friction in Eq. (0.154) into Eq. (0.157), equations of motion in terms of the normal impulse p for the first phase of sliding are 
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µ  (0.171) andµ µ< . Equations of motion are thus 



 

 

01 =v  (0.172) 
02 =v  (0.173) 

1

33

1

32

1

31
3 sincos- −−−

+−= mmm
dp

dv
φµφµ  (0.174) During the second phase of sliding, or slip reversal, equations of motion, Eqs. (0.163) to (0.165), are still valid. However, different from the first phase of sliding in which sliding direction varies during collision, sliding in the second phase is along a constant direction φ. It is obtained by solving ( , ) 0h µ ϕ = in Eq. (0.167) for φ. There can be multiple solutions of φ. The sliding direction is the unique solution satisfying 

( , ) 0ds dp g µ ϕ= >  defined in Eq. (0.166). If friction causes slip halt, then comparison of the friction coefficient μ and coefficient for stick µ  determines if slip stick or slip reversal occurs after that. If  µ µ< , slip-stick is achieved. Otherwise, slip reversal happens immediately.  For further details of the dynamic equations and the numerical method for collision simulation, please refer to Flow Science Technical Notes #75 and #76. 
Dissolving Solid Solute Model Dissolution of solid solute in liquid may be of interest in several applications – from solution mining to food processing to medical applications. This section describes a model for dissolving solid solute in fluids and tracking the solute in the brine. The dissolution of solid solute increases the density of the fluid and thus may affect the flow. In addition, as the solute is dissolved, the flow domain increases. The model accounts for the basic physical phenomena, such as mass transfer at the interface between solid and fluid, the change of volume and shape of the solid solute, diffusion and convection of the dissolved solute in fluid and, finally, the change in fluid density, viscosity and surface tension coefficient. The amount of dissolved solute in fluid is represented with its mass concentration C. The transport equation for C is 
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u  (0.175) where u is the fluid velocity and D is the diffusion coefficient of the dissolved solute in the fluid. The mass flux of solute, Q, at the fluid/solid boundary is defined as 
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Q C Cκ= −  (0.176) where κ is the constant mass transfer coefficient and CSAT is the solute saturation concentration. The fluid mixture density ρ is assumed to be a linear function of concentration: 
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where ρ0 is the density of pure liquid and α is a constant obtained experimentally. Accordingly, the fluid volume varies with the concentration, also linearly: 
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 (0.178) The mixture density coefficient a may take values in the range between  for substitutional solutes ( is the solid solute density), when the solvent molecules are completely displaced by the larger molecules of the solute, and 1.0 for interstitial solutes, when the smaller solute molecules fit perfectly in the spaces between the molecules of the solvent.  For example, the density of the saturated sea water (brine) at room temperature is about 26% greater than the density of fresh water, while its volume increases by 13%, resulting in α=0.5. Note that there is no change to the mixture volume upon dissolution when α=1.0. This assumption can also be used as a simplification of the model if:  

� the velocity of the interface controlled by the dissolution rate is small compared to the average fluid velocity; and  
� solute concentrations are small compared to fluid density. The flow equations are 
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 (0.179) with P being fluid pressure, μ viscosity and g gravity. The source term S accounts for the change in the position of the boundary between fluid and solid solute as well as for the increase in the fluid specific volume (see Eq. (0.184)). The Fractional Area/Volume Obstacle Representation method (FAVOR™) is used to represent the changing geometry of the solid solute. To account for the presence of solid solute in the flow domain, and its change in volume and shape as it is dissolved in the fluid, a variant of the General Moving Object (GMO) model has been developed. While the standard GMO model describes the motion of rigid objects moving through the flow domain, the solute model tracks the change of the solid solute boundary of the otherwise stationary dissolving component. Both models use time-dependent area and volume fractions to represent the changing geometry in the fixed rectangular grid. These variables are updated at every time step to reflect the changes in component’s boundary location. Fluid quantities such as pressure and velocity must be initialized in newly-opened cells. Volume sources and sinks are also computed at the moving boundaries to maintain continuity of the fluid and solid. In the augmented model, the geometry component representing the solid solute is designated as a component of a type dissolving: it is stationary but changes shape and volume. It is designated with the input variable IFOBDISS(NOB)=1, where NOB is the component number. The area and volume fractions are recomputed at every time step to reflect the gradual dissolution of the solid solute. The primary variable 



 

 

representing such geometry component is the relative (fractional) volume of solid solute in a cell, which is the ratio of the solid volume in the cell to the total cell volume: 
Vfsolute  Vsolute /  Vcell, 0  Vfsolute  1.0= ≤ ≤  (0.180) The open volume fraction in cell, or volume fraction, is then 
Vf  1.0 –  Vfsolute=  (0.181) The area fraction at a cell face, Af, is computed from the volume fractions in the two cells sharing the face (subscripts 1 and 2 in Eq. (0.182) below), according to the following ordered rules: 
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The change the solid solute content in a computational cell is 
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=  (0.183) where dA is the wetted area of solid surface in the cell and ρs is the density of solid solute. The sink term S in the continuity equation, Eq. (0.179), reflecting continuity of fluid and solid at the interface and the change in fluid volume as solute is dissolved, is: 
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 A schematic of the interface region in the numerical model. The shaded area to the right of the interface is occupied by a dissolving component representing the solid solute whose shape and volume vary with time. The dissolved solute is distributed in the fluid within the volume adjacent to the interface marked by the thin dashed line. The thick dashed line shows the volume of solid solute in cell. 



 

 

The amount of solute dissolved in a given time increment, dm QdAdt= , is distributed over a fluid volume adjacent to the interface equal to the volume of the mesh cell containing the interface (thin dashed-line rectangle in the figure above. If the interfacial cell is only partially filled with fluid, then part of the dissolved solute will be apportioned to a neighboring cell. Such averaging of the solute concentration makes the solution less dependent on the position of the interface within a cell and is consistent with the control volume approach, where each volume is associated with a single solute concentration value. The dissolution rate of the solid solute is assumed to be limited by diffusion, that is, the dissolved solute must diffuse away from the interface before more can be dissolved. The volume of solute dissolved in a time increment dt per unit surface area is Qdt. In the same period of time, the amount of solute that diffuses from the interface into the bulk is approximately . Comparing the two expressions imposes a limit on the effective solute mass transfer coefficient: 
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 (0.185) Once the dissolved solute has been apportioned to the control volumes, diffusion and convection take over and may further redistribute the solute within the mixture. 

Lost Foam Model In the lost foam casting process, foam occupies the mold cavity and offers a resistance to the flow of metal. Momentum plays only a small role in the lost foam process. Foam is represented with a special kind of obstacle that prevents the flow of metal unless it is heated sufficiently to lose its strength. In this sense the movement of metal into foam is controlled by heat transfer mechanisms and not by pressure or inertia of the metal. When metal enters a control volume containing foam, the heat transferred to the foam from the metal during one increment in time is computed. This amount is then used to compute the volume of foam that is decomposed and raised to the temperature of the metal. When computing the amount of foam decomposed, it is necessary to include the heats-of-transformation for melting and vaporization of the foam. Energy transferred to the foam is removed from the metal. Thermal conduction in the foam is ignored in the model. Metal advances through the action of a sink equal to the amount of foam volume removed in each control volume. The sink is specified in terms of velocity components at the metal surface, which keeps the metal moving into the foam as long as the pressure in the metal is sufficiently high. The average speed of the metal front, u, can be estimated as 
1HOBS

u
RCOBS

=  (0.186) where HOBS1 is the metal/foam heat transfer coefficient, and RCOBS is the foam density times specific-heat product. 



 

 

No attempt has been made to directly model the flow of gas produced from vaporized foam. The importance of gas is well known in terms of the effect that different coating permeabilities on the foam pattern may have on the performance of a casting. With insufficient permeability, gas buildup may actually blow metal back out of the mold. The effects of coating permeability are approximately included in the present model through a change in the metal/foam heat transfer coefficient. The reasoning behind this is that the rate of heat transfer should be proportional to the thickness of the gas region. A low permeability coating would result in gas buildup and reduce heat transfer. A gravity effect can be taken into account in the calculation of the metal/foam heat transfer coefficient using variable CGFOB. Since the foam decomposition products are usually lighter then the metal, they can be displaced by the metal advancing downwards and accumulate above the metal front that is moving upwards. Thus, one can expect a smaller interfacial gap when metal is above foam than in the reverse situation. This effect is described by making the metal/foam heat transfer coefficient a function of the gravity component, GHT, normal to the metal/foam front 
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where 
GVEL GHT ROUGH= ⋅  (0.188) ROUGH is user-defined roughness for each foam obstacle. The roughness parameter describes the characteristic length scale of the surface irregularities at the metal/foam interface (a value of 0.1 cm is not unreasonable). According to the expression, the heat transfer coefficient between metal and foam is larger where metal is above foam, therefore making it easier for the metal to advance downwards than upwards. The recommended value for CGFOB is 0.5. A special simplified filling model is available, IHONLY=4, that may be used to determine general filling patterns and locate possible sources of defects arising from the convergence of metal fronts (folds). This model, however, gives no information about temperature or velocity distributions, surface defects, or solidification. For better pressure iteration convergence it is recommended to use a small degree of limited compressibility by setting RCSQL to a value around 10-6 in CGS units or to a value on the order of 0.1/(estimated maximum fluid pressure). 
Porous Media Models Soils, fractured rock, sponges, and paper are all examples of porous media. Porous media refers to solid materials with connected interstitial voids through which fluid can flow. On a microscopic scale the velocities and pressures in the void spaces are highly irregular but from a macroscopic viewpoint, a volume averaged approach represents the flow quite well. 



 

 

The size of the voids relative to the overall dimensions of the material suggests the appropriateness of modeling a material as porous vs. simulating each individual void. For example, although a sheet of paper is quite thin, the size of the voids within the sheet is much smaller. If the average flow through the paper is of interest, treating the paper as a porous medium with certain volume-averaged macroscopic properties, such as porosity, would be appropriate. However, if the wicking behavior in a small region within the paper, due to anisotropic fiber distribution, is of interest, each fiber would need to be represented in the simulation. For the concept of averaging many pores over the volume of a computation cell to be valid, the size of the voids must be much smaller than the control volume. 

 Left: A porous model is appropriate when the size of the pores is much smaller than the size of the control volume, for example, sandstone, and packed powder. Right: A discrete model (each solid modeled) is appropriate when the size of the pores is on the same order as the control volume and flow details in the pores is of interest. For example, microflows in fiber mats. 
Governing Equations in Porous Media The porosity of a porous medium is defined as the open volume divided by the total volume. In FLOW-3D nomenclature, porosity is identical to volume fraction Vf. 
Porosity  

f
V≡  Materials such as metallic foam filters are almost completely open and may have porosities approaching 1.0. The porosity of close packed spheres varies from 25% to 47% depending on the packing configuration. By constructing a continuum model of the porous material and applying averaging to each control volume, the usual conservation equations are obtained. Conservation of mass is expressed by Eq. (0.189) 
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U  (0.189) where U is the macroscopic flow velocity. A momentum equation in porous media can be formed based on the observation of French engineer Henry Darcy in 1856 who noted that the unidirectional flow rate through porous media is proportional to the applied pressure difference. This relationship is expressed as 
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∂  (0.190) where the coefficient K is the specific or intrinsic permeability of the material. K is generally independent of the fluid and has dimensions of length2. Equation (0.190) is referred to as Darcy’s law. Values of K for 



 

 

common materials are 10-7 ~ 10-9 m2 for gravel and 10-13 ~ 10-16 for clay m2. The smaller the value of permeability, the greater is the resistance to flow. This resistance is commonly referred to in porous media modeling as drag. The resistance to flow in a porous medium is represented in the Navier-Stokes equations as a drag term proportional to the velocity 
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F=b U  (0.191) where Fd is the porous media drag coefficient. The permeability K can be expressed in terms of the drag coefficient Fd according to 
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=  Before discussing the various types of drag models available in FLOW-3D, it should be noted that there are two flow regimes possible within the porous medium—saturated and unsaturated. A saturated flow is one where the interface between the gas and the liquid is relatively sharp. An unsaturated flow is one where the interface between gas and liquid is diffuse and may exhibit fingering and trapped gas regions. 

 
Drag Calculations in Saturated Flows Since the permeability K is determined by geometry factors rather than fluid properties, it is possible to derive K from geometrical parameters such a particle size and fiber diameter. The Carmen-Kozeny equation (0.192) is derived from the hydraulic radius theory, and is stated as 

2 3

2
  

180(1 )

f

f

D V
K

V
=

−  (0.192) where D is the particle or fiber diameter and 180 is referred to as the Carmen-Kozeny constant. Equation (0.192) gives good results when the porous medium consists of nearly spherical shapes of similar size. Some researchers have found that the Carmen-Kozeny constant is dependent on porosity and fiber aspect ratio. 



 

 

Porosity Dependent Drag To account for the effects of porosity on K, the equation used in FLOW-3D is 
  * b

d f
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−
=  (0.193) where a and b are positive constants. A zero value of b can be used when a constant drag coefficient is desired. Separate values of a and b can be chosen for each individual component, making the use of b largely redundant, since the value of Vf is invariant within each component. Equation (0.193) holds true in saturated flows in porous media where the pore Reynolds number, computed from 
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=  is less than 1. This is usually true for low velocity flows or for porous media with small pore sizes. 

Saturation Dependent Drag Another choice for a linear drag models a fluid saturation dependent form: 
* b

d
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−
=  (0.194) where F is the local fluid fraction (or saturation), and a and b are positive constants. Since the value of F for saturated porous materials is equal to one, except at the interface between liquid and gas regions, b will only have an effect near the interface. 

Reynolds Number Dependent Drag If a porous medium is composed of coarse particles or fibers, the microscopic velocity may be significant and the flow losses it induces may be proportional to the square of the flow velocity rather as well as being a linear function of the velocity. This is typically the case when Red > 10. The linear (Darcian) and quadratic (non-Darcian) flow loss equations can be combined into a single expression for Fd 
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    (0.195) where a =α /D2 and b = β/D. The constant α typically has the value of 180 and β is a roughness factor in the range of 1.8 to 4.0 (smooth to rough). The parameter a should be specified for each porous component to prevent unphysical flow. The definition of b is optional; it defaults to zero. 
Capillary Pressure Within a saturated porous medium, the effects of surface tension on the fluid/gas interface may be significant if the fluid is strongly wetting or non-wetting relative to the porous material. This capillary pressure arises because of the high surface curvatures present in the tiny pores of the material. When the material is wetted by the fluid (i.e. the static contact angle is less than 90º), absorption and wicking of the fluid into a porous medium occurs. When the fluid and porous material are non-wetting, the opposite occurs and external pressure must be applied to force fluid into the material. The strength of the wetting or non-wetting dynamics of the porous medium are defined by the capillary pressure.  



 

 

The value of the capillary pressure is based on the average pore diameter, the surface tension of the imbibing fluid, and the static contact angle to the porous material and can be estimated using 
4 cos

CAP
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σ θ
=  (0.196) where σ is the surface tension coefficient of the fluid, θ  is the static contact angle of the fluid relative to the porous solid and D is the average pore diameter. The most accurate method of determining PCAP is experimentally through the use of laboratory apparatus. The capillary pressure represented by Eq. (0.196) is applied to the liquid/gas interface (cells where the fluid fraction is less than 1.0 and greater than 0.0). 

Unsaturated Flow in Porous Media The unsaturated porous media model is designed to simulate two phases (usually liquid and gas) which intermingle to varying degrees throughout the porous medium. Therefore, the fluid fraction (akin to saturation, the local volume fraction of the pore space occupied by liquid) varies throughout. In FLOW-3D, the Volume-of-Fluid technique (VOF) is used to track this fluid fraction, F.  The drag is a function of the saturation because there is more flow resistance within a porous material where there are two phases than a single phase. This is due to the many small bubbles which are difficult to dislodge because of the strong surface tension effects at small scales.  
Drag Calculations in Unsaturated Flows Two drag models for unsaturated flow have been incorporated into FLOW-3D. The simplest drag model for unsaturated flow, the "power-law" model, is represented by 

* b

d
F a S

−
=  (0.197) where S is the degree of saturation. The saturation S is computed from 
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−  (0.198) where F is the fluid fraction within the control volume, FCMN is the irreducible saturation and FCMX is the maximum saturation limit for the porous medium. These saturation limits refer to the volume fraction of liquid when no more liquid can be removed from the material and when no more can be added, respectively. FCMN and FCMX are computed relative to the open pore volume of the particular material. Another choice for a drag model in unsaturated porous media is 
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−  (0.199) where PEXP is a user-defined constant. In regions where there is no fluid, the F is limited to a minimum value of 10-6 if FCMN is not set. It may be necessary to either define an initial F value greater than FCMN or add some F diffusion to prevent the large 



 

 

drag resulting from Eq. (0.199) when F is close to FCMN. Otherwise, fluid may be prevented from entering regions where F approaches FCMN . 
Capillary Pressure in Unsaturated Flows The capillary pressure is also a function of the local saturation. In regions of the medium where the saturation is low, there are multiple interfaces with a high degree of curvature and a resulting very high capillary pressure. Conversely, in saturated regions, there are few free surfaces and the capillary pressure is near zero.  In FLOW-3D, there are two capillary pressure curves computed: one for when the material is draining (i.e., the saturation is going down) and the other for when the material is filling (i.e., the saturation is going up). The relationship between capillary pressure and saturation is shown in the diagram below for advancing flows (filling curve) and receding flows (draining curve). 

 The draining curve is defined as 
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=  (0.200) where Pbub is the maximum capillary pressure at saturation condition F = FCPMX and S is the saturation. The bubbling pressure, Pbub, is defined as 
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−   (0.201) The filling curve is defined as 
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= −  (0.202) NOTE: THE FILLING AND DRAINING CURVES ARE ALWAYS EQUIDISTANT AND SEPARATED BY THE VALUE OF BUBBLING PRESSURE. 



 

 

Transition between Draining and Filling Curves When a local region of the material switches between filling to draining (or vice versa), the capillary pressure follows a scanning curve between the curves. The slope of this scanning curve is computed from the local slope of the draining curve, plus 10 times the local difference between the target curve (either draining or filling) and the locally computed pressure until the scanning curve intersects the target curve. If a simulation is expected to involve only the filling or draining of a region, then it is only necessary to specify the appropriate capillary pressure-versus-saturation curve. However, when there are alternating filling and draining transients, then both curves must be considered and some means must be provided to numerically transition between these processes. Experimentally it is observed that the transition occurs along a “scanning” curve. This curve must have a slope that is larger than the slopes of the filling and draining curves, otherwise it would not be possible to pass between them. Because no experimental data has been found for guidance, we have arbitrarily set the slope of the scanning curve. We use a value equal to the slope of the draining curve at the current value of F plus an additional slope computed as the difference between the filling and draining curve pressures at saturation F divided by a change in saturation of 0.1.  When evaluating PCAP, which is done in the user-accessible subroutine pcapcl.F, a first guess for the new capillary pressure at time step n+1 is obtained from the previous time-step value by assuming a variation along a scanning curve 
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= + −  where (dPCAP/dF) is the slope of the scanning curve at the current saturation. The new value is then tested against the filling and draining curve values PCAP,FILL and PCAP,DRAIN such that  
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=  These tests ensure the capillary pressure is between the limits imposed by the two curves, or in the case of only one curve, keeps PCAP on that curve. This behavior can be customized by modifying the subroutine pcapcl.F. 
Solidification Drag Model A simplified model for solid-to-liquid phase change can be constructed using the porous media drag concept. By neglecting volume changes associated with a phase change and assuming that solid material is at rest with respect to the computational mesh, we can approximate solidification processes (i.e., the state of zero flow velocity) by using a drag coefficient that is a function of the local solid fraction. The drag should be effectively infinite when material is in the solid phase. At intermediate states consisting of a mush, the drag should assume an intermediate value. In FLOW-3D, the drag coefficient is 
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where Fs is the local solid fraction. When Fs =FSCR, the drag coefficient, K, becomes effectively infinite. FSCR is a user-defined constant denoting the critical solid fraction value at which all flow in the mushy zone seizes. TSDRG is a user-defined constant. Its value depends on the mushy zone microstructure the modeling of which is outside the scope of the solidification model in FLOW-3D. The actual choice for TSDRG is likely to depend on the specific application and, in general, will require some confirmation with experimental data. When the value of TSDRG is set to zero, then no drag force is applied to the fluid in the mushy region. The D’Arcy-type drag model for the liquid phase flow in the mushy zone given by Eq. (0.203) can be enhanced to include additional flow effects at low and high solid fractions. At low solid fraction values, Fs < FSCO, crystals of the solid phase are sparse and float freely in the liquid without forming a coherent solid structure (Solidification Characteristics of Aluminum Alloys, 1996). The solid/liquid mixture can then be approximated as a single fluid with the mixture viscosity dependent on the solid fraction according to 
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µµ  (0.204) where μ0 is the molecular viscosity of the liquid phase. The drag coefficient K in this range of solid fraction values is zero. As solidification continues and the solid fraction reaches the coherency point, FSCO, the solidified phase is assumed to form a rigid structure. In this case the fluid viscosity is maintained at the value given by Eq. (0.204) with Fs=FSCO and the drag term given by Eq. (0.203) is applied. This continues until the solid fraction exceeds the critical solid fraction, FSCR, at which point the flow stops. Both FSCO and FSCR are user-defined constants. It is assumed in the model that 
0.0 1.0FSCO FSCR≤ < ≤  (0.205) In addition, the solid phase can be moving at a uniform linear velocity (which may be time-dependent) as happens during a continuous casting process. Please refer to Moving Solid Phase in the Model Reference chapter for more details. Other models could be incorporated into FLOW-3D by altering the subroutines DRGCL, in which the drag coefficient is computed, and MUCAL, where the fluid viscosity is computed. The concept of the solidification drag and the effective viscosity described by Eqs. (0.206) and (0.207) is based on the important assumption that a mushy zone exists within the solidification range through which the liquid phase flows. This assumption is not true for materials with a zero freezing range, like pure metals. In this case it helps the accuracy of the model is a small artificial freezing range is introduced of the order of 0.1 to 1.0 degree. 
Rigid Body Dynamics for Non-Inertial Reference Frame Sometimes we are interested in the flow of fluids within rigid bodies whose motion is itself influenced by the dynamics of the fluid. In such cases, one may apply the coupled rigid body dynamics model, integrated into FLOW-3D, to predict the combined motion of the rigid body and the associated fluid. We shall consider the evaluation of the motion of a rigid body relative to inertial space. Furthermore, we shall suppose that the body contains internal cavities (tanks) which may be partially filled with fluid. We wish to simulate the motion of the rigid-body center of mass, its rotation (attitude) and the motion of the 



 

 

fluid in its tanks. The simulation is to predict these attributes as time progresses. Evaluation of the fluid motion and the resulting forces and torques are performed with the usual FLOW-3D algorithms, allowing inclusion of a wide variety of physical phenomena. 

 Inertial and body-fixed coordinates To perform this simulation, we define both inertial and body-fixed reference frames, as shown in the figure above. We label the Cartesian coordinates fixed in the rigid body as (x, y, z) and those fixed in inertial space as (x', y', z'). The fluid dynamics calculation utilizes the body-fixed coordinates as usual. Newton's equation for the location of the rigid-body center of mass is solved in the inertial reference frame, but the equations for the rotation of the body are formulated in body-fixed coordinates. We also define a gravitating-body reference frame, the origin of which coincides with that of the inertial coordinate system but which may rotate at a constant rate about the z' axis. We use a spherical coordinate system for this reference frame to reduce confusion. This reference frame is not used in the formulation of the equations of motion. It is intended as a convenience for the user, directly relating the computed results to an earth (or solar) based system. NOTE: AN EARTH-BASED REFERENCE FRAME IS ONLY APPROXIMATELY INERTIAL. CORRECTIONS TO THIS APPROXIMATION CAN BE IMPLEMENTED ELSEWHERE IN THE SOLUTION ALGORITHM IF NECESSARY. The effect of the gravitational force emanating from this body is included in the rigid-body motion equations and the fluid motion equations. Torques resulting from the gravitational field have been ignored. 



 

 

Provision has been made for the inclusion of both environmental and control forces and torques. This is accomplished by including subprograms that can easily communicate with the other portions of the solution algorithm. These subprograms do not model specific sources of force and torque but are available for the user to include such phenomena as aerodynamic and geomagnetic effects or control jets and/or flywheels. Sometimes more than one tank may influence the motion of the rigid body. FLOW-3D can account for this by treating each tank as an independent flow region (or component). The fluid forces and torques are then summed over all components to determine their effect on the rigid body. 
Sediment Scour Model The sediment scour model estimates the motion of sediment flow by predicting the erosion, advection and deposition of sediment. It does so by: 
� Computing the advection of the sediment suspended in the flow. 
� Computing the settling of sediment due to gravity. 
� Computing the entrainment of the sediment due to shearing and flow perturbations. 
� Computing the transport known as bed-load transport, whereby sediment particles roll or bounce along the bottom. In FLOW-3D this is done by considering two states in which sediment can exist: suspended and packed sediment. Suspended sediment is typically of low concentration and advects with fluid #1. Packed sediment does not move with any fluid and exists in the computational domain at the critical packing fraction, as defined by the user. Suspended sediment is transported by advection along with the fluid. Therefore, without considering the VOF and FAVOR™ functions, the transport equation for each sediment species i is 
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u  (0.208) where cs,i is the concentration of the suspended sediment, in units of mass per unit volume and u is the mean velocity of the fluid/sediment mixture. Because sediments typically have a density greater than the surrounding fluid, they will sink, or drift, relative to the surrounding fluid. The rate of this drift is related to the balance between the buoyancy force (the force that causes the drift) and the drag force (the force that resists the drift). Therefore, one can write momentum balances for each sediment species and the fluid-sediment mixture (again neglecting the VOF and FAVOR™ functions): 
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(0.209) 
Here u s,i is the velocity of sediment species i, ρs,i is the density of the sediment material, fs,i is the volume fraction of sediment species i, P is the pressure, K is the drag function, F includes body and viscous forces, ur,i is the relative velocity, 
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= −u u u is the drift velocity, i.e., the velocity needed to compute the transport of sediment due to drift. Assuming that the motion of the sediment is nearly steady at the scale of the computational time and that the advection term is small (i.e., for small drift velocity udrift), the result of Eq. (0.212) is 
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∑ ∑  (0.214) Note that in many simulations the pressure gradient can become very noisy, particularly close to the free surface. For most problems the ratio of pressure gradient to mixture density is typically equal to the acceleration of gravity, g. With this assumption we get 
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u  (0.215) A reasonable choice for the drag function Ki combines form drag and Stokes drag: 
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r,iu  (0.216) where ds,i and CD,i are the diameter and the drag coefficient for sediment species i, respectively, and μf is the fluid viscosity (usually water). Finally, the drift velocity is computed from the relative velocity using the definition of the drift and relative velocities: 
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= − − ∑u u u  (0.217) Equations (0.215), (0.216) and (0.217) are solved via the quadratic formula to find udrift,i. Sediment is entrained by the picking up and re-suspension of packed sediment due to shearing and small eddies at the packed sediment interface. Because it is not possible to compute the flow dynamics about each individual grain of sediment and it is oftentimes difficult to compute the boundary layer at the interface, an empirical model must be used. The model used here is based on Mastbergen and Von den Berg (Mastbergen, D.R. and J.H. Von den Berg, 2003). Also, the Shields-Rouse equation (Guo, J., 2002) can be used to predict the critical Shields number, or a user-defined parameter can be specified. The first step to computing the critical Shields number is calculating the dimensionless parameter Ri*: 
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g  (0.218) and from this, the dimensionless critical Shields parameter is computed using the Shields-Rouse equation (Guo, J., 2002): 
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    (0.219) Also included in the model are the effects of armoring, whereby larger sediment particles protect finer particles from becoming entrained. The first step is the calculation of the local mean particle size in the computational cell: 
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∑  (0.220) where cs,i is the mass concentration of sediment species i. The critical Shields parameter is then modified by the effects of armoring (Kleinhaus, M.G., 2002): 

, , 2

,

10

50

1.666667

log 19

cr i cr i

s i
d

d

θ θ′ =

 
 
   (0.221) Note that, according to Eq. (0.221), if ds,i is far smaller than d50, the denominator will be a small number and thus enhance the value of 
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θ ′ , because the finer particles are surrounded by larger particles. Conversely, for values of ds,i much larger than d50, Eq. (0.221) will serve to reduce it, because the coarser particles are more exposed when surrounded by finer particles. The critical Shields parameter is further modified for sloping surfaces to include the angle of repose. The idea here is that at sloping interfaces, the packed sediment is less stable and is thus more easily entrained by the moving fluid. The modification further alters
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θ ′  (Soulsby, R., 1997): 



 

 

2 2 2 2

, ,

cos sin cos tan sin sin

tan

i

cr i cr i

i

ψ β β ϕ ψ β
θ θ

ϕ

+ −
′′ ′=  (0.222) where β is the computed angle of the packed interface normal relative to the gravitational vector g, φi is the user-defined angle of repose for sediment species i, and ψ is the angle between the flow and the upslope direction. Therefore, for flow directly up a slope ψ = 0°. The local Shields number is computed based on the local shear stress, τ: 

, ,( )
i

s i s i f
d

τ
θ

ρ ρ
=

−g  (0.223) Here g  is the magnitude of the gravitational vector. The entrainment lift velocity (volumetric flux) of sediment is then computed as (Mastbergen, D.R. and J.H. Von den Berg, 2003): 
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    (0.225) αi is the entrainment parameter, whose recommended value is 0.018 (Mastbergen, D.R. and J.H. Von den Berg, 2003), and ns is the outward pointing normal to the packed bed interface. ulift,i is then used to compute the amount of packed sediment that is converted into suspended sediment, effectively acting as a mass source of suspended sediment at the packed bed interface. Once converted to suspended sediment, the sediment subsequently advects and drifts. Bed-load transport is the mode of sediment transport due to rolling or bouncing over the surface of the packed bed of sediment. For bed-load transport, the model currently used is from Meyer, Peter and Muller (Soulsby, R., 1997). This model predicts the volumetric flow of sediment per unit width over the surface of the packed bed. The model is 
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θ ′ is from Eqs. (0.222), and Фi is the dimensionless bed-load transport rate, and is related to the volumetric bed-load transport rate per unit width, qi, by 
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g  (0.227) where g  is the magnitude of the gravitational vector. The value of βi in Eq. (0.226) is typically equal to 8.0 (Van Rijn, L. C., 1984). Equation (0.227) computes the bed-load flux in units of volume per bed width per time. Another piece of information needed an estimate of the bed-load thickness, i.e., the thickness of the saltating sediment. The relationship chosen to estimate this thickness is(Van Rijn, L. C., 1984) 
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 (0.230) The direction of the motion is determined from the motion of the liquid adjacent to the packed bed interface. Therefore, the volumetric flux is 
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u  (0.231) Here  u u represents the direction of the fluid-sediment mixture adjacent to the packed interface, and the resulting bed-load velocity, ubedload,i, is used to transport the packed sediment. The resulting mass flux of sediment as computed across computational cell boundaries in FLOW-3D is 
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fδ ρ=Q u  (0.232) and hence the δi and fb from Eq. (0.229) are cancelled out. Note that alterations to the empirical equations for drifting, entrainment and bed-load transport can be made by modifying the user-customizable routines scour_drift.F, scour_lift.F, and scrersn.F. 

Shallow Water Model This section describes how the Volume-of-Fluid (VOF) method for tracking fluid interfaces and the FAVOR™ method for the description of geometry can be combined in a shallow water model (C.W. Hirt and J.E. 



 

 

Richardson, 1999). The volume fraction variable, VF, can be used to define a variable bottom contour and F the depth of fluid. A shallow flow is one in which the horizontal extent of the flow is much larger than the vertical extent. Examples include the ocean, large estuaries, seasonal floods, liquid coatings, lubricating films, and water on automobile windshields. If a flow is shallow enough that vertical accelerations can be neglected, then it can be shown (J. Pedlosky, 1987) that a good approximation to the flow is to replace all flow variables by their averages in the vertical direction. The resulting depth-averaged, three-dimensional equations of motion then become a two-dimensional representation in the horizontal plane. The most interesting cases involve a top fluid surface that is free to exhibit wave phenomena. In some instances non-uniform horizontal boundaries (e.g., a sloping beach) may also induce small deviations from purely horizontal flow. In this sense the depth-averaged approximation still includes some three-dimensional effects. There are excellent discussions of the shallow-water equations and higher order refinements of those equations in references (J.A. Knauss, 1978), (C.H. Su and C.S. Gardner, 1969). When the depth averaging treatment is applied to the three-dimensional vertical momentum equation, it reduces to a hydrostatic relation for the pressure 
p ghρ=  (0.233) in terms of the fluid density ρ, vertical acceleration of gravity g and the fluid height h (J. Pedlosky, 1987). The general three-dimensional formulation used in FLOW-3D is limited to two dimensions for the shallow water approximation to be valid. This is done by restricting fluid to reside in only one vertical layer of control volumes (i.e., the first layer of real cells in the z-direction). Let the height of this layer be δz. The two-dimensional momentum equations used in FLOW-3D are identical to the shallow water equations if the fluid pressure is defined correctly. In FLOW-3D the pressure in an element containing a free-surface is defined as 

0p p gHρ= +  (0.234) where p0 is the external pressure on the surface of the liquid, including the surface tension forces, and H is the height of the surface above the bottom of the grid. H is, therefore, the sum of the fluid and obstacle heights 
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H V z F V zδ δ= − ⋅ + ⋅ ⋅  (0.235) The volume/area blockages used in the FAVOR™ method can be interpreted as the height of the bottom contour. When making this correspondence, it is only necessary to make sure all the approximations used in FLOW-3D consider the solid blockage to lie at the bottom of the control volumes. Substituting the fluid height expressions into the shallow water continuity equation, and using the appropriate area fractions for the x and y directions, we arrive at 
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This is precisely the equation for F used in the VOF method for flow in a single, horizontal layer of control volumes provided there is no transport of F in the z-direction, a restriction that is necessary in the shallow-flow model (see Eq.(0.17)). It shows that there is an equivalence between the VOF and FAVOR™ representations as used for a single layer of control volumes and the usual shallow water formulation. Additions of Coriolis forces and viscous stresses are straightforward and need no further comment. Equation (0.236) can be solved explicitly, in which case, there is a limitation on the size of the time step to prevent gravity waves from moving more than one grid cell in one time step. An implicit solution (IMP=1) is also available that removes the limitation on time-step size. The implicit option is used by default. Fluid can move into dry regions or withdraw from previously wet regions. Nonlinear waves and weak hydraulic jumps are automatically included in the model. The addition of surface tension forces with wall adhesion to the depth averaged equations is described in (C.W. Hirt and J.E. Richardson, 1999). The shallow water model assumes that the shallow direction is the z-direction. There must be at least two real cells defined in each mesh block in the z-direction (there is no reason to have more than two cells). Fluid is only allowed to exist in the lower layer of cells. Therefore, the cell size in the z-direction should be sufficient to contain all fluid in that layer throughout the simulation, i.e., it must be larger than any fluid depth occurring in the model. Any fluid crossing into the second layer of cells will be removed resulting in a loss of mass conservation. To be on a safe side, the cell size in the z-direction can be made significantly larger than fluid depth, but it should not be excessively great or there could be a loss of accuracy. Cells in the upper layer of z-cells should be left empty of fluid and geometry. This will enable the model to properly treat the free surface in the lower layer. The shallow water model is not compatible with any of the turbulent models, but viscous forces are usually important in large-scale shallow-water flows. These can be included by using either a laminar or turbulent formulation of the wall shear stress. A roughness of the bottom of the reservoir can also be defined. Activation of the shallow water model in FLOW-3D is accomplished by setting the parameter ISWAT=1. Definition of the bottom contour is made by using obstacles to fill the space below the contour.  Initial fluid configurations, Coriolis forces, and bottom roughness (i.e., obstacle roughness) are defined in the same way as for three-dimensional simulations. A wind shear on the free-surface can be imposed in terms of the top wall tangential velocity components (UBC(6) and VBC(6)) or their time-dependent counterparts (UBCT(n,6) and VBCT(n,6)). A non-zero value for the wind shear coefficient, WNDSHR, is needed to activate this model and set the strength of the applied shear stress. 
Solidification Shrinkage and Porosity Models FLOW-3D can be used to model casting processes such as high pressure injection, gravity and tilt pours, and centrifugal and squeeze castings. One such application is modeling volumetric shrinkage during solidification, which is a common cause of porosity defects leading to poor mechanical properties of the final product. FLOW-3D provides an efficient way to help design a cost-effective process that minimizes the occurrence of these defects. Porosity in solidifying metal occurs as a result of gas evolution as well as volumetric changes (i.e., shrinkage) during phase transformation. There are two models in FLOW-3D that can be employed to predict macro-



 

 

porosity formation in metals due to shrinkage. The first model involves the solution of the full system of hydrodynamic equations. As a result, the evolution of velocity and pressure in the solidifying metal can be predicted. Therefore, this model is called the Hydrodynamic, or First Principles (FP), shrinkage model. The continuity and energy equations, Eqs. (0.5) and (0.19), are modified to include volumetric source terms. These are defined by the solidification rate and solid/liquid density difference. The basis of the model is that material contracts when it solidifies, and this induces some tension in the material in the form of a lowered pressure that attempts to pull surrounding liquid in to replace the volume lost to shrinkage. If the surrounding liquid is confined and cannot flow, the pressure will continue to decrease with further shrinkage until the critical pressure is reached. At that point a shrinkage cavity is allowed to open. The critical pressure can be related to the typical pressure at which dissolved gases come out of solution. Despite being an accurate tool to study the porosity formation phenomena, the FP model may be computationally costly because at each time step the numerical algorithm involves the complete solution of momentum and energy equations. The size of the time step, controlled by various stability criteria associated with fluid flow, may also be small compared to the total solidification time of the casting. The latter may be as long as hours for large sand castings. The other, simplified shrinkage model is based on the solution of the metal and mold energy equations only. No fluid flow equations are solved in this case. Porosity is predicted by evaluating the volume of the solidification shrinkage in each isolated liquid region in the casting at each time step. This volume is then subtracted from the top of the liquid region in accordance with the amount of liquid metal available in the cells from which the fluid is removed. The “top” of a liquid region is defined by the direction of gravity. The relevance of this approach is supported by the fact that in many situations fluid flow in the solidifying metal can be ignored. Porosity formation in that case is primarily governed by metal cooling and gravity. Feeding due to gravity often occurs on a time scale much smaller than the total solidification time. This model is called Simplified Solidification Shrinkage (SSS) model. The SSS model in FLOW-3D provides a simple tool to perform quick simulations of shrinkage in complicated castings. Neither model includes the evolution of gases, therefore, the porosity volume is defined by the cooling rate and solid/liquid density difference.  The most important aspect of shrinkage modeling in FLOW-3D is that shrinkage cavities are explicitly described, therefore, its influence on fluid and heat flow is also taken into consideration. No volumetric expansion, e.g., due to remelting, is also included in these models. Both shrinkage models account for volume changes occurring during solidification as well as during the cooling of the liquid phase before it begins to solidify. The Simplified Solidification Shrinkage model is also coupled to the Cast Iron Solidification model which describes the evolution of gamma-iron (austenite), graphite and carbide phases during the eutectic solidification(Carter, A. Starobin and M. C., 2011). The evolution of these phases affects the density and, therefore, the volumetric changes of the solidifying alloy. The metal may shrink or expand during solidification of a casting, depending on the initial carbon and silicon compositions of the alloy as well as the cooling rate. Liquid shrinkage upon cooling is also included in the model. 



 

 

The full flow shrinkage model does not account for the density changes due to the formation of graphite and carbon during cast iron solidification. Instead, the volume changes in that model are defined the by thermal expansion/contraction of the liquid phase and the densities of the liquid and solid phases. In addition to the shrinkage models designed to predict macro-cavity formation, FLOW-3D computes a variety of solidification functions that can be used to evaluate the occurrence of microporosity and some microstructural features (T. Overfelt, 1992). These are: 
� Solidus velocity, Vs, which is the velocity of the solidus isotherm at the time of solidification.  
� Thermal gradient, G, at the time of solidification.  
� Cooling rate, R, at the time of solidification. Local and absolute solidification times, tl and ta.  
� The local solidification time is the time it took to cool the metal from liquidus to solidus.  
� Feeding efficiency index, G/tl. This function can be visualized by plotting the ‘SLDCF2’ variable. 
� Niyama criterion function, G
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. This function can be visualized by plotting the ‘SLDCF1’ variable. 

� Lee, Chang and Chieu (LCC) criterion, 2
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. This function can be visualized by plotting the ‘SLDCF3’ variable. 
Turbulence Models Turbulence is the chaotic, unstable motion of fluids that occurs when there are insufficient stabilizing viscous forces. At high Reynolds numbers, the natural instabilities that occur within the flow are not dampened and they manifest in the formation of eddies of various sizes. This behavior is easily observed in flow out of a faucet or in a fast-moving stream by the striations visible on the free surface. Less visible are the turbulent eddies swirling around the car during your daily commute. Turbulence can be important in industrial processes as well: high pressure die casting filling is most certainly turbulent, as are almost all medium to large scale flow processes. In short, turbulence is all around us, and cannot be ignored in numerical flow modeling. Ideally, we would be able to simulate, with the equations of mass and momentum conservation, the full spectrum of turbulent fluctuations. This is possible only if the mesh resolution is sufficient to capture such details. However, this is generally not possible because of the computer memory and processing time limitations. Therefore, we must resort to simplified modeling that describes the effects of turbulence on the mean flow characteristics. In FLOW-3D, there are five turbulence models available: the Prandtl mixing length model, the one-equation, the two-equation k-ε and RNG models, and a large eddy simulation, LES, model. Our formulation, however, differs slightly from other formulations in that we have included the influence of the fractional areas/volumes of the FAVOR™ method and have generalized the turbulence production (or decay) associated with buoyancy forces. The latter generalization, for example, includes buoyancy effects associated with non-inertial accelerations. 
Turbulence Transport Models The one-equation turbulence transport model consists of a transport equation for the specific kinetic energy associated with turbulent velocity fluctuations in the flow (the turbulent kinetic energy) 
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k u v w= + +  (0.237) where u’, v’, w’ are the x-, y-, z-components of the fluid velocity associated with chaotic turbulent fluctuations. The transport equation for kT includes the convection and diffusion of the turbulent kinetic energy, the production of turbulent kinetic energy due to shearing and buoyancy effects, diffusion, and dissipation due to viscous losses within the turbulent eddies. Buoyancy production only occurs if there is a non-uniform density in the flow, and includes the effects of gravity and non-inertial accelerations. The transport equation is: 
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∂ ∂ ∂ ∂   (0.238) where VF, Ax, Ay, and Az are FLOW-3D’s FAVOR™ functions, PT is the turbulent kinetic energy production: 
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where CSPRO is a turbulence parameter, whose default value is 1.0, and R and ξ are described earlier in the Mass Continuity Equation section and are related to the cylindrical coordinate system (if used). The buoyancy production term is 
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∂ ∂ ∂ ∂ ∂ ∂    (0.240) where μ is the molecular dynamic viscosity, ρ is the fluid density, P is the pressure, and CRHO is another turbulence parameter, whose default value is 0.0, but for thermally buoyant flow problems should be chosen to be approximately 2.5. The diffusion term is 
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∂ ∂ ∂ ∂ ∂ ∂       (0.241) where υk is the diffusion coefficient of kT and is computed based on the local value of the turbulent viscosity. The user-defined parameter RMTKE is the multiplier of viscosity used to compute the turbulent diffusion coefficient (its value defaults to 1.0). 



 

 

The rate of turbulent energy dissipation, εT, in the one-equation model is related to the turbulent kinetic energy kT : 
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ε =  (0.242) where CNU is a parameter (0.09 by default), kT is the turbulent kinetic energy and TLEN is the turbulent length scale. By default FLOW-3D chooses a value for TLEN that is 7% of the smallest domain dimension; however, it is recommended that this value should instead be 7% of the hydraulic diameter (M. H. Shojaee Fard and F. A. Boyaghchi, 2007), which is a characteristic length scale of the flow. In pipe flow, the hydraulic diameter is equal to the inner pipe diameter. In stream flows, it is the depth of the stream. A more sophisticated – and more widely used – model consists of two transport equations for the turbulent kinetic energy kT and its dissipation εT, the so-called k-ε model (F.H. Harlow and P.I. Nakayama, 1967), thus eliminating the need for Eq. (0.242)(except at inflow boundaries and in flow regions with near-zero dissipation εT). The k-ε model has been shown to provide reasonable approximations to many types of flows (W. Rodi, June 1980). An additional transport equation is solved for the turbulent dissipation, εT: 
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∂ ∂ ∂ ∂  (0.243) Here CDIS1, CDIS2, and CDIS3 are all dimensionless user-adjustable parameters, and have defaults of 1.44, 1.92 and 0.2, respectively for the k-ε model. In most of the flow domain, Eq. (0.243) replaces (0.242) and thus reduces the need for a user-specified value of TLEN throughout the domain.  The diffusion of dissipation, Diffε, is: 
1

x TT T T

x y z

F

A
Diff A R A R A

V x x y y z z x

ε

ε ε ε ε

υ εε ε ε
υ υ υ ξ

  ∂ ∂ ∂∂ ∂ ∂   
= + + +     

∂ ∂ ∂ ∂ ∂ ∂       (0.244) Another turbulence model is based on Renormalization-Group (RNG) methods(V. Yakhot and S.A. Orszag, 1986)(V. Yakhot and S.A. Orszag, 1986)(V. Yakhot and L.M. Smith, 1992). This approach applies statistical methods to the derivation of the averaged equations for turbulence quantities, such as turbulent kinetic energy and its dissipation rate. The RNG model uses equations similar to the equations for the k-ε model. However, equation constants that are found empirically in the standard k-ε model are derived explicitly in the RNG model. Generally, the RNG model has wider applicability than the standard k-ε model. In particular, the RNG model is known to describe low intensity turbulence flows and flows having strong shear regions more accurately. Also, the default values of RMTKE, CDIS1 and CNU are different than are used in the k-ε model; they are 1.39, 1.42 and 0.085, respectively. CDIS2 is computed from the turbulent kinetic energy (kT) and turbulent production (PT) terms. In all turbulence transport models, the kinematic turbulent viscosity is computed from 
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=  (0.245) where νT is the turbulent kinematic viscosity. One particular numerical challenge of both the two-equation k-ε and RNG models is the need to limit the value of εT  from below. Equation (0.243) could produce values of εT very near zero, and although physically kT should approach zero in such instances as well, it may fail to do so for numerical reasons, resulting in unphysically large values of νT in Eq.(0.243). To deal with this problem, we limit the value of εT such that it cannot fall below 
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ε =  (0.246) where TLEN is the maximum turbulent length scale. This can be defined by the user or the turbulent length scale can be limited automatically. Further discussion on this is presented in the following section. The principal goal of any turbulence model is to provide a mechanism for estimating the influence of turbulent fluctuations on the mean flow quantities. This influence is usually expressed by additional diffusion terms in the equations for mean mass, momentum, and energy transport, Eqs. (0.1), (0.8) and (0.19). Because turbulence enhances the diffusion of momentum, it effectively enhances the viscosity. Wherever the coefficient of dynamic viscosity appears in the equations, we assume that it is a sum of the molecular and turbulent viscosities, 
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µ ρ ν ν= +  (0.247) Strictly speaking, this is not always correct, but it is a good approximation for high levels of turbulence, i.e., when the turbulent viscosity is much larger than the molecular value. At low levels of turbulence the k-ε model is not correct without additional modifications. 
Turbulent Scales Turbulent time and length scales can be formed from turbulent kinetic energy and dissipation 
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k ε is replaced by the turbulent time scale. In FLOW-3D, TLEN is a user-defined parameter that represents an estimate of the actual turbulent length scale for the one-equation model, and a maximum value of the length scale for the two-equation models. Additionally, this maximum turbulent length scale can be computed automatically as a function of space and time during the simulation. 



 

 

When the dynamic computation is selected, the model computes the bounded turbulent time and length scales. The bounded turbulent time scale is  
max ,min ,

low up T

T T T

T

k
T T T

ε

  
=   

  

ɶ  (0.248) 
3/2

max ,min ,
low up T

T T T

T

k
L L L

ε

  
=   

  

ɶ  (0.249) These limiters originate from the Kolmogorov scales [*] on the lower bound and the rapid distortion theory on the upper bound (M. Kato and B.E. Launder, 1993), (P.A. Durbin, 1996). 
Prandtl Mixing Length Model The simplest model, the Prandtl mixing length model, assumes that the fluid viscosity is enhanced by turbulent mixing processes in regions of high shear, e.g., near solid boundaries. However, this is really only adequate for fully developed, nearly steady flows. More generally, it is necessary to account for some transport processes (i.e., convection and diffusion) to better emulate the space and time distributions of turbulence intensity. The Prandtl mixing length model assumes that turbulence production and dissipation are in balance everywhere in the flow: 
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P G ε+ =  (0.250) where, as above, PT  and GT are the turbulence productions due to shearing and buoyancy effects, respectively, and εT is the turbulence dissipation. PT  and GT are defined as above. In other words, advection, diffusion, and the time rate of change of turbulent energy are neglected. The turbulence dissipation can also be written as 
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ε =  (0.251) where CNU is a parameter (0.09 by default). Combining Eqs.(0.250) and (0.251), kT is computed in terms of TLEN and the local shear rates and pressure/density gradients. Then kT and TLEN can be used to compute the turbulent kinematic viscosity νT from 
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TLENν =  (0.252) It has been shown that this procedure produces a result which is a generalization of the original Prandtl mixing length model (W. Rodi, June 1980). Because of its restrictive assumptions, this model is less useful than the one- and two-equation turbulence transport models. 

Large Eddy Simulation Model The Large Eddy Simulation (LES) model of turbulence arose from atmospheric modeling efforts. The basic idea is that one should directly compute all turbulent flow structures that can be resolved by the computational grid and only approximate those features that are too small to be resolved (Smagorinsky, 1963). When using the LES model, it is important to remember that the model is inherently three 



 

 

dimensional and time-dependent. Furthermore, fluctuations must be initialized and/or input at inflow boundaries. Although this requires more effort, and computations can be CPU-intensive due to the finer meshes than otherwise would be required, LES results often provide more information than that produced by models based on Reynolds averaging (i.e., the aforementioned models). For example, when LES models are used to compute turbulent flow around large buildings, one gets not only mean wind stresses but also an estimate of the magnitude and standard deviation of force fluctuations associated with the turbulent flow. In the LES model, the effects of turbulence too small to compute are represented by an eddy viscosity, which is proportional to a length scale times a measure of velocity fluctuations on that scale. For the length scale, (Smagorinsky, 1963) uses a geometric mean of the grid cell dimensions, 
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3( )L x y zδ δ δ=  (0.253) and scales velocity fluctuations by the magnitude of L times the mean shear stress. These quantities are combined into the LES kinematic eddy viscosity,  
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v cL e e= ⋅  (0.254) where c is a constant having a typical value in the range of 0.1 to 0.2 and eij denotes the strain rate tensor components. This kinematic eddy viscosity is incorporated into the dynamic viscosity used throughout FLOW-3D in exactly the same way as it is for the turbulence transport models (Eq. (0.247)): 
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Turbulence Boundary Conditions Equations (0.237) and (0.243) constitute the two-equation turbulence models used in FLOW-3D. Boundary conditions for these equations are partly built into the equations through the fractional areas. For instance, all advective and diffusive fluxes are automatically zero at rigid walls where the fractional open areas vanish. At free surfaces, tangential stresses are zero because of vanishing velocity derivatives across the surface. At inflow boundaries, the user can specify turbulent kinetic energy and dissipation directly. If a value is provided for the turbulent kinetic energy, but not dissipation, then a value for the dissipation will be automatically computed based on the value of TLEN. Tangential stresses evaluated at wall boundaries are also zero because of zero flow areas. However, there should be contributions to the kT and εT transport equations arising from tangential wall shear stresses. These stresses occur in laminar sub-layers and are proportional to the molecular viscosity and local velocity gradients. Thus, we could incorporate wall shear stress contributions in the production term PT. Unfortunately, this approach does not always seem to work well. It does not properly limit the values of kT and εT near boundaries. Therefore, we have followed the more standard procedure (e.g., Reference (W. Rodi, June 1980)) in which kT and εT are specified at mesh locations adjacent to wall boundaries. 



 

 

Because the FAVOR™ method accounts for wall boundaries that can pass through a mesh cell at any angle, the calculation of suitable boundary values for kT and εT has been generalized beyond a simple cell edge evaluation. In FLOW-3D values are assigned to kT and εT in every mesh cell that has one or more of its faces partially blocked or wholly blocked by a rigid wall. To determine boundary values for kT and εT, the usual procedure assumes a local equilibrium between turbulent shear production and decay processes and a law-of-the-wall velocity profile (W. Rodi, June 1980). Combined with the definition of the turbulent viscosity, Eq. (0.249), this leads to the values 
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ln  (0.257) and u is the parallel component of the velocity computed adjacent to the wall. The normal distance of the computed velocity from the wall is denoted by d and κ is the von Karman constant.  Since the FAVOR™ method does not precisely locate wall locations within a cell, approximations must be introduced to find u, u* and d. For this purpose, we first determine the direction of the wall normal in the cell, then u can be computed as the component of the cell-centered velocity that is parallel to the wall. The average distance to the wall, d, is estimated to be half of the cell width in the wall normal direction. That is, the triplet (δx, δy, δz) is treated as a vector whose inner product with the wall normal is defined as the cell width in the normal direction. Finally, u* is iteratively computed from Eq. (0.256) in terms of u and d. If there is a mass source at the wall surface, then we add to u* a term equal to u times the effective normal injection speed of the mass. This roughly accounts for the additional shear stress induced by mass injection. Once these quantities have been computed, Eq. (0.255) is then used to specify the cell-centered values of kT and εT, which represent the desired boundary conditions. 

Wall Heat Transfer For calculations performed with the energy transport equation option, FLOW-3D allows the transfer of heat between fluid and structural material called a heat structure. Fluid calculations may be fully compressible, nearly incompressible, or incompressible flows. Heat structures may be either internal obstacles or walls at the computational mesh boundaries. Heat transfer across two-dimensional baffles is also permitted. The heat transfer model has numerous options intended to provide flexibility for the user. Flows may or may not be dominated by buoyant forces generated by the heat transfer. FLOW-3D calculates heat transfer from boundaries having a known temperature, a specified heat flux, or a specified internal power source. Multiple structures can be included, each with an independent temperature/heat-flux/power-source model. For two-fluid problems, the mixture internal energy equations, Eqs. (0.19) and (0.20), are used so that a source (or sink) term is added to the mixture energy. This term is evaluated from the heat transfer between 



 

 

fluid and walls as described below. The source is divided between the two fluids in such a way as to assure equal fluid temperatures. 
Energy Source Terms Evaluation of the energy source term must consider multiple structures. In any computational mesh cell there may be more than one structure, in which case the source must be the sum of the individual contributions. Each contribution is determined by options specified for that structure. The source term may be directly specified by the user as a time-dependent energy per unit time (power) or calculated from the heat-structure and fluid temperatures. Specified net heat-flow rates for a structure are converted to local heat-flow rates by assuming a uniform heat flux over the surface of the heat structure. Optionally, the heat flux may be uniform on the wetted area of the heat structure. This results in an energy source rate for a computational mesh cell of the form 
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=  (0.258) where WA, QT , and AT refer to the heat structure under consideration and represent the surface area within the cell, the total structure heat flow rate, and the total structure surface area, respectively. QT can be specified by the user as a time-dependent quantity. If the wall temperature of a heat structure is known (either as a specified or calculated value), FLOW-3D evaluates the local energy source rate as 
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q hW T T= −  (0.259) where the heat transfer coefficient to the fluid, h, may be specified by the user or evaluated from correlation functions based on local conditions, as described below. In Eq. (0.259), T is the fluid surface temperature, WA is the heat structure surface area, and Tw is the heat-structure (i.e., obstacle or wall) surface temperature. The heat-structure surface temperature, Tw, may be a specified time-dependent quantity dynamically calculated from the conduction equation (as described in Diffusion Processes) or evaluated from the lumped parameter expression 
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= − ∑  (0.260) where the sum is carried out over all cells connected to the structure, POW is a specified time-dependent power for the structure, and MwCw is the total heat capacity (mass times specific heat) of the structure. The energy source terms q are calculated from Eq. (0.259). 

Surface Area Evaluation The heat surface area in each fluid mesh cell is automatically evaluated by FLOW-3D from the geometry of the heat structure. However, a surface roughness provided by the user can be used as a multiplicative factor on the geometric area to increase or decrease the effective heat transfer rate. Specifying a zero roughness, for example, eliminates the heat-structure calculation entirely, which is useful for an adiabatic boundary. 



 

 

ROBS is used to define obstacle surface roughness and RWALL for wall mesh boundaries. A separate roughness variable ROUGH can be used to define frictional roughness (see Prandtl Mixing Length Model). The correct geometric surface area in a mesh cell is easily calculated at a mesh boundary, since this boundary necessarily falls on a mesh coordinate plane. Obstacle boundaries, on the other hand, may cut through mesh cells. In this case the surface area is estimated by assuming that the surface is locally flat. This is also consistent with the calculation of area and volume fractions within FLOW-3D. The result is then multiplied by the roughness to obtain the actual area used in subsequent calculations. The total surface area of a heat structure is evaluated by summing all the mesh cell surface areas. Because of finite resolution, the calculated value may not equal the exact geometric surface area of the obstacle. FLOW-3D permits the user to renormalize calculated areas by specifying known total areas through input. This assures the correct total surface area in cases where the total area is expected to be an important consideration for accurate results. 
Fluid/Obstacle Heat Transfer Coefficient Care must be taken to resolve areas where the flow variables have steep gradients. Discontinuity surfaces and internal boundaries represent such areas. The VOF method, for example, allows one to resolve a free-surface boundary inside a computational mesh cell and set boundary conditions in the cell according to the amount of fluid in it and the surface orientation (C.W. Hirt and B.D. Nichols, 1981). Another example is the use of the FAVOR™ method to describe the obstacle surfaces inside mesh cells (C.W. Hirt and J.M. Sicilian, September 1985). The FAVOR™ method is also utilized in FLOW-3D to compute the fluid/obstacle interfacial heat fluxes. Cell-centered temperatures represent control volume averaged fluid and obstacle heat contents and may be substantially different from the interfacial temperatures used in Eq. (0.259). Therefore, using cell-centered temperatures to compute the interfacial flux would not be right. In FLOW-3D, a linear interpolation of the temperature between a cell node and the location of the metal/mold interface is employed to obtain metal and mold temperatures at the interface (H. Goldstein, 1950). These temperatures are then used to compute the heat flux at the interface, Eq. (0.259). The approximate location and orientation of the interface can be evaluated from fractional area and volume fractions. The interfacial temperatures are obtained by assuming a linear profile of the temperature between the interface and the nearest cell node in the normal direction to the interface. This procedure yields an effective heat transfer coefficient heff between two temperature nodes on either side of the interface, 
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(0.261) 
Where 1/h is the thermal resistance of the interface (defined by the user), k1 and k2 are fluid and obstacle thermal conduction coefficients, and a1 and a2 are distances to the interface from the nearest cell nodes in the fluid and obstacle, respectively. Eq. (0.259) implies the net heat transfer is limited by the smallest of the thermal resistances of the fluid, obstacle and interface. 



 

 

Conductive terms in the fluid and obstacle energy equations are also modified in the interfacial cells to account more accurately for temperature gradients in partially blocked cells. In two-fluid problems the mixture heat transfer coefficient is computed as a weighted average with respect to the local volume fraction of each fluid 
21 )1(
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hFhFh ⋅−+⋅=   (0.262) where F is the fluid fraction and heff1 and heff2 are computed according to Eq. (0.261), in which h is substituted by the heat transfer coefficient for fluids one and two, respectively. If no heat transfer coefficient is supplied by the user, then it is evaluated by FLOW-3D using simple analytical or empirical expressions for flow over a flat plate. Flow conditions near a wall in each control volume are correlated to one of the following physical situations: natural convection, forced laminar and turbulent convection, and conduction within the fluid. The heat transfer coefficient is then derived based on the closest situation. It is important to understand that the resulting value of h in each control volume reflects heat transfer conditions in the fluid layer between the wall and the center of the cell open volume. The actual thermal resistance of the fluid/obstacle interface is assumed to be zero. From the discussion in this section it appears that the heat transfer coefficient is always adjusted in each control volume, irrespective of whether it is explicitly defined by the user or left to the default. In case a specific heat transfer coefficient value must be used between the fluid and obstacle temperature nodes, without any further adjustments, the user must define a positive heat transfer coefficient and a positive value of the obstacle length scale variable OBSL. The thermal resistance of the contact interface between two materials, i.e., fluid and wall, represented in Eq. (0.263) by the heat transfer coefficient h, is largely a function of the surface properties of the two materials, like roughness, and the size of the gap between them, if any. In casting applications it may also be a function of temperature and solid fraction. In FLOW-3D, the latter is accounted for through a linear relationship between the heat transfer coefficient and the solid fraction Fs: 
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⋅−+⋅=  where HOBS1(n) is the user-defined heat transfer coefficient in the liquid metal, HOBS1S(n) is the user-defined heat transfer coefficient in the solid metal and n is the component number described by these coefficients. Typically, HOBS1S(n) is much smaller than HOBS1(n) because of a better contact that liquid materials make with walls than the solid ones. 
Baffle Heat Transfer Heat transfer across baffles is quite different from that with heat structures. Since baffles are treated as having no thickness and consequently no heat capacity, the heat transfer rate depends only on the instantaneous fluid temperatures on either side of the baffle. Suppose one face of a baffle with porosity PBAF separates fluid cells N and M. The energy source (sink) rate in fluid cell M is evaluated as: 
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The effective heat transfer coefficient HBFT is approximated by an electrical resistance analog as 
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+  (0.265) where HN, for example, is the two-fluid volume weighted average for cell N, 
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H F HBAF F HBAF= − ⋅ + ⋅  (0.266) and where HBAF2 and HBAF1 are user-supplied heat transfer coefficients. These coefficients must account for any heat conduction losses as well as convection. If both are zero, no heat is transferred across the baffle. 
Heat Transfer to Void Regions Fluid and obstacles transfer heat to void regions according to 
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q h W T T= −  (0.267) where hV is a (constant) heat transfer coefficient, WV is the heat transfer surface area, TV the void region temperature, and T is the fluid or obstacle temperature. Each void can have a different but constant temperature.  Heat transfer coefficients can be set for fluid/void heat transfer associated with both convective and radiation heat losses. Similarly, two heat transfer coefficients may be set for obstacle/void heat transfer. Another heat transfer coefficient can be set for the heat exchange between a fluid and void separated by a baffle. Radiation is modeled only computing as an emissivity proportional to the differences in the fourth power of the radiating body temperature and the temperature of the void. This model assumes temperatures to be in degrees Kelvin. Void regions with heat transfer can be used to approximate cooling channels, for instance, without having to explicitly compute fluid flow in the channels. Three types of void regions can be defined, each having its own heat transfer coefficient associated with convective, radiation and cross-baffle heat transfer. These, for example, could be used to describe cooling channels containing air, water, and oil. 
Numerical Approximations 
Overview FLOW-3D numerically solves the equations described in the previous sections using finite-difference (or finite-volume) approximations. The flow region is subdivided into a mesh of fixed rectangular cells. With each cell there are associated local average values of all dependent variables. As explained in the following, all variables are located at the centers of the cells except for velocities, which are located at cell-faces (staggered grid arrangement). Curved obstacles, wall boundaries, or other geometric features are embedded in the mesh by defining the fractional face areas and fractional volumes of the cells that are open to flow (the FAVOR™ method (C.W. Hirt and J.M. Sicilian, September 1985)). 



 

 

To construct discrete numerical approximations to the governing equations, control volumes are defined surrounding each dependent variable location. For each control volume, surface fluxes, surface stresses, and body forces can be computed in terms of surrounding variable values. These quantities are then combined to form approximations for the conservation laws expressed by the equations of motion. Most terms in the equations are evaluated using the current time-level values of the local variables, i.e., explicitly, although various implicit options exist as well. This produces a simple and efficient computational scheme for most purposes but requires the use of a limited time-step size to maintain computationally stable and accurate results. One important exception to this explicit formulation is in the treatment of pressure forces. Pressures and velocities are coupled implicitly by using time-advanced pressures in the momentum equations and time-advanced velocities in the mass (continuity) equation. This semi-implicit formulation of the finite-difference equations allows for the efficient solution of low speed and incompressible flow problems. The semi-implicit formulation, however, results in coupled sets of equations that must be solved by an iterative technique. In FLOW-3D, two such techniques are provided. The simplest is a successive over-relaxation (SOR) method. In some instances, where a more implicit solution method is required, a special alternating-direction, line-implicit method (SADI) is available. As described later, the SADI technique can be used in one, two, or in all three directions depending on the characteristics of the problem to be solved. The basic numerical method used in FLOW-3D has a formal accuracy that is first-order with respect to time and space increments. Special precautions have been taken to maintain this degree of accuracy even when the finite-difference mesh is non-uniform. Second-order accurate options are also available. In any case, boundary conditions are at least first-order accurate in all circumstances. For example, in cells partially occupied by an obstacle, the FAVOR™ method is equivalent to a first-order interpolation of boundary conditions within the cell. However, the implementation of the heat transfer boundary conditions at fluid/obstacle interfaces is second-order accurate with respect to the cell size. In the following sections these numerical techniques are made more precise through specific examples of the finite-difference and control volume approximations used throughout FLOW-3D. 
Notation The finite-difference mesh used for numerically solving the governing equations consists of rectangular cells of width δxi depth δyj and height δzk. The active mesh region has IBAR cells in the x-direction labeled with the index i, JBAR cells in the y-direction labeled with the index j, and KBAR cells in the z-direction labeled with the index k. This region is surrounded by layers of fictitious or boundary cells used to set mesh boundary conditions. Thus, there are usually (IBAR + 2)(JBAR + 2)(KBAR + 2) total cells in a complete mesh. If periodic or specified pressure boundary conditions are used in a given coordinate direction, however, one additional layer of boundary cells is used in that direction. This fact must be remembered only when setting dimension statements. The preprocessor will automatically initialize the necessary number of boundary cells needed to satisfy all boundary conditions. The figure below illustrates the cell labeling nomenclature. 



 

 

 Mesh arrangement and labeling convention Fluid velocities and pressures are located at staggered mesh locations as shown for a typical cell in the figure below: u velocities and fractional areas Ax at the centers of cell-faces normal to the x-direction, v velocities and fractional areas Ay at the centers of cell-faces normal to the y-direction, and w-velocities and fractional areas Az at the centers of cell-faces normal to the z-direction. Pressures (p), fluid fractions (F), fractional volumes (V), densities (ρ), internal energy (I), turbulence quantities for energy (q), dissipation (D), and viscosity (μ) are at cell centers. 



 

 

 Location of variables in a mesh cell The finite-difference notation used here corresponds to that used in the code where fractional index values cannot be used. The convention is that all fractional indexes are decreased to the nearest whole integer. For example, the u velocity at i + ½ which is located on the cell-face between cells (i, j, k) and (i+1, j, k), is denoted by 
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i j k
u  . A superscript n refers to the n-th time-step value. Similarly, 
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F = fluid fraction at center of cell (i, j, k) at time level n. 
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i j k
P = pressure at center of cell (i, j, k) at time level n. Similarly for ρ , I, q, D, and μ. 
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i j k
u = x-direction velocity at middle of i + ½  cell-face at time level n. 

, ,
n

i j k
v = y-direction velocity at middle of j + ½  cell-face at time level n. 

, ,
n

i j k
w = z-direction velocity at middle of k + ½ cell-face at time level n. Fractional areas and volumes appear with the following notation: AFRi,j,k = fractional area Ax for flow in x-direction at i + ½  cell-face. AFBi,j,k = fractional area Ay for flow in y-direction at j + ½ cell-face. AFTi,j,k = fractional area Ax for flow in z-direction at k + ½  cell-face. VFi,j,k  = fractional volume for flow at center of cell (i, j, k). 



 

 

When free surfaces or fluid interfaces are present, it is necessary to distinguish those cells that are empty, contain a surface, or are full of one fluid. By definition, a surface cell is a cell containing fluid #1 and having at least one adjacent cell (at ), that is empty or full of fluid #2. A cell with an F value less than unity, but with no empty neighbor, is considered a full cell in one-fluid problems. A flag NFi,j,k  is used to label the cells and also, in the case of surface cells, to indicate which neighboring cell lies in the direction of the inward normal to the surface. The flag values are NF i,j,k = 0 full or obstacle cell = 1 surface (i-1 inward neighbor) = 2 surface (i+1 inward neighbor) = 3 surface (j-1 inward neighbor) = 4 surface (j+1 inward neighbor)  = 5 surface (k-1 inward neighbor) = 6 surface (k+1 inward neighbor) = 7 cell undergoing cavitation = 8 empty cell NF is used to indicate the orientation of the surface between two fluids in an analogous manner. 
Outline of Finite Difference Solution Method The basic procedure for advancing a solution through one increment in time, δt, consists of three steps: 1. Explicit approximations of the momentum equations, Eq. (0.8), are used to compute the first guess for new time-level velocities using the initial conditions or previous time-level values for all advective, pressure, and other accelerations. 2. To satisfy the continuity equation, Equation (0.1), (0.5), or (0.7), when the implicit option is used, the pressures are iteratively adjusted in each cell and the velocity changes induced by each pressure change are added to the velocities computed in Step (1). An iteration is needed because the change in pressure needed in one cell will upset the balance in the six adjacent cells. In explicit calculations, an iteration may still be performed within each cell to satisfy the equation-of-state for compressible problems. 3. Finally, when there is a free-surface or fluid interface, it must be updated using Equation (0.17) to give the new fluid configuration. For compressible problems, density, Equation (0.1), and energy, Equation (0.19), must be updated to reflect advective, diffusive, and source processes. Turbulence quantities and wall temperatures are also updated in this step. Repetition of these steps will advance a solution through any desired time interval. At each step, of course, suitable boundary conditions must be imposed at all mesh, obstacle, and free-boundary surfaces. Details of these steps and boundary conditions are given in the following subsections. 
Momentum Equation Approximations A generic form for the finite-difference approximation of Equation (0.8) is (remember the fractional index convention) 
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here, for example, 
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The advective, viscous, and acceleration terms have an obvious meaning, e.g., FUX means the advective flux of u in the x-direction; VISX is the x-component viscous acceleration; BX is the flow loss for a baffle normal to the x-direction; WSX is the viscous wall acceleration in the x-direction; and GX includes gravitational, rotational, and general non-inertial accelerations. 
First-Order Method The simplest FLOW-3D finite-difference approximation is first-order accurate in both space and time increments. In this case the advective and viscous terms are all evaluated using old-time level (n) values for velocities. Wall shear stresses are implicitly evaluated as described below. Because the pressures at time level n+1 are generally unknown at the beginning of the cycle, these equations cannot be used directly to evaluate the n +1 level velocities but must be combined with the continuity equation. In the first step of a solution, the pn+1 values in these equations are replaced by pn values to get a first guess for the new velocities. In an explicit approximation the pressure gradient in Equation (0.268) is evaluated at time n, therefore further adjustment to p does not influence the evaluation of un+1. 



 

 

 Control volume (dashed line) in x-z plane used in finite-difference approximation for U momentum Specific approximations chosen for the various acceleration terms in Eq. (0.268) are relatively unimportant provided they lead to a numerically stable algorithm. Special care must be exercised, however, when making approximations in a mesh with non-uniform cell sizes. This problem has been discussed elsewhere (e.g., Reference (C.W. Hirt and B.D. Nichols, 1981)) but is repeated here because it is a problem that has often been overlooked. Consider the approximation procedure used in the original MAC method for Cartesian coordinates(F.H. Harlow and J.E. Welch, 1965), (J.E. Welch, F.H. Harlow, J.P. Shannon, and B.J. Daly, 1966). Let us also assume for simplicity that all fractional areas and volumes are equal to unity. In the MAC scheme the continuity and momentum equations, Eqs. (0.7) and (0.8), were first combined so that the advective flux terms could be written in a divergence form (i.e., uu∇ instead of u u∇ ). Thus FUX would be, for example, δu2/δx rather than uδu/δx. The divergence form was preferred in MAC because it provided a simple way to ensure conservation of momentum in the difference approximations. This may be seen by considering an x-z cross section of the control volume used for ui as indicated by dashed lines in the figure above. With the divergence form, Gauss' theorem may be used to convert the integrated value of FUX over the control volume to boundary fluxes at its sides. Then, the flux leaving one control volume will be gained by the adjacent one and conservation during advection is assured. This idea worked well in the original MAC scheme, which was developed for use in uniform meshes. Unfortunately, in non-uniform meshes, conservation does not automatically imply accuracy. To see this, suppose an upstream or donor-cell difference approximation is used for 2
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 (0.273) To check the accuracy of Eq. (0.271) we expand it in a Taylor series about the x-position where FUX is evaluated (assuming u-velocities are positive) 
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+ ∂   (0.274) Clearly, the coefficient on the zeroth order term is incorrect unless the cell widths are equal, 1i i
x xδ δ

+
= . In other words, the variable mesh reduces the order of the conservative difference approximation by one, which in this case leads to an incorrect zeroth order result. If a centered- rather than a donor-cell-approximation had been used, the result would have been first-order accurate, not second-order, as it is in a uniform mesh. It does not necessarily follow from the above analysis that variable meshes are always less accurate in practice. For example, they allow improved resolution in regions where flow variables are rapidly varying. Nevertheless, variable meshes must be used with considerable care. It is best, for example, to use a gradual variation in cell size to minimize the reduction in approximation order. It is also worthwhile to look for other approximations that do not lose their formal accuracy when applied to variable meshes. In this regard, it should be noted that the reason the conservative form of the advective term loses accuracy is because the control volume is not centered about the position of ui. The shifted control volume leads directly to the reduction in accuracy computed in Eq. (0.274). In FLOW-3D a modified donor-cell approximation has been developed that retains its accuracy in a variable mesh and reduces to a conservative difference expression when the mesh is uniform (C.W. Hirt and J.M. Sicilian, September 1985). This method approximates advective fluxes in the non-conservative form, u u∇ , which is necessary because of the inherent difficulty with conservative approximations noted above. In this approximation it is also possible to combine the donor-cell and centered-difference approximations into a single expression with a parameter that controls the relative amount of each. The general form of this approximation for x
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If the mesh is uniform, this approximation reduces to a spatially second-order accurate, centered-difference approximation when α=0. When α =1, the first-order, donor-cell approximation is recovered. In either case, the method reduces to the correct zeroth order expression in a variable mesh. In a uniform mesh the advective flux approximations can be shown to reduce to a conservative approximation form uu∇ . The basic idea underlying Eq. (0.275) is to weight the upstream quantity being fluxed more than the downstream value. The weighting factors are (1 + α) and (1 - α) for the upstream and downstream directions, respectively. This type of first-order approximation scheme is used for all advective flux terms appearing in Eq. (0.268).  All other acceleration terms in the momentum equations are approximated by standard centered differences. 
Second-Order Method The approximations described above have truncation errors proportional to the first power of the time increment δt and, if  or the mesh is non-uniform, the first power of the space increments dx, dy and dz. The advantage of these first-order approximations is that they are simple and easy to keep computationally stable. For a great many applications they also provide good solutions. In some cases, however, it may be too costly to use the mesh resolution necessary for an accurate first-order solution. When this happens, it may be useful to employ a second-order accurate approximation for the advective and viscous accelerations. Two optional second-order approximation schemes for the momentum equations can be requested through the input data. The essence of the first scheme is a double pass through the advection and viscous subroutines. In the first pass, the first-order method is used with the donor cell parameter α =1.0. These new velocities are then stored in the arrays for the previous time velocities. The first-order calculations are then repeated, but this time the parameter is set to α=-1.0. Finally, the results of the two calculations are averaged to give the desired second-order approximation to the new time-level velocities. These approximations are second-order in time because the first pass uses time-n velocities, while the second pass uses (first-order) approximations for velocities at time n+1. The average then has level n + ½, which is second-order in δt. Likewise, using α= + 1.0 in the first pass and α = -1.0 in the second results in an average α-value of zero, which is second-order in dx, dy, dz if the mesh is uniform. (See Reference (C.W. Hirt, 1978) for a more complete analysis of this second-order scheme.) This algorithm is the least numerically diffusive of the three advection methods available in FLOW-3D. However, it does not possess the transportive property, which in standard upstream differencing schemes ensures that a flow disturbance only propagates downstream from its initial location. In addition, this method is the most CPU intensive. Finally, this method may occasionally generate a numerically unstable solution for flows with transient free-surfaces. 



 

 

Second-Order Monotonicity Preserving Method The other higher order advection algorithm in FLOW-3D is based on a second-order, monotonicity-preserving upwind-difference method (B. Van Leer, 1977). It is as robust as the original first-order advection scheme. It requires slightly more CPU time than the first-order method, although in most cases the difference is insignificant. The monotonicity-preserving method may be applied in FLOW-3D to approximate momentum advection, as well as density, energy and fluid fraction advection. The higher-order discretization scheme is derived by using second-order polynomial approximations to the advected quantity in each of the coordinate directions (C.L. Bronisz and C.W. Hirt, 1991). For a variable Q advected in the x-direction, the value fluxed through a cell-face, Q*, is computed as 
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x C xδ= −  (0.279) within the cell. Coefficient A can easily be computed from two neighboring first derivatives by linear interpolation, provided these derivatives are second-order accurate. The latter can be achieved by computing the derivatives at the midpoints between Qi locations; for example, 
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+  (0.280) is a second-order accurate first derivative of Q at the point between Qi and Qi +1. With this approach it is easy to extend the higher-order, monotonicity-preserving method to non-uniform grids. An advantage of Eq. (0.278) is that the first term on the right side gives the usual first-order donor-cell approximation. Thus, the second-order approximation, which is generated by the addition of the second term on the right side of Eq. (0.278), can easily be made an option in a computer program. To ensure monotonicity, IT IS NECESSARY to restrict the value of the derivative A. According to Reference (B. Van Leer, 1977), the value of A is not allowed to exceed twice the minimum magnitude of the centered Q derivatives used in its computation 
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   (0.281) Furthermore, if Qi is a local minimum or maximum value - that is, if the two centered derivatives appearing in Eq. (0.281) are of opposite sign - then A is set to zero and the donor-cell approximation is used. 



 

 

Locally Implicit Approximation of Advection Explicit (e.g., forward in time) finite-difference approximations used to solve time-evolution equations are subject to limits on the size of the time increment. In this type of approximation it is assumed that the values of all dependent variables are advanced in time through a succession of small time intervals. Knowing the variable values at all steps, up to and including step n, they can then be used to estimate the rates-of-change of the variables. This makes it possible to estimate what the dependent variable values will be at step n+1, which corresponds to a small time δt later, tn+1=tn + δt. The need for small δt in this type of approximation arises because the rate-of-change of a dependent variable is usually evaluated in terms of differences between that variable and the values of its immediate neighbors in space. With an increasing time step size, a variable would be expected to be influenced not just by its immediate neighbors but by values located increasingly further away. Therefore, there must be a limit on the size of time advancement δt to insure stability and accuracy. While explicit finite-difference equations are simple to use, their requirement for limiting the time-step size δt can sometimes lead to long computation times.  To overcome this limitation, it may be desirable to resort to an implicit finite-difference method that eliminates the troublesome time-step restriction.  The basic idea is to include in the approximation of the rate-of-change of a variable the values of variables at the advanced time level n+1.  Since the level n+1 values that one is trying to compute now depend on those same values, the difference equations are said to be implicit. A locally implicit method exists in FLOW-3D to approximate advection terms in the fluid transport equations. The implicit treatment can be applied selectively in time and space thus minimizing the overhead and inaccuracies associated with implicit methods in general. Consider a simple one-dimensional scalar advection equation, 
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∂ ∂∂ ∂∂ ∂∂ ∂  (0.282) The corresponding upwind finite-difference equation based on donor advection (u > 0) is, 
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δδδδ  (0.284) A time level has not been specified in the approximation for the rate-of-change Aj. An explicit approximation using the n-level values for S would have a stability limit requiring δt to be less than δx/u. To add implicitness we now expand Aj into a Taylor series with respect to Sj. Neglecting the terms of the order higher than one, we obtain 
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From Eq. (0.284) we have 
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∂∂∂∂      (0.287) The advection flux now contains dding a degree of implicitness to it. Let us check the stability of this approximation. An asymptotic δt test to check unconditional stability says divide by δt and let it go to infinity. In this limit the first term disappears, and the result is a new equation for the change in S, 
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∂∂∂∂  (0.288) which means that the modified equation is unconditionally stable (as long as the coefficient ∂A/∂S is not zero). In fact, the resulting equation looks like the original explicit expression except that the time step has been replaced by the reciprocal of ∂A/∂S. This new “time step” is precisely the limiting time step for explicit stability, δx/u, therefore, the approximation of Eq. (0.288) is essentially stable. If we don’t take the limit of infinite time step we have a new, locally implicit, unconditionally stable, finite-difference equation for the advancement of S, which can be written as 
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δ ∂δ ∂δ ∂δ ∂      (0.289) This approximation remains stable for all time-step sizes because it effectively replaces the time step by a new one that is always less than that necessary for explicit stability. Equation (0.289) still has the same steady-state solution, namely A=0, when Sn+1=Sn. Since the flux term in this equation is not coupled to the time n+1 values of the adjacent cells, no iterations are necessary to solve it.  This method is a simple scheme for generating an implicit numerical approximation of advection fluxes having an unconditional stability. It maintains the upstream dependence expected of advection, while limiting the flux to essentially one grid cell per time step. When activated, the method is applied to all fluid transport equations. Because the difference approximation only involves the values of neighboring quantities and does not include an iterative process, the locally implicit advection may not be very accurate when the time-step size becomes too large, i.e., an unrestricted implicitness can lead to inaccuracies. Large gradients of an advected quantity, like fluid fraction at the free surface, may also result in significant numerical errors in the implicit method. To reduce these inaccuracies the under-relaxation is limited to only those locations where a computational instability would occur if not treated implicitly. In other words, the locally implicit approximation is applied only in cells only where and when the time-step size exceeds the local stability limit defined by the velocity 



 

 

in the cell and the cell size. At all other times and places, the regular conservative explicit approximation is employed. To prevent inaccuracies in the treatment of free boundaries the implicit advection method is not applied in cells that contain a moving free surface, that is, where there is a significant velocity component along the free surface normal. This limitation means that time-step sizes must be limited in their usual manner in such cells. 
Density Evaluation The densities,
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ρ  , required for Eq. (0.8) are evaluated based on the type of problem at hand. For one-material, incompressible flows, all density values are set to the density of fluid #1. For two-fluid, incompressible flows the density is a weighted average of the densities of the two fluids (ρ1 and ρ2) based on volume fraction, F, 

[ ]1 2( , , ) ( , , ) 1.0 ( , , )RHO i j k F i j k F i j kρ ρ= + −  (0.290) Fluid densities ρ1 and ρ2 may be temperature-dependent as discussed in the Vaporization Residue section.  Fluids at free surfaces in a one-fluid problem can either evaporate or condense when a phase change model is used. This holds true for both cases where the gas side of the interface is a constant pressure or when it is a homogenous bubble region. If the fluid contains one or more solutes, the concentration of the solutes must change in response to the gain or loss of liquid. Typically the solutes become more concentrated due to liquid evaporation. In either the evaporation or condensation case, any scalar concentration that is associated with the fluid will have its concentration altered by the phase change. If a surface element is less than half filled with liquid, then the concentration change is spread into the principal neighbor of the surface element to the extent that the concentration region equals half the thickness of the surface element. If enough evaporation occurs and the solute concentration becomes high enough, it may result in a surface skin or a residue may form on a solid surface if the liquid is completely evaporated. For this to be simulated in FLOW-3D, the residue model must be selected. Activation of this model causes the solute to form a non-moving residue once its concentration reaches a user-defined maximum packing density. If more than one solute is present, the residue model will record the total of all solute contributions to the residue.   For compressible problems the density is evaluated from the continuity equation, Eq. (3.1). As discussed below, this is equivalent to a volume-weighted equation-of-state density 
[ ] [ ] [ ]1 1 2 2( , , ) ( , , ) ( , , ), ( , , ) 1.0 ( , , ) ( , , ), ( , , )RHO i j k F i j k P i j k I i j k F i j k P i j k I i j kρ ρ= ⋅ + − ⋅  (0.291) where ρ1 and ρ2 are functions of the pressure and internal energy. The compressible flow equation-of-state functions for density are programmed to permit easy modification; however, the functions provided have some flexibility. Both fluids are assumed to have a constant specific heat (which can be defined by the user) so that the specific internal energies are 
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= ⋅  (0.292) Fluid #1 is assumed incompressible, and its density is specified as RHO1. Fluid #2 is a perfect gas with 
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⋅  (0.293) where RF2 is a user-supplied gas constant. 
Wall Shear Stresses Wall stresses are included in an implicit way to avoid possible numerical instabilities arising in cells with large wall areas and small flow volumes. The basic approach for the w-velocity equation, for example, is as follows. Wall shears influencing w can arise from wall areas located on x or y cell-faces surrounding w. For any one of these faces, if the fractional flow area A is less than unity, the remaining area fraction (1—A) is considered to be a wall on which a stress is generated. On an x face to the right of w, for instance, the acceleration due to wall shear in laminar flow, wsz, is an approximation to ∂/∂x(μ(∂w/∂x)), 
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= − − −  (0.294) where Ax∂x and μ are evaluated in the cell in which w is located. The area fraction Az is estimated at the same control volume face where w is located. The velocity wo is either zero or is equal to the z-direction tangential velocity at moving component and mesh boundaries. Because w is on the boundary between two cells, the Ax is an average for these cells. Similar stresses are evaluated at each of the four surrounding cell walls, and their sum is taken as the total stress. If the w appearing in Eq. (0.294) is the time level n value, the approximation is explicit but subject to possible numerical instability. To avoid this possibility, the w is taken to be the new value computed from the full momentum equation. Although this makes the momentum equation for w implicit, it is trivial to solve since it is linear in w. For turbulent shear stress, Eq. (0.294) changes to 
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= − = − − −  (0.295) where  computed from Eq. (0.257). The quadratic expression for the tangential velocity is linearized, with the w in the parenthesis on the right-hand side taken at time level n+1. Effective wall shear stresses arising from mass injection from obstacle surfaces are modeled in much the same way. The effective stress is, e.g., 
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where QSR is the average mass source rate in the mesh cells on either side of the boundary where w is defined. No stress is used if the source is negative (a sink) because fluid is assumed to leave with the local velocity. Here again one uses the new W value so that the contribution to the momentum equation is implicit for enhanced numerical stability. Slippage at walls is only allowed for laminar flows and is modeled by using a friction factor κ. The wall shear stress given by Eq. (0.294) modified for slippage is 
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= − −  (0.297) where ws is the fluid slip velocity at the wall: 
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Both laminar and turbulent wall shear stresses at wall surfaces can be modified by defining a wall roughness. The roughness has the dimensions of length. The length is, in some sense, proportional to the size of the roughness elements. It is incorporated into the usual shear stress calculations by adding to the molecular viscosity the product of ρ, ξ, and w, where ξ is the surface roughness and w means the difference between the local fluid velocity and the wall velocity. In this implementation the wall shear stress in laminar flow is equal to ρ(ν + ξw)w/δx. For turbulent flow, the law-of-the-wall relation retains the same form as for a smooth wall, except the change in viscosity (i.e., from ν to ν + ξw) automatically converts the logarithm dependence from a characteristic length scale defined by ν/w to ξ, when ξ is the larger of the two characteristic lengths. The roughness should be smaller than the grid cell size at the obstacle boundary, although larger values can be used. The value of the frictional roughness parameter ROUGH does not affect obstacle/fluid heat transfer (see also Surface Area Evaluation). 
Porous Baffle Flow Losses For flow losses at baffles, an implicit solution is used that is similar to that for wall shear stresses. The only difference in this case is that the implicit equation for w (or u and v) may be quadratic and may require the taking of a square root for its solution. 
Generalized Drag Forces Flow in porous media and the solidification/melting model use a drag force proportional to the first power of the velocity, -Ku. These models assume the possibility of an arbitrarily large drag coefficient, K, in which the momentum equations may reduce to a balance between drag and pressure gradient forces. To compute in this high drag limit for incompressible flow, it is necessary to treat the drag terms implicitly, not only in the momentum equations but also in the continuity equation. This is accomplished by using the time-advanced value for the velocity in the drag term and algebraically solving the difference equation for the new velocity. The result is a division of all contributions to the new velocity by the term (1+Kdt). Keeping the 



 

 

effect of this extra term throughout all pressure/velocity adjustments then ensures that a balance between pressure gradient and drag forces can be achieved that also satisfies the continuity equation. 
Non-Inertial Reference Frame FLOW-3D has two strategies for analysis of flows inside a moving tank: the general moving object (GMO) method and the non-inertial frame method. The former moves the tanks through the computational mesh that is fixed in an inertial frame (See General Moving Objects Model in this chapter and in Model Reference). The latter embeds the computational mesh in a non-inertial reference frame that moves with the tank, which is presented in this section.  Due to reference frame transformation, in the non-inertial frame the fluid experiences "fictitious" accelerations that can be related to a set of independent variables that describe the motion of the reference frame with respect to inertial space. In FLOW-3D, these variables are the three Cartesian components of linear acceleration, three components of angular velocity (in radians per unit time), and three components of angular acceleration (in radians per unit time squared). All nine of these variables may be functions of time. Clearly, there are also three relationships between the components of angular velocity and angular acceleration that must be satisfied. Therefore, there are really only six independent functions of time.  Additionally, there are three (time-independent) variables, which simplify the specification of some types of motion. These are the three Cartesian components of an "offset" vector (RCX, RCY and RCZ). These components specify the vector from the origin of the coordinate system to a point about which rotations are to be described (see figure in Rigid Body Dynamics). This is useful, for example, in describing the motion of a body that is moving without experiencing "external" forces, in which case the center of mass can conveniently be taken as the "rotation" point. The evaluation of the local "fictitious" force experienced by the fluid is evaluated by three completely general subroutines ACCXCL, ACCYCL, and ACCZCL. These routines do not, generally, require modifications by the user. Evaluation of the nine time-dependent variables, however, cannot be completely generalized. Therefore, this evaluation has been segregated to a single subroutine (MOTION), which may be modified by the user if necessary. Another special case is discussed in Coupled Rigid Body Dynamics description and will not be discussed further in this section. Gravitational Force in Non-inertial Frames In many cases, one may be interested in the movement of a reference frame within a uniform gravitational field. An example is the slosh of cargo in tanker ships on the ocean surface. To facilitate such analyses, a specific "gravity vector" model can be used. In this model, the user must specify the initial components of gravity (relative to the Cartesian computational reference frame) through the input variables GRAVX, GRAVY, and GRAVZ in namelist MOTN. The routine MOTION will then evaluate the instantaneous components required by the fluid solution algorithm as the reference frame rotates. Note that translation of the reference frame has no effect on these gravitational components.  Specifying Non-Inertial Reference Frame Motion To use the non-inertial reference frame model in any calculation, one must first request that this option be turned on by setting IACCF=1 in namelist XPUT. This causes FLOW-3D to read and process the MOTN namelist and to invoke the MOTION, ACCXCL, ACCYCL, and ACCZCL subroutines at appropriate points in the calculation. 



 

 

Since there are now four options for specifying the movement of the reference frame to MOTION, a new input parameter has been added to MOTN to choose among them. Its values signify:  IATYPE=0: Simple rotation or acceleration along the x axis or rotation about the z axis. IATYPE=1: Harmonic oscillation of the components of linear acceleration and angular velocity and acceleration. IATYPE=2 through 5: Tabular specification of reference frame parameters. The following sections describe each of these options in more detail. Simple Rotation or Acceleration along the X-Axis This option is provided for compatibility with earlier versions of FLOW-3D. The same reference frame motions can be selected using other options if desired. The automatic evaluation of gravitational components is not implemented in this option. However, it can be used with fixed gravitational components specified by GX, GY and GZ. The input parameters relevant to this option are: RCX, RCY, RCZ, A0, OMG0, SPIN and RPS. Three motions are permitted under this option and may be combined if desired: The acceleration along the Cartesian x-axis is specified by 
0 0sin( )UCDX A MG t= ⋅ Ο ⋅  (0.299) The rotation about the axis parallel to x through the offset point (RCX, RCY, RCZ) is given by in radians/second. 

OMGX SPIN=  (0.300) The rotation about the axis parallel to z through the offset point (RCX, RCY, RCZ) is given by 
2OMGZ RPS= ⋅ ⋅π  (0.301) where RPS is revolutions per second. Harmonic Oscillation This option permits use of independent simple harmonic functions for each component of linear acceleration and angular velocity. Automatic evaluation of gravitational components is allowed with this option. The input parameters relevant to this option are: RCX, RCY, RCZ, GRAVX, GRAVY, GRAVZ, TFREQX, TFREQY, TFREQZ, TMAGX, TMAGY, TMAGZ, TPHIX, TPHIY, TPHIZ, RFREQX, RFREQY, RFREQZ, RMAGX, RMAGY, RMAGZ, RPHIX, RPHIY and RPHIZ. Each component of linear acceleration is given by: 

( )
2

sina f d f t= − ⋅ ⋅ ⋅ −φ  (0.302) where f is the frequency input (TFREQX, etc.), d is the displacement input (TMAGX, etc.), and φ is the phase angle input (TPHIX, etc.). Note the sign change and multiplication by the square of the frequency, which converts a displacement function to the required linear acceleration. Each component of angular velocity is given by: 



 

 

( )sinf f t= ⋅ ⋅ ⋅ −ω α ϕ  (0.303) with f = RFREQX, α = RMAGX and φ= RPHIX, etc. Finally, the angular acceleration components are given by: 
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α φ  (0.304) where the same input variables as for angular velocity are used to ensure compatibility. Tabular Specification One can specify tabular data for six of the reference frame variables by providing a data file that will be read by subroutine MOTION during the calculation. Three of the reference frame variables are always the Cartesian components of linear acceleration. The other three variables may be the components of angular acceleration (IATYPE=2 or 4) or they may be the components of angular velocity (IATYPE=3 or 5). The remaining three variables are calculated by numerical differentiation or integration as appropriate to ensure compatibility. Automatic evaluation of gravitational components is allowed with this option. The pertinent input variables are: RCX, RCY, RCZ, GRAVX, GRAVY, GRAVZ, ACONV and OMCONV. The values of IATYPE=4 or 5 permit the specification of impulsive intervals as well as smoothly varying accelerations. The same values also permit the specification of the time-step size to be used at a particular time if desired. IATYPE= 2 or 3 permits only smoothly varying motions. During execution, subroutine MOTION will try to read the necessary data from the data file "MOVIN.INP" (under many operating systems the name of this file can be modified in the execution script or procedure). Since MOTION is invoked in both PREP3D and HYDR3D, this file must exist in the same directory as the PREPIN.INP file to execute either module of FLOW-3D. The file has a free-format structure. The first card must contain an integer indicating the number of lines that follow it to be skipped by MOTION. This permits you to annotate the file for your own documentation and inspection. After these "header" lines must be a sequence of lines. Each line describes the reference frame variables at a specific time. These times must be in strictly increasing order! The time must be the first entry on this line. Time should correspond to the internal time in FLOW-3D. For restart calculations, time begins from the selected value, TREST, not from zero. The next three entries are the x-, y-, and z-components of linear acceleration.  The next three entries on the line are the three x-, y-, and z-components of angular velocity in radians per unit time (if IATYPE=3 or 5). The next three entries are the three x-, y-, and z-components of angular acceleration in radians per unit time squared (if IATYPE=2 or 4). The next two entries, which are only read if IATYPE > 3, are the desired time-step size (this value is only used if it is positive), and the duration of the impulsive interval. The impulsive interval duration parameter distinguishes between smooth interpolation points (for which it is non-positive) and impulsive interval data (for which it is positive). MOTION will convert the units of the data in the input file by multiplying linear acceleration values by the input variable ACONV and angular variables by OMCONV. The converted values are printed in the 



 

 

HD3OUT.DAT file. Values are interpolated between available data. Constant values are used before the first time value or after the last, in which case a message is printed in HD3OUT.DAT indicating that the data file values have been extrapolated. As implied above, one may combine impulsive and smoothly varying accelerations if IATYPE > 3. This is accomplished by specifying positive values for the impulse duration in some card groups and zero or negative values in others. MOTION interprets this kind of data file by first interpolating the smooth data point parameters to the present time, then adding the impulsive values if the present time lies within an impulse. This permits accelerations that include rapid changes. This may happen, for example, in response to a control system action on board a spacecraft. Time-step size control is provided so that FLOW-3D can anticipate the need to reduce the time-step size before an acceleration impulse is encountered. This also keeps FLOW-3D from accidentally skipping over the impulsive period because its selected time-step size is larger than the interval of the impulse. If automatic time-step selection is enabled, the time-step size will recover to large values between impulses, greatly reducing the total computational cost. 
Coupled Rigid Body Dynamics As described in Non-Inertial Reference Frames above, FLOW-3D can be used to study the fluid flow in moving tanks by embedding the tank in a coordinate system that moves with respect to inertial space. Under some circumstances, FLOW-3D is also able to analyze the motion of this reference frame in a coupled manner, including the influence of the forces and moments exerted by the internal fluid on the tank. This is known as the "Coupled Rigid-Body Dynamics" model and is described in this section. The basic approach of this model is to treat the fluid region as a part of a larger rigid body that can move through inertial space (see Rigid Body Dynamics). This body may be subject to a variety of forces and torques and will respond to them in a well-known manner. Since the computational mesh is embedded in the rigid body, its motion is identical to that of the body. One set of important forces and torques that may be imposed on the body is that created by the motion of fluid adjacent to it. Several alternative coupling schemes are selectable by input and are described briefly below. A wide variety of other forces may also be experienced by the body. FLOW-3D divides these forces into three classes: 
� Environmental Forces and Torques 
� Control Forces and Torques 
� Gravitational Force The first two classes are treated by providing links to two subroutines that can be programmed for the specific analysis at hand. The distinction between environmental and control classes is for convenience only and can be arbitrarily decided by the analyst. The effects of gravity from a point-gravitating body are automatically calculated, including the effects of the relative movement of the coordinate system and the body. Since this model is intended for use by the aerospace community, among others, both the direction and magnitude of gravity are adjusted throughout the calculation. In some situations, more than one fluid tank may affect the motion of the rigid body. These tanks may contain fluids with differing properties (density, viscosity, etc.). A multiple-tank model is included in FLOW-3D to permit the investigation of these situations. 



 

 

Input Data The coupled rigid-body dynamics model is activated by setting IACCF=2 in the XPUT namelist. It is also necessary to specify the dry mass and moments of inertia of the rigid body; these are provided in namelist RBDATA. Other input data may include the initial location, orientation and motion of the body and the parameters of the gravitating body. The input parameter IRBACC controls the coupling algorithm to be used and the manner in which the initial values of linear and angular acceleration are calculated. Initial evaluation of accelerations is necessary since the fluid reaction forces are not known at the start of a calculation. IRBACC allows the analyst to choose between ignoring the fluid and treating it as a frozen mass at the start of the first fluid time step. In general, use of the coupled model requires special versions of the control and environmental force and torque specification routines, RBCTRL and RBENVR. The distribution version of FLOW-3D includes a special purpose control routine, which can accept a variety of input parameters. There are three options available in this standard routine. The choice among them is made by specifying IATYPE as follows: IATYPE = 0: No force or torque supplied IATYPE = 1: Control force calculated from a spring and damper model IATYPE = 2: Control torque calculated from a spring and damper model IATYPE = 3: Tabular specification of control force and torque components The spring and damper coefficients for IATYPE = 1 or 2 are specified in the namelist MOTN as RADKRB, RDMPRB or THEKRB, TDMPRB. For IATYPE = 1 one may also specify an equilibrium radius via REQRB. (The equilibrium angle is always zero for IATYPE = 2.) The tabular input option is similar to tabular specification of reference frame motion. One can specify tabular data for the six Cartesian components of control force and torque by providing a data file that will be read by subroutine RBCTRL during the calculation. The default name for this file is THRUST.INP. The conversion constants (ACONV and OMCONV) may be used in conjunction with the thrust data file. The force components read from the file are multiplied by ACONV for use by RBCTRL, while the torque components are multiplied by OMCONV. The file has a free-format structure. The first card must contain an integer indicating the number of lines that follow it to be skipped by MOTION. This permits you to annotate the file for your own documentation and inspection. After these "header" lines must follow a sequence of input lines. Each line describes the force and torque components at a specific time. These times must be in strictly increasing order! The time must be the first entry on this line. Time should correspond to the internal time in FLOW-3D. For restart calculations, time begins from the selected value, TREST, not from zero. The next three entries are the components of the control force (in the order x, y, z). The following three entries are the components of control torque in the same order. The next entry is the desired time-step size. This value is only used if it is positive. The final entry determines if the line is used as an interpolation point for smooth force and torque variation or as an impulsive motion specification. If IATYPE > 3 this entry must always be present at the end 



 

 

of the line. If the data entry is positive, it indicates the length of the impulse. Otherwise, the line is interpreted as an interpolation point in smoothly varying functions. As implied above, one may combine impulsive and smoothly varying accelerations. This is accomplished by specifying positive values for the impulse duration in some lines and zero or negative values in others. RBCTRL interprets this kind of data file by first interpolating the smooth data point parameters to the present time, then adding the impulsive values if the present time lies within an impulse. This permits accelerations that include rapid changes. This may happen, for example, in response to a control system action on board a spacecraft. Time-step size control is provided so that FLOW-3D can anticipate the need to reduce the time-step size before an acceleration impulse is encountered. This also keeps FLOW-3D from accidentally skipping over the impulsive period because its selected time-step size is larger than the interval of the impulse. If automatic time-step selection is enabled, the time-step size will recover to large values between impulses, greatly reducing the total computational cost. Explicit Solution Algorithm and Stability Limitations The explicit coupled solution proceeds by (1) solving the fluid flow equations using the previous solution for the movement of the reference system, (2) evaluating the resulting fluid forces and torques, (3) adding the control and environmental effects to produce equations for the motion of the rigid body, and (4) solving these equations for the new acceleration parameters, center of mass location, and rigid body orientation (attitude). The new reference frame parameters are used in the following cycle for the fluid solution. This explicit form of coupling is known to be unstable if the fluid mass or its inertia moments exceed those of the rigid body. (This is only an approximate relationship. We have seen cases where the fluid mass or inertia can be somewhat larger without instability developing. We also suspect that there will be cases where the opposite is true.) Implicit Solution Algorithms Two implicit solution algorithms are available. The first algorithm (IRBACC=2) is analogous to the explicit method, except that the fluid mass is treated as frozen during step 4. That is, the fluid forces respond to changes in reference frame acceleration as if the fluid were frozen to the computational mesh. This modification eliminates the stability limitation of the explicit solution. The accuracy of this algorithm depends on the extent to which the "frozen" approximation is appropriate to the solution. A refinement to this method is to treat the calculated reference frame motion as an estimate of the end of cycle result. The fluid solution is then repeated for the same cycle, using the estimated reference frame motion. New fluid forces are combined with environmental and control forces to reevaluate the reference frame motion. Iterations are continued until a convergence criterion on the accelerations is met. This is the iterative implicit algorithm (IRBACC=3). Again, its accuracy depends on the validity of the "frozen" approximation. For additional information on the coupled rigid body dynamics model, including a complete description of input parameters and output variables, please refer to References(Sicilian, J.M., August 1992), (Sicilian, J.M., 1995). 



 

 

Pressure Solution Algorithm The numerical treatment of mass conservation is quite different in compressible and incompressible flows. However, in either case, the appropriate mass equation leads to an algorithm for determining cell pressures and updating velocities. For incompressible flows or flows of limited compressibility (which must use the implicit pressure solution method), the continuity equation, Eq. (3.6) or Eq. (0.7), can be directly interpreted as an elliptic condition on the cell pressures and velocities. For compressible flows, the continuity equation, Eq. (3.1), is solved as a parabolic equation, i.e., by a marching algorithm in time. The pressure is then determined by requiring the equation-of-state density to equal the updated cell density. In this case the velocities do not need to be updated if the time-step size is small enough to ensure stability with respect to the propagation of sound waves. Using the implicit option for compressible flows permits the use of larger time steps, but may be less accurate for shock and rarefaction wave profiles. Sometimes adding artificial limited compressibility to the fluid can improve convergence without introducing significant errors into the solution. In FLOW-3D this can be done in an automated way by setting IMP=2 (the default is IMP=1). See Flow Science Technical Note #55 for details of the model. 
Incompressible SOR Method Velocities computed from Eq. (0.268) must satisfy the following discretized approximation to the limited compressibility continuity equation, Eq. (0.7), 
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where XCi is the x location of the center of cell i. For cylindrical coordinates one has CYL=1.0 and Ri=XIM1/ XCi, in which XIM1 is the radius (x location) of the outer edge of the last real cell in the mesh. In Cartesian geometry Ri =1.0 for all i, and CYL=0.0. The term RSOR/ρ represents the volume source of fluid in the cell. The compressibility coefficient, 1/( ρ c)2, is calculated by the formula for two-fluid problem 
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   (0.306) Only the second term exists for one-fluid problems. Subscripts l and v denote fluid #1 and fluid #2, respectively. This form allows use of limited compressibility for two purposes, physical and numerical. By setting the two input parameters, RCSQL=1/( ρc2)l and RCSQV=1/( ρc2 )V, one can model limited physical compressibility of the fluids. 

http://www.flow3d.com/pdfs/tn/FloSci-TN55.pdf


 

 

By setting RCSQL and RCSQV appropriately (or using the IFPK option described later), one can also mitigate the effects of occasional numerical pressure pulses caused by the collapse of free-surfaces onto obstacle boundaries. For velocities to satisfy Eq. (0.305), it is necessary to adjust the pressure and, hence, the velocities in each computational cell occupied by fluid. This is done in one of two ways. The simplest method is a successive over-relaxation (SOR) iterative process. The computational mesh is swept cell by cell starting with the first non-boundary cell in the mesh. Sweeping is first carried out on i, then j, and finally on k values. Calculations are only performed in cells that contain fluid and have no empty neighbors. The pressure change needed to make the velocities in cell (i, j, k) satisfy Eq. (0.305) is 
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∂ ∂  (0.307) where S is the left-hand side of Eq. (0.305). Eq. (0.307) is simply a Newton type of relaxation process that will produce the value of p needed to make S=0. In each cell the velocity values used in evaluating S are the most current values available during the iteration process. Using the result from Eq. (0.307), the new estimate for the cell pressure is 
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p pδ+  (0.308) and new estimates for the velocities located on the sides of the cell are 
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where the velocities appearing here are also the most current values available during the iteration. To start the iteration process, the new estimated velocities from Eq. (0.268) are used with the pressures remaining from the previous time step. Of course, velocities located at zero area faces are not adjusted at this stage. In cells containing a free-surface, that is, a cell containing fluid, but with one or more empty neighbors, a different procedure is used. The boundary condition wanted in these cells is that the pressure is a specified 



 

 

value, say ps, at the surface. The surface pressure is set equal to the sum of the neighboring void region pressure, PR, and the surface tension pressure, PS, 
, ,( )

s i j k
p PR n PS= +  (0.310) where n is the index of the adjacent void region. Evaluation of PS is described in Surface Tension with Wall Adhesion. The surface pressure, ps, is then imposed on the solution by extrapolating it to the pressure, pi,j,k, at the center of the surface cell, assuming a hydrostatic distribution within the cell. The hydrostatic variation depends on the net acceleration in the direction normal to the surface, as defined by NF. This surface cell pressure is not changed during the pressure iteration, but is treated as a fixed boundary value. In this way the actual location of the free-surface within the cell is explicitly taken into account. It has been observed that numerical instability can develop due to the explicit approximation of the void region pressure, PR(n), when high pressure, adiabatic, gas bubbles are present(C.W. Hirt, 1992), (M.R. Barkhudarov and S.B. Chin, 1994) (the adiabatic bubble model is described in Variable Pressure (Adiabatic) Void Region). To help eliminate these difficulties, an implicit bubble model has been added to FLOW-3D. The purpose of this addition was to anticipate bubble pressure changes computed at the end of a cycle and include them in the usual pressure-velocity iteration process. The implicit bubble model works well if the "stiffness" of the bubbles is not too large. A stiff bubble is one whose anticipated and actual pressure changes within one time step are very different. In other words, a stiff bubble is, by definition, one in which the end-of-cycle pressure is not well approximated by the implicit model. When stiff bubbles occur, the solution may have large pressure changes every cycle and corresponding large fluctuations in velocities and other quantities (see Ref. (C.W. Hirt, 1992) for more details). For two-fluid problems, all cells are treated as full; that is, pressures and velocities are adjusted in all fluid cells during iterations. If surface tension is employed, then pressure PSi,j,k is only applied to one of the fluids so that a discontinuity in pressure across the interface due to surface tension effects is maintained. A complete iteration consists of adjusting pressures and velocities in all full cells according to Eqs. (0.307), (0.308) and (0.309). Convergence of the iteration is achieved when all cells have S values whose magnitudes are below some small number, i,j,kEPSI VF ⋅ . The value of EPSI is computed automatically by FLOW-3D as a function of the time-step size at every time cycle. This algorithm is invoked when the value of the input parameter EPSADJ is positive. Alternatively, a constant value of EPSI can be used throughout a calculation. In some cases, convergence of the iteration may be accelerated by multiplying δp in Eq. (0.308) by a relaxation factor, OMEGA. A value of OMEGA equal to 1.7 or 1.8 is often optimum. In no case should OMEGA exceed 2.0, because otherwise an unstable iteration results. For compressible flows OMEGA is set to 1.0. Also, it is recommended to use OMEGA=1.0 for incompressible flows when the time-step size is significantly below the convective stability limit. This may reduce a possible pressure noise in the solution. 

Incompressible Line Implicit SADI Method The previously described SOR iterative method for computing pressures is simple and works quite well for many problems. However, there are situations where the SOR method can be extremely slow to converge. For instance, meshes in which the cell size in one direction is much larger than in the other directions will 



 

 

exhibit slow convergence in that direction because the SOR pressure relaxation is limited by the smaller cell sizes in the transverse directions. A remedy for this type of slow convergence is to use a more implicit solution method in the direction of smaller cell sizes. For this purpose, a modified Alternating-Direction-Implicit (SADI) scheme was developed. SADI is based on a standard tridiagonal solver for pressures along an i, j, or k column of mesh cells. This solver is applicable to all boundary conditions including periodic boundaries. When periodic boundaries are used in the azimuthal direction in cylindrical coordinate system, it is recommended to use the ADI pressure solver –and only in that direction—by setting IADIY=1. This will help eliminate numerical noise in the pressure and velocity solution that can sometimes occur. Alternatively, turning off over-relaxation by setting OMEGA=1.0 may help to reduce the noise.  If the SADI method is used in the z-direction, the iteration consists of a sweep through all i and j indexes and for each (i, j) pair solving implicitly for the pressures in the k-index direction. Pressure values required in adjacent columns are always taken to be at their latest iterative values, a practice not always used with standard ADI methods, but one which improves convergence. The SADI method can be used in any combination of directions: any one, any two, or all three. This means that the more costly implicit sweeps can be limited to only those directions necessary to improve convergence of the overall iteration. When only one or two directions are treated implicitly, the over-relaxation between columns is controlled by the parameter OMEGA used in SOR over-relaxation. Generally, SADI is not too sensitive to this parameter, and the default value, OMEGA=1.7, is usually satisfactory. When SADI is used in all three directions, the parameter OMEGA has no effect, as the over-relaxation is fixed at its maximum value in that case. 
Compressible Solution Method For compressible flows, the cell pressure is determined by equating the continuity equation density to the density determined from the equation-of-state. Both SOR and SADI solutions to this equation are available. For both algorithms the iteration function used in Eq. (0.307) is defined as 
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+ = ⋅ + − ⋅    (0.313) Note that the equation-of-state density is not adjusted for energy changes from time level n to level n+1 caused by expansion or compression. Since the iteration is repeated every time step, the error made in not updating the energy is at most only one time step behind and is not significant for purposes of achieving time-step stability. The quantity δS/δp used in Eq. (0.307) requires the term DSDPU = δDTi,j,k/δpi,j,k, which is evaluated and stored once each cycle.  The SADI solution proceeds as in the incompressible case. The iteration function can still be treated as a tridiagonal system (retaining latest iterate values for p in the transverse directions). Convergence is reached in either case for all cells when 
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S EPSI t VFδ< ⋅ ⋅  (0.314) An option is provided in the SOR solution algorithm that is useful when the dependency of pressure on density in the equation of state is non-linear (achieved though a customization of the code). An inner iteration is implemented to vary the pressure within a cell to satisfy the condition of Eq. (0.314) before proceeding to the next cell. The user may specify the maximum number of inner iterations (IITMX) and the relaxation factor, OMEGA. OMEGA=1.0 is recommended if IITMX > 1. Specified velocity and specified pressure boundary conditions can create a uniform pressure change in the computational domain that is difficult to compute by either of the available iteration methods. For this situation an additional algorithm is provided in the compressible solution procedure to give a uniform global pressure adjustment. The option is activated by setting variable IPUN equal to 1. If IPUN=0, no uniform pressure change is evaluated. This uniform pressure adjustment is calculated by summing over cells the product of Si,j,k and the cell volume and dividing the result by the sum over cells of δS/δp times the cell volume. 

GMRES Pressure-Velocity Solvers New pressure-velocity solvers have been implemented in FLOW-3D (S.F. Ashby, T.A. Manteuffel and P.E. Saylor, 1990)(R. Barrett, 1994)(Saad, Y., 1996). GMRES stands for the generalized minimum residual method. In addition to the GMRES solver, a new optional algorithm—the generalized conjugate gradient (GCG) algorithm—has also been implemented for solving viscous terms in the new GMRES solver. This new solver is a highly accurate and efficient method for a wide range of problems. It possesses good convergence, symmetry and speed properties; however, it does use more memory than the SOR or SADI methods. The GMRES solver does not use any over- or under-relaxation. For more details on the methods used, a Flow Science technical note can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN68.pdf.  
Scalar Advection The compressible continuity equation, Eq. (0.1), fluid fraction equation, Eq.(0.17), internal energy equation, Eq.(0.19), and the turbulent energy and dissipation equations, Eqs. (0.238) and (0.243), all share the common form, in vector notation, 
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uA  (0.315) which is a scalar advection equation for the quantity Φ with a right-hand side, RHS, that may contain diffusion and source contributions. All five equations are represented by the same finite-difference algorithm with the advected quantity, Φ , located at mesh cell centers. As described below, an interface sharpening algorithm is used for the flux term ∇ (uAΦ ) for those quantities identified with specific fluid types. Apart from the density, energy, fluid fraction and turbulent transport equations, FLOW-3D has additional conservation equations, similar to Eq. (0.315), for arbitrary scalar quantities. These quantities can be used to describe the evolution of passive contaminants in the flow or could be employed to develop new physical models that require a transport equation, e.g., chemical reactions and time-dependent rheological model. It is important that all of the advected quantities associated with different fluids are proportional to the advected amount of fluid, δF (see Time Advancement of Fluid Configuration). Turbulence and arbitrary scalar quantities in two-fluid problems are not in this category because we assume these to be continuously distributed across two-fluid interfaces. 

Time Advancement of Fluid Configuration Scalar advection of the fluid fraction F is governed by Eq. (0.315). When Eq. (0.315) is integrated over a computational cell, the changes in F in a cell reduce to a sum of fluxes of F across the cell-faces. Special care, however, must be taken in computing these fluxes to preserve the sharp definition of fluid boundaries. The method employed here uses a type of Donor-Acceptor flux approximation. The essential idea is to use information about F downstream as well as upstream of a flux boundary to establish an approximate interface shape and then to use this shape in computing the flux. The basic method developed for use in the Volume-of-Fluid (VOF) technique, which is used here, may be understood by considering the amount of F to be fluxed in the x-direction through a cell-face during a time step of duration δt (C.W. Hirt and B.D. Nichols, 1981). The flux of volume crossing this face per unit cross-sectional area is L = uAxδt, where u is the normal velocity at the face and Ax is the area open to flow. The sign of u determines the donor and acceptor cells, i.e., the cells losing and gaining volume, respectively. For example, if u is positive, the upstream or left cell is the donor and the downstream or right cell the acceptor. The amount of F fluxed across the cell-face in one time step is defined as δF times the unobstructed face cross-sectional area (δy, δz), where 
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CF MAX F F L F F V xδ = − − −   (0.317) Single subscripts denote the acceptor (A) and donor (D) cells. The double subscript, AD, refers to either A or D, depending on the orientation of the interface relative to the direction of flow, as explained below. FDM is the maximum of FD and the F value in the next cell upstream of the donor cell. 



 

 

Briefly, the MIN feature in Eq. (0.316) prevents the fluxing of more F from the donor cell than it has to give, while the MAX feature accounts for an additional F flux, CF, if the amount of void (1-F) to be fluxed exceeds the void amount available. The series of figures below provides a pictorial explanation of Eq. (0.316). The donor and acceptor cells are defined in (a) of the figure below for fluxing across a vertical cell-face. When AD = D, the flux is an ordinary donor cell value, 
D

F F L= ⋅  (0.318) in which the F value in the donor cell is used to define that portion of the possible flow area exposed to fluid (see (b) in the figure below). Numerical stability requires that |L| be less than Vδx, so that it is not possible to empty the donor cell in this case. 

 Examples of free-surface shapes used in the advection of F. The donor-acceptor arrangement is shown in (a) where the dashed line indicated the left boundary of the total volume being advected. The shaded regions shown in (b-d) are the actual amounts of F fluxed. When AD=A, the value of F in the acceptor cell is used to define that portion of the flow area across which F is flowing. In (c) of the figure above, all the F fluid in the donor cell is fluxed because everything lying between the dashed line and the flux boundary moves into the acceptor cell. This is an example of the MIN test in Eq. (0.316). In (d) of the figure above, more F fluid than the amount FA|L|, must be fluxed, so this is an example of the MAX test. Whether the acceptor or donor cell is used depends on the mean surface orientation. The acceptor cell is used when the surface is advected in a direction normal to itself (as defined by the cell flag NF); otherwise, the donor cell value is used. However, if the acceptor cell is empty of F or if the cell upstream of the donor cell is empty, then the acceptor cell F value is used to determine the flux regardless of the orientation of the surface. This means that a donor cell must be nearly full before any F fluid can enter a downstream empty cell. The reason for testing on surface orientation is that an incorrect steepening of surface waves will occur if the acceptor cell is always used to compute fluxes. Consider, for example, a horizontal surface with a small 



 

 

wave moving in the positive x-direction. A flux based on the downstream (acceptor) value of F will eventually steepen the wave into a step discontinuity. In effect, the acceptor method is numerically unstable because it introduces a negative diffusion of F (i.e., a diffusion-like transport with a negative coefficient). Instabilities do not grow to unbounded values, however, because of the MIN and MAX tests used in the flux definition. On the other hand, when the surface is advecting normal to itself, a steepening that maintains the step-function character of F is exactly what is desired. Once the flux has been computed by the above method, it is multiplied by the flux boundary area to get the amount of F fluid to be subtracted from the donor cell and added to the acceptor cell. In this way the fluid volume defined by F is conserved. When the advection process is repeated for all cell boundaries in the mesh, the resulting F values correspond to the time-advanced values satisfying Eq. (0.17) and still sharply define all interfaces.  In practice, the definition of interfaces may deteriorate somewhat with time if the fluid motions are violent enough to cause repeated coalescence and breakup of surfaces, particularly if such processes occur on the scale of a cell size. Several tests for special cases have been incorporated into the basic F-advection routine described above to further improve its interface tracking ability. For free-surface problems, a mechanism has also been added to help close up partial voids (i.e., F values less than one) in interior fluid regions. Such regions sometimes appear when fluid surfaces impact on one another or on solid objects. This closure mechanism also helps mitigate pressure spikes during fluid impacts on obstacles. An input flag (IFPK) is used to enable or disable this option, which can only be used with free-surface problems having no void compressibility, RCSQV=0.0. In extreme cases of fluid breakup it may be necessary to add additional interface sharpening in order to preserve free-surfaces. The parameter IFPK is used to select this option too, although it is not recommended for general use, as it usually produces slightly more jagged free-surfaces. 
Other Scalar Advection The algorithm used for advecting F is extended to ρ and ρI for compressible flows. The interface location, and therefore the quantity of each fluid to be fluxed, is determined as described above. The flux of ρ (or ρI) is then easily calculated as 

1 2( )F L Fδ δ δΦ = Φ + − Φ  (0.319) or equivalently 
[ ]1 2(1 )Lδ η ηΦ = Φ + − Φ  (0.320) where 1Φ and 2Φ  are associated with the two fluids and η=δF/|L|. For turbulence quantities in two-fluid problems, which are distributed over both fluids, the flux is simply equal to Φ |L|. The second-order, monotonicity-preserving advection method described in Second-order Monotonicity Preserving Method can also be applied to the advection of the fluid fraction, F, density, r, and/or energy, I. 

Determining Surface Normals and Cell Flags For application of free-surface boundary conditions and advection of the F function, it is necessary to assign an approximate normal direction to the surface. The approximate normal in a surface cell is recorded by an integer value (assigned to array NF) that identifies the neighboring cell that is closest to the direction of the 



 

 

inward normal to the surface. This direction must point away from an empty neighbor cell. If the surface cell has more than one empty neighbor, then the direction selected is the one having the largest F value in the opposite neighbor cell. When surface tension forces are required, it is necessary to compute more accurate surface normals. For this purpose it is assumed that the boundary can be represented locally as a single-valued function X(y,z), or Y(x,z), or Z(x,y) depending on its orientation. If, for example, the approximate normal points in the z-direction, then the boundary is represented by Z(x,y) and we compute Z values for the five columns (i, j), (i  1, j), and (i, j  1). From these quantities, finite-difference approximations for δZ/δx and δZ /δy and the second derivatives needed for surface tension can be computed. The approximation used for Zi,j about level k is a sum over a three-cell column, 
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a zero value is used when there is a zero flow area between levels k-1 and k in any one of the five columns. This prescription is necessary in order to get reasonable estimates for surface slopes and curvatures in the vicinity of obstacles and baffles. 

Surface Location within a Cell Once the inward normal direction has been determined, the surface location is defined by a flat surface normal to this coordinate direction that extends to the proper height in the three-cell column. In practice, it is necessary to use a column height somewhat modified from that used in the derivative calculations. Measured from the center of the neighbor cell in the direction of the inward normal, the height is equal to the height of the fluid level in the surface cell plus one half of the height of fluid in the neighbor cell. This prescription ensures that the surface will lie above the neighbor cell center even if it is nearly empty. 
Cleanup of Misty Fluid Regions For some applications it is important to maintain smooth free-surface shapes to achieve good solution accuracy. For example, a poorly resolved or jagged free-surface may produce numerical “noise” in the evaluation of surface tension forces. These, in turn, could result in an even more jagged free-surface shape. These fluctuations may eventually lead to the creation of “misty” fluid regions in which small amounts of fluid are distributed across several adjacent mesh cells. Since the free-surface cannot be satisfactorily resolved in such regions, the accuracy of the surface tension solution deteriorates rapidly. Another example when “misty” regions can degrade the quality of the numerical solution occurs in flows with excessive splashing and free-surface breakup. Trying to follow the motion of small fluid droplets in all these regions may prove to be inefficient and is probably unnecessary. A provision has been made in FLOW-3D to avoid such situations by artificially removing fluid in “misty” regions (i.e., clean up the fluid distribution). This adjustment is controlled by the variable FCLEAN. Fluid in a cell is thrown away if the F value in it and in all adjacent cells is below FCLEAN. A typical value of FCLEAN is between 0.0 and 0.1. For two fluid problems with sharp interfaces, this procedure is applied to both fluids to maintain solution symmetry. 



 

 

The use of the cleanup algorithm is only recommended in problems with extreme free-surface deformations, where flow is largely controlled by conditions at the free-surface. Generally, its application results in only small errors in the total fluid volume (less than 1%) but yields accurate and efficient solutions. 
Bookkeeping Adjustments The new F values determined by the above method occasionally have values slightly less than zero or slightly greater than unity. Therefore, after the scalar advection calculations have been completed, a pass is made through the mesh to reset values of F less than zero back to zero, and values of F greater than one, back to one. Accumulated changes in fluid volume introduced by these adjustments during a calculation are recorded and printed out as VCHGT on long prints. The total fluid volume, VL, is also printed. There is one other adjustment needed in F so that it may be used as a boundary cell flag. Boundary cells have values of F lying between zero and one and have at least one empty cell as a neighbor. However, in a numerical solution, F values cannot be tested against exact numbers like zero and one because round off errors would cause spurious results. If, after advection, a cell has an F value less than εF , where εF is typically 10-6, this F is set to zero and all neighboring full cells become surface cells by having their F values reduced from unity by an amount 1.1 εF. These changes in F are also included in the accumulated volume change. Volume errors after hundreds of cycles are typically observed to less than one per cent of the total fluid volume. 
Diffusion Process, Heat Conduction and Heat Transfer 
Diffusion Process Internal viscous shear (that is, shear forces away from solid boundaries) and the diffusion of fluid fraction, fluid density, fluid energy density, turbulence energy, and turbulence dissipation are all treated in analogous ways by FLOW-3D. The diffusion coefficient for each process is proportional to the dynamic viscosity, μ, which may vary in space and time as a result of the turbulence models included in FLOW-3D or other models incorporated by the user. To account for this variation, all diffusion processes are formulated as the divergence of a flux rather than the more usual Laplacian form. The explicit difference techniques used for diffusion processes are fairly straightforward. Both the viscosity and the diffused quantity are evaluated from old time arrays. This leads to the stability requirements discussed in Stability Considerations. These limitations can be quite severe in some circumstances, where an implicit treatment of the viscous momentum diffusion terms is preferred (see Implicit Viscous Stress) The spatial differencing of scalar quantity diffusion is also quite straightforward. The flux across any mesh cell-face is evaluated as the first-order difference of cell-centered quantities on opposite sides of the face multiplied by an averaged product of diffusion coefficients and cell-face area fractions. The spatial differencing of viscous stress is necessarily more complicated due to its vector nature. Briefly, we apply first-order differences to velocity components to obtain local shear rates, then multiply by averaged products of viscosity and cell-face area fractions. The results are then differenced to approximate the net viscous stress. All quantities are evaluated explicitly in these calculations. 
Heat Conduction and Heat Transfer Thermal conduction and heat transfer terms appear in both the fluid energy density equation, Eq.(0.19), and the solid temperature equation, Eq.(0.36). These terms are treated in analogous ways by FLOW-3D and include two optional implicit formulations to eliminate associated time-step stability limits. This 



 

 

approximation is included because there are often large differences in the time scales associated with these thermal processes and the time scale of the fluid flow itself, particularly in steady and quasi-steady situations (see Implicit Viscous Stress). To display the approach used, consider a reformulated analog of Eq.(0.19), 
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∑  (0.323) where T represents the fluid temperature, TW the solid temperature, h a heat transfer coefficient, WA an interfacial area, A, a cell-face area, k, an averaged heat conduction coefficient, and ∆ , an appropriate spatial increment. All terms on the right side of Eq. (0.323) are evaluated at the "old" time level, tn, meaning that an explicit approximation is used for the heat fluxes. The explicit algorithm implies a time-step size stability limit (see Stability Considerations). Note that the explicit approximation conserves energy because the same difference is used on both sides of any cell-face. 

Implicit Viscous Stress and Heat Flux Approximations Since the minimum time-step size required for the numerical stability of the explicit viscous and heat diffusion approximations is estimated over the whole mesh, it is clear that this time-step size limitation could sometimes be too severe to allow an efficient numerical solution. This may be the case in highly distorted meshes where the time-step size is controlled by the stability limit in the smallest cell, even though the variables may not be changing in this region. Since the minimum time-step size required for the numerical stability of the explicit viscous diffusion approximations is estimated over the whole mesh, it is clear that this time-step size limitation can potentially be too severe for highly viscous flows to allow for an efficient numerical simulation. Two implicit solvers have been developed to alleviate the problem. The first one employs a Jacobi iteration method for the implicit terms in the momentum equations. The second method is based on the ADI method. To illustrate these methods, we will simplify the momentum and continuity equations presented earlier Eqs. (0.268), (0.269), (0.270) and (0.305) by omitting the area and volume fractions and assuming Cartesian two-dimensional geometry. For an incompressible fluid with constant viscosity, the flow equations are discretized in a uniform (for simplicity) grid as follows 
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+ =  (0.325) Here i and j are cell indexes in the x and y directions, δx and δy cell spacings, and FUX, FUY, FVX and FVY are the momentum advection terms described in Momentum Equation Approximations. The wall shear stresses are assumed to be linear with respect to velocity, with coefficients wx and wy, and fx and fy include all other forces acting on the fluid. The terms with the superscript n are evaluated explicitly using the solution at time tn. The superscript n+1 denotes terms evaluated implicitly at time tn+1 = tn + δt. Since Eqs. (0.324) and (0.325) are coupled between each other and to the variables in the neighboring cells, an iterative solution method must be employed to obtain solution for ui,j, vi,jand pi,j for all 0<i<Nx+1, 0<j<Ny+1. Two iteration loops are defined in the Jacobi iteration method: one for the viscous terms in the momentum equations, and the other for pressure using the continuity equation. The second iteration loop is similar to the one described in Pressure Solution Algorithm. Full-pressure convergence is obtained after each viscous iteration. In other words, each viscous iteration generally requires many pressure iterations (the average pressure iteration number over all viscous iterations at a given time step is then computed for the diagnostics output). At each viscous iteration kv+1 the momentum equations are solved for the diagonal implicit terms ui,j and vi,j (for kv=1 the solution from the previous time step is used): 
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Here u* and v* include all respective explicit terms in Eqs. (0.324). Substituting the kv+1 level velocity from Eq. (0.326) into Eq. (0.325) yields an equation for pressure. Similar to the standard SOR method described in Pressure Solution Algorithm, a pressure adjustment is made in each control volume to satisfy the zero-divergence condition 
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where S is the left-hand side of Eq. (0.325), ω is the relaxation factor defined by the input parameter OMEGA, and kp is the pressure iteration number. The corresponding adjustments of pressure and velocity components differ from those given in Eq. (0.309) in that Dx and Dy are present in the equations: 
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+ + +  (0.329) After pressure iterations are completed for a given viscous iteration kv, the converged solution is used to solve Eq. (0.326) for the next viscous iteration kv+1. The solution is converged when both viscous and pressure iterations have converged. The convergence criterion for the pressure iterations, EPSI, is the same as for the explicit viscous algorithm. EPSI is generally a 



 

 

function of the time-step size. An additional multiplier for EPSI, EPSADJ, can be used to tighten (EPSADJ < 1.0) or loosen (EPSADJ > 1.0) convergence. The default value of EPSADJ is 1.0. The viscous iterations are deemed converged when the normalized velocity change between successive iterations does not exceed 0.01 x EPSI. An additional multiplier, EPSVIS, can be used to tighten or loosen convergence. The default value of EPSVIS is 1.0. An under-relaxation factor OMEGVS is used in Eq. (0.326) to improve convergence of the viscous iterations. The default value of OMEGVS for the Jacobi iteration method is 0.9. This method is activated when IMPVIS=1. In the ADI solver, momentum and pressure equations are solved together within the same iteration. There is no division into separate pressure and velocity iterations. At iteration k+1 a pass is made through the grid to evaluate δp using velocities from the previous iteration k: 
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where the denominator is evaluated from Eq. (0.329) and Dx and Dy defined in Eq. (0.326). Note that ω in Eq. (0.330) defaults to 1.0. It is not recommended to use values greater than 1.0. Then the momentum equations are solved with the latest pressures from Eq. (0.330), employing a tridiagonal matrix solver. First, a pass is made in the x-direction using the k-th level velocity components to evaluate the y-derivatives: 
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Equations (0.331) are solved for the terms with superscript k+1. A pass is then made in the y-direction using the velocity components from the x-direction pass to evaluate the x-direction derivatives. A pass in the z-direction is added in three-dimensional problems. Over-relaxation can also be used in this method, but OMEGVS currently defaults to 1.0 to minimize numerical noise. Time level n velocities are used as the first guess for the iteration process. The solution is converged when the continuity equation residual is smaller than EPSI everywhere in the grid, and the normalized momentum equation residual is less than 1.0-8  x EPSVIS. EPSVIS is an input variable with the default value of 1.0. The momentum equation residual (in the x-direction) is normalized by the maximum of 1

, ,

n

i j xi j
u D

+ and the modulus of the right-hand side of Eq. (0.331). The ADI iteration method is activated by setting IMPVIS=2. It converges faster and gives a more accurate solution than the Jacobi method in cases when viscous friction is a dominant force. This will apply to highly viscous flows of semi-solid metals, polymers and amorphous materials, when the simulation would typically run at a time-step size a few orders of magnitude above the viscous stability limit. 



 

 

The Jacobi method is more efficient than the ADI solver in pressure-driven flows, in which viscous stresses are secondary to pressure forces and the time-step size is only a couple orders of magnitude above the viscous stability limit. An ADI iteration method is used for the solution of the thermal energy equation, which is solved simultaneously in fluid and obstacles. An over-relaxation procedure employed in this iteration algorithm improves the rate of convergence. The degree of over-relaxation is controlled by OMEGHT, with the default set for an optimum convergence. Iterations are considered converged when the maximum residual of the energy equation normalized by temperature is less than EPSIHT=1.0e-04 x EPSHTC. The default value for EPSHTC is 1.0. The convergence criteria in both thermal and viscous solutions are set automatically during a calculation and may vary from time step to time step. The implicit viscous option cannot be used in conjunction with turbulence models because those models involve other kinds of diffusive processes that are not treated implicitly. The implicit solution method eliminates the restrictions imposed on δt by conduction and heat transfer processes. The following remarks, however, may be useful to realize the differences between explicit and implicit approximations. The maximum time-step size that ensures a numerically stable transient explicit solution can be interpreted as a period of time over which a heat wave propagates in space by no more than one cell. When larger time steps are used in the implicit algorithms, these waves are allowed to travel farther in one time step. Over that period of time, several heat waves may pass through the same location in the flow, therefore fluid energy and temperature at this location may experience a complicated transient behavior over that same period of time. However, the temporal partial derivative in the energy equation is approximated with a first-order differencing scheme, which effectively assumes linear energy variation during one time step. Therefore the use of large time steps in the implicit scheme leads to smoothing, or diffusing, of the solution, and to a certain loss of accuracy in the transient solution. In FLOW-3D the size of the time step for the implicit solution is controlled automatically to ensure accuracy and efficiency of the implicit solution. The time-step size is adjusted so that the number of iterations does not exceed IDTHT (default is 20). 
Boundary Conditions In addition to the free-surface pressure boundary condition described earlier (see Eq. (0.310)), it is also necessary to set conditions at all mesh boundaries and at surfaces of all internal obstacles. 
Free-Slip vs. Non-Slip Boundaries As a general rule all rigid and free boundary surfaces are treated as free-slip boundaries -- that is, as surfaces having zero tangential stresses. This condition is imposed by setting to zero all velocity derivatives that are computed using one or more velocity components from cell-faces having a zero flow area (or a face outside the fluid in free-surface problems). No-slip conditions are imposed using the wall shear-stress options described in the Prandtl mixing length model. At mesh boundaries a symmetry condition can be specified such that free-slip conditions will be used there even when the wall shear-stress option is requested. 



 

 

At mesh boundaries it is also possible to have a non-zero tangential wall velocity. This option is useful for various types of sliding wall and spinning container problems. 
Mesh Boundaries At the mesh boundaries a variety of conditions may be set using the layer of fictitious cells surrounding the mesh. Consider, for example, the boundary separating the i=1 and i=2 layer of cells. The i=1 cells are fictitious in the sense that variable values are set, not calculated, in these cells to satisfy boundary conditions. If this boundary is to be a rigid wall, the normal velocity there must be zero. The tangential velocity can be set to any value for a no-slip type of wall. Thus, for a rigid wall the boundary conditions are, for all j, k 
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Free-slip conditions are set automatically by ensuring that all velocity derivatives across the wall are zero. No-slip wall conditions, including specified wall velocities, are imposed through the wall shear-stress model described earlier. Conditions given by Eq. (0.332) are imposed on the velocities obtained from the momentum equations and after each pass through the mesh during the pressure iteration. At fixed velocity or fixed pressure boundaries one must specify inflow values for F and T, tangential velocities and the normal velocity for the former, or pressure for the latter type of boundary condition. These may be specified as time-dependent functions for each edge of the computational mesh. It is important to note that scalar quantities are defined at the centers of the boundary cells which are half a cell away from the actual mesh boundary location. This affects the gradients of these quantities near the boundaries, which may be especially important for temperature and pressure calculations. The same applies to the tangential velocities at all open mesh boundaries (for the wall type boundaries the tangential velocities are defined at the edge of the boundary itself). Of course, the normal boundary velocities are always set at the edge of the boundary. Time-independent boundary conditions are set using input variables UBC(M), VBC(M), WBC(M), PBC(M), FBC(M) and TBC(M). Time-dependent boundary condition values are specified through the tables: UBCT(N,M), VBCT(N,M), WBCT(N,M), PBCT(N,M), FBCT(N,M) and TBCT(N,M). The TIMBCT(N) specifies the time at which the other values with the same first index N begin. Values are interpolated at intermediate times. Subscript M specifies the boundary location as follows M  1 left boundary (minimum x) 2 right boundary (maximum x) 3 front boundary (minimum y) 4 back boundary (maximum y) 



 

 

5 bottom boundary (minimum z), 6 top boundary (maximum z) Fixed pressure boundaries are treated somewhat differently from the fixed velocity case. When a fixed pressure boundary is requested, the mesh generator creates one additional layer of boundary mesh cells in which the pressures are defined. Three types of specified pressures are possible. If the pressure is the local static pressure, then across this extra layer of cells, zero velocity-derivative conditions are imposed similar to the continuative condition described next. If the pressure is an upstream stagnation pressure, then a zero normal velocity is imposed at the mesh boundary to approximate stagnation conditions. Finally, a hydrostatic pressure distribution in one of the coordinate directions may be imposed for incompressible problems. Continuative outflow boundaries, where fluid is to flow smoothly out of the mesh causing no upstream effects, are always a problem for low speed or incompressible flow calculations. Potentially, any prescription can affect the entire flow field. In FLOW-3D, the continuative boundary conditions used at the i=1 boundary, when the flow is directed out of the computational domain, are the vanishing of all normal derivatives, which are (for all j, k) 
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These conditions, however, are only imposed after applying the momentum equations and not after each pass through the pressure iteration. Omitting these conditions during the pressure adjustment provides additional "softness" at the boundary that helps to minimize upstream effects. If the flow at a continuative boundary is directed into the computational domain, then all conditions given by Eq. (0.333) are applied except for the normal velocity component, which is set to zero to make inward flow more difficult. When using the continuative boundary condition, the user should be careful to ensure that it is adequate for his purposes. In general, it should not be trusted if there is a significant flow entering a grid at this type of boundary (see discussion below). For periodic boundary conditions in the x-direction, both the i=1 and i=IMAX boundaries must be set to reflect the periodicity. This is most easily done when the period length is chosen equal to the distance from the boundary between the i=1 and 2 cells to the boundary between the i=IMAX-2 and IMAX-1 cells. That is, two layers of cells, i=IMAX and i=IMAX-1, are reserved for setting periodic boundary conditions at the far side of the mesh. The mesh generator automatically accounts for this extra layer of cells and requires no special considerations on the part of the user. The conditions for periodic flow in the x-direction are then, at i=1 for all j, k 
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and, for all j, k 
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where IM1=IMAX-1 and IM2=IMAX-2. These conditions are imposed on velocities computed from the momentum equations and after each pressure iteration. Boundary conditions similar to these are used at all other mesh boundaries. Of course, the appropriate normal and tangential velocities must be used in each case. At fixed pressure boundaries the user has the option of setting either the static pressure, PBC = p, or the full (stagnation) pressure, PBC = p + ρ u2/2. The choice is made by using the input variable PBCTYP (see discussion below). For convenience to the user, the program has been written so that any of the above boundary conditions can be imposed by setting input numbers. For example, for the i=1 boundary the quantity WL is an integer set according to the table: WL Boundary Condition 1 Symmetry plane 2 Rigid, no slip wall, if IWSH=1 3 Continuative 4 Periodic in x 5 Specified pressure 6 Specified velocity 



 

 

7 Grid Overlay (GO) boundary 8 Outflow In a similar fashion, the other boundaries are controlled by the input parameters, Parameter Mesh Boundary WL i=1 WR I=IMAX WF j=1 WBK j=JMAX WB k=1 WT k=KMAX Other special conditions may be added by the user in the location reserved for this purpose at the end of boundary condition subroutine (BC). Pressure Boundary Conditions The ability to specify a pressure condition at one or more boundaries of a computational region is an important and useful computational tool. Pressure boundaries represent such things as confined reservoirs of fluid, ambient laboratory conditions, and applied pressures arising from mechanical devices. Generally, a pressure condition cannot be used at a boundary where velocities are also specified, because velocities are influenced by pressure gradients. The only exception is when pressures are necessary to specify the fluid properties, e.g., density crossing a boundary through an equation-of-state. There are typically two types of pressure conditions, referred to as static or stagnation pressure conditions. In a static condition, the pressure is more or less continuous across the boundary and the velocity at the boundary is assigned a value based on a zero normal-derivative condition across the boundary. In contrast, a stagnation pressure condition assumes stagnation conditions outside the boundary so that the velocity upstream from the boundary is zero. This assumption requires a pressure drop across the boundary for flow to enter the computational region. Since the static pressure condition says nothing about fluid velocities outside the boundary (other than it is supposed to be the same as the velocity at the boundary), it is less specific than the stagnation pressure condition. In this sense the stagnation pressure condition is generally more physical and is recommended for most applications. As an example, consider the problem of flow in a section of a pipe. If the upstream end of the computational region coincides with the physical entrance to the pipe, then a stagnation condition should be used to represent the external ambient conditions as a large reservoir of stationary fluid. On the other hand, if the upstream boundary of the computing region is inside the pipe, and many diameters away from the entrance, then the static pressure condition would be a more reasonable approximation to the flow conditions at that location. 



 

 

Continuative Boundary Conditions In many simulations there is a need to have fluid flow out one or more boundaries of the computational domain. At such "outflow" boundaries the question arises of what constitutes a good boundary condition. In compressible flows, when the flow speed at the outflow boundary is supersonic, it makes little difference how the boundary conditions are specified, since flow disturbances cannot propagate upstream. In low speed and incompressible flows, however, disturbances introduced at an outflow boundary can have an effect on the entire computational region. It is this possibility that is discussed below. The simplest and most commonly used outflow condition is that of a "continuative" boundary. A continuative boundary condition consists of zero normal derivatives at the boundary for all quantities. The zero-derivative condition is intended to represent a smooth continuation of the flow through the boundary. It must be stressed that the continuative boundary condition has no physical basis; rather, it is a mathematical statement that may or may not provide the desired flow behavior. In particular, if flow is observed to enter the computational region across such a boundary, then the computations may be wrong because nothing has been specified about flow conditions existing outside the boundary. In FLOW-3D, a special enhancement to continuative boundaries is used to improve their behavior. If flow attempts to enter the computational region across this type of boundary it must do so by starting from condition of rest. This practice helps to reduce inflow and often results in a reasonable approximation of a smooth outflow condition. Nevertheless, a continuative boundary condition must always be viewed with suspicion. As a general rule, a physically meaningful boundary condition, such as a specified pressure condition, should be used at outflow boundaries whenever possible. When a continuative condition must be used, it should be placed as far from the main flow region as is practical so that any adverse influence on the main flow will be minimal. Outflow Boundary Conditions Better outflow boundary conditions exist for some classes of flow problems. For example, for wave propagation problems, special boundary treatments have been devised that try to determine the speed and direction of waves approaching the boundary and then set boundary conditions in such a way as to allow their continuation through the boundary with a minimum of reflection. An early and useful example of this type of treatment, sometime called a radiation boundary condition, is described by (Orlanski, 1976). The outflow boundary condition allows users to numerically investigate the effects of wave interactions with structures. This capability permits a reduction in the extent of the computing mesh needed for accurate computations. Open boundaries in low-speed flow calculations are difficult to define because they can, in principle, influence the entire computational region. For wave propagation problems, it is natural to seek a boundary condition that will allow outgoing waves to smoothly leave the computational mesh with minimum reflection. This problem is analogous to wave absorption in experimental wave tanks, where one wants to eliminate the reflection of waves from the downstream end of the tank. In these tanks a variety of techniques are used, but nearly all of them employ some sort of energy dissipation (e.g., porous beaches). 



 

 

Regardless of the method employed, the length of absorption must be at least as long as the longest waves to be trapped. In a computational wave tank, we are not limited by physical dimensions, so we can imagine a mathematical continuation of the flow in the tank beyond the end of the computed region. This is the spirit of the Sommerfeld radiation boundary condition, which is a simple mathematical continuation having the form of outgoing waves: 
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∂ ∂  (0.336) where Q is any quantity, positive x is directed out of the boundary and c is the local phase speed of the assumed wavelike flow.  To use this idea as a boundary condition, the flow should consist of wavelike disturbances that are propagating toward the boundary. The waves don't have to be directed normal to the boundary, they don't have to be linear, and no assumption about wavelength is necessary. The mathematical expression in Eq. (0.336) is simply a statement that any flow quantity Q at the boundary will translate across the boundary with speed c. If there is no time variation, this condition reduces to the "continuative" boundary condition of zero normal derivative. To use Eq. (0.336) as a basis for an "outflow" boundary condition in a three-dimensional computation, we must apply it to every flow variable at every location on the outflow boundary. The phase speed c is unlikely to be a constant because different quantities will be moving in different directions (e.g., surface waves don't move with the same velocity as a fluid particle) and waves may strike a boundary at different times from different directions. To account for this, we make a further assumption that Eq. (0.336) is not only valid at the boundary, but also at one control volume removed from the boundary. The phase speed c is assumed to have the same value at both locations. This assumption allows us to use numerical approximations for Eq. (0.336) at two locations: one to determine the value of c and the other to compute a boundary value for the quantity Q. The outflow boundary condition can be used for incompressible fluid flows that are confined or have free-surfaces. It can also be used for fully compressible flows. Equation (0.336) is a first-order wave equation that describes wave propagation in the positive x-direction. Because it is first-order, it requires only one initial condition to specify a starting condition. In contrast, a second-order wave equation requires two initial conditions and can have waves propagating in both the positive and negative directions. The restriction to a first-order expression simplifies the implementation of the condition in the FLOW-3D computer program because it requires no additional storage for more time levels of information at the boundary. The outflow boundary condition used in FLOW-3D will be illustrated in terms of the right (maximum x) boundary of the computational region. Let i be the index of the spatial location on or outside the boundary where we need a value of some quantity q. This value is the boundary condition we are seeking. We assume  
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q is a known value of q at this point at time level n. This value may have been used to compute n+1 time-level quantities in the interior of the grid. What we are seeking, then, is a condition that will give us the next value, 1n
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+ , which is needed to begin the next cycle of computation. 



 

 

We begin with a second-order (in space and time) difference approximation for the Sommerfeld condition, Eq. (0.336), 
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   (0.337) The first two terms are time derivatives centered about n+1/2. One term is at location i and the other at i-1, so their average is centered about x location i-1/2. The last term contains an average of two x-derivatives centered about i-1/2 at times n and n+1. This term is also centered about i-1/2 and n+1/2. In this expression we have assumed constant grid spacing, δx, and time interval, δt. Rearranging this expression, 
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= . Next we rewrite Eq. (0.338) by shifting the i index one node to the left and solve for the coefficient involving C, which gives us the prescription for the phase speed, or in this case, a function of the phase speed, 
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+ −  (0.339) Substituting the expression in Eq. (0.339) into Eq. (0.338) gives the needed boundary value for 1n

i
q

+ . In order to use this expression, however, there are two limiting cases that must be considered. Because we are only interested in outgoing waves and want to suppress incoming flow, the value of the non-dimensional phase speed C must not be negative. Furthermore, computational stability requires that C be less than or equal to unity. This completes the specification of the outflow boundary condition: it is Eqs. (0.338) and (0.339) with the restrictions given by  
0 1C≤ ≤  (0.340) Note that any Fourier wave with a component in the x-direction, and arbitrary phase speed c, is a solution of Eq. (0.338) and exhibits no damping. 
Periodic Linear Wave Generator  A periodic, linear, surface wave can be generated at a mesh boundary. The model is based on Airy's linear wave theory (G.B. Airy, 1845). As shown in the figure below, the linear wave is assumed to come from a flat bottom reservoir into the computational domain. A linear wave is characterized by the wave amplitude A, wavelength λ, angular frequency ω and wave number k=2π/λ. A uniform current may also exist, and its undisturbed velocity component in the wave propagation direction is U=const. For the equations in this section, a reference system (x, z) is established with its origin fixed at the mean free surface, +x going in the wave propagation direction and +z in the upward direction (when using the code, users can place the coordinate origin at any location but +z must be in the upward direction).  



 

 

 Schematic diagram showing a linear wave coming from a flat bottom reservoir on the right into the computational domain through the mesh boundary  The linear wave theory is based on the following assumptions:  
� fluid is incompressible, inviscid, irrational, two-dimensional flow; 
� the wave amplitude (A) is small compared to the water depth (h) and wavelength (λ). With the above assumptions, the problem can be reduced to a linear potential flow problem. Please refer to (H. Lamb, 1945) and (R. G. Dean and R. A. Dalrymple, 2008) for more details. The free surface elevation η(x,t) measured in the vertical direction from mean water surface, the velocity potential ( , , )x z tϕ , and velocity components in x and z directions ( , , )u x z t and  ( , , )w x z t are obtained as 
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=  where φ is the phase shift angle, t is time, and h is the mean depth of the fluid. The dispersion equation in terms of wave speed c = ω/k is given by  
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This relationship indicates that the wave frequency and wave length are not independent but are related: 
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   Users can specify either wave frequency or wave length; the other quantity is then calculated by the dispersion equation. The linear wave theory assumes a flat bottom reservoir and this assumption is required to generate the wave at the mesh boundary. Once the wave enters the computational domain, the bottom surface no longer needs to be flat, and flow can be inviscid, laminar or turbulent, in which case the wave may deviate from the analytical solution given by the equations above. Since the full Navier-Stokes equations are solved inside the domain, nonlinear effects can develop. An irregular or random wave can also be simulated by defining multiple linear wave components with different wave amplitudes, frequencies, and initial phases at a mesh boundary. These wave components are superimposed at the boundary and propagates into the domain to form the desired wave (irregular or random wave). 
Stokes Wave Generator A fifth-order Stokes wave can be generated at a mesh boundary. The model is based on the fifth-order Stokes wave theory developed by (Fenton, J. D., 1985). Different from the linear (Airy) wave theory for small-amplitude progressive surface waves, the Stokes wave theory is a nonlinear theory for limited-amplitude progressive surface waves. It allows higher wave amplitude than the linear wave theory. 

 Stokes wave entering the left side of a computational domain from a reservoir with flat bottom. As shown in the figure above, a wave train is assumed to come from a flat bottom reservoir into the computational domain through the mesh boundary. The reference system (x, z) is established with its origin fixed at the bottom, +x going in the wave propagation direction and +z in the upward direction. The wave is 



 

 

characterized by the wave height H (measured vertically from trough to peak), wavelength λ and wave period T. The undisturbed water depth is d=const. Water elevation η is time-dependent and measured along +z from the bottom to the water surface. A current may exist and its x-component of undisturbed velocity is U=const. The angular wave frequency ω and the wave speed c in (x, z) system are related to other parameters as  
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2k π λ=  The Stokes wave theory assumes potential flow, namely the fluid flow is incompressible and irrotational. The stream function ψ  thus exists and satisfies the Laplace equation 
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∂  With the further assumption that a wave crest exists at x=0 at t=0, the Laplace equation for ψ, along with its boundary conditions at the free surface and the bottom, are solved using a perturbation method. The perturbation parameter is the dimensionless wave amplitude 2kHε = , also known as the wave steepness. The solution for the water elevation and velocity with fifth-order accuracy with respect to ε is 
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∑ ∑  where X x ct= − , or kX kx tω= − . The coefficient Aij, Bij and C0 are nonlinear functions of kd and are presented in Fenton (1985). It is found that the linear wave theory is the first-order approximation of the Stokes theory. In other words, the fifth-order Stokes theory is four-orders of ε higher in accuracy than the linear wave theory.  



 

 

The wave number and wave frequency are not independent parameters but satisfy the nonlinear equation 
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      where C0, C2 and C4 are nonlinear functions of kd  (Fenton, J. D., 1985). It can be found that the dispersion equation for linear wave is the first-order approximation of this relation without considering the last two terms at the left-hand side. As a result of this relation, when generating wave at a mesh boundary, the users cannot provide both wave length and wave period as input parameters at the same time. If a wave length is given, then the wave period (or wave frequency) is obtained easily from this equation. If wave period is known, however, the wave length (or wave number) is calculated from the above equation iteratively. The first approximation of k used in the iterations is(Fenton, J. D., 1988). 
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d gα ω=  and cothβ α α= . This theory is applicable to waves in both deep and shallow water, but restrictions exist. The parameter ε must be a small number, namely the wave’s steepness must be small. Furthermore, the theory cannot work for waves that are long compared to the water depth. A reasonable upper limit for the wave length is  
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10T g d dλ≈ ≈  (Fenton, J. D., 1985). Beyond this limit, other theories (e.g., a cnoidal theory or a solitary wave theory) should be used. Finally, this theory is not valid for breaking waves. Users can also follow the figure below (Le Méhauté, B., 1976), (U.S. Army Corps of Engineers, 2006) for the applicability ranges for linear wave, Stokes wave and other wave theories. When modeling a single wave train, it is recommended that the fifth-order Stokes theory be used whenever the linear or Stokes wave theory (first to fifth order) is valid due to its higher-order of accuracy. Waves in FLOW-3D are generated at mesh boundaries. After entering the computational domain, a wave may transform to any type of wave with or without breaking. Once the wave enters the computational domain, the bottom no longer needs to be flat, and flow can be inviscid, laminar or turbulent, in which case the wave may deviate from the analytical solution given by the equations above. The wave may also break inside the computational domain.  



 

 

 Applicability ranges of various wave theories ((Le Méhauté, B., 1976), (U.S. Army Corps of Engineers, 2006). 
Turbulence Model Boundary Conditions At all boundaries, except for rigid no-slip boundaries, the turbulence energy and dissipation functions are treated as analogous to other cell-centered quantities such as density. At symmetry boundaries no special conditions are needed, as there are zero velocity derivatives across the boundary, and hence zero turbulence production. Also, there is a zero flow area that automatically ensures no advective or diffusive fluxes. At rigid, no-slip boundaries, special considerations are necessary because numerical resolution is usually too coarse to resolve details of a laminar boundary layer region. The wall shear-stress model based on a turbulent (power law) velocity profile has already been discussed (see Prandtl Mixing Length Model). To be consistent with this, it is necessary to define wall boundary values for the turbulence energy and turbulence dissipation functions.  



 

 

Within the context of the FAVOR™ method, in which rigid walls may cut at any angle through a mesh cell, it is not obvious how these boundary conditions are to be satisfied. We have elected to use the following procedure.  The turbulence energy and dissipation values are set in all cells having one or more faces partially or wholly blocked by a no-slip, rigid boundary. Wall boundary values are deduced from the assumed velocity profile (logarithmic law approximation) and the assumption of a local equilibrium between turbulent production and decay processes. Prandtl Mixing Length Model describes the method by which this is accomplished, which includes an approximate treatment for wall orientation and multiple wall effects. 
Free-Surface Boundaries The normal stress, i.e., specified pressure, condition at a free surface is satisfied by the pressure setting scheme described in Incompressible SOR Method. (Free-surface boundary conditions only exist in single fluid problems.) Tangential stresses at a free-surface are zero because all velocity derivatives that involve velocity components outside the surface are set to zero. Velocities must be set on every cell boundary between a surface cell and an empty cell, however, to correctly account for fluid advection. This is done in two steps. First, every velocity component on a face adjacent to an empty cell is set equal to the value on the opposite face of the surface cell. If the faces opposite one another are both adjacent to empty cells, then the velocity set at these faces is the average of the two values previously defined there. In the second step, a virtual pressure adjustment is made to the surface cell that attempts to drive the velocity divergence of the cell toward zero. Only velocities on sides open to empty cells are adjusted in this process. The cell's velocity divergence may not actually be driven to zero because the adjustment is also proportional to the fractional amount of fluid in the cell. This procedure improves momentum distribution at free-surfaces and eliminates spurious velocity components that we occasionally observed in previous algorithms. Advective fluxes of turbulent quantities and all diffusive fluxes into empty cells are set to zero since there is no fluid in those cells to either supply or receive the fluxed quantities. In applying the above boundary conditions, care is taken to keep the flow consistent with internal obstacles. 
Internal Obstacle Boundaries The definition of obstacles within a mesh is accomplished by defining the fractional cell areas and volumes of these cells partially occupied by obstacles (the FAVOR™ method) and by flagging those mesh cells that are entirely occupied by obstacles. The quantity chosen as a flag is the volume fraction VFijk. When this quantity is zero, the cell is entirely within an obstacle and all fluid calculations in the cell are eliminated. All interior fractional areas/volumes initially default to unity corresponding to a fully open mesh. The fractional areas of mesh boundaries defined to be rigid free-slip or no-slip walls are automatically set to zero. When obstacles are defined in the input file, using the FLOW-3D geometry builder or STL data, the area/volume fractions are automatically calculated before the hydrodynamic calculations are carried out. In the program no velocities or pressures are computed in full obstacle cells, and all velocity components on faces of obstacle cells are automatically set to zero. 



 

 

Because of the formulation of the viscous stresses, which include fractional areas, all internal obstacles and mesh boundaries are represented as free-slip boundaries in the basic stress tensor. However, no-slip effects have been added separately, as previously mentioned, through the wall shear-stress algorithm. 
Surface Tension with Wall Adhesion Surface tension effects are included in calculations by defining the surface tension coefficient SIGMA (units are force per unit length). It can be used in one fluid-flows with free-surface or two-fluid problems with sharp interface between them. Wall adhesion is controlled by the contact angle, CANGLE, in degrees. This is the angle in the fluid between the wall tangent and the fluid surface tangent. To compute the net surface tension force acting on a surface cell, we view the cell as a control volume and calculate the net surface tension stresses acting at the sides of the cell. We assume that surface tension forces can be replaced by an equivalent surface pressure. To be specific, suppose the inward surface normal is pointing in the negative z-direction (i.e., NF=5). The surface tension stresses acting on fluid across the cell-faces normal to the x and y directions will, in general, have components in all three coordinate directions. In terms of an equivalent surface pressure, these forces must be equal to this pressure times the projected surface area in each coordinate direction. In the z-direction, in particular, it is assumed that the projected area is the entire cell cross-sectional area (δxδy) because the surface normal is principally in the z-direction. The equivalent surface pressure is, therefore, the net z-direction force divided by this area. To compute the net z-direction force, consider first the cell-face located in the positive x-direction. Surface tension forces act tangent to the surface and can be resolved into components directed along two principal tangent directions. We select one tangent to lie in the cell-face so that forces in this direction do not contribute to the net force across the face. It is the force in the direction of the second principal tangent that we must calculate. The z-direction component of this force can be shown to be 
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∫  (0.341) where σ is the surface tension coefficient, θ is the angle of the second principal tangent with respect to the z axis, and φ is the angle of the first principal tangent with respect to the y axis. The factor dy/cos(φ) is the length of the surface intersecting the cell-face and must be included because σ is a force per unit length. Estimates of θ and φ are computed from the columnar sums described earlier (see Surface Location within a Cell). In this case (NF=5) the appropriate sums are the Z(x,y) quantities. At cell-faces perpendicular to the x-axis we have approximately, 
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At faces perpendicular to the y-axis, the two angles are interchanged because the force integrations are with respect to x. For other NF values suitable changes must be made in the x, y, and z direction quantities used in these prescriptions. When wall boundaries are present, an additional modification is necessary. For instance, if a wall intersects the cell-face where the stresses in Eq. (0.342) are computed, these stresses are multiplied by the fraction of the face open to flow. For the remaining (closed) area fraction, we assume the fluid adheres to the wall with the contact angle, CANGLE. Stresses associated with this wall adhesion are given by Eq. (0.341) in which θ is replaced by CANGLE and the contribution is multiplied by the wall area fraction. The evaluation of the force arising from wall adhesion takes into account the slope of the wall. 
Stability Considerations There are several restrictions on time-step size in FLOW-3D that must be observed to avoid numerical instabilities. If the user requests the automatic time-step selection in the input data, the code will adjust the time step to be as large as possible without violating stability conditions or exceeding the user-supplied maximum time-step size. Time-step size will also be reduced when pressure and/or temperature iterations exceed corresponding nominal values that depend on the iteration options. Generally, the time step will float up or down with 5% changes per cycle unless a stability condition is violated, in which case a larger reduction may occur. It is recommended that the automatic time-step option be used whenever possible to achieve optimum results. The time-step size can also be changed, even if a constant value has been requested, when the fluid fraction advection exceeds an amount equal to twice the volume of the cell times the stability factor CON (or 0.85 times the volume of the cell if this is smaller). In this case the solution is returned to its state at the beginning of the cycle before continuing, and the cycle is repeated with the time step cut in half. If the user disables the automatic time-step control, then he must select time steps to satisfy the following criteria. First, fluid must not be permitted to flow across more than one computational cell in one time step. This advective transport depends not only on the velocity but also on the fractional area/volume open to flow. The basic stability condition is 
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   (0.343) where (u, v, w) are velocity magnitudes and a factor of CON=0.45 is typically used to account for "worst case" situations suggested by a simplified stability analysis. For compressible flow applications, the CON factor is decreased to 0.25. A cell with a large open face area and a small volume could restrict the time step to small values if there is significant flow in this cell. Should this happen, and it can be determined by monitoring the mesh locations controlling the time step as printed in the output file, it may be necessary to modify the mesh/obstacle arrangement. An algorithm to automatically adjust these ratios by making small "errors" in all volumes is available. A negative value of AVRCK no larger than -2.0 is recommended (e.g., AVRCK= -5.0 or -3.1). Free-surfaces also introduce another type of stability condition associated with the propagation of surface waves. If an acceleration ACCN is applied to the fluid in a direction normal to the free-surface, there can be 



 

 

surface waves with speeds of order ACCN h⋅ where h is the depth of fluid or length of the wave. In practice, we use the cell size in the normal direction for h and include an extra factor of 1/2 in the stability test. The actual condition is that surface waves should not propagate more than one cell in one time step. For example, if z is the normal direction to the surface and ACCZ is the normal acceleration, then 
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δ  (0.344) Similar limits must be imposed in the x and y directions for each cell containing a free-surface. A linear analysis indicates that the time step must be further limited when a non-zero value of dynamic viscosity is used. This condition is 
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DXS x CYLδ= − ⋅ , and RM is the maximum multiplier used on μ for all types of diffusional processes. The restriction physically means that no quantity should diffuse more than approximately one mesh cell in one time step. For safety, an extra factor of 0.5 has been incorporated in the right side of Eq. (0.345) because the limit is otherwise marginal. When the surface tension option is exercised, a time-step limit must be imposed for these forces. Defining 
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σ  (0.348) One more parameter must also be set correctly to ensure stability. This parameter controls the relative amounts of donor-cell and centered differencing used for the momentum advection terms shown in Eq. (0.275). When α=1.0 is used, the above stability conditions are sufficient. Generally, one should always use a value for α such that 
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For instance, if condition of Eq. (0.343) is satisfied, then we must have α > CON. In no case should α exceed 1.0. 
Discrete Particle Dynamics 
Marker Particles Sometimes it is desirable to mark specific regions of fluid so that the evolution (i.e., location and shape) of these regions can be followed. For this purpose, there is a marker (i.e., zero mass) particle capability. Marker particles can also be useful for computer graphic displays. By having a capability for markers to diffuse relative to the fluid, they may be used to model pollutant dispersal or other types of scalar transport in turbulent flows. Marker particles do not affect the fluid dynamics. They move with the mean flow and, if the option is selected, diffuse with the diffusion coefficient D = RMPART • v + NUP, where RMPART is the inverse Schmidt number, v kinematic fluid viscosity and NUP is a constant particle diffusion coefficient. The program allows for rectangular blocks of particles to be initialized within the computing mesh. Additionally, sources of particles may be defined. Each source occupies a certain volume in space and produces particles at a specified rate. Marker particles move with the local interpolated mesh velocities up, vp, wp such that the increment in position in a time step δt is upδt, vpδt, wpδt. Particle velocities are interpolated from the neighboring cell edge velocities using a linear interpolation. Particles that cross continuative, outflow, fixed velocity, or constant pressure boundaries are deleted; while particles crossing a periodic boundary are reinserted at the opposite side of the mesh. At rigid walls (including the mesh cell edges of internal obstacles) particles are specularly reflected, or transmitted, with probabilities that relate to the appropriate closed or open area fractions, respectively. Particles reflect at walls with the normal velocity component equal to PCRST times the normal velocity before the reflection, where PCRST is the coefficient of restitution. For example, if PCRST=0, then particles do not reflect at the walls. When PCRST=1, then no particle kinetic energy loss occurs during reflection. When the particle diffusion coefficient multiplier, NUP, is non-zero, each particle is given an additional increment in position which is added to the mean flow increment before the new coordinate calculation and boundary condition tests are performed. The idea behind this diffusional increment is to consider the particle as a point source. After a time interval, δt, this point source should diffuse in all directions, forming a small cloud with a Gaussian mass distribution in each direction (i.e., it is a "Gaussian puff"). However, the particle is to remain a discrete point. So, rather than replacing it with a distribution, the Gaussian cloud is interpreted as a probability map for moving the particle. Using a random number generator, a new location for the particle is selected with a probability corresponding to the mass distribution within the cloud. In this way a Monte Carlo approximation is generated for the local diffusion of each particle. Three random numbers are selected for each particle to compute random shifts in each of the three coordinate directions. Repetition of this process over many time steps, together with the mean flow advection, will produce a solution for the scalar transport equation 
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∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂         (0.350) in which C is the concentration of marker particles. Of course, the accuracy of the solution will improve as the number of particles per unit volume is increased. Two additional points regarding the Monte Carlo diffusion approximation should be noted. First, the random number generator is based on a uniform distribution in the interval (0,1). This number, x, is transformed into a uniform distribution in the interval (-1,1) by the arithmetic operation 2x-1, and then an inverse error function must be computed to get the desired Gaussian distribution. Unfortunately, system routines for inverse error functions are time consuming and, when used three times for every particle in every time step, can significantly increase computational costs. To minimize this problem, a small table of inverse error functions is used. In the particle moving routine this table is used to interpolate for the inverse error function for each random number, which requires much less time than a system routine. A second point to note is that a call is made to a system clock at the beginning of the particle initialization routine to initialize the random number generator. This ensures a new random number sequence with each new calculation. For some applications, the user may wish to run particle transport calculations in a steady flow—for example, to investigate the sensitivity of pollutant dispersal to different source locations or different diffusion rates. In such cases it makes no sense to continue the fluid dynamic solution. In this case, only the equations for particle motion are solved in the frozen flow field resulting in a considerable savings in computer time. 
Mass Particles Multiple mass particle species can be included into fluid simulation in FLOW-3D. The dynamics of the mass particles is governed by the equation 
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g u u u u  (0.351) where u1 = up + udiff , up and ρp are particle mean velocity and density, respectively, g includes gravity and other body forces, u and P are fluid velocity and pressure and β is a drag coefficient.  The particle diffusion velocity, udiff, is evaluated according to the Monte Carlo technique and added to the mean velocity as described in Marker Particles. Note that particles do not interact with each other. The effects of the particle motion on fluid flow are described in the next section. The drag coefficient β is a function of the Reynolds number of the fluid flow around particles, Re
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=  , where d is the particle diameter, U=|u-u'| and μ is the fluid viscosity. For spherical particles this drag coefficient is given by the empirical relation (G.K. Batchelor, 1983) 

4 24 6
0.4

3 Re 1 Re
D

d
C

 
= = + + 

+ 
β  (0.352) 



 

 

For small Reynolds numbers the drag force given by Eq. (0.352) approaches the Stokes analytical solution for a viscous laminar flow around a sphere. The input variable PDRG3 is used as a multiplier for the Reynolds number dependent drag coefficient β. A multiple-species particles model can be applied to simulate particles of variable sizes or of variable density. For instance, this model might be used to model foreign inclusions in liquid metals or dust particles in the air. 
Particle/Fluid Interaction The particle motion is influenced by the fluid flow through the drag forces. The reverse effect of the particles on the fluid can be neglected if the forces that particle exert on the fluid are small compared to other forces and fluid inertia. This can usually be assumed if particle mass is small compared to the mass of fluid in any given region and particle concentrations are also small. This is the default setting in the particle model. In cases when there are significant interactions between the continuous and dispersed materials that arise because of the drag experienced by the dispersed particles as they move through the continuous fluid, a fully coupled particle/fluid interaction model must be used. A secondary interaction effect is the displacement of fluid volume by particle volume. These effects are not taken into account in the particle model, so the volume concentration of the particles is assumed to be small. Particle/fluid momentum exchange is considered a more important factor because it can be significant even when the volume of particles is small. The equations describing the motion of the fluid and particles must be solved simultaneously. An implicit numerical method is used to couple the momentum of the particles and fluid together. Consider the momentum equations for a small control volume (i.e., grid cell) and a single particle that appears in that volume. The particle momentum equation is used to advance the particle velocity from time t to t + δt. The new velocity can be expressed in terms of all known quantities except for the fluid, which appears in the coupling term. Next, this velocity can be algebraically substituted into the corresponding coupling term in the fluid momentum equation to produce an expression for the new fluid velocity. A similar substitution can be done for all particles that influence the fluid element. Because the fluid velocities that appear in the drag expressions are linear (quadratic drag terms are linearized), it is a trivial matter to collect all the occurrences of the new velocity together in order to obtain a solution for it in terms of the remaining known quantities. Once this has been done for the entire grid, and a solution for the new velocities is obtained, they can then be used to compute the drag force needed for updating the particle velocities. This, then, is the strategy: 1. Compute new particle velocities in terms of the as yet unknown fluid velocities. 2. Substitute those velocities into the momentum exchange terms in the fluid equations and solve for the new fluid velocities. 3. Return to the particles and update their velocities to reflect the new fluid velocities. More details can be found in the Flow Science Technical Note #50 (C.W. Hirt, 1999). 

http://www.flow3d.com/pdfs/tn/FloSci-TN50.pdf


 

 

Rigid Body Dynamics Algorithm for Non-Inertial Reference Frame Model As previously mentioned in Rigid Body Dynamics, the non-inertial reference frame method is for analysis of flow in a moving container. Computational mesh is fixed with the container in a non-inertial reference frame while fictitious forces are applied on fluid to account the non-inertial effects. If motion of the container is not prescribed but dynamically coupled with the flow inside the container, a rigid body dynamics algorithm is employed to solve the container motion to obtain the fictitious force. Coupling between the body motion and fluid dynamics can be either explicit or implicit, as described below.  The model described in Rigid Body Dynamics involves a high degree of mutual coupling. Therefore, a general solution should consider the equations for all parts of the problem simultaneously. Such a solution, however, is very difficult to implement, particularly without specification of the details of the environmental and control forces and torques. Here, we shall outline a sequential, explicitly coupled solution, which, while not universally valid, is widely applicable and efficient within its range of validity. This explicit algorithm has been generalized to permit an iterative implicit coupling, which extends the solution to some additional situations. We choose to decompose the solution into the following six steps: 1. Evaluation of Environmental Forces and Torques. 2. Evaluation of Control Forces and Torques. 3. Solution of the Fluid Dynamic Equations for all Components. 4. Solution of the Dynamic Equations for the Rigid-Body Center of Mass. 5. Solution of the Dynamic Equations for the Rotation of the Rigid Body. 6. Integration of the Kinematic Equations for the Rigid-Body Attitude. These six steps are combined into a cyclic algorithm that advances the total solution through time. Each step utilizes previous results from the others, forming an explicit algorithm. The iterative implicit solution adds a seventh step, convergence testing, and repeats the basic six steps until convergence is achieved. Step 1: Evaluation of Environmental Forces and Torques This step is clearly very problem-dependent. The results of this step are three net force components and three net torque components. These components are in the body-fixed Cartesian coordinate system. Typically, these may represent forces arising from aerodynamic drag, solar wind and/or geomagnetic effects. This routine can also incorporate the torque due to gravitational gradients or the fictitious forces and torques that compensate for an earth-fixed reference frame. Three components of gravitational acceleration (in the inertial coordinate system) are also evaluated by RBENVR and stored in common. These values are calculated at the location of the rigid-body center of mass and do not account for variations of gravity through the body. The location of the rigid-body center of mass (in inertial coordinates) and the rigid-body attitude are available for the evaluation of these forces and torques. For some purposes the gravitating body coordinates may be simpler to use. Vector quantities can readily be transformed between inertial and body-fixed coordinates by use of the transformation matrix and its inverse. Additional input that may be required to evaluate control functions can be specified through the FLOW-3D user data namelist (USRDAT) or the "dummy" variables in namelist XPUT.  



 

 

Step 2: Evaluation of Control Forces and Torques This step is directly analogous to Step 1. The two are separated to simplify the combination of models for various phenomena. The control forces and torques are transferred through body-fixed components, which are stored in variables separate from the environmental force and torque components. To provide an elementary control capability, we have developed a skeleton version which treats a few special cases. Step 3: Solution of the Fluid Dynamics Equations Decomposition of the analysis as described is motivated by the desire to retain the fluid analysis capabilities of FLOW-3D intact. Only peripheral changes to the usual solution algorithm are needed by this approach. It is important to note that we are choosing to consider the fluid as a separate entity in our solution algorithm. Thus, when we consider the rigid body, we are specifically excluding any onboard liquids. The fluid part of the analysis is handled explicitly in Step 3. All usual FLOW-3D models and solution methods are available for the solution of the fluid component of the simulation. The continuity, volume-of-fluid and momentum equations are solved to determine the location and velocity of the fluid within the body-fixed reference frame. The influence of the gravitating body must be added through transient evaluation of the local gravitational field since the apparent direction of this force will vary as the rigid body rotates, and its strength may vary as the center of mass moves. This acceleration must be incorporated in the fluid equations directly since it influences both the fluid and the rigid body. We have simplified this calculation by using the gravitational vector at the rigid-body center of mass throughout the fluid. Thus we can account for neither displacement of the fluid from the rigid-body mass centroid nor the variation of gravity within the fluid region. The gravitating body force is accounted for by modifying the components of linear acceleration used by the fluid-flow solution calculated by the rigid-body center of mass motion algorithm in Step 4. This is accomplished in subroutine MOTION. The constant gravity components GX, GY and GZ are not used by this model and generally should not be combined with the coupled rigid-body dynamics model. The net force and torque exerted on the rigid body by the fluid are calculated in subroutine FEVAL. The components of these vectors are resolved in the body-fixed Cartesian coordinate system (even if the fluid calculation uses cylindrical coordinates). The torque is converted to that about the rigid-body center of mass for use in Step 5. Force moments for other purposes are evaluated about the origin of the body-fixed coordinates and are still available in the FLSGRF data file. Since the fluid-dynamic calculation occurs before the rigid-body dynamics, we must deal with an initialization difficulty. The flow analysis requires knowledge of the rotation and acceleration of the rigid body. To resolve this difficulty, we temporarily assume (for the first cycle only) either that the fluid mass acts as if frozen in position or that the body acceleration can be calculated by ignoring the fluid. This permits evaluation of approximate values of the rigid-body acceleration and rotation for the purpose of solving the flow equations during the first cycle. Step 4: Solution of the Dynamic Equations for the Rigid-Body Center of Mass Standard analysis shows that the equations for the motion of any rigid body can be separated into an equation for the motion of the center of mass of the body and independent dynamic equations for the rotation of the body about the mass center(G.K. Batchelor, 1983), (H. Goldstein, 1950),(J.R. Wertz, et al., 



 

 

1978). In our algorithm we identify the rigid body as excluding the fluid mass for the specific purpose of allowing this separation. Therefore, Step 4 solves the linear momentum equation: 
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F F F F  (0.353) where V'CM is the velocity of the center of mass of the dry rigid body. This velocity is relative to the inertial reference frame and is resolved in the (x', y', z') coordinates. M is the total dry mass of the rigid body, F'e, F'c, F'f  are the environmental, control and fluid forces that are evaluated in Steps 1-3, respectively, and F'g is the force due to the gravitating body. Note that the environmental, control and fluid force vectors are resolved in the inertial reference frame in this equation. This requires application of the attitude transformation (see Step 6) to the components stored in common since those components are in the body-fixed reference frame. The gravitational force is, of course, already evaluated in the inertial reference frame. For the explicit coupling algorithm, we use a simple first-order forward difference technique to integrate the momentum equation. The technique is explicit in that the most recently calculated values of the forces are used at each cycle. The difference technique is motivated by the difficulty of calculating the fluid force, which normally involves many nonlinear equations. This makes the use of more accurate integration techniques of questionable value. The implicit algorithm uses a "frozen fluid" approximation to estimate the acceleration to be used for the next iteration. This approximation adds the "frozen fluid" mass (which is taken to equal the total liquid mass) times the acceleration vector to both sides of the momentum equation. The term on the left-hand side is treated implicitly (that is with the new estimate of the acceleration), while the right-hand side is treated explicitly. This removes the limitation on fluid/rigid mass ratio, since the resulting equation uses the total (fluid + rigid) mass in calculating the new estimate of acceleration. Once converged, the original equation is almost satisfied, since the old and new accelerations are nearly equal. The center-of-mass velocity is used to integrate directly for the position of the rigid-body center of mass relative to the inertial reference frame coordinates (x', y', z'). This position is then converted to spherical coordinates. Finally, the influence of the gravitating body rotation is accounted for in calculating longitude and latitude relative to the gravitating body. Step 5: Solution of the Dynamic Equations for the Rotation of the Rigid Body The separation of translational and rotational momentum used in Step 4 to evaluate the position of the rigid-body center of mass results in the angular momentum conservation equation: 
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ω ωω ωω ωω ωT T T⋅ = + − × ⋅ +∑  (0.354) where J is the dry-rigid-body inertial matrix, ω is the angular velocity and Te, Tc and Tt are the torques due to environment, control and fluid forces, respectively. Note that this equation is written in the body-fixed reference frame although the angular velocity is that with respect to the inertial reference frame. This accounts for the "additional" cross product term, which is absent if the equation is written in the inertial frame. The inertia matrix and torques are also resolved along the body-fixed (x, y, z) coordinate system. 



 

 

Equation (0.354) is solved in a manner analogous to the linear momentum equation in Step 4. Thus, we use an explicit, forward-time formulation or a "frozen fluid" approximation, depending on the time algorithm selected. The results of this step are the components of the angular velocity and angular acceleration of the dry rigid body in the body-fixed reference frame. These components are available for Steps 1-3 of the next cycle. Step 6: Integration of the Kinematic Equations for the Rigid-Body Attitude There are several popular representations of the attitude of a rigid body (H. Goldstein, 1950). We choose to describe the attitude by the full transformation matrix. The matrix [A] is defined to transform an arbitrary vector (G’) from inertial coordinates to body-fixed coordinates through the equation 
[ ]G A G′ = ⋅  (0.355) As shown in reference (H. Goldstein, 1950), the components of [A] are then the direction cosines between the axes of the two systems 
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A x x′= ⋅  (0.356) where we have switched to subscripted unit vectors to simplify the notation. As usual, x1 is equal to x, x2 is equal to y, etc. By definition, this matrix must be orthogonal, and therefore its inverse is equal to its transpose, and we have the relationship 
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G A G′  = ⋅   (0.357) The kinematic equation relating the transformation matrix [A] to the rigid-body velocity is 
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Step 6 of our algorithm implements a first-order, forward-time difference approximation to determine the variation of the transformation matrix [A] with time. One potential problem with this approach is the accumulation of errors in the matrix elements. The most serious difficulty associated with these errors is the potential for generating non-orthogonal matrices. To ensure that this does not occur, we orthogonalize the matrix at the completion of every cycle using a simple Gram-Schmidt orthonormalization procedure on the implied inertial coordinates. That is, we define the approximate inertial unit vectors as the column vectors of the transformation matrix [A]. These vectors are orthonormalized in the usual way, and the transformation matrix columns are replaced with the modified 



 

 

unit vectors. This ensures that [A] represents a physical rotation transformation at all times. Therefore, the errors are limited to incorrect rotation angles. Accumulated error magnitudes are evaluated as part of the orthonormalization procedure. The result of Step 6 is the current value of the transformation matrix. The matrix can be used directly to transform between the inertial and body-fixed reference frames as necessary in Steps 1-5. 
Convergence Testing This algorithm is for the explicit coupling method. The implicit method, however, requires a final step, which is the testing of the current accelerations and forces for convergence. Actually, the convergence test is made only on the acceleration components, and we assume that the force and torque components must also be converged. The user can supply a convergence criterion (ACCEPS). The change in each acceleration component between iterations must be less than this parameter times an appropriate normalization velocity for convergence to be achieved. The user may also specify a maximum number of iterations. If convergence is not achieved within this limit, the calculation is aborted and an error message generated. 
Simplified Shrinkage Algorithm The Simplified Solidification Shrinkage (SSS) model is based on the solution of metal and mold energy equations. No fluid flow equations are solved by the model. Porosity is predicted by first evaluating the volume of solidification shrinkage in each isolated liquid region in the casting at each time step. This volume is then subtracted from the top of the liquid region in accordance with the amount of liquid metal available in the mesh cells from which the fluid is to be removed. The volume is subtracted if no feeding occurs through mesh boundaries. The “top” of a liquid region is defined by the direction of gravity and centrifugal forces (in centrifugal casting), which can be time dependent (as in tilt pour casting). Feeding is then assumed in the direction of the combined body force. When the minimum solid fraction in a liquid metal region reaches the coherency point, FSCO, the direction of feeding changes from along body force to along the temperature gradient – from hot to cold. This mode of feeding is called interdendritic feeding. An option exists to use only that kind of feeding, which is useful for thin-wall castings, where the mushy zone may not be resolved well by the computational mesh.  A liquid region is considered isolated if it is surrounded by mold walls, solidified metal, and/or free-surfaces. The feeding is controlled by the value of the solidification drag force, F=Ku, where u is the local liquid metal velocity and K is the solidification drag coefficient. The latter is a function of the local solid fraction (see Solidification). If the drag coefficient multiplied by the time-step size, Kδt, is above 106, then no feeding occurs. Otherwise the shrinkage that occurred during the period of Dt is fully fed. This feeding criterion can be controlled by using the input variable TSDRG, which is used as a multiplier when computing K. If an isolated liquid region does not have a free-surface, then volumetric shrinkage in it will result in the opening of an internal cavity at the top of the liquid region. The SSS model uses the following assumptions: 
� Volumetric expansion is included in the model, but only when space is available for expansion. 
� The mold is rigid. 



 

 

� The liquid metal free-surface is normal to the direction of body forces. 
� Feeding occurs instantaneously. 
� Internal cavities open immediately as soon as a liquid region is separated from the feeder. 
� Shrinkage is always fed through open mesh boundaries as long as the fluid fraction (FBCT) at these boundaries is above zero and the fluid temperature at the boundaries is above solidus (TS1). The feeding occurs irrespective of the orientation of the boundaries relative to the feeding direction. This allows to model applied pressure at inlets designed to reduce porosity in the casting (e.g., in squeeze casting). At any given time increment dt, the total amount of shrinkage, V∆ , is defined by the current liquid and solid phase densities, ρl and ρs respectively, 
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 (0.360) where dVl is the volume of liquid metal that solidified in time dt. The volume changes in the liquid phase during cooling, before it begins to solidify, are also taken into account. There are no limitations on the actual casting shape or configuration and metal and mold properties in the SSS model. The accuracy of the model depends on how important the convective heat transfer is compared to thermal conduction and whether significant gas evolution in the metal is present. The larger the role the thermal conduction plays, the better the accuracy of the model. Since no fluid flow equations are solved, fluid velocities are assumed to be zero. No dynamic fluid flow phenomena can therefore be modeled with the SSS model except for heat transfer and volume reduction. When the implicit algorithm is employed, the use of a large time step may cause significant inaccuracy in the predictions of the SSS model. This can be illustrated by considering the example of a one-dimensional plane solidification front moving in the positive x-direction. Since there is a sharp boundary between liquid and solid phases, all the volumetric shrinkage occurring at the front will be fed by the liquid ahead of the front.  In the numerical approximation we divide the domain into small control volumes (cells). In our example, when the solidification front is inside of a control volume, the cell behind the front is already solid, while the one ahead of the front is still liquid. Therefore, each solidifying cell will have a fully liquid neighbor from which it can be fed. If we restrict the front to advance at most one cell during each time step, then all shrinkage in each control volume will be fed. This will be a physically sound solution. However, if the time step is large, then the solidification front may advance a few cells in one time step and some of those cells may have no adjacent liquid cells to feed them at the time of solidification. This will lead to porosity in these cells, which obviously is not correct. A sub-time-stepping procedure for the SSS option is used in FLOW-3D to reduce the effect of a large time step on porosity predictions (H. Goldstein, 1950). This is only done in conjunction with the implicit heat transfer algorithm. The procedure uses a linear interpolation between the previous and the current values of energy, En and En+1, respectively, to compute the solid fraction, volumetric shrinkage and feeding in each control volume at each sub-time step between times tn and tn+1. 



 

 

Reactive Flows Algorithm The chemistry model was designed to operate at the control volume level, i.e., the chemistry model is used to determine new scalar concentrations within each computational cell at the finish of each time cycle. Three modifications to the basic model were made to adapt the solution algorithm for use in FLOW-3D. First, a loop through the entire algorithm was added. This enables the calculation of new scalar quantities in every computational mesh cell. Second, additional logic was added to limit the chemistry calculations to those locations occupied by fluid and scalars only. Third, logic was added to set the duration of each chemistry integration equal to the hydrodynamic time step used by the main program. The convection and diffusion of an arbitrary number of chemical reactants is handled by species concentration transport equations that were already a part of FLOW-3D. A new input variable, ISCLR(ns), was added to control the flow properties of certain chemical species, e.g., chemical species attached to rigid surfaces. The chemistry model uses a simple, first-order time integration algorithm with an automatically determined level of implicitness. The kinetic equations are integrated with a time step representative of the equation system, which may be orders of magnitude larger than the characteristic time step of the fastest reaction. The solution procedure is based on the physical idea that the species governed by sufficiently fast reactions exist in quasi-equilibrium with the other species. Accordingly, the fast (stiff) equations are integrated with their small characteristic time step only until this condition is achieved within each system time step. This feature makes the algorithm very efficient for stiff systems. Because a simple, first-order solution algorithm is used, data storage requirements are very small. The chemistry model combines an explicit integration procedure with an implicit procedure that integrates the fast reaction equations at a reduced time step until quasi-equilibrium is achieved. The solution is accomplished by the following steps. 1. Calculate the progress rate for each reaction based on kinetic equations supplied by the user. 
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′  (0.362) 3. Define a time step ∆t for the system of reaction equations. First calculate ∆ta as the arithmetic average of δti. If all δti < 2.1 ∆ta, then ∆t = ∆ta. Otherwise, eliminate all δti  > 2.1∆ta  and recalculate ∆ta from the remaining values. This procedure is repeated until the new ∆ta is within a factor of two of the previous ∆ta, then ∆t =∆ta. 4. Determine which reactions are stiff. A stiff equation is defined as one where: 
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<  (0.363) 5. If the system has no stiff equations, then the progress increments are calculated for each reaction as 
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C C tφφφφ∆ = ∆  (0.364)  φ is a function which controls the level of implicitness in ∆Ci. The value of φ is calculated automatically by the program each time step. New concentrations are calculated as: 
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C t t C t C− ∆ = + ∆  (0.365) 6. If the system has stiff equations, adjust δti for each stiff equation to be an integral fraction of ∆t for a reduced time-step integration. The smallest δti is the time step, δtmin, used for the integration of the stiff equations. 7. The reduced time-step integration is performed as follows. a. For the non-stiff equations ∆Ci is constant for all integrations performed using ∆tmin. 
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C C tφφφφ  (0.366) b. For the stiff equations a new ∆Ci calculated at the end of each sub-time step, ∆tmin. c. New concentrations are given by: 
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C t t C t C+ ∆ = + ∆  (0.367) Integration at the sub-time step level continues until a condition of quasi-equilibrium is reached for the stiff equations, that is, until: 
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− <  (0.368) for all stiff equations. The quantity ξ is a defined "zero." The final integration is performed in one step to obtain the new concentrations at t + ∆t. This completes the solution algorithm, which is repeated consecutively, until the stopping time is reached. 
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Chapter 4 – Users Interface 
Overview This chapter will familiarize the user with the various parts of the FLOW-3D graphical user interface (GUI), as well as how to use the controls in the interface. The chapter is only intended to give descriptive treatment of each component and its individual elements, without delving into the meaning, importance or effect of selections required or allowed for every button or edit box. For such substantive information, the user should refer to the other sections of this Manual, to the FLOW-3D Users Site, to the materials received at a FLOW-3D Training Class, and to the advice of the Flow Science support team. The FLOW-3D graphical user interface is based on a “notebook” design. Like the tabs on a notebook divider, the tabs in the FLOW-3D user interface are used to mark the different sections into which the interface is divided. Each tab represents the steps required for completing CFD analysis using FLOW-3D: setting the parameters desired for a simulation and fixing the output desired (Model Setup tab); running and monitoring a simulation (Simulate tab); prescribing the view desired of the output of a simulation (Analyze tab) and viewing and manipulating the results (Display tab).  The Navigator tab, which is the first tab seen when opening FLOW-3D, is designed to help the user organize simulations and run multiple simulations in batch mode. 
Main Menu The Main Menu is located at the very top of the FLOW-3D user interface:   A description of each of the various menu options is given below. 
File Menu The File menu is the main menu option for opening, saving and closing simulation files. From the Navigator tab you can obtain the File options below:  
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 File menu options are as follows: New Workspace Select New Workspace to create a new workspace.  See also: Navigator A New Workspace dialog box opens: 

 Enter a name for the workspace. The user can choose to leave the workspace file in the default location or click the Browse button to place the workspace file in a different directory location. Check the box if it a subdirectory having the same names as the workspace file is desired. When selected, the new workspace will appear in the tree structure on the left side of the Navigator tab under Portfolio. 



 

 

Open Workspace Select Open to open an existing workspace. A standard dialog box for browsing to find a file in a directory location will open. Save All Select Save All to save all workspaces and simulation files. Add New Simulation Select Add New Simulation to open a new default FLOW-3D simulation input (prepin) file. A New Simulation dialog box opens: 

 Here the user enters the name for the simulation or loads a template prepin file. The user can choose to leave the workspace file in the default location or click the Browse button to place the workspace file in a different directory location. Check the box if a subdirectory having the same name as the workspace file is desired. Click OK to complete the creation of the simulation. When selected, the new simulation will appear in the tree structure on the left side of the Navigator tab under the highlighted or selected Workspace. Add Existing Simulation…  Incomplete Import Existing Simulations...   
Select Import Existing Simulations... to open several simulations. A dialog box titled Browse for Folder will open allowing the user to select a folder that contains at least one folder with simulations in it. NOTE: IF THE USER HAS A SINGLE FOLDER WITH AT LEAST ONE SIMULATION IN IT AND THAT FOLDER WAS CHOSEN TO IMPORT EXISTING SIMULATIONS, ZERO SIMULATIONS WILL BE ADDED. THE STRUCTURE IS SET UP TO ENCOURAGE ORGANIZING SIMULATIONS IN WHICH EACH SIMULATION WILL BE PLACED IN A WORKSPACE FOLDER WHERE THEY ARE SEPARATED INTO INDIVIDUAL FOLDERS. Add Restart Simulation… Add Restart Simulation... is used to create a restart simulation from the simulation file that is selected in the tree structure. A New Simulation dialog box will open: 



 

 

 Here the user can name the restart file, select a directory location, and choose to copy any related geometry files to the directory location for the new restart simulation. The option to not copy the geometry files but still use them can be achieved by checking the Use relative path located at the bottom of the dialog box. For the restart simulation, by default the starting time is the last time for the simulation from which the copy was made. To change this start time, the user must go the General tab and click on the Restart button. Add Simulation Copy… Add Simulation Copy... is used to create a duplicate of the simulation file that is selected in the tree structure. A New Simulation dialog box will open (identical to the image above).  Use this feature to set up multiple similar simulations with minor variations. Add Example… Select Add Example... to open a directory of sample FLOW-3D simulation files. Save Simulation Saves the current working simulation file in the current directory location. Save Simulation As… Select Save Simulation As... to change the name of the simulation input file and save it in a selected location. Revert Simulation to Saved Select Revert Simulation to Saved…to revert to the saved file if changes were made to the simulation input file but which should not be implemented or saved. Edit Simulation Select Edit Simulation to open the input file for the selected simulation in a text editor. The text editor can be used to modify input files directly. The user directly modifies the text by typing in changes. Right-click the mouse in the text area to bring up a dialog allowing for quick changes such as Undo, Redo, Copy and Paste.  



 

 

 A Search box is provided to enable the user to search for desired text. Print the file by clicking on the printer icon. The user can check the syntax of changes or additions he has made by clicking on the Check Syntax button. If there are errors, these will be highlighted by the editor. NOTE: IN ORDER FOR ANY CHANGES MADE TO THE SIMULATION FILE TO BE SAVED, THE USER MUST CLICK OK. TO CLOSE THE TEXT EDITOR WITHOUT SAVING ANY CHANGES, CLICK CANCEL. Rename Rename is used to rename the simulation input file selected in the tree structure. Reset Version Options to Default For a selected Workspace, all simulations within it can be reset to default settings version (double precision) and number of processors to be used (for users with multi-processor computers and license). By default, FLOW-3D is set to double precision and all available processors. Set Version Options ... The version (double precision, single precision, custom double precision, custom single precision) and number of processors to be used (for users with multi-processor computers and license) can be set for all simulations in a workspace. Close Workspace Close Workspace will close the workspace selected in the tree structure. This action may also be accomplished by pressing the Delete key. NOTE: THE USER WILL BE GIVEN THE OPPORTUNITY TO SAVE ANY CHANGES MADE TO SIMULATION FILES IN THE WORKSPACE BEFORE CLOSING. Exit Select Exit to close FLOW-3D. NOTE: THE USER WILL BE GIVEN THE OPPORTUNITY TO SAVE ANY CHANGES MADE TO SIMULATION FILES BEFORE CLOSING. NOTE: WHEN THE USER IS IN ANY TAB OTHER THAN THE NAVIGATOR TAB, ONLY THREE SELECTIONS ARE AVAILABLE IN THE FILE MENU. 



 

 

 Select Save Simulation to save the simulation input file. Select Edit Simulation to open the input file for the selected simulation in a text editor. See above for more information. Select Exit to close FLOW-3D. 
Diagnostics Menu The Diagnostics menu enables the user to view diagnostics files generated by FLOW-3D. Typically, it is not necessary to review these files. However, they can be useful for troubleshooting. 

 Diagnostics menu options are: Report  Contains the Preprocessor Report and the summary of the solver phase such as CPU time and available times at which the simulation could be restarted. Preprocessor Errors If any errors or warnings occur during the preprocessing phase, a detailed message will be shown by selecting Preprocessor Errors. Preprocessor Summary The Preprocessor Summary file includes a summary of all parameters set by the preprocessor. It also includes a detailed description of the mesh. It is a good idea to review this file to be sure the problem is set up correctly. Solver Errors If any errors or warnings occur while the FLOW-3D solver was running, a detailed message will be shown by selecting Solver Errors. Solver Messages The Solver Messages file provides detailed information about the simulation such as time-step size, stability criteria, etc. Below is an excerpt from a typical simulation: 



 

 

 Solver Summary Click on the Solver Summary option to view detailed information about the simulation such as the number of voids in the simulation at a specified time, the computed stability criteria and at what cells the criteria are a minimum, etc. This information is valuable in the understanding of what could be done to make a simulation run more efficiently. 
Preference Menu The options under the Preference menu enable the user to specify certain preferences for running FLOW-3D.  

 Preference menu options are as follows: Sub-tab Color Select Sub-tab Color to open a dialog box that enables you to change the color of the second row of tabs under the Model Setup tab. Default Workspace Location… Select Default Workspace Location to open a file location selector box to choose where FLOW-3D will point to when choosing to save a workspace or simulation file. 



 

 

Default Version Options  Select Default Version Options to apply default settings for version (single precision, double precision, custom single and custom double precision) , number of processors to be used (for users with multi-processor computers and license), and the options for token usage. By default, FLOW-3D is set to double precision and all available processors. 

 These settings (version and number of processors) are written into the prepin file for FLOW-3D Version 9.3 and above. If a user opens a file created using an earlier version of FLOW-3D, the default settings will be used but not written into the prepin file unless the user saves the file.  For any given prepin file, the user can override the settings by changing them in the General tab (see Version Options). Add Existing Simulation starts in Workspace Select Add Existing Simulation starts in Workspace to allow the user to add simulations from the selected Workspace. If this is not checked then the user can browse for an existing simulation to add.  Autosave Before Simulating And Switching Between Simulations  Select Autosave Before Simulating and Switching Between Simulations if the user wants the Autosave. If this is not selected the user will be prompted before simulation and switching between simulations if they would like to save. 
Physics Menu This menu allows the user to make changes to the Physics located in the Physics tab without having to go to the Physics tab. The user can also see what Physical models are currently activated. To modify or add physics simply select the physics model (Air Entrainment, Cavitation, etc..) and the dialog box for that physical model will open. 



 

 

 
Utilities Menu Certain useful programs are accessible from the Utilities menu. 

 Utilities menu options are as follows: Auto update Auto Update enables the user to set up his PC to automatically check for updates on the FLOW-3D Users Site. More extensive instructions are available in the Introduction Chapter, Activating Automatic Updates. 
 Select User Settings to turn on automatic updates. A dialog box opens to enable the user to enter his User ID and password for the FLOW-3D Users Site, and required 
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connection information (proxy and port number). Only users with an active maintenance contract with Flow Science can have access to the FLOW-3D Users Site. If you have a maintenance contract and do not know your user ID and password for the Users Site, contact Flow Science’s License Administrator at licenses@flow3d.com. When automatic updates is activated, each time FLOW-3D is started, the GUI will check to see if a newer version is available the FLOW-3D Users Site, and, if so, inform the user and give him the opportunity to download and install. Select Deactivate to turn off automatic updates. Check now allows the user to check for updates manually. lmtools Select lmtools to access the Macrovision FLEXlm utility “lmtools.exe” to check system settings, start or stop the license server, read or reread the license file and so on. 

 Note: If the user has multiple installations of FLOW-3D and does not have a licenses subdirectory in current F3D_Home directory, lmtools will not show in this menu. 
Simulate Menu The Simulate menu is where the user launches either the preprocessor or the solver for FLOW-3D. 

 The options given in the Simulate menu are as follows: 
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Preprocess Simulation Select Preprocess Simulation to launch the FLOW-3D preprocessor for a selected simulation input (prepin) file only. Run Simulation Select Run Simulation to launch the FLOW-3D solver for a selected simulation input file only. Simulate Workspace Select Simulate Workspace to launch the FLOW-3D solver for all simulation input files in a selected Workspace. Simulate Portfolio Select Simulate Portfolio to launch the FLOW-3D solver for all simulation input files in all Workspaces in the portfolio open in the Navigator tab. Preprocess Simulation Select Preprocess Simulation to launch the FLOW-3D preprocessor for a selected simulation input (prepin) file only. Terminate Simulation ... Select Terminate Simulation... to stop the solver for the selected simulation input file (and any simulation input files otherwise set up to run thereafter via Simulate Workspace or Simulate Portfolio. NOTE: THE SOLVER CAN ALSO BE STOPPED IN SIMULATE TAB. Clear Simulation List When multiple simulations have been run in a single session of FLOW-3D, either at the same time or one after another, they are added to the Simulation queue drop-down box in the Navigator tab. In this drop-down box are shown the names of the simulations that have been run, with an icon indicating the current status: Running, Terminating, Terminated, or Complete. After running many simulations, workspaces or portfolios, this list can become filled with completed simulation queues. Select Clear Simulation List to remove all completed or terminated simulations from the list. Running simulations are left undisturbed. Set Max Simultaneous Simulations (10) ... Select to set the maximum number of simultaneous simulations for users with multi-processor computers and license. The default is set to 10. 
Materials Menu The Materials menu provides access to the Fluids Database and Solids Database. 

 The Fluids and Solids Databases allow the user to load, organize and save fluid and solid properties used within FLOW-3D. Properties for a selection of fluids and solids are included within the database and are intended as a starting point for the user of FLOW-3D. The material properties in these databases may not cover all available models in FLOW-3D and, therefore, the user should double check the setup after a material has been loaded.  The Material Property Database (MPDB) for FLOW-3D is a third party database which can be purchased from Flow Science, Inc. separately. It contains a rich collection of temperature-dependent solid material properties from the literature. MPDB for FLOW-3D is an exclusive version of MPDB which allows the user to 



 

 

export file formats that are compatible with FLOW-3D’s native databases and therefore the data can conveniently be imported into FLOW-3D’s native database. Fluids Database... The Fluids Database is where a user selects the fluid(s) to be used in a simulation. When Fluids Database is selected, the following dialog box appears: 

 The icon next to a material indicates whether it was created by the user or comes from the original database.   This icon indicates it is from the original database. The properties of these fluids cannot be changed.   This icon indicates it is a user-defined fluid. To load a fluid into the input file (prepin) for a simulation, the user selects a fluid from the Fluids Database and clicks on the appropriate Load Fluid button at the bottom of the interface. NOTE: THE LOAD FLUID 2 BUTTON WILL ONLY BE ACTIVE IF THE USER HAS SELECTED TWO FLUIDS IN THE NUMBER OF FLUIDS SECTION IN THE GENERAL SUB-TAB. A previously loaded fluid can be replaced with another fluid by loading the desired fluid over the one to be replaced (e.g., if the user loaded Mg Alloy AZ31B as Fluid 1, but intended to load Mg Alloy AZ91B, then highlight Mg Alloy AZ91B and click on the Load Fluid 1 button). The Fluids Database lists all fluids available in the FLOW-3D installation package. The database can be modified by the user, both by adding new fluids and by creating a copy to edit the properties given for fluids listed in the database. The Display button shows the properties of the selected fluid in a display window, from which the user can save them as a text file. The user can add new fluids into the database by clicking Add. This opens a New Fluid Database dialog box. Here, the user can enter the properties, fluid name, and choose the units. Note that the dialog box has two tabs, for basic and phase change properties. Click OK to add the fluid to the database, or Cancel to abort the action. This will create a new fluid for that user and is indicated that it is a user-defined material by the following icon . Unit conversion is not performed when adding a fluid to the database. The user can only edit the user-created materials in the database. To edit their 



 

 

properties the user must highlight a material in the database list of fluids and click on Edit. This opens an Edit Fluid Database dialog box. Here, the user can change the properties of the fluid and choose the units. Note the dialog box has two tabs, for basic and phase change properties. Click OK to save the changes to the database, or Cancel to abort the action.  NOTE: THE TITLE OF THE FLUID CANNOT BE CHANGED WHEN EDITING THE FLUID. IF THE TITLE ALSO NEEDS TO BE CHANGED THEN A COPY OF THE MATERIAL MUST FIRST BE CREATED. The user can also delete materials from the Fluids Database by highlighting a fluid and clicking on the Delete button. Since this action cannot be undone, the user is asked for confirmation. To view the properties of any listed fluid, use the mouse to select the desired material name and then click on the Display button. This opens another window which displays the properties of that material. The data can be saved to a text file by clicking Save as. To modify a database fluid or create a copy of a fluid select Create Copy. The original database fluids cannot be edited or modified unless a copy is made. A copy can be created from both the original and user materials. Notes on Fluid Properties The metal properties are taken from a variety of sources. The most useful source is the NSF report Summary of Thermal Properties for Casting Alloys and Mold Materials (R. D. Pehlke, December 1982). This report includes a vast quantity of data for many different materials. Three sample aluminum alloys are included in the database. Liquid and solid specific heats are taken at the liquidus and solidus temperatures respectively. The thermal conductivities are also evaluated at the liquidus and solidus temperatures. The heat of fusion of pure aluminum is taken from (R. D. Pehlke, A. Jeyarajan, and H. Wada, December 1982). The heat of fusion of the Al-4.5 Cu alloy is taken from (ASM Handbook: Properties and Selection: Nonferrous Alloys and Special-Purpose Materials, 1990), AA201 alloy, and is very similar to that of pure aluminum. No heat of fusion for Al-8 Mg was found. The value used is the weighted average for that of aluminum and magnesium. The densities for both liquid and solid are that of the solid. The density of pure aluminum is taken from (R. D. Pehlke, A. Jeyarajan, and H. Wada, December 1982). The densities for the alloys were taken from (Boyer, H.E. and Gall, T.L., 1985). A sample carbon steel alloy, AISI 1026, is included in the database. The properties are taken from (R. D. Pehlke, A. Jeyarajan, and H. Wada, December 1982). The specific heats for the liquid and solid were evaluated at the liquidus and solidus temperatures. The values were approximately the same, and thus one value of specific heat is used in the database. The thermal conductivities are also evaluated at the liquidus and solidus temperatures. The heat of fusion of pure iron was used. The density of the liquid is that of 0.2% C steel at 1823 K. The density of solid AISI 1026 is reported as 7860 kg/m3 at 288 K. No density for AISI 1026 was reported near the solidus temperature.  The viscosities of all metals in the database are evaluated at the liquidus temperature of the pure metal, using the temperature relationships in (Brook, E. A. Brandes and G. B., 1992). Although the viscosities are temperature dependent, a constant value was used. Turbulence is present in many casting processes. The turbulence models of FLOW-3D will calculate a turbulent viscosity that is most likely many times greater than that of the molecular viscosity. Thus assuming that the dynamic viscosity is constant in the liquid phase is a reasonable approximation. 



 

 

Solids Database...  The Solids Database allows the user to load material properties for geometry Components. When Solids Database... is selected, the following dialog box appears: 

   This icon indicates it is from the original database. The properties of these materials cannot be changed.   This icon indicates it is a user-defined material. If a simulation has more than one component, the dropdown box at the top of the window allows the user to choose the component to which the properties should be applied. The list of materials in the database is given in a tabular format. Select Load to load the material properties into the simulation (prepin) file. The properties selected will also appear in the tree structure under the selected component. The user can only edit the user-defined materials in the database. To edit the properties of a user material, select the desired material and then click on the Edit button. This opens a dialog box which displays the properties of that material and allows the user to modify them. Click OK to save the changes to the database, or Cancel to abort the action. In order for the edited properties to be correctly reflected in the input file, editing must be completed prior to loading. The user can add new materials into the database by clicking Add. This opens an Add to Solids Database dialog box. Here the user can enter the properties, material name, and choose the units. Click OK to add the material to the database, or Cancel to abort the action. To view the properties of any listed material, use the mouse to select the desired material name and then click on the Display button. This opens another window which displays the properties of that material. This can be saved as a text file by clicking Save as. The user can also delete materials from the database by highlighting a material in the list and clicking on the Delete button. Since this action cannot be undone, the user is asked for confirmation. To modify a given database material or create a copy of a user-defined material select Create Copy. The original database solids cannot be edited or modified unless a copy is 



 

 

made. A copy can be created from both the original and user database properties. Notes on Solid Properties Two kinds of sand and one carbon steel are included in the solids database. Properties for the sands are taken from (R. D. Pehlke, A. Jeyarajan, and H. Wada, December 1982). The densities used to calculate density*specific heat were the dry sand densities. The silica sand has 7% Bentonite, and the Olvine sand has 5.9% Bentonite. The carbon steel density was that of 0.5% C at 1473 K. Import material from MPDB The Material Property Database (MPDB) for FLOW-3D is a third party database which can be purchased from Flow Science, Inc. separately. It contains a rich collection of temperature-dependent properties from the literature. In problems with thermal gradients, it is crucial to account for variations in different material properties as a function of temperature. MPDB for FLOW-3D is an exclusive version of MPDB which allows the user to export file formats that are compatible with FLOW-3D’s native database and therefore the data can conveniently be imported into FLOW-3D’s native database. The materials in MPDB are mostly solid. Therefore, any model in FLOW-3D which requires solid properties can take advantage of the data, in particular, the fluid-structure interaction, solidification and thermal stress evolution models.  MPDB can be used as a standalone database which can export data in a wide variety of formats. For general instructions on MPDB visit the JAHM Software, Inc. website. The instructions here are on how to use MPDB in conjunction with FLOW-3D. Once purchased separately, the executable for MPDB must reside in  %F3D_HOME%\Utilities in Windows and  $F3D_HOME/Utilities in Linux. The executable is called MPDB_for_FLOW-3D. This executable is detected by the FLOW-3D GUI and the menu item Import material from MPDB under the Materials menu becomes active. If any of these conditions are not met, MPDB cannot be accessed through FLOW-3D GUI. 
 Click on Import material from MPDB and the user interface for MPDB opens in a separate window. Materials have been categorized by their main elements. On the Elements tab, by right-clicking on an element from the table, the user can see a list of materials that contain that element. 
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 For example, the following figure shows a list of materials in the database which contains iron (Fe). 

 The user also can switch to other tabs which categorize different alloys, ceramics, glass or other unclassified material. The next figure shows the list for Al & Cu Alloys. 



 

 

 Once a material is identified, double-click on it and a separate window with a list of properties that are available for that material appears. For example, from the Fe & Ni Alloys, open 1006 (UNS G10060). Not all of these properties are used in FLOW-3D. 

 Each property can be displayed, plotted or saved to a file in different formats selectable on the right side of this window. However, not all these properties are used and recognized in FLOW-3D. In order to generate file formats that are compatible with FLOW-3D, close the material window and start from FLOW-3D/SolidWorks/ANSYS 



 

 

menu. There are 3 files formats with which the properties for a material can be imported into FLOW-3D, Fluids database format which has .f3d_dbf extension, Solids database format which has .f3d_dbs extension, and general comma separated value (csv) format. From the FLOW-3D/SolidWorks/ANSYS menu, select the FLOW-3D compatible format suitable to the simulation at hand. Although, the materials in MPDB are mostly solid, if the user wants to import properties for the solidified fluid, the Fluids database format should be chosen because in FLOW-3D the solidified fluid properties are part of fluid properties. The solids and fluids database file formats as well as the CSV files will be saved in the current user’s documents folder and inside <My Documents>\FLOW-3D\gui\MaterialsDatabase in Windows and  /home/<user>/FLOW-3D/gui/MaterialsDatabase in Linux. These locations are where the databases in FLOW-3D look for user defined materials. Any material that is exported by MPDB into these locations gets picked up by the native databases in FLOW-3D. From the FLOW-3D/SolidWorks/ANSYS menu select one of the FLOW-3D formats, for example, FLOW-3D solids database format (.f3d_dbs). Click on Create a new database… and choose a units system, for example, SI. The FLOW-3D/SolidWorks/ANSYS menu turns green which indicates a database file is open.  Select the 1006 (UNS G10060) iron alloy. 

 Some of the properties that were available previously are disabled simply because 



 

 

they are not relevant in FLOW-3D. Each property can be plotted, for example, thermal conductivity, first gives a Low temperature warning followed by the plot as a function of temperature. As soon as each property is processed, meaning plotted or data displayed, the Reference and Note sections become active. The Reference tab indicates where the property was taken from and the Note section usually contains notes regarding composition and accuracy of the data. 

 

 
 
 In order to write the .f3d_dbs file, click on the Add to database button and select the properties to be written to file on the next window. Properties can be selected for available phases. Once the properties are selected, click Write data and Close. Close the material window. Close database from the FLOW-3D/SolidWorks/ANSYS menu. In some cases a material is missing a property that the user needs. In those situations after adding available properties to database, the missing property can be obtained 



 

 

from an alloy which has similar properties (at the user’s own risk). As long the database is open, properties can be mixed and matched for the one material that is going to be used in FLOW-3D. 

 After Close database the user will be prompted for a filename, the default is what MPDB assigns to the material. The location and the extension of the file are preset so that FLOW-3D recognizes the material as a user-defined material. 

 In case a CSV file is selected. The same process applies, and once the data is written to file, it can be retrieved from the Import Values button on each tabular property window.  The first column is always temperature. 



 

 

 
Help Menu Selections in the Help menu provide the user with information about FLOW-3D software. Click on Contents to open the online FLOW-3D users’ manual. The Help menu also includes links to the FLOW-3D website, the users forum on CFD-Online and the FLOW-3D Users site. About reveals the specific versions of the FLOW-3D solver and user interface being used, well as other information regarding the machine and its environment variables. 

 
Navigator With the Navigator, users can create Workspaces in which multiple simulation files (prepin) can be arranged together for ready reference. 
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 Navigator Tab The Navigator tab is organized into four sections. On the left side of the tab is a tree structure which lists all open workspaces and the simulation files in each workspace. When FLOW-3D is first opened, a default workspace is seen. This default workspace enables the user to either start a new simulation or open an existing simulation without creating a workspace. The rest of the tab contains information about the workspaces and simulation files open in the Navigator.  At the top is a group, Portfolio, that summarizes the number of open workspaces and the number of included simulation files.  Below that, the Selected Simulation group identifies the location of the selected workspace file and simulation file.  The final group, Simulation Progress, displays the progress of the user’s simulations:  If the user has chosen to launch the solver for more than one workspace, the order of simulation will be given in the Simulation queue drop-down box. The user can order the queue so that workspaces are simulated in a different order than shown in the Navigator’s tree structure by selecting the preferred first workspace in the tree and either right-clicking and selecting Simulate Workspace or selecting Simulate Workspace from the Simulate menu in the main FLOW-3D menu bar. Next, in Simulation Summary, information is provided regarding which simulation is currently being simulated, the start time, and elapsed time for all chosen simulations. 



 

 

Finally, in Running Simulation, the simulation currently being simulated is displayed, along with the start time and elapsed time. 
More Information About Workspaces: A workspace is a container for simulation simulations. Workspaces can help the user organize his work, not only within FLOW-3D, but also on his hard drive. The user can organize related simulations for parametric studies or iterative designs. When testing alternative parameters, an original input file can easily be copied and the changes tested without lots of extra steps.  Normally, each workspace and each simulation file associated with the workspace will have a directory on hard disk. The default location for new simulation files is the directory of the workspace in which the new simulation is located, but the user can specify other locations. The default directory where workspace directories are saved can be specified. 
Examples of the Use of Workspaces: An engineering services company can use a distinct workspace for each job for a client, with each simulation file in the workspace representing various aspects of the client's design, or improvements to the model as work progresses on the job. The R&D department of a manufacturing concern has groups of simulations that are related to work on a specific development for an internal “client.” Workspaces can be used to hold the simulation files for each of these tasks. Workspace files can be stored anywhere in a user’s hard drive, and by themselves take virtually no space…they are only pointers identifying the location of simulation files. Many users will find it useful to organize associated simulations (simulation directories) by storing them as subdirectories in a directory together with a workspace file that essentially mirrors that directory structure. However, directories from different locations on your disk can be added to and saved in a single workspace without changing the location of the simulation file or the destination of any of the files FLOW-3D generates, such as results files, message files and so on. Another valuable benefit which users gain with Navigator is the ability to line up multiple simulations, each with its own settings, to run in “batch mode,” such as before leaving for the weekend or on vacation. In this way, workspaces can be used to assemble even disparate simulations to be run serially, with the associated FLOW-3D files being written to the original simulation file directory locations. The user can re-arrange the order of simulations within the tree structure by dragging and dropping the file in the tree. Left click on the simulation to be moved, hold the mouse button and drag it to the desired location. This feature might be useful, for example, if the user wants to assure the completion of a specific simulation over the weekend. 
Model Setup The Model Setup tab is to the starting point for FLOW-3D users to create or modify simulations. Like the user interface as a whole, the Model Setup tab is designed as a notebook organized into eight sub-tabs, arranged in the following order: 



 

 

Sub-Tab Title Purpose General General simulation parameters Physics Select physical models Fluids Import/edit fluids Meshing & Geometry Import/create geometry; create/modify mesh Output Define output to be captured Numerics Modify numerical settings The user works through the different sub-tabs to set various options and specifications for a simulation. The following sections describe the basic functions of each sub-tab within Model Setup. NOTE: THE USER CAN CHANGE THE COLOR OF THE MODEL SETUP SUB-TABS (FOR EASIER DISTINCTION FROM THE MAIN TABS) BY SELECTING SUB-TAB COLOR IN PREFERENCES IN THE MAIN MENU BAR. Resting the mouse on most edit boxes or radio buttons will cause the input variable for that option to appear in a fly-over box. 
General Tab Under the General sub-tab, the user sets certain fundamental options for a FLOW-3D simulation, including such parameters as flow mode (compressible versus incompressible), finish condition (time versus fill fraction), number of fluids, simulation units and more. The General sub-tab is also where the user sets the parameters for a restart simulation. 

 



 

 

The following describes generally the various parts of the General sub-tab. 
Finish Time If the simulation is to be based on finish time, enter the desired finish time for the simulation in the edit box. This time represents the actual time to be simulated (not wall clock time). If the simulation is to be based on Fill Fraction (see below under Finish Condition), then this box can be ignored. 
Restart The Restart button opens the Restart Options dialog box. 

 Within the Time group, specify the restart calculation time by choosing from the available times in the Restart time drop down box. This will be the time at which the solver will restart from the previous simulation. Check the Reset time to zero check box to set the restart time to 0.0. Specify an Initial time step in the edit box. If not specified, the time step at the restart time from the previous simulation will be used. Use the radio buttons in the Fluid Initialization, Turbulence, Scalar Transport, Particles and Temperature groups to specify different options for the restart simulation. 



 

 

Finish Condition The Finish condition button opens the Finish condition dialog box. 

 Use the Finish condition button to choose the basis for terminating the simulation. Under the Finish condition dialog box, termination can be based on time (Finish time), fraction of the open computational volume occupied by fluid (Fill fraction), fraction of the solidified fluid volume (Solidified fluid fraction; only available if the solidification model is turned on), or on reaching a steady-state condition. If either of the Fill fraction or Solidified fluid fraction options is selected, the desired final fraction (which must be between 0 and 1.0) is entered in the Finish Fraction edit box. By default, it is set to 1.0. The user can select up to six quantities that can be watched for the Steady state finish condition (Steady-state watch list). These quantities are Total mass, Total fluid energy, Total solid energy, Average mean kinetic energy, Average mean turbulent energy, and Average mean turbulent dissipation. The default Variation threshold over the Time window is 1.0%. That is, if over the duration of the time window each of the selected quantities varies by less than 1.0% of its mean value, the flow is considered steady. The simulation is then terminated with the termination message indicating the last variable to reach steady-state. The duration of Time window defaults to one tenth of the simulation finish time. The user can specify this Time window in the units of time.  NOTE: FLOW-3D WILL ALWAYS TERMINATE WHEN THE SIMULATION TIME REACHES THE FINISH TIME. 



 

 

Interface Tracking Select the appropriate radio button here to enable or disable the sharp interface tracking option. 
Number of Fluids Make the selection here between a one-fluid and a two-fluid simulation. 
Units In the Simulation units dropdown box in the Units section, the user can select the units to be used in setting up a problem. A unit system is used in specifying the properties for fluids and components. There are four choices for Simulation units: SI, CGS (default selection), Engineering and Custom. When the user specifies Simulation units, unit conversion is not implied; the setting is solely for the purpose of reference. Units are changed only while loading properties for the fluids and/or components. FLOW-3D does not assume any unit system and users must make sure that the units are consistent. The following example demonstrates the use of Simulation units: Goal: Load the properties for water in CGS units as Fluid 1.  Step 1: In the Simulation units dropdown menu, select CGS. Click OK. Step 2: From the Materials menu select Fluids Database, select "Water at 20 C in CGS units" from the Fluid Database, then click Load Fluid 1. Note that the radio buttons in the Convert units dialog are grayed out. In the Temperature units dropdown box in the Units section, the user can select the temperature units to be used in the given simulation. SI and CGS only allow for Degrees Kelvin or Celsius. Engineering units only allow for Degrees Rankin or Fahrenheit. Custom units will allow any of the temperature units. 
Flow Mode Select the appropriate radio button here to choose either incompressible or compressible flow. To accelerate flow not containing a free surface to the steady state, check the Steady State Accelerator check box. 
Mentor Options Use the radio buttons to select the desired Mentor level. 
Version Options The FLOW-3D program comes with four versions of the solver program: Single Precision, Double Precision, Custom Single Precision and Custom Double Precision. The user selects his desired version in the Version options section. When FLOW-3D is first installed, the Single Precision and Custom Single Precision versions are identical, as are the Double Precision and Custom Double Precision version. If a user has modified any of the distributed FLOW-3D source subroutines, the recompiled version of his customized code will be accessed by selecting Custom Single Precision or Custom Double Precision, as appropriate (see the Customization chapter of this manual). 



 

 

The other selection in the Version options section is between the serial and the shared-memory parallel versions of the FLOW-3D solver. If the machine being used has more than one processor and the user has acquired an upgrade to enable parallel processing, the number selector next to Number of processors will be active and the user can select the number of processors to be used. Check the Run serial code if parallel tokens in use box if more than one users have access to solver tokens, not all available solver tokens are parallel tokens and you want to run your simulation whether a parallel tokens are available or not. Check the Use parallel code if the license file contains both serial and parallel tokens and the user wishes to increase the number of processors the simulation is using. By default, FLOW-3D is set to double precision and all available processors. The default settings can be reset by selecting Reset to Defaults button. NOTE: CHANGES MADE TO THE VERSION OPTIONS IN THE GENERAL TAB WILL NOT AFFECT THE SETTINGS FOR OTHER SIMULATIONS, INCLUDING NEW SIMULATIONS CREATED AFTER THE CHANGE IS MADE OR EXISTING SIMULATION FILES OPENED AFTER THE CHANGE IS MADE. In order to run FLOW-3D using its multi-processor capability, the user must have a special token from Flow Science. 
Notes Use the box in the Notes section of the General sub-tab to enter documentation about the simulation. Some useful items to record include date of setup, assumptions, and units. The first line of the Notes section will appear on all plots. The font used in the Notes section can be changed by clicking on the Font… button in the upper right-hand corner of the Notes section. 
Physics The Physics sub-tab is where the user selects the physical models to be used in her simulation. Each button provides access to a dialog box or boxes where the user turns on the model and enters information or changes options associated with the selected physical model. The user should specify the appropriate physical models through the Physics sub-tab before proceeding to the Fluids sub-tab. 



 

 

 The buttons for the various physical models are ordered alphabetically. If a button contains a checkmark, then some aspect of that model has been activated, as so:  Click on a model button to open a dialog box to activate and set parameters for the model.  The following table briefly highlights the methods of activation and the requirements for each model: Model Activate By Requirements Air entrainment Check the box General tab: One fluid and free surface Bubble and phase change  Select one of the four buttons  General tab: One fluid and free surface. Thermal bubble options also require heat transfer model to be turned on. Two-fluid phase change Select the radio button in Bubble and phase change model General tab: Two fluid and compressible flow mode Cavitation Check one of two options General tab: One fluid and free surface Core Gas Check the boxes to Activate Core Gas Physics tab: Full obstacle heat 



 

 

Model and Print Venting  transfer must be turned on Meshing and Geometry tab: Core gas and Core gas properties must be defined Defect tracking Select the “Track free surface” radio button General tab: One fluid and free surface Density evaluation Selecting one of the second two radio buttons None Dissolving objects Check the box None Drift-flux Check the box (not active unless requirements are met) Physics tab: Viscous flow plus one of: (1) solve transport equation for density; (2) 2-fluid flow without free surface; or (3) 1-fluid flow with solidification.  Elasto-visco-plasticity Check the box None Electro-mechanics Check the box for “Activate electric potential” to make options available.  None Fluid Sources Check the box None Granular Flow Check the box Physics tab: Activate the Adiabatic bubble model from the Bubble and phase change button, define gamma, and initial void pressure, which must be absolute pressure. Gravity Fill in gravity component for a given direction None Heat transfer Select one of the two radio buttons Fluids tab: Define fluid specific heat and conductivity in Thermal properties Lost Foam Select one of the two radio buttons Physics tab: First-order heat transfer with “full energy equation” selected Moisture  Physics tab: Moving and flexing objects Use check boxes to activate General Moving Objects, Collision and Deforming models. None Non-inertial reference frame (RF) Check the box None Particles Click Edit next Particle block(s), Particle source(s) , History particle(s) to open Particle block options, Particle source options, Particle history options dialog box. None 
Porous media Select one of the two options General tab: For unsaturated flow, 



 

 

one fluid and free surface must be selected. Scalars Use the arrow key next to Number of Scalars to add scalars. None Sediment scour Use the arrow key next to Number of Sediment Species to add sediment species. None Shallow water Check the box General tab: One fluid and free surface Solidification Check the box  Physics tab: Heat transfer General tab: One fluid and free surface Surface tension Check the box None Thermal die cycling Check the box Physics tab: First-order heat transfer, with “solve full energy equation in solids” selected. Numerics tab: Use Zero velocity field. Viscosity and turbulence Check the box Fluids tab: Fluid viscosity must be defined. For further details on use of the various models, see the Model Reference chapter and the Theory chapter. 
Fluids The Fluids sub-tab is where a user can input the fluid(s) properties to be used in a simulation. 



 

 

 
Properties Tree Use the Properties tree to enter or modify properties for a fluid that has been loaded into the simulation file. Clicking on a branch with a + expands the branch to the next level. Some items in the tree will have an icon button next to it. The button will only be activated when the appropriate physics have been selected. When this button is depressed, equations, charts, or both will be displayed in the box next to it. Below the display is a list of equations that can be selected, changing the display to show the associated charts, equations, or both. Tabulated data may be added using the Tabular button and checking the box. The data can be added manually by adding .cvs file from the simulation directory or another directory. 
Meshing & Geometry This sub-tab enables the user to create or import geometry files, to create or modify a computational mesh, set boundary conditions and initial conditions, and to specify certain quantities and properties like thermal conductivities, heat transfer coefficients, mass sources and moving object properties. The sub-tab is divided into three primary parts: a set of menu and tool bars, a tree structure and an interactive OpenGL-based graphical window. Each of these is described in detail below. 



 

 

 
Menu Bar Within the Meshing & Geometry tab, there is a menu bar which governs functions within this tab only.  
Tools Menu The Tools menu enables the user to conduct several functions, such as image capture, saving and loading light and eye point positions, changing background color, loading material properties from a customizable database, etc. 

 The Tools menu options are: Take A Snapshot Allows the user to capture a snapshot of the graphical window. Captured formats are .bmp, .jpeg or .png. When a format is selected, a Save Image File window pops up. Assign a name to the image file in the File Name box. Files may be saved in any directory the user can access, locally or across a network. 



 

 

Axis Rotation Selecting Axis Rotation displays or hides the Axis Rotation dials in the lower left corner of the Meshing & Geometry tab.  Rotations will take place about the x, y, or z axes (as manipulated on the dials) in the Perspective panel in the graphical window. To rotate, left-click on one of the dials and drag left or right or type in the degrees of rotation. Select all Objects Use this menu selection to select all of the objects in the graphical window. ADmesh Selecting ADmesh opens the following window: 

 This tool can be used to check an STL file. A further description on how to use this tool can be found in Meshing & Geometry. Options Selecting Options opens the following window: 



 

 

 There are three tabs: Color, Light/Camera Settings, and 3D Graphic font. Color The Color tab, shown in the image above, allows the user to change the colors for a number of the tools in the Meshing & Geometry tab, such as the background, the front and back face of objects (when in Back Face view), the display box, the rubber band and graphic text. The color of the buttons next to each item indicates the active color for that item. Left-click on the button next to any item to open a window providing a color palette to choose from. Light/Camera In the Light/Camera Settings tab, the user can save a light or camera position by clicking Save and then selecting the desired location of the file (*.env for camera position file; *.lght for light position file), usually the simulation subdirectory. An existing light or camera position file can be loaded by selecting Load and browsing to find the file in the saved location. 3D Graphic Font 3D Graphic font is the third tab, but it is used solely for displaying results, so it has no effect in Model Setup. 
View Menu The View menu allows the user to choose several viewing options in the Meshing & Geometry window. 



 

 

 The View menu options are:   Boolean  Select Boolean to change the coloring of all geometry objects so that any subcomponents that are holes are one color and any subcomponents that are complements or solids are another color. The colors used can be changed; go to Tools > Options > Color and select Hole or Solid. Back Face Select Back Face to color the front and back faces of objects differently for easier inspection. The colors applied for either the back or the front face can be changed; go to Tools > Options > Color and select Front face or Back face. Show Plane Limiters(s) The view option Show Plane Limiters is available for users to view the location of plane limiters. Users have the option of seeing all plane limiters, low and high, or any combination of the three (X, Y and Z) directions.  Wireframe Select Wireframe to display geometry as a wireframe. Draw Axis Selecting Draw Axis enables the user to display an XYZ coordinate system: (1) at the center of the object; (2) at the origin (0,0,0); or (3) in the lower left-hand corner of the graphical window. The user may also choose to have no coordinates displayed. Whichever display choice is chosen, the X-axis is always displayed in red, the Y-axis in green, and the Z-axis in blue. Show 3D Length Scale Select Show 3D Length Scale to display the numerical values of the X, Y and Z extents of the mesh and geometry. 



 

 

 Display Box Users may notice that movements, rotations and zooming of objects consisting of a very large number of triangles may be very slow. To speed up these operations, select Display Box. With Display Box activated, only the containing box is displayed when the user clicks on the object to move it, rotate it or zoom it. Once the mouse is released, the original object is again displayed. The default setting is Display Box. Probe Point List Selecting Probe Point List allows users to see multiple probe points as they are being selected, which eliminates the need for users to write down the individual probe points. Switch to perspective projection A perspective projection is a frustum of a pyramid (a truncated pyramid whose top has been cut off by a plane parallel to its base). Objects that fall within the viewing volume are projected toward the apex of the pyramid, where the camera or viewpoint is. Objects that are closer to the viewpoint appear larger because they occupy a proportionally larger amount of the viewing volume than those farther away in the larger part of the frustum. Switch to orthographic projection In an orthographic projection, the viewing volume is a rectangular parallelepiped, or more informally, a box. Unlike perspective projection, the size of the viewing volume doesn't change from one end to the other, so the distance from the camera doesn't affect how large an object appears. 
Mesh Menu The Mesh menu gives the user options for controlling the display of the computational mesh. 

 The Mesh menu options are as follows: View mode Sometimes a mesh might be too dense for easy viewing when turned on. Users can 



 

 

choose to display only the mesh outline or only Fixed Points. To so limit the mesh display, select View Mode > Outline or View Mode > Fixed Points. To return to display the full mesh, select View Mode > All. Show Select Show to turn on the mesh display. Slice  Select Slice to investigate how a mesh resolves the geometry by moving through the mesh, row by row. Where Cartesian meshes are being used, a box appears, enabling the user to slice the mesh row by row from any (and each) of six directions (X positive, X negative, Y positive, Y negative, Z positive and Z negative), using the slider bars or arrow buttons. 

  NOTE: MESH SLICE WORKS ONLY FOR ONE MESH BLOCK AT A TIME. SELECT THE MESH BLOCK TO BE SLICED USING THE DROPDOWN BOX AT THE TOP OF THE MESH SLICE DIALOG. In cylindrical meshes, users can only slice in two directions, Z positive and Z negative. Create  By selecting Create from the Mesh menu, the user can use the mouse to create a mesh, rubber-band style. This function may also be invoked by clicking on the Create button on the menu bar:  When Create is invoked, a message appears with both directions and a warning. Click OK and then place your mouse pointer in one corner of where you wish to place your mesh, press the left mouse button and drag the mouse to the opposite corner, releasing the mouse button at the far extent you wish the mesh to be. Upon releasing the mouse button, the following dialog box will appear (for Cartesian meshes): 



 

 

 The user can adjust the precise location of the minimum and maximum extents of the mesh, if desired. The user can also check the Snap to geometry box if he wishes to make the mesh block conform to the extents of the geometry upon which the mesh has been placed. The user also can enter the total number of cells he wishes the mesh block to contain in the Total number of cells edit box. NOTE: IN ORDER TO USE THE RUBBER-BAND FUNCTION, THE GRAPHICAL WINDOW MUST BE IN ONE OF THE SIX PLANE VIEWS (X-Y POSITIVE OR NEGATIVE, X-Z POSITIVE OR NEGATIVE AND Y-Z POSITIVE OR NEGATIVE.  It will not be possible to achieve the exact number of mesh cells entered in Total number of cells in the FLOW-3D preprocessor. A further description of how to create computational meshes is given in Meshing & Geometry. 
Subcomponent Menu Subcomponents are created by starting from the Subcomponent menu (or, for FLOW-3D primitives, by clicking on the appropriate icon in the Toolbar). A more complete discussion of creating geometry is contained in Chapter 5, Meshing & Geometry. 

 Sphere  To create a sphere subcomponent, select Sphere in the Subcomponent menu (or click on the sphere icon in the Toolbar). 



 

 

Cylinder  To create a cylindrical subcomponent, select Cylinder in the Subcomponent menu, or click on the cylinder icon in the Toolbar. Cone  To create a conical subcomponent, select Cone in the Subcomponent menu or click on the cone icon. Box  To create a box subcomponent, select Box in the Subcomponent menu, or click on the box icon. Torus  To create a toroidal subcomponent, select Torus in the Subcomponent menu (or click on the torus icon). Geometry File(s)  Users can import different types of geometry files into FLOW-3D. The most common file type imported is stereolithography (STL) files. Virtually every CAD program can save objects created in the program as an STL file. In addition, users can import Ansys or I’DEAS files, as well as topographical files. To import any such files, select Geometry File(s) in the Subcomponent menu. Advanced Select Advanced if you are an experienced user and wish to use the global geometry creation approach available in earlier versions of FLOW-3D. New users and users with limited experience are advised to ignore this option. STL Library A small library of STL objects is provided (including some basic shapes and files used in the Tutorials). For users that have objects frequently used in multiple simulations, this library can be expanded. Save the intended STL files into the “gui\stl_lib” subdirectory of the FLOW-3D home directory. 
Toolbar Just below the Menu Bar in the Meshing & Geometry tab is the Toolbar, which contains numerous functions. 

 The following is a description of the functions of each icon. Navigation Icons   Select this icon to print the view shown in the graphical window. A standard Print dialog box will open, enabling the user to select a printer and make changes to the print quality, etc.  Allows the user to use the mouse to quickly zoom in on an object. NOTE: MAKE THE FIRST APPLICATION OF THIS ZOOM AS SMALL AS POSSIBLE, AS THE ZOOMING CAPABILITY DECREASES SIGNIFICANTLY AFTER THE FIRST APPLICATION.  Resets the objects to original position, prior to moves and zooming. 



 

 

 Eyepoint changes (zooming, rotating or moving the geometry) can be reversed by clicking on the Undo icon. Up to 20 eyepoint changes are saved.  The Redo icon repeats an eyepoint change that was undone with the Undo icon. View Icons    FAVORize icon. Click on the FAVORize icon to open the FAVOR™ dialog box. Using this tool, a user can obtain a quick view of how, using FLOW-3D’s FAVOR™ method, the created mesh will resolve the geometry on a problem. In addition, the user can view any initial fluid regions. 

 In the FAVOR™ dialog box, the user can FAVORize geometry using the computational mesh created in the Meshing & Geometry sub-tab, or create a special grid by clicking the Using Renderspace radio button. The user selects between the Open and Solid radio buttons to view the open or solid volumes of the geometry. To view the initial fluid regions, check the View fluid box. The complement of fluid region can also be displayed. In order to FAVORize using renderspace, the user must first create this domain by clicking on the Create Renderspace button. This brings up a Render Space Dimensions dialog box for the user to assign maximum and minimum values for the space to be rendered in FAVORized view, and the cell size to be used to resolve the geometry in FAVORized view. A user may choose the renderspace option in order to use much finer resolution of his geometry than in the actual simulation. The user also has the option to use the geometry extents and can easily add these by selecting the Geometry extents button. 



 

 

 Once a user has generated a FAVORized view of geometry, the cutting planes feature or the mesh slice feature can be used to investigate the interior portions of the geometry. Click on the Return to Model Building button to return to regular view in the Meshing & Geometry tab.  Cutting Planes icon. Opens a dialog box that allows the user to push a cutting plane through the geometry. 

 There are a total of six cutting planes possible, and all six can be used simultaneously. Use the mouse to move the bars or click on the arrows at the end of each direction to move a cutting plane. The location of the cutting plane will show in the graphical window as the plane is pushed through the geometry. The option to not show the planes is made available. Once the Close button is selected the geometry will return to its original state.  Mesh Slice icon. This icon opens the same dialog box and enables the user to slice through the mesh one row at a time, as described in the Mesh Menu discussion above. ,  Click on this icon to orient the graphical window in the X plane, either positive or negative. When clicked, the icon shown changes to the opposite plane. ,  Click on this icon to orient the graphical window in the Y plane, either positive or negative. When clicked, the icon shown changes to the opposite plane. ,  Click on this icon to orient the graphical window in the Z plane, either positive or negative. When clicked, the icon shown changes to the opposite plane. ,  Click on this icon to orient the graphical window in the perspective view. 



 

 

,  Click on this icon to change from orthographic projection to perspective projection. Geometry Icons These Toolbar options give the user ready access to create basic FLOW-3D primitives: spheres, cylinders, cones, boxes and toroids. Another button (STL) is for users to import different types of geometry files. A further description is given at Subcomponents Menu above.  Mesh Icons These Toolbar options give the user ready access to turn on or off the mesh creation function, and to update the mesh after changes have been made. A detailed description of how to create meshes is given in Meshing & Geometry.  Click on the Create icon to use the mouse to rubber-band create a mesh. Further definition of the use of this function is given above. NOTE: IN ORDER TO USE THE RUBBER-BAND FUNCTION, THE GRAPHICAL WINDOW MUST BE IN ONE OF THE SIX PLANE VIEWS (X-Y POSITIVE OR NEGATIVE, X-Z POSITIVE OR NEGATIVE AND Y-Z POSITIVE OR NEGATIVE).  Click on the Mesh Update icon to update the mesh in the graphical window and the Tree Structure. NOTE: UPDATING A MESH BY USING THE UPDATE ICON ONLY RECALCULATES AND REDRAWS THE MESH LINES BASED ON THE LATEST CHANGES; IT DOES NOT ALTER THE SIMULATION INPUT (PREPIN) FILE. TO MAKE THE CHANGES TO THE PREPIN FILE, SAVE THE SIMULATION. 
Transparency Slider Bar The user can control the transparency of all objects in the graphical window via the Transparency slider bar:  Left-click, hold and drag the control left or right with the mouse. To apply transparency to one subcomponent at a time, select that subcomponent by clicking on the subcomponent in the Tree Structure. Then right-click to open this menu: 



 

 

 
Tree Structure On the left-hand side of the Meshing & Geometry sub-tab, a Tree Structure gives the user handy access to a considerable amount of information concerning all components, subcomponents, meshes, boundaries, initial conditions, and mass sources/sinks that have been created. In addition, the user can apply transformations to (or delete) components and subcomponents, can enable or disable components and subcomponents, enter numerous parameters (e.g., moving objects, collision properties, solid properties, initial conditions and more), add and modify baffles, and add, change and delete meshes. 



 

 

 
Navigating the Tree Structure Click on the + sign next to an entry in the Tree Structure to open the branch. Click on the – sign to close the branch. Double-click on the name of the branch (rather than the + or -) to open all levels of the Tree Structure in that branch. Click on a mesh block number in the Tree Structure to select that mesh block in the graphical window. Click on a subcomponent number in the Tree Structure to select that subcomponent in the graphical window. 
Geometry Branch The Geometry branch in the Tree Structure contains most geometry-related information for the open simulation input file. 



 

 

Global The Global branch displays the minimum, maximum and extent for each direction of the domain. Components Each component is listed separately in the Tree Structure. Under each component, branches are shown for subcomponents created for each component, as well as Component Properties for entering/modifying Type of Flexing Object, Type of Deforming Object, Dissolving, Collision Properties, Mass Source, Solid Properties, Surface Properties, Initial Conditions, Electrical Properties, Mold Vent, Core Gas Component Properties, Lost Foam Properties, Porous Properties, Moisture Properties, FSI Deformable Component, Thermal Stress Analysis, Granular Flow Vent Properties, and Output for the component. Additionally, the components can be disabled, allowing for the user to turn them off during a simulation or while pre-processing. 

 Changing Component Properties The color of a component, as displayed in the graphical window, can be changed by clicking on the colored box to the right of the component number in the Tree Structure. This opens a standard color palette dialog box to enable color changes. Each geometry component and subcomponent can be give unique names to help distinguish them from each other. Additionally, the material name can be entered for each geometry component. If a component’s material properties are loaded from the material database, the component’s material name will come from that database entry.  The component type can be changed in the dropdown box to the right of the branch titled Component Type. Click the mouse inside the box to reveal the selections: Standard, Lost Foam, Porous and Domain Removing. 



 

 

These are the same options given when the component was created (see Creating Geometry in Meshing & Geometry). Components and subcomponents can now be enabled or disabled. This allows the user to enter all the geometry at once and to only enable the geometry deemed necessary for that particular simulation run. If the Activate membrane and wall model box was checked in the Physics sub-tab, the edit box to the right of the Type of Flexing Object branch will be active and the type of flexing object can be selected. Click the mouse inside the box to reveal the selections. Click on the + next to Type of Flexing Object to open the Flexing Object branch. Click the box titled Edit to open a dialog box enabling the entry of necessary parameters for modeling the selected type of flexing object.  If the Moving Object model has been turned on in the Physics sub-tab, the edit box to the right of the Type of Moving Object branch will be active and the motion type can be selected. Click the mouse inside the box to reveal the selections. Click on the + next to Type of Moving Object to open the branch Moving object properties. Click the box titled Edit to open a dialog box enabling the entry of necessary parameters for modeling the selected type of moving object. For a detailed description of the required settings in these dialog boxes, see the GMO section in Model Reference. Output allows users to output Pressure and Shear Forces and/or Buoyancy Center, Metacentric Height, and Component Wetted Area. Buoyancy Center and Metacentric Height can only be activated if Moving Objects in the Physics sub-tab has been activated. The output is written to the Global history data catalogue in the Analyze tab, Probe sub-tab. Changes to the properties and to the initial conditions of a selected component can be entered directly in the appropriate box in the Tree Structure. Some properties need to be activated by checking the box next to them before data can be entered. NOTE: AS THE EDIT BOXES IN THE TREE STRUCTURE ARE PRIMARILY TIED TO THE INITIALIZATION OF PHYSICAL MODELS IN THE PHYSICS SUB-TAB, MANY EDIT BOXES WILL NOT BE ACTIVE UNLESS THE APPROPRIATE MODEL IS TURNED ON. The material properties of components can be imported via the Solids Database selection from Materials menu. Subcomponents For every subcomponent, there are the following branches: Name; Subcomponent type; Enable; Min/Max; Transformations; Limiters; Mass Density; and Cooling Channel. Right-click on any subcomponent in the Tree Structure and the following dialog will pop out: 



 

 

 Delete This selection will delete the selected subcomponent. Since the deletion is permanent, the user is asked to confirm the selection. Disable/Enable Selecting Disable/Enable will disable or enable the subcomponent depending on what its initial state is in. Transparency Selecting Transparency will open a dialog box to enable the user to apply transparency to the selected subcomponent only. Hide Select Hide to hide the selected subcomponent. Show all Select Show all to show all subcomponents (useful if one or more subcomponents have been hidden) Show only Select Show only to show only the selected subcomponent (useful if there are many subcomponents and the user needs to examine one closely) Show Select Show to show the selected subcomponent if it has been hidden Copy Selecting Copy will enable the user to copy the subcomponent into the same component or another existing or new component. This can be useful when a problem involves many very identical or very similar objects. This selection opens the following dialog: 

 The subcomponent name, position, and type can be defined in this dialog box. Click Transform to translate, rotate, and reflect the copies across given coordinate planes to become additional parts of a component. Cancel stops the process without copying the subcomponent. Reassign Selecting Reassign will enable the user to place the subcomponent in a different order 



 

 

in the Tree Structure, either within the same component, another existing component, or a new component. This function can be useful if a user has failed to create subcomponents in the required order (see Creating Geometry in the Meshing and Geometry chapter). Expand all Selecting Expand all will open all the tree branches associated with that subcomponent. Collapse all Selecting Collapse all will close all the branches associated with that subcomponent. Collapse others Selecting Collapse others will collapse all other subcomponents in the same Subcomponents tree. Expand/Collapse to one level Selecting Expand/Collapse to one level will collapse or expand up to the Subcomponent level Subcomponent type Click in the box next to Subcomponent type to make a change to the type of the subcomponent (options are Solid, Hole and Complement; see  Creating Geometry in the Meshing and Geometry chapter). Min/Max The minimum, maximum, and extent in each direction, and the surface area of each subcomponent are displayed here. These entries are informational only and cannot be edited. 
Transformations All transformations (magnifications, rotations, or translations) that the user may have made to the subcomponent when creating or importing the subcomponent are displayed here. In addition, the user can apply any combination or all transformations to the subcomponent by typing the desired magnification, rotation, or translation in the appropriate edit boxes for the subcomponent and then pressing enter. Typically the magnification and rotations occur at the center 0,0,0. The Transformations center allows the user to specify the center for the transformations such as rotation and magnification occur. Limiters Limiters applied to the subcomponent created using the Advanced option in the Subcomponent menu will be displayed in this portion of the Tree Structure. Limiters can also be applied by making entries in the appropriate edit boxes for the subcomponent and then pressing enter. Mass Density If a user is specifying different mass densities for individual subcomponents, the edit box to the right of Mass Density is where the values can be entered. For a further description, see General Moving Objects in the Model Reference chapter. Cooling Channels The user can define geometry as a cooling channel eliminating the use of void pointers. The appropriate physical models from the Physics tab or menu must be activated in order to check this box. Three types of cooling channels can be defined, identified by the heat transfer coefficient to the die. Each subcomponent can defined multiple cooling channels of the same type. 



 

 

Solidified Fluid Region The thermal stress evolution of a solidified fluid region requires the Finite Element meshing. This branch allows the user to define the FE (Finite Element) mesh by using a file and checking the box Simulate with specified mesh file. If this is not checked and file has been selected it will overwrite this file. To modify the existing mesh the user must open the FE Mesh File tree and checking the Use local input mesh. This will open a copy of the global mesh and allows the user to modify it. For more information about FE meshing see the Fluid Structure Interaction section. 
Mesh Branch The Mesh branch in the Tree Structure contains all mesh-related information for the open simulation input file. Right-click on Mesh in the Tree Structure to open the following selection box: 

 The following table explains each of the functions in the selection box shown above: Add a mesh block Mesh blocks can be added by choosing Add a mesh block, or by right-clicking on any listed mesh block and selecting Add. A dialog will appear asking if the user wishes to add a mesh block with boundary data. Click Yes to proceed. A new mesh block will now be inserted into the Tree Structure. This mesh block will have 10 cells in each of the X and Z directions and 1 cell in the Y direction. The extent of the mesh is 0 and 1 in each direction. Modify the mesh as discussed above. Change to Cylindrical Coordinates Select Change to cylindrical coordinates to change from the Cartesian coordinate system to a cylindrical coordinate system (or back). When in the cylindrical coordinate system, the selection in this box will read Change to Cartesian coordinates. Changing coordinates deletes all mesh blocks and leaves only a default mesh. So, when the user selects to change coordinate systems, the following warning window will pop up: 
 Mesh block summary information… Mesh block summary information opens an informational box that displays general information on cell count for all mesh blocks. 



 

 

 Mesh View Mode Allows the user to show mesh outline, planes, grid lines, or the boundaries. Show all mesh blocks Show all mesh blocks will cause all existing mesh blocks to be seen in the graphical window. Hide all mesh blocks Hide all mesh blocks will cause all existing mesh blocks to be hidden in the graphical window. Expand all Selecting Expand all will open all the tree branches associated with that subcomponent. Collapse all Selecting Collapse all will close all the branches associated with that subcomponent. Collapse others Selecting Collapse others will collapse all other subcomponents in the same Subcomponents tree. Expand/Collapse to one level Selecting Expand/Collapse to one level will collapse or expand up to the Subcomponent level Mesh Block Specific Operations Right-click on any numbered mesh block to open the following selection box: 



 

 

 The following table explains each of the functions in the mesh block-specific selection box shown above: Add Mesh blocks can be added by selecting Add. A dialog will appear asking if the user wishes to add a mesh block. Click Yes to proceed. A new mesh block will now be inserted into the Tree Structure. This mesh block will have 10 cells in each of the X and Z directions and 1 cell in the Y direction. The extent of the mesh is 0 and 1 in each direction. Modify the mesh as discussed above. Delete Mesh blocks can be deleted by right-clicking on any listed mesh block and selecting Delete. A window will pop up to confirm that deletion of the block is desired. Click Yes to confirm. This will delete the selected mesh block. Auto mesh… Right-click on any listed mesh block and select Auto Mesh. The user will be prompted to save before proceeding. The Auto Mesh dialog box as seen below: 
 Using this function, the user can choose to assign a set number of cells in one or more directions or can stipulate the size of all cells. Any fixed points between the domain of the mesh can be removed by checking the Remove mesh constraints. Adjust mesh block… Select Adjust mesh block to open a dialog box that enables you to make adjustments to the size of any mesh block. 



 

 

 The dropdown menu (top) allows you to select any existing mesh block for adjustment. To snap to the closest geometry extent in a given direction, select the snap button in that given direction. Scale mesh block… Select Scale mesh block to change the scale of the selected mesh block in all three directions at once. Adjust the ratio to the desired scaling and click OK. Move mesh block… Any existing mesh block can be moved by right-clicking on the mesh block in the Tree Structure and selecting Move mesh block. A dialog box will open to allow for the placement of the new mesh block by entering the appropriate X, Y and Z coordinates. Copy mesh block… A new mesh block can be created by copying any existing mesh block. Right-click on the desired mesh block in the Tree Structure and select Copy mesh block. A dialog box (same as above) will open to allow for the placement of the new mesh block by entering the appropriate X, Y and Z coordinates. Split mesh block… Select Split mesh block to open a dialog box (below) in order to split the mesh block into multiple mesh blocks. Check the Transfer all boundary conditions to the new blocks box to transfer all boundary conditions to the relevant boundaries of the external boundaries after splitting. 

 NOTE: THE SPLIT MESH BLOCK FEATURE IS PRIMARILY FOR USE IN CONJUNCTION WITH THE DISTRIBUTED-MEMORY VERSION, FLOW-3D/MP. IT IS NOT RECOMMENDED FOR USE WITH THE STANDARD VERSION OF FLOW-3D. Fit to Geometry Select Fit to Geometry if to change the mesh dimensions automatically to encompass the entirety of the geometry in a problem. The selection brings up the following dialog box: 



 

 

 Here the user can either specify a total number of cells or the size of the cells. An offset option allows the user to create an equal offset in all directions. Mesh information… Mesh information… opens a dialog that displays general information about the cell count for all mesh blocks. 

 Mesh View Mode Mesh View Mode allows the user to view the Mesh Outline, Mesh Planes, Grid Lines or the Boundaries. Hide Hide mesh will cause all existing mesh blocks to be hidden in the graphical window. Show Show mesh will cause all existing mesh blocks to be visible in the graphical window. Show Only Show Only will cause the only selected mesh block to be visible in the graphical window. Show all If any mesh block is hidden, Show all will cause all existing mesh blocks to be visible in 



 

 

the graphical window. Expand all Selecting Expand all will open all the tree branches associated with that subcomponent. Collapse all Selecting Collapse all will close all the branches associated with that subcomponent. Collapse others Selecting Collapse others will collapse all other subcomponents in the same Subcomponents tree. Expand/Collapse to one level Selecting Expand/Collapse to one level will collapse or expand up to the Subcomponent level. Click on the + sign next to any mesh block to open another branch that shows, for each direction (X, Y, and Z), the total number of cells and all fixed points. 

 Any mesh block can be modified by entering changes to the total number of cells or the fixed points in the appropriate edit boxes.  Mesh block colors can now be changed. The default colors are the preset colors. To change the colors of all new mesh blocks being added, select the color bars next to Mesh. The left-hand color represents the mesh planes and the right-hand color with the arrow represents the lines. The option to apply these standard colors to all, to reset to the preset or default, and the option to reset all the older mesh blocks back to preset are available when clicking on the color. 
  Additionally, the user can change individual mesh blocks. Mesh planes can be added to an existing mesh block by right-clicking on the plane direction or one of the Mesh Planes and selecting Add. The following dialog box will appear: 



 

 

 Mesh Planes can be added to an existing mesh block by right-clicking on the plane direction or one of the Mesh Planes and selecting Add.  From this dialog, mesh planes can be added to any existing mesh block, in any direction, without closing the box. Simply select the mesh block from the Mesh Block by using the arrows, select the direction from the Direction dropdown box and enter the point in the New mesh plane box. Click Add and the new mesh plane will be added. The box remains open for more entries. Click Close to finish. Mesh planes can also be deleted from an existing mesh block by right-clicking on one of the fixed Mesh Planes and selecting Delete. This will delete the selected Mesh Plane. The delete option is only available if there are more than two fixed points. 
Boundaries Each boundary of the computational domain has an associated boundary condition. The user enters the boundary condition types in the Meshing, Boundary tree. 

 The boundary condition type for each boundary of a mesh block can be displayed by right-clicking on Mesh block, selecting View mode, and then selecting Boundaries. This will graphically display colored boundary labels in the graphical window. The boundary condition type is also shown in the Tree Structure on the right side of the boundary limits. 



 

 

 The icons in the graphical window are colored red, green and blue to correspond with the x, y, and z coordinates, respectively. The letters on each icon represent the assigned boundary condition type.  The user sets boundary condition types and enters values and parameters, including time-dependent values, in the Boundary dialog box. This dialog can be opened one of two ways: click on the appropriate icon in the graphical window or on the button to the right of the desired boundary in the Tree Structure. Boundary Dialog Box The Boundary dialog Box enables the user to select boundary conditions for that mesh boundary. Use the radio buttons in the Boundary type group at the top of the dialog to select the type of boundary condition. When finished with changes, click OK to exit the Boundary dialog and save all changes made. Click Cancel or the X in the upper right corner of the Boundary dialog to exit without saving any changes. 



 

 

 There are edit boxes to set a constant value for the following parameters at a given boundary: Volume flow rate, Velocity, Pressure, F (fluid) Fraction, Fluid elevation, Density, Alloy solute concentration, Electric charge, and Electric Potential. To add a constant concentration for scalars or sediment the user must first select the Scalars or Sediment concentration button. NOTE: CLICK THE STAGNATION PRESSURE CHECKBOX TO ENABLE OR DISABLE STAGNATION PRESSURE FOR THAT BOUNDARY. IF STAGNATION PRESSURE IS DISABLED, A STATIC PRESSURE BOUNDARY CONDITION IS USED INSTEAD. A STAGNATION PRESSURE BOUNDARY ONLY APPLIES TO PRESSURE BOUNDARY CONDITIONS. The user can set time-dependent conditions for velocities, pressure, fluid fraction, fluid elevation, density, , solute concentration, sediment concentration, scalars, electric charge, and electric potential. Click on the appropriate button to open a Time Edit table to specify time-dependent conditions.  The user can also import data either located in the simulation directory or elsewhere. To import data, select the appropriate button to open the tables, select import data to search for the data file or select import data from simulation directory. A graph of the data is shown next to the table to allow the user to verify that their data has been entered correctly. 



 

 

 NOTE: TIME ENTRIES MUST BE CONSISTENT ACROSS ALL BOUNDARY CONDITION TIME-DEPENDENT TABLES SPECIFIED. REMEMBER TO HIT ENTER OR CLICK IN ANOTHER CELL AFTER THE LAST DATA ENTRY. The Thermal information button opens the Thermal boundary options dialog box. The Turbulence quantities button opens the Turbulence quantities dialog box. Thermal Boundary Options Dialog Box The Thermal boundary options dialog box enables the user to enter various properties associated with the energy equations and thermal nature of the simulation. Enter a boundary temperature in the temperature edit box or a power in the power edit box. The buttons labeled Temperature and Power display a table input that enable the user to enter time-dependent temperatures or powers. The tables can also be imported from .cvs files from the simulation directory or another directory. Enter wall roughness and wall length scale in the appropriate edit boxes. Finally, heat transfer coefficients to fluid #1 and fluid #2, and between the obstacle and the wall, can be entered in the appropriate edit boxes. 



 

 

 Turbulence Quantities Dialog Box Use the Turbulent kinetic energy edit box to specify a turbulent kinetic energy at the boundary. Use the Turbulent dissipation edit box to specify a turbulent dissipation at the boundary. Both buttons display a table that allows the user to enter time dependent conditions or import data for the specified quantity. 
 Click OK to exit and save the changes. Click Cancel or the X in the upper right corner of the dialog to exit without saving any changes. Baffles Branch Users can add, modify or delete baffles in the Tree Structure. 

 Forces can be calculated on baffles by selecting yes from dropdown next to Calculate Forces on Baffles. The force data is history data and can be found after simulating in the Analyze > Probe tab. To add a new baffle, right-click on Baffles and select Add. A new branch will appear in the tree. Click on the + sign to open the branch and enter baffle name definitions, porosity and/or heat transfer properties, and region. B. Check box to define baffle as a Flux Surface to make the baffle operate as a flux surface (see Flux Surfaces in the Model 



 

 

Reference chapter) and/or a Tracer which can be introduced at flux surface to enhance flow visualization. An existing baffle can be deleted by right-clicking on the baffle to be deleted and selecting Delete. Springs and Ropes Branch Springs and Ropes can be added by right clicking on Springs And Ropes. A tree will open allowing the user to define the position, extents, type of spring or rope, spring coefficient, and initial torque. The tree boxes will not be activated until the Moving and flexing objects on the Physics tab has been activated. An existing spring/rope can be deleted by right-clicking on the spring/rope to be deleted and selecting Delete. NOTE: AS THE EDIT BOXES IN THE TREE STRUCTURE ARE PRIMARILY TIED TO THE INITIALIZATION OF PHYSICAL MODELS IN THE PHYSICS SUB-TAB, MANY EDIT BOXES WILL NOT BE ACTIVE UNLESS THE MOVING AND FLEXING OBJECTS MODEL IS TURNED ON. Search Use the Search function to find files in the Tree Structure. Begin typing the file name and the Tree Structure will open to the indicated file.  Graphical Window In the main graphical window, geometry and the computational mesh is displayed. Upon opening the interface, the default view is orthographic, but the orientation can be changed to x-y, x-z or y-z views by clicking on the appropriate icons in the Toolbar:  
Viewing Graphical Display Only The option to hide the Geometry tree has been added. To hide the tree window select the left arrow icon located in between the graphical display and the tree window. This icon will now change pointing to the right. To unhide the tree window select the left arrow. To reset back to default select the reset icon. This will include both windows displaying the tree window at the maximum.  Allows the user to hide/unhide tree window.  Allows user to reset default window. 

                            



 

 

Using the Mouse to Move, Zoom or Rotate The buttons on the mouse can be used to move, magnify or rotate objects and meshes in the graphical window. To Rotate the object, press and hold the left mouse button, then move the mouse to rotate the object and/or mesh. To Zoom the object and/or mesh in or out, press and hold the center button or wheel, then push the mouse up or down on the mouse pad. To Move the object and/or mesh, press and hold the right mouse button, then move the mouse. 
Toolbar Icons  Zooming To use the mouse to quickly zoom in on an area in the graphical window, click on the Rubberband Zoom icon Tool Bar.  When this icon is activated, the mouse is used to draw out a rectangular area in the graphical window, which is then zoomed to. NOTE: MAKE THE FIRST APPLICATION OF THIS ZOOM AS SMALL AS POSSIBLE, AS THE ZOOMING CAPABILITY DECREASES SIGNIFICANTLY AFTER THE FIRST APPLICATION. NOTE ALSO THAT THE RUBBERBAND ZOOM FUNCTION STAYS ACTIVE ONLY FOR ONE APPLICATION. THE MOUSE MODE RETURNS TO THE STATE IT WAS IN BEFORE THE RUBBERBAND ZOOM ICON WAS CLICKED. Undo / Redo Eyepoint changes (zooming, rotating or moving geometry and/or mesh) can be reversed by clicking on the Undo icon (below left). Up to twenty eyepoint changes are saved. The Redo icon (below right) repeats an eyepoint change that was undone with the Undo icon.  Resetting The orientation and location of objects can be reset to the original view by clicking on the Reset icon (below).  NOTE: IF THE SIZE AND NUMBER OF OBJECTS BEING DISPLAYED IS VERY LARGE, OR THE COMPUTER GRAPHICS CARD IS POOR, ZOOM, MOVE OR ROTATION OPERATIONS CAN BECOME SLOW. IN THIS CASE, SELECT DISPLAY BOX IN THE VIEW MENU TO SPEED THE OPERATIONS. 



 

 

Probe Data Box Using the Probe function, a user can probe the surface of any object in the graphical window. Hold the control key and left-click the mouse on the surface of the object at any desired location. The probe location is not visually seen in the graphical display but the location of the selected probe can be found in lower left hand corner of the GUI display.   
Initial Initial conditions are now entered in the Meshing & Geometry sub-tab and have their own tree structure. The Initial tree is divided into four sections; Global, Fluid Regions, Temperature Regions, and Pointers. The following describes these in more detail. 

 
Global Tree When opening FLOW-3D, the Initial tree is unpopulated. In the Global tree there are areas to specify fluid & void initial state, an initial pressure field, fluid initialization, sediment concentrations, and uniform dissolved solute. 
Fluid Initial State Directly under the Global tree are the entry boxes to specify the initial state of the fluid. These quantities are uniform quantities and affect all the fluid in the computational domain. NOTE: SOME ENTRIES ARE DISABLED IF THE APPROPRIATE CONDITIONS HAVE NOT BEEN MET. THE TABLE BELOW SHOWS WHICH CONDITIONS ACTIVATE WHICH QUANTITIES. Quantity: Enabled by: Temperature Activating the heat transfer model Turbulent k.e. Activating the turbulence model Fluid rotation Using a cylindrical mesh. This is the fluid velocity relative to the mesh. Thus if the mesh is also spinning, this velocity is added to it.  Electric charge density Activating the electric potential and fluid electric charge models 



 

 

Uniform alloy solute concentration Activating the segregation model 
Initial Pressure Field The user can specify either a uniform pressure, or a hydrostatic pressure distribution in one of the three coordinate directions. An initial pressure can also be specified. 
Fluid Initialization This tree allows the user to use one of two shortcuts to set the fluid volume. Specifying a fluid elevation allows the user to set the initial elevation of the fluid in the domain. This option assumes that z-direction is vertical, and gravity is acting downward. The volume option allows the user to specify an overall fluid volume. The preprocessor will place the volume at the “bottom” of the simulation, where the “bottom” is defined as the direction of the overall gravity. The wave boundary tree allows the user to define the boundaries for the fluid initialization of a wave. NOTE: THE OPTION FOR SETTING A VOLUME IS DISABLED UNLESS FREE SURFACE OR SHARP INTERFACE TRACKING HAS BEEN SET IN THE GENERAL SUB-TAB. THE OPTION FOR SETTING THE WAVE BOUNDARY IS DISABLED UNLESS A WAVE BOUNDARY HAS BEEN SELECTED. 
Void Initial State Use the entry boxes to specify the initial pressure and/or temperature state of the void. These quantities are uniform quantities. NOTE: THE OPTION FOR SETTING AN INITIAL TEMPERATURE STATE OF THE VOID IS DISABLED UNLESS THE HEAT TRANSFER MODEL IS ACTIVATED. 
Uniform Dissolved Solute Concentration The user can specify the initial uniform dissolved solute concentration. This is only activated when the Dissolving objects model has been activated. 
Suspended Sediment Concentration The user can specify the initial suspended sediment concentration for each type of species. This is only activated when the Sediment scour model has been activated. 
Fluid Regions The user can specify one or more initial fluid regions, do transformations, and initialize fluid properties for the fluid regions. A fluid region can be added as an .STL file or created using basic primitives. To add a fluid Right-click on Fluid regions and select Add. The user also has an option to delete a fluid region by selecting the Fluid region 1, right-clicking, and selecting Delete. Additionally, to view or change the thermal information select the fluid region, right-click select Thermal information. A thermal information dialog box will open, allowing the user to add or edit heat transfer coefficients. 



 

 

 
Temperature Regions The user can specify one or more initial temperature regions. A temperature region can be added by right-clicking on Temperature regions and selecting Add. Once a temperature region has been added a new tree will be created to allow the user to create the temperature region, apply transformations, and define the initial temperature. The user also has an option to delete a temperature region by selecting the temperature region, right-clicking, and selecting Delete. 
Pointers The user can define fluid regions or void regions by adding pointers. To add a pointer right-click on Pointers and select either fluid or void pointers with the option to use previously selected probe points. Once a pointer has been added a tree will be created so the user can input initial properties.  

 Pointers can be deleted by selecting the pointer in the tree, right-clicking, and selecting delete. NOTE: SOME ENTRIES FOR ADDITION OF VOID OR FLUID POINTERS OR A VALVE ARE DISABLED UNLESS FREE SURFACE OR SHARP INTERFACE TRACKING HAS BEEN SET IN THE GENERAL SUB-TAB. 
Mass Momentum Sources/Sinks The user can create mass momentum sources/sinks by selecting the mass momentum sources/sinks, right-clicking, and selecting add. This will activate the model and open a tree to define the geometry and properties. A mass momentum source/sink can be deleted by selecting the mass source/sink, right-clicking, and selecting Delete. 



 

 

Valves To add a valve select the valves, right-click, and select Add. The user will be prompted to activate the adiabatic bubble model, external void pressure (absolute), and gamma (ratio of specific heats). 
  Once this has been done, a tree will open for defining the location and properties. A valve can be deleted or hidden by selecting the valve, right-clicking, and selecting Delete or Hide. Valves can be added from previous probe points by holding down the control button and left clicking in the placement location. This option will appear if the user has probed points. Once a valve has been defined it will appear in the display window as a green sphere. The valve will not be visible in the results. 

History Probes To add a history probe select History probes, and select add or control + left click in the region where you want the probe, then right click on History probes and select add a history probe at (x, y, z). A tree will open allowing the user to define the location unless the location was determined by the probe point, motion component, motion type, and History probe type. A history probe can be deleted or hidden by selecting the history probe, right-clicking, and selecting Delete or hide. A blue sphere will appear in the graphical display window at the defined history probe location. The history probes will not be visible in the results. 
Sampling Volume To add a sampling volume select Sampling volume, right-click in blank space, and select add. A tree will open allowing the user to define the sampling volume. Sampling volumes can now be visualized as a box in the graphical display. To hide or delete a sampling volume, right click on the sampling volume and select one of the options available. The sampling volume will not be visible in the results. 
Output The Output sub-tab is where the user determines what sort of files will be generated by the solver for postprocessing. Various output options, such as frequency of plot output or animation output, can be selected here. The user can also ask for debug output or output based on fill fraction. 



 

 

 
Basis for Output Click the appropriate radio button for the desired Basis for output intervals: time, fill fraction, or solidified fraction. NOTE: THE FILL FRACTION OPTION IS DISABLED UNLESS FREE SURFACE OR SHARP INTERFACE TRACKING HAS BEEN SET IN THE GENERAL SUB-TAB. 
Plot Output Controls Use the edit boxes under Plot Output Controls to change the plot intervals for the output options indicated in this group. For restart (spatial) and history data, the user can specify time-dependent intervals by clicking on the appropriate Time interval button. Otherwise, a constant interval can be specified via entry in the appropriate edit box. For the Restart data check the Do not write initial state box to suppress the writing of data for time zero. NOTE: THE DEFAULT FOR RESTART DATA PRODUCES ELEVEN EDITS (INCLUDING THE INITIAL CONDITIONS), AND THE DEFAULT FOR HISTORY DATA IS 100 HISTORY DATA EDITS. 
Print Output Controls Use Print Output Controls to change the intervals for the indicated printed data. The user can specify a constant interval in the print interval edit boxes, or click the appropriate buttons to enter time dependent intervals for long or short prints in a time edit box. By default, printed output is written at time intervals of 1/10th of the simulation time. 



 

 

Selected Data List In order to create smooth animations without generating extraordinarily large data files, FLOW-3D offers the user the option to output many frames of a limited or “selected” list of data. Selected data contains only the data requested in the Selected data list (such as, pressure, fluid fraction, temperature, etc.) by checking the box. As with restart and history data, the user can specify time-dependent intervals by clicking on the appropriate Time interval button. Otherwise, a constant interval can be specified via entry in the appropriate edit box. Even though the selected data option is chosen, restart data will still be output by the solver according to the interval chosen (or the default) in Plot output controls. 
Output Frequency Enter the frequency at which it is desired for FLOW-3D to write the Selected data. By default, Selected data is written at time intervals of 1/100th of the simulation time. Selected data is always written on a time interval, never at fractional intervals. If time dependent intervals are desired, click on the Selected data button to bring up an edit box. 
Additional Output Controls Eight additional output controls are offered:  The Output Filling time option is used during casting simulations. When the box is checked, FLOW-3D will write the time at which each cell first fills with fluid, as well as the last time the cell filled with fluid. If a cell fills and never empties in the course of the simulation, the two times will be identical. NOTE: THIS OPTION IS DISABLED UNLESS FREE SURFACE OR SHARP INTERFACE TRACKING IS SET IN THE GENERAL SUB-TAB. The Output Strain rate option computes and stores the local fluid strain rate. The Output fluid residence time option to compute and store the amount of time the fluid in a particular cell has been inside the computational domain. The Output Hydraulic data option provides users running hydraulics simulations with fluid surface elevation, Froude number, fluid depth, Depth-averaged velocity, and near-bottom velocity with the option of entering a vertical offset from the riverbed. The offset is a user-defined parameter with the default value equal to zero. 
� The Output Distance Traveled by Fluid option computes and stores the distance traveled by the fluid.  
� The Output Dynamic viscosity option computes and stores the dynamic viscosity. 
� The Output Fluid vorticity option computes and stores the vorticity of the fluid. 
� The Output Total hydraulic head option is based on the Bernoulli integral and is useful in hydraulic, casting and other applications where flow losses in complex channels are of interest.  
� The Output Enable tracers option allows the user to view the tracer results. In addition to the spatial output, the average total hydraulic head is computed at each flux surface and output to the global history data catalogue found in Analyze tab, Probe sub-tab. 



 

 

FSI/TSE Tecplot File The user can request to save the solution from FSI/TSE model in Tecplot® compatible finite element mesh and data file format. The data is written out at the same time intervals as the general restart data. new fluid-solid interaction or the thermal stress evolution data and mesh can be output to be read by Tecplot®. 
Excess Shear Stress Output Activating this option allows the user to select critical shear stress values to be plotted in Restart spatial data. The critical shear stress for a single component can also be implemented. 
Sampling Volume Output Selecting this button allows the user to create a sampling volume for computing hydraulic forces and torques acting on walls, fluid volume, and for counting particles within this sampling volume. The output is in the history data catalogue found Analyze tab, Probe sub-tab. For more information on Sampling Volumes, please refer to the Model Reference chapter.  
Debug Level Use the radio buttons to choose the desired level of debug output. 
Numerics The user can adjust parameters associated with the numerical methods used during a simulation in the Numerics sub-tab. 

 



 

 

NOTE: GENERALLY, USERS WILL NOT NEED TO CHANGE EXISTING SELECTIONS IN THIS TAB. BY DEFAULT, FLOW-3D WILL SET MOST SOLVER OPTIONS TO EXPLICIT (FOR MAXIMUM ACCURACY) AND OTHERWISE SELECT NUMERICAL METHODS IN ACCORDANCE WITH THE TYPE OF PROBLEM SET UP IN OTHER PARTS OF THE MODEL SETUP TAB. HOWEVER, THERE WILL BE CASES (SUCH AS WHEN A PROBLEM IS UNABLE TO REACH CONVERGENCE OR THE USER DESIRES TO FOREGO MAXIMUM ACCURACY AND APPLY IMPLICIT METHODS IN ORDER TO SPEED UP SIMULATIONS) WHERE THE USER MAY WANT TO CHANGE THE DEFAULT NUMERICAL SETTINGS IN FLOW-3D. 
Time-Step Controls Use the entry boxes in this group to change the initial time-step size, minimum time-step and maximum time-step. As a general rule, however, it is unnecessary to specify these values. 
Pressure Solver Options Select the appropriate radio button to choose the desired pressure iteration scheme. The convergence controls button opens a dialog box which allows the user to control convergence parameters. See Pressure Solution Algorithm in the Theory chapter for a discussion of the several options presented. 
Fluid-Structure Interaction Here the user may change numerical options for the Fluid-Structure Interaction model. 
Viscous Solver Options Here the user may change the numerical options associated with viscosity. Use the radio buttons to select from between three options for implicit viscous stress evaluation. Use the Convergence Controls buttons to modify the default convergence criteria if desired, when implicit options are selected. For a discussion of explicit versus implicit methods, go to the Flow Science website at: http://www.flow3d.com/cfd-101/cfd-101-implicit-explicit-schemes.html. 
Other Explicit/Implicit Solver Options Here the user may change the numerical options associated with heat transfer, elastic stress, surface tension, bubble pressure advection and moving object/fluid coupling. Use the radio buttons to select either explicit or implicit solvers and, for viscosity. Use the Convergence Controls buttons to modify the default convergence criteria if desired, when implicit options are selected. For a discussion of explicit versus implicit methods, go to the Flow Science website at: http://www.flow3d.com/cfd-101/cfd-101-implicit-explicit-schemes.html. 
Volume-of-Fluid Advection Select the desired VOF method from among the radio buttons. See Fluid Interface (VOF) Approximations in the Model Reference chapter for a discussion of the several options presented. 
Two-Fluid Interface Slip The new temperature slip model (similar to the existing velocity slip model) greatly reduces numerical diffusion, improving the accuracy which is particularly important in liquid/gas sloshing problem with phase change. Both of these require two fluids be activated on the General sub-tab and for the temperature two fluid slip heat transfer the Physics tab needs to be activated. 
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Momentum Advection Group Use the radio buttons to select an option for the evaluation of the advection terms in the momentum equation. See Momentum Equation Approximations in the Theory chapter for a discussion of the several options presented. 
Wave Boundary Condition These options allow the user to eliminate or allow the flux of a wave through a boundary. These options will only be activated when wave boundaries are selected in the Meshing & Geometry tree. 
Fluid Flow Solver Options Use the radio buttons to select an option for the evaluation of fluid flow and heat transfer. It is possible to solve all fluid flow equations, assume constant fluid velocity, or assume zero fluid velocity. 
Simulate Tab The Simulate tab enables the user to monitor the activity of the FLOW-3D solver. Information describing the progress of the solution is provided in the form of history plots, a progress bar, and periodic message data written by the solver. Various utilities, located across the top of the screen, enable users to interact with the solver while it is running. 

 



 

 

Warnings and Errors Select the Warnings and Errors button to view error and warning messages generated by the solver. This button is inactive if there are no error or warning messages. This information is also accessible via the Diagnostics > Solver Errors menu item in the main menu bar. 
Restart Times Select the Restart Times button to display restart and spatial data availability. 
Status While the solver is running, select the Status button to force the next available message line to be written in the message display window. 
Restart Data While the solver is running, select the Restart Data button to force a restart and spatial data edit. 
History Data While the solver is running, select the History Data button to force a history data edit. 
Runtime Options Click the Runtime Options button to open the dialog box shown below: 

 



 

 

In this dialog, the user can make changes to the simulation input file as the solver is running and without having to stop and restart the simulation. Changes can be made to selections such as finish time and time step controls (under the General tab), pressure solver choices and convergence controls (Pressure solver options tab), explicit and implicit solver options and convergence controls (Explicit/implicit solver options tab), advection methods certain physical model options and more. To effect any changes entered, click the Write to prepin file button. Check the Define time when changes are applied box and set the time in the adjacent edit box. These changes can only be made for future times, not past.  Restart edit data can be written on demand by checking the Force restart edit data box.  If the user desires to undo all changes previously made while the solver was running and reset the simulation input file to the initial state when the solver was launched, he can do so by clicking the Set all to initial state button. Likewise, to reverse changes made and sent to the solver and go back to a previous state, the user can click the Set all to last sent state button. Click the Send and close button to send changes made to the simulation input file and close the dialog. Click the Close button to close the dialog. Click the Cancel button to cancel and close.  
Pausing a Simulation The user can pause a simulation by clicking on the Pause button. This will release a solver license token for use on another machine. The processing unit should be freed up and FLOW-3D will be swapped out of memory (may be machine-dependent). 
Resuming a Simulation Click the Resume button to resume a simulation which has been paused. 
Terminating a Simulation Click the Terminate button to terminate the solver gracefully (i.e., perform a final restart and spatial data edit, close files, and stop). Please ensure that the correct prepin file is being terminated from the current workspace by using the drop-down menu. 
Time History Plots Time history plots indicate the evolution of various runtime parameters. The default plot is a comparison between the stability limit and the time-step size. Other quantities from the list at the left of the plot window can be displayed by clicking on the desired plot name.  The user can zoom in on these plots to examine them more closely, during or after the simulation. Use the left mouse button to draw a rectangle around the desired area of interest. When the mouse button is released, the plot will zoom into the framed area (see below). This can be repeated up to a magnification of 10E5. Other mouse controls are: ctrl-left click: unzoom one level ctrl -right click: zoom back in one level 



 

 

Alt-Left click or Esc: unzoom to the original size Middle button-drag: pan 
  Left image shows original plot; Right image shows zoomed area. 
Message Display Window Messages generated during a simulation are displayed in the lower portion of the Simulate tab. The same information is also accessible via the Diagnostics menu in the main menu bar by selecting Solver Messages. 
Progress Bar  The progress bar indicates the progress of a simulation. The solution is complete when the bar reads 100% or indicates "Terminated." 
Analyze Tab The Analyze tab is the starting point for viewing preprocessor and solver results. Plots that are created automatically, as well as customized plots, can be selected. 



 

 

 At the very bottom of the Analyze tab are nine buttons. These buttons are common to all panels (Custom, Probe, 1-D, 2-D, 3-D, Text Output and Neutral File) in the Analyze tab. Their functionality will be described here: 
Open Results File Simulation results can be viewed at any time, including while a simulation is running. To view results of a FLOW-3D simulation, the user can click on the Open results file button to bring up the FLOW-3D Results dialog box. This enables the user to locate data files containing results from either the preprocessor or the solver. For more, see Results Dialog Box, below.  At the top of the FLOW-3D Results dialog box, two radio buttons give the user the option to view either the results of plots generated automatically by FLOW-3D (Existing) or create customized plots (Custom). 
Existing Output When the Existing radio button is selected, plots generated automatically by FLOW-3D will be shown in the data file path box, if they exist. There are two primary results file types here: Files with the prefix "prpplt" contain plots created by the preprocessor, while files with the prefix "flsplt" contain plots automatically created by the postprocessor, as well as plots specified in the $GRAFIC namelist in the input file.  



 

 

 Once a file is selected, click OK (or double-click on the file name) to proceed. The Display tab will open and present a list of available plots for the problem. 
Custom Output When Custom radio button is selected, files with the name "flsgrf.*" will be shown in the data file path box. Each of these files contains the complete results of a simulation. The portion of this dialog box titled “Data file path” displays the names of data/plot files available in the current directory. Use the file filter to navigate file directories to locate the desired file. 



 

 

 Once a file is selected, click OK (or double-click on the file name) to proceed. The Analyze tab will open to display available plotting choices for the problem, based on the output options available by default in FLOW-3D or otherwise selected by the user when the problem was set up. 
Reload Results File If the user has opened a results file while the solver is running, he may wish to update the results file to see further data generated by the solver after the passage of time. Click on the Reload results file button to cause the same results file already activated in the Analyze tab to be refreshed. 
Save Settings Users can save individual preferences files for both 2-D and 3-D display. The preferences include both settings established in the Analyze tab (such as limits, time frame selections, vector/streamline options and more) as well as visualization choices made in the Display tab (such as eyepoint, lighting, display or not of a title, color scale or time frame, attributes of the fluid, obstacles, particles, vectors and streamlines and more). Click the Save settings button to open a Save preference as dialog box. This enables the user to save simulation-specific preferences, a general preferences file, or both. Preference files are saved with a *.pref suffix. 
Load Settings Click the Load settings button to bring up an Open preference as dialog box. This enables the user to find a saved preferences file. 
Reset Settings Click the Reset settings button to cause all saved settings in both Analyze and Display tabs to be reset to the default settings for the existing FLOW-3D session. 



 

 

NOTE: THIS ACTION DOES NOT DELETE THE PREFERENCES FILE, WHICH CAN BE RELOADED. 
Cancel Render Sometimes a user starts to render results from a very large simulation (which can take substantial time to complete, if the results file is large) but realizes not all settings were as he wanted. He can click Cancel render to stop the rendering process and change his selections. 
Render Click the Render button to process and display the data requested in the Display tab. 
Units Click on the Units button to bring up a dialog box to select the plotting units to be rendered and displayed. The user now has the option to look at different temperatures as well as to change the units system. Check the Show units on plots box to display the unit category. The results and temperature units will be carried over from the General tab where they were initially set. 

 
Mesh Block Click the Mesh block button to open a Mesh Block # dialog to select the desired mesh block(s) to be processed. This button is disabled if data from only one mesh block is in the simulation. By default, all mesh blocks will be rendered. 



 

 

 
Custom Plots In the Custom panel, the user can modify the flsinp plot request file. Flsinp files can be modified and saved for future use. The flsinp.tmp file is a temporary file written when generating Probe, 1-D, 2-D, 3-D, Text Output and Neutral File results. The Custom panel allows users to further modify these results and re-render through the Render button at the bottom of the tab. 

 



 

 

File List Dropdown Box Use the file list dropdown box to select the flsinp file. 
Save Select the Save button to save a currently open flsinp file. 
Save As… Select the Save As… button to save the currently open flsinp file with a new name. 
Edit Window In the Edit window, enter changes into the flsinp file. The edit functions Undo, Cut, Copy, Paste, Delete, and Select All are available by highlighting text, and then right-clicking in the edit window. 
Probe Data In the Probe panel, the user can generate output data from a selected mesh cell. 

 
Data Variables Selection Box  This list displays the available solution variables. To select a data variable, click on its name (multiple selections can be made). A window showing these data at all output times will appear after clicking on the Render button. 



 

 

Data Source Use the radio buttons to select the desired data source. The variables listed in the data selection window will change as the selected source is changed. If no Selected data or Solidification data is available, these selections will be disabled. 
Output Form  Use the radio buttons to choose either graphical or text output. 
Data Point Slider Bars Use these slider bars to position the data probe inside the mesh. The coordinate location of the data probe as well as its index location (i.e., i, j, or k) appears to the left of the slider bars. 
Time Frame Slider Bar Use the Time Frame slider bar to choose a time frame for which to display results. 
One-Dimensional Plots One-Dimensional plots display a computed value along a row of cells through the mesh in the selected direction.  

 
Data Variables Selection Box This screen displays a list of data available in the solver output. To select a data variable, click on its name. Multiple selections are not possible. 



 

 

Data Source Use the radio buttons to choose the type of data source. If no Selected data or Solidification data is present, then those choices will be disabled. To create plots of history variables versus time, go to the Probe panel and select General History or Mesh Dependent History as the data source. 
Plot Direction Radio Buttons Use these radio buttons to select the mesh direction of the plot (x, y or z). 
Plot Length Slider Bar Use this slider bar to set the spatial limits of the plot. 
Plot Location Slider Bars Use these slider bars to identify the row of cells along which the plot will be made. 
Time Frame Slider Bar Use this slider bar to select a time frame from which plots will be made. Plots can be made at all restart and spatial data edit times. 
Two-Dimensional Plots In the 2-D tab, users generate two-dimensional plots which display the variation of a computed value on a selected mesh plane. 

 



 

 

Contour Variable Select a variable from the dropdown list to create a two-dimensional contour plot of this variable. Vector Type Use this menu to select the type of vectors to appear on the contour plot, or to select to plot no vectors. To activate additional contour types in the Contour type list box, the user must choose No vectors or Plain Velocity Vectors in this list box. Particle Type Use this menu to specify the appearance of particles on the contour plot. This menu will only be active if the simulation included particles so that particle data was generated. Plane Radio Buttons and Mesh Checkbox Use the Plane radio buttons to select the plotting plane (that is, the x-y plane). Check the Mesh box to display the mesh overlaid on the plot generated. Plot Limit Slider Bars Use the Limits slider bars to limit the spatial extent of a plot. The spatial range of the plot, as well as the cell index range for the plot, appear in the boxes to the left and right of the sliders. The user can enter specified limits in these edit boxes, if they have multiple mesh blocks. The slider controlling the third dimension (that is, the coordinate direction orthogonal to the plotting plane) can be used to request plots in multiple planes by moving them individually. Time Frame Slider Bar Use the Time frame slider bar to select the time frame(s) from which plots will be created. Plots can be created at all restart and spatial data edit times, or at all animation times for available animation data. Data Source Radio Buttons The Data source radio buttons allow the user to choose the data source for plotting: Restart (spatial), Selected (animation), or Solidification data. Solidification data is only available if solidification is activated for that simulation. 
Contour Type Group Contour Type  Use this drop down box to select contour appearance (e.g., B/W contour lines or color-shaded contours). The user must choose No vectors in the Vectors list box to activate contour types beyond ‘Color shaded’.  Number of Contours Use this edit window to adjust the number of contour lines. The double arrow utility will return the number of contours to its default value (i.e., 5). This number is only used when black and white contour plots are generated. 



 

 

Scaling Group Vector Length Scaling Factor Enter a number in this box to scale the size of vectors appearing in the plots. The double arrow button will reset the scaling factor to a value of 1.0. Common Vector Length Checkbox Check the Common box to specify common vector scaling for all plots. Contour Limit Radio Buttons Use these radio buttons to select the data range used for contouring. Auto uses the min/max values for each image frame as the contour plot limits. Global uses the min/max values for the entire data set as the contour plot limits. Select User defined to define the min/max values used for contouring in the edit box to the right. Contour Options Button This button activates the 2-D advanced options dialog box. 

 Check the No contour smoothing box to turns off the interpolation of the contour variable values between the mesh nodes used for smooth color shading. With no color interpolation, each control volume is shaded by a single color that corresponds to the contour variable value at its node. This option may be useful for better visualization of the variables with large and highly localized spatial variations. Blanking is used to avoid plotting data in areas of no interest (e.g., fluid velocities in void regions). When a blanking variable is selected and a value is entered in the Value edit box, no color shading is performed in regions where the value of the blanking variable is below the value entered, if the Blank cells below value radio button is selected. Likewise, no color shading is performed in regions where the value of the blanking variable is above the value entered, if the Blank cells above value radio button is selected. For one-fluid problems, the default blanking variable is ‘fluid fraction’ with the blanking value of 0.5. Select ‘none’ for the blanking variable to turn off blanking.  



 

 

Vector Options Button This button activates the 2-D vector options dialog box, where the user can alter the frequency of vectors in all three coordinate directions. 
 Symmetry Reflection Checkboxes Use these checkboxes to reflect an image about a plane of symmetry. The reflections can be in the horizontal direction, the vertical direction, or in both directions. 

Three-Dimensional Plots In the 3-D tab, users generate three-dimensional views of iso-surfaces for analysis. 

 Iso-Surface Variable The Iso-surface dropdown menu offers available selections for the variable to be used by the postprocessor to plot an iso-surface. The iso-surface options will be dependent upon the type of problem. 



 

 

Color Variable The Color variable dropdown menu offers available selections for the variable to be used for color contouring the iso-surfaces to be plotted. Color variable options will be dependent upon the type of problem. Additionally, a user can select multiple variables by selecting the Additional variables button. NOTE: ANY VARIABLE THAT REQUIRES CALCULATION, SUCH AS VELOCITY MAGNITUDE, SHOULD BE THE PRIMARY COLOR VARIABLE. 

 Options Use this dropdown menu to choose to plot particles (if particle data is available in the simulation results), plain or colored vectors, or activate plain or colored streamline seeding. If colored vectors or colored streamlines are selected, the variable chosen in Color Variable menu will be used to color the vectors or streamlines. If the user has selected to add either plain or colored vectors in the Options menu, the appearance of the vectors can be modified by clicking the Vector Options button. This opens a 3-D vector options dialog box in which the user can apply limits to the vectors, choose the frequency of the vectors in each of the three spatial directions and, if thermal stress analysis has been undertaken in the simulation, opt to view displacement vectors. 

 



 

 

NOTE: WHEN THE RESULTS ARE RENDERED, THE USER IS GIVEN THE OPTION TO ALTER THE LENGTH OF THE VECTOR HEAD AND TAIL. The user can only select to activated plain or colored streamline seedings in the 3-D sub-tab. If the user has selected to activate plain or colored streamline seedings the placement of these seedings will be performed in the Display sub-tab after selecting the Render button. Please see Display Tab below for more information on streamline seeding. 
Plot Limit Slider Bars The Limits slider bars are used to limit the extents of a three-dimensional plot. The coordinate range and the index range of the plot appear in the boxes to the left (minimum) and right (maximum) of the slider bars. The user can enter specified limits in these edit boxes when there are multiple mesh blocks. 
Time Frame Slider Bar Use the Time frame slider bar to select the time frame(s) from which three-dimensional plots will be created. Plots can be made at all restart and spatial data edit times, at all animation times for available animation data, or at any subset of the total available time range. As either slider bar is moved, the minimum or maximum time frame to be generated will be shown to the left (beside “Min:”) or right (beside “Max:”). If Solidification data is chosen in the Data source group box, then the slider bar collapses to one point. 
Data Source Options Use these radio buttons to select the type of data to be used for plotting. Select Restart to plot spatial data written by the solver at a default frequency of 10 times during a solution. Selected data (also referred to as “animation data”) is written at a frequency set by the user in the Output tab (the default frequency is 100 times during a solution). Select Solidification to display solidification data in casting simulations.  NOTE: THE SOLIDIFICATION OPTION IS GRAYED OUT IF SOLIDIFICATION WAS NOT ACTIVATED IN THE PHYSICS TAB FOR THE PROBLEM.  
Display Options Use these radio buttons to select which display window you would like to render the data in. It is important to implement these sequentially. Please see the Display Tab below for more information regarding these options. 
Iso-Surface Options group Contour Value  Use this edit window to change the contour value of the fluid iso-surface chosen for plotting. The default selection, Auto, uses the average of the minimum and maximum values for each image frame. Click the double arrow button to the right to return the contour value to the default setting. Component Iso-Surface Overlay Use these radio buttons to select the appearance in the plot of components used in the simulation. The default selection, None, renders the fluid volume only, no components are displayed. The Open Volume option overlays an iso-surface of the open volume or volume fraction function in the computational domain, 



 

 

along with the fluid. The Solid Volume option overlays an iso-surface of the solid volume or the complement of the volume fraction function, along with the fluid.  If either Open Volume or Solid Volume is selected, the Contour value edit box below the Component Iso-Surface Overlay radio buttons can be used to change the iso-surface value of the open or solid volume fraction. The value to be entered ranges between 0 and 1. The double arrow button will return the contour value to its default setting. Open symmetry boundaries Check this box to open symmetry boundaries, if available. This allows the iso-surface to be reflected by selecting Tools, Symmetry in the Display tab. Save output to disk Check this box to save all iso-surface files (isosurf00n.f3d) for the time frame(s) to be rendered. Because these files can consume as much as 2-3 MB of disk space per time frame, by default, FLOW-3D will only generate the first iso-surface file when first rendering results. This option must be selected if the user wishes to use the Append to existing output option (below). Append to existing output Check this box to append the plots to existing output iso-surface files to make an animation from a series of results files for the same problem. The Save output to disk and Append to existing output is great for combining data with restart data. Text Output Text Output generates data in text form in a data window. The user can inspect the data in the window and save it as an ASCII file. 



 

 

 
Data Variable This list box displays the variables to be generated to the data window. At least one variable must be selected.  
Data Source Use these radio buttons to select the type of data to be used for plotting. Select Restart to plot spatial data written by the solver at a default frequency of 10 times during a solution. Selected data (also referred to as “animation data”) is written at a frequency set by the user in the Output tab (the default frequency is 100 times during a solution). Solidification is selected to display solidification data in casting simulations.  NOTE: THE SOLIDIFICATION OPTION IS GRAYED OUT IF SOLIDIFICATION WAS NOT ACTIVATED IN THE PHYSICS TAB FOR THE PROBLEM. 
Plot Limit Slider Bars The Limits slider bars are used to limit the extents of a three-dimensional plot. The coordinate range and the index range of the plot appear to the left (minimum) and right (maximum) of the sliders. 
Time Frame Slider Bar Use the Time frame slider bar to select the time frame(s) from which text output will be generated. Text output can be generated for all restart and spatial data edit times, at all animation times for available animation data, or at any subset of the total available time range. If Solidification data is chosen in the Data source group box, then the slider bar collapses to one point. 



 

 

Neutral File Neutral file data is output to the file “transf.out.” The data is also shown in a data window and can be saved as an ASCII file under another name. Neutral file output requires a transf.in file which defines the points to output data. 

 
Data Variables Use this list box to choose the variables to be output to the neutral file. At least one variable must be selected.  
Interpolation Use these radio buttons to choose the type of interpolation. Select Interpolate data to interpolate the data to a specific coordinate point. Select Cell centered data to output the cell-centered data of the FLOW-3D mesh cells. 
Plot Limit Slider Bars The Limits slider bars are used to limit the extents of the neutral file output. The coordinate range and the index range of the plot appear to the left (minimum) and right (maximum) of the sliders. 
Time Frame Slider Bar Use the Time frame slider bar to select the time frame(s) from which neutral file output will be generated. Neutral file output can be generated for all restart and spatial data edit times, at all animation times for available animation data, or at any subset of the total available time range. 



 

 

FSI TSE Tab This tab allows the user to select the components to Display, the time-steps, and type of data for the Thermal Stress Evolution of the solidified fluid or the Fluid Structure Interacting solid. 

 
Display Tab The Display tab displays FLOW-3D results after rendering in the Analyze tab.  There are two viewing formats in Display: 2-D Format: Existing plots and plots generated by user selections in the 1-D and 2-D panels under Analyze tab will be displayed under the Display tab in one viewing format (2-D Format).  3-D Format: Customized results rendered using the user’s selection in the 3-D panel under Analyze will be displayed in a different viewing format (3-D Format).  Fluid-Solid Interaction and Thermal Stress Evolution can be displayed by first rendering from the FSI TSE tab. The controls for plots displayed in the two formats are different, and each format is described below.  Results generated by users from the Probe, Text Output and Neutral File panels in the Analyze tab are displayed in a third format, a simple text display window such as shown below: 



 

 

 Click on the Save as button to save this output as a text file or a data file in any directory location desired. The Next and Previous buttons allows the user to page through large quantities of data. The Continue button closes the window 
2-D Format Display Mode This display mode contains four major elements: the Canvas Window, the Control Panel, the Menu Bar, and the Tool Bar. Plots are drawn in the Canvas Window. The Control Panel shows a list of available plots, and contains a number of command buttons that allow the user to change plotting options. The Menu Bar and Tool Bar are at the top of the Canvas Window and allow access to a variety of commands. 



 

 

 
Canvas Window The graphical output generated by the postprocessor is shown here. The location and magnification of the graphics in the Canvas Window can be manipulated with the mouse. Press the right mouse button and move the mouse to move the graphics around in the Canvas Window. Press the middle (scroll) mouse button and push the mouse up or down to zoom or pan the graphics in the Canvas Window. The left mouse button will retain the same mouse function as last chosen between move and zoom. 
Control Panel The Control Panel (located on the right-hand side of the Display tab) allows users to perform a variety of operations and change various plot settings. It has two main regions: the top region containing command buttons, and the lower plot list window. The following is a description of the functions of the various buttons in the Control Panel: Button Function Previous Highlights previous plot in the list and displays it in the Canvas Window. If highlighted plot is the first plot, then the last plot in list is shown. Refresh Redraws displayed (current) plot. Next Highlights next plot in the list and displays it in the Canvas Window. If highlighted plot is the last plot, then the first plot in list is shown. Files Use to open and create plot files. 



 

 

Output Use to create .bmp, postscript files, and .avi animation files. Animate Displays plots one after the other, effectively showing an animation on screen. Format  Click the Format button the open the Format options dialog, which allows the user to modify the appearance of plots. 

 The Plot attributes list shows the attributes of the 2-D display that can be modified. The modifications primarily are changing colors (lines, text, background, particles, etc.) or turning attributes off or on (such as vectors, titles, text, color scale, etc). In the Values box, the attributes of the selection under the Plot attributes list are changed.  Under Color bar option, the user can choose the reverse the color scale.  In the Particle size is a Mag factor edit box which enables the user to magnify (or shrink) the visible size of particles. In the Vector style group, the user can choose from three style options. The Vector size group presents the user the opportunity to customize the display of vectors—length of the vectors, the width of the head of the vector and the scale of the vector. In the Plot scaling group, the user can shrink or enlarge the display in either the horizontal or vertical directions. In the Options group, settings chosen in Format options dialog can be set, saved and opened. Rubber Band area Limited portions of the Canvas Window may be captured by rubberbanding. Check the Rubber Band area box, then click in the Canvas Window, and drag the mouse. A “rubber band rectangle” appears. Drag the mouse so the rectangle includes the desired area for capture, then release the mouse button. The area that will be captured in a BMP file is now set to the area inside the rectangle. To capture the selected area, select Output from the Control Panel. Single-Multi- This dropdown box is used list to choose mode of display in the Canvas Window. The 



 

 

Overlay Drop Down box default is Single, displaying one plot. Choose Multi to display up to four plots. Overlay will overlay all selected plots. Please note that overlaying contour files on top of x-y plots can cause Display to crash.  At the bottom of the Control Panel: Clear Resets BMP capture area to full screen and removes BMP capture area rectangle. Hide Hides Control Panel. To show the Control Panel again, click on the Control Panel icon in the Tool Bar:   
Toolbar The toolbar across the top of the 2-D Format display has buttons for user-convenience commands. Resting the mouse over a button will display a tool tip showing the button’s purpose. The available buttons are as follows:  Tool: Action: Open Plot File  Opens a plot file and closes currently open file Append Plot File  Opens a plot file and appends plots to current list Create Plot File  Create a plot file by writing selected plots to new file Previous Plot  Displays the previous plot Next Plot  Displays next plot Refresh Plots  Refresh the plot in the Canvas Window. Control Panel  Display or hide the Control Panel.  Format Plot  Opens the Format options dialog box.  .ps and .bmp output  Display panel to create postscript and BMP files  Start Animation  Display shows each plot in succession, effectively showing an animation. Animation begins at plot currently highlighted in the Control Panel.  Stop Animation  Stops the animation 



 

 

 Faster Animation  Causes animation to run faster Slower Animation  Slows display of animation Single Mode  Only display one plot at a time on screen Multiple Mode  Display up to four plots on screen Overlay Mode  Overlay selected plots. Overlaying a 2-D contour plot over a 1-D plot will cause 2-D Display to crash.  Print  Select this icon to print the view shown in the Canvas Window. A standard Print dialog box will open, enabling the user to select a printer and make changes to the print quality, etc. Zoom  Allows the user to use the mouse to quickly zoom in on an object Reset  Resets the objects to original position, prior to moves and zooming 
Menu Bar The menu bar contains a small selection of commands. File menu 

 Open Open a new plot file and close currently open plot file Open (Add) Open a new plot file and add plots to plot list Create Create a new plot file 



 

 

View Menu 
  Refresh Refreshes the plot in the Canvas Window Control Panel Displays or hides the Control Panel Next Plot Displays the next plot Previous Plot Displays the previous plot Start Animation Display shows each plot in succession, effectively showing an animation. Animation begins at plot currently highlighted in the Control Panel. Stop Animation Stops the animation 
3-D Format Display Mode The 3-D Display Format is the display mode for three-dimensional FLOW-3D results. In this mode, the Display window contains five principal elements: the Menu Bar, the Tool Bar, the list of Available Time Frames, the Object List and the Display Area. 

 



 

 

FSI/TSE Format Display Mode The FSI/TSI Display Format is the display mode for Fluid-Structure-Interaction  and the Thermal Stress Evolution FLOW-3D results. In this mode, the Display window contains five principal elements: the Menu Bar, the Tool Bar, the list of Available Time Frames, the Object List and the Display Area. 

 
Menu Bar  A menu bar is located at the top of the Display tab.  
Tools Menu The Tools menu gives the user command over functions such as image capture, saving and loading light and eye point position, changing background color, etc. 



 

 

 Tools options are as follows: Take a Snapshot Allows the user to capture a snapshot of the Display Area. Press and hold the left mouse button and position the cursor over Take a Snapshot in the menu. The available formats for capture are then shown in a menu that appears to the right: .bmp, .jpeg and .png. Move the mouse cursor to the desired format and release the mouse button. A Save Image File window pops up. Assign a name to the image file in the File Name box. Files may be saved in any directory the user can access, locally or across a network. Click OK to capture the image. Suggestion: Since the image captured will be the entire display panel area, it is a good idea to zoom in on the objects in the Display Area to as large as you can. Axis Rotation Selecting Locked Rotation hides or displays the Axis Rotation dials (shown below) in the lower left corner of the Display Area Rotations will take place about the x, y, or z axes (as manipulated on the dials). To rotate, left-click on one of the dials and drag left or right. Select All Objects Select All Objects allows the user to select all objects displayed in the display panel. Set Title Select Set Title to type in a title to be displayed with any images or animations. Click OK after entering a title to save and exit. Click Cancel to exit without saving any title. 
 Baffles Choose Baffles to import or unload baffles after Preview has been run in the Finalize tab of Model Setup. Press and hold the left mouse button and position the cursor over Baffles to cause another menu to appear to the right. Move the mouse cursor over Import Baffles to import baffles which were included in the simulation setup. Move the mouse cursor over Unload Baffles to remove any baffles which were previously loaded to the Display Area. 

 



 

 

STL For optimum display of the geometry used in a simulation, a user may wish to use the STL file which was used in the simulation. This can be done by importing the STL files into the Display Area. Press and hold the left mouse button and position the cursor over STL to cause another menu to appear to the right. Move the mouse cursor over Import STL to import STL files that were included in the simulation setup. Move the mouse cursor over Unload STL to remove any STL files which were previously loaded to the Display Area. 
 Animation Select Animation to create an animation from a series of time frames. The user must first highlight the desired starting time frame in the Available Time Frames table on the left side of the Display tab. Press and hold the left mouse button and position the cursor over Animation to cause another menu to appear to the right. The user is given the option to capture a specific portion on the Display Area, or to capture the full Display Area:  If Rubberband Capture is selected, the user will be instructed to select an area to capture. This is done by left-clicking the mouse and dragging out a rectangular outline, rubber-band fashion, to encompass the extent of the image to be captured. If Fullscreen Capture is selected, the entire display panel will be captured as in the animation. The user is next prompted to name the animation file that will be created and to specify the directory the file will be saved. The user is also given the option to delete the source bitmap files (to save hard disk space). A Video Compression dialog box next appears. Here, the user can select a compression method, compression quality, frame rate and data rate. The user can also select no compression. Usually no change to the data rate is required. Click OK to proceed to generate the animation. FLOW-3D next runs through the series of time frames from the first selected time frame to the last time frame, at which point a box appears that announces that the animation has been created. Click OK. The animation file should be available in the directory location. If animation creation is underway, the process can be terminated by clicking on the Cancel Animation button in the Available Time Frames section.  Options Select Options to open the following dialog box: 



 

 

 In this dialog, there are four tabs: Color, Light/Camera Settings, Color Scale, and 3D Graphic Font. Color The Color tab, shown in the image above, allows the user to change the colors for a number of the tools in the Display tab, such as the background, graphic text and so on. The color of the buttons next to each item indicates the active color for that item. Left-click on the button next to any item to open a window providing a color palette to choose from. Light/Camera Settings In the Light/Camera Settings tab, the user can load saved light or camera positions or save a new light or camera positions. Color Scale In the Color Scale tab, the user can modify the minimum and maximum color values, select a color scale format and reverse the color scale. 3D Graphic Font In the 3D Graphic Font tab, the user can scale the size of font used in the title, color bar and the time frame. Here, the user can also choose to apply a scientific format to the color bar or the time frame to be used in the color scale display. Symmetry If symmetry was used in setting up the simulation, this option enables the user to display symmetry and copies. 



 

 

 To reflect symmetry along the appropriate axis, click in the box next to the axis in the Symmetry portion of this window. The user can also create symmetry reflections rotational copies for cylindrical coordinates. To create a 360 degree image, enter 360 in Total Angle. The number entered in Num. Copies will determine the number of copies of the object that are made. A higher number will result in a smoother image. When choices have been made, click Apply, then Close. Below is shown the weir example problem before and after symmetry has been applied along the Y-axis: 
  Streamline edit This option allows the user to edit the streamlines. This option will only be activated if the user had created streamlines from the Analyze tab. 

View Menu The View menu gives the user numerous viewing options. 



 

 

 View menu options are as follows: Baffle Options  Select Baffle Options to change the display characteristics of any imported baffles.  Color Scale If the object being displayed is colored by a selected variable, a color scale will appear in display panel when Color Scale is selected. The color scale may also be displayed by clicking on the icon in the Tool Bar:  Time Frame Select Time Frame to display the time frame in the display panel. The time frame may also be displayed by clicking on the icon in the Tool Bar:  Title If a title was assigned under Tools > Set Title the title will appear in display panel when Title is selected. Wireframe Select Wireframe to view free-surface in wireframe. Draw Axis Selecting Draw Axis gives the user the choice displaying an XYZ coordinate system: (1) at the center of the object; (2) at the origin (0,0,0); or (3) in the lower left-hand corner of each panel in the display panel. The user may also choose to have no coordinates displayed. An example of the axes displayed in the lower left-hand corner is shown below.  Whichever display choice is chosen, the X-axis is always displayed in red, the Y-axis in green and the Z-axis in blue. Display Box Selecting Display Box is useful when displaying and manipulating objects consisting of a very large number of triangles. Users may notice that movements, rotations and zooming may become very slow with such objects. To speed up these operations, select Display Box. With Display Box activated, only the containing box is displayed when the user clicks on the object to move it, rotate it or zoom it. Once the mouse is 



 

 

released, the original object is again displayed. The default setting is in Display Box mode. Show Display 1 Select Show Display 1 to show only the results from Display 1. The Show Display 1 may also be displayed by clicking on the icon in the Tool Bar:  Show Display 2 Select Show Display 2 to show only the results for Display 2. The display will only show if Display 2 results were loaded from the Analyze, 3-D sub-tab. The Show Display 2 may also be displayed by clicking on the icon in the Tool Bar:  Side by Side Layout Select Side by Side Layout to view the two Displays side by side. The Side by Side Layout can also be displayed by clicking on the icon in the Tool Bar:  Stacked Layout Select Stacked Layout to view the two Displays Stacked. The Stacked Layout can also be displayed by clicking on the icon in the Tool Bar:  Link Viewpoint Select Link Viewpoint to link or unlink the two displays. This will link all transformations (rotations, translations, zooming).  Switch to perspective  Select this to switch from Orthographic projection to Perspective projection. A perspective projection is a frustum of a pyramid (a truncated pyramid whose top has been cut off by a plane parallel to its base). Objects that fall within the viewing volume are projected toward the apex of the pyramid, where the camera or viewpoint is. Objects that are closer to the viewpoint appear larger because they occupy a proportionally larger amount of the viewing volume than those that are farther away, in the larger part of the frustum. Switch to orthographic  Select this to switch from Perspective projection to Orthographic projection. An orthographic projection, the viewing volume is a rectangular parallelepiped, or more informally, a box. Unlike perspective projection, the size of the viewing volume doesn't change from one end to the other, so distance from the camera doesn't affect how large an object appears. 
Mesh Menu 

 Show Select Show to overlay the computational mesh on the displayed results. Uncheck Show to hide the mesh. The default is to not display the mesh in the Display tab. View Mode The mode of display of the mesh can be changed between showing the full mesh or just the outline of the mesh. Slice Select Slice to investigate how the mesh resolves the geometry by moving through the 



 

 

mesh, row by row. Where Cartesian meshes are being used, a box appears, enabling the user to slice the mesh row by row from any (and each) of six directions (X positive, X negative, Y positive, Y negative, Z positive and Z negative), using the slider bars or arrow buttons. 

 
Toolbar Just below the menu bar in the display panel is the Toolbar. This toolbar has several useful functions. 

 Navigation Bar  Select the Print icon to print the view shown in the graphical window. A standard Print dialog box will open, enabling the user to select a printer and make changes to the print quality, etc.  Allows the user to use the mouse to quickly zoom in on an object. Hint: Make the first application of this zoom as small as possible, as the zooming capability decreases significantly after the first application.  Resets the objects to original position, prior to moves and zooming.  Eyepoint changes (zooming, rotating or moving the geometry) can be reversed by clicking on the Undo icon. Up to five eyepoint changes are saved.  The Redo icon repeats an eyepoint change that was undone with the Undo icon.  Click this icon to create an animation. See above for instructions on the process of creating animations. Note that, using this icon, the user can only create full-screen animations.  Click this icon to create an animation using the rubberband zooming function to select a specific region within the Display Area. See above for instructions on the process of creating animations.   Click this icon to bring up the streamline edit box. 



 

 

 Here the user can select the Seeding plane for placement of points by selecting the radio button and then the location along the axis can be implemented by using the slider bars or by entering the location in the edit box. The user can then add points individually, add a range between two points, delete, save, or clear points.  Click on this icon to use the mouse to move the scale within the Display Area. If the color bar is not visible, once you select this icon it will become visible and the user will have the option to move it. Note: the move function is only activated for one move per activation.  Click on this icon to use the mouse to move the time frame with the Display Area. Note: The move function is only activated for one move per activation.  Click this icon to add a title to the Display Area.  Click this icon to display or remove Title in the Display Area. NOTE: THIS WILL ONLY BE ACTIVATED IF A TITLE HAS BEEN ADDED.  &  Changes the orientation of the displayed results to the X positive or X negative plane.  &  Changes the orientation of the displayed results to the Y positive or Y negative plane.  &  Changes the orientation of the displayed results to the Z positive or Z negative plane.  Changes the orientation of the displayed results to the perspective view. ,  Click on this icon to change from orthographic projection to perspective projection.  Select this icon to view only Display 1.  If using more than one display, you can select this icon to view only Display 2.   Select this icon to view the displays side by side. Notice that Display 1 is green and Display 2 is red. 



 

 

 Select this icon to view the displays stacked. Notice that Display 1 is green and Display 2 is red.  Select this icon to link or unlink the two displays. This will link/unlink all transformations (rotations, translations, zooming). 
Transparency Slider Bar This slider bar allows the user to change the appearance of all objects on the screen (fluid, particles, baffles, and/or components) from completely opaque to varying levels of transparency (including invisible). Left-click, hold and drag the bar.  NOTE: THIS SLIDER BAR WILL AFFECT THE TRANSPARENCY OF ALL OBJECTS (COMPONENTS, BAFFLES, STL OBJECTS, PARTICLES) AND FLUID IN THE DISPLAY AREA. TO CHANGE THE TRANSPARENCY OF INDIVIDUAL OBJECTS OR THE FLUID SEPARATELY, SELECT THE DESIRED ITEM IN THE OBJECT LIST (SEE BELOW). 
Color Variable The Color Variable panel on the left side of the Display tab allows the user to select from the additional color variables selected in the 3-D tab. 

 
Available Time Frames The Available Time Frames panel on the left side of the Display tab shows the times available to the user for viewing results of simulation(s). In this panel, the first time frame shown is the earliest time frame specified in the Analyze tab. Double-click on any time frame to display that time frame in the Display Area. 



 

 

 When displaying two sets of simulations the Available Time Frames will be available for both displays. There are three options available for the two displays: Select No Lock radio button when only one display at a time is to be activated. Select Nearest Time Frame radio button to synch the time frames to the nearest time when stepping through. This is useful for animating the two displays. NOTE: THIS WILL ONLY SYNCH THE TIMES THAT ARE NEAREST SO IF DISPLAY 1 HAS A TIME FRAME THAT STARTS FROM 0.0000000000E0 AND DISPLAY 2 STARTS AT 5.3456785845E0 IF YOU START WITH DISPLAY 1 AT TIME 0.0000000000E0 AND STEP THROUGH THE TIME FRAMES THEN ONLY DISPLAY 1 WILL STEP THROUGH UNTIL THE TIMES ARE SYNCHED. Select Nearest Index Frame radio button to synch the 1st available time frame, 2nd available time frame, etc., regardless of the time-steps. The Previous and Next buttons enable the user to scroll through the available time frames. Click on Remove frame to remove a time frame, click on Insert frame to put a time frame that has been removed back into the list of available time frames. 



 

 

Click the Cancel animation button to terminate the process of generating an animation, if underway. 

 
Object List The Object List group is a convenient control for objects in the Display Area, including components, fluid surface, particles, baffles and STL objects. Click on the desired object to select it both in the Object List and in the Display Area). When using two displays the user must first select the Display to activate the object list for that Display. Changes to the characteristics of the selected objects can then be made. Below is an example. 



 

 

 
 Object List when Components or Fluids are selected (left) and when Particles are selected (right)  After selecting an object, the user can: 1. Change the color by clicking on the Change color, which opens a dialog box with a color palette. When Fluid Surface is selected, there is no Change color option. 2. Any selected object (components, fluid surface, particles, STL files) can be hidden in the Display Area by unchecking the Show box. Check the box to make the selected object will be displayed. 3. Apply transparency to just the selected object. 



 

 

4. For Fluid Surface and Components only, export the object as an STL file. Clicking on the Export to STL button opens a Save file as dialog, where the user can name the file and save it in a desired directory location. 5. For Particles only, change the size of the particles (to enable them to be more easily seen. 6. For Streamlines only, the option to have ribbons or streamlines is made available. 
Probe Data Box  Using the probe function, a user can probe the surface of any object in the display panel. To select a point on any object in the display panel, hold the Shift key and left-click the mouse on the surface of the object. The Probe Data Box will display the x, y and z coordinates of the location on the surface of an object where the mouse cursor is positioned.  If the mouse pointer is positioned over an iso-surface, the value shown in the Value box will be the color value generated for that location. 



 

 

 
Running FLOW-3D from the Command Line This section will introduce the mechanics of running FLOW-3D in the command line mode. It covers using runscripts and displaying results, and describes the use of the solver monitoring utility PEEK. It also describes how to run a series of simulations using a single command. The symbol "$" in this section represents a command prompt. The graphics display tool shows graphic images produced by the preprocessor and the postprocessor. It can also create bitmap (.bmp) files on Windows PC machines, and postscript (.ps) files on both PC and Linux platforms. FLOW-3D consists of four main modules: 



 

 

 
Runscripts Runscripts (or batch files) to carry out all these tasks are provided with the standard installation. There are runscripts for executing the preprocessor, solver, and postprocessor individually, and a runscript for running all three consecutively. The graphics display programs are run directly by typing the respective program name. An additional monitoring utility, PEEK, allows users to communicate with the solver while it is running. Finally, a special runscript allows users to run a series of simulations in sequence. The runscripts are designed to be executed from the working problem directory. The scripts reside in the $F3D_HOME/local directory, where $F3D_HOME is the environment variable containing the path to the FLOW-3D installation directory. The user’s PATH environment variable must be modified to include $F3D_HOME/local in order to use the scripts.  On Linux systems, the runscripts may also be used to submit batch runs from the problem directory using the at or batch system utilities:  

$ batch 

runall 

<Crtl>d The following scripts are provided for running FLOW-3D: runpre <ext1> <ext2> Runs preprocessor on simulation prepin.<ext1> with the output files appended with the extension <ext2>. If <ext2> is not defined, then <ext1> is used for the output file extension. If neither <ext1> nor <ext2> are defined, the input simulation name is expected to be prepin.inp with the output files appended with <dat>. runhyd <ext2> Runs solver using <ext2> as the extension for both input (created by runpre) and output files. If <ext2> is not defined, then the input files are expected to have extension <dat> which is also used for the output files. runpost <ext2> Runs postprocessor using <ext2> as the extension for both input (created by runpre and runhyd) and output files. If <ext2> is not defined, then the input files are expected to have extension <dat> which is also used for the output files. runall <ext1> <ext2> Runs all three scripts on simulation prepin.<ext1> with the output files appended with the extension <ext2>. If <ext2> is not defined, then <ext1> is used for the output file extension. If neither <ext1> nor <ext2> are defined, the input simulation name is expected to be prepin.inp with the output files appended with <dat>. 



 

 

runbatch <batch file> Runs a series of simulations in sequence in the order defined in the text file <batch file>. The absolute or relative (to the directory from which the script is launched) path to each simulation file is defined on a separate line as shown in the example below. After completion, the script returns to the directory from which it was launched. An example of a <batch file> for a Linux system is given below (for Windows forward slashes must be replaced with the backward ones): 
/home/flow3d/examples/weir/prepin.<ext1> <ext2> 

/home/joe/tesprob/prepin.inp 

../test1/prepin.<ext1> 

../test2/prepin.inp 

local_directory/prepin.inp <ext2> The paths to the last three simulations in this example are given relative to the directory where the runbatch script is executed. When the runpre and runpost scripts are run, the new files created will overwrite the old files. However, runhyd and runall scripts will not run if the results data file flsgrf.<ext2> exists in the directory. The user must delete flsgrf.<ext2> before runall and runhyd can be run (this is to help avoid accidental overwriting of results data files). The old files can be deleted by typing: 
$ rm flsgrf.<ext2> 

on Linux systems and 

$ del flsgrf.<ext2> 

on Windows. 

Modifying Plot Requests In most cases, users should use the Analyze tab of the GUI to produce the types of plots and output desired. However, there may be times when they do not have access to the GUI. For these cases, plot requests may be modified and the plots created by running the postprocessor using the runscripts. Sometimes users may want to have additional output plots that were not specified ahead of time, or may simply want to modify previously defined plots (for example, changing the plotting plane for 2-D plots). There are two approaches to creating new or modified plots. The first approach would have the user edit the flsinp.dat file to modify plots or to include new plots. Alternatively, users can modify prepin.inp and run the preprocessor to create a new flsinp.dat. The postprocessor can then be run with this new flsinp.dat to create the new plots. For information on the flsinp file options, see the Customized Postprocessing chapter. For information on specifying plot requests directly in the prepin file, see Graphic Output in the Input Variable Summary chapter. 



 

 

 
Display Program: PLTFSI and FLOWPLOT The postprocessor can be run while the solver is running. This allows the user to look at data plots up to the current simulation time, for example, to check that the simulation is proceeding as expected. To do this, the user can open a new command window, change to the working problem directory, and run the postprocessor using runpost. Plots may then be displayed as usual by typing pltfsi (on Linux and Windows) or flowplot (on Windows only). A graphical display program, PLTFSI, allows users to view the plots created by the postprocessor (flsplt.* files) and preprocessor (prpplt.* files). The program is available on both Linux and Windows systems. PLTFSI is a text menu-driven program that allows a variety of actions. Ideally, it should be run from the directory where the problem is running. You can start it by typing “pltfsi”. After starting the program the user is prompted for the plot file name. Type it in, for example, “flsplt.dat,” and press Enter. A text menu will appear showing the available options and brief description of each. The see the full list of plots press l. To view all the plots press d. Alternatively, to display a specific plot or plot range press dN or dN-M, where N and M denote the plot numbers in the list of plots.  Option Number Option 0 Exit 2 or 1 Display the list of plots in the file 4 or d Display plots 5 or w Write PostScript files 8 Open another plot file 10 Select plotting options 11 Help 



 

 

12 Saving current viewing settings 13 Restore previously saved viewing options Another display program FLOWPLOT, similar to PLTSFSI in its capabilities, but more user-friendly, is available on Windows. Type “flowplot” at the command line and a graphical user interface will appear with a menu for opening and viewing plot files. 
The Monitoring Program: PEEK A solver monitoring program, PEEK, allows users to interact with the FLOW-3D solver while it is running. PEEK is a menu-driven program that allows a variety of actions. PEEK may be used when the solver is running either interactively or in batch mode (Linux). PEEK must be run from the directory where the problem is running. PEEK communicates with the solver through a text signal file named HYdr3D_SIgnAL.dat. Each time PEEK is invoked, this file is created and a number indicating the desired action is written to the file. Once the solver reads the signal file, it is deleted. The solver writes time-step messages and certain failure messages to the hd3msg.dat file. This file is monitored by PEEK. While the solver is running, one can open a window, change to the directory where the solver is running, and then run PEEK. To run PEEK, type: 

$ peek During execution, the solver checks signal flags (sent by PEEK) at the end of each time step. PEEK can instruct the solver to do a variety of things. The options most commonly used are shown below: Option Number Option 2 Terminate the solver after writing the current state to the output files 3 Write a status message to the hd3msg.dat file 4 Write a spatial data dump to the flsgrf.dat file 5 Write a history data dump to the flsgrf.dat file 6 List the hd3msg.dat file 9 List the tail end of the hd3msg.dat file 10 Show the available restart times listed in the hd3msg.dat file 12 Specify the message file name if not hd3msg.dat (i.e., for restarts hd3msg.test) PEEK assumes that the solver process is a regular (non-restart) run and that the message file is hd3msg.dat. 



 

 

PEEK is most often used to check the status of a solver run by displaying the contents of the solver message file (hd3msg.*). After starting PEEK, the hd3msg file can be listed by typing 6 or 9 at the menu prompt. If the progress of the analysis is slower than anticipated and status messages are not printed out often enough to know how the process is running, the user may want to force a status message by typing 3 at the menu prompt. The user can also tell the solver to write spatial or history data dumps to flsgrf (options 4 or 5). This is particularly useful when the analysis appears to be having trouble, and the user would like to see what is going on at the current stage of the calculation. If the analysis is not running as expected, it can be terminated (option 2). This forces the current solution state to be written out, all data buffers to be dumped and all files to be closed before the solver is terminated. If the solver is terminated by a system kill, i.e., <Ctrl>c, data may be lost and the user will not be able to determine the solution state before termination. 
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Chapter 5 - Meshing and Geometry 
Constructing Geometry Geometry is constructed in FLOW-3D by assembling solid geometric "objects" which combine to define the flow region for a simulation. The flow geometry is then embedded in the computational grid by the preprocessor using a technique called FAVOR™, an acronym for Fractional Area/Volume Obstacle Representation. FAVOR™ offers a simple, accurate way to define angled surfaces inside cells even in relatively coarse grids. The FAVOR™ method embeds complex geometries in the computational mesh by computing the area fractions (AFT, AFR, AFB) on the cell faces along with the volume fraction (VF) open to flow. Definitions There are two key definitions for geometry construction: Components and Subcomponents. Components—organize subcomponents into groups that share common properties and initial conditions. Components have specific properties (e.g., thermal conductivity, porosity and roughness) that distinguish them from each other. A component may not necessarily be a continuous entity. For example, two unconnected spheres can be defined as one component consisting of two spherical subcomponents. Subcomponents—represent solid objects, holes and complements: the actual physical geometry of components. Subcomponents are defined by .stl files, other file types, or FLOW-3D primitives. A component must consist of at least one subcomponent. A simulation can have multiple components, and each component may consist of multiple subcomponents which can be added and subtracted in series to define a complex region of geometry. A single component is shown below. The component is comprised of one solid spherical subcomponent and one cylindrical subcomponent created as a hole. The left image shows the geometry in Boolean view, with both subcomponents. The right image is shown in a FAVORized view that previews the embedded geometry with the hole removed. 

    Boolean View     FAVORized view 
Geometry Methods in FLOW-3D There are five methods for defining subcomponents in a FLOW-3D computational grid. Each subcomponent is assigned a value in input file (prepin.*) that specifies the method used for that subcomponent. Specifying geometry in the User Interface (GUI) will automatically configure the appropriate values in the prepin file. 



 

 

The prepin variable is IGEN(n)=L in namelist OBS, where n is the subcomponent number and L is one of the numbers in the following list:  
� primitives generated by the FLOW-3D solids modeler in the GUI or input file,  
� pre-FAVORized data in an external data file, 
� I-DEAS universal CAD files (*.cadf or *cadf*.inp), 
� stereolithography files (*.stl or *stl*.inp), 
� Ansys tetrahedral files (*.elem or *cade*.inp and *cadn*.inp), and  
� topographical data files (*.topo or *topo*.inp).  Any combination of methods can be used to define a component with multiple subcomponents. The possible values for IGEN are described below in more detail. NOTE: IN FLOW-3D, GEOMETRY IS ALWAYS INTERPRETED IN CARTESIAN COORDINATES EVEN IF THE GRID HAS BEEN DEFINED IN CYLINDRICAL COORDINATES. 
Generating Primitives and Quadratic Functions (IGEN=0) The FLOW-3D solid modeler is based on the definition of regions in terms of quadratic functions defined in the input file. The User Interface makes it easy to define simple (primitive) shapes as spheres, cylinders, cones, ellipsoids, and toroids, using variations of the general quadratic function.  

 Creating a box-type primitive subcomponent in the GUI. The full quadratic function, which is more generalized than the User Interface primitives, can be controlled by editing the input file text manually to specify the eleven coefficients of the general function in namelist OBS: 
F(x,y,z) = CX2•x² + CY2•y² + CZ2•z² + CXY•x•y + CXZ•x•z + CYZ•y•z + CX•x 

+ CY•y + CZ•z + CRXY• + CC where x, y and z are Cartesian coordinates with the same origin and units used to define the grid and CX2(L)=n is, for example, one of the coefficients for subcomponent number L with numeric value n. By convention, the subcomponent consists of the region where the function F(x,y,z) is negative. Changing the sign of all coefficients will, therefore, define the complementary subcomponent. 



 

 

 Subcomponents are defined where the function F(x,y,z) is less than zero. Additionally, by setting IOH (L)=0, the subcomponent becomes a hole where F < 0. The default value for all coefficients is zero, except for the constant term CC, which defaults to a very small negative number. This setting allows one to simply use the coordinate limiters to define simple shapes (e.g., blocks, cylinders and spheres) without having to set any function coefficients. The defined region can be further modified after it is created, that is: 
� Spatial limits can be imposed; 
� The surface can be scaled, rotated and translated; scaling is useful for unit conversion; 
� The surface can be combined with other geometrical input to create a complete component, e.g., additional subcomponents can be added to create holes in the subcomponent or the object itself can define a hole in a previously defined subcomponent; 
� Physical properties can be assigned to the component containing the subcomponent. 
Importing existing FLOW-3D geometry (IGEN=1) After a simulation is preprocessed and the geometry is embedded in the mesh, the fractional area and volume information generated by the FAVOR™ function can be exported as a .f3d file, which contains triangular surface data in the .stl format described below. These files can be re-imported to new simulations when IGEN(L)=1 in namelist OBS, where L is the subcomponent number. This method is rarely used because the .f3d file is an approximation of the original geometry, with resolution dependent on the mesh used to generate it. 
Importing I-DEAS Universal Files (IGEN=2) FLOW-3D users can import CAD data generated in the form of tetrahedral elements with specified node coordinates and connectivity (see the figure below). This data is assumed to be in SDRC's Universal File format from its I-DEAS program, but other formats could also be accommodated by customizing the 



 

 

preprocessor. The preprocessor reads the file specified in the input file namelist OBS when IGEN(L)=2 and FIDEAS(L)='filename'. The default filename is "cadfnn.inp" where nn is a two-digit representation of the subcomponent number L; e.g., for L=1 nn=01 and for L=12 nn=12. All defined subcomponents can have coordinate limiters as well as translations and rotations applied to them, as described for primitives above. 

 Typical Tetrahedral Element 
Importing STL Files (IGEN=3) Most CAD packages can export solid models as stereolithography (.stl) format. In the .stl format, the solid object surface is described by triangles. Vertex coordinates and the facet unit normal for each triangle are stored in the .stl file. The unit normal is used to distinguish the interior from the exterior of the object and always points away from the object. All coordinates are defined in the Cartesian coordinate system. 

 



 

 

Triangle is defined by vertex coordinates and the normal n. Each .stl object must be a closed surface defining an enclosed volume. That is, the model data must specify the inside, outside and boundary of the object. Each file can contain more than one closed surface. The total number of triangles in each STL file is unlimited. .stl files can be either ACSII or binary. An ASCII format file is substantially larger than a binary file with the same data but can be text-edited. Binary files are preprocessed much faster, and for large files the difference in preprocessing time will be significant. Each triangle is processed only once, in the order they appear in the .stl file, so processor time is linearly proportional to the number of triangles. The processing time is also linearly proportional to the number of cells in the grid. Calculations for each triangle only involve those mesh cells that lie in the vicinity of the triangle.   FLOW-3D can import both the ASCII and binary .stl format. The format type is detected by the preprocessor automatically. The ASCII format is shown below: 

 Each file section starting with facet normal ... and ending with endfacet describe one triangle. The first and last lines of the file contain an optional title for the object. The order in which the triangles are listed is unimportant. 



 

 

In the input file, subcomponent number L is defined by .stl file when IGEN(L)=3, FSTL(L)='filename'. The default filename is "stlfnn.inp", where nn corresponds to the subcomponent number. Once the .stl input has been defined, the specified surface can be manipulated in the same ways described for primitives above. 
Importing ANSYS Tetrahedral or Surface Triangle Files (IGEN=4) Ansys tetrahedral or surface triangle data may also be imported. The data needed by FLOW-3D are the node coordinates and the connectivity. When using Ansys input for a subcomponent IGEN(L)=4, the preprocessor reads two files: one specified by FANSEL(L)='filename' (element connectivity data) and one specified by FANSND(L)='filename' (nodal coordinates data) in namelist OBS in the input file. The default filenames are "cadenn.inp" and "cadnnn.inp" where nn is a two-digit representation of the subcomponent number L, and the specified geometry can be further modified as described for primitives above. 
Importing Topographical Data Files (IGEN=5) Imported topographic data files must be in ASCII format. The FLOW-3D topographic reader automatically converts the topographic data to .stl data, and then processes this data to create geometry in the FLOW-3D mesh. The .stl data is stored in file stlfnn.inp, where "nn" is the subcomponent number for the topographic data, and this .stl file can be used to create a subcomponent in future runs to save time during preprocessing. The actual format of the file is set in subroutine RDTOPO. This subroutine may be modified by the user to accommodate a wide variety of topographic file formats. The standard format expects two title lines at the top of the topographic file, followed by the actual topographic data (one location per line) written as: 

x-coordinate y-coordinate z-coordinate in free format. The x and y coordinates may be random, and do not need to be in a regular grid. These coordinate locations are assumed to represent a top surface (in the z-direction), and therefore, only one z coordinate is allowed for any given x and y location. When the .topo file includes regions of high resolution (many x,y,z points per unit area) surrounded by regions of low resolution (few x,y,z points per unit area), the preprocessor will ignore some of the points due to limitations in the artificial intelligence required to connect all points to each other. In these cases, using an .stl file of the topography is recommended. When importing topographical data, the preprocessor reads the file specified by FTOPO(L)='filename' in the input file namelist OBS. The default filename is "topofnn.inp" where nn is a two-digit representation of the subcomponent number L. Like other subcomponents, topographical data subcomponents can be further modified as described for primitives above. 
Limitations Associated with FAVOR™ The FAVOR™ method is very powerful, but it is important to recognize that it is limited by the resolution of the computational grid. The preprocessor generates area fractions for each cell face in a grid by first determining which corners of the face are inside and which are outside of a defined subcomponent: 
� If all four corners of a cell face are inside the subcomponent, then the entire face is defined to be within the subcomponent.  
� Similarly, if all corners lie outside, then the entire face is assumed to be outside the subcomponent. 



 

 

� When some face corners are inside a subcomponent and some are outside, the area fraction generator computes the intersection of the subcomponent with the face edges. Area fractions are then computed from these intersection points assuming straight-line connections between intersection points within the face. The straight-line assumption introduces a small error in the fractional area when the subcomponent boundary is curved inside the cell. The approximation improves as the grid resolution is refined. The implication of this construction is that any piece of a subcomponent extending across a cell face, but not including a corner of that face, is not recognized by the area fraction generator. For instance, a small spherical subcomponent (say smaller than a mesh cell) will not be recorded unless it covers at least one grid vertex, as illustrated for the circle in the upper left corner of the mesh shown below. 
 Left: Subcomponent Definition; Right: Subcomponent Created. If the object surface has sharp edges then a multiple intersection is likely to occur, that is, a cell face intersects more than one neighboring edge. In this case the corresponding cell edge is assumed to be either fully inside the object, as shown below (top) or fully outside it (bottom). The representation is improved as the mesh resolution is increased (i.e. the cell size is decreased). 



 

 

 FLOW-3D’s interpretation of multiple intersections: Original shape is shown on the left and the resulting shape on the right. Exact areas are often essential when modeling precise inflow and outflow rates at the boundaries of the grid. To help the user in this regard, the preprocessor summary file (prpout.*) and the report file (report.*) contain summaries of the computed open areas at each boundary of the grid. Additionally, the preprocessor generates plots along each coordinate axis, where the open area in the plane perpendicular to the axis is plotted versus the axis coordinate. 
Constructing Geometry Using the GUI The FLOW-3D GUI enables users to create or import subcomponents, limit portions of them, and apply transformations to them, in the Model Setup tab > Meshing & Geometry sub-tab. 
Creating Geometry In the GUI, users can create geometry using FLOW-3D’s solids modeler or by importing geometry files as discussed above. Subcomponents are created first. Start from the Subcomponent menu or by clicking on the appropriate subcomponent icon in the Toolbar. 



 

 

  
 

Subcomponent Menu Subcomponent Toolbar New subcomponents may be assigned to an existing component or a new component by clicking on the Add to component dropdown box:  When a new component is created, the Add component dialog box appears after the selections for the first subcomponent are made. The user is required to specify the new component Type (Standard, Porous, Lost Foam, Domain Removing, etc.): 

   The following is a description of how to create subcomponents through the Subcomponent menu: Sphere Select Sphere in the Subcomponent menu (or click on the sphere icon in the Toolbar). The 



 

 

 following dialog appears: 

  In the Radius box, specify the radius that the sphere is to have, with the same units of length as the mesh.  By default, FLOW-3D creates subcomponents as solid objects, and this is the only option when the subcomponent belongs to a new component. To change the type to a hole when adding to an existing component, select Hole under Subcomponent Type. Complements can only be .stl files, so this option is unavailable for primitives like spheres. Other transformations (translations, rotations, and magnifications) as described below in Transformation Options can be performed by selecting Transform. Click OK to create the sphere. Cancel will close the dialog without changing the simulation. Cylinder  Select Cylinder in the Subcomponent menu or click on the cylinder icon in the Toolbar. The following dialog box appears: 

  Specify a radius for the cylinder In the Radius box. The height of the cylinder must also be 



 

 

defined by specifying values for Z Low and Z High in the appropriate boxes. Note that the cylinder is initially defined with center on the Z axis. It can be rotated and moved in any direction via the Transform option. By default, FLOW-3D creates subcomponents as solid objects, and this is the only option when the subcomponent belongs to a new component. To change the type to a hole when adding to an existing component, select Hole under Subcomponent Type. Complements can only be .stl files, so this option is unavailable for primitives like cylinders. Other transformations (translations, rotations, and magnifications) as described below in Transformation Options can be performed by selecting Transform.  Cone  Select Cone in the Subcomponent menu or click on the cone icon in the Toolbar. The following dialog box appears: 

  In the Angle box, set the angle that the cone is to have. The assigned Height will be recorded as Z low: the point of the cone will be at the origin and the base at z = Height. By default, FLOW-3D creates subcomponents as solid objects, and this is the only option when the subcomponent belongs to a new component. To change the type to a hole when adding to an existing component, select Hole under Subcomponent Type. Complements can only be .stl files, so this option is unavailable for primitives like cones. Other transformations (translations, rotations, and magnifications) as described below in Transformation Options can be performed by selecting Transform. Box  Select Box in the Subcomponent menu, or click on the box icon in the Toolbar. The following dialog box appears: 



 

 

  The user can either manually set the Low and High limiters for each direction in the appropriate edit boxes, or select Uniform Size and then set an extent for each direction. If Uniform Size is selected, the box will straddle the origin, with one-half of its extent in each direction, positive and negative.  By default, FLOW-3D creates subcomponents as solid objects, and this is the only option when the subcomponent belongs to a new component. To change the type to a hole when adding to an existing component, select Hole under Subcomponent Type. Complements can only be .stl files, so this option is unavailable for primitives like boxes. Other transformations (translations, rotations, and magnifications) as described below in Transformation Options can be performed by selecting Transform. Torus  Select Torus in the Subcomponent menu (or click on the torus icon in the Toolbar). The following dialog box appears: 



 

 

  Set the Minor Radius and Major Radius in the appropriate boxes. The minor and major radii are as shown in the figure below. The torus will initially be created about the origin, and can be rotated and moved by selecting Transform. 
 By default, FLOW-3D creates subcomponents as solid objects, and this is the only option when the subcomponent belongs to a new component. To change the type to a hole when adding to an existing component, select Hole under Subcomponent Type. Complements can only be .stl files, so this option is unavailable for primitives like toroids. Other transformations (translations, rotations, and magnifications) as described below in Transformation Options can be performed by selecting Transform. Geometry File(s)  Select Geometry File(s) in the Subcomponent menu. The following dialog appears: 



 

 

  Click on Add to open a new dialog box. Select the file format to be imported in the Files of Type dropdown, and then browse for the desired file(s): 

 Multiple files can be imported by holding the control (ctrl) key on the keyboard while selecting the desired files with the mouse. Each file will be assigned to a different subcomponent of the same component. Click Open. This returns the user to the Geometry File(s) dialog, with the selected files listed: 



 

 

 Add more files by clicking Add; remove files by clicking Remove or Remove All.  By default, FLOW-3D creates subcomponents as solid objects. The subcomponent can be made a hole when adding to an existing component by selecting Hole. .stl files can be defined as complements, where the solid region is defined as the entire domain that is not the .stl geometry. If the subcomponent is the first in the simulation, it can be made a complement after clicking OK by changing the Subcomponent Type from Solid to Complement in the Geometry > Component tree. Transformations (translation, rotation and magnification) can be performed by selecting Transform, as described below in Transformation Options.  Advanced Select Advanced to access all geometry options at once. This is never necessary, but is included for users of older versions. When Advanced is selected, the following box appears: 

 Select the source type for the subcomponent in the Type dropdown, then activate or deactivate Use Geometry File. Browse to select the file if necessary. The subcomponent is a Solid by default and can be a Hole if it’s being added to an existing component. Transform and 



 

 

Limiters open the following dialogs, where the definitions of the subcomponent can be set: 

  

 STL Library A library of STL objects is provided. When STL Library is selected, the following dialog box appears: 



 

 

 Select one of the files listed and click Add. Click Transform to scale (magnify), rotate, or translate the subcomponent. The STL Library is customizable. Frequently-used .stl files may be added by placing them in the gui\stl_lib subdirectory of the installation directory. The file must be named according to the convention “my_object.stl” for the file to be shown in the STL Library. NOTES: A SUBCOMPONENT WHICH IS DEFINED AS A HOLE MUST BE CREATED AFTER ANY SUBCOMPONENTS OF THE SAME COMPONENT WHICH DESCRIBES THE HOLE. A SUBCOMPONENT WHICH IS DEFINED AS A COMPLEMENT MUST ALWAYS BE THE FIRST SUBCOMPONENT OF A COMPONENT. 
Transformation Options When a subcomponent is first created, the user is presented with options to transform the object. Each of the dialog boxes that appear when a subcomponent is being added has a button titled Transform in the lower left corner. This opens a Transformations dialog box with options for modifying the objects initial state. Translating means moving the object in the Cartesian coordinate system, and has units of length. Rotating means about the Cartesian axes, and has units of degrees. Magnifying the object means scaling it by a specified ratio in the x, y, z, or all directions (Global magnification). Transformations can also be applied to already-created geometry as described below. 



 

 

 NOTES: SCALING IS PERFORMED BEFORE ROTATIONS, WHICH ARE ALWAYS PERFORMED BEFORE TRANSLATIONS.   ROTATION ABOUT THE X-AXIS IS PERFORMED FIRST, FOLLOWED BY ROTATION ABOUT THE Y-AXIS AND THEN ROTATION ABOUT THE Z-AXIS.  
Modifying Geometry in the Tree Structure Geometry that has been imported or created is displayed with all properties and associations in the Geometry Tree of the Model Setup > Meshing & Geometry tab, along with mesh and boundary condition specifications, initial conditions, and a variety of other options for defining the simulation. It is in the tree that most of the simulation specification takes place. Components and subcomponents can be edited in the tree, which has more options than the subcomponent dialog boxes described above. 

 
Navigating the Tree Structure Toggle the arrowheads next to the headings to open or close branches. Double-click headings to open all levels in that branch. Click on a mesh block title to highlight that mesh block in the display pane. Click on a 



 

 

subcomponent number to highlight that subcomponent in the display pane. Right click on any header for additional options specific to that branch, including options to add or remove branches. Geometry Branch Global The Global branch displays the minimum, maximum and extent of all geometry in each direction of the entire domain.  Components Each component is listed separately in the tree under a Component # heading, with a Subcomponents branch listing all the subcomponents and their properties that compose the component geometry. Each component branch also contains branches for defining component properties. 



 

 
 



 

 

Changing Component Properties The color of a component as displayed in the display pane can be changed by clicking on the colored box to the right of the component number in the tree. This opens a standard color palette dialog box to enable color changes.  Changes to the properties and to the initial conditions of a component can be entered directly in the appropriate box in the tree. Check boxes activate optional properties. Buttons labeled Tabular open dialogs to enter tabular (time or temperature dependent) parameters. Buttons labeled Edit open additional dialogs for setting complex parameters, such as motion parameters for moving components.  NOTES: EDIT BOXES WILL NOT BE ACTIVE UNLESS THE APPROPRIATE PHYSICS MODEL IS TURNED ON. MATERIAL PROPERTIES CAN BE IMPORTED VIA THE SOLIDS DATABASE SELECTION IN THE TOOLS MENU. Subcomponents For each subcomponent branch in the tree, there are the branches for (1) Min/Max; (2) Transformations; and (3) Limiters, as well as an option to make the subcomponent a Cooling Channel (with the heat transfer model) and entries for Mass Density (for the moving object model) and Contact Angle (for the surface tension model). 

 Min/Max The minimum and maximum Cartesian coordinates and extent are displayed here for each direction. These entries are informational: use the transformations described below to change them. Transformations All transformations (magnifications, rotations or translations) that were applied to the subcomponent when it was created are displayed and editable here. 



 

 

Limiters Limiters exclude a portion of geometry from a file: for example, a limiter can be used to make a sphere a half-sphere or wedge. Limiters are displayed and editable here. Right-click on a subcomponent title in the tree to show the following dialog. The options are described below. 

 Delete Permanently removes the selected subcomponent from the simulation. Disable Deactivates the subcomponent from the simulation so it is not included in the run, but leaves the subcomponent definition in the input file to be enabled later.  Transparency Opens a slider to apply transparency to the selected subcomponent only. Hide Select Hide to hide the selected subcomponent from view but leave it active in the simulation. Show all Select Show all to show all subcomponents. Show only Select Show only to show only the selected subcomponent and hide all others. Show Select Show to show the selected subcomponent if it has been hidden. Copy … Makes a copy of the subcomponent. The copy can be added to any position within an existing or new component and can be transformed as shown below: 



 

 

 Reassign … Places the subcomponent in a different order in the tree, as part of any existing or new component. The order of components is important (see the Notes above).  Creating and Deleting Baffles and Other Specialized Geometry Baffles are two-dimensional surfaces, can be porous or non-porous, and can measure heat and mass fluxes and applied forces. They can be simple shapes like planes, cylinders, cones, or spheres, or more complex shapes defined with quadratic functions or .stl files. Right-click on Baffles and select Add to add a new baffle. 
 Specify the Definitions, Limiters and Transformations, as well as an .stl file for a complex baffle, under the Baffle Region branch. Quadratic functions can only be used to define a baffle by modifying the input file manually (File > Edit Simulation on the top menu). Other properties can be defined: see Flow Losses in Porous Baffles, Heat Transfer Across Baffles, and Flux Surfaces in the Model Reference chapter for details. Use a similar process to add Springs and Ropes (used to tether moving objects), Mass Momentum Sources (used to add fluid from 2-D surfaces within a simulation domain), Valves (for releasing bubble pressure), History Probes (measurement points), and Sampling Volumes (3-D sampling regions).  Delete any component, subcomponent, baffle, or other specialized geometry by right-clicking on the branch in the tree and choosing Delete. 



 

 

Constructing Geometry Using the Text Editor Some users may prefer to create or modify geometry by direct editing of the input file (prepin.*) in a text editor (File > Edit Simulation on the top menu). Entering the information below into namelist OBS. Each subcomponent is associated with one component by the variable IOB(L)=N, where L is the subcomponent number and N is the component number. IOH(L) defines the subcomponent as either a solid (1), a hole in an existing subcomponent of the same component (0), or a complement (< 0, only possible if the subcomponent is specified from a CAD file).  In the input file, the variable IGEN(L) governs the method for defining a subcomponent:  IGEN Method IGEN (L)=0 FLOW-3D Solid Modeler IGEN (L)=2 I-DEAS Tetrahedral CAD Data IGEN (L)=3 .stl CAD Data IGEN (L)=4 Ansys CAD Data IGEN (L)=5 XYZ Topographic Data Each subcomponent can be cropped to lie within assigned coordinate limits by defining limiters: Variable Name Variable Description XL(L) XH(L) Minimum and maximum x coordinate YL(L) YH(L) Minimum and maximum y coordinate ZL(L) ZH(L) Minimum and maximum z coordinate RAL(L) RAH(L) Minimum and maximum cylindrical radius 2 2
x y+  RSL(L) RSH(S) Minimum and maximum spherical radius 2 2 2

x y z+ +  RSL(L) RSH(S) Minimum and maximum spherical radius 2 2 2
x y z+ +  ANGLL(L) ANGLH(L) Minimum and maximum wedge angle  (measured about the z-axis from the x-axis). CONEL(L) CONEH(L) Minimum and maximum cone angle (measured from the z-axis) Translate and rotate defined components to their desired location using transformations: Variable Name Variable Description MAGNX(L) MAGNY(L) MAGNZ(L) Scaling factors in x, y and z directions MAGN(L)   Uniform scaling factor TRNX(L) TRNY(L) TRNZ(L) x, y and z translations ROTX(L) ROTY(L) ROTZ(L) Rotations about x, y and z axes in degrees 



 

 

NOTE: LIMITERS ARE ALWAYS APPLIED BEFORE MAGNIFICATIONS, WHICH ARE PERFORMED BEFORE ROTATIONS, WHICH ARE PERFORMED BEFORE TRANSLATIONS. ROTATION ABOUT THE X-AXIS IS FIRST, FOLLOWED BY THE Y-AXIS AND THEN THE Z-AXIS. FOR EXAMPLE, IF MAGN(L) = 0.1 IS USED TO CONVERT THE UNITS FROM MM IN THE ORIGINAL OBJECT TO CM FOR THE SIMULATION, THEN THE LIMITERS HAVE TO BE DEFINED IN THE ORIGINAL MM. Copying Components With The Text Editor After a subcomponent shape has been defined, copies of that shape can be made as part of the same component using the text editor. The copies can be translated, rotated, and reflected to become spatially separated parts of the component. Copies are requested by setting, for the Kth copy, the variable ICPY(K) = L where L is equal to the number of the component to be copied. Copy transformations occur in the order:  
� rotations about the x axis 
� rotations about the y axis 
� rotations about the z axis  
� reflections about an x plane 
� reflections about a y plane  
� reflections about a z plane 
� translations in x, y and z in any order The transformation variables are shown below, where K is the number of the copy: Variable Name Operation Performed ICPY(K) Number of component being copied CRFLX(K), CRFLY(K), CRFLZ(K) Copy reflection plane locations CROTX(K), CROTY(K), CROTZ(K) Copy rotations in degrees CTRNX(K), CTRNY(K), CTRNZ(K) Copy translations NOTE: CAD OBJECTS CANNOT BE COPIED OR REFLECTED. HOWEVER, A CAD FILE CAN BE READ MULTIPLE TIMES AND THEN TRANSLATED AND ROTATED USING THE TRNX... AND ROTX… VARIABLES.  Virtual Components Sometimes it is necessary to define an ‘imaginary’ component, with one or more subcomponents, around the origin or some other special location and then make copies and translate and rotate them to the desired location. An example of this approach is defining fans and impeller regions: regions of flow where the fluid undergoes additional momentum changes beyond those required to solve the Navier Stokes equations. Setting the flag IVRT(N)=1 for component N tells the preprocessor that the component is virtual and is not to actually be constructed. Instead, the user makes one or more copies of the component by setting ICPY(K)=N, where K is the copy number, and defines the copy translations and rotations to move the component to where it is wanted. 



 

 

Component Properties To use the text editor to assign components specific properties such as porosity, heat capacity, conductivity, velocity, mass and energy sources, see the Input Variable Summary chapter for a complete list of variables, and search the digital User Manual for the variables you are interested in. Zero Blockage Obstacles Certain special applications require components with unit porosity. Unit porosity (OPOR=1) means that the component has no mass and offers no blockage to flow. Such components, however, can be assigned drag coefficients (OADRG, OBDRG), a surface area per unit volume (OSPOR) and mass and energy sources (QSROBS, POBS). For example, drag coefficients of a zero-blockage obstacle are useful for modeling impellers, fans or other types of devices that impart momentum to a fluid (which must also be copies of a virtual component). The assignment of mass and/or energy sources across a distributed surface area per unit volume can be useful for modeling the chemical or nuclear production of gas and heat in a fluid. 
Mesh Building 
Meshing Basics FLOW-3D uses an orthogonal mesh defined in either Cartesian or cylindrical coordinates. Complicated geometries are modeled using the FAVOR™ method where obstacles and baffles are embedded in the orthogonal mesh by partially blocking cell volumes and face areas. This allows independent definition of the mesh and geometry. That is, the geometry may be modified without redefining the mesh. Mesh generation is much simpler and faster than with body fitted coordinates. The mesh is defined independently for each of the three orthogonal coordinates. Multi-block gridding enables more efficient computation when modeling complex flow fields. Each block is a rectangular mesh enclosing a region of the whole flow domain. Nested blocks refine a region within a coarse block. Linked blocks define adjoining, non-overlapping regions. 
Uniform Meshes A uniform mesh has uniform cell lengths for each direction. The user must supply the coordinates of the mesh edges and the total number of cells in each direction or a uniform directional cell size. 
Non-Uniform Meshes In a more complicated mesh, intermediate mesh planes (fixed points) are defined, as well as cell sizes at particular locations or the number of cells between particular points. Intermediate fixed points might be used to ensure that a mesh plane is aligned with a baffle or obstacle edge or with an inlet or outlet opening. Intermediate points are also used to define locations of higher resolution. Occasionally, intermediate points are used to force symmetry since there may be some round-off error when creating a mesh. Non-uniform meshes have varying cell lengths for each direction. 



 

 

The mesh generator uses the specified information and attempts to create a smoothly varying mesh. Users should take care not to over-specify the mesh, which can result in abrupt cell size changes between adjacent cells. The best approach is to specify as little as possible and let the mesh generator do the work. 
Multi-Block Meshes Single-block meshes may not be adequate when a single block contains too many cells. Using multiple mesh blocks can increase the simulation resolution only in the area of interest and exclude regions where no flow is expected. There is no limit on the number of mesh blocks for the solver and pre-processor, but the postprocessor is limited to 150 mesh blocks. Mesh blocks cannot partially overlap each other. They must either not overlap at all (that is, they are adjacent or linked) or one of them must completely contain the other (the blocks are nested). Nested blocks may contain additional nested blocks, so that the mesh resolution is progressively refined without sharp discontinuities in cell size. Nested blocks can be linked to adjacent nested blocks. Common examples of cases where the multi-block model is useful include sinuous flow regions or problems where a small area of interest requires high resolution. In both cases, multi-block meshes enable the user to resolve the domain better and with fewer cells than a single block. 
General Cartesian Meshes A minimum of two mesh planes in each direction creates a Cartesian mesh. If no other mesh planes are user-specified, the grid will be uniform. If additional mesh planes are specified within the domain, the mesh may be non-uniform. Mesh planes within the domain can be associated with specified adjacent cell sizes or number of cells between the mesh plane and the next specified mesh plane. Cylindrical Meshes In cylindrical coordinates, the Z axis is the rotational axis of the system, X is the radial coordinate and Y is the azimuthal angle of the mesh in degrees. The figure below shows the relationship of a cylindrical mesh to the Cartesian system used to specify the geometry. The Z axis is out of the screen. NOTE: SPECIFY THE TYPE OF MESH BY RIGHT-CLICKING THE MESH BRANCH OF THE TREE (MESH – CARTESIAN OR MESH – CYLINDRICAL) AND CHOOSING CHANGE TO … COORDINATES. EXISTING MESH BLOCKS WILL BE DELETED.  



 

 

 2-Dimensional and 1-Dimensional Meshes 2-dimensional meshes have only one cell in the third direction. 1-dimensional meshes are one cell thick in two directions. For 1 and 2-dimensional axisymmetric (radial) problems, the default azimuthal angle of 30º is recommended. Definitions Total Cells: refers to both the total number of cells in the mesh block and the number to be generated in each specified direction of the mesh.  Mesh Planes: also called fixed points or grid plane locations. The first and last mesh planes in a given direction define the mesh domain. Intermediate points may also be defined to force the mesh to align with specific geometric features or to allow non-uniform resolution. Grid Lines: cell faces. They are spaced between mesh planes automatically by the mesh generator.  Mesh Generator: automatically places grid lines between mesh planes. Constructs the best possible mesh consistent with the specified mesh plane locations and the specified numbers and sizes of cells, described below.  Cell Size: refers to the specified edge length of cells on both sides of a particular mesh plane, and more generally to the edge lengths of any cell generated by the mesh generator. If the cell size associated with a mesh plane is larger than the distance to the next specified plane a warning message will appear and the smaller size will be applied. 



 

 

Number of Cells: the number of cells to be generated between adjacent fixed points, and more generally the number of cells in one or more given directions in the mesh block. If the total number of cells is less than the number specified between adjacent fixed points, an error message will require the user to correct the inconsistency. 

 
Mesh Building Mechanics There are three ways to create or modify a Cartesian or radial mesh in FLOW-3D: 
� Edit the mesh data in the geometry tree.  
� Draw meshes graphically using the mouse in the display pane. 
� Generate the mesh manually by text-editing the input file by setting variables in namelist MESH.  
Mesh Building and Modification in the Tree Structure Right-click on Mesh in the Tree Structure to access options for creating mesh blocks: 



 

 

 Add a Mesh Block to create a new block with default extents that can then be modified as described below.  Mesh Block Summary Information lists number of blocks, total, and individual cell count for all mesh blocks: 

 Change the mesh block extents by opening the mesh block branch of the tree and entering new coordinates for the first and last mesh planes in each direction.  Add intermediate mesh planes by right-clicking a direction branch and selecting Add as shown below. 



 

 

 
 Additional mesh planes can be added in any direction to any block without closing the Add Mesh Plane dialog box. Right-click the Mesh Block title for the following options: 



 

 

 Options are described below: Add Add a new mesh block with default extents. Leaves the selected mesh block unchanged. Delete Delete the selected mesh block. Auto Mesh … Specify the directions and value to apply to create the mesh. If intermediate mesh planes are present, the mesh generator will automatically adjust for them. Only one option (Total Cells or Size of Cells) can be selected: 

 



 

 

If the total number of cells is specified, that number is divided among the checked directions taking the length of each direction into account to give the most uniform mesh possible. If a uniform cell size is specified, the cell size will be set to the closest value that divides the domain evenly in each checked direction. Adjust Mesh Block … Adjust the extents of a block: 

 Select the current or another block from the dropdown menu at the top. Snap to automatically position the selected extent at the edge of the geometry or the nearest adjacent mesh block (to link them). Change the Step to increase or decrease the ratio by which arrow adjusts the extents. Scale Mesh Block … Change the extents of the selected mesh block in all three directions at once while keeping the specified cell count constant. 
 Move Mesh Block … Select Move Mesh Block to shift the block without changing the cell size.  

 Copy Mesh Block … Create an exact copy of the selected block and translate it (shift it) by the specified lengths. 



 

 

 Split Mesh Block … Split the block evenly by the specified number of partitions. New blocks can keep the original block boundary conditions, if desired. Especially useful for users of FLOW-3D/MP. 

 Fit to Geometry… Automatically place the block edges at the extents of the geometry, with an optional offset (measured away from the geometry edge) and create the cell grid as described above for Auto Meshing. 

 Mesh Information … Display the number of cells, maximum and minimum cell sizes, and adjacent cell size ratio (for non-uniform grids) in each direction of the block. Also shows the maximum (worst) aspect ratio between x,y, and z for all individual cells, and the total number of cells. 



 

 

 Mesh View Mode Displays the mesh block with only the edge mesh planes, all mesh planes, mesh planes and cell gridlines, or with codes for the boundary conditions.  Hide, Show, Show Only, Show All Adjusts the display to conceal or render mesh blocks to make it easier to see geometry. Expand and Collapse Opens or closes multiple branches of the mesh tree. 
Mesh Building in the Display Pane Create a mesh interactively in the display pane of the Meshing & Geometry tab by first switching to one of the six plane views with the tool buttons: . Then select Mesh > Create menu above the display pane, press Ctrl-M, or click on the Create Mesh icon in the toolbar:  Now left-click and hold in one corner of the desired mesh block and drag the rubber band to define the extents of the block. When the mouse button is released, a dialog box will appear (see below). Specify the total number of cells in the block here. Assign a total number of cells for the created mesh block or keep the 



 

 

default 1,000 cells. This selection can be modified later in the mesh tree. In the Cartesian coordinate system, you can ensure that the mesh exact fits the geometry (if desired) by selecting Snap to Geometry. 

  Dialog boxes for Mesh Creation in Cartesian (left) and Cylindrical (right) coordinates Select OK to generate the mesh block in the display pane and a new branch in the mesh tree. An existing mesh block can be deleted by right-clicking the mesh block in the mesh tree and selecting Delete. NOTES: TO CREATE A LINKED BLOCK BY DRAWING IN THE DISPLAY PANE, BE SURE TO OVERLAP THE NEW MESH BLOCK AND THE EXISTING BLOCK BY LESS THAN A CELL DEPTH IN THE EXISTING BLOCK. THE GUI WILL CAUSE THE NEW BLOCK TO ‘SNAP’ TO THE EXACT BORDER WITH THE EXISTING MESH BLOCK. WHEN CREATE IS SELECTED (OR WHEN THE MESH ICON IS SELECTED), THE MOUSE REMAINS IN MESH-CREATION MODE UNTIL THE OPTION IS DESELECTED BY UN-CHECKING CREATE IN THE MESH MENU, BY CLICKING ON THE MESH ICON, OR BY PRESSING <CTRL>-M.  
Mesh Building and Modification in the Text Editor Some users may prefer to create or modify meshes by directly editing the input file (prepin.*) in a text editor. This option is available by selecting File > Edit Simulation… from the upper menu of the GUI. All mesh variables are in namelist MESH. Each mesh block is defined in a separate MESH namelist. Multiple mesh blocks are defined by consecutive MESH namelists in the file, each followed by a BCDATA namelist for the boundary conditions. The input variable ICYL controls the choice between cylindrical and Cartesian systems. If ICYL=0 (default), a Cartesian system is used. If ICYL=1, then a cylindrical coordinate system is generated.  Mesh Planes are defined using PX(i), PY(i), PYA(i) and PZ(i), with index number i counting from minimum extent (1) to maximum extent (n). The total numbers of cells in each direction are defined by NXCELT, NYCELT and NZCELT. Cell sizes associated with mesh planes are defined as SIZEX(i), SIZEY(i), SIZEYA(i) and SIZEZ(i). The numbers of cells between mesh planes are defined by NXCELL(i), NYCELL(i) and NZCELL(i). 



 

 

The mesh setup for cylindrical coordinates is directly parallel to Cartesian mesh setup; however, mesh planes in the y (azimuthal) direction are now specified by PYA, and the cell size is specified by SIZEYA (both in degrees).  
Mesh Tips and Rules of Thumb for Mesh Generation Avoiding Errors with Cartesian Meshes Don't over-specify the mesh. Specify only what is necessary and let the mesh generator create a smooth mesh. The actual number of cells created by the mesh generator may differ from the specified value by one or two since the generator attempts to smooth the mesh. Check the maximum adjacent cell size ratios and the maximum aspect ratios in the mesh. This can be done by clicking the Info button on the mesh panel, or by looking at the mesh summary in the report file. The preprocessor summary file, prpout, contains a complete list of mesh coordinates, cell sizes, and other diagnostic data such as minimum cell size, maximum cell size, and the maximum ratio of adjacent cell sizes. For accurate and efficient results: the size ratio between adjacent cells should be as close to unity as possible, and not exceed 1.25 ; and cell aspect ratios should be as close to unity as possible, and not exceed 3.0. In areas with high pressure or momentum gradients or with surface tension, cell aspect ratios should be as uniformly close to 1.0 as possible. A stretched mesh is non-ideal and may be satisfactory in areas with low gradients in the stretched direction.  Unavoidably large cell aspect ratios cause pressure iteration difficulties, and it may be necessary to turn on a line-implicit solution method in the direction with the small cell size (see Pressure Iteration Options in the Input Variable Summary chapter). Avoiding Errors with Cylindrical Meshes Generally, cylindrical coordinates are used only for axisymmetric or annular domain calculations. Axisymmetric calculations without swirl (azimuthal flow) call for symmetry-plane boundary conditions on the Y min and Y max boundaries. Swirl calculations require periodic boundary conditions on the Y min and Y max boundaries. When periodic boundaries are used in the y-direction, it is recommended to employ the ADI pressure solver in that direction.  Non-annular flows may result in very small time steps because of the flow near the z-axis. Note that the z-axis is a singularity point. For 2-D axisymmetric problems, an azimuthal angle of 30º is recommended. Obstacles, baffles, and fluid and temperature regions are always defined in terms of Cartesian coordinates. 



 

 

Gravitation terms are interpreted in terms of cylindrical coordinates in cylindrical meshes. The non-inertial reference frame model must be used to model gravity in the direction normal to the z-axis (see Gravity in the Model Reference chapter). Avoiding Errors with Multi-Block Meshes The order of the mesh namelists in the input file defines the mesh block numbers which distinguish one block from another. The multi-block model is implemented in such a manner as to minimize the dependence of the numerical solution on mesh block ordering, but a dependency still exists. There are no specific requirements or limitations on how the meshes in adjacent or overlapping blocks must match at the boundaries. However, the interpolation procedure employed in the inter-block data transfer algorithm introduces interpolation truncation errors. These errors are unavoidable components of every spatial interpolation algorithm. Interpolation occurs at discrete times of the solution, adding additional temporal discretization truncation errors. These errors are usually small, but may become significant if there are large spatial and temporal variations in the flow near the inter-block boundaries. Following the guidelines below will help minimize those errors and maintain good accuracy and stability of the multi-block algorithm: 
� Minimize the number of blocks. Every mesh block introduces new boundaries that require interpolation and are possible sources of truncation errors. 
� Avoid having large differences in cell sizes between adjacent or nested blocks, especially in the coordinate direction normal to the boundary. A ratio of 2 to 1 should be considered as the maximum acceptable to avoid significant inter-block accuracy loss. 
� Avoid placing inter-block boundaries in flow areas where large flow gradients are expected, including areas with significant variations in geometry. 
� For each pair of linked blocks, make sure that the outer edges of one block are aligned with specified mesh planes in the adjacent block to force the gridlines generated by the mesh generator to align and thus reduce interpolation error.  
� Similarly, in each mesh block containing a nested block, set specified mesh planes aligned with the nested block edges. Reducing Memory Use The amount of memory required to run a simulation depends on the selection of the physical and numerical options and the size and resolution of the active mesh, i.e. the total number of cells used. Minimizing the latter improves runtime and reduces memory and CPU requirements. FLOW-3D reduces memory usage by taking advantage of the Unstructured Memory Allocation (UMA) methodology by which computational cells can be deactivated if they are not needed in the numerical solution and divides the mesh into active and passive cells. Cells are deactivated automatically by the preprocessor: 
� automatically for cells completely blocked by geometry, when heat transfer and electric potential equations are not solved for solids (IHTC < 2 and IEPOT=0).  



 

 

� manually by adding a Domain Removing Component. These components are used to deactivate open areas in the mesh that will never contain fluid or other solution quantities during the simulation. Domain Removing Components can also be used to deactivate parts of solids to limit heat transfer to only the important areas when the full energy heat transfer model is turned on (IHTC=2). Components are made domain removing by selecting that Type when creating the component, or in the tree after it’s created: 

 Cells are deactivated during preprocessing, with the original and final cell count reported on screen: 
“total and active cell counts:   708482   70484” The original count on the left is based on the total mesh, including boundary cells, and the final count on the left is of active cells after removing solid and domain-removing components. If these two numbers are equal, then no cells have been deactivated. The same information can be found the preprocessor report report.* and summary file prpout.*, along with other mesh statistics: cell summary: total number of cells (active and passive) =708482 total number of active cells =70484 active cells include: real cells (used for solving flow equations) =69192 open real cells =50408 fully blocked real cells =18784 



 

 

   standard boundary cells (used for boundary types 1 to 8) =1292    inter-block boundary cells (store interpolated variables) =0 When meshing a complex flow domain it is often possible to use one mesh block with domain removing components and require a similar amount of memory as a multi-block mesh. An advantage of using a single block is the additional accuracy and efficiency (given the same number of active cells) due to the absence of inter-block boundaries. 
Reviewing the FAVORized Geometry and Mesh The Fractional Area-Volume Obstacle Representation (FAVOR™) method used exclusively in FLOW-3D smoothly blocks out fractional portions of grid cell faces and volumes. FAVOR™ applies a collection of special algorithms to compute interfacial areas, enhance numerical stability, and compute advection and stress along solid boundaries. The FAVOR™ algorithms are executed once when the user preprocesses the simulation (or runs it), and at every time step if the General Moving Object physics are activated.  The resolution of the FAVORized geometry and mesh can be reviewed by preprocessing the simulation and viewing the results, or more quickly by FAVORizing the geometry during model setup. Click on the FAVORize icon  in the Toolbar above the view pane on the Meshing & Geometry tab to open the FAVOR™ dialog: 

 



 

 

Geometry can be “FAVORized” using the computational mesh defined in the mesh tree, or using a temporary grid called a Renderspace, which can be created in the geometry tree or defined in the FAVOR™ dialog and requires spatial extents and a uniform cell size to be entered: 

 Using Renderspace only previews geometry and does not show the accuracy of the actual computational mesh. The principal reason to use the Renderspace option is to quickly check the correctness of solids and holes (Boolean operations) when multiple subcomponents are used.  Viewing the geometry Using Computational Mesh is recommended, as it illustrates the geometry the solver will generate. Select Open to see the open areas represented as a gray solid (useful for seeing the insides of cavities) or Solid to see the solid geometry represented in gray. Render to view the FAVORized geometry in the display pane. Use either the cutting planes feature or the mesh slice feature to investigate the interior portions of the geometry to determine if, for example, the mesh needs to be altered to resolve thin sections. Click on the Return to Model Building button to return to regular view in the Meshing & Geometry tab.
Checking and Fixing .stl Geometry Files Often the .stl geometry files generated by CAD software have errors. Errors in geometry files may not appear in the view pane, and can affect the solution accuracy severely. All .stl files should be checked for accuracy before they are imported into FLOW-3D.  Two third-party utilities are provided with FLOW-3D Version 10.0 to check and correct .stl files: MiniMagics and ADMesh. MiniMagics is a free tool provided by Materialise Software at http://www.materialise.com. ADMesh is a free utility available for download from various locations on the Internet. Installing and Running MiniMagics MiniMagics is an .stl geometry viewer and checker and is available for Windows only. Single or multiple geometry files may be viewed simultaneously. It is often useful to import all geometry files into MiniMagics together to identify potential misfits or differences in units between files. MiniMagics provides no fixing capabilities but commercial tools are available from Materialise Software. 

http://www.materialise.com/


 

 

To use MiniMagics, first install it: open Start > All Programs > FLOW-3D v10.x.x > Install MiniMagics Launch MiniMagics: use the desktop icon or open Start > All Programs > Materialise Software > MiniMagics Running ADMesh ADMesh is a command line tool which both tests and corrects .stl files. To facilitate the use of ADMesh, a graphical interface pyADMesh has been created. Launch pyADMesh: On Windows: click the desktop icon, or open Start > All Programs > FLOW-3D v10.x.x > pyADMesh On Linux: run {FLOW-3D Installation Directory}/utilities/pyADMesh 
Detecting Errors in STL Geometry Files Both MiniMagics and ADMesh can be used to detect errors in .stl files. A sample .stl file will be examined to demonstrate the capabilities of both tools. The sample file is that of a solid ring which has three bad triangles. One triangle has a reversed normal, and two triangles are missing. 
MiniMagics Open MiniMagics. Select File > Import Part to import an .stl geometry file. In this example, MiniMagics shows the problem triangles clearly. In the image below, three triangles are highlighted. The left-most triangle is the triangle with a reversed normal. The two triangles on the right are the missing triangles. The geometry can be rotated in such a way that the inside of the part can be seen through the triangles, verifying that the triangles are indeed missing. 

 The Parts Pages dialog below shows the problems found under Diagnostics. One inverted normal is shown in the Inv. Normals box and twelve bad edges are indicated. Also, the surface of the geometry is not closed due 



 

 

to the missing triangles. Open surfaces do not meet the requirements of .stl geometry so another error reports two shells. This error will also be generated when an .stl file contains more than one closed shell. The error can be ignored as long as the surfaces are completely closed. 

 The Parts Pages dialog in MiniMagics provides the part volume, surface area, number of triangles, and maximum Cartesian coordinates and dimensions.  
ADMesh Open pyADMesh and load the geometry file using the Browse button. Select No Save and then Apply to check the file without making any corrections. 



 

 

  Output from ADMesh for is shown under Messages. The output from ADMesh indicates errors in the file and also indicates what actions would be taken to fix these problems if an Output option were selected. The reversed facets to be added include the one which is reversed and the two that will be added. To fix problems that were found and generate a new geometry file with the fixes, select Custom Check and then: 
� Add facets to fill holes  
� Remove facets that have zero neighbors (automatically selected by first option) 
� Only check for perfectly matched edges (automatically selected by first option) 
� Check and fix direction of normals 



 

 

Enter a name for the output file in the Output box and Browse to the directory where the output file will be saved. Select Binary as the saved output format. NOTE: ONLY THE BINARY AND ASCII FORMATS ARE RECOGNIZED BY FLOW-3D. 

  Click Apply to check and fix the file. The results of the selected options, including any errors, will be shown under Messages.  It should be kept in mind that ADMesh is a free utility and is not supported by Flow Science. The ability of ADMesh to fix problems depends on their severity. As the number of problems increase, the likelihood that ADMesh can fix them decreases. If the problems can’t be fixed, it is recommended that the .stl file be regenerated using a CAD package. 



Chapter 6 – Model Reference 
Overview In this chapter, FLOW-3D models and options are described. The chapter is divided into two parts. The first part addresses numerous modeling objectives by answering the question, “How do I model…?” The second part addresses various numerical options. Most of the models and options can be activated using the graphical user interface (GUI). However, some may be activated only by editing the prepin input file in the GUI text editor.  In cases where variables can be set directly from the GUI panels, references are given in italics, indicating where the variables are set. Flyovers are also included on most of the GUI panels, telling the user the variable names and values that are being set in the simulation input file.  Options that are inaccessible from the GUI are described in terms of the input variables found in the prepin file. Full descriptions of these variables can be found in the Input Variable Summary chapter of this manual. To access the GUI text editor after a simulation has been opened, click on Utilities, and then click the Text Editor button at the bottom of the Utilities menu. This opens the current simulation input file for editing. All models and options may be activated by editing the prepin file. 
How Do I Model...? 

Acoustic Waves (Limited Compressibility) Main variables: PROPS: RCSQL, RCSQV 

 The limited compressibility model is used to model acoustic waves in a fluid that otherwise can be treated as incompressible. It is typically used for flows of liquids in problems where sharp pressure changes occur or can be used to simulate flows of gases where pressure fluctuations are small. The model is activated by 



setting Compressibility coefficients for either or both fluids in the properties tree of the Fluids tab. These coefficients are defined as 1/ρc² of fluid #1 and fluid #2, where ρ is the respective fluid density and c is the adiabatic speed of sound. These parameters are assumed to be independent of pressure, density or temperature. Limited compressibility can also be used as a numerical tool to improve pressure convergence in “stiff” flow problems. The idea is to allow a small amount of “give” in the fluid to dampen out sharp pressure fluctuations, easing convergence. To activate this option select the Implicit with automatic limited compressibility radio button in the Pressure solver options group of buttons in Numerics. In this case, there is no need for the user to define the compressibility coefficient in the fluid properties tree. 
 NOTE: IF THE EVOLUTION OF THE ACOUSTIC WAVES IS OF PRIMARY IMPORTANCE, THEN THE TIME-STEP SIZE SHOULD BE LIMITED TO THE CHARACTERISTIC TIME SCALE OF THE ACOUSTIC WAVES TO ENSURE ACCURACY BY SETTING THE MAXIMUM TIME STEP IN NUMERICS. FOR EXAMPLE, THE CHARACTERISTIC TIME SCALE CAN BE ESTIMATED AS THE TIME IT TAKES FOR AN ACOUSTIC WAVE TO PROPAGATE THROUGH THE DISTANCE OF ONE OR TWO CELLS. 

Adiabatic Bubbles 

     FLOW-3D can simulate bubble regions in the flow, however the bubbles must be at least a few cells across. The adiabatic bubble model can only be used in one-fluid, free-surface flows, which can be selected in the Global tab. The model is activated by selecting Physics > Bubble and phase change models > Adiabatic bubbles and setting Gamma in Fluids > Phase Change to a positive number equal to the ratio of the specific heats for the gas that fills the bubbles, for example, Gamma=1.4 for air. In this case, each bubble pressure will be inversely proportional to its volume to the power of Gamma. See the Bubble Models section in the Theory chapter. This does not apply to bubbles that are in contact with a specified void pressure boundary, 



with fluid fraction equal to zero. Those bubbles always assume the boundary pressure. The initial void pressure must be set to the absolute pressure of the gas.  NOTE: IT IS RECOMMENDED TO USE THE IMPLICIT ALGORITHM FOR THE BUBBLE PRESSURE EVALUATION BY SELECTING IMPLICIT FOR THE BUBBLE PRESSURE IN NUMERICS (DEFAULT). 
Air Entrainment 

 In free-surface flows, the turbulence in the liquid may be sufficient to disturb the surface to the point of entraining air into the flow. This process is important, for example, in water treatment where air is needed to sustain microorganisms for water purification, and in rivers and streams for sustaining a healthy fish population. Mold filling with liquid metal is an example where air entrainment is undesirable and is avoided to prevent porosity and other structural and surface finish defects. Although air entrainment is assumed to arise from turbulent disturbances at a free surface, it is not necessary to use a turbulence model to model air entrainment. When modeling turbulence is desired, it is recommended to use the Two-equation (k-ε) or RNG turbulence models. These models can be activated in Physics > Viscosity and Turbulence. See Turbulence. The air entrainment model is activated in Physics > Air entrainment. The Entrainment rate coefficient must be defined to a positive value and defaults to 0.5, which is suitable for most cases. The optional Surface tension coefficient for fluid can also be defined. This will not activate the surface tension model, but will include surface tension in the balance of forces defining the amount of entrained air. In this mode, the model acts as a passive addition to the main flow model in that it does not affect the fluid flow. This is sufficient when the amount of entrained air is relatively small. If this is not the case, flow may be affected by the lighter air entrained in the fluid. Variable density model with density transport must be activated in Physics > Density evaluation to take into account the changes of fluid density due to entrained air. See Flows with Density Variations. In this case, input the value for Air density in the Air Entrainment model panel. 



In addition to the variable density model, the Drift-flux model can be activated to model the fluid/air mixture as a two-phase flow. In this case, the air bubbles can move within fluid due to the difference in their densities. See Drift Flux. If the Allow gas to escape at free surface check box is selected, the entrained air can also escape back into the atmosphere. See Escape of Gas through a Free Surface. The model evaluates and stores a quantity called “Vol. fraction of entrained air,” which is available for postprocessing in spatial and history plots. A Flow Science technical note on air entrainment can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN61.pdf.  
Bingham Material Approximation 

 A Bingham material has a finite yield stress. When applied forces do not exceed the yield stress the material behaves as a solid. Once the yield stress is exceeded, the material then behaves as a viscous fluid. Toothpaste is often cited as an example of a Bingham material.  

http://www.flow3d.com/pdfs/tn/FloSci-TN61.pdf


FLOW-3D has an elastic-plastic stress model that can be used to compute the actual elastic yield stress. The model is activated in the Physics > Elastic stress panel. The elastic modulus and the yield stress values for each fluid are defined in the fluid properties tree in the Fluids > Elastic Properties tab. Fluid will behave as an elastic material until the yield stress is exceeded, at which point it starts behaving as a viscous fluid so fluid viscosity should also be defined in the tree. It is recommended to use the implicit solver for the elastic model for better performance, the selection can be found in the Elastic stress panel, as well as in Numerics. A Flow Science technical note on modeling elastic stress can be found at: http://www.flow3d.com/pdfs/tn/FloSci-TN64.pdf.  
Boundaries with Hydrostatic Pressure Distribution 

 Hydrostatic pressure distribution can be set only at left (X min), right (X max), front (Y min) and back (Y max) boundaries. Select the mesh block and the mesh boundary in the Boundaries tab using the tree structure on the left or the boundary icons in the graphical window. The boundary has to be set to Specified pressure type and the Fluid Elevation (in terms of the actual z-coordinate) also has to be defined. Fluid elevation can be defined as a function of time, using the time-table under the Fluid Elevation button. The elevation can be above the top of the mesh, in which case the boundary will be covered with fluid. Pressure value at such boundary is the reference pressure at the fluid elevation. For free-surface problems where the fluid elevation is below the top of the mesh, Pressure is set to the void pressure defined in the Initial tab. Then, pressure P at each point in the vertical direction is set according to 
P(z) Pr essure GZ RHOF (FLHTn z)= − ⋅ ⋅ −= − ⋅ ⋅ −= − ⋅ ⋅ −= − ⋅ ⋅ −  where GZ is the gravity component in the z-direction, and FLHTn is the current fluid elevation at the specific boundary. The setting is done from top to bottom. The density RHOF is constant, as defined in the properties tree in the Fluids tab, and does not reflect possible variations of density inside the grid, e.g., due to thermal expansion in buoyant flows. As a result the boundary pressure may not be equal to the fluid pressure next to the boundary at the same elevation, even in a zero velocity field, which may lead to flow across the boundary. Fluid surface elevations can also be set at the Specified velocity boundary. 

http://www.flow3d.com/pdfs/tn/FloSci-TN64.pdf


NOTE: FOR FREE-SURFACE PROBLEMS WITH HYDROSTATIC BOUNDARIES WHERE THE TOP BOUNDARY IS A VOID PRESSURE BOUNDARY (I.E., FLUID FRACTION=0. AT THE TOP BOUNDARY), THE USER SHOULD SET VOID PRESSURE EQUAL TO THE PRESSURE AT THE TOP BOUNDARY.  
Buoyant Flow 

 Buoyant flow can occur due to fluid density variation because of thermal expansion, addition of mass scalars and in two-fluid mixtures. Select Physics > Density Evaluation > Density evaluated as a function of other quantities to enable local variations in fluid density. Since fluid density becomes a function of other quantities, additional models may have to be activated to compute these quantities. For example, Physics > Heat transfer > Fluid internal energy advection model must be activated to model thermally buoyant flow. The standard buoyant flow model only introduces a change in density as it appears in the momentum equation. There is no volume change in the fluid. If desired, the corresponding volume changes can also be included in one-fluid cases only. This option is activated by selecting Include volumetric thermal expansion in Physics > Density evaluation. NOTE: ADDITIONAL BUOYANCY EFFECTS DUE TO GRADIENTS IN ALLOY CONCENTRATION ARE INCLUDED IN THE MACRO-SEGREGATION MODEL FOR BINARY METAL ALLOYS. IN THIS MODEL, CONVECTIVE FLOW OCCURS FROM THE COMBINED EFFECT OF THERMAL AND SOLUTAL BUOYANCY. 
Cavitation and Bubble Formation (Boiling) Cavitating void regions may open up in fluid when the local pressure drops below a critical value, which is called the cavitation pressure. The cavitation model is activated in Physics > Cavitation > Activate cavitation model and can only be used in one-fluid free-surface flows. Cavitation pressure and Characteristic time for formation of cavitation bubbles is also set in this dialog. 



 The cavitation pressure in the basic model is constant. All cavitating regions have the same pressure and each such region is treated as a fixed pressure bubble, with the pressure equal to Cavitation pressure. This approach is useful in cases where fluid heating is negligible and cavitation occurs due to rapid changes of pressure in the flow, such as flow in pipes, valves and similar fixtures. 

 



If the Thermal bubbles with phase change model is activated in Physics > Bubble and phase change models, the cavitation pressure becomes a function of the local fluid temperature and computed from the vapor saturation curve that must be defined in Fluids > Properties > Phase Change. In this case, the Cavitation model is coupled to the Vaporization/Condensation model. The value of the phase change Accommodation coefficient is typically in the 0.01 to 0.1 range. Exponent for T-P Curve is the exponent in the temperature-pressure saturation relationship. The default saturation curve is a Clausius-Clapeyron relation between pressure P and temperature T: 
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    = ⋅= ⋅= ⋅= ⋅  Where PV1 and TV1 and the pressure and temperature values at a point on the saturation curve, and  
TVEXP (GAMMA 1) CVVAP / CLHV1= − ⋅= − ⋅= − ⋅= − ⋅  where GAMMA is the ratio of the vapor specific heats, CVVAP is vapor specific heat at constant volume, and CLHV1 is the latent of vaporization. After opening, each cavitating region has its own pressure, P, which is a function of heat and mass transfer and the volume of the bubble: 

vap
P (GAMMA 1) CVVAP T= − ⋅ρ ⋅ ⋅= − ⋅ρ ⋅ ⋅= − ⋅ρ ⋅ ⋅= − ⋅ρ ⋅ ⋅  where T is the temperature and ρvap density of the vapor in the bubble. The constant Cavitation pressure input parameter is not used in this model. The general model should be employed when bubbles are formed by heating the fluid like in thermal bubble printers. Boiling, or cavitation, in the liquid bulk can be delayed past the saturation temperature by using the Superheat temperature. A positive value of the Superheat Temperature allows the liquid in the bulk to heat that many degrees above the boiling temperature before vapor bubbles begin to form at that location. Before the liquid temperature reaches the superheat temperature, the formation of the vapor bubbles is controlled by the Characteristic time for formation of cavitation bubbles defined in Physics > Cavitation. After the superheat temperature is exceeded, vapor bubbles appear and grow on a time scale of several time-step sizes. Superheating can be selectively turned off near solid walls by using a non-zero wall roughness. Component roughness is defined in Meshing & Geometry > Geometry > Component # > Surface Properties > Surface Roughness. See Component Roughness. If modeling cavitation directly is not desirable due to numerical constraints, the Cavitation potential model can be used instead. This model is activated in Physics > Cavitation. It offers an efficient way of modeling possible cavitation by predicting the likelihood of cavitation, or the cavitation potential, without actually introducing bubbles into the flow. The model evaluates the integral over time of the difference between the Cavitation pressure and the local fluid pressure: 
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S max(0, PCAV p(ijk))dt= −= −= −= −∫∫∫∫  The larger the value of this variable, the larger the potential for cavitation can be. The integral is taken from the beginning of the simulation. 



The cavitation potential model can be used to predict die erosion due to cavitation during high-pressure die casting filling, where metal pressure often drops several atmospheres below the vapor pressure in areas of very fast flow, usually near the gates, causing the metal to cavitate. The most reliable indications of possible die erosion are highly localized “hot spots” of the cavitation potential, that is, small areas of very high values of this quantity. To activate this model, go to Physics > Cavitation > Activate cavitation potential model and enter a value for the cavitation pressure. NOTE: IN THE GENERAL CAVITATION MODEL NEWLY CREATED VAPOR BUBBLES ARE ASSIGNED HEAT TRANSFER VOID TYPE 1. See Heat Transfer to Voids and Condensation/Evaporation for additional options.  
Centrifugal Casting In the centrifugal casting process, the mold rotates around a fixed axis, typically vertical or horizontal. The best way to model this process in FLOW-3D is to use the non-inertial reference frame model. In this approach, the coordinate system is attached to the mold, the rotation of which is defined in tabular fashion as angular velocity versus time. See also Smooth Tabular Motion. Since the computational mesh is associated with the coordinate system, the mesh is also rigidly attached to the mold and rotates with it. Open the non-inertial reference frame panel in Model Setup > Physics and activate the model. We will assume below that the rotation occurs around a vertical axis aligned with the z-axis. Select Tabular Input and click on Edit. In the dialog window that opens, select Angular velocity and type Time values in the first column and Z angular vel. in radians per second in the seventh column. In the example below, the angular velocity ramps up from zero to 18.85 rad/s (three revolutions per second) in one second after which time it will stay constant. Click Save and then OK. The tabular input is saved to the file movin.inp shown at the top of the Tabular input panel. Define the Rotation Point located on the axis of rotation. The initial gravity vector direction is defined in the edit boxes provided. NOTE: IT IS IMPORTANT TO DEFINE GRAVITY HERE AND NOT IN THE GRAVITY PANEL IN PHYSICS. 

 



If metal is entering at an inlet mesh boundary, i.e., at a fixed-pressure, flow-rate or velocity boundary, select Add counter-rotating flow component at inlet boundaries. This option will account for the fact that the incoming metal is not rotating with the mold. In the rotating coordinate system of the model, a flow component is added to the incoming metal, rotating in the direction opposite to the mold’s rotation as defined in Tabular input. 
Chemically Reacting Flows Main variables: XPUT: ICHM   SCALAR:  NSC, ISCLR, CMSC   CHM: RATE, DD, ICOEFF  The chemistry model is activated by setting ICHM=1 in namelist XPUT. Chemical species are defined by adding scalar quantities in Physics > Scalars. An equation must be defined for each chemical species n4 participating in the reactions. The equations are defined in the CHM namelist using the rate coefficients, ARATE(n1) , correspondence matrix ICOEFF(n2,n3) for the rate coefficients and the power correspondence array DD(n2,n3,n4), where n1 is the rate coefficient index, n2 is the equation index, n3 is the term index in equation n2 and n4 is the species index. Each species corresponds to a scalar with the same index.  ARATE(n1) is a list of reaction rate coefficients for all reactions. Reaction coefficients are always positive, but the sign in front of a coefficient can be either positive or negative as defined by the sign of ICOEFF(n2,n3). ICOEFF(n2,n3) tells which rate coefficient in the ARATE list corresponds to term n3 in equation n2. A negative value of ICOEFF corresponds to a negative sign in front of the rate coefficient. Finally, DD(N,M,I) is the exponent for species n4 in term n3 of equation n2 (default is zero). Currently, no volume or heat sources are incorporated into the chemically reacting flow model. Please refer to the Reactive Flows section of the Theory Chapter for details of the model. Example: The following input is required to specify the equation    
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∂  ARATE(1) = k1, ARATE(2) = k2, ICOEFF(1,1) = 1, ICOEFF(1,2) = -2, DD(1,1,1) = 1.1, DD(1,1,2) = 2.0, DD(1,2,1) = 1.0, DD(1,2,3) = 0.8, 



Compressible Flow 

 For compressible flow select Global > Flow mode > Compressible. Since only fluid #2 can be compressible, this option can only be used together with the two-fluid model. If there is no incompressible component present in the simulation, then the initial and boundary conditions should be set to that of fluid #2, i.e., fluid fraction should be equal to zero everywhere.  

 Temperatures have to be described in terms of degrees Kelvin or Rankin, while actual and not "gauge" values must be given for pressure. Gas properties are defined in the Properties tree for fluid #2 under Fluids. Both pressure and temperature must be defined for the initial and fixed-pressure and fixed-velocity boundary conditions. There is only one velocity value in each computational cell. When densities of the two fluids differ greatly, i.e., roughly by more than a factor of 10, this mixture velocity may not adequately represent the flow, since velocities of each of the fluids in the same cell can be very different. As a consequence, slip conditions between the fluids are not modeled accurately, which may result in an incorrect fluid interface motion. When modeling liquid and gas phases with liquid heavier than gas by more than a factor of 10.0, separated by a sharp interface, and with the viscous boundary layer thickness at the interface much smaller than a cell size, the Two-fluid interface slip model may help to obtain more accurate results. This model improves the momentum coupling at the interface between such fluids. Two-fluid interface slip model is activated in Advanced Options in the Volume-of-fluid advection group of buttons in the Numerics panel. 



NOTE: CURRENTLY, THE BUILT-IN EQUATION OF STATE IS THAT FOR A PERFECT GAS WITH THE GAS CONSTANT DEFAULTING TO THE VALUE FOR AIR IN CGS UNITS. 
Condensation/Evaporation (One Fluid with Thermal Bubbles) 

 

 Heat and mass transfer may occur between the bubble and surrounding liquid and solid surfaces. It is assumed that the bubble is filled with liquid vapor (i.e., there is only one gas component). The bubbles are homogeneous in that the pressure, temperature and density in the bubble are uniform. There can be many bubbles, each having its own set of values that may change with time because of volume changes and heat and mass transfer. A bubble intersection at a specified pressure mesh boundary will have the pressure and temperature of that boundary. The equation of state for the vapor is the ideal gas equation,  
vap

P (GAMMA 1) CVVAP T= − ⋅ρ ⋅ ⋅= − ⋅ρ ⋅ ⋅= − ⋅ρ ⋅ ⋅= − ⋅ρ ⋅ ⋅  where T is the temperature and ρvap density of the vapor in the bubble. Bubbles are initialized by specifying their initial pressures and temperatures in absolute units. Vapor can also be created in the fluid through cavitation or boiling. See Cavitation. 



The vapor pressure is a function of the local temperature. The vaporization/condensation model is activated in Physics > Bubble and phase change models > Thermal bubbles with phase change. The vapor pressure is then computed as a function of the local fluid temperature using a user-defined saturation curve. The vapor properties and saturation curve are defined under Fluids > Properties > Phase change. The value of the phase change Accommodation coefficient is typically in the 0.01 to 0.1 range. Exponent for T-P Curve is the exponent in the temperature-pressure saturation relationship. The default saturation curve is a Clausius-Clapeyron relation between pressure P and temperature T: 
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    = ⋅= ⋅= ⋅= ⋅  Where PV1 and TV1 and the pressure and temperature values at a point on the saturation curve, and  
TVEXP (GAMMA 1) CVVAP / CLHV1= − ⋅= − ⋅= − ⋅= − ⋅  where GAMMA is the ratio of the vapor specific heats, CVVAP is vapor specific heat at constant volume, and CLHV1 is the latent of vaporization. Each void region has its own pressure, which is a function of heat and mass transfer and the volume of the bubble. The vapor pressure in each cell is computed and stored in the results file. A non-zero value of the Vapor specific heat, which is defined in Fluids > Properties > Phase Change, is used to distinguish a heat transfer bubble with evaporation from an adiabatic bubble. Both types of bubbles require Gamma > 1.0. A positive value for Accommodation coefficient must be defined for the phase change model. It is also necessary to specify Latent heat of vapor in Fluids > Properties > Phase Change. Heat transfer between geometry components and the vapor in a bubble is specified by the component-to-void heat transfer coefficients in Meshing & Geometry > Geometry > Component > Surface properties. The same is true for heat transfer between liquid and vapor in a bubble, which is specified by a fluid-to-void heat transfer coefficient. Note that newly created vapor bubbles are assigned heat transfer void type 1. Physics > Heat transfer > Fluid to solid heat transfer must be activated to enable heat transfer between vapor bubbles and solid components. Phase changes are based on the average fluid properties (density, thermal energy, and liquid fraction) in an element. In particular, it is assumed that the temperatures of the liquid and vapor are equal in an element and not a temperature in a thin layer of fluid at the surface. In this sense, the phase change model is phenomenological and requires the adjustment of the Accommodation coefficient to control the rate of phase change. It is not recommended to use a value larger than 1, because convergence of the phase change model may be difficult to attain. Values of the mass exchange rate associated with phase change (positive values for evaporation, negative for condensation) can be obtained by selecting Physics > Bubble and phase change models > Output phase change mass flux. See also Cavitation and Bubble Formation for additional options.  



Condensation/Evaporation (Two-fluid Model) 

     

 A two-fluid model which has an incompressible liquid and a compressible vapor can have liquid-vapor phase changes occurring at the interface. Nucleation in pure liquid regions or condensation in pure vapor regions is also allowed. Fluid #1 describes the liquid state of the fluid and compressible fluid #2 (gas) describes the vapor. The equation of state for the vapor is the ideal gas equation, 
P RF2 T= ⋅ ρ ⋅= ⋅ ρ ⋅= ⋅ ρ ⋅= ⋅ ρ ⋅ , where RF2 is the gas constant for the vapor, P pressure, ρ density and T temperature of the vapor gas. 



The two-fluid phase change model is initiated in Physics > Bubble and phase change models > Two-fluid phase change and requires a positive value for Accommodation coefficient in Fluids > Phase change. The phase-change rate is directly proportional to the accommodation coefficient. The value of the coefficient is typically in the 0.01 to 0.1 range, and it should not exceed 1.0, although this is not an absolute limit. Vapor properties are defined as properties of the compressible fluid #2, and the vapor latent heat and the saturation curve are defined under Fluids > Properties > Phase change. The pressure-temperature pair, defined by the Saturation Pressure and Saturation Temperature, must be a point on the saturation curve. Exponent for T-P Curve is the exponent in the temperature-pressure saturation relationship. The default saturation curve is a Clausius-Clapeyron relation,  
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    = ⋅= ⋅= ⋅= ⋅ , where PV1 and TV1 and the pressure and temperature values at a point on the saturation curve, and  
TVEXP ( 1) CV2 / CLHV1= γ − ⋅= γ − ⋅= γ − ⋅= γ − ⋅  where GAMMA is the ratio of the vapor specific heats, CV2 is vapor specific heat at constant volume, and CLHV1 is the latent of vaporization (energy per unit mass). Phase changes are based on the average fluid properties (density, thermal energy, and liquid fraction) in a control volume. In particular, the temperatures of the liquid and vapor are assumed to be equal in an element. The interfacial mass flux is computed and stored for postprocessing as a spatial variable. The saturation pressure and temperature corresponding to a specified temperature are computed in subroutine, PSAT, which is a user-customizable routine. Phase change in the liquid bulk can be delayed past the saturation temperature by using the Superheat temperature. A positive value of the Superheat Temperature allows the liquid in the bulk to heat that many degrees above the boiling temperature before vapor bubbles begin to form at that location.  Superheating can be selectively turned off near solid walls by using a non-zero wall roughness. Component roughness is defined in Meshing & Geometry > Geometry > Component # > Surface Properties > Surface Roughness.  See Component Roughness. See Condensation/Evaporation (One Fluid with Thermal Bubbles) for additional options. See Condensation/Evaporation (Two Fluids with Non-condensable Gas) for additional options. 



Condensation/Evaporation (Two Fluids with Non-condensable Gas) 

 The condensation/evaporation model (two-fluid model) assumes that the surrounding gas (i.e., fluid #2) is composed entirely of the vapor phase of the liquid. For situations where the gaseous phase is composed of a mixture of vapor and a non-condensable gas (e.g., water vapor in air), select the Non-condensable gas model. Additions to the two-fluid vapor model include the computation of a mixture gas constant, which is evaluated as a density-weighted average of the gas constants of the vapor, RF2, and the non-condensable gas, RFNC: 
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=  Where ρvap and ρnc are the computed vapor and non-condensable gas macroscopic densities, respectively, and RF  is the mean gas constant. Therefore, the pressure is now computed as 

P RF Tρ= ⋅ ⋅ . Although the saturation pressure of the vapor is computed the same was as in the basic Two-fluid model, the mass flux is computed using the partial pressures of the vapor as opposed to using the full gas pressure, 
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 where Pvap is the partial pressure of the vapor in the gaseous fluid, and Psat(T) is the saturation pressure at the local temperature, computed from the Clausius-Clapeyron Equation, which is defined in the user-customizable subroutine PSAT.F. RSIZE is the accommodation coefficient, which is typically set to a value much smaller than 1.0. Were the value to be 1.0, the model would attempt to predict sufficient phase change to reach equilibrium within one time step. This rate would likely be too fast compared to the actual physical conditions. It is impossible for FLOW-3D to predict accurately the phase change rate without this 



coefficient as the dynamics within the boundary layer at the liquid/gas interface are too small in scale to include in the model. To use this model, select the check box in Physics > Bubble and phase change models > Non-condensable gas model. Enter the values for the Gas constant and Specific heat of the non-condensable gas. Where gas enters at domain boundaries, you can specify the volume fraction of the non-condensable gas (between 0 and 1) by placing the CNCBC (or CNCBCT for a time-dependent variation of the non-condensable gas concentration at the boundary) in the BC namelist of the input file. To define initial fluid regions that contain non-condensable gas, define the volume fraction CNCI in the FL namelist of the input file for all fluid 2 regions, or CNCREG for individual fluid regions, or CNCVRD for defining the volume fraction of non-condensable gas within fluid pointer regions. 
Confined Flow 

 Confined homogeneous fluid can be simulated by employing the one-fluid flow model with the interface tracking algorithm turned off. Select Global > Interface tracking > No sharp interface and Global > Number of fluids > One fluid. In this case, all open space in the mesh is filled by fluid #1 at all time. Pressure, velocity, and temperature and other fluid quantities can be initialized in the Initial tab. NOTE: FOR CONFINED ONE-FLUID COMPRESSIBLE FLOW THE TWO-FLUID MODEL HAS TO BE EMPLOYED AND THEN NO INCOMPRESSIBLE COMPONENT, FLUID #1, SHOULD BE DEFINED IN THE INITIAL AND BOUNDARY CONDITIONS. See Compressible Flow. 
Cooling Channels & Determine Heat Transfer Coefficients In high pressure die casting cooling channels are used to extract heat from hot spots that can potentially create shrinkage porosity in the cast part. In FLOW-3D, the flow in cooling channel is not modeled explicitly but instead the physical influence is modeled approximately using the heat transfer coefficient and temperature of the radiating surface. This section shows the user how to do the following: 
� How to define cooling channels  
� Determine heat transfer coefficients for cooling channels How to Define Cooling Channels To create cooling channels the following steps need to be followed. 1. Create or use existing Workspace. 2. Create a new simulation. 3. Activate Heat Transfer from Model Setup > Physics tab. 



 4. Add the cooling lines as a solid. If they have different heat transfer coefficients then they should be modeled as separate components and must be activated as a Cooling Channel.  5. Define void type/cooling channel type. Each cooling type is defined as having its own unique temperature and heat transfer coefficient. The user can have up to 3 different types. The example shows a typical tree branch for a high pressure die casting simulation. 



 Cooling waterlines defined as separate Components, as a Cooling channel with different Cooling Channel types. Define heat transfer coefficient and temperature in the tree. Heat transfer coefficients are defined in Component Properties, Surface Properties, Heat transfer coefficients to, and Cooling Channel/Void Type. The figure below shows a defined cooling channel. 



 Cooling Channel defined. FLOW-3D models cooling channels as void regions, meaning there is no mass or heat capacity so the temperature in the void/cooling channel remains constant. Determining Heat Transfer Coefficients for Cooling Channels To calculate the heat transfer coefficient in a pipe you must first calculate the non-dimensional Nusselt number. Table 1 is a list of equations used to determine Nusselt number. Conditions Equation Fully-developed turbulent flow,  n=0.3 for cooling, 0.4 for heating   Fully-developed turbulent flow,    



Fully-developed turbulent flow,    Fully-developed laminar flow, constant surface temperature  Table: Heat transfer equations for pipe flow. The user must be careful in choosing the correct condition or the results could result in some uncertainty. Re is the Reynolds number which is equal to : 
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=  (0.2)   D is the inside diameter of the pipe (m) kf is the thermal conductivity of the fluid (W/(m*K)) ρ is the density of the fluid (kg/m3) V is the mean velocity of the flow (m/s) µ is the viscosity of the fluid (Pa*s) µs is the viscosity at the surface temperature of the wall (Pa*s) Cp is heat capacity at constant pressure (J/(kg*K)) The heat transfer coefficient is h then calculated from the correlation given in Eq.Error! Reference source not found. which can be derived from Newton's law of cooling ratio between a stagnant flow and moving flow: 
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= , (0.3) where: h is the heat transfer coefficient (W/(m2*K)) D is the inside diameter of the pipe (m) kf is the thermal conductivity of the fluid (W/(m*K)) 



In the thermal entry region, a "local" heat transfer coefficient hx is a function of the axial location where an "average" heat transfer coefficient hL may be obtained by integrating the heat transfer over the entire length of the pipe. Example Water flows through a pipe at the temperature of Tm1= 26 C enters a 0.254 m- long tube with an inner diameter of D= 0.003175 m.. The average velocity of the water in the tube is V= 23.9 m/s. The water exits at a temperature of Tm2=37.7 C. What is the heat transfer coefficient?      First we calculate the Reynolds number to determine if the flow is turbulent or laminar and what regime it falls in to give the proper condition for the appropriate heat transfer equation. 
Re  75,882=  The flow is turbulent. Next we calculate the Prandtl number to help us determine which heat transfer equation is needed. The Prandtl number is calculated as  

 7.0Pr =  Finally using the third condition from the Table above, gives the following Nusselt equation: 
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Core Blowing FLOW-3D models core blowing as a two-phase continuum, not as individual particles of sand. The two-phase effects (air/sand coupling) are modeled as a drift flux where the approximation of their relative velocities is taken into account. The sand/air model is modeled as a single fluid with free sharp interfaces with pure air. The pure air is modeled as an adiabatic bubble. Vents are defined as valves. For more information about how these models are implemented, refer to Flow Science Technical Note TN88. The steps for creating the simulation are: 
� Create Workspace or select existing workspace in the Navigator tab. 
� Create new Simulation in the Navigator tab. 

http://www.flow3d.com/pdfs/tn/FloSci-TN88.pdf


� Import Geometry or create geometry using FLOW-3D primitives in Model Setup > Meshing & Geometry tab. 
� Add vents as valves if there are only a few vents or Granular Flow Vents as geometry if there are too many vents to add as valves. Valve losses are derived from Bernoulli's obstruction theory. To add vents as valves: select Meshing & Geometry tab > Initial tree > right-click on Valves to add them. A dialog box will open, Valve input prerequisites. Activate Adiabatic bubble, define the ratio of specific heats or gamma, and define external absolute pressure. 

 Once the dialog box has been closed, a valve tree will be added. The location of the valve, external pressure, and the valve loss coefficients need to be defined. The valve loss coefficient is defined as: 
2

*VALC C A
ρ

=  where: 
� A is the total open vent area 
� ρ is the density of air 
� C represents the minor losses which occur in a contraction. For sharp-edged entrances, C has a typical value of 0.5. To add vents as geometry, create a separate component in the Meshing & Geometry tree. This is because vents have their own properties, and components are grouped according to their properties and motion. When modeled this way, vents do not occupy volume. If the vents are the same size then they can be modeled with one STL or modeled using primitives in the same component. If they are different sizes, then they need to be modeled separately. To define them as vents select from the Component Type drop down > Granular Flow Vent. Once the type has been set, the properties must be defined. In Model Setup > Meshing & Geometry > Component > Component Properties > Granular Vent Model define the Vent flow area, diameter of the vent channel and the vent external pressure. 



 6. Activate the following physics and define parameters in the Model Setup > Physics tab: Define Gravity in the correct direction: 

 Activate Viscosity and laminar flow from Viscosity and Turbulence: 



 Granular Flow Model Enter Mechanical volume fraction, Close packing volume fraction, Average grain  diameter, Gas Density, and Gas viscosity: 

 A Global vent is added to represent the venting through the sand. This loss coefficient is a multiplier that represents an average loss through sand plus reduction in area vents due to blockage of the sand. It also takes an average of all the valve external pressures and the sum of all the valve coefficients. An estimate can be calculated by the following equation: 
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Where fsmx is maximum possible solid volume fraction, L is the average distance between the air pocket and the vents, and d is the diameter of the sand. The mechanical jamming volume fraction is the volume fraction of sand above which the flow experiences resistance due to grain-grain interaction. A good value to use is 0.61. Close packing volume fraction describes the sand volume fraction at which flow becomes frozen. When the volume fraction exceeds 0.995*(close packing volume fraction) the velocity of that element is set to zero. This is typically 0.63 for sphere packing. The average grain diameter and density need to be defined and can be found from the manufacturer. Gas or air density and viscosity also need to be defined. The Multiplier in packing drag, Multiplier in threshold packing velocity, and the Angle of repose (degrees) are not needed for modeling core blowing. Density Evaluation Model Once Granular Flow is activated it will automatically activate First order  approximation to density transport equation. 
 Bubble and Phase Change Model This model will be activated automatically if vents were defined as valves this was a perquisites. If the vents were defined using geometry, then the Bubble and phase change model needs to have the adiabatic bubble model selected, gamma defined, and the absolute void pressure specified. 

 



7. Meshing can be defined in the Meshing & Geometry tab. Right-click on Meshing tree select Add a mesh block and select Yes to add with boundaries. Right-click on Mesh Block 1 > Automesh > select all directions, enter size or number of cell, and select OK. Adjust mesh as necessary to ensure flow regions and geometry is well defined. 8. Initial and boundary conditions can be added in the Meshing & Geometry tab. Initial conditions of the void region or bubble region have already been defined when the Adiabatic bubble model was activated from the Bubble and phase change model. The boundary conditions are defined in the Meshing > Mesh Block 1 > Boundaries tree. Sand is carried through the core box by air pressure so a pressure boundary and an air/sand mixture density need to be applied at the boundary. Select the correct boundary box with an S (stands for symmetry boundary) and a boundary dialog box will appear. Select Specified pressure radio button define the inlet pressure, Fluid fraction of 1.0, and define the density. 

 9. Set a finish time, select data output, run simulation. The finish time can be set on the General tab. Data output can be selected on the Output tab along with the frequency of output. The simulation can be can be run by selecting Simulate menu>Run simulation. 
Core Gas Model Dependencies The core gas model computes the generation and flow of the chemical binder gases in permeable molds and cores. The model works in conjunction with other models in FLOW-3D such as filling. It requires the activation of the full heat transfer model (Physics > Heat Transfer > Full Energy Equation) and the solution of the fluid momentum equations (Numerics > Solve momentum and continuity equations). The model requires temperature and pressure to be absolute, for example, in SI units, temperature should be in degrees Kelvin (K). The core gas model does not allow for changes in the computational mesh during restarts. In other words, restart calculations with the core gas model must be carried out on the same mesh in all mesh blocks as in the original simulation. 



      Global Model Controls The model is controlled by a set of global input parameters available through the Physics tab and a set of component-specific input parameters set in the Meshing & Geometry section of the GUI. The model is activated in Physics > Core gas. Additionally, the user can activate venting at all core prints and set numerical options that control the computation of the core gas source terms and the convergence behavior of the core gas flow solver. The print venting option allows the user to model cases of well-vented print surfaces where the gas escapes to atmosphere either through the parting plane, or through specially introduced mold vents drilled to the print surfaces. The reference pressure at prints is the void pressure set in Initial > Void initial State > Pressure. To achieve good accuracy of the core gas source in the binder decomposition zone, a sub-cell resolution method is used. For a typical resin binder a decomposition zone width at the surface of the core, where the thermal gradients are steepest, is 0.25-0.5 mm. A submesh resolution is, therefore, needed for a mesh with cell size larger than 0.5 mm. The core gas flow is computed with a compressible SOR pressure-velocity solver with a convergence tolerance multiplier and max iteration count defined in Physics > Core gas > Numerical Options. The core gas flow is influenced by the metal pressure distribution on the surface of the core which acts as a boundary condition for the gas flow. With the default boundary under-relaxation time of zero, the metal pressure variations are instantaneously reflected on the core gas flow. For a positive value of the under-relaxation time, the changes in the metal pressures exponentially decay to the current value with the specified relaxation time. Core Gas Component Properties Individual core gas obstacles are defined in the Meshing & Geometry component tree. First, in the Solid Properties/Shell Mold drop-down menu, the user can select between a core and a shell mold component. Shell molds are generated around the casting to the thickness set by Maximum Thermal Penetration Depth. At the exterior of such a component, a fixed pressure venting boundary condition is imposed, with the pressure defined in Initial > Void initial state > Pressure. The core gas obstacle is characterized by the thermophysical properties of the sand, by the chemical properties of the binder, and by the flow properties of the gasified binder. 



Model Output The core gas model generates the model-specific output for postprocessing. The General History output in Probe includes the core gas mass fluxes to metal, to void, to prints and a total gasification rate from each core gas component. The spatial plots contain the binder content, gasification rate, surface gas flux and gas density in the core. To access gas velocities and pressures the user should specifically choose core gas velocity and core gas pressure variables to plot these quantities inside the components. The user can also plot core gas pressures concurrently with metal pressure in the casting. 

 The gas flow domain inside core components is confined to fully blocked cells, therefore, the sand core thickness should be resolved by at least one full cell for the core gas flow solution to be accurate. The quality of core component resolution should be checked by first preprocessing the input, then loading the prpgrf file into the Analyze tab and plotting the iso-surface of the complement of volume fraction with the contour value of 0.99. The resulting iso-surface for the sand core components should be continuous throughout the core. If it is not continuous, then the mesh should be refined and the resolution checked again using this procedure. 
Custom Fluid Forces  Main variables: XPUT: IFFOR 



 Users can add body forces, e.g., electromagnetic forces, to act on a fluid using a special subroutine FORCAL, which is called when IFFOR=1 in the namelist XPUT of the simulation input file prepin. The FORCAL routine contains informative comments to guide the user in making additions. No time-step stability checks are performed for forces added in this routine. The user must limit the time-step size in Numerics > Time-step controls > Maximum time step to prevent these forces from causing a numerical instability, which is possible if the forces are a coupled to other flow parameters like velocity or pressure. 
Dielectrophoresis 

 Dielectric forces arise due to polarization of fluid molecules and of particles. The electric potential model must, first, be activated in Physics > Electro-mechanics. The dielectrophoresis model can then be activated in the same window. The dielectric properties for fluid are defined in Fluids > Properties > Electrical Properties. For geometry components the related properties are defined in Meshing & Geometry > Geometry > Component > Electrical Properties. 



 When the dielectrophoresis model is activated in Physics > Electro-mechanics the dielectric force acts in fluids with the dielectric constant greater than one. The dielectric force is also applied to all mass particles in the computational domain. In this case, Particle dielectric constant must also be defined in Physics > Electro-mechanics. Dielectric forces are not compatible with the electro-osmosis model because of the different scales at which these forces are significant. The dielectrophoresis model is automatically deactivated when the electro-osmosis model is turned on. The electro-osmosis model is turned on in Physics > Electro-mechanics, in which case additional input is required and can be provided in the same Electro-mechanics window. Zeta-potential is defined for each solid component in Meshing & Geometry > Geometry > Component > Electrical Properties. The permittivity of vacuum is set in Physics > Electro-mechanics > Permittivity of vacuum, which must be defined to reflect the proper electrical units (e.g., for MKS units with potentials in volts and electric charges in coulombs then ELPERM=8.854x10-12 coul2/joule/m). All dielectric constants are the ratios of the permittivity of the material to that of vacuum.  Two implicit solvers are available for the electric potential equation, GMRES and ADI. The GMRES solver is recommended. See Electric Fields and Electro-osmosis for additional options. A Flow Science technical note on modeling dielectric phenomena can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN56.pdf. 

http://www.flow3d.com/pdfs/tn/FloSci-TN56.pdf


Distance Traveled by Fluid 

 With this feature, the user can request output for the distance traveled by fluid. The feature computes the initial time or from the time at which the fluid enters the flow domain (either through boundaries or mass sources), the distance that a volume of fluid has traveled through the domain. To use this model, navigate to the Output tab, and within the Special output section, check the box next to Distance traveled by fluid. 
Drag in the Mushy Zone The mushy zone in casting is defined as the region where liquid and solid can coexist as a mixture. Only the local viscosity is affected when the equiaxed dendrites (structures consisting of crystals that grow radial inside an under cooled melt) are free to flow within the liquid. Once a fixed solid network is formed and the dendrite coherency is attained, the flow is influenced by the mushy zone. This document will show the user: 
� How FLOW-3D defines coefficient of solidification drag 
� How to add an effective viscosity for flows with a solid fraction less than coherency Defining Drag Coefficient in FLOW-3D To define the coefficient of solidified drag the user must first activate the Heat transfer and Solidification models. These can be activated by from the Model Setup > Physics tab. The figure below shows the activation of these models. Shrinkage using the rapid shrinkage model or the full fluid flow model can be activated via the solidification model. 



 Activation of the heat transfer and solidification models from the Physics tab. Once the models have been activated the drag coefficient can be defined in the Model Setup > Fluids tab by opening the Fluid 1 > Solidification Model > Solidified Fluid 1 Properties tree > Other tree. The figure below shows the input.  

 Fluids tab, showing where the coefficient of solidification drag is input. 



The solid fraction is used to determine solidification. When the solid fraction is at the critical fraction then the drag is infinite. When the solid fraction is below the coherent fraction then the drag is zero. In between coherent fraction and the critical solid fraction the flow is in the mushy zone. The critical and coherent solid fractions are defined by the user and can be found in papers and books. The model can be enhanced by looking at the metal before the coherency where crystals of the solid phase are moving in the flow changing the viscosity. This occurs before solid fraction reaches the coherent fraction. Once the fluid reaches the coherent fraction the drag equation is taken into account and the viscosity is constant. The viscosity enhancement is added manually to the input deck via the text editor. The text editor can be opened from the GUI, select File > Edit Simulation. The molecular viscosity variable is defined by MUS and placed in the PROPS list. See the figure below for an example. Select OK to save the edited input deck. 

 Addition of molecular viscosity in prepin file. How to Calculate Permeability Darcy's law is a mathematical description of flow in porous media which is given below for dendritic networks (Poirier 1987) 
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where: 
� VL is the velocity of the interdendric flow 
� K is the specific permeability of the mushy zone 
� F is the volume fraction of the interdendritic liquid  This is only valid if the following assumptions are true: 
� slow flow; ignoring inertial effects 
� steady flow 
� uniform and constant volume fraction of liquid 
� negligible liquid-to-liquid interaction forces There are several models that can be used to define the permeability but FLOW-3D uses the Blake-Kozeny model. If a user wishes to use other models these can be customized with the source code that comes with the software. Blake-Kozeny Model This model is for flow through a vertical direction is defined as the Blake-Kozeny model. 
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 (0.5) Where d is the characteristic dimension of the dendrite. If the dendrite is modeled as a sphere then d is the diameter of the sphere. If we apply Eq. (0.4) to Equation (0.5) we get the following permeability (Poirier, 1987) 
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 (0.7) where λI is the dendritic arm spacing, C2 is tortuosity, and F is the porosity. Some typical values for dendritic arm spacing are given below. The typical value of tortuosity is 1. 

  Table 8.2: Range of cooling rates in solidification processes (Cohen & Flemings, 1985) 



How FLOW-3D Defines the Coefficient of Solidification Drag FLOW-3D uses a porous media drag to model the solid to liquid phase change. The drag is a function of solid fraction. There are two shrinkage models available to the user; the rapid shrinkage model and the full fluid flow model. The rapid shrinkage model does not take into account volume changes associated with phase change and the fluid is assumed to be at rest. The full fluid model takes into account the volume changes associated with the phase change. Since the drag force is inversely proportionate to the permeability, it can be expressed as follows; 
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= , (0.8) where Fd is the drag force and ø or (1-Vf) is the volume fraction of liquid. Rearranging Eq. (0.8) we get 
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= . (0.10) In FLOW-3D the local solid fraction, fs is equal to (1-Vf) and TSDRG is the coefficient of solidified drag which is equal to  making the drag force: 
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. (0.11) The equation used to enhance the local viscosity is given below: 
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, (0.12) where: 

� µ0 is the molecular viscosity 
� FSCO is the coherent solid fraction 
� FSCR is the critical solid fraction It is important to understand that this works for the solidification range. When using pure metals where the freezing range is zero, it is recommended that the user should introduce a small freezing range, such as 0.1 to 1.0 degree. 



Drift Flux 

 The drift model describes the relative flow of two intermixed fluid components, one continuous and the other dispersed, with different densities. The drift model can be used in four different situations: One fluid, variable density flow with or without free surface The fluid is a mixture of two components, each of a constant density. First, Global > One fluid option must be selected and the variable density model must be selected in Physics > Density Evaluation > Solve transport equation for density (first or second order). Second, activate the drift-flux model in Physics > Drift-flux. The continuous phase density is defined in Fluids > Properties > Density > Fluid 1. For the dispersed component (e.g., bubbles or particles) the density is set in Physics > Drift-flux > Density of the dispersed phase. The initial density distribution can be set in Initial. The mixture density at inlet boundaries, i.e., at a velocity or pressure boundary, can be set in Boundaries. The initial and boundary values of the mixture densities must be in the range between the densities of the two components. No heat transfer is allowed in this case.  One fluid flow with solidification with or without free surface The fluid is a mixture of liquid and solidified phases, each of a constant density. Select Global > One fluid option. The solidification model must be activated in Physics > Solidification (see Solidification). The liquid (continuous) and solid (dispersed) phase densities are defined as in case 1. In Physics > Density Evaluation either Constant uniform density or Density evaluated as a function of other quantities can be used. 



Two incompressible fluids, each of a constant density Select Global > Two fluids, No sharp interface and Incompressible in Global. Densities for the two fluids are defined in Fluids > Properties > Density. Incompressible and compressible fluid mixtures In this case, the density of the compressible gas is defined by the equation of state, while the incompressible material has a constant density, which is always assumed to be much larger than the gas density. Select Global > Two fluids, No sharp interface and Compressible in Global. Fluid #1 density is defined as in case 3. The gas properties are defined the same way as for any compressible fluid case (see Compressible Flow). There are two available drift-flux models: Linear and Quadratic, referring to the approximation of momentum coupling between the two phases. The Drift coefficient in the linear model describes a Stokes-type, viscosity dominated flow of the continuous phase around particles of the dispersed phase. It is the reciprocal of the drag coefficient for the momentum exchange term, which is a function of the fluid viscosity and average particle size (see Theory): DFCOF = µ

ρ

9

2 2
r  where ρ and μ are the fluid density and dynamic viscosity, and r is the average particle size in the dispersed component. The drift velocity in this case cannot be too large, otherwise, the linear approximation may not be accurate. The quadratic drift-flux model takes into account both viscous and pressure forces acting between the two phases, covering a wider range of flow types. This is the recommended model. Required input is Drag coefficient, Average particle size and the Richardson-Zaki coefficient (used for closely packed dispersed phase). In addition, Physics > Drift-flux > Volume fraction of dispersed phase at inversion point can be used in both linear and quadratic cases to model the coalescence of the dispersed phase droplets into a continuous fluid at this volume fraction. This may be important in such devices as oil/water separators. See also Escape of gas through a free surface for a special case of using the drift model. 

Droplet Source Model Main variables: FL: NDROP, XDROP, YDROP, ZDROP, UDROP, VDROP, WDROP, RDROP, SDROP, EDROP, TIMDROP, PDROP, RHODROP, TDROP The droplet source model provides a way to introduce droplets or bubbles into the computational domain at a prescribed location and rate. Bubbles can be introduced in one-fluid, free-surface simulations. Unless stated otherwise, “droplet” below includes both a fluid droplet and a bubble. In version 9.3, the input variables for the droplet source model must be entered directly into the prepin (input) file using a text editor. To activate the droplet source model, define the number of sources using the input variable NDROPS in the namelist FL. Up to 30 sources can currently be defined. A droplet source can be either of fluid #1 or fluid #2, depending on the value of the variable IFDROP(n): IFDROP(n)=1 generates fluid #1 droplets and the value of 



2 generates droplets of fluid #2. For one-fluid, free-surface cases, IFDROP(n)=2 generates bubbles, which should be used together with the adiabatic bubble model.  The droplets at each source are generated at a fixed location X, Y and Z location defined by XDROP(n), YDROP(n) and ZDROP(n). The radius is defined by the variable RDROP(n). When a droplet is introduced into a region where fluid already exists, that fluid is replaced with the droplet at a uniform pressure PDROP(n), temperature TDROP(n), density RHODROP(n) and, for fluid droplets only, velocity UDROP(n), VDROP(n) and WDROP(n). The starting and ending times for the droplet generation is set by the variables SDROP(n) and EDROP(n), which by default span the whole simulation time. The droplets are emitted at a fixed rate defined by the variable TIMDROP(n) (which is time interval between consecutive droplets). The default value of the initial droplet pressure PDROP(n) is set equal to the initial pressure PRESI, except for a bubble source which uses an initial value equal to the void pressure PVOID. The default value of the density RHODROP(n) is set to the density of fluid #1 for fluid droplet source of fluid #1, and to the density of fluid #2 for drop source of fluid #2. The variable RHODROP(n) is only used when the density transport model (first or second order) is activated. Initial velocity and density settings are not used for bubble sources. 
Elastic and Plastic Materials 

 



 Viscoplastic materials are materials that behave as elastic solids up to their yield stress, at which time they behave as a viscous liquid. The incremental elastic stress model in FLOW-3D computes the elastic stress using a Hookean model. Although this constitutive equation predicts only a linear response to stress, implemented as an incremental model it allows the prediction of highly nonlinear responses. This model predicts the total state of stress as a summation of the viscous stress and the elastic stress. Which stress dominates depends on local strain and strain rate. See Theory for more detail. Activate the elastic stress model in Physics > Elastic stress. Select the Implicit or Explicit solver. An implicit solver can be used if the explicit model uses a time-step size too small for an efficient calculation. Also select the type of boundary condition at walls, Fluid sticks to walls or Fluid can freely pull away from walls, depending on the physical situation. For an elastic material, the shear elastic moduli and yield stresses for both fluids can be specified in Fluids > Properties > Elastic Properties. Specifying the yield stress to be negative tells the model that the yield stress is infinite; no yielding occurs. See also Thermoelastic Materials. A Flow Science technical note on modeling incremental elastic stress can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN64.pdf. 

http://www.flow3d.com/pdfs/tn/FloSci-TN64.pdf


Elastic Membrane 

 The elastic membrane model simulates deformation of an elastic membrane in response to external hydraulic and actuator forces. An elastic membrane is a rectangular or circular thin plate with uniform thickness and material properties. Its edge type can be either simply supported or clamped. Finally, a membrane must be oriented perpendicular to x, y, or z-axis. An actuator can be included in the model. The actuator is assumed to be centered on the membrane. The normal force exerted by the actuator on the membrane is the so called actuator force. It is a user-prescribed force and can be given as a sinusoidal function of time, 
( )02sin φπ += tfAF

f , where F is the actuator force, Af is the amplitude, f is the frequency, and φ0 is the initial phase. Alternatively, the force can be defined as a piecewise linear function of time using the tabular input. The actuator force is uniformly distributed over an area over the membrane which is called force distribution area and has the same shape as the membrane, i.e., rectangular or circular. If the force distribution area is set to zero, the actuator force is reduced to a concentrated force at the membrane center. Multiple membranes can be defined with different geometries, locations, orientations and properties. The model is compatible with most other models, e.g., heat transfer across the membranes is allowed. It is noted that an elastic membrane cannot be a porous media or a moving object at the same time. If a moving object collides on a membrane, the latter is treated as a non-moving rigid object in the collision simulation. To activate the elastic membrane model, open Model Setup > Physics > Moving and simple deforming objects and select Activate elastic membrane and wall model. A membrane is created as a regular geometry component. Its subcomponent(s) can be defined by the primitive(s), STL data and other kinds of file(s) allowed by FLOW-3D. The dimensions and even shape of the 



component do not have to exactly correspond to those of the actual membrane, which are defined separately. For example, the extents of the component can be made larger to overlap with the surrounding components to prevent potential leaks in their connect regions. The thickness of the component can also be larger than the actual membrane thickness to help resolve the in the mesh. Once the component representing the membrane has been created, go to Model Setup > Meshing & Geometry > Geometry > Component (desired component) > Component Properties. Inside the dropdown box next to Type of Simple Deforming Object, select Rectangular Membrane or Circular Membrane. Then click the Edit button near the dropdown box to bring up the Membrane Setup window with Membrane dimensions, Material properties and Actuator force and Reference Pressure tabs. 

 The Membrane dimensions tab inside the window is used to define the size, orientation, location and type of edge for the membrane. Open the tab and in the two dropdown boxes, choose Normal in X direction, Y direction or Z direction and Clamped edges or Simply supported edges. Then under Coordinates of Membrane Center, define the membrane center location. Under Membrane size, input the membrane’s linear dimensions (for rectangular membrane) or radius (for circular membrane) and thickness. As noted above, these dimensions are about the actual size of the membrane and do not have to correspond exactly to the dimensions of the component that is used to define the membrane. For example, the component may represent the whole assembly of a printer nozzle. The dimensions and the location of the membrane can then define the part of this assembly that actually deforms. In any case, the properties of the membrane defined in this tab are used by the model to compute the deflections. Deflections will be zero for the part of the component which is outside the membrane dimensions. Mass density, Poisson’s ratio and Young’s modulus of the membrane need to be specified in the Material properties tab in the corresponding input boxes. To input the actuator data, open the Actuator force tab in the window. In Force distribution area, insert the linear dimensions (for rectangular membrane) or radius (for circular membrane) of the actuator force area in the corresponding input boxes. To define a concentrated actuator force at the membrane center instead, type zero for the area. In Force-time function, select Sinusoidal and input the amplitude, frequency (in 



Hertz) and initial phase (in degree) of the force. Alternatively, select Tabular > Edit and fill the table with data for a piecewise linear function for the force. Users may also import a data file with a cvs extension for time-variant force by clicking on Import Values and loading the file. The file must have two columns of data which represent time and force from left to right. 

 Users may need to input the Reference pressure depending on the simulation case. The reference pressure represents the ambient pressure on the membrane surfaces that are blocked by other components or are located outside the mesh. It is the fluid pressure at which the membrane has no deformation. If both sides of the membrane are open and are inside the computational domain, the reference pressure is not necessary and has no effect on the results. By default, the reference pressure is equal to zero. Once the input is completed for all three tabs, click OK to close the window. In membrane simulations, default of the relaxation factor for pressure iterations is set equal to 1.0. Users may need to reduce it to 0.75 or 0.5 if convergence difficulties persist. This is done in Model Setup > Numerics > Pressure solver options > Convergence controls. Input the value for Relaxation factor less than 1.0. It is noted that an unnecessarily small relaxation factor may result in slow convergence of the pressure iterations. In the result file flsgrf, membrane deflection is included as spatial data. Its contours can be shown in 2D and 3D plots. Deflection of the membrane center, where it is the largest, is included in the general history data and can be viewed in both text and graphical formats. Positive/negative value of membrane deflection means the deflection is in the positive/negative direction of the coordinate axis which the membrane is perpendicular to. Note that the geometry does not actually change in the mesh as the membrane deforms, in accordance with the assumption that the deformations are small compared to the size of the membrane. See Theory for more details of the model. 



Elastic Wall 

 The elastic wall model simulates deflection of elastic walls under pressure from surrounding fluid. An elastic wall is a geometry component of arbitrary shape, and its deflection at any point on the surface is in the direction normal to the surface and proportional to the hydraulic pressure, namely 
K
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−=  where w is the local deflection and is defined positive in the direction of the outer surface normal, p is the adjacent fluid pressure, pref is a reference pressure, K is the stiffness coefficient per unit area. At the reference pressure, an elastic wall has no deflection. For the selection of the value for K, please refer to the Theory chapter. The model allows for multiple elastic wall components with independent properties. Deflections are assumed to be small compared to the mesh size. If the local deflection is comparable to the local cell size, the validity of the model may be adversely affected. To activate the elastic wall model, open Model Setup > Physics > Moving and simple deforming objects and select Activate elastic membrane and wall model. 



 An elastic wall component can consist of multiple subcomponents defined by the primitive, STL data and other kinds of data allowed by FLOW-3D. It can be completely or partially inside the computational domain. To define the elastic wall properties, go to Model Setup > Meshing & Geometry and click on Geometry > Component (the desired component) > Component Properties. In the dropdown box next to Type of deforming object, select Elastic Wall and press the Edit button to display the Elastic Wall Setup window. Insert values for the Stiffness coefficient per unit area and the Reference pressure and click OK to close the window. 
 To achieve a good convergence for elastic wall simulation, under-relaxation for pressure and velocity iterations is often needed. The relaxation factor is suggested to be equal to 0.5. This is done in Model Setup > Numerics > Pressure solver options > Convergence controls > Relaxation factor. It is noted that an unnecessary small relaxation factor may result in slow convergence of the pressure iterations. In the result file flsgrf, elastic wall deflection is included as spatial data. Its contours can be shown in 2D and 3D plots. Note that the geometry does not actually change in the mesh as the wall deforms, in accordance with the assumption that the deformations are small compared to the computational cell size. The model is compatible with most other models of FLOW-3D, e.g., heat transfer within elastic wall component is allowed. An elastic wall component cannot be a porous media or a moving object at the same time. If a moving object collides with an elastic wall component, the latter is regarded as a non-moving rigid object in collision simulation. See Theory for more details of the model. 



Electro-osmosis 

 Many substances such as silica and glass will acquire a surface electric charge when brought into contact with an aqueous (polar) medium (electrolyte solution). When this occurs it creates what is known as an Electric Double Layer (EDL). An EDL is a region near the charged surface where an excess of counter-ions over co-ions exist in the fluid in order to neutralize the surface charge. An electric potential (zeta-potential) is created due to the EDL which is a property of the liquid-solid pair that can be measured experimentally. Electro-osmotic flow occurs due to the existence of EDL and an external potential imposed upon it. 

 



The electric potential model must, first, be activated in Physics > Electro-mechanics (see Electric Fields for more details). The electro-osmosis model can then be activated in the same window. The model required two constants to be defined, F*C and F/R*T, where F is the Faraday constant, C is the ionic concentration in the bulk solution and T the ambient temperature in degrees Kelvin. The electrical properties for fluid are defined in Fluids > Properties > Electrical Properties. For geometry components the related properties are defined in Meshing & Geometry > Geometry > Component > Electrical Properties.  A time-dependent external potential can be specified at mesh boundaries or for a conducting component. Insulation boundary conditions for the Zeta-potential are assumed at all mesh boundaries. The Zeta-potential is only associated with components and can be defined in Meshing & Geometry > Geometry > Component > Electrical Properties. If not provided, a zero value of Zeta-potential is assumed. See Dielectrophoresis and Electric Fields for additional options.  A Flow Science technical note on electro-osmosis can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN65.pdf. 
Electric Fields 

 An electric potential can be computed as a function of charge and potential distribution in a computational domain. The model is activated in Physics > Electro-mechanics. The Permittivity of vacuum should be set to correspond to the system of units chosen for a simulation. If electrical charges are present in the fluid or particles, Fluid electric charge model can also be activated. Then Particle charge can be defined in Electro-mechanics. The same charge is assigned to all particles in the domain (see Marker and Mass Particles). 

http://www.flow3d.com/pdfs/tn/FloSci-TN65.pdf
http://www.flow3d.com/pdfs/tn/FloSci-TN65.pdf


Fluid #1 and fluid #2 conductivity and dielectric constants are defined in Fluids > Properties > Electrical Properties. The initial charge density in the fluid can be defined in Initial. 

 Conditions are mesh boundaries are defined in Boundaries. Mesh boundary conditions for electric potential can be conducting or insulating. If a conducting boundary condition is specified on a mesh boundary, the specified value of the electric potential on that boundary can be provided as a function of time. Also a fluid charge density can be defined at inlet boundaries as a function of time. 

 If there are solid components in the computational domain, the components can be of two types: dielectric, or conductive. These properties are defined in Meshing & Geometry > Geometry > Component > Electrical Properties. The initial charge density in the component can be defined in Meshing & Geometry > Geometry > Component > Initial > Electric Charge Density. The electric potential (electric fields) can be activated without fluid in the computational domain. 



Solution of the Poisson equation that governs the potential is done by either ADI or GMRES iteration method; the GMRES solver will typically be more efficient. Choose the ADI solver if the GMRES solver fails to converge. The convergence criteria and the maximum iteration number are defined by EPSELE and MAXPHIT, respectively. Both variables have acceptable defaults and it is not, generally, recommended to change them. It is recommended to use the GMRES solver for better efficiency. See Dielectrophoresis and Electro-osmosis for additional options.  
Electro-thermal Effect 

 Free charges and Joule heating are two consequences associated with the electrical conductivity of materials. A charge density equation that accounts for charge formation, relaxation and convective transport is solved together with the electric field equations. Charged layers may then develop at fluid interfaces or at the boundaries between fluids and solids inducing electric and dielectric forces.  Joule heating and additional forces can be added to include fluid and solid heating due to electric currents. These modeling options require the activation of the thermal energy transport that can be done in Physics > Heat Transfer > Fluid internal energy advection and Physics > Heat Transfer > Full energy equation. The Electric potential model must also be activated in Physics > Electro-mechanics. 



 Joule heating with electro-thermal forces option will include forces in the fluid arising from the variation of its permittivity and electric conductivity with temperature. The respective properties are defined in Physics > Electro-mechanics and Fluids > Properties > Electrical Properties.  

 NOTE: FLUID ELECTRIC CONDUCTIVITY MUST BE DEFINED FOR THE ELECTRO-THERMAL EFFECTS TO WORK. See Electric Fields for additional options.  



Escape of Gas through a Free Surface 

 The drift-flux model is useful for modeling two-phase flow situations in which the phases or components are strongly coupled (see Drift Flux for the general use of the drift-flux model). The drift model allows a lighter material, dispersed in a denser fluid, to move in the direction of the pressure gradient. In the standard drift flux model applied to a single fluid mixture, both fluid components constitute fluid #1. Therefore, the total fluid volume stays constant as the two components separate. In the case of small gas bubbles rising (drifting) to a free surface, the bubble mass will be accumulated at the surface unless a separate model is used to allow the gas to escape into the overlying gas region. This is the purpose of the gas escape option. The Physics > Drift-flux model must be activated. Also, One fluid and Free surface options must be activated in Global. To allow gas to escape at a free surface set IDFESP=1 in namelist XPUT. Related variables: XPUT: IFRHO, ITB, NMAT 
Fan and Impeller Model Main variables: OBS: OADRG, OBDRG, OSPIN, NOBLDS, OBLTHK 



The fan and impeller model imparts momentum to fluid in a region defined by a special kind of "phantom" component. It is used to represent propellers and impellers that rotate too quickly or cannot easily be resolved. See also Rotating components. The model induces both swirl and axial velocity components in fluid that enters a "phantom" geometry component that defines a region but does not block area or volume. These geometry components are usually cylinders of outer radius R and thickness L, which define the region swept out by the rotating blades. The following steps should be performed by editing the prepin file with a text editor, in namelist OBS, preferably after adding and specifying all other geometry in the simulation. 
� First create a single solid subcomponent, usually a cylinder, centered at the origin and axisymmetric about the z-axis. For a cylinder: 

� IOH(m)=1,  
� ZL(m) = 0-(thickness of swept rotation/2),  
� ZH(m) = 0+(thickness of swept rotation/2),  
� RAH(m) = outer radius of swept area, 
� RAL(m) = minimum radius of swept area (radius of the shaft).  where ZH(m) – ZL(m) is the thickness of the swept area, and m is the subcomponent number. 

� Make the subcomponent part of new component, which includes only that subcomponent: IOB(m) = n, where m is the subcomponent number and n is the component number. 
� Set the new component type to “phantom” by setting IFOB(n)=2, where n is the component number. 
� Make the phantom component “virtual” by setting IVRT(n)=1, where n is the component number. 
� Make a single copy of the virtual, phantom component by setting ICPY(l)=n, where n is the component number and l is the copy number, starting with l=1 for the first impeller. Only one copy of each virtual component is permitted for rotating copies like fans and impellers. 
� Rotate the copy so it is oriented correctly using CROTX(l), CROTY(l), and CROTZ(l), where l is the copy number and the rotations are in degrees. 
� Translate the copy so it is located correctly using CTRNX(l), CTRNY(l), and CTRNZ(l), where l is the copy number and the translations are in units of length measured from the origin. 
� Specify the rotation rate, in radians per unit time, as OSPIN(t,n), where n is the component number and index t is used for specifying time-dependent rotational velocity, together with TOBS(t)=time a new velocity begins. At least one OSPIN(1,n) must be specified. 
� Specify the accommodation coefficient for transferring rotational velocity to the fluid as OADRG(n) where n is the component number. See below for the equations to find OADRG(n). 
� Specify the coefficient for transferring axial velocity to the fluid as OBDRG(n) where n is the component number. A negative axial velocity is generated by a negative value of OBDRG(n). See below for the equations to find OBDRG(n). 
� OPTIONAL: Specify the number of blades to add blade effects as NOBLDS(n) where n is the component number. 
� OPTIONAL: Specify the blade thickness in the azimuthal direction as OBLTHK(n) where n is the component number. 
� Repeat all the steps above for each additional impeller, making sure that subcomponent index m, component index n, and copy index l are each increased by one for each additional impeller. 



� Update NOBS to equal the total number of components (nmax), including the virtual components just added, so the model adds the new components to the simulation. It is best to determine the values of OADRG(n) and OBDRG(n) from empirical data because the performance of a fan or impeller depends on details of the blade sizes and shapes that are not part of the model. The manufacturers of these devices often characterize them by so called "performance curves," which are plots of pressure drop across the device versus the average flow rate passing through it. The model performance curve is a linear approximation. The figure below shows a hypothetical example of a performance curve. 
 Typical performance curve (solid) and FLOW-3D approximation (dashed). A performance curve for the model can be derived by relating the rotating momentum source to an equivalent pressure drop across the thickness of the device and averaging the flow rate over the entire cross section. The result is: 
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   In this expression ρ is the fluid density, Q is the net flow rate, and we have simplified the input parameter notation to Ad= OADRG(n), Bd= OBDRG(n) and Sd= OSPIN(t,n). The radius R* in the first term on the right side is R*=R(1-r³/R³) where R is the outer radius of the rotating blades, RAH(m) and r is the minimum radius of the rotating blades, RAL(m). This relationship gives a linear performance curve with y intercept ∆p0 and x intercept Q0 given by: 
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=  Using these relations and a given rotation rate, the OADRG(n) and OBDRG(n) parameters can be computed to give a linear approximation to any desired performance curve. 



Filling Times 

 It is often useful to know the filling history, for example, in casting simulations. Often a control volume fills and then empties many times during a filling process. Both the first and the last times a computational cell is filled can be recorded and stored for postprocessing. This is achieved by selecting Output > Special Output > Filling time check box. This output option is only available for one-fluid, free-surface flows. 
Filters Filters are defined as porous obstacles in FLOW-3D to reduce the flow gradually. It is not used for filtering particles. The fluid is resisted by the viscous and geometric (tortuosity) effects. The most common type is the D'arcy type flow which flow resistance varies linearly with the velocity. When a porous medium is composed of coarse particles or fibers, the flow losses it induces may be proportional to the square of the flow speed rather than the speed itself. This section will show the user: 
� How to model Filters 
� How to determine the drag coefficients from experimental data  How to Model Filters To model filters the user will need to do the following steps: 1. Create or select an existing Workspace. 2. Create a new Simulation. 3. Activate the Porous Media Model from the Model Setup > Physics tab. Darcian is the linear and Forchheimer is the non-linear drag equation. 



 4. Import or create porous media geometry in the Model Setup > Meshing & Geometry. Components are made up of subcomponents. Material and motion properties are defined for Components only not individual Subcomponents. When imported the geometry created in CAD software the actual filter does not need to be modeled only the outer shape. The user will be prompted to define the type and for porous and the porosity which has a range from 0, fully open to 1, fully closed. 

     5. Define the porous properties under Component > Component Properties > Porous properties. 



 Anisotropic properties can be defined for the x, y, and z directions. The capillary pressure model in porous media can be used only in one-fluid, free-surface flows. Within a porous material, a considerable force due to the effects of surface tension within the pore cavities may be generated if the fluid is either wetting or non-wetting to the material. This capillary pressure arises because of the high surface curvatures in the pores of the porous medium. Absorption and wicking of fluid into a porous media is caused by this phenomenon. When the fluid and porous material are non-wetting, the opposite effect occurs, that is, a pressure must be applied to force fluid into  the material. Heat transfer between fluid and porous components can also be modeled, as well as heat conduction with porous components. The surface area of the porous media per its unit bulk volume, should be set because the surface area of a porous component depends on its structure. It can be non-zero even if the component is 100% porous, i.e., in completely open flow regions, making this a useful way to define  mass and/or energy sources in any region of the flow. Heat transfer must be activated in Model Setup > Physics. Thermal-physical properties of a porous component should correspond to the solid component of the porous medium since the effect of porosity is already built into the heat transfer equations. These properties can be defined in Meshing & Geometry > Geometry > Component > Solid Properties. 



   How to determine the drag coefficients from experimental data and estimate drag coefficients  Darcy's law is a mathematical description of flow in porous media which is given below: 
K P

xµ

∂
= −

∂
U , (0.13) where: 
� U is the velocity of the flow 
� K is the specific permeability This is only valid if the following assumptions are true: 
� slow flow; ignoring inertial effects 
� steady flow 
� uniform and constant volume fraction of liquid 
� negligible liquid-to-liquid interaction forces If the Reynolds number increases and the pressure drop become higher additional non-linear terms are introduced in the so called Forchheimer equation: 
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, (0.14) where : 

� a and b are the coefficients defined by experimental data 
� u is the velocity 
�  is the pressure drop across the porous length 



The linear (Darcian) and quadratic (non-Darcian) flow loss equations can be combined into a single expression for Fd 
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, (0.15) where: 

� OADRG is the linear drag coefficient 
� OBDRG is the non-linear drag coefficient 
� Vf is the porosity 
� µ is the viscosity 
� ρ is the density 
�  the Reynolds number 
� D is the diameter of the pore 
�  is the drag coefficient We can define the drag coefficients as: 
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 (0.16) Since the experimental data probably used water to flow through the porous media the user will have to convert this in order to get the correct pressure drops using molten metal. Example 1: Determining drag coefficients from manufacturer's data sheet. Given the following data: 

 Data for various filters 



 Curve fit coefficients for filters. The chart above shows b1 and b2, which are the curve fit coefficients. These correspond to a and b respectively; the linear and non-linear coefficients. These must be converted for molten metal to get the correct flow losses. Given that we are using Foam 20ppi with Aluminum 357, determine the drag coefficients given the data above and the following data: 
� ρ = 2437 kg/m3 
� μ = 0.0012 Pa-s 
� Vf = 0.2 
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 OADRG = 397114.58 OBDRG = 2.43 

Flow in Porous Components Creating a Porous Component A porous component can be specified on the Model Setup > Meshing and Geometry tab in two equivalent ways: 
� in the Add Component window when adding any new component to the geometry, or 
� as the Component Type in the Geometry > Component tree. 



 

 Two Ways of Adding a Porous Component Porous Component Properties Once the Component Type is set to Porous, the parameters on the component branch Porous Properties become active (the drag coefficients become active only when a porous drag model is selected in the Physics tab > Porous media dialog). 
� Porosity (OPOR): Volumetric porosity. Porosity must be a positive value or the component will be treated as a solid. Values are between 0.0 for solid (closed) and 1.0 for empty (open), with default value of 0.5. Use multiple porous components to define complex regions with spatially-variable porosity. Porosity is dimensionless (open volume per total volume), and cannot be time-dependent. 
� X-, Y-, and Z-Direction Porosity (OPORX, OPORY, OPORZ): Allow simulation of anisotropic materials. These could be used to express preferential flow paths, as in tube bundles. Units of area per total area (dimensionless). The volumetric porosity is the largest of these three values. 



� Capillary Pressure (OPCAP): the average, constant additional resistance or enhancement to flow in the media as a function of capillary (surface tension) effects. See the sections below for more detail. Units of pressure (force/area, mass/length/time2). 
� Specific Surface Area (OSPOR): total surface area per unit volume of bulk media. Used only for heat transfer. Defaults to 1.0. Units of area per volume (length-1). 
� Drag Coeff ‘a’ and ‘b’ (OADRG, OBDRG): coefficients that describe the magnitude of drag experienced by fluid in the media. The values and units of these parameters depend on the porous drag model selected. 
� Minimum Saturation (OFCMN): the volumetric fraction of porosity that can't be drained. Usually a function of capillary surface tension effects. Defaults to 0.0; dimensionless. 
� Maximum Saturation (OFCMX): the maximum fraction of porosity that can be filled. Is less than one when there are void regions that can't be occupied by fluid: either because they are completely enclosed by solid or because of bubble entrapment. Defaults to 1.0; dimensionless. 
� Unsaturated Drag Function (IODFIT): selects a drag (i.e. permeability) relation for unsaturated media. Options are described in detail below. 
� Unsaturated Pressure Curve (IOPCFD): selects whether the full wetting and draining (hysteresis) relationship should be used, or if a wetting or draining curve should be used alone. 
� Simplified Saturation at Max Capillary Pressure (OFPCMX): when the simplified capillary pressure model is used, this term describes the absolute saturation (dimensionless) below which the capillary pressure magnitude is greatest and constant. 
� Simplified Maximum Capillary Pressure (OPCMX): the capillary pressure matching the saturation just described, when using the simplified capillary effects model. Units of pressure (force/area, mass/length/time2). 
� Pressure Curve Fitting Coefficient (OPEXP): a dimensionless exponent used to describe the relationship between saturation and drag in unsaturated media when using the power law or exponential drag models. 
� Wetting and Draining Curve Parameters (ALPHWOBS, XNWOBS, XMWOBS, ALPHDOBS, XNDOBS, XMDOBS): The wetting and draining curve parameters used with the Van Genuchten capillary pressure effects model. 



 User-Defined Component Porous Properties Porous Media Physics Models Specify whether the flow should follow saturated (IDRG = 4) or unsaturated (IDRG = 5) drag and capillary models on the Model Setup > Physics > Porous Media dialog. No drag (IDRG = 0) maintains a sharp interface in the porous media with constant capillary pressure but no drag. Constant capillary pressure requires a one-fluid, free-surface simulation. The models are described in detail below. For all porous media models, surface tension pressure computed by the Surface Tension physics model is neglected inside porous media. However, surface tension pressure still acts on (and is calculated for) fluid outside the porous components when the Surface Tension model is active. 

 Selecting a Physics Model to Describe Flow in Porous Media 



Both saturated and unsaturated drag models can be related to the equation of Henry D'arcy (circa 1865), in which flow resistance is linearly proportional to velocity by the permeability K:  Here usuperficial is the apparent velocity, K is the intrinsic permeability, μ is dynamic viscosity, and  is the pressure drop per unit length of superficial transit. D’Arcy’s original observation holds when the pore Reynolds number ReP is less than 1, and is usually reasonably accurate up to ReP of 10, while the addition of the quadratic term provides better accuracy when the velocity of fluid in the media is such that ReP exceeds 10:  Where ρ is the fluid density, upore is the actual (microscopic) velocity of fluid in a pore of the media, Vf is the average effective porosity, and other terms are as previously defined. Vf is the effective porosity of the media, and equals the input value of porosity: OPOR or the maximum of OPORX, OPORY, OPORZ. Microscopic velocity upore is almost never measured directly due to the difficulty of accurately measuring flow between grains without disturbing the media and flow path. Instead, macroscopic (superficial) velocity is measured as the transit time across a unit of media or the flow rate into or out of the media. Saturated macroscopic and microscopic velocities are theoretically related by the media effective porosity via the equation:  All the porous drag models in FLOW-3D use a modified definition of permeability that includes fluid density and a drag coefficient Fd and is combined with D’Arcy’s equation to relate pressure loss and velocity:  and therefore,  The drag term (Fd upore) is added to the right side of the momentum balance (see the Momentum Equations 3.8 and 3.152 in Theory). Here upore is the microscopic flow velocity which is also reported by the postprocessor. Fd may be a function of viscous drag, form drag, capillary effects, or a combination of these, depending on the model selected. In all drag models, the drag coefficient Fd is calculated for each cell at each time step and converted with ∆t (the time-step size) as output into the dimensionless quantity DRG:  



 This value always varies between 0.0 (infinite drag – no fluid flow) and 1 (zero drag or infinite permeability). This quantity can be plotted in the output as (1 – DRG) which is called the normalized drag coefficient. Saturated Capillary Effects in Porous Components  (Physics > Porous media > No drag or Saturated drag, and Component Capillary Pressure OPCAP ≠ 0) Saturated flow in porous media is characterized by a sharp interface between fully saturated and fully unsaturated regions. When Saturated drag or No drag is selected, capillary pressure is a user-defined constant which is applied at the interface between the fully saturated and unsaturated regions only, i.e., in cells where 0.0 > fluid fraction F > 1.0. Saturated capillary pressure is subtracted from the void pressure at the sharp fluid interface inside the porous media. Saturated capillary pressure is defined for each component as OPCAP and is positive when the media is wetting and negative when the media resists wetting. While the best way to determine the interface capillary pressure is via laboratory experiment, the following relation estimates saturated capillary pressure:  where σ is the surface tension of the fluid, θ is the average contact angle between fluid and solid in a pore (< 90° is wetting, > 90° is drying), and Dpore is the average pore diameter. Saturated Drag Losses in Porous Components (Physics > Porous media > Saturated drag) Saturated drag is simulated by a combination of viscous (linear) and form (quadratic) drag terms combined in a single expression for the drag coefficient:  Combining with the pressure loss equation yields the linear and quadratic contributions to pressure loss per unit length as a function of superficial velocity:  This equation can be used to curve-fit pressure loss testing data, where OADRG and OBRDG are media-specific loss coefficients. When test data is unavailable, they can be estimated:  



 α is a constant, typically of order 180, β is a roughness factor typically ranging between 1.8 and 4.0 (representing smooth through rough fibers), and Dparticle is the average equivalent spherical diameter of the fibers, dendrites, or particles of the porous media. For randomly packed spheres, the Ergun equation uses α = 150 and β = 1.75. Test data, where available, will provide better accuracy. Unsaturated Capillary Effects in Porous Components (Physics > Porous media > Unsaturated flow) The capillary pressure model in porous media can be used only in one-fluid, free-surface flows. There are two models that describe the relationship between saturation and capillary pressure: a simplified capillary pressure model and a more thorough Van Genuchten capillary pressure model that follows the work of Niemi & Bodvarsson. Both models allow the user to specify capillary pressure as a function the local saturation and one or more hysteresis functions. The user may include or ignore hysteresis effects in each component by specifying the Unsaturated Pressure Curve (IOPCFD) under Model Setup > Meshing & Geometry > Component tree > Porous Properties: 
� full hysteresis (both wetting and draining effects, IOPCFD = 0), 
� a wetting-only curve (IOPCFD = 1), or 
� a drying-only curve for (IOPCFD = 2)  In addition, one of three drag models can be selected for each component:  
� Power Law drag (IODFIT = 1) 
� Exponential drag (IODFIT = 2), or  
� Mualem’s model for relative permeability (IODFIT = 3). Both the simplified and Van Genuchten capillary pressure models use minimum and maximum saturation (OFCMN and OFCMX), which represent the irreducible and maximum absolute saturation fraction of the media from 0 to 1. With the local fluid fraction F they determine the relative (effective) saturation Se:  The capillary pressure and drag models and their parameters are described individually below. Simplified Unsaturated Capillary Pressure Model (IDRG = 5 and IVG = 0) The simplified form of the wetting and draining relationship between saturation and capillary pressure is illustrated below: 



 Simplified Unsaturated Capillary Pressure Model Hysteresis  PCMX (OPCMX for an individual component) defines the maximum capillary pressure that retains fluid in the material at some critical fluid fraction OFPCMX. The shape of the curves for saturation greater than FPCMX is given by the following relations. The bubbling (air-entry) pressure Pb, is the pressure at which air can be forced into an initially saturated sample, and is the magnitude of the separation between the wetting and draining curves in the Simplified Capillary Pressure model.    Select OPCMX, OFPCMX, and OPEXP to fit experimental data. Scanning curves represent the change in pcap vs. Se when alternating between filling and draining, and have an arbitrary simplified slope of:    Van Genuchten Unsaturated Capillary Pressure Model (IDRG = 5 and IVG = 1) A more physical form of the complex relationship between saturation, capillary pressure, and draining/filling state of the fluid is provided by the Van Genuchten Capillary Pressure model illustrated below, with arrows showing the state path for a series of changes in filling direction: 



 Hysteresis Path 1. Begin draining from saturated media. Capillary pressure follows envelope. 2. Reverse to filling. Capillary pressure follows 1st-order filling scanning curve. 3. Reverse to draining. Capillary pressure follows 2nd-order draining scanning curve. 4. Continue draining. Capillary pressure follows draining envelope. 5. Minimum absolute saturation. Begin filling. Capillary pressure follows envelope. 6. Reverse to draining. Capillary pressure follows 1st-order draining scanning curve. 7. Reverse to filling. Capillary pressure follows 2nd-order filling scanning curve. 8. Reverse to draining. Capillary pressure follows 3rd-order draining scanning curve. 9. Finish experiment. 

Media Parameters OFCMN = 0.0714 OFCMX = 0.9400 ALPHWOBS = 53316 dyne/cm^2 ALPHDOBS = 118630 dyne/cm^2 XMWOBS = 0.6 XMDOBS = 0.9091 XNWOBS = 9 XNDOBS = 11 Van Genuchten Unsaturated Capillary Pressure Model Hysteresis  The primary filling and draining curves define the envelope of the capillary pressure for each porous media-liquid system. If the process switches between filling and draining before filling or draining is complete, the capillary pressure follows scanning curves inside the envelope. There are an infinite number of filling and draining scanning curves within the envelope, and the actual curve depends on the local saturation and capillary pressure when the reversal occurs. The model detailed by Niemi and Bodvarsson has been enhanced to include the first-order draining and second-order filling scanning curves. 



 
 The curves should be defined from experimental data and curve-fit using the equations above. The first-, second-, and higher-order draining curves define intermediate capillary pressure vs. saturation paths depending on whether the direction of flow has reversed once, twice, or more than twice. The scanning curve shapes are set by the primary curve parameters, which should be determined experimentally: 

� Alpha coefficient of the wetting curve (ALPHWOBS): Units of pressure, defaults to 0.0.  
� M-exponent for the wetting curve (XMWOBS): Dimensionless. Defaults to 1.0. 
� N-exponent for the wetting curve (XNWOBS): Dimensionless. Defaults to 1.0.  
� Alpha coefficient of the draining curve (ALPHDOBS): Units of pressure, defaults to 0.0. 
� M-exponent for the draining curve (XMDOBS): Dimensionless. Defaults to 1.0. 
� N-exponent for the draining curve (XNDOBS): Dimensionless. Defaults to 1.0.  Unsaturated Drag Losses in Porous Components  (IDRG = 5) Drag losses in unsaturated porous components, like capillary pressure effects, are primarily a function of saturation, as well as intrinsic characteristics of the media like pore size, tortuosity, and microscopic geometry. An unsaturated drag model can be selected for each component when Unsaturated Flow is selected on the Model Setup > Physics > Porous Media dialog. To select a drag model, set Unsaturated Drag Function (IODFIT) to Power Law (IODFIT = 1), Exponential (IODFIT = 2), or Mualem (IODFIT = 3) in the Model Setup > Meshing & Geometry > Component > Porous Properties tree. The models are described below. Power Law Unsaturated Drag Model (IDRG = 5 and IODFIT = 1) The simplest of the unsaturated drag models relates the drag coefficient Fd (described above) to a constant OADRG and a power-law relation to saturation via OBDRG:  where Se is the effective saturation of the porous material (described above) and OADRG is the coefficient that describes the drag when the media is fully saturated (units of inverse time), and can be empirically estimated as:  where α is a constant that typically has a value around 180 (150 is correct for the Ergun equation for randomly-packed spheres). OBDRG is the empirically-determined parameter describing the saturation 



relation, and it can be shown that OBDRG = 3.0 theoretically represents a close-packed bed of uniform pore size. There is evidence that the relation to drag also follows hysteresis in the same way as capillary pressure; in this simplified power-law model, the uncertainties of the hysteresis effect are ignored. Exponential Unsaturated Drag Model  (IDRG = 5 and IODFIT = 2) More physically descriptive than the power-law model, the exponential model uses the following relation for the drag coefficient described above:  OPEXP, OBDRG, and OADRG should be fit to known permeability data, and OADRG (units of inverse time) can be estimated using the relation given above. Note that the exponential unsaturated drag model and the simplified unsaturated capillary pressure model both use the same OPEXP. Mualem’s Unsaturated Drag Model for Relative Permeability  (IDRG = 5 and IODFIT = 3) This model has a strong experimental basis and defines permeability K as the product of a saturated permeability K0 (units of area) and a relative permeability Kr (dimensionless):  Kr is defined as a function of effective saturation (defined above) and a dimensionless fitting parameter OBDRG:  All porous drag models in FLOW-3D relate permeability K to a calculated drag function Fd:  OADRG is the permeability K0 of the material at full saturation, so the drag coefficient is: 
 Heat Transfer and Conduction in Porous Components First activate the heat transfer model by selecting Physics > Heat transfer > Fluid to solid heat transfer. Set Specific Surface Area (OSPOR, surface area per unit bulk volume) for the porous component under its Porous Properties tree. In FLOW-3D, OSPOR can be non-zero even if the component is 100% porous, i.e., completely open. This is used to define mass and/or energy sources in any region of the flow. 



Set thermal-physical properties under Meshing & Geometry > Geometry > Component > Solid Properties for the pure solid of the medium. The effect of the open volume in the media is already included in the heat transfer equations. 
Flow Losses in Porous Baffles 

 Baffles in FLOW-3D are used to describe thin walls. Unlike solid components, baffles do not block any volume; they are located at boundaries between computational cells blocking the whole face. If, for example, a spherical baffle is defined in the input, the preprocessor will convert it to a stair-step shape conforming to the nearest cell boundaries. Therefore baffles are ideal to describe flat thin, flat surfaces. Additionally, a uniform porosity can be given to each baffle to model permeable screens. To add a baffle, right click on Baffles in Meshing & Geometry and select Add. Simple shapes then can be defined using variables in Definitions and Limiters under the newly created baffle. Specify only one definition, and as many transformations and limiters as necessary: for example, to make a circular plate baffle, specify the definition as Z = 0, a limiter as Cylinder Outer Radius, and then rotate and translate the baffle to the desired location. Remember that specifying a radius as a definition or limiter applies the radius around the z-axis, not necessarily around the center of the baffle. Porosity of a baffle is defined in Porosity Properties in the Baffle property tree. Baffle porosity can take values between 0.0, for no porosity, and 1.0, for a completely open baffle. Flow losses in porous baffles can be linear or quadratic, or both, with respect to the fluid velocity. Note that the flow losses are computed from the microscopic fluid velocity, using the actual flow velocity inside the porous baffle. The linear losses are specified using the Linear Loss Coefficient, and quadratic flow losses are defined using the Quadratic Loss Coefficient. The latter has no dimension, while the former has the dimension of velocity. See more details on how the loss terms are incorporated into flow equations in Theory. 



Flows with Density Variations 

 Fluid density in FLOW-3D may vary in a number of situations: 6. Density is a function of other variables, e.g., temperature, scalar concentration or solid fraction. Select Physics > Density evaluation > Density evaluated as a function of other quantities for this option. For example, in thermally buoyant flow density is a linear function of temperature. This model is activated when Physics > Heat transfer > Fluid internal energy advection is activated, and the thermal expansion coefficient is defined for either or both fluids in Fluids > Properties > Density. The Reference Temperature used in the density equation is defined under Fluids > Properties > Thermal Properties. (see also Buoyant Flow). Similarly, in the Macro-segregation model density may be a function of alloy composition. In that case Solutal Expansion Coefficient must be defined in Fluids > Properties > Segregation Model. 

 7. In two-fluid problems the local density represents the mixture density of the two fluids and will vary according to the fraction-of-fluid function distribution. In this case, Physics > Density evaluation > Density evaluated as a function of other quantities is turned on automatically by the code. 8. A one-fluid density may vary spatially in an otherwise incompressible flow with or without free surfaces, as set in the initial and mesh inlet boundary conditions. Use Physics > Density evaluation > Solve transport equation for density (first- or second-order). 



 9. Compressible fluid density is a function of pressure and temperature according to the equation of state. When the compressible flow model is used, Physics > Density evaluation > Solve transport equation for density option is automatically activated. When Solve transport equation for density option is activated, density advection is computed directly from a continuity equation. See Density Advection. The initial density distribution can be set in Initial. The fluid density for case 3 above can be set at an inlet boundary (i.e., at a velocity or pressure boundary) in Boundaries. NOTE: SOLVE TRANSPORT EQUATION FOR DENSITY CANNOT BE USED WITH TWO INCOMPRESSIBLE FLUIDS OR WITH FLUID INTERNAL ENERGY ADVECTION FOR INCOMPRESSIBLE FLOWS.  
Fluid Residence Time 

 It is sometimes useful to know the time a fluid particle spends within the computational domain. A special output quantity called, fluid residence time can be computed and stored in every computational cell containing fluid. This is achieved by selecting the Output > Special Output > Fluid residence time check box. A second-order transport equation is solved for this variable, designated here as S, with the unit source term: 



S t S 1∂ ∂ + ⋅∇ =∂ ∂ + ⋅∇ =∂ ∂ + ⋅∇ =∂ ∂ + ⋅∇ =u  The units of S are time. The initial value of S for any fluid entering the computational domain is zero. This output option is available for both one and two fluid flows. 
Fluid-Structure Interaction and Thermal Stress Evolution Fluid-Structure Interaction 

 The fluid-structure interaction model is an integrated solid mechanics modeling capability in FLOW-3D. This model makes use of the finite element method (FEM) to simulate and analyze the stresses within solid components and the resulting deformations. Stresses develop in the solid due to the forces exerted by the 



surrounding fluid, thermal gradients within the solid, and/or constraints imposed by walls and other components. Model Setup Defining a solid component as a Deformable Component in the Component Properties tree activates the model for that particular component. The minimum requirements in terms of the material properties for this model are: Solid Density and at least two elastic properties out of Bulk Modulus, Shear Modulus, Elastic (Young’s) Modulus, and Poisson Ratio. Unless these minimum requirements are met, the simulation will not start. If the Heat Transfer model is turned on and thermal gradients exist with the solid, the model uses that information to compute thermal stresses. Most of the solid properties are temperature dependent and if this information is available, all the properties mentioned above can be defined as temperature dependent tables. Click on the Tabular button to enter the temperature dependent properties directly, or Import Values from an existing comma separated value (CSV) file. These properties can also be loaded into components from the Solids Database under the Materials menu. After the elastic properties are provided, it is time to generate a finite element (FE) mesh for the solid. The preprocessor makes use of a rectangular Cartesian mesh around the solid component to generate the FE mesh. This Input Mesh can be the Cartesian mesh that is used to solve for the fluid (default), or it can be an independent Local Input Mesh whose purpose is only to generate the FE mesh for the solid component.  NOTE: THE LOCAL INPUT MESH INFORMATION WILL BE SAVED IN THE FE MESH FILE THAT IS GENERATED IN THE NEXT STEP, AND NOT IN THE PREPIN FILE. After the Input Mesh is defined, right click on the FE Mesh File and Generate to create the FE mesh. If there is no filename specified, the filename for this mesh defaults to comp#.prjext.FEmesh, where prjext is the project extension. If an FE mesh file already exists, Open it using the File options button, right click on the FE Mesh File and Load and Display the existing FE mesh file. If satisfied with the FE mesh, check the Simulate with specified mesh file option. If the Simulate with specified mesh file option is not checked, the FE mesh file for this component is regenerated every time Generate All or Preprocess Simulation is selected. 



 Simulation The solver used for the solution of the stresses within the solid component is similar to the GMRES pressure solver. This is the only solver currently available, and the user can adjust the GMRES subspace size 



(sometimes called the restart number, and is MRSTRTFSI in the input file), the maximum number of iterations and the convergence tolerance. Changes to these parameters are made from the Numerics tab: 
 The default value of the GMRES subspace size is 20. Increasing this value will allow the solver to achieve convergence with fewer iterations; however, the CPU time per iteration will increase and the memory usage will rise linearly with the subspace size. In some simulations, where convergence is not being reached, increasing this value can drastically reduce the overall CPU time. The maximum number of FSI iterations limits the number of iterations used by the solver; the default value is 25 which should be more than enough for most simulations. If the FSI iteration count in the solver is repeatedly reaching the limit (as seen in the Simulation messages), this limit or the subspace size can be increased. The convergence tolerance specifies the maximum residual permitted in the solution of the solid dynamics equations. This value is dimensionless independent of the mesh size and time step. The value represents a relative error in the computed strain. The default value is 10-6, which should work well for most simulations. However, if the goal of the simulation is to get a final-time stress result, rather than accurate time-dependent results, raising this value will not greatly harm the accuracy of the end result. For simulations where the displacements and stresses are needed to be highly accurate during the course of the simulation, lowering this value can help. Note that convergence generally becomes increasingly slow for values of the convergence tolerance smaller than 10-8 for reasons of machine precision round-off. The FSI model solves the equations of solid dynamics incrementally, so theoretically, large deformations can be predicted with reasonable accuracy. Although fluid motion due to displacements at the solid-fluid interface is predicted by the model, FLOW-3D volume and area fractions (FAVOR™ fractions) are not updated, so the geometry changes of the solid components are not seen by the fluid. Therefore, in simulations, where significant deformations are modeled, although the solid dynamics are accurately represented, its effects on the fluid are not. Components must be in contact with fluid mesh boundaries or other components during a simulation so that they cannot move freely. If not constrained, the solid dynamics equations will predict rigid-body motion for the components, and this motion will not be represented in the fluid. Therefore, when setting up simulations, it is key that components be in contact with other components or fluid mesh boundaries. Yielding materials cannot be accurately represented by the model. This is because the incremental stress model maintains a linear stress-strain relationship within each time step. Furthermore, the mesh is Lagrangian, which means that the mesh deforms along with the solid material. If the material were allowed to yield, then the mesh could become highly distorted and eventually lead to numerical failure. However, the existing Elasto-viscoplastic model in FLOW-3D is designed to simulate yielding materials. 



Postprocessing The finite-element results produced by the model can be viewed in a separate display. To access the FSI data, from the Analyze tab, select the FSI TSE sub-tab: 
 From this tab, select which of the components to view: 

 Also selectable are the time limits, and the data source. Note that to view Selected data, selected data for fluid-structure interaction must have been chosen during set up of the simulation. Click Render and the Display tab appears, and from here various data variables can be plotted for the FSI component. Other controls to zoom, rotate, etc., are the same as the 3-D display. The default display is the normal displacement. This shows the surface displacement in the direction of the outward-pointing normal over the entire surface of the component, relative to its original conformation. Negative values indicate that the surface is pulled in and positive values indicate that the surface is pushed out relative to its original position. Individual displacements throughout the component in the Cartesian x, y and z directions can also be plotted. There are 6 components of elastic stress and 6 components of strain available for plotting. These are the 6 independent components that comprise the symmetric stress and strain tensors. These components are difficult to conceive for three-dimensional simulations, as even simple 1-D tension, diagonal to the coordinates, will produce non-zero values in many of the stress components. That is why the mean isotropic and the Von Mises stresses are provided. They are stress invariants, and as such, are independent of the Cartesian coordinates chosen. The mean isotropic stress indicates the amount of compressive (negative values) or tensile (positive values) stresses in the part, which could indicate areas most prone to buckling or cracking. In contrast, the Von Mises stress is a measure of shearing stresses; its value is always positive. Regions with high shearing stresses are more prone to tearing. Temperature is available for plotting as a convenience. This temperature will be the same as the wall temperature available from the fluid 3-D display. The volume expansion indicates regions of the component 



that have expanded (positive values) or shrunk (negative values) during the course of the simulation. Such expansion or contraction could be caused by temperature changes, or by tensile or compressive stresses. Thermal Stress Evolution in Solidified Fluid Region 

 The thermal stress evolution (TSE) model is designed to use the finite element method (FEM) to simulate and analyze the stresses and deformations within the solidified fluid region. These stresses can develop as a result of forces exerted by the surrounding fluid, thermal gradients within the solidified fluid, and/or constraints imposed by walls and other components. Model Setup These computations are only performed for the fully solidified fluid cells and therefore the model requires the Solidification model to be turned on. The Thermal stress analysis is activated either from the Solidification window or the Solidified fluid region branch under Meshing & Geometry > Geometry tree. The minimum requirements in terms of the material properties for this model are: Fluid Density and at least two elastic properties out of Bulk Modulus, Shear Modulus, Elastic (Young’s) Modulus, and Poisson Ratio. Unless these minimum requirements are met, the simulation will not start. These properties are set under the Fluids tab, Properties > Fluid 1 > Solidification Model > Solidified Fluid 1 Properties. Pressure in the unsolidified fluid is used as a boundary condition at the liquid/solid interface. Most of the solidified fluid properties can be defined as functions of temperature using tabular input. Click on the Tabular button to enter the temperature-dependent properties directly, or Import Values from an existing comma separated value (CSV) file. These properties can also be loaded into components from the Fluids Database under the Materials menu.  NOTE: TO DEFINE DENSITY AS A FUNCTION OF TEMPERATURE, IT NEEDS TO BE DEFINED IN THE DENSITY PROPERTIES OF FLUID 1. ONCE A TABLE FOR DENSITY EXISTS, IT WILL ALSO BE USED FOR THE SOLIDIFIED FLUID DENSITY. 



 After the elastic properties are provided, it is time to generate a finite element (FE) mesh for the solid. This is done from the Meshing & Geometry > Geometry > Solidified fluid region. The preprocessor makes use of a rectangular Cartesian mesh around the fluid region to generate the FE mesh. This Input Mesh can be the Cartesian mesh that is ultimately used to solve for the fluid (default), or it can be an independent Local Input Mesh whose purpose is only to generate the FE mesh for the solidified fluid region. NOTE: THE LOCAL INPUT MESH INFORMATION WILL BE SAVED IN THE FE MESH FILE THAT IS GENERATED IN THE NEXT STEP, AND NOT IN THE PREPIN FILE. After the Input Mesh is defined, right click on the FE Mesh File and Generate the FE mesh. If there is no filename specified, the filename for this mesh defaults to solidified_fluid.prjext.FEmesh, where prjext is the project extension. If an FE mesh file already exists, Open it using the File options button, right click on the FE Mesh File and Load and Display the existing FE mesh file. If satisfied with the FE mesh, check the Simulate with specified mesh file option. If the Simulate with specified mesh file option is not checked, the FE mesh file is regenerated every time Generate or Preprocess Simulation is selected.  NOTE: THE PREPROCESSOR MESHES THE WHOLE OPEN REGION WITHIN THE INPUT MESH. IF IT IS KNOWN A PRIORI THAT THE FLUID IS NOT GOING TO BE PRESENT IN A PART OF THE OPEN REGION, THAT SECTION CAN BE REMOVED FROM THE FE MESH USING A PHANTOM COMPONENT WITH IFOB(M)=7. 



 Simulation The solver used for the solution of the stresses within the solidified fluid region is similar to the GMRES pressure solver. This is the only solver currently available, and the user can adjust the GMRES subspace size (sometimes called the restart number, and is MRSTRTFSI in the input file), the maximum number of iterations and the convergence tolerance. Changes to these parameters are made from the Numerics tab: 



 The default value of the GMRES subspace size is 20. Increasing this value will allow the solver to achieve convergence with fewer iterations; however, the CPU time per iteration will increase and the memory usage will rise linearly with the subspace size. In some simulations where convergence is not being reached, increasing this value can drastically reduce the overall CPU time. The maximum number of FSI iterations limits the number of iterations used by the solver; the default value is 25 which should be more than enough for most simulations. If the FSI iteration count in the solver is repeatedly reaching the limit (as seen in the Simulation messages), this limit or the subspace size can be increased. The convergence tolerance specifies the maximum residual permitted in the solution of the solid dynamics equations. This value is dimensionless, independent of the mesh size and time step. The value represents a relative error in the computed strain. The default value is 10-6, which should work well for most simulations. However, if the goal of the simulation is to get a final-time stress result, rather than accurate time-dependent results, raising this value will not greatly harm the accuracy of the end result. For simulations where the displacements and stresses are needed to be highly accurate during the course of the simulation, lowering this value can help. Note that convergence generally becomes increasingly slow for values of the convergence tolerance smaller than 10-8 for reasons of machine precision round-off. The thermal stress evolution (TSE) model solves the equations of solid dynamics incrementally, so theoretically, large deformations can be predicted with reasonable accuracy. Although fluid motion due to displacements at the solid-fluid interface is predicted by the model, FLOW-3D volume and area fractions (FAVOR™ fractions) are not updated, so the geometry changes of the solidified fluid are not seen by the unsolidified fluid. Therefore, in simulations, where significant deformations are modeled, although the solid dynamics are accurately represented, its effects on the fluid are not. If gravity is used in the simulations, the solidified fluid region must be in contact with fluid mesh boundaries or other components so that it cannot move freely. If not constrained, the solid dynamics equations will predict rigid-body motion for the solid, and this motion will not be represented in the fluid. Free-floating solidified fluid regions can be modeled in the absence of gravity. Yielding materials cannot be accurately represented by the model. This is because the incremental stress model maintains a linear stress-strain relationship within each time step. Furthermore, the mesh is Lagrangian, which means that the mesh deforms along with the solid material. If the material were allowed to yield, then the mesh could become highly distorted and eventually lead to numerical failure. However, the existing Elasto-viscoplastic model in FLOW-3D is designed to simulate yielding materials. 



Postprocessing The finite-element results produced by the model can be viewed in a separate display. To access the TSE data, from the Analyze tab, select the FSI TSE sub-tab: 
 From this tab, select which of the components to view.  NOTE: THE SOLIDIFIED FLUID REGION IS ALWAYS LABELED AS COMPONENT 0: 

 Also selectable are the time limits, and the data source. Note that to view Selected data, selected data for fluid-structure interaction must have been chosen during set up of the simulation. Click Render and the Display tab appears, and from here various data variables can be plotted for the FSI component. Other controls to zoom, rotate, etc., are the same as the 3-D display. The default display is the normal displacement. This shows the surface displacement in the direction of the outward-pointing normal over the entire surface of the solidified fluid region, relative to its original conformation. Negative values indicate that the surface is pulled in and positive values indicate that the surface is pushed out relative to its original position. Individual displacements throughout the component in the Cartesian x, y and z directions can also be plotted. There are 6 components of elastic stress and 6 components of strain available for plotting. These are the 6 independent components that comprise the symmetric stress and strain tensors. These components are difficult to conceive for three-dimensional simulations, as even simple 1-D tension, diagonal to the coordinates, will produce non-zero values in many of the stress components. That is why the mean isotropic and the Von Mises stresses are provided. They are stress invariants, and as such, are independent of the Cartesian coordinates chosen. The mean isotropic stress indicates the amount of compressive (negative values) or tensile (positive values) stresses in the part, which could indicate areas most prone to buckling or cracking. In contrast, the Von Mises stress is a measure of shearing stresses; its value is always positive. Regions with high shearing stresses are more prone to tearing. Temperature is available for plotting as a convenience. This temperature will be the same as the wall temperature available from the fluid 3-D display. The volume expansion indicates regions of the solidified 



fluid region that have expanded (positive values) or shrunk (negative values) during the course of the simulation. Such expansion or contraction could be caused by temperature changes, or by tensile or compressive stresses. 
Flux Surfaces 

 A flux surface is a diagnostic feature in FLOW-3D for computing fluid flow rates and counting particles. It can be used together with sampling volumes to obtain time-dependent information about the flow in different parts of the domain. A typical flux surface is a 100% porous baffle with no flow losses so it does not affect the flow in any way. However, a real porous baffle with a porosity between 0.0 and 1.0 and non-zero flow loss and heat transfer coefficients can also be designated as a flux surface. In this case, the baffle will represent an actual porous screen and act as a flux surface at the same time. A baffle with the zero porosity cannot be a flux surface. To add a baffle, right click on Baffles in Meshing & Geometry and select Add. Simple shapes then can be defined using variables in Definitions and Limiters under the newly created baffle. Specify only one definition, and as many transformations and limiters as necessary: for example, to make a circular plate baffle, specify the definition as Z = 0, a limiter as Cylinder Outer Radius, and then rotate and translate the baffle to the desired location. Remember that specifying a radius as a definition or limiter applies the radius around the z-axis, not necessarily around the center of the baffle. To make the baffle a flux surface select Yes in the Meshing & Geometry > Baffles > Define as Flux Surface dropdown box. By default such a baffle will have the porosity of 1.0 and no flow losses. There is no limit on the number of such surfaces other than the maximum allowed number of baffles. For each such surface the flow rates for fluid #1, fluid #2 (if present) and the total for the two fluids are computed and stored in General history data catalogue of the flsgrf file at the history data edit time intervals. They are also automatically plotted as a function of time in the flsplt file created at the end of a simulation. Each flux surface #n can have a defined title, FPTITL(n), defined together with the baffle in namelist BF. The default name is "flux surface M", where M is the flux surface number as it appears in the prepin file (not the baffle number). Heat flow rates are still computed for sampling volumes as well (see Sampling Volumes), but these are not automatically plotted in flsplt unless Expanded or Maximum debug level is selected in Output.  NOTE: FLOW RATES ARE NO LONGER COMPUTED AT SAMPLING VOLUME BOUNDARIES. In addition, flux surfaces can count the number of particles crossing them. If the particle model is turned on, the user can define up to 10 particle groups to be counted at the flux surfaces. The total number of groups is defined using the NSPCS variable in namelist PARTS. RSP1(nn) and RSP2, also in the PARTS namelist, define the minimum and maximum size or density for each group (depending on the value of IPFLAG variable). These ranges need not be consecutive and may overlap each other, have gaps, and so on. Particles in each group will be counted separately at each flux surface.  



If only marker particles are present, then only one group can be defined for counting at flux surfaces, NSCPS=1, and includes all marker particles. The signs of the flow rate and particle count are positive when the flow or a particle crosses from the negative side of the baffle to the positive side, as defined by the sign of the function describing the baffle. For example, for a baffle defined at x = a (enter 4 in Meshing & Geometry > Baffles > Definitions > X coordinate) the positive side of the baffle is where x > a, so the positive direction for the flow rate and particle count coincides with the positive direction of the x-axis. NOTES: FLUX SURFACES ARE NOT ALLOWED IF NUMERICS > FLUID FLOW SOLVER OPTIONS > USE ZERO VELOCITY FIELD IS SELECTED. FLUX SURFACES SHOULD HAVE AT LEAST TWO MESH CELLS BETWEEN THEM FOR THE FLOW RATE AND PARTICLE COUNT RESULTS FOR EACH OF THE SURFACES TO BE ACCURATE. 
Sampling Volumes A sampling volume is a diagnostic feature in FLOW-3D for computing hydraulic forces and torques acting on walls, fluid volume and for counting particles within the sampling volume. A force window is a three-dimensional rectangular “shoe box” volume defined by setting the six min and max coordinates in each direction. If the computational domain is made up of several mesh blocks, then the default sampling volume boundaries follow the external boundaries of these mesh blocks.  In cylindrical coordinates, sampling volume boundaries follow the direction of the respective coordinate axes. For example, for a cylindrical mesh extending to 360 degrees in the azimuthal direction, the default sampling volume shape has the cylindrical shape of the computational domain. However, the force and moment output is converted to the Cartesian coordinate system.  Up to 100 sampling volumes can be defined. Sampling volumes do not affect the flow in any way. Sampling volumes are defined on the Meshing and Geometry tree.  To add a sampling volume, right-click on Sampling Volumes in the tree and select Add a sampling volume.  Once the sampling volume has been created, it can be named and its dimensions can be defined. 

 The following quantities are computed and stored in General history data catalogue of the flsgrf file at the history data edit time intervals.  



Hydraulic forces and moments relative to the origin of the coordinate system acting on all wall boundaries within the sampling volume, including solid surfaces that are located at the sampling volume edges. Total volume of fluid #1 within the sampling volume. Center of mass of fluid #1 within the sampling volume. Total amount of scalar species within the sampling volume. This is calculated as a volume integral, so if a scalar quantity represents mass concentration, then the total mass within the sampling volume is computed. For some species, like the residence time, an average value is computed instead. Number of particles within the sampling volume. If the particle model is turned on, the user can define up to 10 particle groups to be counted in the sampling volumes. The total number of groups is defined using the NSPCS variable in namelist PARTS. RSP1(nn) and RSP2, also in the PARTS namelist, define the minimum and maximum size or density for particle group nn (depending on the value of IPFLAG variable). These ranges need not be consecutive and may overlap each other, have gaps and so on. Particles in each group will be counted separately at each flux surface. If only marker particles are present, then only one particle group can be defined for counting in sampling volumes, NSCPS=1, and includes all marker particles. Heat flow rates at each of the six boundaries of a sampling volume. These include fluid convection, conduction in fluid and solid components and fluid/component heat transfer. The sign of each flux is determined by the coordinate direction, for example, heat flux in the positive x-direction is also positive. 
Free-Surface Flow 

 Flows with free surfaces are simulated using the one-fluid, sharp interface models. Select Global > One fluid and Free surface or sharp interface. The properties of the fluid are defined in Fluids with the properties of fluid #1. All open space in the mesh is assumed to be initially empty, unless otherwise specified by the user, e.g., by setting fluid Elevation or Volume in Initial.  Each void region is described with unique volume, pressure and temperature that can vary with time. The default void region Pressure and Temperature are initialized in Initial > Void initial state and stay constant during the calculation, unless one of the bubble models is employed (see Adiabatic Bubbles). NOTE: MESH BOUNDARY CONDITIONS FOR FLUID FRACTION IN BOUNDARIES AT VELOCITY AND PRESSURE BOUNDARIES DEFAULT TO 1.0, ALLOWING FLUID TO ENTER THE MESH DOMAIN IF OTHER CONDITIONS PERMIT. FLUID FRACTION AT FIXED-PRESSURE MESH BOUNDARIES SHOULD BE SET TO 0.0 TO MODEL AMBIENT GAS WITH NO FLUID ENTERING THE DOMAIN.  
General Moving Objects: Basics The general moving objects (GMO) model in FLOW-3D can simulate rigid body motion, which is either user-prescribed (prescribed motion) or dynamically coupled with fluid flow (coupled motion). If an object’s motion is prescribed, fluid flow is affected by the object’s motion, but the object’s motion is not affected by 



fluid flow. If an object has coupled motion, however, the object’s motion and fluid flow are coupled dynamically and affect each other. In both cases, a moving object can possess six degrees of freedom (DOF), or rotate about a fixed point or a fixed axis. The GMO model allows the location of the fixed point or axis to be arbitrary (it can be inside or outside the object and the computational domain), but the fixed axis must be parallel to one of the three coordinate axes of the space reference system. In one simulation, multiple moving objects with independent motion types can exist. Any object under coupled motion can undergo simultaneous collisions with other moving and non-moving objects and wall and symmetry mesh boundaries See General Moving Objects: Collision. The model also allows the existence of multiple elastic linear and torsion springs and ropes which are attached to moving objects and apply forces or torques to them. See General Moving Objects: Elastic Springs and Ropes.  In general, the motion of a rigid body can be described with six velocity components: three for translation and three for rotation. In the most general cases of coupled motion, all the available velocity components are coupled with fluid flow. However, the velocity components can also be partially prescribed and partially coupled in complex coupled-motion problems (e.g., a ship in a stream can have its pitch, roll and heave to be coupled but yaw, sway and surge prescribed). For coupled motion only, in addition to the hydraulic, gravitational and inertial forces and torques which are calculated by the code, additional control forces can be prescribed by the user. These can be defined either as up to three forces with their application points fixed on the object or as a net control force and torque. The net control force is applied to the GMO’s mass center, while the control torque is applied about the mass center for 6-DOF motion, and about the fixed point or fixed axis for those kinds of motions. The inertial force and torque exist only if the Non-inertial Reference Frame model is activated. In FLOW-3D, a GMO is classified as a geometry component. As with stationary components, a GMO can be composed of a number of geometry subcomponents. Each subcomponent can be defined either by quadratic functions and primitives, or by STL data, and can be solid, hole or complement. If STL files are used, since GMO geometry is re-generated at every time step in the computation, the user should strive to minimize the number of triangle facets used to define the GMO to achieve faster execution of the solver while maintaining the necessary level of the geometry resolution. For mass properties, different subcomponents of an object can possess different mass densities. In order to define the motion of a GMO and interpret the computational results correctly, the user needs to understand the body-fixed reference system (body system) which is always fixed on the object and experiences the same motion. In the FLOW-3D preprocessor, the body system (x', y', z') is automatically set up for each GMO. The initial directions of its coordinate axes (at t=0) are the same as those of the space system (x, y, z). The origin of the body system is fixed at the GMO's reference point which is a point automatically set on each moving object in accordance with the object’s motion type. The reference point is: 
� the object’s mass center for the coupled 6-DOF motion; 
� the fixed point for the fixed-point motion; 
� a point on the fixed axis for the fixed-axis rotation; 
� a user-defined point for prescribed 6-DOF motion. If not defined, it is set at the mass center or geometry center of the object depending on whether the object's mass properties are given. The GMO’s motion can be defined through the GUI using four steps: Step 1: activate the moving objects model; Step 2: create the GMO’s initial geometry; 



Step 3: specify the GMO’s motion-related parameters, and Step 4: define the GMO’s mass properties. Without the activation of the GMO model in step 1, the object created as a GMO will be treated as a non-moving object, even if steps 2 and 3 are accomplished. Step 1: Activate the GMO Model To activate the GMO model, go to Model Setup > Physics > Moving and simple deforming objects and check the Activate general moving objects (GMO) model box. 

 The GMO model has two numerical methods to treat the interaction between fluid and moving objects: an explicit and an implicit method. If no coupled motion exists, the two methods are identical. The explicit method, in general, works only for heavy GMO problem, i.e., all moving objects under coupled motion have larger mass densities than that of fluid and their added mass is relatively small. The implicit method, however, works for both heavy and light GMO problems. A light GMO problem means at least one of the moving objects under coupled motion has smaller mass densities than that of fluid or their added mass is large. The user may change the selection on the Moving and deforming objects panel or on the Numerics tab > Moving object/fluid coupling. Step 2: Create the GMO’s Initial Geometry In the Meshing & Geometry tab, create the desired geometry for the GMO components using either primitives and/or imported STL files in the same way as is done for any stationary component. Note that the Copy function cannot be used with geometry components representing GMOs. Step 3: Specify the GMO’s Motion Related Parameters The following section discusses how to set up parameters for prescribed and coupled 6-DOF motions, fixed-point motions and fixed-axis motions. The user can go directly to the appropriate part. 



Prescribed 6-DOF Motion  In Meshing & Geometry > Geometry > Component (the desired GMO component) > Component Properties > Type of Moving Object, select Prescribed motion. Go to Type of Moving Object > Moving Object Properties > Edit > Motion Constraints. Under Type of Constraint, select 6 Degrees of Freedom in the combo box. 

 

 To define the object’s velocity, go to the Initial/Prescribed Velocities tab in the Moving object setup window. The prescribed 6-DOF motion is described as a superimposition of a translation of a reference point and a rotation about the reference point. The reference point can be anywhere inside or outside the moving object and the computational domain. The user needs to enter its initial x, y and z coordinates (at t=0) in the provided edit boxes. By default, the reference point is determined by the preprocessor in two different ways depending on whether the object’s mass properties are given: if mass properties (either mass density or integrated mass properties) are given, then the mass center of the moving object is used as the reference point; otherwise, the object’s geometric center will be calculated and used as the reference point. With the 



reference point provided (or left for the code to calculate), users can define the translational velocity components for the reference point in space system and the angular velocity components (in radian/time) in body system. Each velocity component can be defined either as a sinusoidal or a piecewise linear function of time by making a selection in the corresponding combo box. For a constant velocity component, choose Non-Sinusoidal and simply enter its value in the corresponding input box (the default value is 0.0). If a velocity component is Non-sinusoidal and time-dependent, click on the corresponding Tabular button to open a data table and enter values for the velocity component and time. As an option, instead of filling the data table line by line, the user can also import a data file for velocity component versus time. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and velocity from left to right and must have a csv extension. If the velocity component is sinusoidal in time, then enter the values for Amplitude, Frequency (in Hz) and Initial Phase (in degrees) in the input boxes. The expression for the sinusoidal velocity component is 0sin(2 )v A ftπ ϕ= + , where A is the amplitude, f is the frequency, and φ0 is the initial phase. 

 



 Users can also set limits for the translational displacements of the object’s reference point in both negative and positive x, y and z directions in space system. The displacements are measured from the initial location of the reference point. During motion, the reference point cannot go beyond these limits but can move back to the allowed range after it reaches a limit. The limits for rotation, however, cannot be set. To set the limits for translation, go to the Motion Constraints tab and enter the maximum displacements allowed in the corresponding input boxes, using absolute values. By default, these values are very large. Prescribed Fixed-point Motion In Meshing & Geometry > Geometry > Component (the desired GMO component) > Component Properties > Type of Moving Object, select Prescribed motion. Go to Moving object properties > Edit > Motion Constraints. Under Type of Constraint, select Fixed point rotation in the combo box and enter the x, y and z coordinates of the fixed point in the corresponding input boxes.  To define the velocity of the object, go to the Initial/Prescribed Velocities tab in the Moving object setup window. The velocity components to be defined are the x, y and z components of the angular velocity (in radian/time) in the body system. Each velocity component can be defined as either a sinusoidal or a piecewise linear function of time by making a selection in the corresponding combo box. For a constant velocity component, choose Non-Sinusoidal and simply enter its value in its input box (the default value is 0.0). If a velocity component is time-variant and Non-sinusoidal, click on the Tabular button to open a data table and enter the values for the velocity component and time. Alternatively, the user can also import a data file for the velocity component versus time. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and velocity component from left to right and must have a csv extension. If the velocity component is sinusoidal in time, then enter the values for Amplitude, Frequency (in cycles/time) and Initial Phase (in degrees) in the corresponding input boxes. The expression for a sinusoidal angular velocity component is 0sin(2 )A ftω π ϕ= + , where A is the amplitude, f is the frequency, and φ0 is the initial phase. Prescribed Fixed-Axis Motion In Meshing & Geometry > Geometry > Component (the desired GMO component) > Component Properties > Type of Moving Object, select Prescribed motion. Go to Moving Object Properties > Edit > Motion Constraints. Under Type of Constraint, select Fixed X-Axis Rotation or Fixed Y-Axis Rotation or Fixed Z-Axis Rotation in the combo box depending on which coordinate axis the rotational axis is parallel to.  



Coordinates of the rotational axis need be given in two of the three input boxes for Fixed Axis/Point X Coordinate, Fixed Axis/Point Y Coordinate and Fixed Axis/Point Z Coordinate. For example, if the rotational axis is parallel to the z-axis, then the x and y coordinates for the rotational axis must be defined. Users can also set limits for the object's rotational angle in both positive and negative directions. The rotational angle (i.e., angular displacement) is a vector and measured from the object’s initial orientation based on the right-hand rule. Its value is positive if it points in the positive direction of the coordinate axis which the rotational axis is parallel to. The object cannot rotate beyond these limits but can rotate back to the allowed angular range after it reaches a limit. To set the limits for rotation, in Motion Constraints > Limits for rotation, enter the Maximum rotational angle allowed in negative and positive directions in the corresponding input boxes, using absolute values in degrees. By default, these values are infinite. 

 To define the angular velocity of an object (in radian/time), go to Initial/Prescribed Velocities. The angular velocity can be defined either as a sinusoidal or a piecewise linear function of time by making a selection in the corresponding combo box. For a constant angular velocity, choose Non-Sinusoidal and simply enter its value in its input box (the default value is 0.0). If it is Non-sinusoidal in time, click on the corresponding Tabular button to open a data table and enter the values for the angular velocity and time. Alternatively, the user can also import a data file for the angular velocity versus time by clicking Tabular > Import Values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and angular velocity from left to right and must have a csv extension. If the angular velocity is sinusoidal in time, then enter the values for Amplitude, Frequency (in cycles/time) and Initial Phase (in degrees) in the corresponding input boxes. The expression for a sinusoidal angular velocity is 
0sin(2 )A ftω π ϕ= + , where A is the amplitude, f is the frequency, and φ0 is the initial phase. 



Coupled 6-DOF motion In Meshing & Geometry > Geometry > Component (the desired GMO component) > Component Properties > Type of Moving Object, select Coupled motion. Go to Moving Object Properties > Edit > Motion Constraints. Under Type of Constraint, select 6 Degrees of Freedom in the combo box. Users need to define the initial velocities for the object. Go to the Initial/Prescribed Velocities tab. Enter the x, y, and z components of the initial velocity of the GMO’s mass center in X Initial Velocity, Y Initial Velocity and Z Initial Velocity, respectively. Enter the x’, y’ and z’ components of the initial angular velocity (in radian/time) in the body system in the boxes for X Initial Angular Velocity, Y Initial Angular Velocity and Z Initial Angular Velocity, respectively. By default, the initial velocity components are zero. For coupled 6-DOF motion, user-prescribed control force(s) and torque exerting on the object can be defined either in the space system or the body system. They are combined with the hydraulic, gravitational, inertial and spring forces and torques to determine the object’s motion. There are two different ways to define control force(s) and torque: users can prescribe either a total force and a total torque about the object’s mass center or multiple forces with their application points fixed on the object. By default, all the control force(s) and torque are equal to zero. To prescribe total force and total torque, in the Control Forces and Torques tab, choose Define Total Force and Total Torque in the combo box. Further select In Space System or In Body System depending on which reference system the control force and torque are define in. If a component of force or torque is a constant, it can be specified in the corresponding edit box (default is zero). If it varies with time, then click on the Tabular button to bring up a data input table and enter the values for the component and time. The time-variant force and torque are treated as piecewise-linear functions of time during simulation. Alternatively, instead of filling the data table line by line, the user can also import a data file for the force/torque component versus time by clicking Tabular > Import Values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and the force/torque component from left to right and must have a csv extension. 

 If, instead, control forces and their application points need to be defined, then in the Control Forces and Torques tab choose Multiple Forces and Application Points in the combo box. Users can specify up to five forces. For each force, in the editor boxes, choose the force index (1 to 5) and then select Force Components in Space System or Body System depending on which reference system the force is defined in. In field on the left, enter the initial coordinates (at t=0) for the force's application point. In the field on the right, prescribe components of the force in x, y and z directions of the body or space system. For a constant force component, enter its value in the corresponding edit box. If it varies with time, then click on the Tabular 



button to bring up a data input table and enter values for the force component versus time. Tabular force input is approximated with a piecewise-linear function of time. Alternatively, the user can import a data file for the force versus time by clicking Tabular > Import Values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and from left to right and must have a csv extension. 

 Motion constraints can be imposed to the object to decrease the number of the degrees of freedom to less than six. This selection is made by setting part of its translational and rotational velocity components as Prescribed motion while leaving the other components to coupled motion in Motion Constraints tab > Translational and Rotational Options. Note that the translational and rotational components are in the space system and the body system, respectively. Then go to the Initial/Prescribed Velocities tab to define their values. A prescribed velocity component can be defined as either a Sinusoidal or piecewise linear function of time in the combo box. For a constant velocity component, choose Non-Sinusoidal and enter its value in its input box (the default value is 0.0). If the velocity component is time-dependent and non-sinusoidal, click on the Tabular button to open a data table and enter the values for the velocity component and time. Alternatively, the user can import a data file for the velocity component versus time by clicking Tabular > Import values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and the angular velocity component from left to right and must have a cvs extension. It is treated as a piecewise-linear function of time. If it is a sinusoidal function of time, instead, enter its Amplitude, Frequency (in Hz) and Initial Phase (in degrees) in the edit boxes. The expression for a sinusoidal velocity component is 0sin(2 )v A ftπ ϕ= + , where A is the amplitude, f is the frequency, and φ0 is the initial phase. Users can also set limits for displacements of the object’s mass center in both negative and positive x, y and z directions in the space system, measured from its initial location. The mass center cannot go beyond these limits but can move back to the allowed motion range after it reaches a limit. To specify these limits, open the Motion Constraints tab and in the Limits for translation area enter the absolute values of maximum displacements in the desired coordinate directions. There are no Limits for rotation for an object with 6-DOF coupled motion. Coupled Fixed-Point Motion In Meshing & Geometry > Geometry > Component (the desired GMO component) > Component Properties > Type of Moving Object, select Coupled motion. Go to Moving Object Properties > Edit > Motion Constraints. 



Under Type of Constraint, select Fixed point rotation in the combo box and enter the x, y and z coordinates of the fixed point in the corresponding input boxes. The Limits for rotation and Limits for translation cannot be set for fixed-point motion. Definition of the initial velocity for the object is required. Go to the Initial/Prescribed Velocities tab and enter the x, y and z components of initial angular velocity (in rad/time) in the boxes for X Initial Angular velocity, Y Initial Angular velocity and Z Initial Angular velocity. Default values for the initial velocity components are zero. Further constraints of motion can be imposed to the object to decrease its number of degrees of freedom. This is done in the Motion Constraints tab by setting part of its rotational components as prescribed motion while leaving the others as coupled motion in the combo box for Translational and rotational options. Note that the rotational components are in the body system. By default, the prescribed velocity components are equal to zero. To specify a non-zero velocity component, go to the Initial/Prescribed Velocities tab. It can be defined as either a sinusoidal or a piecewise linear function of time by making selection in the corresponding combo box. For a constant velocity component, choose Non-Sinusoidal and simply enter its value in the input box (the default value is 0.0). If it is non-sinusoidal time-dependent, click on the Tabular button to open a data table and enter the values for the velocity component and time. Alternatively, the user can import a data file for the velocity component versus time by clicking Tabular > Import values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and the angular velocity component from left to right and must have a cvs extension. If the velocity component is a sinusoidal function of time, enter the values for Amplitude, Frequency (in Hz) and Initial Phase (in degrees) in the input boxes. The expression for a sinusoidal velocity component v is 
0sin(2 )A ftω π ϕ= +  where A is the amplitude, f is the frequency, and φ0 is the initial phase. User-prescribed total torque exerting on the object can also be defined. They are combined with the hydraulic, gravitational, inertial and spring torques to determine the object’s rotation.  In the Control Forces and Torques tab, choose Define Total Force and Total Torque in the combo box. Further, select In Space System or In Body System depending on which reference system the control torque is define in. If the torque is constant, it can be simply set in the provided edit box for its x, y and z components. For a time-dependent control torque, click the Tabular button to bring up data tables and then enter the values of time and the torque components. The control torque is treated as a piecewise-linear function of time. As an option, instead of filling the data table line by line, the user can also import a data file for the angular velocity versus time by clicking Tabular > Import Values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and velocity from left to right and must have a csv extension. Coupled Fixed-Axis Motion In Meshing & Geometry > Geometry > Component (the desired GMO component) > Component Properties > Type of Moving Object, select Coupled motion. Go to Moving Object Properties > Edit > Motion Constraints. Under Type of Constraint, select Fixed X-Axis Rotation or Fixed Y-Axis Rotation or Fixed Z-Axis Rotation in the combo box depending on which coordinate axis the rotational axis is parallel to. Coordinates of the rotational axis need be given in two of the three input boxes for Fixed Axis/Point X Coordinate, Fixed Axis/Point Y Coordinate and Fixed Axis/Point Z Coordinate. For example, if the rotational axis is parallel to the z-axis, then the x and y coordinates for the rotational axis must be defined. Users can also set limits for the object's rotational angle in both positive and negative directions. The rotational angle 



(i.e., angular displacement) is a vector and measured from the object’s initial orientation based on the right-hand rule. Its value is positive if it points to the positive direction of the coordinate axis which the rotational axis is parallel to. The object cannot rotate beyond these limits but can rotate back to the allowed angular range after it reaches a limit. To set the limits for rotation, in Motion Constraints > Limits for rotation, enter the maximum rotational allowed in negative and positive directions in the corresponding input boxes, using absolute values in degrees. By default, these values are infinite. A definition of the initial angular velocity for the object is required. In the Initial/Prescribed Velocities tab, enter the initial angular velocity (in radians per time) in x, y or z direction in the corresponding input box in the Angular velocity components area, depending on the orientation of the rotational axis. The default value is zero. User-prescribed total torque exerting on the object can be defined. They are combined with the hydraulic, gravitational, inertial and spring torques to determine the object’s rotation.  In the Control Forces and Torques tab, choose Define Total Force and Total Torque in the combo box. If the torque is constant, it can be simply set in the provided edit box for x, y or z component of the torque, depending on direction of the coordinate axis which the rotational axis is parallel to. For a time-dependent control torque, click the corresponding Tabular button to bring up a data table and then enter the values of time and the torque. The control torque is treated as a piecewise-linear function of time in computation. As an option, instead of filling the data table line by line, the user can also import a data file for the torque versus time by clicking Tabular > Import Values. If the file is in the simulation directory, check Import from simulation directory. The file must have two columns of data which represent time and torque from left to right and must have a csv extension. The torque about the fixed axis is the same in the space and body systems, thus the choice of In space system or In body system options make no difference to the computation. User-prescribed total control force is not allowed for the fixed-axis cases. 

 Step 4: Specify the GMO’s Mass Properties Definition of the mass properties is required of any moving object with coupled motion. It is optional for objects with prescribed motion. If the mass properties are provided for a prescribed-motion object, the solver will calculate and output the residual control force and torque, which complement the gravitational, hydraulic, spring, inertial and user-prescribed control forces and torques to maintain the prescribed motion. To specify the mass properties, click on Mass Properties to open the dialog window. Two options are available for the mass properties definition: provide Mass density or the Integrated mass properties including the total mass, mass center and the moment of inertia tensor. 



 The option to provide mass density is convenient if the object has a uniform density or all its subcomponents have uniform densities. In this case, the preprocessor will calculate the integrated mass properties for the object. In the Mass Properties tab, select Define Density in the combo box and enter the density value in the Uniform Density input box. By default, each subcomponent of the object takes this value as its own mass density. If a subcomponent has a different density, define it under that subcomponent in the geometry tree, Geometry > Component > Subcomponents > Subcomponent (the desired component) > Mass Density. The option to provide integrated mass properties is useful if the object’s mass, mass center and moment of inertia tensor are known parameters regardless of whether the object’s density is uniform or not. In the Mass Properties tab, choose Define Integrated Mass Properties in the combo box and enter the following parameters in the input boxes depending on the type of motion: 
� Total Mass, Initial Mass Center location (at t=0) and Moment of inertia tensor about mass center for 6-DOF and fixed-point motion types; 
� Total Mass, Initial Mass Center location (at t=0) and Moment of inertia about fixed axis for fixed-axis motion type. Output: For each GMO component, the solver outputs time variations of several solution variables that characterize the object’s motion. These variables can be accessed during post-processing in the General History data catalogue and can be viewed either graphically or in a text format in Analyze > Probe. For both prescribed and coupled types of motion with the mass properties provided, the user can find the following variables: 
� Mass center coordinates in space system 
� Mass center velocity in space system 
� Angular velocity in body system 
� Hydraulic force in space system 
� Hydraulic torque in body system 
� Combined kinetic energy of translation and rotation There will be no output for items 1, 2 and 6 for any prescribed-motion GMO if the mass properties are not provided. Additional output of history data include: 



� Location and velocity of the reference point for a prescribed 6-DOF motion. 
� Rotational angle for a fixed-axis motion  
� Residual control force and torque in both space and body systems for any prescribed motion and a coupled motion with constraints (fixed axis, fixed point and prescribed velocity components) As an option, the history data can also include the buoyancy center and the metacentric heights for rotations about x and y axes of the space system, which is useful for stability analysis of a floating object. Go to Geometry > Component (the desired moving object) > Output > Buoyancy Center and Metacentric Height, and select Yes. The buoyancy center is defined as the mass center of the fluid displaced by the object. The metacentric height (GM) is the distance from the gravitational center (point G) to the metacenter (point M). It is positive (negative) if point G is below (above) M.  GMO components can participate in heat transfer just like any stationary solid component. When defining specific heat of a GMO component, Component Properties > Solid Properties > Density*Specific Heat must be given. Two options are available when defining heat sources for a GMO component: use the specific heat flux, or the total power. When the total power is used, the heat fluxes along the open surface of the moving object are adjusted at every time step to maintain a constant total power. If the surface area varies significantly with time, so will the heat fluxes. When the specific heat is used instead, then the fluxes will be constant, but the total power may vary as the surface area changes during the object’s motion. To define heat source for a GMO component, go to Component Properties > Solid Properties > Heat Source type > Total amount or Specific amount. Mass sources/sinks can also be defined on the open surfaces of a GMO component. Details can be found in the mass source model section. The GMO model can be used with most physical models and numerical options, but limitations do exist: 
� For coupled motion, the explicit and implicit GMO methods perform differently. The implicit GMO method works for both heavy and light moving objects. The explicit GMO method, however, only works for heavy object problems (i.e., the density of moving object is higher than the fluid density). 
� When the explicit GMO method is used, solution for fully coupled moving objects may become unstable if the added mass of the fluid surrounding the object exceeds the object’s mass. Activating the implicit GMO model or adding limited compressibility for fluid (automatic or manual) can help to prevent such instabilities. 
� If there are no GMO components with coupled motion, then the implicit and explicit methods are identical and the choice of one makes no difference to the computational results. 
� The implicit method does not necessarily take more CPU time than the explicit method, even though the former required more computational work, because it improves numerical stability and convergence, and allows for larger time step. It is thus recommended for all GMO problems. 
� It is recommended that the limited compressibility be specified for fluid property to improve numerical stability by reducing pressure fluctuations in the fluid. 
� In the simulation result, fluctuations of hydraulic force may exist due to numerical reasons. To reduce these fluctuations, the user can set No f-packing for free-surface problems in Numerics > Volume of fluid advection > Advanced options and set FAVOR™ tolerance to 0.0001 in Numerics > Stability factors > Stability enhancement. It is noted that an unnecessarily small FAVOR™ tolerance factor can cause small time steps and slow down the computation. 



� In order to calculate the fluid force on a moving object accurately, the computational mesh needs to be reasonably fine in every part of the domain where the moving object is expected to be in contact with fluid. 
� An object can move completely outside the computational domain during a computation. When this happens, the hydraulic forces and torques vanish, but the object still moves under actions of gravitational, spring, inertial and control forces and torques. For example, an object experiences free fall outside the domain under the gravitational force in the absence of all other forces and torques.  
� If mass density is given, then the moving object must initially be placed completely within the computational domain and the mesh around it should be reasonably fine so that its integrated mass properties (the total mass, mass center and moment of inertia tensor) can be calculated accurately. 
� If a moving object is composed of multiple subcomponents, they should have overlap in places of contact so that no unphysical gaps are created during motion when the original geometry is converted to area and volume fractions. If different subcomponents are given with different mass densities, this overlap should be small to avoid big errors in mass property calculation. 
� A moving object cannot have porosity. 
� A moving object cannot be of a phantom component type like lost foam or a deforming object. 
� The GMO model works with the electric field model the same way as the stationary objects, but no additional forces associated with electrical field are computed for moving objects. 
� A Courant-type stability criterion is used to calculate the maximum allowed time-step size for GMO components. The stability limit ensures that the object does not move more than one computational cell in a single time step for accuracy and stability of the solution. Thus the time step is also limited by the speed of the moving objects during computation. Time-Saving Tip: For prescribed motion, users can preview the object motion in a so-called “dry run” prior to the full flow simulation. To do so, simply remove all fluid from the computational domain to allow for faster execution. Upon the completion of the simulation the motion of the GMO objects can be previewed by post-processing the results. 
General Moving Objects: Collision The GMO model allows users to have multiple moving objects in one problem, and each of them can possess any independent type of coupled or prescribed motion. At any moment of time, each object under coupled motion can collide with any other moving objects (of a coupled- or prescribed-motion type), non-moving objects as well as wall- and symmetry-type mesh boundaries. Without the collision model, objects may penetrate and overlap each other. 



  The GMO collision model is activated by selecting Physics > Moving and simple deforming objects > Activate collision model. It requires the activation of the GMO model first, done in the same panel. For a GMO problem with only prescribed-motion objects, the collision model has no effect on the computation. The model allows each individual collision to be fully elastic, completely plastic, or partially elastic, depending on the value of Stronge’s energetic restitution coefficient, which is an input parameter. In general, a collision experiences two phases: compression and restitution, which are associated with loss and recovery of kinetic energy. The Stronge’s restitution coefficient is a measure of kinetic energy recovery in the restitution phase. It depends on the material, surface geometry and impact velocity of the colliding objects. The range of its values is from zero to one. The value of one corresponds to a fully elastic collision, i.e., all kinetic energy lost in the compression is recovered in the restitution (if the collision is frictionless). Conversely, a zero restitution coefficient means a fully plastic collision, that is, there is no restitution phase after compression thus recovery of the kinetic energy cannot occur. A rough estimate of the restitution coefficient can be conducted through a simple experiment. Drop a sphere from height h0 onto a level anvil made of the same material and measure the rebound height h. The restitution coefficient can be obtained as 0h h . In this model, the restitution coefficient is an object-specific constant. A global value of the restitution coefficient that applies to all moving and non-moving objects and wall boundaries of the computational mesh is set in Physics > Moving and simple deforming objects > Coefficient of restitution. Friction can be included at the contact point of each pair of colliding bodies by defining the Coulomb’s friction coefficient. A global value of the friction coefficient that applies to all collisions is set in Physics >General moving objects > Coefficient of friction. Friction forces apply when the friction coefficient is positive; a collision is frictionless for the zero value of the friction coefficient, which is the default. The existence of friction in a collision always causes a loss of kinetic energy. The global values of the restitution and friction coefficients are used in the collisions at the wall-type mesh boundaries, while collisions of the moving objects with the symmetry mesh boundaries are always fully elastic and frictionless. 



The object-specific values for the restitution and friction coefficients are defined in the tab Model Setup > Meshing & Geometry. In the geometry tree on the left, click on Geometry > Component (the desired component) > Component Properties > Collision Properties and then enter their values in the corresponding data boxes. If an impact occurs between two objects with different values of restitution coefficients, the smaller value is used in that collision calculation. The same is true for the friction coefficient. Sliding, rolling and resting of an object on top of another object are simulated through a series of small-amplitude collisions, called micro-collisions. Micro-collisions are calculated in the same way as the ordinary collisions thus no additional parameters are needed. The amplitude of the micro-collisions is usually so small that the motion is hardly seen on the plots. However, an obvious overlap between the two objects may develop over time after repeated micro-collisions if the micro-collisions are inelastic (i.e., the restitution coefficient is less than one) and/or frictional (i.e., the friction coefficient is larger than zero). It may eventually lead to one object “sinking” into the other due to a loss of mechanical energy. To make the micro-collision model work for long intervals of time, make sure the micro-collisions are completely elastic and frictionless. If the collision model is activated but the user needs two specific objects to have no collision throughout the computation, he can open the text editor (File > Edit Simulation) and set ICLIDOB(m,n)=0 in namelist OBS, where m and n are the corresponding component indexes. An example of such a case is when an object (component index m) rotates about a pivot − another object (component index n). If the former has a fixed-axis motion type, then calculating the collisions with the pivot is not necessary. Moreover, ignoring these collisions makes the computation more accurate and more efficient. If no collisions between a GMO component m with all other objects and mesh boundaries are desired, then set ICLIDOB(m,m) to be zero. The collision model works with and without existence of fluid in the computational domain. It is required, however, that the contact point for a collision is within the computational domain, whereas the colliding bodies can be partially outside the domain at the moment of the collision. If two objects are completely outside the domain, their collision is not detected although their motions are still tracked. Collisions are not calculated between baffles and moving objects; these objects can overlap when they contact. 
General Moving Objects: Elastic Springs & Ropes The GMO model allows existence of elastic springs (linear and torsion springs) and ropes which exert forces or torques on objects under coupled motion. Users can define up to 100 springs and ropes in one simulation, and each moving object can be connected to multiple springs and ropes. For a linear spring, the restoring force F is along the length of the spring and satisfies Hooke's law of elasticity, 

l
F k l= ∆ , where kl is the spring coefficient, and ∆l is the spring's length change from its free condition. F is a pressure force when the spring is compressed, and a tension force when stretched.  An elastic rope also obeys Hooke's law. It generates tension force only if stretched, but when compressed it is relaxed and the restoring force vanishes as would be the case of a slack rope. A torsion spring produces a restoring torque T when it is twisted, following the angular form of Hooke's law,  
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where kθ is the spring coefficient in the unit of [torque]/degree, and ∆θ is the angular deformation of the spring. It is assumed that there is no elastic limit for the springs and ropes, namely Hooke's law always holds no matter how big the deformation is. In this model, a linear spring or rope can have one end attached to a moving object and the other end fixed in space or attached to another moving object. Each moving object can move with 6-DOF or have a fixed-axis or a fixed point, but at least one of the objects must be in coupled motion. A torsion spring, however, must have one end attached to an object under coupled fixed-axis motion and the other end fixed in space. It is assumed that the rotation axis of the object and the axis of the torsion spring are the same. As a result, the torque applied by the spring on the object is around the object's rotation axis, and the deformation angle of the spring is equal to the angular displacement of the object from where the spring is in free condition.  A linear spring has a block length due to the thickness of the spring coil. It is the length of the spring at which the spring's compression motion is blocked by its coil and cannot be compressed any further. This model allows for three types of linear springs:  
� Compression and extension spring: a spring that can be both compressed and extended. Its block length, by default, is 10% of its free length (the length of the spring in the force-free condition). 
� Extension spring: a spring that can only be extended. Its block length is always equal to its free length. 
� Compression spring: a spring that applies force only when it is compressed. When it is stretched, the force on the connected object vanishes. Its default block length is 10% of its free length. To define a spring or rope, go to Model Setup > Meshing Geometry. Right click on Springs and Ropes in the input tree and select Add spring/rope. Click + next to the newly added Spring and Rope to expand the branch. In the combo box for Type, select the type for the spring or rope. 
� Linear spring and rope: Click to open the branches for End 1 and End 2 which represent the initial coordinates of the ends of the spring/rope. In each branch, go to Component # and select the index of the moving object which the spring end is connected to. If the end is not connected to any moving component, i.e., is fixed in space, select None. In the X, Y and Z edit boxes, enter the initial coordinates of the spring’s end. Each end can be placed anywhere inside or outside the moving object and the computational domain. Enter Free Length (the length of the spring/rope in the force-free condition), Block Length and Spring Coefficient. Note that the Block Length is deactivated for rope and extension spring because the former has no block length while the latter always has its block length equal to its free length. By default, the free length is set equal to the initial distance between the two ends. 
� Torsion spring: End 1 represents the spring's end that is attached to a moving object, and End 2 the end fixed in space. Click to open the branch for End 1. In the combo box for Component #, select the index of the moving object which End 1 is attached to. Then enter Spring Coefficient (in unit of [torque]/degree). Finally enter the Initial Torque in the input box. The initial torque is the torque of the spring applied on the moving object at t = 0. It is positive if it is in the positive direction of the coordinate axis which the rotation axis of the moving object is parallel to. 



 After the simulation is complete, users can display the calculated deformation and force (or torque) of each spring and rope as functions of time. Go to Analyze > Probe > Data source and check General history. In the variable list under Data variables, find the Spring/rope index followed by “spring/rope length extension from free state,” “spring/rope force” and/or “spring torque.” Then check Output form > Text or Graphical and click Render to display the data. Positive/negative values of spring force and length extension mean the linear spring or rope is stretched/compressed relative to its free state and the restoring force is a tension/pressure force. Positive/negative values of the torque of a torsion spring means its deformation angle (a vector) measured from its free state is in the negative/positive direction of the coordinate axis which its axis is parallel to. 
Granular Flow 

 Granular flow is a mixture of solid particles and a gas (e.g., sand and air). The granular flow model assumes the volume fraction of solid material is 50% or greater. This mixture of solid and gas is treated as an 



incompressible fluid that may be bounded by free surfaces. Density variations in the mixture fluid can exist initially and may arise during a flow because of a relative velocity of the solid and gas that is computed using the Drift-Flux model. Gas escape from a free surface may occur as solid compacts forcing the gas out from between the grains. To activate this model select Global > One fluid option and Physics > Granular Flow > Activate granular flow model. A granular flow menu appears in which it is necessary to define the diameter and microscopic density of the grains and the density and viscosity of the gas. If necessary, the maximum close packing volume fraction of the solid and the volume fraction of mechanical jamming can be changed from their default values of 0.63 and 0.61, respectively. Also, an angle of repose for free surfaces can be entered if the default value of 34° is not correct for the solid material to be modeled. When the granular flow option is selected this automatically activates several other models in the program that are used in the model. Also, it should be remarked that it is unnecessary to define a mixture viscosity because this is automatically computed as part of the model. In fact, it is not necessary to define any of the fluid properties in the Fluids tab. If a granular material is to enter a computational region through a mesh boundary, it is important to define the density of the solid/gas mixture, which should have a solid fraction less than that for close packing, otherwise, it would not flow. Two auxiliary input variables are available. One is a multiplier for the threshold velocity cvelgran and the other a multiplier for packing drag drggrn. The threshold velocity is the speed above which flow will set into motion packed solid material. The packing drag is used to bring a flow to zero when the grains pack to a sufficiently high density. Both of these variables should be left at their default values unless the user knows that the granular material has cohesive or other forces that could change these quantities. 
Gravity Gravity vector components in a Cartesian coordinate system can be simply set in Physics > Gravity. The direction of the gravity vector is constant during a simulation. 

 If a cylindrical coordinate system is employed, then the z-direction component can still be used for a constant gravity vector completely aligned with the z-axis. However, non-zero x and y gravity components are aligned with radial and azimuthal coordinate directions at every point in the mesh, therefore, making little physical sense. The Physics > Non-inertial RF model must be used for a gravity vector not aligned with the z-axis in a cylindrical coordinate system. The Non-inertial reference frame model must be activated, together with 



Harmonic oscillation to enable the input of the Gravity field components. In that case, all entries in Physics > Gravity must be zero. 
Heat Sources Heat sources can be modeled when Physics > Heat transfer > Fluid to solid heat transfer is activated. Uniform heat sources in both fluid #1 and #2 can be set in Fluids > Properties > Thermal Properties > Power source per unit mass. When defined, each of those variables represents a constant heat source uniformly distributed in the fluid. The units are energy per unit mass of the corresponding fluid. 

 The uniform heat sources are ignored when Numerics > Use zero velocity field option is activated. Time-dependent and localized heat sources can be associated with components. In that case, set POBS(N,M) to be equal to the total power (energy per unit time) generated at component M in namelist OBS. The first index N, together with the TOBS(N) variable, can be used to set tabular input for time-dependent component power. Power at a heat source can be positive or negative. The component energy source can be either deposited evenly inside the geometry component or distributed as a flux over its surface. The choice is governed by the value of the component’s Density*Specific Heat defined in Meshing & Geometry > Geometry > Component > Solid Properties. If the specific heat is positive, then the source energy will be deposited inside the component leading to a change in its temperature. When the component specific heat is set to zero, then the energy is distributed evenly along the component’s open surface, and is deposited directly into the fluid that is in contact with the component. In that case, no thermal solution is obtained for the component itself. 



 Component power sources can be used to define a spatially variable (piece-wise constant) heat sources in fluids. For that purpose, use porous components with 100% porosity set Specific Surface Area equal to a positive number. In that case fluid and heat flows are not obstructed by the component, but energy is deposited into the fluid at every point of the porous component location. GMO components can participate in heat transfer just like any stationary solid component. When defining specific heat of a GMO component, the Density*Specific Heat product must be used and not the total heat capacity because the volume of a GMO component may change as it moves through the grid and even in and out of it. Two options are available when defining heat sources for a GMO component: use the specific heat flux, SPOBS(t,n) or the total power POBS(t,n). The latter is defined under Heat Source in the component’s Solid Properties branch; the former must be defined directly in the prepin file. When the total power is used, the heat fluxes along the open surface of the moving object are adjusted at every time step to maintain a constant total power. If the surface area varies significantly with time, so will the heat fluxes. When SPOBS is used instead, then the fluxes will be constant (equal to SPOBS), but the total power may vary. If both POBS and SPOBS are defined, the former is ignored. Heat sources can also be defined at mesh boundaries of type Wall, similar to component heat sources. It can be defined in Boundaries > Thermal information > Power. NOTE: SINCE POBS DENOTES THE TOTAL POWER SOURCE OF A COMPONENT, CARE MUST BE TAKEN WHEN USING HEAT SOURCES IN 2-D SIMULATIONS. FOR EXAMPLE, IN AN AXISYMMETRIC PROBLEM WITH THE  -DIRECTION GRID COVERING 30 DEGREES, POBS HAS TO BE REDUCED BY A FACTOR OF 1/12 TO ACCOUNT FOR THE FACT THAT ONLY THAT FRACTION OF THE TOTAL COMPONENT VOLUME (COVERING 360 DEGREES) IS INCLUDED IN THE GRID. 
Heat Transfer across Baffles 

 Baffles can have thermal resistance for fluid-to-fluid and fluid-to-void heat exchange, although baffles themselves do not posses any heat capacity. The default setting is no heat transfer through baffles. 



Cross-baffle heat transfer is enabled when Physics > Heat Transfer > Fluid to solid heat transfer is activated. The heat transfer coefficients are defined in Meshing & Geometry > Baffles > Heat Transfer Properties for each baffle. For example, if a baffle has fluid #1 on one side and fluid #2 on the other side, then the resulting cross-baffle heat transfer coefficient between fluid #1 and #2 is: h = 2.0 . h1 . h2 / (h1 + h2) where h1 and h2 are the heat transfer coefficients for fluid #1 and fluid #2, respectively. Similarly, cross-baffle heat transfer coefficients between fluid #1 and voids of heat transfer type n (see Heat Transfer to Voids) can also be defined in Meshing & Geometry > Baffles > Heat Transfer Properties. 
Heat Transfer and Conduction in Components To enable heat transfer between fluid and components of all types activate Physics > Heat transfer > Fluid to solid heat transfer. 

 If Heat transfer > Uniform component temperatures is activated, no conduction equation is solved within the components. Each component is treated as a lumped temperature body if its Density*Specific Heat, defined in Meshing & Geometry > Geometry > Component > Solid Properties, is positive. If Density*Specific Heat variable is zero for a specific component (default), the component is treated as having a fixed temperature or a specified surface heat flux, both of which can be defined as a function of time using tabular input. 



 If Heat transfer > Non-uniform, constant temperature option is activated, the temperature in the solids is allowed to vary in space, but still no conduction equation is solved within the solids. Therefore, the temperatures in the solids will stay constant in time, irrespective of the thermal properties of the solid components. The spatial variation of the solid temperature can be defined either as the initial conditions in the input or using the restart data. Finally, when the Full energy equation is activated, the thermal conduction within components is also included. In this case, Thermal Conductivity and Density*Specific Heat have to be specified in each components’ Solid Properties. If both of these variables are set equal to zero (default), then the component is treated as a fixed-temperature component. When the Full energy equation is activated and the Maximum thermal penetration depth is specified for component m, only the portion of the component volume within that depth along the component surface, called the Thermally active layer, is retained in the computation, which typically results in a more efficient calculation. For example, during high pressure die casting, where the typical filling time is 100 ms, heat penetrates only a few millimeters into the die. Therefore, ignoring the part of the die beyond that depth provides significant memory and CPU savings. A practical value for the thickness of the thermally active layer in casting problems depends on the properties of the mold material, component/fluid heat transfer coefficient and on the simulation time. The figure below shows the thermal penetration depth for H13 steel die and a silica sand mold as a function of time. The values are estimated from the exact one-dimensional heat penetration solution into a semi-infinite medium. The temperature cutoff used to calculate the depth is 1% of the difference in metal/mold initial temperatures. In other words, within the thermally active layer, the component temperature varies by 



more than 1% of the initial temperature difference. The actual value selected should take into account the shape of the interface. 
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 To view the thermally active layer, run Preview, and then open the prpgrf file in Analyze and plot the iso-surface of “thermally active component volume.” By default, the whole component is included in the heat transfer model. When defining the specific heat of a GMO component, the Density*Specific Heat product, RCOBS(n), must be used and not the total heat capacity MOBS(n), because the volume of a GMO component may change as it moves through the grid and even in and out of it. Heat transfer coefficients between components and fluids and voids are defined in Meshing & Geometry > Geometry > Component > Surface Properties. If no component/fluid heat transfer coefficient is specified, then the heat transfer coefficient is evaluated in each cell based on the flow conditions and properties of the materials in each cell. A specified heat transfer rate between fluid and a component can be defined in two ways. By default, the specified rate represents a contact resistance that acts in series with conduction in the fluid and component. The heat transfer is then computed as a reciprocal average of all the rates linked in series. If, instead, the specified rate represents the actual rate of heat transfer, the user needs to set the component length scale in namelist OBS, OBSL(m), to a positive value. Fluid/component heat transfer can be enhanced, or reduced, for a given component by using the Surface Area Multiplier, which serves as a multiplier for the interfacial area. If the multiplier is equal to zero for a specific component, then no heat transfer is calculated between fluid and that component. When heat transfer between fluid and a porous component is desired, Specific Surface Area of the porous component should be specified in Meshing & Geometry > Geometry > Component > Porous Properties, which defines the surface area per unit bulk volume of the component. If Specific Surface Area is not used, then the interfacial area at the external surface of the component will be evaluated by the preprocessor from the volume and area fractions. 



Heat transfer between any two components N and M can be specified using HTCOB(n,m) in namelist OBS to define a thermal resistance at the contact surface between the two components, in addition to thermal conduction. This lets the user take into account gaps between components. If HTCOB is not specified, the components are assumed to have perfect contact, and the effective conductivity between the two components will be used in the conduction equation. See also Heat Transfer to Voids. NOTE: THERMAL PROPERTIES OF EACH COMPONENT MATERIAL ARE CONSTANT. 
Heat Transfer Only 

 When it is desired to model only heat transfer and skip the fluid flow solution select Numerics > Fluid flow solver options > Use zero velocity field or Use constant velocity field. The latter option is useful when doing a restart heat transfer calculation in a steady-state flow field, while the former is useful when modeling solidification after filling. If either of the two options is selected, the fluid velocities and pressures are not computed.  NOTE: POWER SOURCE PER UNIT MASS IN FLUID ARE IGNORED IF USE ZERO VELOCITY FIELD IS SELECTED. 
Heat Transfer to Voids 

 Heat transfer to void regions can be employed only in one-fluid, free-surface problems, i.e., when Global > One fluid and Global > Free surface or sharp interface options are selected. Also, you need to activate Physics > Heat transfer > Fluid to solid heat transfer if heat transfer between solid components and voids is to be considered. Initial locations of void regions are defined on the Meshing and Geometry tab under Fluid Regions. To add a void region, right click on Fluid Regions and select Add a fluid region. 
 Set the Fluid Fraction of the added fluid region to 0 to create a void.   In order to simulate heat transfer from a void to a solid or fluid, a void pointer must be specified to define the void type.  The void type is either 1, 2 or 3 and these numbers correspond to the heat transfer 



coefficients defined on the Fluids tab under Thermal Properties.  To add a void pointer, right click on Pointers under Initial tree on Meshing and Geometry. 
 The coordinates of a void pointer need to be within the void region in order for the pointer specifications to take effect. For a pointer located within a void region, all mesh cells that are part of that void region have the same heat transfer properties. 

 The temperature of each void region is uniformly distributed within the void and is usually constant in time (see Condensation/Evaporation (One Fluid with Thermal Bubbles) for details on voids with non-zero specific heat). Define Void temperature and Heat transfer type. Three heat transfer types are allowed. It defines which of the three heat transfer coefficients will be used for heat transfer with fluid and geometry components. The heat transfer coefficients between components and cooling channels are defined in Meshing & Geometry > Geometry > Component n > Heat transfer to void type k, where n is the component number and k is the void type. The type variable allows user to have up to three different types of void regions, each with a unique heat transfer coefficient. 



 Time-dependent heat transfer coefficients can be defined in the component’s Surface Properties in the component property tree. The definition of void region heat transfer properties can also be done by using a special flag in the component setup, IVR (nn) in namelist OBS, where nn is the subcomponent index. If a void region is defined by a hole subcomponent, i.e., it is located inside a solid component rather than surround by fluids, then setting IVR(nn)=m will mark this void as heat transfer void. The variable m is the pointer index that defines the void properties. Using the IVR variable, multiple void regions with the same properties can be set by reading just one CAD file describing the voids. 

 Each type of void region has its own heat transfer coefficient to the fluid defined in Fluid 1 properties in Fluids. In addition to conductive heat transfer coefficients, there are radiation emissivity heat transfer coefficients from the fluid, and from the components to voids. Radiation heat flux is proportional to the 



fourth power of the emitting body temperature. Those fluxes are only computed at the emitting surfaces, therefore, the radiation energy is lost once it leaves the surfaces. When emissivities are used, temperatures must be in degrees Kelvin. Also, the Stephan-Boltzman constant (5.6697x10-8 W/m2K4) must be included in the emissivity heat transfer coefficient. NOTE: VOID REGIONS CAN BE USED TO MODEL COOLING CHANNELS (see Cooling Channels), AND VOID REGION TYPES ARE USED TO DEFINE CHANNELS FILLED WITH DIFFERENT FLUIDS. 
History Probes Main variables: GRAFIC:  XLOC, YLOX, ZLOC, NPMOV A history probe is a diagnostic feature in FLOW-3D for computing flow parameters at the location of the probe and storing them as history data in the flsgrf file. Usually an interpolation is required to compute these quantities at the location defined by the probe coordinates. At each probe, FLOW-3D computes and stores all quantities relevant to the simulation. The user has no control over what is to be computed at each history probes. If a probe is located inside area blocked by a solid geometry component, then only quantities related to the geometry, e.g., wall temperature, will be computed. Up to 200 history probes can be defined. History probes do not affect the flow in any way. History probes must be defined directory in the prepin file using Utilities > Text Editor. Save the current simulation input file if prompted to do so. The input data for history probes are defined in the namelist GRAFIC. As a minimum, set XLOC(n), YLOC(n) and ZLOC(n) coordinates for each history probe #n. By default these coordinates are defined outside the domain. There is no need to define the total number of history probes. A title can also be defined for each probe using the variable WINTL(n). The default title is based on the probe’s location. By default, a history probe is a fixed point. It can also be made into a moving probe that follows the flow like a marker particle by setting NPMOV(n)=1. See also Marker and Mass Particles for information on history probes attached to mass particles. A history probe can also be attached to a moving component by setting LOCOBS equal to the moving component number that the probe should be attached to. In this case, the probe will move at the velocity of the moving component, whether prescribed or coupled. Furthermore, for GMO components a probe can be made to move as if rigidly attached to it, LOCOPT(n)=0, or using only its translational velocity, LOCOPT=1, which is useful if the translational motion of the component is of the primary interest. Related variables: GRAFIC: ILOC, JLOC, KLOC, LOCOBS, LOCOPT, WINTL, NCOPLT 



Hydraulic Data 

 This option allows the user to output additional data that may be useful in civil hydraulic simulations, such as, fluid elevation, depth and the Froude number. One value for each of the three quantities is computed at every (x,y) location in the mesh and stored for every cell in the vertical column (there is no variation of the data in the z-direction). Fluid elevation is computed as the z-coordinate of the topmost fluid element in a vertical column. Fluid depth is computed as the difference between Fluid elevation and the z-coordinate of the bottommost blocked element in a vertical column. The computation of Froude number is based on: 
Fr V gD=  Where V is the depth-averaged velocity, g is the acceleration of gravity in the z-direction and D is the Fluid depth. To request this output, navigate to the Output tab, go to the Special output section and check the box next to Hydraulics data. NOTE: THIS OPTION IS ONLY VALID FOR ONE-FLUID, FREE-SURFACE FLOWS WHERE THE VERTICAL COORDINATE IS IN THE Z-DIRECTION. 
Impulsive Motion of Non-inertial Reference Frame Non-inertial reference frames are specified in tabular form in file movin.inp when Physics > Non-inertial RF > Activate non-inertial reference frame option is activated together with Tabular input. The input can be typed into a table that is open when clicking on the Edit button under Tabular input. Impulsive motion can also be specified in the table when Angular acceleration with impulsive motion or Angular velocity with impulsive motion are selected above the table. For impulsive motion, the data specified is the same as that for smooth motion (time, linear accelerations, angular velocities, angular accelerations), except the impulse duration is also specified. Also, the computational time-step size to be used at the beginning of the impulse interval can be specified for better accuracy in capturing the duration of the impulse. 



 By clicking the OK button the data is written into the file defined in the Input file edit box of the Tabular input window, with the default name movin.inp. The file name is defined in the Input file edit box of the Tabular input window, with the default name movin.inp. It contains the user-defined tabular data for the non-inertial reference frame motion. It can contain both smooth and impulsive motion data. Any time entries with a non-zero impulse duration are taken to be impulsive, while entries with a zero impulse duration are taken to be smooth. Impulsive accelerations are superimposed on top of the smooth data. In the movin.inp file shown below, the z linear acceleration is defined by both smooth and impulsive data. The impulse duration is in the "impldt" column, and the time-step size is in the "delt" column. Smooth accelerations are defined with points at t=0, t=9.5, and t=100. The z acceleration will be evaluated using a linear interpolation for those points. The z acceleration also has impulsive data specified at t=2, t=5, and t=8, each with a pulse width of 1 sec. The impulses are superimposed on top of the smooth variation as shown in the figure below.  Example file of impulsive and smooth acceleration data: T accx accy accz omx omy omz omdx omdy omdz delt impldt 0. 0. 0. 0. 0. 0. 0. 0. 0. 0. 0. 0. 2. 0. 0. .1 0. 0. 0. 0. 0. 0. 0. 1. 5. 0. 0. .1 0. 0. 0. 0. 0. 0. 0. 1. 8. 0. 0. .1 0. 0. 0. 0. 0. 0. 0. 1. 9.5 0. 0. .5. 0. 0. 0. 0. 0. 0. 0. 0. 100. 0. 0. .5 0. 0. 0. 0. 0. 0. 0. 0.  



 Graph of impulsive and smooth acceleration data Variable Definitions and Units: t  = time (S) accx = acceleration along x-axis (L/S2) accy = acceleration along y-axis (L/S2) accz = acceleration along z-axis (L/S2) omx  = rotational velocity about x (Rad/S) omy = rotational velocity about y (Rad/S) omz = rotational velocity about z (Rad/S) omdx = rotational acceleration about x (Rad/S2) omdy = rotational acceleration about y (Rad/S2) omdz = rotational acceleration about z (Rad/S2) delt = time-step size (S) impldt  = impulse duration (S) See Non-inertial Reference Frame and Smooth Tabular Motion. NOTE: THE BASIC FORMAT OF THE MOVIN.INP FILE IS DESCRIBED IN SMOOTH TABULAR MOTION. FOR IMPULSIVE MOTION, THE TIME-STEP SIZE AND THE IMPULSE DURATION ARE INCLUDED AFTER THE Z ANGULAR ACCELERATION. AS WITH THE SMOOTH DATA, "PLACEHOLDERS" MUST BE ENTERED FOR ALL DATA QUANTITIES, EVEN IF THAT DATA IS NOT USED (I.E., ENTER ZERO FOR TIME-STEP SIZE IF IT IS NOT TO BE SPECIFIED). 
Lost Foam Casting Process In the Lost Foam casting process, a sand mold is filled with an expanded foam material, typically polystyrene. When liquid metal is poured into the mold, it must remove the foam by melting or vaporizing it before it can fill the cavity. The filling is primarily controlled by heat transfer from the metal to the foam. 



 To represent foam as disappearing solid, FLOW-3D uses a special "free" or "phantom" component, which does not contribute to area/volume blockages. The mold cavity is defined by the usual FAVORTM technique for the Standard components and is then filled with foam. Solid components always take precedence over phantom components, which can only fill open spaces. Additional component properties can be assigned to define the heats-of-transformation of foam. Foam components are defined like any other component, e.g., by importing an STL file or using the solid modeler in the code. When adding a foam component, specify the type of the new component as Lost Foam. Since foam will not affect real components, its geometric definition does not have to conform exactly to the mold cavity. Usually a simple box or cylinder shape is sufficient to fill a cavity with foam. Lighteners (i.e., holes) can be cut in foam, as in ordinary components, by selecting the type of the subcomponent defining a lightener as Hole. The foam component must be assigned a density-specific-heat value, a density-transformation-energy and temperature for melting, a density-transformation-energy and temperature for vaporization. 



 The heat transfer between foam and liquid metal must be set using the Meshing and Geometry > Component tree > Lost Foam Properties > Heat Transfer Coeff. As a rule-of-thumb, the average speed at which metal moves into foam is approximately given by the ratio: (metal-foam heat transfer coefficient) / (foam density * specific heat) Additionally, the orientation of the metal/foam interface with respect to gravity is taken into account. The heat transfer coefficient between metal and foam is larger where metal is above foam then when it is below, therefore, making it easier for the metal to advance downwards than upwards. The recommended value for CGFOB is 0.5. Since filling is controlled by heat transfer, inlet conditions must be specified by pressure and not velocity boundary conditions. A special simplified filling model is available, IHONLY=4 in namelist XPUT, that may be used to quickly determine general filling patterns and locate possible sources of defects arising from the convergence of metal fronts. This model, however, gives no information about temperature or velocity distributions, surface defects, or solidification. 
� Fluid cannot be initialized in the regions already occupied by foam. 
� Foam can be viewed by plotting the 'free obstacle volume' variable. For better pressure iteration convergence it is recommended to use a small degree of limited compressibility by setting Physics > Compressibility > Manual compressibility, and setting the compressibility of fluid 1 (Fluids > Compressibility > Fluid 1) to a value around 1.e-6 in CGS units (see Acoustic waves), or to a value on the order of 0.1/(maximum fluid pressure). See also Solidification. NOTE: THE LOST FOAM MODEL CAN BE USED ONLY IN ONE-FLUID FLOWS WITH A SHARP INTERFACE AND HEAT TRANSFER. Several Flow Science technical notes on modeling the lost foam casting process are listed at http://www.flow3d.com/resources/res_tn_1.html. 

http://www.flow3d.com/resources/res_tn_1.html


Macro-Segregation during Alloy Solidification The segregation model is designed to model changes in binary alloy composition due to transport of solute by convection and diffusion. 

 The phase diagram is assumed to have straight solidus and liquidus lines. The phase diagram is constructed based on the input data and is included in the preprocessor plot file prpplt. The phase diagram is defined by the values of the solidus and liquidus temperatures, TS1 and TL1, at a reference solute concentration defined by CSTAR. In addition, the partition coefficient needs to be defined. Alternatively, the melting point of the pure solvent can be specified. If both partition coefficient and pure solvent melting temperature are set, then solvent melting temperature is redefined from the phase diagram. Finally, the eutectic temperature, or concentration, can be specified to define the eutectic reaction. Again, if both of these variables are set, then eutectic concentration is redefined from the phase diagram. The coefficient DRATIO defines the ratio of the diffusion coefficients of solute in the solid and liquid phases. The solute molecular diffusion coefficient in liquid is specified by CMSEG. RMSEG defines the turbulent diffusion coefficient multiplier of the solute. 



 Most of these quantities are set in Fluids > Properties > Segregation Model. Solute diffusion coefficient is set in Physics > Solidification > Segregation model > Solute diffusion coefficient. 

 If density variation due to solute redistribution is important, then set Physics > Density evaluation > Density evaluated as a function of other variables… and use Fluids > Segregation model > Solutal Expansion Coefficient as the solute expansion coefficient to define metal density as a linear function of solute concentration. In that case, CSTAR will be used as the reference concentration. In addition, Fluids > Density > Fluid 1 > Thermal Expansion can be used to account for thermal buoyancy effects (see also Buoyant Flow). 



 Activate segregation in Physics > Solidification > Activate segregation model. Initial solute concentration can be set in Initial > Fluid initial state > Initial solute. A non-uniform initial distribution can be set in the FL section using quadratic functions. At pressure and velocity boundaries use Boundaries > Boundary face > Solute concentration to set solute boundary conditions. Liquid and solid phase compositions can be plotted by using data transformations in the postprocessor. Eutectic solidification can be visualized by plotting 'SLDEUT' which stores the mass fraction of the eutectic in the metal. If thermal gradients in the liquid phase are significant, use the higher-order advection method for more accuracy by setting Physics > Heat Transfer > Second order monotonicity preserving. Flow losses in mushy zone are controlled by the Fluids > Properties > Solidification Properties > Other > Coefficient of Solidification Drag, which is a function of the dendrite arm spacing. Since the latter is not evaluated by the model, Coefficient of Solidification Drag has to be set by the user. NOTE: THE VALUE OF SOLIDIFICATION TEMPERATURE CAN BE NEGATIVE UNLIKE THE STANDARD SOLIDIFICATION MODEL. 



Marker and Mass Particles 

 Particles can be massless (marker particles), or they can have mass. Select mass or marker particles in Physics > Particles > Particle type. Mass particles can have either varying size or density (selected in Physics > Particles > Particle type > Mass particles). Particle diameter and density are specified in Physics > Particles > Particle type > Size and density.  Particles can be introduced into the flow as an initial block, a source, or a history particle. A rectangular block of particles can be defined at the beginning of a simulation using the Physics > Particles > Add block. Set the number of particles in each coordinate direction within the Add Block > Particle block options > Particle spacing. For mass particles, the number of particles types (species) according to their size (or density) can be defined using Add block > Particle block options > Species information > Number of species. Add block > Particle block options > Species information > Minimum size and Maximum size define the minimum and maximum limits for the size variation. Intermediate particles sizes are generated at equal intervals between these sizes. Specify the location of the block in Add block > Particle block options > Limits.  Particle sources can also be used to generate particles during a simulation. The rate of generation of the particles is specified in Add source > Species information > Rate of generation. This rate is per second, so extremely short finish times will either generate very few particles or require high rates of generation. Particle species and size distribution are the same as for particle blocks. Specify the location in the Add source > Particle source options > Limits. Mass particles entering fluid at a source can have a non-zero initial velocity specified by Add source > Particle source options > Particle velocity. 



Normally, particles are generated randomly in space and time, with only average spacings and rates of generation. It is possible to change this. To generate particles regularly in space in a particle block, choose Physics > Particles > Initialization > Regularized in space in initial block. For a regular generation rate, choose Physics > Particles > Initialization > Regularized in time. For both options (regular spacing in initial block, and regular generation rate at sources), then choose Physics > Particles > Initialization > Options 2 and 3. Finally, single particles can be initiated at specific locations using Add history particle > Particle Location. These particles act as moving probes. They record the flow parameters in the surrounding flow as they move in the fluid and output these quantities as history plots similar to the standard, stationary history probes. These probes, or moving history points, can be marker particles or they can be mass particles with the size set by …Add history particle > Particle history options > Size. Mass probe particles can also have an initial velocity (Add history particle > Particle history options > Particle velocity). Moving probes that hit an outlet boundary become stationary history points at their last location in the mesh. The coefficient of restitution (Physics > Particles > Properties > Coefficient of restitution) controls the loss of the particle kinetic energy when bouncing off solid walls. If the coefficient=1.0 then no energy loss occurs, while a coefficient of zero results in a complete energy loss in that time cycle. When the coefficient is negative, particles will stick when they come in contact with a wall, and then remain attached to that wall.  The Physics > Particles > Properties >Free surface interaction controls the particle/free-surface interaction. When free-surface interaction equals 1.0, then particles can move in either fluid or void and can penetrate the free surface. When Free surface interaction equals -1.0, then particles can penetrate the free surface, but are deleted in void regions (for example, for particles representing gas bubbles rising in fluid). In the case of interaction=0.0, a mass particle that attempts to penetrate the free surface gets trapped at the free surface. Both mass and marker particles also undergo diffusion with a constant diffusion coefficient, (Physics > Particles > Properties > Diffusion coefficient), or with diffusion proportional to the viscosity, (Physics > Particles > Properties > Inverse Schmidt number). Mass particles can also have an electric charge, which contributes to the electric field and adds an electric force to the particles (see Electric Fields). This is set in Physics > Electro-mechanics > Electro-mechanics options > Electric potential > Particle charge. Finally, it is possible to introduce particles during a restart. Specify the particle options on Physics > Particles, then select Global > Restart > Particles > Particle data reset in input. This tells the solver to restart and use the particle data from the input file, not the previous results. It is possible to combine this with constant velocity flow by also choosing Numerics > Fluid solver options > Use constant velocity field.  Mass particles have inertia and, therefore, have their own velocities. The effect of the surrounding fluid on the mass particles dynamics is taken into account through the drag force. Set the drag coefficient in Particles > Properties > Drag coefficient. See also Theory. Particles can interact with the fluid in different ways. Normally, the fluid moves the particles, but particles do not affect the fluid flow (Particles > Properties > Partial fluid particle interaction). This is a good approximation only if the particle size and concentration in the fluid are small. If this is not the case, then mass particle motion can significantly influence the fluid flow through particle/fluid drag forces. To activate the two-way particle/fluid momentum transfer model set Particles > Properties > Full fluid particle interaction. 



At partially blocked grid cell boundaries, including porous components, particles are transmitted (reflected) with a probability proportional to the open (closed) area. The subroutine in which particle sources are defined, PARSOR, is provided in source form so that users may customize particle sources, for example to define a creation rate that is time-dependent. See Customizing FLOW-3D: subroutines included in distribution. NOTE: A MARKER PARTICLE MOVES WITH THE SPEED OF THE SURROUNDING FLUID. A STRING OF MARKER PARTICLES ORIGINATING AT THE SAME LOCATION CAN BE USED TO VISUALIZE STREAMLINES IN A STEADY-STATE FLOW. 
Mass Sources A mass source is associated with a geometry component. When a component is defined as a mass source, fluid enters the computational domain at a user-specified mass flow rate or volume flow rate from its open surface (surface not blocked by other components or by the boundary of the computational domain). A mass source with negative flow rate removes fluid from the computational domain and is called a sink (in the following a source represents only a mass source with positive flow rate). Both stationary and moving components can be defined as sources or sinks. The model allows for multiple sources and sinks, each characterized by a unique set of properties such as mass or volume flow rate, fluid type (fluid #1, #2 or their mixture), fluid density and temperature.  It is noted that: 
� The mass/volume flow rate can vary with time. As a result, a source can change to a sink, and vice versa, during a simulation. 
� In two-fluid problems, either fluid can be added/removed at a source/sink. In additions, a two-fluid mixture can be removed at a sink.  
� In one-fluid problems fluid #2 is replaced with void which can also be added or removed at a source/sink. In that case, the added or removed void volume is converted to the corresponding pressure change in the void region adjacent to the source/sink. 
� When both fluid #1 and fluid #2 (or void) are removed at a sink, the amount of each fluid removed is automatically determined at each point in time in proportion to its current volume fraction in the mixture adjacent to the sink. For example, if the fluid fraction in the mixture is 0.1, then 10% of fluid #1 and 90% of fluid #2 by volume are removed at the sink. If fluid fraction is equal to 1.0, then no fluid #2 is removed. Since the mixture content can change during simulation, so will the removal rate of each fluid. 
� For simulations with heat transfer, the temperature at a sink is automatically computed as the average temperature in the cells adjacent to the sink and, therefore, need not be defined by the user. 
� Examples below describe the use of the mass sources/sink model in different simulation cases. Case 1, one-fluid flow with constant density, free surface, and no heat transfer: 
� A source can release fluid #1 (liquid) or void but not both. If fluid #1 is released, the source fluid density defaults to the density of fluid #1 and cannot be changed by the user. If void is released and the mass flow rate is defined, the gas density for the void at the source/sink must be specified. If void is released and volume flow rate is defined, gas density of void at the source is not needed. 
� A sink can remove fluid #1 (liquid), void or a mixture of the two. If void or a mixture of fluid #1 and void is removed while mass flow rate is defined, then the gas density for the void at the sink must be defined. In all other cases, gas density of void at the sink is not needed. 



� If void is released at a source or void or its mixture with fluid #1 is removed at a sink, then a bubble model must be activated in Physics > Bubbles and phase change. Case 2, one-fluid flow with variable density (a density transport equation is solved), free surface and no heat transfer: 
� A source can release either fluid #1 (liquid) or void but not both. If fluid #1 is released, the source fluid density must be defined. If void is released and mass flow rate is defined, the gas density for the void at the source must be defined. If void is released and volume flow rate is defined, gas density of void at the source is not needed.  
� A sink can remove fluid #1 (liquid), void or a mixture of the two. If void or a mixture of fluid #1 and void is removed while mass flow rate is defined, then the gas density for the void at the sink must be defined. In all other cases, gas density of void at the sink is not needed. 
� If void is released at a source or void or its mixture with fluid #1 is removed at a sink, then a bubble model must be activated in Physics > Bubbles and phase change. Case 3, one-fluid flow with constant or variable density (function of temperature), free surface and heat transfer: 
� A source can release either fluid #1 (liquid) or void but not both. If fluid #1 is released, the source fluid density cannot be defined by the user because it is either constant (equal to the fluid density) or depends on temperature. If void is released and mass flow rate is defined, then the gas density of void at the source must be defined.  
� A sink can remove fluid #1 (liquid), void or mixture of the two. If void is removed while mass flow rate is defined, then the gas density for the void at the sink must be defined. In all other cases, the gas density of void at the sink is not needed. 
� If void is released at a source or void or its mixture with fluid #1 is removed at a sink, then a bubble model must be activated in Physics > Bubbles and phase change.  
� Temperature of the fluid must be defined at a source but is not needed at a sink.  Case 4, one-fluid flow with constant density, no free surface and no heat transfer: 
� A source can only release fluid #1. The source fluid density defaults to the density of fluid #1 and cannot be changed by the user.  
� A sink can only remove fluid #1. Density at the sink is that of fluid #1 and cannot be defined by the user. Case 5, one-fluid flow with constant density, heat transfer and no free surface: 
� A source can only release fluid #1. The source fluid density defaults to the density of fluid #1 and cannot be changed by the user.  
� A sink can only remove fluid #1. Fluid density at the sink is that of fluid #1 and cannot be defined by the user. 
� Temperature must be defined at a source but is not needed at a sink.  Case 6, one-fluid flow with variable density (a density transport equation is solved), no free surface and no heat transfer 
� A source can only release fluid #1. The density of the source fluid must be defined by the user. 
� A sink can only remove fluid #1. Fluid density at the sink has its local value and cannot be defined by the user. 



Case 7, one-fluid flow with variable density (function of temperature), heat transfer and no free surface  
� A source can only release fluid #1. The fluid density at the source cannot be defined because it depends on temperature.  
� A sink can only remove fluid #1. Fluid density at the sink has its local value and cannot be defined by the user. 
� Temperature must be defined at a source but not at a sink.  Case 8, two-fluid incompressible flow with sharp interface and no heat transfer: 
� A source can release either fluid #1 or fluid #2 but not both. The fluid density at a source defaults to that of the source fluid and cannot be changed by the user. 
� A sink can remove fluid #1, #2 or their mixture. Fluid density at the sink has its local value and cannot be defined by the user. Case 9, two-fluid incompressible flow with sharp interface and heat transfer: 
� A source can release either fluid #1 or fluid #2 but not both. The fluid density at a source defaults to the source fluid density and cannot be changed by the user. 
� A sink can remove fluid #1, #2 or their mixture. Fluid density at a sink need not be defined.  
� Temperature must be defined at a source but not at a sink.  Case 10, two-fluid incompressible flow with no sharp interface and no heat transfer: 
� A source can release either fluid #1 or fluid #2 but not both. The fluid density at a source defaults to the source fluid density and cannot be changed by the user. 
� A sink can remove fluid #1, #2 or their mixture. Fluid density at the sink has its local value and cannot be defined by the user.  Case 11, two-fluid incompressible flow with heat transfer and no sharp interface: 
� A source can release either fluid #1 or fluid #2 but not both. The fluid density at a source defaults to that of the source fluid and cannot be changed by the user. 
� A sink can remove fluid #1, #2 or their mixture. Fluid density at the sink has its local value and cannot be defined by the user. 
� Temperature must be defined at a source but not at a sink.  Case 12, two-fluid flow with sharp interface, and flow of fluid #2 is compressible: 
� A source can release either fluid #1 or fluid #2 but not both. If fluid #1 is released, source fluid density defaults to that of fluid #1 and cannot be changed by the user. If fluid #2 is released, source fluid density must be defined. 
� A sink can remove fluid #1, #2 or their mixture. Fluid density at the sink has its local value and cannot be defined by the user.  
� Temperature must be defined at a source but not at a sink.  A mass source/sink can be defined with the following procedures.  Activate Mass Source The mass source mode is activated in Model Setup > Physics > Fluid sources by checking Activate fluid source model. 



 To define a mass source/sink, go to Meshing & Geometry > Geometry > Component (the desired component) > Component properties and check the Mass Source checkbox. The tree for mass source definition can be expanded, as shown in the figure below. 

 Define Source Properties Users can specify fluid type (fluid #1, #2 or their mixture), pressure type, density and temperature at a source and fluid type and density at a sink, depending on definition of the problem.  The pressure types include Stagnation pressure and Static pressure and only applies to sources (i.e., when the mass flow rate is positive). At a Stagnation pressure (default) source, fluid is assumed to enter at zero velocity. As a result, pressure must build up at the source to move the fluid away from the source. Such sources are designed to model fluid emerging at the end of a rocket or a deflating balloon. In general, stagnation pressure sources apply to cases when the momentum of the emerging fluid is created inside the source component, like in a rocket engine. At a Static pressure source, the fluid velocity is computed from the mass flow rate and the surface area of the source. In this case, no extra pressure is required to propel the fluid away from the source. An example of such source is fluid emerging from a long straight pipe. Note that in this case the fluid momentum is created far from where the source is located. Typically, the distinction between those two types of mass sources is only important for sources associated with coupled-motion GMO components because it affects the fluid pressure at the source hence the hydraulic force acting on the moving object. Define Flow Rate In the dropdown boxes under Flow rate, one can choose to define Mass flow rate or Volume flow rate for the source/sink. Both flow rates can be selected as either total flow rate or flow rate per unit area of the source component.  



The total flow rate is distributed uniformly over the open surface of the source component. When flow rate per unit area is selected, the total flow rate is the specified flow rate per unit area times the open surface area of the source component. If the open surface area changes in time, so will the total mass flow rate. For example, the calculated surface area of a moving component depends on mesh size and mesh distribution and is updated at each time step, thus it can change with time, resulting in a time-variation of the total flow rate.  If total flow rate is specified with a moving component, the fluxes along the open surface are adjusted at every time step to maintain the defined total mass flow rate.  If flow rate is constant, then simply input it in the corresponding edit box under Total flow rate or Per unit area flow rate. Otherwise click on Tabular to pop up a data table, as shown below, and enter a series of data for time versus flow rate. Flow rate is positive for a source and negative for a sink and can change sign with time. As an option, users can also define flow rate versus time by importing an existing data file using the Import Values button. The file must have two columns of data which represent time and flow rate from left to right, respectively. A csv extension is required for the file. If the file is in the simulation directory, check Import from simulation directory. As with other time-dependent inputs in FLOW-3D, data is interpolated in a piecewise linear fashion between time points.  Define Scalars at Source Scalars have to be first activated in Scalars under Physics tab. Scalar quantities in the fluid at a mass source can be defined as scalar concentrations at the source, which is mass of the scalar per unit volume of the fluid entering the computational domain. The mass flow rate of a scalar entering the domain is equal to the specified scalar concentration times volume flow rate of the source fluid at the source. In Mass Source > Source > Scalars > User defined scalar, enter the scalar concentration. For time-dependent scale concentration, clicking on Scalars > User defined scalar > Tabular to pop up the Time edit tables window and enter time versus scalar concentration. Alternatively, the scalar concentration can be defined using a data file that can be imported using the Tabular > Import Values button. There should be two columns of data in the file, which represent time and scalar concentration from left to right, respectively. The file must have a csv extension. 

 



Mass-Momentum Sources The mass-momentum source model allows the user to introduce fluid at any location and orientation into the computational domain at a specified (time-dependent) flow rate and velocity without having to model the geometry of the actual source. A mass-momentum source is represented by an array of particles of a special type in a planar surface. Users only need to define the location, shape and orientation of the source surface, and the solver will generate these particles automatically at the specified location in a pattern that follows the user-specified shape and orientation. In addition, mass-momentum sources can move at a user-defined velocity. They are intended to represent objects like nozzles, ventilation air ducts, pipes, etc as shown in the image below. This approach is particularly useful when source dimensions are small compared to the size of the computational domain. A mass-momentum source can release fluid (when flow rate is positive) or remove fluid (when flow rate is negative). In the following we will call a mass-momentum source that releases fluid a source and one that removes fluid a sink. Multiple sources and sinks are allowed to exist in one simulation each characterized by a unique set of properties such as mass or volume flow rate, fluid type (fluid #1, #2 or their mixture), fluid density and temperature.  It is noted that: 
� The mass/volume flow rate can vary with time. As a result, a source can change to a sink, and vice versa, during a simulation. 
� In two-fluid problems, either fluid can be added/removed at a source/sink. In additions, a two-fluid mixture can be removed at a sink.  
� In one-fluid problems fluid #2 is replaced with void which can also be added or removed at a source/sink. In that case, the added or removed void volume is converted to the corresponding pressure change in the void region adjacent to the source/sink. 
� When both fluid #1 and fluid #2 (or void) are removed at a sink, the amount of each fluid removed is automatically determined at each point in time in proportion to its current volume fraction in the mixture adjacent to the sink. For example, if the fluid fraction in the mixture is 0.1, then 10% of fluid #1 and 90% of fluid #2 by volume are removed at the sink. If fluid fraction is equal to 1.0, then no fluid #2 is removed. Since the mixture content can change during simulation, so will the removal rate of each fluid. 
� For simulations with heat transfer, the temperature at a sink is automatically computed as the average temperature in the cells adjacent to the sink and, therefore, need not be defined by the user. Please refer to the Mass Source section for the description of the behavior of the mass/momentum source feature in different modeling cases. For example, to model oil spill into water, simulation can be set up as a one-fluid, free-surface case with water modeled as fluid #1, air as void and the oil phase can be modeled using the variable density model (see section on  Density Variations). In this case, the source can represent the oil flow into the water with the source fluid density set equal to the oil density. A mass-momentum source/sink can be defined with the following procedures.  Activate Mass-Momentum Source The mass-momentum source model is activated in Model Setup > Physics > Fluid sources by checking Activate fluid source model. 



 In Meshing & Geometry > Geometry > Mass-momentum sources, right click on Mass-momentum sources to add a mass-momentum source/sink, as shown in the figure below. The checkbox before Enabled should be checked. Users may also give a name to the source/sink, as shown below. 
 Define Geometry for Mass-Momentum Source Mass-momentum sources are designed to represent planar sources, for example, the inlet/outlet of a pipe, or an air duct or that of a nozzle. A source can be square, rectangular, circular or elliptical. Click on Geometries to expand the branch and select appropriate shape in the Shape box. After that, define the size of the source by inputting the size parameters. 

 The default orientation of a source is in the X-Y plane and centered at the coordinate origin. The default outer-normal (which is the default flow direction) of the source surface is in +Z direction. The source can be rotated to the specified orientation and then moved to a desired location by specifying rotation and translation parameters. The rotation is made about X first, then Y and Z in the end using the right hand thumb rule, according to the specified rotation angles (in degrees) about the axes. The flow direction of the source fluid is rotated accordingly. Once the rotation is made, the X, Y and Z components of the outer-normal vector of the source surface are displayed as Normal X, Normal Y and Normal Z. The figure below describes how the transformations are conducted.  



 Define Source Fluid Properties The mass/volume flow rate can change with time. A source can change to a sink, and vice versa, during a simulation. Under Properties > Source and Properties > Sink, users can define fluid type (fluid #1 or #2), density and temperature at a source and define the fluid type (fluid #1, #2 or their mixture) and density at a sink. 

 Define Flow Rate Users can choose to define total mass flow rate or total volume flow rate for the source/sink in Properties > Flow rate type. The flow rate is distributed uniformly over the source.  If flow rate is constant, then simply enter it in Properties > Flow rate type > Flow rate. Otherwise click on Flow rate > Tabular to open a data table and type time versus flow rate, as shown below. The flow rate is positive for a source and negative for a sink and can change between source and sink with time. As an option, users can define flow rate versus time by importing a data file using the Import Values button. The file must have two columns of data which represent time and flow rate from left to right, respectively. A csv extension is needed for the file. If the file is in the simulation directory, check Import from simulation directory. As with other time-dependent inputs in FLOW-3D, data is interpolated between the time points in a piecewise linear fashion. Based on the specified mass flow rate and area of the source, the fluid velocity component along the source normal is automatically computed by FLOW-3D. 



Define Motion of Source A mass-momentum source/sink can be stationary or can be assigned translational motion by defining time-dependent velocities in X, Y and Z directions. Rotational motion is not allowed. The source velocity is not added to the fluid discharged by the source.  When moving, the source can move in and out of the computational domain without loss in shape or size. If during simulation a source becomes partially outside the computational domain or blocked by a solid component, then the fluid flow rate at the source is scaled down accordingly. Importantly, if some part of a source is inside a solid component or outside the mesh at time zero, then that part of the source is ignored completely; the specified flow rate is then distributed over the valid portion of the source at time zero.  The X, Y and Z velocities of the source/sink motion can be defined in Source/Sink Motion > U velocity, V velocity and W velocity, respectively. If they are time-dependent, click on the corresponding Tabular buttons and input the values for time and velocity. As an option, the source/sink velocity can be defined using a data file that can be imported using the Tabular > Import Values button. There should be two columns of data in the file, which represent time and velocity from left to right, respectively. The file must have a csv extension. Define Scalars at Source Scalars have to be first activated in Scalars under Physics tab. Scalar quantities in the fluid at a mass-momentum source can be defined as scalar concentrations at the source, which is mass of the scalar per unit volume of the fluid entering the computational domain. The mass flow rate of a scalar entering the domain is equal to the specified scalar concentration times volume flow rate of the source fluid at the source. In Mass Source > Source > Scalars > User defined scalar, enter the scalar concentration. For time-dependent scale concentration, clicking on Scalars > User defined scalar > Tabular to pop up the Time edit tables window and enter time versus scalar concentration. Alternatively, the scalar concentration can be defined using a data file that can be imported using the Tabular > Import Values button. There should be two columns of data in the file, which represent time and scalar concentration from left to right, respectively. The file must have a csv extension. Customization (An Option) In addition to the standard capabilities, users can introduce mass-momentum sources of more complex properties and shapes. This can be done by editing and compiling the customizable FORTRAN subroutine PARQSR (see FLOW-3D subroutines included in distribution). A value of IPQSR=2 indicates that at least one of the sources in PARQSR is time-dependent, either because its flow rate is changing or its location and/or orientation is changing. 



Microporosity Formation 

 The microporosity model can only be used when modeling solidification (see Solidification) and is activated in Physics > Solidification > Activate micro-porosity model. The required input are liquid and solidified fluid densities, defined in Fluids > Densities> Fluid 1 and Fluids > Solidification Properties > Solidified Fluid 1 Properties > Density, where the solidified fluid density is greater than the liquid density. Also, Fluids > Solidification Properties > Other > Critical Solid Fraction must be set equal to a value less than 1.0. The Physics > Solidification > Square of the speed of sound at critical solid fraction can be defined. It describes the compressibility of the solidifying fluid at the large negative pressures developing in the mushy zone due to shrinkage. The Solidification > Critical pressure at which gas pore can form variable allows user to couple the model to the initial pressure in the fluid, defined in the Initial tab, or taken from the restart data. Intensification pressure can also be defined for high pressure die casting simulations to account for the extra pressure created by the shot sleeve plunger during solidification to delay the formation of porosity. The larger the intensification pressure the less porosity will form in the casting during solidification. The micro-porosity model does not require any specific setting other than the activation of a solidification model. It can be used together with the full system of flow equations, or in zero velocity field, i.e., in a purely thermal problem. The model produces an additional output quantity called “Percent micro-porosity,” which is available for postprocessing in spatial and history plots. 



A Flow Science technical note on modeling micro-porosity can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN66.pdf. 
Moisture in Sand Molds Main variables: XPUT: IHTC   OBS: OBSM, OBSMRC, OBSMRL, OBSMT  Sand molds may have moisture distributed throughout the sand. This moisture will evaporate as the mold temperature increases during solidification of the casting. The latent heat released during evaporation may significantly affect the temperature evolution in the mold and the cooling rate of the casting. The sand moisture model in FLOW-3D assumes that the vapor escapes from the mold immediately after evaporation and no recondensation occurs. This significantly simplifies the model since no separate vapor transport equation has to be solved. The model can be used only if Physics > Heat transfer > Solve full energy equation in solids model is activated. Moisture can only exist in components with non-zero specific heats and thermal conductivities, RCOBS and KOBS, that is, in components that can have a distribution of temperature within them. The initial uniform moisture content for component NOB is set using the OBSM(NOB) variable. OBSM(NOB) is the volume fraction of moisture of the bulk “dry” component volume. If experimental measurements supply the mass fraction of moisture of the “dry” component mass, then the value of OBSM can be obtained by multiplying the mass fraction by the ratio of the “dry” component density to the density of water. OBSMRC(NOB) defines the moisture density-specific-heat product, OBSMRL(NOB) is the density-latent-heat product, and OBSMT(NOB) is the moisture evaporation temperature. All these variables are constant for each component and default to zero. Different moisture properties can be assigned to different components. The density-specific heat of moisture, OBSMRC, is added to that of the “dry” component, RCOBS, but component conductivity, KOBS, is not adjusted for moisture content. Moisture can be viewed by plotting the ‘moisture content’ variable. The total moisture volume is also plotted as a function of time, similar to the total fluid volume. NOTE: THE PRESENCE OF MOISTURE IMPLIES THAT THE COMPONENT IS POROUS. HOWEVER, THE USER DOES NOT HAVE TO EMPLOY THE POROUS COMPONENT MODEL TO USE THE MOISTURE MODEL, ALTHOUGH MOISTURE BEARING COMPONENTS CAN BE POROUS. IN THE LATTER CASE THE BULK COMPONENT VOLUME IS DEFINED AS VBULK=VOBS/(1-OPOR) WHERE OPOR IS THE COMPONENT POROSITY AND VOBS IS THE ACTUAL (SOLID) COMPONENT VOLUME. 
Moving Components with Tangential Surface Velocity Main variables: OBS: IMO, UTOBS, VTOBS, WTOBS Users can define a tangential velocity at a geometrical component surface by customizing function subroutine VELOBS. This is particularly useful for modeling moving webs. Note that the geometry of the component with this model does not change or move with time, but rather, a tangential velocity is applied at the component surface. When this type of component is defined, it is identified as having a moving surface by setting the variable IMO(N)=2 in namelist OBS, where N is the component number. 
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In order for this model to be able to accommodate complex geometries, the user must specify the velocity at the component surface in function VELOBS. This function is called for each component identified by IMO (N)=2. In this function subroutine, the user has access to the component number, and x, y and z coordinates where the tangential velocity is to be calculated. Note that these coordinates are the closest cell intersections to the surface, and may not lie exactly on the component surface. If the VELOBS subroutine is not modified, the velocities at the component surface will be defined by UTOBS, VTOBS and WTOBS. 
Moving Solid Phase Main variables: OBS: IFOB, UTOBS, VTOBS, WTOBS  The moving solid phase option allows users to model continuous casting. A "phantom" component is defined in the region where the solidified moving fluid will be located. It is a "phantom" component because it covers a specified domain, but only in definition. It does not actually block area or volume, and therefore, has zero volume. This phantom component is given velocity using UTOBS(t,n), VTOBS(t,n) and WTOBS(t,n) in namelist OBS, which may be functions of time. For solid fractions larger than the coherency solid fraction Fluids > Solidification Properties > Other > Coherent Solid Fraction, a D'Arcy type of drag is used to drive the fluid toward the phantom component velocity. When the solid fraction exceeds the point of rigidity specified in Fluids > Solidification Properties > Other > Critical Solid Fraction, it will move with the velocity of the phantom component (see Solidification). To create a continuous casting phantom component, define an component as usual, but then set variable IFOB (component #)=4. The IFOB variable identifies this component as a continuous casting phantom component. This phantom component will not appear in component plots, but can be seen by plotting the quantity vfob. NOTE: THE PHANTOM COMPONENT MUST BE FLAT SINCE A UNIFORM VELOCITY IS APPLIED ACROSS THE ENTIRE DOMAIN OF THE COMPONENT. 
Multi-Block Meshes Multi-block gridding in FLOW-3D enables users modeling complex flow phenomena to run their simulations faster yet, at the same time, more efficiently use the computer resources. Each block spans a specified region of the entire flow domain and contains the standard structured rectangular mesh. A mesh block can be nested (contained entirely within another block) or linked (joined with another block at their boundaries). Each mesh block can have a set of standard boundary conditions at its external boundaries. 



 Any two mesh blocks cannot partially overlap each other. Either they do not overlap at all (linked) or one completely overlaps the other (nested). A linked block communicates with adjacent blocks via its boundaries while a nested block receives data from the containing block. A nested block can be nested in another larger mesh block, which may itself be nested in an even larger block, and so on. A nested block receives data from the containing block at its boundaries, and passes the data back to the containing mesh block in the whole real domain of the nested block. There are no specific requirements or limitations on how the meshes in adjacent or overlapping blocks must match at the boundaries. The inter-block mesh boundaries are defined automatically based on the relative location of mesh blocks. However, the following guidelines will help maintain good accuracy of the multi-block algorithm: Avoid having large differences in resolution between any two adjacent or nested blocks. A ratio of 2 to 1 in any coordinate direction should be considered as the maximum acceptable to avoid significant accuracy loss in inter-block data transfer. Avoid placing inter-block boundaries in flow areas where large gradients of solution quantities are expected. This includes areas with significant variations in geometry. When using nested blocks, user-defined mesh planes (lines, in two-dimensions) in the containing blocks should be positioned at the boundaries of the nested blocks. This should be easy to achieve since all mesh blocks are rectangular. Minimize the number of mesh blocks. Each new block introduces new boundaries, at which solution must be interpolated, produce additional truncation errors, and overhead storage and computations. By default, one mesh block is created in FLOW-3D and one corresponding boundary definition. To add more mesh blocks, select Meshing and Geometry > Mesh – Cartesian > Right click and select Add mesh block. After 



a block is added the user then has the choice of which block to modify by opening the block branch. The user can also create mesh blocks by choosing Meshing and Geometry > Mesh menu > Create. Then the user can click and drag on the screen to create a new mesh block. The view must be set to a two-dimensional view. Each new block also has boundary conditions that pertain to it. The boundary conditions for each block are controlled under the Boundaries tab by selecting the number matching that of the block. In the prepin file, the order of the mesh namelists in the input file defines the mesh block numbers that distinguish one block from another. The multi-block model does not require setting new variables. The multiple mesh blocks, and their boundary conditions, are defined by placing multiple successive entries for the namelists bcdata and mesh. Two types of pressure-velocity coupling are available: the Dirichlet and Neumann. In the Dirichlet-type boundary condition only pressure is passed between mesh blocks, while only velocity is passed for the Neumann-type model. The inter-block boundary type coefficient allows users to mix these two types of boundary conditions. The default value of this parameter is 0.25, in which case 25% of the normal velocity change at an inter-block boundary comes from its interpolation from a neighboring mesh block, and 75% from the interpolated pressure. The user can change this variable in Numerics > Pressure solver options > Convergence Controls > Inter-block boundary type coefficient. A Flow Science technical note on multi-block meshing can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN59R2.pdf. 
Non-Inertial Reference Frame Motion Non-inertial coordinate systems can experience non-zero linear accelerations and rotations. Activate the non-inertial motion model in Physics > Non-inertial RF. The user can select between a simple shake and spin model, harmonic oscillator or tabular input as specified in a data file, called MOVIN.<ext>, where the default file name extension is ‘INP’. 

 The file format is described in Smooth Tabular Motion. Rotations are measured in radians. 
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Impulsive accelerations can specified with tabular data. In this case, in addition to the impulsive accelerations in the MOVIN file, the impulsive motion input contains the duration of the impulse. The time-step size will be automatically adjusted during the simulation to resolve the impulse. Impulsive motion is added to the smooth, slow changing accelerations that are specified in the same tabular input file. 
 See Smooth Tabular Motion and Impulsive Motion. NOTE: CORIOLIS FORCES DUE TO ROTATION CAN BE ACCOUNTED FOR WITH DIFFERENT DEGREES OF IMPLICITNESS. THE DEGREE OF THE IMPLICITNESS IS PROPORTIONAL TO THE VALUE OF THE ACCIMP VARIABLE WHICH IS SET IN UNDER THE IMPLICIT/EXPLICIT SOLVER OPTIONS IN NUMERICS. WHEN ACCIMP=0.0, THE APPROXIMATIONS ARE FULLY EXPLICIT. A FULLY IMPLICIT ALGORITHM IS USED WHEN ACCIMP=1.0. IT IS RECOMMENDED TO USE THE FULLY IMPLICIT METHOD FOR BETTER SOLUTION STABILITY. 

Non-Newtonian Fluid 

 



The non-Newtonian model is activated in Physics > Viscosity and turbulence > Viscosity options. A non-Newtonian flow option allows the fluid viscosity to be a function of strain rate ( 00 0 1 2, , , ,  n and λ λ λ λ µ
∞

) and temperature (TSTAR, a, b, and c). The functional dependence built into the code is given in the Theory chapter. Selecting the proper coefficients allows the user to employ a variety of approximations for non-Newtonian fluid behavior (see also Thixotropic Fluids and Wall Slip). 

 When the non-Newtonian model is employed, the preprocessor will make two additional plots in the prpplt file. One is for dynamic viscosity vs. strain rate at a given temperature and the other one for viscosity vs. temperature at a given strain rate. Since it is difficult for the preprocessor to select the plot ranges and values of the strain rate and temperature at which to make these plots, users can define these settings using four so-called dummy variables in the XPUT section of the input file: DUM1 defines the temperature for which viscosity vs. strain rate will be plotted, and is also the center temperature value for the viscosity vs. temperature plot;  DUM2 defines the plot range, from DUM1-0.5*DUM2 to DUM1 + 0.5*DUM2, for the viscosity vs. temperature plot; DUM3 defines the strain rate for which viscosity vs. temperature will be plotted, and is also the center strain rate value for the viscosity vs. strain rate plot; DUM4 defines the plot range, from DUM3-0.5*DUM4 to DUM3 + 0.5*DUM4, for viscosity vs. strain rate plot. The default value for all four parameters is 100 when used for this purpose, i.e., when MUC1 > 0.0 and/or MUTMP1 > 0.0. NOTE: NON-NEWTONIAN FLUID FLOWS OFTEN OCCUR AT LOW REYNOLDS NUMBERS. AS A RESULT, THE TIME-STEP SIZE MAY BE CONTROLLED BY VISCOUS SHEAR STRESS IF THE EXPLICIT ALGORITHM IS EMPLOYED. TO AVOID THIS LIMITATION, 



WHICH MAY SIGNIFICANTLY SLOW DOWN THE SIMULATION, THE IMPLICIT VISCOUS ALGORITHM CAN BE USED INSTEAD BY SETTING NUMERICS > EXPLICIT/IMPLICIT OPTIONS > VISCOUS STRESSES > SUCCESSIVE UNDER-RELAXATION, LINE IMPLICIT OR GMRES. HOWEVER, CONVERGENCE MAY BE SLOW IF LARGE VISCOSITY GRADIENTS ARE PRESENT IN THE FLOW. 
Outflow Boundary Conditions 

 Outflow mesh boundary conditions can be used by selecting Continuative or Outflow for the corresponding mesh boundary. Mesh boundary condition settings for all mesh blocks are addressed via Boundaries. For a Continuative boundary, gradients of all flow parameters in the direction normal to the boundary are set to zero. If, however, flow tries to enter the computational region across this type of boundary, it must do so by starting from a zero velocity (stagnation) condition. The Outflow condition is another type of outflow condition that uses a Sommerfeld radiation condition to minimize the reflection of outgoing waves. An option is available at each outflow boundary to Allow fluid to enter an outflow boundary, which is useful primarily when modeling linear waves travelling through such boundaries. Since fluid travels in an elliptical trajectory in a wave, it is important to let the motion in both outward and inward directions at the outflow boundary to properly describe the wave behavior. See discussion of mesh boundary conditions in Theory. 
Rigid Body Dynamics Main variables: XPUT: IACCF   RBDATA: ALL VARIABLES  The rigid body dynamics model is activated by setting IACCF=2. In that case the RBDATA input section has to be present in the input file following the BCDATA section. See the Theory chapter for a detailed description of the model, its use and related input parameters. Related variables: MOTN: IATYPE, other variables  
Rotating Components Main variables: OBS: IFOB, OADRG, OBDRG, OSPIN, NOBLDS, OBLTHK  



Tangential velocities in the form of a pure rotation may be assigned to solid, axisymmetric components such as cylinders, spheres and cones. Velocity components must be tangential to the surface so that these components always occupy the same physical space. For solid or phantom component N to rotate it must be defined as a copy of a virtual component by setting IVRT(n)=1 and ICPY(l)=n, where l is the copy number. The virtual component must be defined as an axisymmetric object around the z-axis. A copy can then be turned into any desired orientation and translated to any spatial location using copy input data CTRNX(l), CROTX(l), etc. Only one copy is allowed when the virtual component has a non-zero rotation. Rotation is always specified about the z-axis by the variable OSPIN(t,n) in radians per unit time. Index t is used for specifying time-dependent rotational velocity, together with TOBS(t). To pass flow through the rotating region, as in an impeller, see Fan and Impeller Model. Related variables: XPUT: IWSH   OBS:  ICPY, IVRT, CTRNX, CROTX, and other copy-related variables 
Sediment Scour and Deposition The sediment scour model uses a number of equations which should be understood before attempting to calibrate the model to a data set. Details of the equations are given in Theory chapter as well as in Flow Science Technical Note TN-85. The model will usually produce reasonable trends when properly calibrated. It is unlikely to perfectly match experimental data since the model equations include many empirical simplifications. The scour model is activated in the user interface by selecting Physics > Sediment scour and specifying the number of distinct sediment species to be modeled. 

 The parameters can be set in the User Interface (shown above) or in the prepin file in name list SCALAR. The parameters are described below and in the Theory chapter. 
� Number of sediment species (NSSPC): must be greater than zero to activate the scour model. Up to ten species may be specified. 
� Maximum packing fraction (SCRFCR): the volumetric solid fraction (1 – porosity) of sediment at which the sediment packs (becomes a solid). Defaults to 0.64 (randomly packed uniform spheres). 0.50 to 0.80 is a typical range for sand and gravel mixtures. 
� Name (SSNAME): an optional specification for each species to aid in post-processing. Un-named species are labeled ‘sediment sp. 1’ through ‘sediment sp. 10’ in the results. 
� Diameter (SSDIA): the mean or effective diameter of the sediment species, with units of length. Can be approximated as the diameter of a sphere with volume equivalent to an average grain. Must be specified to run the model. 

http://www.flow3d.com/pdfs/tn/FloSci-TN85.pdf
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� Density (RHFSS): the microscopic (grain) density of the sediment, mass/length3. Defaults to 2.65 for quartz in CGS units. 
� Critical Shields Parameter (SSCRT): the dimensionless critical shear at which particle motion is first observed. There are a number of simplifications and approximations in describing sediment erosion as a function of the Critical Shields parameter. Scour is a stochastic phenomenon, so using an empirical parameter is unavoidable. Use site-specific values for best results. If no Shields parameter is specified, FLOW-3D will calculate the number from the Shields curve using the Shields-Rouse equation described in Flow Science Technical Note TN-85. Be aware that this equation is not valid for sediment diameters smaller than approximately 0.17 mm. Also be aware that the Shields curve itself may over-predict the shear stress required for incipient motion. The Critical Shields parameter will be modified cell-by-cell at every time step to account for multi-species hiding and exposure and bed slope. 
� Drag Coefficient (SSDFCD): the drag coefficient defaults to 0.5 for spheres. Engelund and Hansen (1967) suggested the value of 1.5 as appropriate for sand and gravel, and other typical experimental values are between 0.75 and 1.5. Sediment-specific values may be developed using the equations for combined Stokes and quadratic drag detailed in the Theory chapter. 
� Entrainment Coefficient (SSENTRF): the entrainment (alpha) coefficient controls the rate at which sediment erodes at a given shear stress higher than the critical shear stress. The entrainment coefficient can be used to scale scour rates or fit experimental data. The default value is 0.018 from data of Mastbergen and Von den Berg (2003). A value of zero turns off the entrainment model. 
� Bed Load Coefficient (SSBDLF): similarly, the bed load coefficient used in the Meyer-Peter-Muller equation controls the rate at which bed load transport occurs at a given shear stress higher than the critical shear stress. The default value is 8.0 following the original equation, and subsequent researchers have suggested values ranging from 5.0 for low transport to 13.0 for very high sand transport, with 5.7 a typically-reported value for sand and gravel (Ribberink 1998, Jaggi 1994, Fernandez Luque and Van Beek 1976). A value of zero turns off the bed load model. 
� Angle of Repose (SSANG): the angle of repose describes the maximum resting angle of the bed (typically between 30 and 40 degrees), and is used to modify the local critical Shields parameter. If the angle of repose is not specified, no adjustment is made to the critical Shields parameter. Define initial packed and suspended sediment regions as follows:  
� Initial Packed Regions: first create or import a geometric component (using any format that FLOW-3D recognizes, including topographic data) and set the component type to Packed sediment (on the Meshing & Geometry tab). Set the species mixture (volumetric fraction) under the Packed Sediment Fraction branch of the component properties. The fractions will be normalized to sum to 1, and the total volume fraction of the packed sediment will automatically be equal to the maximum packing fraction. 
� Initial Suspended Regions: enter mass concentrations (mass of sediment per unit volume of fluid) in the Meshing & Geometry > Initial tree. Fluid regions can also be assigned values that will override the global concentration. Define suspended sediment inflows as follows: 
� Suspended Sediment Entering at Boundaries: Select Sediment on the boundary dialog and define an inflow mass concentration (mass of sediment per unit volume of fluid) for each species, either as a constant or as a function of time (by selecting the Tabular button). 
� Suspended Sediment Entering at Mass/Momentum Sources:  Because of the way the mass/momentum source density is calculated, the inflow rate of sediment at mass/momentum sources requires variables that are combinations of physical parameters.  
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� Mass flow rate TVFR(n,t) is based on the density of clear water (Fluid #1) and the volumetric flow rate of the mixture: TVFR = (volumetric flowrate of mixture including solids, length3/time) * (density of fluid 1, RHOF, mass/length3). n is the mass/momentum source identifier, t is the time-number related to TOBS (use 1 for a constant flow rate). 
� Sediment concentration PQSRSS (n,i,t) is set manually in the prepin file (use Ctrl+E to edit it in the GUI): PSQRSS = (mass flowrate of solids in the mixture, mass/time) / (volumetric flowrate of mixture including solids, length3/time). n and t are as described above, i is the sediment species. 

� Suspended Sediment Entering at Mass Sources: In the same way, mass sources require a manual entry in the prepin file. 
� Mass flow rate QSROBS(m,t) is based on clear water (Fluid #1) as described above. m is the component number. 
� Sediment concentration QSRSS(m,i,t) is set manually in the prepin file as described above. Other factors which affect the accuracy of sediment scour simulations and should be accounted for are: 

� Turbulence Modeling: A good turbulence model should be selected when flow is non-laminar; the RNG model is recommended to try first with a user-specified TLEN. The dynamically-computed maximum turbulent mixing length relies on an algorithm developed for single-phase flow. The mesh should be suitably sized so that the near-bed velocity and shear stress calculations are correct. Details on this technique are given in the Wall Effects section. 
� No Bed Roughness: when calibrating your model, keep in mind that the packed sediment bed is defined as a zero-roughness surface with the global slip condition. By default this is no-slip; see the Wall Effects section. 
� Limitations of Included Models and User Customization: the governing equations of the sediment scour model are empirical, and thus validity for the data set they were derived from. There are numerous models for entrainment, hiding and exposure, critical Shields parameter, bed load, and angle of repose: a particular simulation may require a model that is different from the equations supplied with FLOW-3D. All of the scour functions are available for customization in the supplied editable modules scour_lift.F and scrersn.F. 
Shallow Water Flows The shallow water model can only be used in conjunction with the one-fluid, sharp interface flow model. Fluid depth must be reckoned in the z-direction. Define the mesh in the z-direction to have two cells, with the bottom cell having a height greater than any fluid height expected in the simulation. The cell height should not be too large, otherwise it will adversely affect vector and contour plots. Define initial fluid volume or elevation in Meshing & Geometry > Initial > Global > Fluid initialization. Users can also define fluid regions in Meshing & Geometry > Initial > Fluid Regions. Gravity acceleration in the z-direction needs to be specified in Physics > Gravity > z component using a negative number. The shallow water model is activated in Physics > Shallow water > Activate shallow water model. Under Flow type, users can define the flow to be Inviscid, Laminar or Turbulent. For laminar flow, Vertical viscosity multiplier is a correction factor for the bottom shear stress evaluation. It is a necessary parameter because the actual velocity profile in the vertical direction is usually nonlinear, which cannot be resolved in the shallow water approximation. The Vertical viscosity multiplier is designed to compensate for the lack of vertical velocity profile resolution. The default value is 1.5 which corresponds to a quadratic velocity profile in a steady-state shear flow. To use a different value of the Vertical viscosity multiplier, simply define it in its input box. 



 If the shallow water flow is turbulent, FLOW-3D uses the quadratic law for bottom shear stress calculation, 
b D
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� � �  where ρ is the fluid density, u� is the depth-averaged velocity and CD is the drag coefficient. CD is defined in Turbulent > Drag coefficient for bottom shear stress. The default value of CD is 0.0026, which is a typical value in hydraulic and coastal engineering applications. Users can select between implicit and explicit numerical methods for shallow water flow. The implicit method is the default and is the recommended method. It eliminates the restriction on the time step size imposed by surface waves and thus shortens the computation time. If the shallow water flow is also a geophysical flow (e.g., of the scale of an estuary or bay), then the Coriolis force due to the Earth's rotation is important. In this case, users need to activate the geophysical fluid flow option in Physics > Non-inertial reference frame > Motion type > Geophysical fluid flow and define Latitude of the flow region.  Wind shear on water surface may need to be considered in shallow water flows. It can be defined in Physics > Wind. See the Wind Shear Stress section for more information. 



Smooth Tabular Motion 

 Non-inertial reference frames are specified in tabular form when Physics > Non-inertial RF > Acceleration type > Tabular input is selected. When Tabular input > Options > Angular acceleration or velocity is chosen, then smooth (i.e., linearly interpolated) motion is specified in a text file shown in the Input file edit box, with the default name movin.inp. The data specified includes the time, x, y, and z linear accelerations, x, y, and z angular velocities, and x, y, and z angular accelerations. If Tabular input > Options > Angular velocity is chosen, the angular velocities are evaluated by integrating the angular accelerations, with the angular velocities specified at time zero being evaluated from the initial velocities. If Tabular input > Options > Angular acceleration is chosen, the angular velocities specified are differentiated to determine the angular accelerations. The first line contains an integer indicating the number of comment lines to follow. Next are the comment lines. This permits the user to annotate the file. This "header" is followed by the actual data, which are the time, 3 components of linear acceleration, 3 components of angular velocity, and 3 components of angular acceleration, all entered on one line per time. All components are entered x value, then y value, then z value. When reading the data using a free format read, there must be "placeholders" for all quantities, even if those quantities aren't used for the specified option. For example, for Tabular input > Options > Angular acceleration, angular velocities at all times must be entered, while for Tabular input > Options > Angular velocity all angular accelerations must be entered (these can be set to any value since they will be ignored). See Non-inertial Reference Frame and Impulsive Motion. NOTE: THE USER INTERFACE WRITES THE MOVIN FILE FOR THE USER AND AUTOMATICALLY USES THE CORRECT FORMAT. IT DISPLAYS THE DATA IN THE TABLE.  
Solidification Shrinkage Volumetric shrinkage occurs when a material solidifies and the density of the solidified material is greater than the density of the liquid (RHOFS > RHOF, where RHOFS is the solid density and RHOF is the liquid density). The shrinkage model, therefore, requires the Solidification model to be activated and both solid 



and liquid phase densities to be defined, RHOFS > RHOF, where RHOFS is the solid density and RHOF is the liquid density. Shrinkage can be modeled for one-fluid, sharp interface problems. There are two shrinkage models that can be used (see Theory). Selecting the Activate shrinkage model with flow effects button activates nvolves the solution of the full fluid and heat flow equations.  

 This shrinkage model may be CPU intensive, especially if long solidification times are considered. As an alternative, there is the Simple Solidification Shrinkage  model. The simple solidification shrinkage model is activated by setting Physics > Solidification options > Solidification shrinkage > Activate simple shrinkage model.  



 This model is based on the solution of the heat transfer equation only and runs quickly, especially in conjunction with the implicit heat transfer model (Numerics > Explicit/implicit options > Heat transfer > Implicit). Internal cavities open wherever there is no feeding path to a liquid volume. Feeding in both models is defined by computing the drag coefficient for flow in mushy regions. The drag function at every location in the mesh is computed as a function of the local solid fraction with a constant multiplier Fluids > Solidification properties > Other > Coefficient of Solidification Drag. The reciprocal value of the drag function can be visualized in spatial plots: the variable name for plotting this is 'drag coefficient'. While partial feeding due to large flow losses in the mushy region can occur in the DS model, the RSS model can have either complete feeding or no feeding at all. The latter occurs when the local solid fraction along the feeding path exceeds the critical value defined by Fluids > Solidification properties > Other > Critical Solid Fraction (default is 1.0). In addition, until the solid fraction everywhere in the metal in a liquid pocket has reached the Coherent Solid Fraction, feeding in the RSS model occurs from the top of the pocket. After that feeding occurs from the hottest spot in the pocket. Use Global > Finish condition > Solidified fluid fraction for the simulation to stop when all the fluid is completely frozen. The Global > Finish condition > Finish fraction may be used to stop the simulation when the fluid is a specified fraction solidified. NOTE: GRAVITY IS REQUIRED IN THE RSS MODEL TO DETERMINING THE FEEDING DIRECTION, AND SHOULD ONLY BE DIRECTED ALONG ONE OF THE COORDINATE AXES. IF MORE THAN ONE GRAVITY COMPONENT IS NON-ZERO, THEN THE LARGEST ONE IS USED TO DETERMINE THE DIRECTION OF FEEDING. 



Solidification The solidification model can be used when heat transfer is activated (Physics > Heat Transfer > Fluid internal energy advection) and fluid specific heat and conductivity are set. Only fluid #1 can undergo phase transformations. 

 To activate the solidification model set Physics > Solidification > Activate Solidification, and then specify the liquidus temperature, solidus temperature, and latent heat of fusion in Fluids > Solidification Properties branch. In the simplest model the latent heat is released linearly as the material cools from the liquidus to the solidus temperature. For a more complicated model of latent heat release, including heats-of-transformation in the solid phase, use the Fluids > Solidification Properties > Specific Energy Tables to define the release of the latent heat as a function of temperature. One can specify a list of consecutive temperature values and the corresponding values of the enthalpy. Enthalpy entry L in the table is the total enthalpy in the fluid between the temperature (L-1) and the temperature at L. See Theory for more details about this setup. 



 Solidification implies a rigidity and resistance to flow. This stiffness is modeled in two ways. For low solid fractions, i.e., below the point of coherency Fluids > Solidification Properties > Other > Coherent Solid Fraction, the viscosity is a function of solid fraction. For solid fractions larger than the coherent solid fraction, a D'Arcy type of drag force with a drag coefficient proportional to a function of solid fraction is used. A term, -Ku, is added to the right hand side of the momentum balance (see Momentum Equations), K is defined in equation (3.143) and u is the phase-averaged flow velocity which is also reported by the postprocessor.  If the solid fraction exceeds the point of rigidity, Critical Solid Fraction, the drag becomes infinite and there can be no flow with respect to the computational grid (for an exception, see Moving Solid Phase). The drag coefficient contains a factor Coefficient of Solidification Drag that users can adjust to modify the amount of resistance to flow. See also Macro-Segregation during Alloy Solidification. Use Global > Finish condition > Solidified fluid fraction for the simulation to stop when all the fluid is completely solidified. Global > Finish condition > Finish fraction sets the fraction solid value at which to stop the simulation. 
Surface Contamination during Casting In metal casting, it is possible for impurities on the liquid surface to be folded into the interior of a cast part as the liquid metal fills the mold. These impurities may result in a mechanical weakness in the final part. 



 Surface impurities can arise from oxide formation on the surface. In the lost foam casting process, surface impurities result from carbon residue remaining after the melting or vaporization of foam by metal. If metal surfaces fold over or collide during the filling process, any impurity on the surface will then be trapped in the interior of the metal. The surface defect prediction algorithm in FLOW-3D consists of a source term for oxide formation, which is proportional to the surface area and exposure time. For lost foam generated defects the source is proportional to the amount of degraded foam. A transport equation is used to track the movement of defect material with the flowing metal. Defects are tracked using the defect tracking model. It is activated in Physics > Defect Tracking by selecting Track free surface or Lost foam defects. Oxide generation at free surfaces is governed by the Oxide generation rate. Lost foam residue formation is controlled by the Foam residue generation rate. Each of the two variables defaults to one. The actual magnitudes of the generation rates are unimportant, especially in the absence of experimental data quantifying the production of the contamination at the surface. The distribution of the contaminant in the filled mold can be interpreted as the distribution of the probability of defects. For example, locations of local maximums of the oxide defect concentration are more likely to be the locations of defects. An additional defect-tracking variable can be used in the lost foam model to track lost foam residue that attaches, or wicks, to mold walls and cannot be moved by the liquid metal flow. These stationary defects are described by activating Allow residue wicking into mold. These defects are converted to the stationary defects near mold walls at a rate defined by Residue wicking. Surface contaminants can only be tracked in flows with sharp fluid interfaces. See also Air Entrainment. NOTE: IN THE CURRENT MODEL, SURFACE CONTAMINANT CANNOT ESCAPE THROUGH THE SURROUNDING MOLD MATERIAL. 
Surface Tension Surface tension can be modeled in one and two fluid flows with a sharp interface. The model is activated in Physics > Surface tension. The surface tension coefficient can be set in Physics > Surface tension > Surface 



tension coefficient or Fluids > Surface Tension > Surface Tension Coefficient. The static contact angle with components and mesh walls can be defined at Physics > Surface tension > Contact angle or Fluids > Surface Tension > Contact Angle. In addition, a separate static contact angle for each component can be specified using the Meshing and Geometry > Component tree > Surface properties > Component contact angle, which otherwise defaults to the contact angle on the Physics or Fluids tab. The contact angle variables take values between 0.0 (complete wetting) to 180 degrees (completely nonwetting). 

 The default setting is a contact angle of 90 degrees. If surface tension is activated, wall adhesion is also activated; it is no longer possible to turn off wall adhesion at certain components. All fluids exhibit adhesion behavior at solid surfaces, and it is necessary to specify a contact angle representing that behavior, whether the behavior is wetting or non-wetting. 
 Surface tension coefficients can also be a linear function of temperature according to = SIGMA - CSIGMA*(T - TSTAR), where T is temperature, TSTAR the reference temperature and CSIGMA the linear term coefficient. It is entered on either the Physics > Surface tension dialog box or the Fluids > Surface Tension branch. To use the temperature-dependent model it is necessary to activate heat transfer in the fluid (Physics > Heat transfer > Fluid internal energy advection). In flows with substantial free-surface distortion and breakup, small droplets of fluid may be generated due to occasional numerical noise in surface tension pressures. These droplets may cause undesirable variations in surface pressure distribution due to their small surface curvature. Some droplets can be removed to reduce these numerical inaccuracies. This option is controlled by the Fluid fraction cleanup variable defined in Numerics > Volume-of-fluid advection > Advanced options. A positive value for this parameters activates 



the fluid fraction cleanup option. If the fluid fraction values in a cell and its neighbors are less than this value, then fluid will be removed completely from that cell. The removed volume is recorded as the cumulative volume error and plotted at the end of the simulation as a function of time; this shows if the FCLEAN option is leading to any significant change in fluid volume. The default value of FCLEAN for two-fluid surface tension problems is 0.05. For all other problems it defaults to zero. NOTE: THE SURFACE TENSION MODEL IS MORE SENSITIVE TO MESH IRREGULARITIES THAN OTHER MODELS IN THE CODE BECAUSE IT DEPENDS ON CURVATURES, I.E., SECOND DERIVATIVES. IT IS RECOMMENDED TO USE CONTROL VOLUMES AS CLOSE TO CUBES IN SHAPE (SQUARES IN 2-D) AS POSSIBLE. 
Temperature Regions Temperature regions are defined in the Meshing and Geometry tab under the Initial tree. To add a Temperature region, right click on Temperature regions under Initial and select Add a temperature region. 

  Next, define the spatial extents of the temperature region by entering the appropriate information into the tree under limiters.   The input variables TCC, TCX, TCY, TCZ, etc., are used to define a spatially varying temperature within the region. Use ITDIS to indicate whether the function variables apply to fluids or components within that region. Note that the use of temperature functions and the associated variable ITDIS is incompatible with the use of TREG or TWREG. Specifying ITDIS in the input causes the preprocessor to ignore TREG or TWREG, and use only TCC, TCX, TCY, TCZ, etc.  Example:  The following namelist describes a linear variation in component temperature in the z-direction, T=500 at Z=0.5 and T=250 for z=0.0. Additionally, this linear variation is limited to x < 0.5, and extends to the limit of the mesh in the y-direction.  
$temp  

ntmp=1,  

xh (1)=0.5, tcc(1)=250, tcz(1)=500., itdis(1)=2,  

$end  

 

Thermal Die Cycling Thermal die cycling is activated by specifying the total number of thermal cycles, (Physics > Thermal die cycling > Total number of cycles). There is no limit on how many cycles can be modeled in one simulation. Each cycle can then be divided in up to 10 segments. Each segment is characterized by a temperature on the die cavity surface, (Physics > Thermal die cycling > Temperature in the die cavity) and a heat transfer coefficient between the die and the ambient medium, (Physics > Thermal die cycling > Heat transfer 



coefficient at the die cavity surface, e.g., metal, air or spray liquid. Next, define the time interval (Physics > Thermal die cycling > Duration as cycle segment) or segment N, which will be the same within each cycle. The sum of all segment time intervals defines the total time of a cycle. The first cycle segment always describes the cooling of the metal before opening the die, and all subsequent cycle segments assume that the die cavity is empty of metal. The metal is placed into the die cavity at the beginning of each cycle at a uniform temperature specified by the first entry in the table. This can be accomplished by adding a pointer, (Initial > Add fluid pointer) which is located anywhere inside the die cavity, and then setting fluid fraction at the pointer equal to 1.0. 

 No fluid flow is modeled in a die cycling simulation. The uniform initial fluid temperature is set in Initial. It defaults to the temperature set in the first segment of the first thermal die cycle if the latter is set, otherwise the temperature of the first segment defaults to the initial fluid temperature. The specified values of heat transfer coefficient to fluid 1 for a component are only used during the first cycle stage. At later stages the heat transfer coefficient in the die cycling table is used instead of component values. The first value of heat transfer coefficient in the table serves as the default for fluid to die component heat transfer coefficient.  It is recommended to use the implicit heat transfer algorithm, by setting Numerics > Explicit/implicit options > Heat transfer > Implicit (also found on the Physics > Heat transfer) for faster simulations (see Computing Temperatures). The time-step size and the convergence parameters will be dynamically adjusted to achieve the optimum speed of the simulation and accuracy of the results. The values of the TEDIT and TDTMAX arrays are set automatically to control the time-step size during each segment of a die cycle during the 



calculation. The only control that can be imposed by the user is by further limiting the time-step size in Numerics > Maximum time step. The default values of the time intervals for the History data output, HPLTDT, and short prints, SPRTDT, are set to 1/10 and 1/5 of the smallest cycle segment duration. The user can overwrite the default values in the Output window. Most of the Restart data edits are done in the last thermal die cycle, where the solution is supposed to be at steady-state and, therefore, most interesting to the user. There are three factors controlling the spatial output in the thermal die cycling model: One per cycle restart data edit defined in Physics > Thermal die cycling > Number of die cycles at the end… A restart data edit is made at the end of these die cycles. This allows the user to track the results from cycle to cycle and also make restart calculations. Additionally, restart data is automatically saved at the end of each segment during the last die cycle. These data edits allow the user to track the changes in die temperature during the main stages of the process. Finally, restart data can be saved at user-defined intervals during the last die cycle. The output frequency is controlled by the output logic defined in Output > Restart data. The output frequency during the first segment of the cycle can also be based on solidified fraction. NOTE: IF GLOBAL > FINISH TIME IS NOT SPECIFIED IT WILL DEFAULT TO THE TOTAL TIME REQUIRED TO RUN THE SPECIFIED NUMBER OF CYCLES. THE SIMULATION WILL STOP WHEN GLOBAL > FINISH TIME IS EXCEEDED OR THE REQUIRED NUMBER OF CYCLES ARE COMPLETED (WHICHEVER EVENT OCCURS FIRST). 
Thixotropic Fluids Apparent viscosity in a thixotropic fluid is a direct function of time. The time-dependency is described in FLOW-3D in terms of thinning and thickening rates which control the speed at which the apparent fluid viscosity approaches the local steady-state value. The steady-state viscosity is typically a function of shear rate and possibly temperature. When the steady-state viscosity is greater than the apparent viscosity, the latter will increase at this point in the flow at the thickening rate. Conversely, the apparent viscosity will decrease at the thinning rate when it is greater than the local steady-state viscosity. 



 The thixotropic viscosity model is activated by selecting Physics > Viscosity and Turbulence > Thixotropic viscosity. There are two constants for the rate of relaxation by thinning, Fluids > Properties > Viscosity > Thixotropic > Constant Thinning Rate (MUTHN0), and thickening, Fluids > Properties > Viscosity > Thixotropic > Constant Thickening Rate. The rate of thinning can be strain rate dependent if the Strain Rate Dependent Thinning Rate (MUTHN1) coefficient is defined: 
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 ∂ ∂   The constant thinning rate and thickening rate have the dimension of reciprocal time, while the strain rate dependent thinning coefficient is dimensionless. All rate coefficients default to 0.0. Define a non-Newtonian viscosity model that approximates the desired material behavior under steady conditions. Use Fluids > Viscosity to define an initial and inlet boundary value of the fluid viscosity MUI. 



 The implicit viscous algorithm may need to be employed (Numerics > Explicit/implicit options > Viscous stress > Implicit > Successive under-relaxation, or Line implicit, or GMRES) to avoid very small time-step sizes required by the explicit algorithm for very viscous flows. See also Wall Slip. 
Transport of Heat in Fluid 

 



Fluid internal energy advection must be activated before any other heat transfer option can be employed. There two advection options available. The default First-order method is efficient and robust and is suitable for most heat transfer problems. The Second-order monotonicity-preserving is appropriate in situations where resolving temperature gradients is of primary importance, for example, in buoyancy-driven flows. Energy transport in fluids is activated by setting Physics > Heat transfer > Fluid internal energy advection (see Energy Advection). The default setting is no energy transport in fluids. For fluid/component heat transfer see Heat Transfer and Conduction in Components. 

 NOTE: NO ENERGY TRANSPORT IS ALLOWED IN ONE-FLUID PROBLEMS WITH PHYSICS > DENSITY EVALUATION > SOLVE TRANSPORT EQUATION ACTIVATED. 
Turbulence Five choices for viscosity evaluation (turbulence closure) are available in FLOW-3D. Select the desired evaluation in Physics > Viscosity and turbulence. All models require the viscosity model to be activated and a positive value of the dynamic viscosity. Enter viscosity for fluid #1 (and fluid #2, if present) in Fluids > Properties > Viscosity after first activating viscous flow. 



 See the Theory chapter for details on each of these models.  If no initial or boundary conditions for turbulence are specified, then the initial and boundary values of the turbulent kinetic energy are set by the program to small values—physically, this represents laminar flow. If the inflow is truly turbulent, then, as a rule of thumb, the upstream flow turbulence level is set assuming turbulent velocity fluctuations in the undisturbed flow equal to 10% of the mean flow velocity. For example, for a mean upstream velocity of 20 m/s, the magnitude of the turbulent fluctuations of the velocity, u’, is 2 m/s and the boundary value of the turbulent kinetic energy is ½*u’*u’= ½*2*2=2 m²/s². Program defaults are used to set the coefficients which appear in the turbulence models. The value of these coefficients may be changed as necessary, although it is not generally recommended. The Turbulent mixing length should be set by the user for the one-equation turbulent energy model since the default value, 0.07 of the smallest domain dimension (excluding any mesh direction which has only 1 cell), may not be always suitable as it does not include geometry effects or the actual flow field scales. This variable describes the characteristic size of the turbulent eddies present in the flow and is used to define the maximum allowed value of the turbulent viscosity coefficient. 



A Maximum turbulent mixing length is used by the two-equation k-ε and RNG turbulence models to limit the turbulent dissipation ε so that the turbulent viscosity does not become excessively large. This value is computed automatically as a function of time and location during simulation if the option Dynamically computed is selected from the Fluids > Properties > Viscosity window (see above). Alternatively, the user can prescribe a value of the maximum turbulent length scale by selecting Constant and providing a value in the adjacent edit box. The larger the Maximum turbulent mixing length, the smaller the turbulent dissipation may become during the simulation. Since turbulent dissipation appears in the denominator of the equation for the turbulent viscosity, the latter can become large as well, especially in flow regions with small rates of shear. Conversely, smaller values of Maximum turbulent mixing length will result in smaller turbulent viscosity and, therefore, lead to excessively damped out turbulence. For example, in a spillway simulation, the length scale used to compute Maximum turbulent mixing length could be the depth of the flow over the spillway. In a high pressure die casting, the length scale could be the smallest width of the runner. For flows in pipes and ducts, the length scale could be the hydraulic diameter of the flow channel. Once the length scale is determined Maximum turbulent mixing length is computed as 0.07, or 7%, of the length scale. At inflow boundaries, the user can specify turbulent kinetic energy and dissipation directly. If a value is provided for the turbulent kinetic energy, but not dissipation, then a value for the dissipation will be automatically computed based on the value of Maximum turbulent mixing length defined in the edit box. Note that the formulation used for the viscosity evaluation may be changed at program restarts (see Restart Options: Heat Transfer, Scalar Advection, Turbulence). It is not recommended to use an implicit viscous algorithm with turbulence models that involve a solution of turbulent transport equations (k- ε, RNG, or one-equation turbulent energy) since the viscous diffusion terms in these equation are always approximated explicitly. 
Two-Fluid Flow For two-fluid problems, set Global > Number of fluids > Two fluids. Fluid #1 is described with the unit value of the fluid fraction, F=1.0. Regions where F=0.0 are filled with fluid #2. Values of the fluid fraction between zero and one describe a mixture of the two fluids in terms of the volume fraction of fluid #1. 

 Properties of each of the fluids, e.g., density and viscosities, are set in the Fluids section of the input file. The variables names are labeled with 1 or 2 to distinguish between those related to fluid #1 and #2. Heat transfer coefficients for fluid/component can be set separately for each fluid in Meshing and Geometry > Component > Surface properties. Cross baffle heat exchange can be set in Meshing and Geometry > Baffles > Specific Baffle > Heat Transfer Properties. The value of the fluid fraction at open mesh boundaries determines the two-fluid mixture at these boundaries: the value of 1.0 defines fluid #1 at the boundary, while the value of 0.0 defines fluid #2. A fractional value signifies a mixture in terms of the volume fraction of fluid #1. 



In two-fluid models, either sharp interface between the two fluids is expected or the fluids are miscible. In the latter case the fluids may intermix with each other due to fluid advection and diffusion. Specify the type of interface in Global > Interface tracking. Only fluid #1 can have liquid/solid phase transformations (solidification). Fluid #1 is always incompressible, while fluid #2 can be either compressible or incompressible as defined by the Global > Flow mode selection. There is only one velocity value in each computational cell. When densities of the two fluids differ greatly, i.e., roughly by more than a factor of 10, and viscous boundary layer at the interface is thin (less than a cell size), this mixture velocity may not adequately represent the flow, since velocities of each of the fluids in the same cell can be very different. As a consequence, slip conditions between the fluids are not modeled accurately, which may result in an incorrect fluid interface motion. When modeling two fluids with fluid #1 heavier than fluid #2 by more than a factor of 10.0, separated by a sharp interface, and with the viscous boundary layer at the interface much thinner than the cell size, the Two-fluid interface slip model may help to obtain more accurate results. This model improves the momentum coupling at the interface between such fluids. Two-fluid interface slip model is activated on the Numerics panel. 
 NOTE: NO VOID REGIONS CAN BE MODELED WITH TWO-FLUID MODELS SINCE ALL OPEN SPACE COMPLEMENTARY TO REGIONS OCCUPIED BY FLUID #1 ARE FILLED WITH FLUID #2. 

Valves Valves in FLOW-3D can be used to vent adiabatic bubbles to the outside of the domain. This type of valve is defined in terms of its spatial location, the pressure in the external region, and a coefficient that controls the flow rate through the valve. Valves are defined on the Meshing & Geometry tree under the Valves tree. To create a new valve, right click on Valves and select Add a valve. 

 A prerequisite for valves is that the Adiabatic Bubble model be active.  If it is not active, it can be activated during the valve creation process.  Additionally, gamma must be set and the void pressure must be set to atmospheric.  These values can also be specified during the valve creation process. 



 Once the valve has been created, its location and properties can be entered into the tree. 
 The gas valve model is based on the standard formulation: 

  Flowrate =AY C
p pref

ρ

−
•  Here pref is the external reference pressure, p is the bubble pressure, and ρ is the density of the bubble gas. The multiplicative coefficients are: cross sectional area A, loss coefficient C and compressibility factor Y. As used in FLOW-3D, the reference pressure in the external region is defined in Initial > Add valve > Valve external pressure. All the coefficients as well as the gas density are combined into a single variable VALC(m), found in Initial > Add valve > Valve loss coefficient, so that the gas flow rate for valve m is computed as 

Flowrate = ( ) ( )VALC m p VALP m⋅ −  Here, VALP(m) is the reference pressure for valve m. Each valve is represented by a point source/sink in the domain. In Cartesian coordinates, the valve location are the x, y and z locations, respectively in Initial > Add valve > X, Y, Z location. In cylindrical coordinates, X is the radius, Y is the azimuthal position in degrees, and Z remains the height. If the loss coefficient is negative, the valve pressure is treated as a flow rate to the void where the valve is located, rather than computing the flow rate. Valve pressure can be negative and positive. Multiple valves of both kinds can be present together in the same void. 



 The valve model only works in conjunction with the Adiabatic Bubble model. Gas can leave or enter the bubble depending on whether the bubble pressure is greater or smaller than the reference pressure. A bubble can have more than one valve in it. If there is fluid in the cell, then the valve is assumed to be closed. 

 
Vaporization at Free Surfaces In one-fluid, free-surface problems, the effects of vaporization at the free surface can be modeled in terms of a constant saturation state defined for void regions. Select Physics > Bubble and phase change models > Constant pressure bubble with vaporization to activate this model. The Saturation Temperature in Fluids > Properties > Phase Change defines the saturation state of the vapor in the void regions. The latent heat of vaporization is specified in Fluids > Phase change > Latent Heat of Vapor. 



 The fluid energy equation (heat transfer) must be solved in conjunction with this model (Physics > Heat Transfer). Define a positive value of the Accommodation coefficient, found in Fluids > Properties > Phase Change. If the temperature of the liquid at a free surface is greater than saturation temperature then the liquid will evaporate at a rate given by: 
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Γ =  In this expression clhv1 is the latent heat of vaporization, Asur is the effective surface area for phase change, thc1 is the thermal conductivity of the liquid, Tl is the liquid temperature at the surface, and h is a characteristic length for heat conduction in the liquid at the surface defined in terms of a Prandtl number, 
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=  The quantity delmn is the minimum cell size for the computational grid. The variable tv1 is the constant vapor saturation temperature. Finally, rsize is an Accommodation coefficient that is used to control the rate of evaporation. This value is typically in the range 0.01 to 0.1 and should not exceed 1.0. 



 The evaporative mass flux in each surface cell can be saved for postprocessed by selecting Physics > Bubble and phase change models > Output phase change mass flux. Vaporizations may take place only in cells containing free surface. The vapor saturation temperature is the same and constant for all voids, both with constant and variable pressure. 
Vaporization Residue Main variables: SCALAR: IRESID, RMXSC  XPUT: IPHCHG When a liquid solvent evaporates any solute that it contains becomes more concentrated. Likewise, in FLOW-3D, solutes modeled with a scalar concentration variable will automatically be concentrated by evaporation at free surfaces of one-fluid problems. If a surface element is less than half filled with liquid, then the concentration of the scalar will also occur in the principal neighbor of the surface element to the extent that the concentration change is spread over a region equal to half the thickness of the surface element. If enough evaporation occurs and the solute becomes dense, it may result in a surface skin or a residue may form on a solid surface if the solute evaporates completely away. Residue formation can be simulated in conjunction with the Constant pressure bubbles with vaporization (IPHCHG=1) and Thermal bubbles with phase change (IPHCHG=5) models that are activate in Physics > Bubbles and phase change. The residue model is activated by setting IRESID=1, and defining a maximum packing density for the solute scalar m, RMXSC(m). Once the solute is concentrated to its maximum packing density, then any further concentration results in a residue that is fixed (not moving). If more than one scalar solute is present then the residue records the total of all solute contributions to the residue. For more about evaporation refer to Condensation/Evaporation. Solute scalar quantities can be added in Physics > Scalars. 
Viscosity Output Fluid viscosity is automatically saved for postprocessing whenever it is a function of other variables such as, temperature, strain rate or turbulence. Conversely, when viscosity is constant, for example, in a laminar flow of a Newtonian fluid, it is not generally available for postprocessing. The user can override the default behavior by requesting Fluid Viscosity in the Special output section of the Output tab. This function is 



particularly useful when the FORTRAN routine MUCAL, where fluid viscosity is computed, has been customized. 

 
Viscous Heating Viscous heating model can be turned on by checking Physics > Viscosity and turbulence > Activate viscous heating. Note that Viscous laminar flow must be activated first. See Theory for details of the model. This option requires heat transfer to be activated. 



 NOTE: ONLY USED IF A NON-ZERO DYNAMIC VISCOSITY OF A FLUID IS DEFINED IN THE FLUIDS SECTION OF INPUT. 
Volume Flow Rate (VFR) Boundary Condition It is often convenient to be able to specify a volume flow rate into a domain rather than a velocity. For example, if the user knows volumetric flow rate of water entering the domain, it is easier to simply specify flow rate on a boundary rather than being required to determine the open area on each boundary in order to determine the velocity necessary to achieve that flow rate. The VFR boundary was developed to serve this purpose. Compatibility: A VFR boundary condition is nearly identical to a Velocity Boundary Condition with the only difference being that volumetric flow rate is specified instead of a velocity. All physical models are compatible with a VFR boundary condition. If a fluid elevation is set at a VFR boundary, the flow will be distributed over the wetted area. However, a fluid elevation can only be set on vertical (X-min, X-max, Y-min, Y-max) boundaries. At the top and bottom boundaries, the flow will be distributed over the entire open area. 



Inputs Required Optional Volume Flow Rate Time-Dependent Volume Flow Rate  Direction Vector  Fluid Elevation (Vertical Boundaries only) Specifying a VFR Boundary On the Model Setup tab, select Boundaries. Choose the boundary you wish to specify as VFR. Select the Volume Flow Rate radio button. This changes the dialog so that the options for a VFR boundary condition are displayed as shown below. 

 Volume Flow Rate Options: The minimum input for a VFR boundary condition is the volume flow rate which can be either constant or time dependent. 

 Flow Direction Options: If the direction vector is not specified, the flow direction will be normal to the boundary. To specify cross flow, enter the appropriate x, y, and z direction vectors. 



 X flow direction vector = cos(α) ;α = angle between flow direction and x-axis Y flow direction vector = cos(β); β= angle between flow direction and y-axis Z flow direction vector = cos(φ); φ = angle between flow direction and z-axis F fraction Setting the F fraction= 1.0 will bring Fluid #1 into the domain. A fluid fraction less than 1.0 will bring a mixture of fluid #1 and fluid #2 (or void) into the domain. 
 Fluid Elevation The Fluid Elevation on the vertical boundaries may be specified as either constant or time dependent. If no value of fluid elevation is specified, the flow will be distributed uniformly over the open area on that boundary. The Fluid Elevation of the free surface at the boundary is measured in the mesh coordinates. This elevation will be maintained throughout the simulation. Example: 



Specify an inflow of 50 m3/second rotated 30o about the Z-axis with a depth of 0.35 meters on the Minimum X boundary. Also specify an inflow of 50 m3/second rotated -30o about the Z-axis with a depth of 0.25 meters on the Maximum X boundary. 

 On the Boundaries tab of the Model Setup panel, enter the following data for the X Min and X Max boundaries. X Min Boundary  Select Volume Flow Rate Radio Button   Enter 50.0 in Volume Flow Rate box  Enter 0.866 (cos(30o)) in X Flow Direction Vector 0.866 (cos(60o)) in Y Flow Direction Vector  Enter 3.5 in Fluid Elevation box  X Max Boundary  Select Volume Flow Rate Radio Button  Enter 50.0 in Volume Flow Rate box  Enter 0.866 (cos(210o)) in X Flow Direction Vector Enter -0.5 (cos(240o)) in Y Flow Direction Vector  Enter 0.25 in Fluid Elevation box  
Volume of Fluid Initialization When initializing one fluid with free surface in a complex geometry it can be difficult to compute where the surface of a given volume of liquid is initially located. A specific volume can now be entered when the liquid surface is flat and perpendicular to the gravity vector specified in Physics > Gravity > x, y, z components. The volume is entered in Initial > Volume options > Volume. 



 This option only works when there are no initial fluid regions. An iteration process is used to initialize the fluid to within 0.5% of the requested value. The volume of liquid resulting from the iteration is given in the preprocessor report file and in the solver summary and message files at the beginning of the simulation. NOTE: GRAVITY MUST BE DEFINED AND THE REQUESTED VOLUME MUST BE LESS THAN THE TOTAL OPEN VOLUME IN THE MESH. THE MODEL IS NOT APPLICABLE TO CONFINED, ONE-FLUID FLOW, ITB=0 AND NMAT=1. 
Wall Effects: Slip, Shear, and Component Roughness When fluid moves around or through a solid body, the flow encounters resistance that depends upon the flow velocity, turbulence, and the roughness of the bounding surface. The effect of these boundary flows results in additional shear stress, drag, and (in the case of sediment beds) erosion. Modeling these wall (or boundary) effects requires attention to the slip-condition of the surface, the surface roughness, and a mesh size that adequately resolves the near-wall velocity profile. Approaches to modeling each of these parameters are detailed below. Wall Slip Slip describes the presence of flow velocity directly against a boundary to the flow. In general, surface conditions are described as “no-slip,” “partial-slip” and “free-slip.” Free-slip surfaces are surfaces at which there is no change in the velocity profile, and are often used to describe the interface between two fluids (like water and air) that differ by more than an order of magnitude in density. Partial-slip boundaries describe a partial reduction in fluid velocity at the boundary, and may be used to describe, for example, oil flow in pipelines with emulsified coatings inside the pipe. By the far the most common type of boundary condition are no-slip boundaries, which describe nearly all fluid/solid interfaces. Viscous boundary conditions on geometry components and mesh walls include a slip velocity which is linearly proportional to the wall shear stress (see Theory for details). The coefficient of proportionality is the friction coefficient, which applies globally to solid components with unspecified friction coefficients as well as wall-type domain boundaries. The global coefficient can be specified on the Model Setup > Physics tab > Viscosity and Turbulence dialog > Wall Shear Boundary Conditions > Friction Coefficient (FRCOF). The global friction coefficient applies to all wall-type boundaries. 



 Component-specific friction coefficients that override the global value can be defined: Model Setup > Meshing & Geometry > Geometry tree > Component > Surface Properties > Static Friction Coefficient (OFRCOF). 



 As the friction coefficient approaches infinity, the wall slip velocity approaches zero (no-slip). To avoid specifying an arbitrarily large value, the no-slip option is activated by defining a negative value of friction coefficient. A finite, positive friction coefficient results in a partial-slip boundary. Zero specifies a free-slip boundary condition. By default, FRCOF = -1.0 so all unspecified components have no-slip surfaces. No-slip and partial-slip surfaces require dynamic viscosity, defined under Model Setup > Fluids > Properties > Fluid # > Viscosity. Wall Shear Wall shear stresses are modeled by assuming a zero tangential velocity on the portion of any area closed to flow. This zero tangential velocity is modified at mesh boundaries with tangential velocities and for the surfaces of moving objects. Wall shear stresses are calculated when Viscous Flow is activated on the Model Setup > Physics > Viscosity and Turbulence dialog, and a positive fluid viscosity MU1 is specified on the Model Setup > Fluids tab. Shear stresses are calculated automatically (but not automatically output) for no-slip and partial-slip components (i.e. with non-zero friction coefficients) unless the component surface roughness coefficient (ROUGH) is a negative number. Shear stress can be output by selecting Activate Shear Stress on the Model Setup > Output > Activate Shear Stress and specifying Global Critical Shear Stress = 0.  Component specific shear stress can be output by selecting Pressure and Shear Force Output under the Output tree for the component of interest. 



 Closely related to shear stress is strain rate, which can be added to Restart and Selected Data output by selecting Model Setup > Output > Additional Output > Strain Rate. Accurately modeling shear stress, strain rate, and the near-wall velocity profile requires that the mesh be adequately resolved. The first cell adjacent to an obstacle surface is where the logarithmic or laminar wall velocity profile is applied. The cells along the surface are either normal to the surface, if the surface is on a gridline, or they contain the wall surface. If the flow is laminar (as set in the Viscosity and Turbulence physics dialog) the velocity profile is calculated via direct differentiation. The cell average velocity will always be correct, and the velocity profile is better resolved as the mesh is refined. The optimal cell size depends only on the required profile accuracy and the tolerated computational time, both of which increase as the cells get smaller.  If a turbulence model is active, the first cell near the obstacle always gets its velocity according to a logarithmic profile corresponding to the log-law region shown below. The first cells along the wall should be sized so that they include the viscous sub-layer and end well within the log-law region of the boundary layer. If the first cell outer edge falls in the viscous sub-layer or extends into the outer, or free-stream, region, then the calculated near-wall velocity and shear stress deviate from the physical case, where they do not correspond to the log-law relation.  

 Finding a good range of cell sizes is a matter of estimating the height (thickness) of the boundary layer regions normal to the solid surface. A helpful value for this is the non-dimensional normal distance from the wall y+, sometimes referred to as the viscous length and illustrated in relation to dimensionless velocity u+ above. In the equations below, uτ is the shear velocity, τw is the shear stress on the solid, y is the normal distance from the solid, ρf is the fluid density, and μf is the fluid dynamic (molecular) viscosity.   In order to estimate y+, the shear stress τw must be estimated manually, and the interested reader is referred to the hydraulics literature for help with this. In general, y+ (as a function of the cell size) should be greater than 30 (where the inner layer transitions smoothly into the log-law region) and less than a value f
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that depends on the Reynolds number of the flow and the thickness of the boundary layer (generally 100 to 500 is a reasonable upper limit). When manual estimation of τw is impossible, multiple simulations can be used to iterate toward a ‘best fit’, where the observed value (shear stress or velocity) levels off. The approximations used to calculate parameters at solid surfaces assume that flow is fully developed, and caution should be exercised when interpreting the results for undeveloped flows. If the component surface matches the direction of the gridlines then fixed points should be used at the surface itself and at the appropriate distance from the surface (so that the first cell distance y meets the y+ criteria just explained). If the obstacle surfaces are not parallel to the mesh gridlines, use nested mesh blocks where appropriate so that the cells nearest the surfaces are adequately sized. Keep in mind that these guidelines may need to be ignored for simulations where cubic cells are necessary (as when surface tension is to be modeled). Component Roughness Wall shear stresses at component surfaces can be modified by defining surface roughness. Roughness has the dimensions of length, and is incorporated into the usual shear stress calculations by adding to the molecular viscosity the product of fluid_density*roughness *relative_velocity, where relative_velocity means the difference between the local fluid velocity and the wall velocity (usually zero). In this implementation the wall shear stress with the laminar flow model is equal to ρ(ν +k u) u/δy, where k is the roughness. When the roughness is large enough, the stress is proportional to ρu² (k/δy). In the turbulent flow model, the law-of-the-wall relation retains the same form as for a smooth wall, except the change in viscosity (i.e., from ν to ν + k u) automatically converts the logarithmic dependence from a characteristic length scale defined by ν/u to k, when k is the larger of the two characteristic lengths. To make sense in a numerical simulation, the roughness should be smaller than the grid cell size at the component boundary, although larger values can be used. The rough component should be assigned a no-slip surface (via a negative static friction coefficient). In FLOW-3D, the roughness variable k (ROUGH) can be set individually for each component under Model Setup > Meshing and Geometry > Geometry > Component # > Component Properties > Surface Properties > Surface Roughness. 



 ROUGH is defined as the average height of uniformly-distributed surface roughness elements, such as the roughness referenced in Moody diagrams. If the actual surface is uniformly rough, this height can be applied directly, but if the surface is non-uniform then an equivalent roughness value must be selected that will provide accurate results. For example, the common Manning’s equation relating mean velocity, hydraulic radius, and hydraulic slope uses an equivalent roughness parameter (Manning’s n) that can be converted to ROUGH when the hydraulic radius associated with the Manning’s coefficient is known. Manning’s equation is given as:  V is the mean flow velocity in a channel or conduit, Rh is the hydraulic radius (fluid cross-sectional area divided by the wetted perimeter), S is the hydraulic slope of the flow, typically (and often incorrectly) assumed to be the physical slope of the conduit or channel, 1.49 is a conversion factor so that all other units are in the meters/kilograms/seconds (SI) system, and n is the Manning’s roughness. For non-uniform surfaces, the equivalent uniform roughness can be computed from Manning’s n and an estimated hydraulic radius or diameter as shown in the equation below in which ROUGH is the roughness variable used in FLOW-3D, all variables are in SI units (meters), and the flow is fully turbulent and hydraulically rough. The hydraulic diameter Dh is defined as four times Rh (Dh = 4 Rh).   



The conversion given above is technically valid only for the hydraulic diameter which corresponds to the flow stage at which the Manning’s n was originally measured. The conversion is checked as follows: a typical literature value of n for mortar concrete is 0.013. Assume that n was measured in a channel with hydraulic radius 1.25 feet (hydraulic diameter of 5 ft), in which case ROUGH = 0.0033 feet, or about 1 mm, which is also a typical literature value for mortar cement. The calculated value of ROUGH is approximately 1 mm for hydraulic diameters between 1 and 10 feet. The limitations in the range of hydraulic diameters should always be checked. ROUGH > 0 turns off superheating of liquid near the surface of the component in the phase change model (see Cavitation and Bubble Formation). The value of ROUGH does not affect component/fluid heat transfer. If the component-to-fluid heat flux is to be enhanced due to surface roughness, use the ROBS variable which works as a heat transfer surface area multiplier for the component. By default, ROBS = 1.0. ROBS = 0 disables the heat exchange between fluid and component, as well as the component mass source (if used). 
Wave Boundary Condition A wave boundary condition can be defined at left (X Min), right (X Max), front (Y Min) and back (Y Max) mesh boundaries for free-surface problems in Cartesian coordinate system. At such a boundary, a surface wave enters the computational domain and propagates in the direction normal to the boundary. The wave can be a linear wave, a Stokes wave, a cnoidal wave, a solitary wave, or a random wave. A simulation with a wave boundary condition requires the gravitational acceleration to be directed in the negative z-direction, which is a negative number defined in Model Setup > Physics > Gravity > Gravity components > Z component. To set up a wave boundary, go to Model Setup > Meshing & Geometry > Mesh - Cartesian > Mesh block > Boundaries. Click on the button next to the desired mesh boundary to bring up the boundary condition window. Check the Wave radio button and specify Fluid elevation. The Fluid elevation at the boundary is the z-coordinate of the undisturbed fluid surface that the wave motion is superimposed on.  

 Linear wave A linear wave has a sinusoidal surface profile, and its amplitude is small compared to the wavelength and fluid depth. It is generated using Airy's linear wave theory. At the linear wave boundary, in addition to a regular linear wave, users can also define an irregular wave using multiple (up to 1000) sinusoidal linear component waves with independent frequencies, amplitudes and initial phases (another method to 



generate an irregular wave is to use the random wave generator based on a wave energy spectrum, as described in the Random Wave section). The elevation of a linear component wave is expressed as   where A, ω and ϕ are wave amplitude, angular frequency and initial phase, respectively. To define a linear wave or an irregular wave consisting of several linear waves, in the boundary condition window, go to Wave Definition and select Linear in the dropdown box and then click on Definition to bring up the Wave Definition window. In the Wave Attributes area, specify the total number of sinusoidal wave components in the input box for Number of wave components (it is 1 for a single linear regular wave). Then enter the Wave amplitude, Wave period and Phase shift (i.e., the initial phase, in degrees) for each component wave in the data table. The default phase shift is zero, which means at time t=0 the wave elevation is zero and is on the rise. 

 The linear wave solution is derived for an infinite reservoir with flat bottom, which is assumed to exist outside the computational domain and immediately adjacent to the mesh boundary. In this model, the Mean fluid depth defines the undisturbed fluid depth in the reservoir. It defaults to the difference between the Fluid elevation (the z-coordinate of the undisturbed surface) and the minimum z-coordinate of the computational domain. If the Mean fluid depth is different from its default, the user needs to provide the appropriate value in its input box.  At the wave boundary, the model allows for existence of a constant net current (inflow or outflow) in any horizontal direction, but the current must be slower than the wave speed for the linear wave solution to be valid. Find Current velocities > X Velocity and Y velocity, and enter the velocity components of the current in the x and y directions, respectively. The current is assumed uniform across the boundary. 



Stokes Wave and Cnoidal Wave Stokes wave is a nonlinear wave in deep water and possesses sharper crests and flatter troughs than a linear wave. In FLOW-3D, it is generated using either Fenton's Fourier series method or Fenton's fifth-order theory. The former provides higher order accuracy than the latter thus is the recommended Stokes wave generator. To define Stokes wave at the mesh boundary, in the boundary condition window, go to Wave Definition and choose Stokes and Cnoidal (Fourier series method) or Stokes (Fenton's fifth-order theory) and then click on Definition to bring up the Wave Definition window. 

 Cnoidal wave is a nonlinear wave in shallow water. It has even sharper crests and flatter troughs than the Stokes wave. In FLOW-3D, it is generated using Fenton's Fourier series method. To define a cnoidal wave, choose Stokes and Cnoidal (Fourier series method) in the boundary condition window and then click on Definition to bring up the Wave Definition window. In the Wave Attributes area of the wave definition window, specify Wave height (the vertical distance from trough to crest) and Wave period or Wavelength in their input boxes. Wave period and wavelength are not independent variables thus cannot be given at the same time. Similar to the linear wave, the Stokes and cnoidal wave solutions are derived for an infinite reservoir with flat bottom, which is assumed to exist outside the computational domain and immediately adjacent to the mesh boundary. The Mean fluid depth at the boundary defines the undisturbed fluid depth in the reservoir. It defaults to the difference between the Fluid elevation (the z-coordinate of the undisturbed surface) and the minimum z-coordinate of the computational domain. Users need to define the Mean fluid depth if it is different from its default value. 



The model allows for existence of a constant net current (inflow or outflow) in any horizontal direction at the wave boundary, but the current must be slower than the wave speed for the wave solution to be valid. Find Current velocities > X velocity and Y velocity, and enter the x and y velocity components of the current, respectively. The current is assumed uniform across the boundary. During one wave period for all oscillatory waves, including linear, Stokes and cnoidal waves, more fluid moves into the domain at the wave boundary than out of the domain. This is because fluid has a higher elevation when moving in than when moving out. Moreover, for Stokes and cnoidal waves, fluid moves faster at the wave crest than at the trough. This may result in a net increase of fluid volume in the domain over time in certain circumstances. As an option, users can choose to automatically compensate for the net fluid volume influx induced by the wave motion at the boundary by going to Numerics > Wave boundary condition and checking Eliminate net volume flux. Otherwise, check Include net volume flux at wave boundaries. This selection applies to all wave boundaries in the simulation. Solitary Wave To define a solitary wave at the mesh boundary, in the mesh boundary window, go to Wave Definition and choose Solitary and then click on Definition to bring up the Solitary Wave Definition window. In the Wave attributes area, specify Wave height which is the vertical distance from the undisturbed water level to the wave crest. Similarly to the other types of waves, solution of the solitary wave is derived for an infinite reservoir with flat bottom, which is assumed to exist outside the computational domain and immediately adjacent to the mesh boundary. The Mean fluid depth defines the undisturbed fluid depth in the reservoir. It defaults to the difference between the Fluid elevation (i.e., the z-coordinate of the undisturbed surface) and the minimum z-coordinate of the computational domain. Users need to define the Mean fluid depth if it is different from its default value. 



 The solitary wave is initially located outside the computational domain. By default, the initial distance from the crest to the wave boundary is one half of the wavelength. The wavelength of a solitary wave is the extent of the wave in its propagation direction. It is measured between two points at opposite sides of the crest where the surface displacement is 1% of the wave height. If that distance is different from its default value, specify it in its input box. The solitary wave model allows for existence of a constant net current (inflow or outflow) in any horizontal direction at the wave boundary, but the current must be slower than the wave speed for the solitary wave solution to be valid. If such a current exists, in Current velocities > X velocity and Y velocity, enter the x and y velocity components of the current, respectively. The current is assumed uniform across the boundary. Random Wave A random wave is treated as a superposition of many linear component waves with different wave periods, amplitudes and initial phases. In FLOW-3D, the code automatically generates 1000 linear component waves at the wave boundary for a random wave simulation. The periods are evenly distributed from 0.2s to 2s. The initial phases are randomly selected between 0 to 2π. The wave amplitudes are calculated using wave energy spectrum. Two internally defined energy spectra are available for users to choose: Pierson-Moskowitz (P-M) spectrum and JONSWAP spectrum. Users can also define their own wave energy spectrum in an external data file.  



 To specify a random wave, in the boundary condition window, go to Wave Definition and select Random then click on Definition to bring up the Wave Definition window. Under Energy spectrum type, select the type of wave energy spectrum. If P-M or JONSWAP spectrum is used, specify wind speed 10 meters above the sea level in the wind speed input box. For JONSWAP spectrum, users also need to define Fetch length and Peak enhancement factor. The default value of the peak enhancement factor is 3.3. If users want to use their own wave energy spectrum, select Energy spectrum file and load the existing data file that defines the wave spectrum. There should be two columns of data in the file. The left one is a series of angular frequencies of waves (in rad/time), and the right is the corresponding energy values. The total number of rows of data should not exceed 1000. There is no restriction on the extension of the file name. Initialization of Wave Motion Wave motion can also be defined as an initial condition. This is to allow the wave to initially exist throughout the computational domain so that computation time to reach steady wave motion can be shortened. The initial wave elevation and fluid velocity are generated using the same wave generator and the same wave parameters as those at the wave boundary. To initialize wave motion, go to Model Setup > Meshing & Geometry > Initial > Global > Fluid initialization and select Use wave boundary in the dropdown input box. In Reference mesh block and Reference mesh boundary, select the mesh block and the wave boundary which are used to define the initial wave motion. 

 



Wind Shear Stress When modeling large open bodies of water, it is often desirable to include a wind shear stress on the free surface. This can be done in FLOW-3D for a horizontal water surface, namely, the water surface has an outward normal in +z direction, and the gravity is in -z direction. The flow can be two-dimensional (in x-z or y-z plane), three-dimensional, or shallow water flow (depth-averaged flow in x-y plane). The wind shear stress
s
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� is calculated using the quadratic law  
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�  where ρa is the density of air, 10W
� is the wind velocity at 10m above water surface, and C'D is the wind shear coefficient (or drag coefficient) with a typical value of 0.003. In the current version of FLOW-3D, wind velocity can be constant or time-variant but must be uniform over the water surface.  

 Wind shear input is defined in Physics > Wind. Under Wind type, choose Constant wind or Time variable wind. If Constant wind is selected, enter X-velocity and Y-velocity of wind at 10m above water surface. If, instead, Time variable wind is selected, use Browse button to load a user-defined wind data file. The file should have three columns which from left to right represent time, x velocity and y velocity of wind at 10m above water surface. The total number of rows in the file should not exceed 5000. During a simulation, wind velocity at any time is calculated by linear interpolation. Finally, under Wind shear parameters, define Wind shear coefficient (C'D) and Air density (ρa). The default value of C'D is 0.003. 
What are the Available Numerical Options for...? Numerical options are defined in the Numerics tab. The user can choose iterative solvers for pressure and viscous stresses, select a VOF algorithm, implicit/explicit methods, momentum advection approximation and initial time-step sizes. For the user’s convenience, there is a default selection for every option on the Numerics panel. Multiple selections exist because of the wide range of problems that FLOW-3D can be used 



to solve and that can differ greatly in length and time scales, and in the physical processes that control the flow. An optimum choice of the numerical options will provide an accurate and efficient simulation. It is often difficult to find the optimum numerical options. A trial-and-error approach is on way to test a model. Starting with the default selection is a good way to proceed. During a simulation, the Mentor may suggest a change to the numerical options. The Runtime Options feature in the Simulate tab allows the user to change any of the numerical options during the simulation. This feature provides a direct way to experiment with the numerics without the need to restart the simulation. Multiple changes can be made to the same options. If an improvement is found to the original setup, the new selections can be saved to the prepin simulation input file. In addition, a Restart data edit can be requested at the time of a change in case the change results in an unrecoverable problem. In that case, the simulation can be terminated and restarted from the time of the Restart data edit. A time at which changes are to be applied during the simulation can also be defined in Runtime Options. If the time is not defined, the changes are applied right away. 

 When changes are sent to the solver from the Runtime Options panel, the solver will process them within a few time steps (cycles). There is no way to guarantee the exact time when this takes place. After the solver processes the changes it may make further adjustments to make sure the new settings are consistent with other selections, and also to set the related default parameters. The adjusted values are then sent back to the GUI and displayed in Runtime Options. This may take from several seconds to several minutes (for larger simulations). Until then, the Send and Close and Close buttons are disabled. The user can also revert either to the original simulation settings or the last set of options sent to the solver. 



Below are the descriptions of the available options to several numerical algorithms commonly used in FLOW-3D simulations. 
Computing Pressures The selection of different pressure solvers can be done in Numerics > Pressure solver options. Pressure forces in the momentum equation are always approximated implicitly for incompressible fluids (including flows with acoustic waves) as a means of maintaining the incompressibility of the fluid and stability of the solution. 

 For compressible fluid flows the SOR implicit option is the default, but users may optionally invoke the explicit pressure solver. In that case no pressure iteration is required to obtain the numerical solution. However, the time-step size will be limited by the Courant stability criterion in which the fluid velocity includes the speed of sound. Explicit approximations are, generally, more accurate than the implicit ones, especially when the solution involves strong pressure transients, e.g., shock waves. However, the time-step size limitation may be too severe to perform an efficient calculation. A compromise approach can be employed by using the implicit pressure solver, but limiting the time step, e.g., by the time it takes pressure waves to propagate a certain distance in the computational domain. For “stiff” incompressible flow problems convergence of the velocity-pressure iterations can be improved by “softening” the fluid using the limited compressibility model. This feature can be employed either by setting a constant compressibility coefficient in Fluids > Compressibility or by selecting Numerics > Pressure solver options > Implicit with automatic limited compressibility, in which case the compressibility coefficient is chosen by the program automatically and will generally change during a calculation. See also Compressible Pressure Iterations and Acoustic Waves (Limited Compressibility). The default iteration method is the point-by-point SOR algorithm, which achieves fast convergence in a wide range of flow conditions. However, in the SOR method, convergence may be slow when mesh cells have large aspect ratios. In that case the Line implicit (ADI) algorithm can often be employed to improve convergence. 



The ADI method can be used in any single coordinate direction, or in a combination of directions. The use of the ADI algorithm is also useful when flow solution symmetry needs to be preserved. The SOR method is not symmetric with respect to the direction of the coordinate axes (the discrepancy is smaller for tighter converged solutions). For example, if the physical flow conditions are symmetric relative to a plane normal to x-direction, then selecting the Line implicit solver in that direction will maintain the symmetry of the iteration solution. The over-relaxation factor OMEGA, accessible in Numerics > Pressure solver options > convergence controls, defaults to 1.7 for incompressible and to 1.0 for compressible flows. It is not recommended to change the defaults. In any case, OMEGA must be between 0.0 and 2.0 for a stable solution. When the implicit method for the coupling of the GMO components and fluid is used, IMPMOB=1, the value of OMEGA is automatically calculated during the simulation to ensure good convergence of the solution. Under-relaxation is typically used for moving objects that are lighter than fluid. When periodic mesh boundary conditions are used in the azimuthal direction in cylindrical coordinate system, it is recommended to use the Line implicit pressure solver, and only in that direction. This will help eliminate numerical noise in the pressure and velocity solution that can sometimes occur at such boundaries. Alternatively, turning off over-relaxation by setting it equal to 1.0 may help to reduce the noise. Finally, a pressure solver based on the GMRES method is also available. This new solver is a highly accurate and efficient method for a wide range of problems. It possesses good convergence, symmetry and speed properties and is recommended for all kinds of flow problems. It does use somewhat more memory than the other two methods available in FLOW-3D. Usually, the GMRES solver does not require any over or under relaxation to achieve good convergence. However, as with the SOR and ADI solvers, under-relaxation may be employed when the implicit method for coupling of GMO components and fluid is used. For more details, a Flow Science technical note on the GMRES pressure solver can be found at http://www.flow3d.com/pdfs/tn/FloSci-TN68.pdf. NOTE: WATCH FOR PREPROCESSOR MESSAGES RECOMMENDING THE SADI METHOD IN CERTAIN COORDINATE DIRECTIONS BASED ON THE MESH CELLS ASPECT RATIOS (PRPOUT FILE). USUALLY IT IS BEST TO FIRST TRY THE DEFAULT SOR METHOD. IF EXCESSIVE ITERATIONS ARE CAUSING REDUCTIONS IN THE TIME-STEP SIZE, THEN TRY THE LINE IMPLICIT OR GMRES SOLVER. 
Compressible Pressure Iterations For compressible flows, pressure terms can be approximated explicitly by selecting Numerics > Pressure solver options > Explicit. This may be useful to improve the solution accuracy for tracking transient pressure waves. However, the convective time step stability limit will be computed using not only the flow velocity, but the sound speed as well, potentially making the time-step size too small for an efficient simulation. The default SOR implicit method is usually best for most situations. Specified velocity or pressure boundary conditions for compressible flows can create a uniform pressure change in the computational domain that is difficult to compute by either Line implicit or SOR methods. For this situation an additional algorithm is provided to give a uniform global pressure adjustment. Select Numerics > Pressure solver options > Convergence controls > Uniform pressure adjustment. Then a uniform pressure adjustment is done at the end of each cycle to take into account overall pressure changes due to sources, sinks and non-zero net boundary fluxes. 

http://www.flow3d.com/pdfs/tn/FloSci-TN68.pdf


If the equation of state is non-linear with respect to its pressure/density dependence, then inner iterations may be required for better convergence. These iterations are set in Numerics > Pressure solver options > Convergence controls > Maximum number of inner iterations for non-linear equation of state. Set it equal to a value larger than 1 to use the inner iteration procedure. This option is particularly useful for explicit pressure calculations when a non-linear equation of state is employed. The Over-relaxation factor equal to 1.0 is recommended in nearly all cases, and especially if the number of inner iterations is greater than 1. See also Computing Pressures. NOTE: CURRENTLY, THE BUILT-IN EQUATION OF STATE IS THAT FOR A PERFECT GAS, THEREFORE, IT IS LINEAR WITH RESPECT TO ITS PRESSURE VS. DENSITY DEPENDENCE. USING INNER PRESSURE ITERATIONS OFFERS NO ADVANTAGE. 
Computing Temperatures Implicit treatment of heat transfer and conductive fluxes is selected in Numerics > Explicit/implicit solver options. An implicit method can be used to remove the time-step size stability limit associated with the explicit approach. When the conductive or heat transfer stability limit is substantially smaller than other stability limits in a simulation, then using the implicit method may significantly improve the efficiency of the calculation.  An implicit algorithm requires iterations to obtain a thermal solution at each time step. Iterations involve updating temperatures in fluid and geometry components. If there are no other time-step size restrictions during a calculation, then the time-step size is controlled by the number of thermal iterations. When the implicit method is used together with Solidification model, the thermal energy must be a unique function of temperature. In other words, the derivative of energy with respect to temperature, dE/dT, must be a positive finite number for all temperatures. When the latent heat is released at a constant temperature, e.g., when the liquidus temperature is equal to the solidus, a small artificial freezing range will be introduced in the preprocessor. NOTE: TEMPERATURE ITERATION RESIDUALS ARE NORMALIZED BY THE MINIMUM ABSOLUTE TEMPERATURE IN THE SYSTEM. AS A CONSEQUENCE, WHEN THE ABSOLUTE TEMPERATURES ARE SUBSTANTIALLY LARGER THAN THE CHANGE IN TEMPERATURES, CONVERGENCE MAY BE TOO LOOSE, LEADING TO SIGNIFICANT ERRORS. IN SUCH SITUATIONS SOLUTION ACCURACY CAN BE IMPROVED BY REDUCING THE CONVERGENCE CRITERION IN CONVERGENCE CONTROLS. 
Computing Viscous Stresses By default, viscous stresses in fluid are approximated explicitly. This produces a simple and efficient algorithm which, however, requires a limit on the maximum time-step size to maintain stability of the solution. 



 Viscous iterations are performed when an implicit viscous algorithm is chosen for the approximation of viscous stresses in the Navier-Stokes equations in Numerics > Explicit/implicit solver options. An implicit method can be used to remove the time-step size stability limit associated with the explicit approach. When viscous stability limit is substantially smaller than other stability limits in a simulation, then using the implicit method may significantly improve the efficiency of the calculation.  There are three implicit viscous solvers available in the Numerics panel: the Successive under-relaxation (SUR), Line Implicit (or ADI) and the GMRES solver. All three are designed to handle highly viscous flows. Each has its strength and weaknesses. The brief descriptions of these solvers in this section are based on cumulative user and our own experience in using these methods. The SUR method is usually the most stable of the three in that it provides smooth and bound solution for a wide range of flow problems. However, the convergence rate is slower than that in the ADI and GMRES methods. It is often not practical to iterate on the solution to achieve the required convergence level. More commonly, the number of iterations at each time step are limited by the maximum number of iterations (ITVSMX), which is typically set to 10 or 20. Due to the inherent stability of this method, lack of convergence does not result in an unstable solution. However, an improper balance of forces acting on fluid, like gravity and pressure, may be a result of this. Therefore, this method is recommended for flows where viscous stresses are the defining factors. The SUR method can also be used when the other two methods fail to provide converged solution. The SUR method can be used together with SOR, ADI and GMRES implicit pressure solvers. The ADI and GMRES methods exhibit good convergence rates - when they converge, - with convergence itself sensitive to flow perturbations and variations in fluid properties, like viscosity and density. Sometimes, both methods may actually diverge, resulting in an unphysical solution. The ADI method is designed to provide good coupling between pressure and gravity on one side and viscous forces on the other, which are updated within one iteration (therefore, there is no choice of pressure solvers for this method). In cases when these factors are equally important in the flow, convergence may be slow because these forces usually work in opposite directions. Generally, the ADI implicit method is a close contender with the GMRES solver in accuracy and speed. The strength of the GMRES implicit viscous solver is in its fast convergence rate. However, the coupling between pressure and viscous forces is not as tight as in the ADI method. As a result, in flows where this coupling is strong, pressure may not be computed correctly. It is, therefore, recommended to use the GMRES solver when this coupling is not very strong, for example, when pressure distribution in the fluid is 



defined by the conditions at mesh boundaries rather than by the flow within the domain itself. Sometimes this deficiency can be overcome by reducing the time-step size below what the code uses. The GMRES implicit viscous solver requires the GMRES implicit pressure solver. In practice, it is often necessary to try two or all three of these methods to determine which work best. The ultimate test for accuracy, of course, is to compare the implicit results with the explicit solution, if possible. The SUR and GMRES viscous solvers introduce a separate iteration count, in addition to pressure iterations, which is printed together with the pressure iteration counter. In the Line implicit solver pressure and velocity adjustments occur in the same iteration loop, so there is only one iteration counter. Convergence options can be adjusted in Convergence controls for the implicit viscous solver. The most important of them is the Maximum number of iterations, which controls the maximum number of viscous iterations per time step. NOTE: IT IS NOT RECOMMENDED TO USE THE IMPLICIT VISCOUS MODEL TOGETHER WITH A TURBULENCE MODEL THAT INVOLVES THE SOLUTION OF AN ADDITIONAL TRANSPORT EQUATION BECAUSE VISCOUS DIFFUSION TERMS IN THE TURBULENT TRANSPORT EQUATIONS ARE ALWAYS APPROXIMATED EXPLICITLY. THE IMPLICIT VISCOUS SOLVERS ARE ALSO NOT DESIGNED TO BE USED TOGETHER WITH THE COMPRESSIBLE FLOW MODEL, ALTHOUGH THEY MAY STILL WORK IF COMPRESSIBILITY IS NOT A BIG FACTOR. 
Density Advection The default fluid density advection algorithm in variable density problems is a first-order upwind differencing method. It is robust and sufficiently accurate in most situations, although, as in any first-order method, it introduces numerical diffusion into the solution. This method is activated when Physics > Density evaluation > Solve transport equation for density > First order option is selected. 

 When better accuracy is needed for the resolution of density mixing due to advection, e.g., in stratified flows, then a second-order upwind differencing method can be used by selecting Second order monotonicity preserving. NOTE: NO ENERGY TRANSPORT IS ALLOWED IN ONE-FLUID PROBLEMS WITH DENSITY TRANSPORT. 



Energy Advection The default thermal energy advection algorithm in problems involving heat transfer is a first-order upwind differencing method. It is robust and sufficiently accurate in most situations, although, as in any first-order method, it introduces numerical diffusion into the solution. This method is activated when Physics > Heat transfer > Fluid internal energy advection > First order option is selected. When better accuracy is needed for the resolution of thermal mixing due to advection, e.g., in buoyant flows, then a second-order upwind differencing method can be used by selecting Second order monotonicity preserving. 

 NOTE: NO ENERGY TRANSPORT IS ALLOWED IN ONE-FLUID PROBLEMS WITH DENSITY TRANSPORT. 
F-Packing The F-packing algorithm is used to eliminate small voids or “foaming” in flows with significant free-surface breakup. The algorithm works by creating small negative divergences in internal fluid cells, in which the fluid fraction is less than 0.99. It is only used in one-fluid flows with free surfaces. 



 The F-packing algorithm is activated by choosing one of the three options in Numerics > Volume-of-fluid advection > Advanced options > F-packing that activate the model. The default setting is Close up interior voids. When Reduce surface breakup in extreme cases is selected, then additional smoothing of the free surface takes place to reduce its breakup at distortion. On top of that, isolated droplets (i.e., fluid occupying less than one cell) are discarded when Discard isolated fluid drops is chosen. The rate of F-packing is proportional to the F-packing coefficient. The default value is 1.0. When it is equal to 0.0 no packing will take place. Occasionally, pressure changes due to F-packing may significantly interfere with the main flow. An indication of such situation can be a “run away” pressure and/or velocity at a location in the flow, which is out of range of physically meaningful values. In that case a smaller value of the F-packing coefficient may be necessary. 
Fluid Interface (VOF) Approximations There are a number of methods to track fluid interfaces in FLOW-3D. Each is best suited for a certain type of flow problem, as indicated in the Numerics > Volume-of-fluid advection panel. There are two main types of fluid interfaces: a sharp interface and a diffuse interface. 

 Free surface is an example of a sharp interface employed in one-fluid flows with void regions. However, a sharp interface can also exist in two-fluid problems, e.g., between water and air. In both cases select Global > Free surface or sharp interface.  



There are four choices in the Numerics > Volume-of-fluid advection panel for sharp interface tracking. The first is designed for two-fluid flows, the second for free-surface flows, as indicated by the description next to the respective selections. The third and fourth options, the Unsplit and Split Lagrangian methods (also known as TruVOF), are suitable for both cases. Generally, the two Lagrangian methods exhibit good accuracy in tracking sharp interfaces in complex three-dimensional motions. The Split Lagrangian method typically produces lower cumulative volume error than the other methods in FLOW-3D, although the volume error may increase when this method is used together with the GMO.  A Flow Science technical note on TruVOF is available online at www.flow3d.com/pdfs/tn/FloSci-TN63R.pdf. A diffuse interface may exist between fluids of similar densities (e.g., oil and water or air and smoke), which can easily mix on a macro-scale. A second-order, monotonicity-preserving donor cell advection method is used in this case. Do not forget to select No sharp interface in the Global tab for such cases. The user can make any of the five selections available for interface tracking, independently of the type of interface and number of fluids in the problem at hand. The descriptions of these options shown on the GUI’s Volume-of-fluid advection panel indicate the best use of these options. If the user selects Automatic, then the selection will be made by the code automatically, based on the type of the interface and the number of fluids.  Note that the Lagrangian methods are not used as a default for any type of flow. When no fluid interfaces exist, i.e., Global > One fluid and No sharp interface are selected, no fluid fraction advection is needed. 
Momentum Advection Main variables: XPUT: IORDER, IMPADV, ALPHA The default momentum advection algorithm is a first-order upwind differencing method. It is robust and sufficiently accurate in most situations, although, as in any first-order method, it introduces numerical diffusion into the solution. This method is activated in Numerics > Momentum advection > First order. 

 A variation on the IORDER=1 case exists in which a weighting proportional to ALPHA is used between full upwind (donor cell) and central differencing. ALPHA=1.0 corresponds to full upwind (default), while ALPHA=0.0 is central differencing. ALPHA is set in namelist XPUT. When better accuracy is needed for the resolution of flow velocities, e.g., in vortices, then a second-order monotonicity-preserving upwind differencing method can be used by selecting Second order monotonicity preserving. 

http://www.flow3d.com/pdfs/tn/FloSci-TN63R.pdf


Another second-order method based on central differencing of the advection terms can be used by selecting Second order. This method is the least diffusive of the three, but it is not robust and does not always produce a stable solution in the presence of free surfaces. A third-order upwind differencing method can also be employed for an even more increased accuracy, for example, when modeling swirling flows. It proved itself superior to the other available methods in modeling flow around ship hulls. 
Implicit Advection The default techniques for advection of momentum and all other fluid quantities are based on explicit numerical approximations. Explicit methods are simple, and relatively accurate, but require limitations in the maximum time-step size. An implicit technique that removes this limitation can be requested in Numerics > Explicit/implicit solver options > Advection. The implicit treatment of the advection terms in the transport equations is applied selectively in cells if it allows the time-step size to be increased without a loss of accuracy. For example, to maintain accuracy of the interface tracking the implicit method is not employed in cells that contain free surfaces.   When the implicit advection method is activated, a new output quantity called “Courant number” is calculated and stored in every cell as part of the restart data edits. Courant number is a dimensionless parameter equal to 

dx

ut ⋅∆  where ∆t is the time-step size, dx is the cell size and u is the fluid velocity in the cell. Courant number is less than 1.0 in cells where advection is treated explicitly, and greater than 1.0 where the implicit approximation is applied. It should always be kept in mind that implicit techniques invariably introduce some amount of smoothing or damping of the computed results beyond what is expected with explicit techniques. NOTE: ONLY THE FIRST-ORDER ADVECTION OPTIONS FOR MOMENTUM, DENSITY AND ENERGY CAN BE USED IN COMBINATION WITH THE IMPLICIT ADVECTION. 
Pressure Boundary Conditions A Specified pressure boundary condition can be set for both inflow and outflow type of mesh boundaries. There are two main options for an inlet pressure boundary condition: a static pressure condition and a stagnation pressure condition (default). The selection is done by using the Static pressure check box in the dialog window for a specific boundary in the Boundaries window. 



 When the static condition is used then the static pressure, P, at the boundary is equal to the specified value. For the stagnation boundary condition the total, or stagnation pressure, P+ ρU²/2, is equal to the specified value, where U is the normal velocity component of the incoming flow. In that case the static pressure can be computed as the specified value minus the dynamic pressure and, therefore, will not, in general, stay constant. The stagnation pressure boundary condition assumes that fluid next to the boundary is stagnant at the specified pressure value which is an approximation to a large reservoir of fluid outside the mesh domain. Therefore, fluid has to accelerate from zero velocity to enter the domain. The static condition effectively assumes that fluid does not undergo any acceleration or deceleration when entering or leaving the domain, for example, flow in a constant diameter pipe. In general, the stagnation condition is the best and most realistic physical condition to use. A static condition says nothing about the state of flow outside the boundary. In this regard it may lead to incorrect results, so caution is advised when using this type of pressure boundary. The selection of the stagnation vs. static pressure at a specified pressure boundary does not affect the outgoing flow. Static pressure type boundary is always used in this case. See also Boundaries with Hydrostatic Pressure and discussion on Pressure Boundary Conditions in the Theory chapter. NOTE: THE STAGNATION PRESSURE BOUNDARY CONDITION ONLY MAKES SENSE WHEN THERE IS FLUID AT THE BOUNDARY, FOR EXAMPLE, FOR ONE-FLUID PROBLEMS FLUID FRACTION HAS TO BE POSITIVE AT THIS BOUNDARY. IN ADDITION, THE STAGNATION CONDITION APPLIES TO FLUID ENTERING THE DOMAIN. FOR THE FLUID LEAVING THE DOMAIN THE SPECIFIED PRESSURE IS INTERPRETED AS THE STATIC PRESSURE. 
Pressure Iteration Convergence By default, the convergence criterion for pressure iterations, EPSI, is evaluated automatically during a calculation and printed out into the solver message, hd3msg, and solver summary, hd3out, files. This is the recommended option. Convergence can be tightened by defining a positive value of less than one in Numerics > Pressure solver options > Convergence controls > Multiplier for dynamically adjusted convergence criterion. It is not recommended to use a value larger than one. 



 Alternatively, a Constant convergence criterion can be used by setting a positive value in the dialog box. 
Steady-State Flow An accelerated approach to a steady-state flow regime can be achieved by setting a large number, e.g., 1.0e6, for Numerics > Pressure solver options > Convergence controls > Multiplier for dynamically adjusted convergence criterion, and the Over-relaxation factor equal to 1.0. In that case no pressure iterations will be carried out since the convergence criterion is very large. Therefore, the transient solution, as the flow changes from the initial conditions to a steady-state flow, will not be accurate. 



 This option can only be used for Confined Flows (one fluid, no sharp interface) with no heat transfer. NOTE: IF A STEADY STATE SOLUTION DOES NOT EXIST, THEN THE NUMERICAL SOLUTION MAY BECOME INCREASINGLY INACCURATE AS IT PROGRESSES WITH TIME.” 
References Cohen, M., & Flemings, M. C. (1985). Rapidly Solidified Crystalline Alloys. (p. 3). Warrendale: TMS. Poirier, D. R. (1987). Permeability for flow of interdendritic liquid in columnar-dendritic alloys. Metall. Trans. , 18B:245-246. 



Chapter 7 - Customized Postprocessing 
Custom Output Overview 
Accessing FLOW-3D Graphics Plot Files There are two types of graphics plot files generated by FLOW-3D: Existing and Custom. Existing Plots: Existing plots are generated by both the preprocessor and the solver. The preprocessor automatically generates a file named PRPPLT.{ext} which contains plots of the computational grid, history plots of time varying setup parameters such as component power dissipation, and plots of shear dependent properties. The solver automatically generates a file named FLSPLT.{ext} which contains graphics defined by the user manually in the $GRAFIC namelist in the simulation file. The variables specified in the $GRAFIC namelist to create existing plots are listed in Plot Request Variables. Custom Plots:  Custom plots are generated from the Analyze tab based on the user-selected settings there. Custom 1D and 2D plots are stored in a file named FLSPLT.TMP which is generated each time the Render button is selected. Custom 3D plots for contour surfaces are stored in files named ISOSURF####.F3D where #### represents the plot number. Similarly, files named ISO_OBS####.F3D, ISO_VEC####.F3D, ISOPART####.F3D, and ISOSTRM####.F3D are used for storing 3D component, vector, particle, and streamline data, respectively. A master file named ISOFILES.F3D contains a list of the available 3D plots. The ISOSURF####.F3D and the other 3D data files cannot be opened directly but instead can be displayed once the master file ISOFILES.F3D is opened. 
Viewing Existing Plots Once the preprocessor has been run on a particular simulation, the PRPPLT.{ext} file will be available for display. To open this file, go to the Analyze tab, select the Open Results File button, and select the Existing radio button on the file dialog. The PRPPLT.{ext} file will appear in the dialog. Select it and click OK. The available plots will be listed at the right side of the display window. After a simulation completes, an FLSPLT.{ext} file will be available for display. To open this file, go to the Analyze tab, select the Open Results File button, and select the Existing radio button on the file dialog. The FLSPLT.{ext} file will appear in the dialog. Select it and click OK. The available plots will be listed at the right side of the display window. A list of available plots appears in the Control Panel on the right-hand side of the screen. Plots may be viewed by clicking on the name in the list or by using the Previous and Next buttons. The plot file flsplt.* (existing solver plots) is particularly useful because it contains plots such as forces in sample volumes, history point plots, and any other plots predefined in the GRAFIC namelist in the project file.  Various aspects of a plot, such as background and foreground color, line thickness, vector length, and particle size can be changed by selecting options under the Format button. 



Generating Custom Output Custom Output refers to a variety of ways of extracting information from a simulation. For example, transformations can be applied to plots to average the data, multiply by a constant, and integrate/differentiate it. Customized plots are created from the Analyze, Custom tab. The custom plots are entered into a text file named FLSINP.{ext} in the form of plot requests. The input variables used to create custom plots are listed in POSTPROCESSOR INPUT DATA. Once a results file has been opened on the Analyze tab, there are two ways to create custom output. Once way is to go directly to the Custom tab and begin creating the necessary plot requests from scratch. This requires significant knowledge of the format of the FLSINP files as well as the use of plotting variables. A better approach is to create a plot of a quantity similar to what is desired and modify the resulting FLSINP file to achieve your goal. See also the Customizing Plots using the FLSINP file for a description of how to create custom plots. 
Data Output 
Available Options for Data Output Available options for data output are as follows: Main variables: XPUT: PLTDT, PLTFRC, HPLTDT, APLTDT    IEDT, LPR, PRTDT, SPRTDT Other related variables: GRAFIC: EXPTYP, IPLT3D, ITRANP, IBIN  
Plottable Data Output During a FLOW-3D calculation, solution data is periodically written into a binary data file flsgrf. This file is then used by the postprocessor to extract the data for plotting or for continuing a calculation through a restart operation. The data edits are divided into several categories: Restart Data, History Data, and Selected Data. Restart Data Restart data is the default used in FLOW-3D for contour, vector and iso-surface plots. Additionally, restart calculations (see the Restarts chapter) can begin at any of the times for which restart data is available. The time interval between restart data edits is set under the Output tab under the Restart Data box by the PLTDT variable. The basis for output is also set under the Output tab (at bottom center). This option controls whether the plot interval for data written is time, fill fraction or solidified fraction dependent. The variable is IEDT=1, 2, or 3, respectively. The default (if no value is entered) in each case produces eleven edits including the initial conditions. History Data History data is used for making X-Y graphs of a variable evolution vs. time (history probes). The plotted variables include integral and diagnostic quantities, such as fluid volume and iteration number, sample volume output and flow variables at specified history probes. The time interval for history data edits is set by the HPLTDT variable. The default setting results in 100 history data edits. 



NOTE: BELOW ARE FOUR TYPES OF DATA WRITTEN OUT UNDER HISTORY DATA THAT MUST BE REQUESTED IN THE INPUT FILE BEFORE RUNNING A SIMULATION. Sampling Volumes Sampling volumes are rectangular regions in space defined by plane limiters for each coordinate axis. Sampling volume data is available as General History Data under the Probe tab and the Text Output tab under the Analyze tab. The default extents of a sampling volume are the maximum extents of entire domain. Sampling volumes can track data within a region such as volume of fluid, forces or force components on solids, moments and moment components, and particle counts for each species of particles defined. Sampling volumes can be defined in the Output tab of the GUI or in the Sampling Volumes tree in Meshing & Geometry. Flux Surfaces Flux Surfaces are a method of tracking flow rates and particle count of particle species that flow through its surface. Flux surfaces are baffles with 100% porosity (by default), meaning that they are defined by creating baffles in the Baffles tree in the Meshing & Geometry tab under Model Setup. Refer to Flux Surfaces under the Model Reference section for more information and Baffle Setup under the Input Variable section for variable information on baffles and flux surfaces. History Probes History Probes track quantities at specific locations within the flow domain. They can be defined as fixed or moving with the fluid (as a marker particle). History probes track many quantities depending upon the physical models selected. Standard data would be fraction of fluid, pressure, velocities and more. History Probes can be added in the History Probe tree in Meshing & Geometry. Pressure and Shear Forces on Components Components listed in the Geometry tree under the Meshing & Geometry tab under Model Setup can have Pressure and Shear Forces output to General History Data. To do so, select ‘yes’ in the Pressure and Shear Force Output listing of the Component Properties tree structure. Selected Data  Selected Data, like Restart Data, is spatial data for contour, vector and iso-surface plots. With Restart Data, all information pertinent to the solution is written out, thus high a high frequency of data output will generate a large results file (flsgrf.dat). With Selected Data, only the data requested is written. This helps keep the results file size down. This allows users to store the data more frequently to produce smooth animations using third party software packages. To choose Selected Data, go to the Output tab and highlight (by left-clicking) the desired quantities to be written out under the Selected Data box. To set a plotting frequency, place a value in the time interval box. The default value will generate 100 plots if no value is entered. NOTE: RESTART CALCULATIONS CANNOT BE PERFORMED USING THE SELECTED DATA SINCE IT IS USUALLY NOT COMPLETE. SELECTED DATA EDITS ARE CONTROLLED BY THE APLTDT VARIABLE. Spatial plots can be created using the Restart Data or Selected Data. The selection between these two sources of data is made by IDATYP for 2-D contour plots, IDATPS for 3-D surface plots, IDATPP for particle plots and by IDATPV for velocity vector plots. Each of these variables can have either of the two values: 0 for restart spatial data and 1 for selected spatial data. 



Postprocessing can be done in two ways. First, graphical data output requested in the GRAFIC section is processed and stored in the flsplt file for viewing in either the 2-D Display or 3-D Display modes. Second, data can be processed and analyzed in a more interactive manner using the Results button in the main window of the GUI. In the latter case the plot file name is flsplt.tmp so that the original plot file is not overwritten. FLOW-3D solution spatial data can be exported in a number of formats suitable for display by several commercial graphical display programs, for example, the ASCII PLOT3D format. Currently, FIELDVIEW®, Ensight® and Tecplot 360® have direct interfaces to the flsgrf data file. 
Printable Data Output In addition to storing the calculation data for subsequent plotting, data is also printed into the message file hd3msg (short prints) and into the summary file hd3out (long prints). The short print interval is set by the SPRTDT variable (default is 100 edits) and the long print interval is defined by PRTDT (default is 11 edits including the initial data). It is suggested that PRTDT be set to a large value (larger than TWFIN) to reduce the long prints to just two edits: at the beginning and end of the simulation. This will keep the size of the hd3out file minimal. In addition, the size of the mesh domain from which the solution data is written to the hd3out file can be limited using the XLPR, XRPR, YFPR, YBKPR, ZBPR, and ZTPR variables which define a 3-D rectangular box. The LPR flag controls the amount of data stored in the flsgrf file, as well as that printed into the preprocessor summary file, prpout, and the solver summary file, hd3out. The larger the value of LPR, the more data is stored. The default is LPR=1, while LPR = 2 and 3 are also available. LPR=0 reduces the printed output to a minimum. 
Exporting PLOT3D Function File Data To generate a request for PLOT3D data export, set ITRANP=1 in the GRAFIC section of the prepin file. Specify the data to be exported using the variable EXPTYP(N). Leave variable IPLT3D at its default value of zero for function files (which allow any arbitrary data quantities in the file, as opposed to PLOT3D Q files which contain 5 quantities—density, momentum and stagnation energy per unit volume). To export animation data, set variable IDATEX=1. With these settings in GRAFIC, the preprocessor will write a file called flsp3d, which is similar to the flsinp file. To generate PLOT3D data, use the Custom panel in the Analyze tab. Select file flsp3d and select Render, which will run the postprocessor. The postprocessor will create a grid file p3dgrid.dat. It will also create a series of data files, p3dnnn.dat, where nnn is a number series, one for each time that includes all of the requested data. The postprocessor also generates a function name file, fnct000.nam, which indicates what data and times are included in the function files. The PLOT3D files are single-grid 3D whole files. NOTES: ALL FLOW-3D PLOT FILES CREATED BY THE PREPROCESSOR (E.G., PRPPLT) AND POSTPROCESSOR (E.G., FLSPLT) ARE WRITTEN IN AN ASCII FORMAT; THEREFORE, THEY CAN BE MOVED BETWEEN DIFFERENT PLATFORMS FOR VIEWING THE PLOTS. 



TIME INTERVALS FOR SOME DATA EDITS CAN BE MADE TIME DEPENDENT. FOR EXAMPLE, PLOTTING TIME INTERVAL CAN BE SET AS A FUNCTION OF TIME USING THE TEDIT AND TPLTD ARRAYS. FOR ALL TYPES OF DATA EDITS ONLY VARIABLES THAT ARE RELEVANT FOR A GIVEN FLOW SOLUTION ARE STORED. FOR EXAMPLE, FLUID TEMPERATURES ARE STORED ONLY IF THE ENERGY EQUATION IS ACTIVATED (IFENRG>1), AND COMPONENT TEMPERATURES ARE STORED ONLY IF HEAT TRANSFER IN SOLIDS (IHTC=2) IS ACTIVATED. THIS MAY POTENTIALLY CAUSE PROBLEMS AT RESTARTS WHEN A NUMERICAL MODEL, FOR WHICH NO DATA IS AVAILABLE IN THE FLSGRF DATA FILE, IS TURNED ON DURING THE RESTART. SEE RESTART OPTIONS FOR DETAILS. Other related variables: XPUT: ISTNR, TEDIT, TPLTD  GRAFIC: Other plot request variables 
Exporting Neutral File Data The FLOW-3D graphical interface can be used to export what is known as "neutral file data.” A "neutral file" contains FLOW-3D results at user specified locations in a simple ASCII format so that it can be transferred to other analysis packages such as stress analysis packages. The neutral file exporter reads in a list of coordinates from a user-provided file, and then writes out the requested FLOW-3D results at those coordinates. The formats of the "coordinate file" and the "neutral file" were chosen so that they share a common layout. The name of the coordinate file must be transf.in, and the name of the neutral file is transf.out. To generate a neutral file, click on the Analyze tab and open a Custom results file (flsgrf.xxx) in the graphical interface. Then go to the Neutral File tab. Select the variables to be included in the neutral file, the spatial range for the data, and the time. You may also choose to have the data interpolated to the coordinate points, or to use the nearest FLOW-3D cell-centered data. 
The Coordinate File Format A typical coordinate file is shown below. This file is read by FLOW-3D using a free format. The name of the coordinate file must be transf.in, and this file must be in the working directory. All of the lines before the –1 marker line are optional title lines. The –1 flag indicates the beginning of the coordinate information. 

 The zero on the line immediately following the –1 is a placeholder. In a neutral file, this line contains significant information, so the placeholder is included here for consistency. The line following the 



placeholder contains the minimum x, y and z mesh coordinates. This information is not used for generating a neutral file; however, it may be necessary for interpreting a neutral file in FLOW-3D. Following the minimum-mesh-coordinates line, are the actual coordinates (x, y and z) for which data is to be generated. FLOW-3D processes the coordinates using single precision. 
The Neutral File Format A typical neutral file is shown below. The name of the neutral file is transf.out. 

 The first line is the FLOW-3D problem title, which is the first line in the prepin file. The second line indicates the actual simulation time for the outputted data. The fourth line is the –1 marker flag, indicating that neutral file data is to follow. The line after the –1 marker flag indicates the number of data quantities to be written for each coordinate, and the data name identifiers for those data quantities. The data name identifiers indicate the variables selected in the graphical interface. This is followed by the minimum x, y and z coordinates for the FLOW-3D grid. Next is the actual neutral file data. The first three entries on each line are the x, y and z coordinates, followed by the requested data. There can be up to five data quantities specified for each coordinate point. If more quantities are needed, they must be put into another neutral file. If a coordinate point is specified that is outside of the FLOW-3D mesh, the output data is assigned a default value of –1.0e35. Similarly, if fluid-related data is requested at a coordinate where there is no fluid in the FLOW-3D mesh, the value –1.0e35 is assigned to that data. Additionally, if obstacle-related data (for example, wall temperature) is requested at a point where there is no obstacle, the value –1.0e35 will also be assigned to that data. In the example above, there was neither fluid nor obstacle in the FLOW-3D cell at the point x=1.001, y=0.25, z=2.999, so both ‘tn’ and ‘tw’ have been set to –1.0e35. A free-format FORTRAN read statement is recommended for reading the neutral file. 
Generating Text Output The FLOW-3D graphical interface can be used to generate text output in ASCII format. To generate text output, click on the Results button in the graphical interface, then select Custom. Select the desired flsgrf file. Then go to the Text Output tab. First select the desired Data Source (for descriptions of Standard 



Spatial, Animation and History data, see Plottable Data Output). Then, select the variables to be written out, the spatial range for the data, and the time. If the spatial range specified is 3-D, then the data will be written out in 3-D format (x, y and z values followed by the requested data). If a 2-D data range is requested (i.e., the minimum and maximum limits are identical for one dimension), then the data is written out in 2-D format (the constant variable is written above the rest of the data, then on each line the other 2 coordinates are written, followed by the requested data). Similarly, if a 1-D or zero-D data range is requested, the data is written out appropriately. NOTE: THE REQUESTED TEXT OUTPUT DATA IS WRITTEN TO FILE FLSLNK.TMP. THIS FILE IS A TEMPORARY FILE AND IS AUTOMATICALLY DELETED WHEN THE CUSTOM RESULTS PANEL IS CLOSED. THEREFORE, THE USER MUST USE THE SAVE AS BUTTON TO WRITE THE DATA TO A PERMANENT FILE IF THE TEXT OUTPUT IS TO BE SAVED. 
Customizing Plots Using the FLSINP File Main variables: See the Postprocessor Input Data for a complete description of all flsinp file variables. There are many options for customizing plots that are not available directly in the graphical interface. Some of these customizations will be discussed here. The best approach for creating a customized plot is to first create a similar plot using the custom results panels. Remember to set the Limits and Time Frame sliders. When Render is activated, a plot file is created and the plotting package is activated, but also a plot description file is created. This file is called flsinp.tmp. It can be modified by using the Custom tab and selecting this file. After the plot description file has been modified, it can be saved (use Save As to keep this file for future use since the file flsinp is overwritten when using the other custom results tabs), and the modified plots can be generated by selecting Render. An example flsinp file is shown below. This file has a namelist structure with two types of namelists. The first, “contrl”, gives overall plot control information. The second, “pltreq”, specifies specific types of plots. Some plots require multiple “pltreq” blocks, such as for the pressure contour / velocity vector plots generated by the file shown below. Note that on some computers, the initial $ (as in $pltreq) will be replaced by &, and the $end will be replaced by /. 



 
Data Transformations A variety of data transformations can be performed by the postprocessor. A full list of transformations is given in Postprocessor Input Data (see Namelist_pltreq_Variables_ITRANS and ITRANSC ). A complete list of the specifications for each transformation are also given. Some of the transformations for spatial data include converting velocity to Mach number, converting static pressure to total pressure, scaling and adding a constant (i.e., changing relative pressure to absolute, or changing units), and taking the sum or difference between 2 quantities. Some of the transformations for history data include scaling and adding a constant, and differentiating and integrating data. For some of the transformation actions, there are multiple ITRANS and ITRANCS options, the difference being what will be done with the transformed data. For example, there are three velocity component-to-velocity magnitude transformations, one for 2-D contours, one for iso-surface value, one for coloring the iso-surface, vectors, and streamlines. For actions with multiple ITRANS and ITRANSC options, the user must take care to use the correct one. Transformations are controlled by variables ITRANS and ITRANSC in a pltreq namelist block in the flsinp file. Additional data needed for the transformations (i.e., velocity components for converting static pressure to 



total pressure) are specified using the array XVNAM (). Scalar values (such as constant density, or scaling or additive values) are specified using variables XTRANS and XTRANA. An example plot request for transforming static pressure to total pressure where density is a constant is shown below. Variables ITRANS, XVNAM (1...3) and XTRANS have been added. 

 An example plot request for differentiating total volume of fluid is shown below. Variables ITRANS and XVNAM (1) have been added.  
 For this transformation, the variable to be differentiated is specified using variable XVNAM (1). Note that variable PVNAM1 must always be specified (it is a data placeholder), even though this data is not actually used for the transformation. The differentiated values will be stored in the "place" reserved by PVNAM1. 

Plot request variables The postprocessor program retrieves data from both a random-access binary data file (flsgrf) written by the solver, and an ASCII input file, flsinp. The flsinp file instructs the postprocessor as to what data is to be extracted from flsgrf and how that data is to be presented. Normally, an flsinp file is written by the preprocessor based on the modeling options and graphic requests in the pltreq file. This file will have the name flsinp.project, where "project" is the prepin filename suffix, or project name. An flsinp file may also be written from the Custom panel in the Analyze tab based on the plotting options selected. This file called flsinp.tmp for custom results plot requests. 



The user may customize either of these flsinp files using the Custom panel in the Analyze tab. Note that the file named flsinp.tmp is deleted when the Analyze tab is closed, so the user should be sure to save this file with another name if this file is to be kept for future use. See Customizing Plots Using the flsinp File for commonly created special plot requests. Naturally, the postprocessor cannot process data requests for information not found in flsgrf. If such a request is made, the postprocessor issues an error message and aborts. The flsinp file consists of namelist "contrl" followed by one or more occurrences of namelist "pltreq." Each occurrence of "pltreq" represents a separate data request. Complex overlay plots (such as 2-D contour plots with vector overlays) may require more than one "pltreq" data request block. 
Namelist $contrl 

 (Dimension E ≤ 20) NAME DEFAULT DESCRIPTION COLOR ... Controls the color for plotted data on all of the plot requests that follow.  (See description of COLOR in namelist PLTREQ) ICONV 0 Data conversion flag =0, do not show units on plots =1, show units on plots IDEBUG 0 Debug print flag. If IDEBUG=1, tables of flsgrf catalogs are printed. These catalogs describe the data available in flsgrf. ILEGND 0 Default color legend option for plots with color bars =0, horizontal color bar at top of plot =1, vertical color bar on right side of plot =2, same as ILEGND=1 without axes. IP3FNC 1 Controls format of FIELDVIEW®/ PLOT3D files =0, Q files =1, function files. LBAXIS 0  Controls format of axis tic label (for all X-Y plots that follow) =0, F format =1, E.1 format =2, E.2 format =3, E.3 format NAMVEW(E) ' '  Character variable (<50 characters) containing description of view E. (See XEA(E), YEA(E) and ZEA(E).) NTSKIP 0 Skip frequency to be used during the initial cataloging of the data  (see description under namelist pltreq). Default is to catalog all time points NXLAB 6 Number of tic-mark labels to be used on the X-axis (for 



all X-Y plots) NYLAB 6 Number of tic-mark labels to be used on the Y-axis (for all X-Y plots) OMODE 2 Time data output mode. Mode for writing time values to the GRFXMT output file =1, floating point =2, packed integers =3, packed characters. PLOTTING_UNITS_SYSTEM (also ICGS) -1 Units identifier for plots <1, no units =1, lbf, lbm, inches, seconds units =2, cgs units =3, si units =4, engineering units PLOTTING_TEMPERATURE_UNITS -1 Temperature units identifier for plots <0, no temperature units =0, Celsius =1, Kelvin =2, Fahrenheit =3, Rankine SIMULATION_TEMPERATURE_UNITS -1 Temperature units identifier for the data in the flsgrf results file <0, no temperature units =0, Celsius =1, Kelvin =2, Fahrenheit =3, Rankine SIMULATION_UNITS_SYSTEM (also ICGSO) -1 Units identifier for the data in the flsgrf results file <2, no units =2, cgs units =3, si units =4, engineering units TMIN 0.0  If TMAX > TMIN, TMIN is the minimum time value to be included in the catalog. Default is to catalog all time points.  TMAX 0.0  If TMAX > TMIN, TMAX is the maximum time value to be included in the catalog. Default is to catalog all time points XCA 0.0  X-coordinate of approximate mesh center (used for perspective plots) YCA 0.0  Y-coordinate of approximate mesh center (used for perspective plots) ZCA 0.0  Z-coordinate of approximate mesh center (used for perspective plots) XEA(E) ... X-coordinate of eye point for view E in all three-



dimensional perspective plots Default value is calculated based on mesh dimensions. (See NAMVEW(E).) YEA(E) ... Y-coordinate of eye point for view E in all three-dimensional perspective plots Default value is calculated based on mesh dimensions. (See NAMVEW(E).) ZEA(E) ... Z-coordinate of eye point for view E in all three-dimensional perspective plots Default value is calculated based on mesh dimensions. (See NAMVEW(E).) 
Namelist $pltreq Variables ADVFRM - BVAL2 NAME DEFAULT DESCRIPTION ADVFRM 1 Flag to advance frame =0, do not advance frame =1, advance frame. For plot requests with no overlays, ADVFRM should be set to '1'. If overlaying plots, ADVFRM should be set to '1' only in the last overlay request and set to '0' in each overlay request before the last. AUXFL1 ' ' Name of auxiliary data file 1 AUXFL2 ' ' Name of auxiliary data file 2 AUXFL3 ' ' Name of auxiliary data file 3 AUXFL4 ' ' Name of auxiliary data file 4 AUXFL5 ' ' Name of auxiliary data file 5 AUXFL6 ' ' Name of auxiliary data file 6 BVNAM1 ' '  First blanking variable name BVNAM2 ' ' Second blanking variable name BVAL1 0.0  Blanking value for first blanking variable (for spatial plots, if the value of BVNAM1 is less than or greater than BVAL1, then the corresponding cell is left blank; see IBV1). BVAL2 0.0  Blanking value for second blanking variable (for spatial plots, if the value of BVNAM2 is less than or greater than BVAL2, then the corresponding cell is left blank; see IBV2). 
Namelist $pltreq Variables CLRTPS - DRWFRM NAME DEFAULT DESCRIPTION CLRTPS ' ' If specified, this quantity is used to color surface contours (OMODE=-5). CLRTPV ' ' If specified, this quantity is used to color the velocity vectors (OMODE=-3). COEF0 1.0 Coefficients used for ITRANS=2 



COEF0C 1.0 Coefficients used for ITRANSC=52 COEF1 0.0 Coefficients used for ITRANS=2, 41 and 42 COEF1C 0.0 Coefficients used for ITRANSC=52 COEF2 0.0 Coefficients used for ITRANS=2, 41 and 42 COEF2C 0.0 Coefficients used for ITRANSC=52 COEF3 0.0 Coefficients used for ITRANS=2, 41 and 42 COEF3C 0.0 Coefficients used for ITRANSC=52 COEF4 0.0 Coefficients used for ITRANS=2 COEF4C 0.0 Coefficients used for ITRANSC=52 COLOR ... Controls the color for the plotted data for the current request (for plots that would otherwise be black and white). Color may be set to a value between zero and one. The color is interpolated from the current color bar with values near zero corresponding to the color at the low end of the color bar and values near one corresponding to the color at the high end of the color bar. Any color set by this mechanism can be overridden.  DATA_SOURCE 1 Specifies the type of data to be used =1, restart data =2, selected data DEVMAX 0.25 Maximum fractional deviation permitted when using data smoothing transformation option (ITRANS=8). DRWFRM 1 Flag to draw frame =0, do not draw frame =1, draw frame. For plot requests with no overlays, DRWFRM should be set to '1'. If overlaying plots, DRWFRM should be set to '1' in the first request and to '0' in each overlay request afterward. 
Namelist $pltreq Variables IBINRY - IFRHID NAME DEFAULT DESCRIPTION IAPPEND 0 =0, do not append to list of previously-generated files =1, append newly-generated iso-surface files to the list of previously-generated iso-surface files. IBINRY 0 Binary/ASCII flag for ENSIGHT® export data =0, ASCII output =1, binary output IBLANK 0 Controls IBLANK data for data export files (FIELDVIEW®, ENSIGHT® and PLOT3D export files). =0, no IBLANK data written =1, write standard IBLANK data =2, write special IBLANK data (for FIELDVIEW® files only). For FIELDVIEW® data, IBLANK may be set to 1 or 2 in either a fluid surface (F*VF) request or a volume fraction request. BVAL1 should also be set in the same request for data export. 



IBV1 1 This variable controls the blanking test for the first blanking variable. If IBV1=1, cells are blanked whenever "BVNAM1.LE.BVAL1" If IBV1=2, cells are blanked whenever "BVNAM1.GT.BVAL1" IBV2 1 This variable controls the blanking test for the second blanking variable. If IBV2=1, cells are blanked whenever "BVNAM2.LE.BVAL2" If IBV2=2, cells are blanked whenever "BVNAM2.GT.BVAL2" ICMP 0 Component index. Data that is independent of the computational mesh structure is given ICMP=0. Since FLOW-3D is a single component application program, all data that is NOT independent of the computational mesh is given ICMP=1. ICTPS 1 Iso-surface type flag =0, show wireframe =1, show solid iso-surface =2, show solid iso-surface and transparent obstacle =3, show solid iso-surface and transparent obstacle complement =4, show solid iso-surface and solid obstacle =5, show solid iso-surface and solid obstacle complement IFRHID 2 Hidden line option for three-dimensional plot frames =0, do not draw hidden frame edges =1, draw hidden frame edges as solid lines =2, draw hidden frame edges as dotted lines IFSICMP(N) -1 Unique FSI component number =0, solidified fluid region >0, FSI component 
Namelist $pltreq Variables IHIDE - ITMGRP NAME DEFAULT DESCRIPTION IHIDE 0 Hidden surface flag for three-dimensional surface plots =0, plot all surfaces =1, remove hidden surfaces using orientation test and blockage =2, remove hidden surfaces using only surface orientation test. ILEGND 0 Color legend option for plots with color bars =0, horizontal color bar at top of plot =1, vertical color bar on right side of plot =2, same as ILEGND =1 without axes IPASN 1 Surface contour flag =0, use three-dimensional shifted points for surface contours =1, plot contours in coordinate planes =2, plot contours in x planes =3, plot contours in y planes =4, plot contours in z planes =5, use 4-sided surface elements but only plot edges ISYM 0 =0, do not open iso-surface along symmetry plane boundaries =1, open iso-surface along symmetry plane boundaries. 



ISYMH 0 Symmetry option in the horizontal direction (for spatial plots) =0, no symmetric image in the horizontal direction =1, make symmetric image of plot with respect to the origin of the horizontal axis ISYMV 0 Symmetry option in the vertical direction (for spatial plots) =0, no symmetric image in the vertical direction =1, make symmetric image of plot with respect to the origin of the vertical axis ITMGRP 1 Time group for ENSIGHT® export data =1, spatial data =3, animation data 
Namelist $pltreq Variable ITRANS and ITRANSC NAME DEFAULT DESCRIPTION ITRANS 0 Causes the postprocessor to transform or manipulate plotting data. NOTE: PVNAM1 AND IVARN MUST ALWAYS BE SPECIFIED. IXVARN IS ONLY NEEDED WHEN  A VALUE DIFFERENT FROM IVARN IS NEEDED FOR XVNAM.   =0, no transformation   Mach Number Transformation =6, converts fluid velocity to Mach number (for 1-D plots and 2-D contours). The velocity components and fluid temperature are specified by: PVNAM1 IVARN <=> U XVNAM (6) IXVARN (6) <=> V XVNAM(7) IXVARN(7) <=> W XVNAM(8) IXVARN(8) <=> TN This option uses RF2 (gas constant).   Fluid Speed Transformations =1, converts three vector components into a scalar magnitude (for 1-D plots and 2-D contours). The three components are specified by PVNAM1 IVARN <=> U XVNAM (6) IXVARN (6) <=> V XVNAM(7) IXVARN(7) <=> W =61, converts three vector components into a scalar magnitude (for iso-surfacing). The three components are specified by PVNAM1 IVARN <=> U XVNAM (6) IXVARN (6) <=> V XVNAM(7) IXVARN(7) <=> W   Total Pressure Transformations =30, converts static pressure to total pressure (for 1-D plots and 2-D contours). The data is specified by XVNAM (6) IXVARN (6) <=> U XVNAM(7) IXVARN(7) <=> V XVNAM(8) IXVARN(8) <=> W 



XVNAM(9) IXVARN(9) <=> P XVNAM(10) IXVARN(10) <=> RHO or  XTRANS=density If density is a computed value, use XVNAM(10). If it is constant, use XTRANS. =33, converts static pressure to total pressure (for iso-surfacing). The data is specified by PVNAM1 IVARN <=> P XVNAM(6) IXVARN(6) <=> U XVNAM(7) IXVARN(7) <=> V XVNAM(8) IXVARN(8) <=> W  XVNAM(9) IXVARN(9) <=> RHO or XTRANS=density If density is a computed value, use XVNAM(9). If it is constant, use XTRANS.   General Solidification Criterion Function Transformations =2, converts solidification parameters into general solidification criteria functions for predicting defects (for 1-D plots and 2-D contours). This uses the coefficients COEF0-COEF4, which must be specified. The cooling rate, temperature gradient, solidus velocity and local solidification time are specified by PVNAM1 IVARN <=> SLDCLR XVNAM(6) IXVARN(6) <=> SLDGRD XVNAM(7) IXVARN(7) <=> SLDVEL XVNAM(8) IXVARN(8) <=> SLDLST The criterion function is calculated as follows. COEF0 * SLDCLRCOEF1 * SLDGRDCOEF2 * SLDVELCOEF3 * SLDLSTCOEF4   Solute Concentration in Liquid Transformations =41, converts the liquid/solid mixture composition to liquid composition, using coefficients COEF1 (the partition coefficient), COEF2 (the eutectic temperature), and COEF3 (the eutectic concentration), which must be specified. The composition, solid fraction and temperature are specified by PVNAM1 IVARN <=> SCL1 XVNAM(6) IXVARN(6) <=> FS XVNAM(7) IXVARN(7) <=> TN =42, converts the liquid/solid mixture composition to solid composition, using coefficients COEF1 (the partition coefficient), COEF2 (the eutectic temperature), and COEF3 (the eutectic concentration), which must be specified. The composition, solid fraction and temperature are specified by PVNAM1 IVARN <=> SCL1 XVNAM(6) IXVARN(6) <=> FS XVNAM(7) IXVARN(7) <=> TN    Arithmetic Transformations =4, evaluates the difference of the quantity specified as 



PVNAM1 IVARN less the quantity specified as XVNAM(6) IXVARN(6) =10, Sum two arrays (element by element) specified by PVNAM1 IVARN XVNAM(6) IXVARN(6) =11, Multiply two arrays (element by element) specified by PVNAM1 IVARN XVNAM(6) IXVARN(6) =12, Divide two arrays specified by PVNAM1 IVARN (dividend) XVNAM(6) IXVARN(6) (divisor) =13, Scale each element of the array specified by PVNAM1 by XTRANS and add XTRANA (for 1-D plots, 2-D contours, and iso-surfacing). =20, Evaluate the difference of consecutive values in an array. (The first result is always zero.) Input array is specified by XVNAM(6) IXVARN(6)   Smoothing and Min / Max Transformations =7, Smooth a one-dimensional array of data by replacing each value with a moving average. The moving average uses MAVE values on either side, plus the central value. Input array is specified by XVNAM(6) IXVARN(6) =8, Smooth data by eliminating "outliers." Replace values that deviate from the moving average (as calculated by option 7) by a fraction greater than DEVMX with the moving average value. Values within the deviation band are not changed. Input array is specified by XVNAM(6) IXVARN(6) =23, Replace each array value with the cumulative maximum value. If a higher maximum is found toward the end of the array, that value will not affect array entries with a lower index. Input array is specified by XVNAM(6) IXVARN(6) =24, Replace each array value with the cumulative minimum value. If a lower minimum is found toward the end of the array, that value will not affect array entries with a lower index. Input array is specified by XVNAM(6) IXVARN(6)   Integration and Differentiation Transformations  =22, Evaluate the integral (with respect to time) of the array data by trapezoidal integration. (The first result is always zero.) Input array is specified by XVNAM(6) IXVARN(6)  =25, Differentiate (with respect to time) consecutive values of the array data with time. (The first result is always zero.) Input array is specified by 



XVNAM(6) IXVARN(6) ITRANSC 0 Causes the postprocessor to transform or manipulate data used for coloring iso-surfaces, vectors and streamlines. NOTE: PVNAM1 AND IVARN MUST ALWAYS BE SUPPLIED TO SAVE SPACE FOR OUTPUT DATA EVEN WHEN THEY ARE NOT USED AS INPUT. IXVARN IS ONLY NEEDED WHEN TRANSFORMING ANIMATION DATA. The following fluid properties are read directly from the flsgrf file: gas constant, RF2.   =0, no transformation   Fluid Speed Transformations =51 or 71, converts three vector components into a scalar magnitude (for coloring iso-surfaces, vectors and streamlines). The three components are specified by CLRTPS IVARN <=> U XVNAM (2) IXVARN (2) <=> V XVNAM(3) IXVARN(3) <=> W   Total Pressure Transformations =31 or 32, converts static pressure to total pressure (for coloring iso-surfaces, vectors and streamlines). The data is specified by CLRTPV IVARN <=> U XVNAM (2) IXVARN (2) <=> V XVNAM(3) IXVARN(3) <=> W XVNAM(4) IXVARN(4) <=> P XVNAM(5) IXVARN(5) <=> RHO or XTRANS=density If density is a computed value, use XVNAM(5). If it is constant, use XTRANS.   General Solidification Criterion Function Transformations =52, converts solidification parameters into general solidification criteria functions for predicting defects (for coloring iso-surfaces). This uses the coefficients COEF0C-COEF4C, which must be specified. The cooling rate, temperature gradient, solidus velocity and local solidification time are specified by CLRTPS IVARN <=> SLDCLR XVNAM(2) IXVARN(2) <=> SLDGRD XVNAM(3) IXVARN(3) <=> SLDVEL XVNAM(4) IXVARN(4) <=> SLDLST The criterion function is calculated as follows. COEF0C * SLDCLRCOEF1C * SLDGRDCOEF2C * SLDVELCOEF3C * SLDLSTCOEF4C   Arithmetic Transformations =14, Scale each element of the array specified by CLRTPS by XTRANS and add XTRANA (for coloring iso-surfaces). 
Namelist $pltreq Variables IVARN - IVRNP5 NAME DEFAULT DESCRIPTION 



IVARN 0 This index is used to select data associated with the first dependent variable name (PVNAM1) when multiple data entries occur for the same variable name (e.g., it could specify a sample volume, baffle, a history location, or a particular mesh boundary associated with the desired data). For spatial data and mesh independent history data, IVARN=0 is used. For animation data, IVARN=-1 is used. IVEW 0 Perspective viewpoint (corresponds to index 'E' of XEA, YEA, ZEA and NAMVEW in namelist CONTRL). IVRNB1 'IVARN' Index used to select data associated with the first blanking variable name (BVNAM1). See description for IVARN. IVRNB2 'IVARN' Index used to select data associated with the second blanking variable name (BVNAM2). See description for IVARN. IVRNP2 'IVARN' Index used to select data associated with the second dependent variable name (PVNAM2). See description for IVARN. IVRNP3 'IVARN' Index used to select data associated with the third dependent variable name (PVNAM3). See description for IVARN. IVRNP4 'IVARN' Index used to select data associated with the fourth dependent variable name (PVNAM4). See description for IVARN. IVRNP5 'IVARN' Index used to select data associated with the fifth dependent variable name (PVNAM5). See description for IVARN. 
Namelist $pltreq Variables IX - JMIN (Dimensions N < 10, I < 3) NAME DEFAULT DESCRIPTION IX 0 First independent variable index (assigned to the horizontal axis) =0, Time =1, X-coordinate =2, Y-coordinate =3, Z-coordinate. IY 0 Second independent variable index (assigned to the vertical axis for 2-D plots or the second horizontal axis for 3-D plots) =0, no second independent variable (dependent variable will be used) =2, Y-coordinate =3, Z-coordinate. IZ 0 Third independent variable index (assigned to the vertical axis for 3-D plots) =0, no third independent variable =3, Z-coordinate. IXCMP(M) … The list of mesh blocks to be plotted. Blocks are plotted in the order that they appear in the list (i.e., IXCMP(1) is plotted first, IXCMP(2) is plotted second, etc.). Maximum number of blocks is 150. IXNOFF(N) 'NOFF' Data offset for XVNAM(N). See description for NOFF. IXVARN(N) 'IVARN' Index used to select data associated with variable XVNAM(N). See description for IVARN. 



JMAX(I) ... Maximum cell index for the Ith spatial independent variable. Cells whose index is greater than JMAX (I) are excluded from presentation. I=1 corresponds to x-coordinate, I=2 corresponds to y-coordinate and I=3 corresponds to z-coordinate. Default is the last real cell for the data. JMIN(I) ... Minimum cell index for the Ith spatial independent variable. Cells whose index is less than JMIN(I) are excluded from presentation. (See JMAX for description of I index) Default is the first real cell for the data. JVMAX(I) ... Maximum cell index for the Ith spatial independent variable for 3D velocity vector plots. Cells whose index is greater than JVMAX (I) are excluded from presentation. I=1 corresponds to x-coordinate, I=2 corresponds to y-coordinate and I=3 corresponds to z-coordinate. Default is the last real cell for the data. JVMIN(I) ... Minimum cell index for the Ith spatial independent variable for 3D velocity vector plots. Cells whose index is less than JVMIN(I) are excluded from presentation. (See JVMAX for description of I index) Default is the first real cell for the data. 
Namelist $pltreq Variable KOPPLT NAME DEFAULT DESCRIPTION KOPPLT 0 Flag used for setting special plotting options. The plotting option selected is determined by the values of both OMODE and KOPPLT:  OMODE KOPPLT DESCRIPTION -8 1 Subdivide cells for higher resolution contours -8 2 No color interpolation (cells are color-shaded according to their cell-centered value) -8 3 Use the complement of volume and area fractions (used for contouring wall temperatures) -8 4 A combination of KOPPLT=1 and KOPPLT=3 -8 5 A combination of KOPPLT=2 and KOPPLT=3 -5 1 Contour the product of 'PVNAM1' and 'BVNAM1' -5 2 Use the product of 'BVNAM1' and 'BVNAM2' as the blanking function -5 3 Contour the complement of 'PVNAM1' -5 4 Contour the product of the complement of 'PVNAM1' and 'BVNAM1' -5 5 Contour the product of 'PVNAM1', 'BVNAM1' and ‘BVNAM2’ -5 6 Contour the product of the complement of 'PVNAM1', 'BVNAM1' and ‘BVNAM2’ -4 1 Denotes color for two-dimensional particle plots -3 1 Color 2-D vector plots by 2-D magnitude 



-3 2 2-D plots: Color 2-D vector plots by 3rd component or 3-D plots: 3-D vector plots: plot all vectors (no color) -3 3 2-D plots: Color 2-D vector plots by color variable or 3-D plots: 3-D vector plots: plot vectors on front faces (no color) -3 4 3-D vector plots: plot vectors on back faces (no color) -3 5 3-D vector plots: plot only vector components on front faces (no color) -3 6 3-D vector plots: plot only vector components on back faces (no color) -3 23 3-D vector plots: plot all vectors (color by color variable) -3 33 3-D vector plots: plot vectors on front faces (color by color variable) -3 43 3-D vector plots: plot vectors on back faces (color by color variable) -2 1 Use the complement of volume and area fractions (used for contouring wall temperatures) -2 2 A combination of KOPPLT=1 and KOPPLT=3 -2 3 Color contour lines -1 -1 Don't center cell edge data -1 0 Center cell edge data 0 1 Use solid rather than dashed lines for any auxiliary data 6 0 FIELDVIEW® or PLOT3D scalar data 6 1 FIELDVIEW® or PLOT3D vector data 6 2 FIELDVIEW® or PLOT3D scalar data (wall temperature) 6 3 FIELDVIEW® or PLOT3D constant scalar data 8 0 ENSIGHT® scalar data 8 1 ENSIGHT® vector data 8 2 ENSIGHT® scalar data (wall temperature) 8 3 ENSIGHT® constant scalar data 10 0 Write cell centered data to neutral file 10 1 Write interpolated data to neutral file 
Namelist $pltreq Variables LBAXIS - NYLAB NAME DEFAULT DESCRIPTION LBAXIS 0 Controls format of axis tic label on X-Y plots =0, F format =1, E format MAVE 5 Number of data points used on either side of each value when data smoothing transformation is used (ITRANS=7 or 8). NC 0 Number of contours (used only for contour plots). NCNTMX 1000 Maximum integration count for computing streamlines. 



NFRVEC(I) 1 Velocity vector skip factor, where I=1 corresponds to x-coordinate direction, I=2 corresponds to y-coordinate direction and I=3 corresponds to z-coordinate direction. A value of N results in every Nth vector being plotted in the Ith direction. If N=1, every velocity vector is plotted. NOFF 0 Data offset. Omit first NOFF data values of dependent variable (normally NOFF=0). NTRC 0 Number of streamlines to be drawn. NTSKIP 0 Skip frequency for time points =0,1 use every point =2, use alternate points =3, use every third point, etc. NXLAB 6 Number of tic-mark labels to be used on the horizontal axis NYLAB 6 Number of tic-mark labels to be used on the vertical axis 
Namelist $pltreq Variables OMODE - PVNAM5 NAME DEFAULT DESCRIPTION OMODE 0 Output mode. Describes the format in which the data is to be presented =-11, FSI data file =-10, three-dimensional streamline plot =-9, two-dimensional baffle plot =-8, two-dimensional color contour and obstacle plot =-7, two-dimensional grid plot =-6, two-dimensional obstacle plot =-5, three-dimensional contour surface plot =-4, three-dimensional particle plot =-3, vector plot =-2, contour plot  =-1, FLSLNK file output =0, X-Y plot =5, RESTART file output  =6, FIELDVIEW® or PLOT3D time-dependent data =7, FIELDVIEW® or PLOT3D grid data =8, ENSIGHT® time-dependent data =9, ENSIGHT® grid data =10, neutral file output. PMAX(I)  Maximum coordinate value for the Ith spatial independent variable. Cells whose maximum coordinate is less than PMAX(I) are excluded from presentation. I=1 corresponds to x-coordinate, I=2 corresponds to y-coordinate direction and I=3 corresponds to z-coordinate direction. This variable is used in place of JMIN(I) when plotting multiple mesh blocks. Default is the maximum coordinate value in the Ith spatial direction. PMIN(I) … Minimum coordinate value for the Ith spatial independent variable. Cells whose maximum coordinate is less than PMIN(I) are excluded from presentation. I=1 corresponds to x-coordinate, I=2 corresponds to y-coordinate direction and I=3 corresponds to z-coordinate direction. This variable is used in place of JMIN(I) when plotting multiple mesh blocks. Default is the minimum coordinate value in the Ith spatial direction. 



PVMAX(I)  Maximum coordinate value for the Ith spatial independent variable for 3D velocity vector plots. Cells whose maximum coordinate is less than PVMAX(I) are excluded from presentation. I=1 corresponds to x-coordinate, I=2 corresponds to y-coordinate direction and I=3 corresponds to z-coordinate direction. This variable is used in place of JVMIN(I) when plotting multiple mesh blocks. Default is the maximum coordinate value in the lth spatial direction. PVMIN(I) … Minimum coordinate value for the Ith spatial independent variable for 3D velocity vector plots. Cells whose maximum coordinate is less than PVMIN(I) are excluded from presentation. I=1 corresponds to x-coordinate, I=2 corresponds to y-coordinate direction and I=3 corresponds to z-coordinate direction. This variable is used in place of JVMIN(I) when plotting multiple mesh blocks. Default is the minimum coordinate value in the Ith spatial direction. PROT 0.0 Number of degrees to rotate the 3-D coordinate system (3-D plots only) PVNAM1 ' ' First dependent variable name. PVNAM2 ' ' Second dependent variable name. PVNAM3 ' ' Third dependent variable name. PVNAM4 ' ' Fourth dependent variable name. PVNAM5 ' ' Fifth dependent variable name. 
Namelist $pltreq Variables QMN - TMIN NAME DEFAULT DESCRIPTION QMN ... User-specified minimum contour value for contour plots (OMODE=-2 or OMODE=-8). If both QMN and QMX are input, all of the plots generated will have the same contour scale. If QMN and QMX are both set to zero, all of the plots generated will use the same contour scale; but the minimum and maximum of that scale will be determined by the minimum and maximum of the accumulated data for all of those plots. QMX ... User-specified maximum contour value for contour plots (OMODE=-2 or OMODE=-8). See description of QMN for further information. QVAL ... Value contoured in three-dimensional surface plots. Default is the average of the minimum and maximum values in the data. QVOBS … Contour value used for drawing iso-surface of volume fraction. SQMN ... Value to be assigned to the low end of the color bar when coloring three-dimensional surface plots (OMODE=-5). If both SQMN and SQMX are input, all of the plots generated will have the same color scale. If both SQMN and SQMX are set to zero, all of the plots generated will use the same color scale; but the minimum and maximum of that scale will be determined by the minimum and maximum of the accumulated data for all of those plots. SQMX ... Value to be assigned to the high end of the color bar when coloring three-dimensional surface plots (OMODE=-5). See description of SQMN for further information. TITLE ' ' Character title for plots (< 50 characters) 



TMAX 1.0E+6 Maximum time value. Data subsequent to T=TMAX is not included in the presentation. TMIN 0.0  Minimum time value. Data prior to T=TMIN is not included in the presentation. 
Namelist $pltreq Variables VARMIN - VSCALE NAME DEFAULT DESCRIPTION VARMIN 1.0E-6  Minimum data variation factor for contouring If FMIN is the minimum data value and FMAX is the maximum data value, then contour plots are not generated when: (FMAX-FMIN) <= VARMIN*(ABS(FMIN)+ABS(FMAX)) VAXMAX ... For time-history plots, VAXMAX is used as the horizontal axis maximum Default is the maximum of the independent variable data. VAXMIN ... For time-history plots, VAXMIN is used as the horizontal axis minimum Default is the minimum of the independent variable data. VAYMAX ... For time-history plots, VAYMAX is used as the vertical axis maximum  Default is the maximum of the dependent variable data. VAYMIN ... For time-history plots, VAYMIN is used as the vertical axis minimum  Default is the minimum of the dependent variable data. VMAX ...  If input, VMAX is used as the maximum velocity for scaling velocity vectors When VMAX is input, all of the plots generated will have the same velocity vector scale. Furthermore, if VMAX is input as a negative value, the maximum velocity will be determined from the accumulated data for all of the plots to be generated in the specified time interval from TMIN to TMAX. VQMN ... Value to be assigned to the low end of the color bar when coloring velocity vectors (OMODE=-3). If both VQMN and VQMX are input, all of the plots generated will have the same color scale. If VQMN and VQMX are both set to zero, all of the plots generated will use the same contour scale; but the minimum and maximum of that scale will be determined by the minimum and maximum of the accumulated data for all of those plots. VQMX ... Value to be assigned to the high end of the color bar when coloring velocity vectors (OMODE=-3). See description of VQMN for further information. VSCALE 1.0  Scaling multiplier for velocity vectors. Also used to specify a constant density value for evaluation of momentum for export data (FIELDVIEW®, ENSIGHT® or PLOT3D) and to specify a constant value of data to be written to an export data file. When using the shallow water option, this parameter can be used to magnify surface height variations in 3-D surface plots. 
Namelist $pltreq Variables XSHRNK - YMAG (Dimensions N < 100) 



NAME DEFAULT DESCRIPTION XSHRNK 1.0  Shrinkage factor (between 0.0 and 1.0) used to shrink plot size in the horizontal direction. XTRANA 0.0 Constant additive value used for data transformations (ITRANS=13, ITRANS=14). XTRANS 1.0 Constant scaling value used for data transformations (ITRANS=13, ITRANS=14). Also used for constant density for ITRANS=30, 31, 32, and 33. XVNAM(N) ' ' Dependent variable name of additional data to be used for data transformation (ITRANS>0). See ITRANS for specific use. XTRC(L) … X-coordinate of origin of streamline L; (L < 50) YTRC(L) … Y-coordinate of origin of streamline L; (L < 50) ZTRC(L) … Z-coordinate of origin of streamline L; (L < 50) YSHRNK 1.0  Shrinkage factor (between 0.0 and 1.0) used to shrink plot size in the vertical direction. YMAG 1.0  Multiplication factor for vertical coordinates of plot (with the maximum plot area being retained) > 0.0 and < 1.0, shrinks plot size in vertical direction > 1.0, magnifies plot in vertical direction.  



Chapter 8 - Restarts 
Performing Restarts A restart is a continuation from a previous FLOW-3D simulation. The restart may simply pick up where a previous simulation ended and continue to a later time, or various parameters may be changed for the restart run. For example, the user might have already run a spillway simulation to steady-state and decided a finer mesh is needed.  The user may not want to run the full simulation again with a finer mesh because the steady-state condition is all the user needs and the time to run the simulation from the beginning is too long. A restart simulation will begin with the full steady-state flow field of the previous simulation interpolated into a finer mesh. The computational grid can be changed arbitrarily in a restart simulation as long as both initial and restart grids are either Cartesian or cylindrical. The new grid can be finer or coarser than the old one, and can occupy a smaller or larger volume. The output data is transferred from the old grid to the new one via interpolation in the regions where the grids overlap. Regions in the new mesh where no restart data is available are initialized using data from the new input (prepin.*) file. To set up a restart simulation, right-click the previous (original) simulation file in the Portfolio on the Navigator tab and select Add Restart Simulation.  A New Simulation dialog box will open as shown below. 



 

 

 Enter a name for the restart simulation or leave the default name. The default Create Subdirectory Using Simulation Name keeps the simulations organized in separate folders, and is required for restart simulations. Selected geometry files will be copied to the new directory for the restart simulation. If the files are not copied, FLOW-3D will specify the original simulation geometry files for the restart simulation. OK creates the new simulation input file, folder, and geometry files.   Check and modify the restart settings on Model Setup > General tab > Restart. The Restart Options dialog is automatically activated when the restart simulation is created, and appears as below: 



 

 

 Activate Restart Options sets the simulation to begin from an existing output (flsgrf.*) file, specified as Restart Source File. In the Time group, select Restart Time from the dropdown list of restart times in the specified output file.  Reset Time to Zero starts the new simulation at t=0 corresponding to the time selected as the Restart Time in the original simulation. If this option is not selected, the restart simulation will begin with t=Restart Time, and the new finish time must be increased accordingly on Model Setup > General tab > Finish Time. Keep in mind that if there are time-dependent parameters in the previous run (e.g., boundary conditions or moving object parameters), and Reset Time to Zero is selected, the time dependent variables will start at t=0 again in the restart.  For example, the user has a General Moving Object that moves for 10 seconds and then stops for 10 seconds.  A restart simulation is created, with Reset Time to Zero activated. If the General Moving Object physics are turned off or the moving component motion type set to non-moving, then the 



 

 

object won’t move in the restart simulation. But if the user neglects to change the motion then the object will start moving again. NOTES: DIFFICULTIES MAY ARISE IF COMPONENTS ARE REMOVED FROM A RESTART SIMULATION BECAUSE THERE IS NO FLUID FLOW DATA WHERE THE COMPONENT WAS PREVIOUSLY. COMPONENTS CAN USUALLY BE ADDED TO RESTARTS. BAFFLES MAY BE ADDED OR REMOVED BUT MAY CAUSE PRESSURE ITERATION PROBLEMS AS THE FLOW FIELD ADJUSTS.  During the restart run, the post-processor is called by the pre-processor to extract restart data from the flsgrf.* file. This data is then passed to the solver as initial condition data. If the data was not included in the previous run output (e.g., if turbulence is turned on for the restart but was not active in the original) then the simulation will encounter an error. Alternatively, the user may wish to re-specify an aspect of the restart simulation and ignore data from the original simulation. Special restart options have been included for these cases, and are described below. 
Restart Options 
Fluid Distribution TIME Restart Time Specifies the time in the original output file to be used as the initial conditions of the restart simulation.  Reset Time to Zero Makes the time in the original output file equal to t=0 in the restart simulation. Initial Time Step Specifies the first time step length of the restart simulation. If not specified, the time step will be estimated from the restart data.  Set on the order of 1E-3 to 1E-6 when changing geometry to ease the pressure solution in the first few time steps. FLUID INITIALIZATION Fill Non-Empty Cells With Fluid #1 Sets all fluid fraction F values for all cells to unity, completely filling the simulation. The added fluid volume and energy are reported in the solver summary (hd3out.*) and message (hd3msg.*) files. Often used in metal-casting simulations to avoid incorrectly identifying numerical porosity appearing in the restart of a filling simulation as shrinkage porosity. Cells usually have F slightly less than 1 at the end of filling simulations. This is due to velocity divergence caused by the mathematics of the fluid advection and pressure solutions. Reset Velocities to Zero Sets all velocity vectors to zero, and therefore sets pressure to static (atmospheric, as defined by PVOID). Often used for metal-filling simulations where velocities are large due to the reasons above. The large divergent velocities can result in small time-steps and convergence difficulties in the restart solidification simulations. TURBULENCE Restart With All Data as Needed Assumes that the original simulation used a viscous turbulent flow 



 

 

model. Do Not Use TKE or DTKE Data Allows a turbulence model to be activated in the restart when the original simulation used the viscous laminar model. Do Not Use Mu, TKE, or DTKE Data Allows turbulence and/or viscous flow models to be activated in the restart when the original model assumed inviscid flow. SCALAR TRANSPORT Restart With All Scalar Data Assumes that scalar data needed by the restart simulation is present in the flsgrf.* file of the original simulation. Scalar Data Reset in Input Allows scalar physics to be introduced in the restart simulation. PARTICLES Reset With All Particle Data Assumes that particle data needed by the restart simulation is present in the flsgrf.* file of the original and is desired. Particle Data Reset in Input Allows particle physics to be introduced in the restart or resets existing particle data to that specified in the prepin file. THERMAL OPTIONS RESTART DATA Restart With All Data as Needed Uses the full thermal solution available from the original simulation. Fluid/Solid Temperature Reset in Input Resets fluid, component, and mesh boundary temperatures, as well as component moisture content (see Moisture in Sand Molds) using information from the restart simulation file. Allows heat transfer to be activated. Use Solid Temperatures Only Only component temperatures from the first run are used for the restart calculation. All other parameters are reset, including fluid initialization. Void Data Reset in Input Resets the number of voids and void heat transfer data to values specified in the restart input (prepin.*) file. THERMAL OPTIONS INITIALIZATION Restart Based on Internal Energy Calculates temperature using internal energy data from the flsgrf.* file. Restart Based on Temperature Calculates temperature using internal energy data from the flsgrf.* file. THERMAL OPTIONS SOLIDIFICATION DATA Don’t Evaluate Solidification Data The restart simulation neither reads nor writes solidification data. Evaluate Solidification Data Evaluates solidification data and writes it to the new output file. The default for solidification simulations. Restart with Previous Solidification Data Reads solidification data from the previous simulation output and writes solidification output to the new flsgrf.* file. 
Grid Overlay (GO) Mesh boundary conditions can also be arbitrarily changed at restart. A special type of mesh boundary condition, called Grid Overlay (GO) can be used to interpolate a new spatially-varied boundary condition 



 

 

from flow output within the original domain. Restart data taken from the original grid will be used to set flow parameters at the boundary. The boundary flow will be fixed throughout the restart simulation and will use velocity to solve the flow parameters (the original pressure solution will be ignored). GO boundary areas that don't overlap the old grid are treated as fixed velocity boundaries and are initialized from restart simulation data. 
Non-Inertial Reference Frames When IACRST = 1, then non-inertial reference frame data are reset using the information from the restart input (prepin.*) file. The default setting for this flag is 0 and fixes the non-inertial reference frame data using the values at the output time step of the original simulation. 



Chapter 9 - Customization DISCLAIMER: FLOW SCIENCE, INC. IS NOT RESPONSIBLE FOR CUSTOMIZATIONS ADDED BY THE USER. FLOW-3D SUPPORT INCLUDES GENERAL GUIDANCE ON CUSTOMIZING, BUT DOES NOT INCLUDE SPECIFIC INFORMATION ON MODIFYING FLOW-3D FOR SPECIAL USES. FLOW-3D SUPPORT DOES NOT INCLUDE TROUBLESHOOTING USERS' MODIFICATIONS. 
General Customization Information The FLOW-3D distribution includes a variety of FORTRAN source subroutines that allow the user to customize FLOW-3D to meet their requirements.  The FORTRAN subroutines provided allow the user to customize boundary conditions, include their own material property correlations, specify custom fluid forces (i.e., electromagnetic forces), add physical models to FLOW-3D, and more. Several "dummy" variables have been provided in the input file namelists that users may utilize for custom options. A user definable namelist has also been provided for customization. Makefiles are provided for Linux and Windows distributions and Visual Studio solution files are provided for Windows distributions to allow users to recompile the FLOW-3D code with their customizations.  NOTE: TO RUN THE CUSTOM DOUBLE PRECISION OR CUSTOM SINGLE PRECISION VERSION VIA THE FLOW-3D GRAPHICAL INTERFACE, SELECT THE DESIRED VERSION FROM THE VERSION DROPDOWN LIST ON THE MODEL SETUP, GENERAL TAB. TO RUN A CUSTOM VERSION VIA BATCH MODE OR COMMAND PROMPT, THE ENVIRONMENT VARIABLE F3D_VERSION MUST BE SET TO PREHYD FOR CUSTOMIZED DOUBLE PRECISION OR PREHYD_S FOR CUSTOMIZED SINGLE PRECISION. 
Procedures for Customization 

Customizing FLOW-3D on Windows The following software is required to customized FLOW-3D on Windows: 
� Intel FORTRAN 11.1.048 (includes Visual Studio 2008) Optional: 
� Visual Studio 2008 Professional 
� Visual Studio 2005 Professional 
� Windows Platform SDK Not supported:  
� Visual Studio 2010 Intel FORTRAN 11.1.048 is available for both 32-bit and 64-bit Windows. Microsoft Visual Studio 2008 is provided with Intel FORTRAN 11.1.48 for both platforms. The user may choose to use the Visual Studio 2008 



installation provided with Intel FORTRAN 11.0.48 but may also opt to use Visual Studio 2005, Visual Studio 2008 Professional, or Windows Platform SDK. The version of Microsoft Visual Studio 2008 provided with Intel FORTRAN 11.1.48 does not provide a command line build environment however. If a command line build environment is preferred, consider installing Intel FORTRAN 11.1.48 and Windows Platform SDK. Visual Studio solution files for both Visual Studio 2005 and 2008 are located in the “prehyd” directory (for double precision) and the “prehyd_s” directory (for single precision). The solution files for the double precision version are named: custom_double_2005.sln (for Visual Studio 2005) and  custom_double_2008.sln (for Visual Studio 2008) the single precision solution files are named: custom_single_2005.sln (for Visual Studio 2005) and  custom_single_2008.sln (for Visual Studio 2008) The solution files are used to build the solver executable from within Visual Studio. The FORTRAN source files have the extension .F and are located in the /flow3d/vx.x/source directory. The object files are binary files that cannot be edited, have the extension .OBJ, and are compiled versions of the source files. 
Visual Studio Solution Files: Compiling and Linking Visual Studio solution files are used by Visual Studio to keep track of which files are needed to build the executable. They contain a list of all the files in the project and a list of dependencies. Dependencies are used to keep track of what files are affected by changes to a particular file. The Solution Explorer in Visual Studio contains a list of all the files—source files, object files, modules, and libraries – necessary to build the executable. Files are arranged in alphabetical order. To edit a source file (*.F), double-click on that file in the Solution Explorer and it will open in context-sensitive editing window. After changes are made to a source file, save it and rebuild the executable by selecting Build Solution from the Build menu. This will compile the file you modified and create a new executable. A new hydr3d.exe executable will be created and placed in the /flow3d/vx.x/prehyd or prehyd_s/hydr3d/Release subdirectory.  
Double Precision Build To compile and link of the double precision version of hydr3d.exe, open the solution file custom-double_200X.SLN in prehyd/. Make necessary changes to the source code, save and then select Build Solution from the Build menu. 
Single Precision Build To compile and link the single precision version of hydr3d.exe, open the solution file custom-single_200X.SLN in prehyd_s/. Make the necessary changes to the source code, save and then select Build Solution from the Build menu. 
Adding New Source Files There may be occasions when a customization requires additional source code which is not distributed with FLOW-3D. Users can petition Flow Science for proprietary, non-distributed source code on these occasions. 



If this request is granted and additional source code is provided by Flow Science, the source code must be added to the Solution Explorer and the corresponding object files must be removed.  For example, suppose the HVEVAL.F file was provided by Flow Science. Once this file has been received, it would first be placed in the source/utility directory. Then open the appropriate solution file in Visual Studio and remove the HVEVAL.OBJ file from the Solution Explorer. Then add the HVEVAL.F file to the solution file by selecting Project, Add Existing Item. This opens a dialog box that allows you to select HVEVAL.F. Click OK. HVEVAL.F can now be modified and will automatically be compiled and linked each time the solution is built. 
Customizing FLOW-3D on Linux Platforms Customizations on a Linux PC can be accomplished using Intel FORTRAN 11.1.048. No additional software is required.  Customizable FORTRAN source files have been placed in the directory “source.” Subroutines unique to prep3d are in the directory “source/prep3d,” while those unique to hydr3d are to be found in the directory “source/hydr3d.” Subroutines common to both are provided in the directory “source/utility.” The files in directory “source/comdeck” are “include” files which cannot be modified by the user. Make files have been included to automate the tasks of compiling and linking. After modifying one or more source files, the make utility needs to be run from the top level of the FLOW-3D home directory. To compile and link the double precision version from a command prompt, change to the top level of the FLOW-3D home directory and type: 

make To compile and link the single precision versions, type: 
make singlep 

Customizable Source Directory Structure The directory structure for FLOW-3D customizable subroutines and standard distribution executables is as follows: 



 The directory “FLOW3D/vx.x/double” contains the official release of the double-precision (non-customizable) solver (hydr3d), while the directory “FLOW-3D/single” contains the standard single-precision solver. The customizable double precision source code is in the directory “FLOW3D/vx.x/prehyd,” while the directory “FLOW3D/vx.x/prehyd_s” contains customizable single precision source code.  NOTE: THE DOUBLE PRECISION VERSION IS RECOMMENDED FOR MOST SIMULATIONS. IF A SIMULATION REQUIRES MORE MEMORY THAN IS AVAILABLE IN DOUBLE PRECISION, THE SINGLE-PRECISION VERSION IS AVAILABLE FOR THESE CASES. Under the “customizable” directory titled “source,” there are four subdirectories. Subroutines shared by the preprocessor and the solver are located in directory titled “utility.” Subroutines used only by the preprocessor are in the directory titled “prep3d” and those used only by the solver are in “hydr3d.” 
FORTRAN Include Statements In FLOW-3D subroutines, common blocks and dimension statements for global variables are in files in directory titled “comdeck.” These "comdeck" files are essentially “header files,” and are incorporated in the subroutines by use of "include" statements. A typical “include” statement might look like the following: 

include ‘“../comdeck/params.f’” At compile time, the FORTRAN source in the “comdeck” file is in-lined in the subroutine containing the “include” statement. This provides for consistent definition of common blocks and dimension statements. There are also comdeck files that contain FORTRAN source code that is frequently, for example, calculating the indexes for a particular cell's neighbors. In these cases, the comdeck file is just a simple way of in-lining commonly-used source code. NOTES: DO NOT CHANGE COMMON BLOCKS OR DIMENSIONS IN COMDECK FILES SINCE THEY HAVE ALREADY BEEN COMPILED INTO THE ROUTINES PROVIDED AS OBJECT FILES. CHANGING THESE DEFINITIONS RESULTS IN INCONSISTENCIES WHICH MAKE FLOW-3D BEHAVE IN UNPREDICTABLE WAYS. A USER-DEFINABLE NAMELIST (USRDAT) AND COMMON BLOCK (CBUSR) HAVE BEEN PROVIDED, AND THESE MAY BE CHANGED AS LONG AS ALL SUBROUTINES REFERENCING THESE ARE ALSO RECOMPILED (ALL ROUTINES REFERENCING THESE HAVE BEEN PROVIDED AS SOURCE FILES). 



ADDITIONAL COMMON BLOCKS MAY BE DEFINED IN NEW COMDECK FILES, WHICH MAY BE INCLUDED IN SOURCE FILES AS NEEDED. 
Important Comdeck Files The following list describes some of the include modules commonly used in FLOW-3D subroutines. File Description Ijk.f computes 3D ijk index from i,j,k mijk.f computes “minus” neighbor indexes (imjk, etc.) pijk.f computes “plus” neighbor indexes (ipjk, etc.) phiou.f contains i/o file unit assignments dumn.f contains “dummy variables”: idum1…idum25, dum1…dum25, and arrays intdum(1:1000) and fpdum(1:1000) 
Subroutines Included in Distribution The following list describes some of the subroutines included with the FLOW-3D distribution. The actual subroutines included may vary for individual distributions. 
User Customizable Namelist Directory Function Description prep3d prusrd preprocesses user definable namelist USRDAT 
Boundary Condition Customization Directory Function Description utility bc evaluates mesh boundary conditions 
Fluid Property Customization Directory Function Description utility mucal evaluates viscosity hydr3d  thcndf evaluates fluid thermal conductivity utility rhocal evaluates cell density from microscopic values utility rho1cl microscopic density for fluid #1 utility eos.F/rho2cl microscopic density for fluid #2  utility dr1dt dρ/dT for fluid #1 utility dr1dts dρ/dT for solidified fluid #1 utility eos.F/dr2dt dρ/dT for fluid #2 utility eos.F/dro2cl dρ/dp for fluid #2 utility  rhoecl evaluates cell macroscopic energy utility  e1cal specific internal energy for fluid #1 utility  e2cal specific internal energy for fluid #2 utility eos.F/peos gas pressure from equation of state for fluid #2 



utility eos.F/seos speed of sound for fluid #2 utility sigcal evaluates surface tension coefficient utility rho1cs evaluates density of fluid #1 utility teval evaluates fluid temperature from the total mixture internal energy and total mixture density hydr3d heatfl adds heat sources to fluid 
General Moving Objects Customization Directory Function Description hydr3d mvbfrc1_usr Specify time variation of total control force and/or total control torque exerting on a moving object under coupled motion. The subroutine is called at each time step in simulation. hydr3d mvbfrc2_usr Specify time variation of multiple control forces on a moving object under coupled motion. The subroutine is called at each time step in simulation. hydr3d mvbvel_usr Specify time variation of velocity for a moving object under prescribed motion. The subroutine is called at each time step in simulation. 
Vapor Property Customization Directory Function Description utility psat Calculates vapor pressure or temperature from the user-defined saturation curve. 
Component Thermal Properties Customization Directory Function Description utility rcwth Evaluates ρ*Cp and thermal conductivity for components hydr3d heatob Adds heat sources to obstacles 
Component and Subcomponent Definition Customization Directory Function Description prep3d fcn0 Evaluates subcomponent functions (component regions, fluid regions, etc.) prep3d rdtopo Topographic file read format 
Heat Transfer Coefficients Customization Directory Function Description hydr3d qeval Evaluates fluid/solid heat transfer coefficient hydr3d  hfobcl Metal-foam heat transfer coefficient for lost foam process model hydr3d hobs1cl Calculates heat transfer coefficient for fluid #1 and solid hydr3d hobs2cl Calculates heat transfer coefficient for fluid #2 and solid utility hveval Evaluates fluid-void and solid-void heat transfer coefficients 



Drag/Porous Media Model Customization Directory Function Description utility  drgcl Drag in a porous component and solidification drag utility drgcst Drag contribution applied everywhere in the fluid domain utility pcapcl Capillary pressure in unsaturated porous media 
Mass/Particle Model Customization Directory Function Description hydr3d srcal Evaluates mass sources and sinks hydr3d parsor Evaluates particle sources and sinks hydr3d parqsr Evaluates (moving) mass/momentum sources and sinks 
Turbulence Model Customization Directory Function Description hydr3d  tkecon Converts buoyant and production terms to energy and dissipation terms hydr3d tkewbc Evaluates turbulent energy and dissipation from logarithmic law of the wall 
Sediment Scour Model Customization Directory Function Description hydr3d  scour_drift Evaluates drifting velocity of sediment phase for sediment scour model hydr3d scour_lift Evaluates lifting velocity of sediment from packed bed interface for sediment scour model hydr3d scrersn Computes the bed-load flux for the sediment scour model in terms of a volumetric rate per unit width 
Thermal Stress Customization Directory Function Description utility yieldcl Evaluates elastic modulus utility emodcl Evaluates elastic modulus 
Electro-mechanics Model Customization Directory Function Description hydr3d dfdpsi Calculates the derivative of charge density with respect to zeta-potential. The Boltzman distribution is used for charge density and is calculated in function fpsi.F with single valence assumed. hydr3d eforcal.f Evaluates forces on fluid due to electric field effects; includes forces on charged fluid and dielectrophoresis forces hydr3d fpsi Calculates the charge density distribution used in the electro-osmosis model. Here Boltzmann distribution with single valence is used to solve for zeta-potential. Users are allowed to provide other 



different distribution here. 
Non-Inertial Reference Frame Model Customization Directory Function Description utility motion Allows a general specification of the motion of the non-inertial reference frame 
Special Models Customization Directory Function Description hydr3d forcal For addition of custom fluid forces such as electromagnetic forces hydr3d velobs Evaluates tangential velocity for web-type moving objects utility motion Non-inertial reference frame motion hydr3d qsadd Evaluates scalar sources/sinks, and also may be used for adding general models to the solver 
Important Variables The following list describes some of the FORTRAN variables commonly used in FLOW-3D subroutines.  Variable Description i  cell index in x-direction j  cell index in y-direction k  cell index in z-direction ijk  3D cell index ipjk  cell to right of cell ijk imjk  cell to left of cell ijk ijpk  cell to back of cell ijk ijmk  cell to front of cell ijk ijkp cell to top of cell ijk ijkm cell to bottom of cell ijk iprl  first real cell index in x-direction iprr  last real cell index in x-direction jprf  first real cell index in y-direction jprbk  last real cell index in y-direction kprb  first real cell index in z-direction kprt  last real cell index in z-direction imax  total number of cells x-direction including boundary cells jmax  total number of cells y-direction including boundary cells kmax  total number of cells z-direction including boundary cells im1  next to last cell in x-direction, rightmost real cell for all right boundary types except pressure boundaries and periodic boundaries 



im2  2nd to last cell in x-direction, rightmost real cell for right pressure boundaries and periodic boundaries jm1  next to last cell in y-direction, backmost real cell for all back boundary types except pressure boundaries and periodic boundaries jm2  2nd to last cell in y-direction, backmost real cell for back pressure boundaries and periodic boundaries km1  next to last cell in z-direction, topmost real cell for all top boundary types except pressure boundaries and periodic boundaries km2  2nd to last cell in z-direction, topmost real cell for top pressure boundaries and periodic boundaries t  Time delt  time-step size ztest  =1.0e-20, a small real number slightly greater than zero em6  =1.0e-6, test value for completely blocked cell emf  =1.0e-6, test value for existence of fluid in cell x(i)  mesh coordinate at right of cell ijk xi(i)  x coordinate of cell center for cell ijk y(j)  mesh coordinate at back of cell ijk yj(j)  y coordinate of cell center for cell ijk z(k)  mesh coordinate at top of cell ijk zk(k)  z coordinate of cell center for cell ijk delx(i)  cell size in x-direction dely(j)  cell size in y-direction delz(k) cell size in z-direction rdx(i)  reciprocal of delx(i) rdy(i)  reciprocal of dely(i) rdz(i)  reciprocal of delz(i) rri(i)  correction factor for cylindrical coordinates, i.e., delta y at x(i) is dely(j)/rri(i) vf(ijk)  open volume fraction in cell afr(ijk)  open area fraction at right face afb(ijk)  open area fraction at back face aft(ijk)  open area fraction at top face u(ijk)  x-velocity at right face v(ijk)  y-velocity at back face w(ijk)  z-velocity at top face fn(ijk)  fluid fraction in cell at beginning of cycle f (ijk)  fluid fraction in cell at end of cycle p(ijk)  pressure in cell 



tn(ijk)  fluid temperature in cell tw(ijk)  wall (solid) temperature in cell rhoe(ijk) fluid density*specific energy in cell arint(ijk) free surface area in cell rho(ijk)  fluid density in cell (only for variable density) nf(ijk)  free surface indicator in cell =0, interior fluid cell =1 surface cell - fluid at left =2 surface cell - fluid at right =3 surface cell - fluid at front =4 surface cell - fluid at back =5 surface cell - fluid at bottom =6 surface cell - fluid at top =7 surface cell - cavitating cell >=8 void cell - void id number icstat(ijk) cell type flag =0, mesh boundary cell >0, active cell in which solution is found by solving conservation equations <0, passive cell in which solution is found by interpolation from another mesh block. 
Dummy Variables To use integer dummy variables, idum1…idum25, and/or floating point dummy variables, dum1…dum25, simply add the line 

include ‘../comdeck/dumn.f’ after the last include statement. Dummy variables are specified in namelist XPUT in the prepin input file and are used to activate or control custom options. Dummy arrays, intdum and fpdum, can also be defined in namelist XPUT. The default values for all dummy variables is zero. NOTE: SINCE THE DUMN.F INCLUDE STATEMENT INCLUDES ARRAYS, BE SURE THAT THE PARAMS.F COMDECK FILE IS INCLUDED BEFORE DUMN.F. SOME SUBROUTINES WILL ALREADY HAVE PARAMS.F INCLUDED, BUT SOME DO NOT. 
User Definable Variables Users may create new input variables in cbusr.f , located in the comdeck directory. These new variables can then be specified in Namelist USRDAT in the prepin file. Namelist USRDAT may be included in one of two places in the prepin input file. If variable iusrd=1 in XPUT, namelist USRDAT is read at the end of the prepin file. If iusrd=2, USRDAT is read before namelist MESH. Namelist USRDAT may be customized by adding variables to it. These variables may also be added to the common block in comdeck:cbusr. The variables may be initialized (before the namelist is read) in subroutine prusrd in prep3d. This data is automatically transferred to the solver, and the data is available in any subroutine that includes comdeck:cbusr. 
Sample Customizations 
Customizing Region Functions in the Preprocessor A general quadratic function is used to define primitive shapes for components, fluid regions, baffles, and temperature regions. The variables which define this function are contained in subroutine fcn0 in the 



source/prep3d directory. Within fcn0, argument f1 is the x-coordinate, f2 is the y-coordinate, f3 is the z-coordinate, and kn is the region number. A dummy variable is been provided for all region functions to allow customization of this. The variable is cdum for obstacle regions, fcdum for fluid regions, bcdum for baffle regions, and tcdum for temperature regions.  Variables fcdum, bcdum and tcdum are equivalence to cdum, so they are passed to fcn0 as cdum. A “commented out” example is given in fcn0 for using cdum as a coefficient for the sine of the x-coordinate. 
Customizing Boundary Conditions in Subroutine BC Custom boundary conditions may be specified in subroutine bc, which is located in the utility subdirectory. Boundary conditions may be desirable for a variety of reasons. For example, a user may wish to set a parabolic velocity distribution, or specify conditions that change with time, or even to create a new type of boundary condition, for example, a new type of wave generator boundary. If the modifications involve parameters that can change from simulation to simulation, it is a good idea to use the dummy integer variables, idum1…idum25, and/or the dummy floating point variables, dum1...dum25 and arrays intdum and fpdum. These variables can be put into the program through the XPUT namelist. Alternatively, new user-defined variables can be created. In subroutine bc, the boundary values are set for all cells on a boundary. The user should keep in mind that boundary cells are added to the "real" mesh that has been defined by the user. One layer of boundary cells is added for most types of boundaries. However, two layers are added for pressure boundaries, as well as on the "high index" side for periodic boundaries (i.e., right, back, top). Therefore, to set velocities on the left boundary, i would be set to 1 (the "first" cell in the x-direction), j would vary from jprf to jprbk, and k would vary from kprb to kprt (there is no need to set values in the “corners”, i.e., i=1, j=1, k=1). The example shown here allows the user to specify the z-direction velocity on the bottom (minimum z) boundary as a function of space and time. The fluid fraction (indicating where fluid is), may also be set as a function of space and time.  NOTE: AT THE END OF THE BC SUBROUTINE, THERE IS THE COMMENT “SPECIAL BOUNDARY CONDITIONS.” BOUNDARY CUSTOMIZATIONS SHOULD BE ADDED AFTER THIS LINE. 
Example: Velocity at Bottom Boundary as a Function of Time and Space For this example, the w-velocity (z-direction) and the fluid fraction are set at the bottom boundary as a function of time and space. The user must specify functions defining the vertical velocity and fluid fraction at the boundary. The velocity is set only for a velocity boundary, and this customization is only activated when the dummy variable idum1 is set to 1 in XPUT namelist. The coding added at the end of the subroutine bc in the folder utility should look like: 



 This modification does not allow for “iterations” within a time cycle that could implicitly couple the boundary velocity and adjacent fluid pressure. If an implicit method is needed, then additional changes are required. The pressure value immediately above the velocity w(ijk) at the beginning of the current time cycle is given by pn(ijkp). During the time-step cycle the pressure is updated and is given by p(ijkp). 
Adding New Models at the End of a Time Cycle A dummy subroutine (qsadd) is included in the distribution that allows users to add new models or make modifications at the end of a time cycle. qsadd is called after the velocity-pressure iterations, the advection of fluid quantities, and the calculation of dependent quantities (i.e., temperature-dependent densities).  This subroutine is located in subdirectory hydr3d. qsadd is currently set up to access data using scalars, and may be used to include other types of models as well. A list of commonly-used variables is included in qsadd, as well as an example, “loop over all real cells in the simulation.” Also included are example tests for determining if a cell is completely blocked by a solid component and if there is fluid in a cell. 
Example: Counting Particle Concentration in Mesh Cells An example use of this subroutine might be to count the concentration of particles in each cell and store that information as a scalar quantity. For the following example, the particle concentration will be stored in Scalar #1. The following variables will be used in this example. itnps total number of particles xp(k),yp(k),zp(k) coordinate indicators for particle k up(k),vp(k),wp(k) velocity components for particle k psize(k) size of particle k NOTE: THE FOLLOWING LINES SHOULD THEN BE INCLUDED IN THIS SUBROUTINE BEFORE THE RETURN STATEMENT: 



 The particles could also be counted based on the size psize (density or diameter) and stored in different scalar variables. To use this customization, the user would need to indicate that scalars are to be used (nsc>0 in namelist scalar) in the problem input file (prepin). It is also necessary to indicate that the scalar used to store the particle information is a non-advecting scalar (i.e., the scalar values are not moved with the flow) by setting isclr(scalar #)=0. 



Chapter 10 - Input Variable Summary 
Input File Specifications 
Input File Structure and Namelist Blocks The FLOW-3D pre-processor reads the problem definition from the simulation input file, prepin.* (e.g., prepin.inp or prepin.joe), which contains a problem title and a series of namelist blocks that define the problem setup and initial conditions. Many of the parameters listed in this document can be set directly in the Graphical User Interface (GUI) by activating buttons and entering data in dialog boxes. The GUI then adds the appropriate variables to the simulation input file. Those parameters that cannot be set via the GUI can be entered directly into the simulation input file using a text editor. The namelist blocks are separated into logical divisions, i.e., boundary condition data is specified in namelist BCDATA, fluid properties are defined in namelist PROPS, etc. The namelist blocks are summarized below in the order that they must appear in the project file. Most of these namelist blocks are always required (even though some blocks may be empty). The following list indicates which namelist blocks are required and which are used only for special models. Namelist Description Required XPUT Computational parameters Yes LIMITS Computational and print limits Yes PROPS Fluid properties Yes SCALAR Scalar species parameters No CHM Chemistry parameters No PCAP Capillary pressure data for unsaturated porous media model Only read if IDRG=5 in namelist XPUT. No RBDATA Coupled rigid-body dynamics data Only read if IACCF=2 in namelist XPUT. No USRDAT User-definable namelist data Only read if IUSRD=2 in namelist XPUT. No BCDATA Boundary condition parameters Yes MESH Mesh data for computational grid Yes BCDATA Repeated for each additional mesh block Yes MESH Repeated for each additional mesh block Yes 



OBS Geometry data Yes FL Fluid initial conditions Yes BF Baffle setup Yes TEMP Initial fluid temperature distribution Yes MOTN Non-inertial reference frame motion description Only read if IACCF>0 in namelist XPUT. No GRAFIC Graphics output requests Yes PARTS Marker and mass particle setup Yes USRDAT User-definable namelist data Only read if IUSRD=1 in namelist XPUT. No HEADER GUI data No RENDERSPACE FAVORizer data No 
Namelist Format All namelist names must be prefaced with an & and all namelist blocks must end with the statement “1”end. For some FORTRAN compilers an optional format is allowed, where the namelist names are prefaced with $ and namelist endings are designated by $end. Excerpts of a prepin file are shown below to indicate the proper standard and optional formats.  Standard Format Optional Format 

This is the title card 

This is an additional title card 

&xput 

 twfin=1., 

 gz=-9.8, 

remark= “Units are cgs,” 

/ 

&limits 

 itmax=100, 

/ 

This is a comment between 

namelists. 

&props 

 rhof=1.,  

 mui=1.e-2, 

 remark='mui, viscosity is a real 

no.', 

/ 

 . 

 . 

 . 

&parts 

/ 

This is additional text at the 

This is the title card 

This is an additional title card 
$xput 

 twfin=1., 
 gz=-9.8, 
 remark= “Units are cgs,” 

$end 
$limits 

 itmax=100, 
$end 

This is a comment between 
namelists. 

$props 
 rhof=1., 

 mui=1.e-2, 
 remark='mui, viscosity is a real 
no.,” 

$end 
 . 

 . 
 . 

$parts 
$end 

This is additional text at the 



end of the file. end of the file.  

Namelist Rules Namelists must conform to the following rules: 
� All entries must begin after Column 1 (nothing should be entered in Column 1). 
� Namelists are read in free format so spacing is not important. 
� Namelist blocks are not case sensitive.  
� Integer data must be entered as integer values and real data as real values. 
� A comma is required after each data entry (on most computers). 
� Text outside of namelist blocks is ignored. (This is useful for annotating your input file.) 
Problem Title At least one title line must be included at the top of the file. This title line will appear on all FLOW-3D output including plots. Additional title lines may be included, but they are ignored by FLOW-3D. Specifying unique, descriptive titles is a valuable habit to cultivate for reducing confusion when reviewing results of similar calculations. 
Adding Comments Using the Remark Variable Within each namelist block, comments may be added using the character variable REMARK. For example, 

Remark= “Units are CGS,” could be added in XPUT as a reminder of the units system used for the calculation. REMARK may contain up to 50 characters and may appear as many times as desired within each block. 
Conventions Used for the Input Variable Summary 
� A complete list of input variables is included in the Input Variable Summary for each of the namelist blocks. A brief description of each variable is given along with default values. 
� All default values are in CGS units (cm, gm, sec), and all (non-zero) fluid #1 property defaults are for water. 
� Subscripted variables are indicated with dummy indexes. 
� The word “Alternate:” indicates alternative input variables. 
� Whenever "..." is listed in the DEFAULT column, there are conditional defaults which are described in the DESCRIPTION column. More details about some options can be found in the Model Reference chapter, under the appropriate topic. 
Physical and Computational Parameters (XPUT) 
Advection Options 

Namelist XPUT  



NAME DEFAULT DESCRIPTION ALPHA 1.0 Controls weighting of upstream values in advection approximations when IORDER=1 =0.0, central differencing =1.0, upstream differencing.  IFENRG ... Flag for internal energy evaluation =0, no energy solution =2, solve transport equation for internal energy (1st order advection) =3, solve energy transport equation using monotonicity preserving,  second order method. Not used for two-fluid compressible flow with sharp interface. Defaults to 0 if ICMPRS=0 and IHTC=0; defaults to 2 if ICMPRS=1 or IHTC>0. IFPK ... Flag for F-packing =0, no F-packing =1, close up interior voids in free-surface problems Defaults to 1 if ITB=1 and NMAT=1; defaults to 0 otherwise.  IFPK is set to 0 if IDRG=5. IFRHO … Flag for density evaluation =0, constant uniform density =1, evaluate density as function of fluid fraction and local temperature =2, solve transport equation for density (1st order advection) =3, solve density transport equation using monotonicity preserving, second order method. Not used for two-fluid compressible flow with sharp interface. Defaults to 0 if NMAT=1; defaults to 1 if NMAT=2 and ICMPRS=0;  defaults to 2 if ICMPRS=1.  IFTHEXP 0 Thermal expansion flag for flow with density a function of temperature =0, no volume expansion =1, fluid volume expands in accordance with density charges Requires IFRHO=1 and IFENRG=2 or 3. IFVOF ... Flag for F advection options =0, no F advection =2, monotonicity preserving, second-order advection =3, VOF interface tracking =4, VOF plus interior donor cell =5, Unsplit Lagrangian method =6, Split Lagrangian method. Defaults to 4 if ITB=1 and NMAT=1; defaults to 3 if ITB=1 and NMAT=2; defaults to 0 if ITB=0 and NMAT=1; defaults to 2 if ITB=0 and NMAT=2. IFSLP 0 Flag for two-fluid interface velocity slip option 



=0, no-slip condition at the interface between liquid and gas =1, free-slip condition at the interface between liquid and gas. The free-slip should be used in two-fluid, sharp-interface (NMAT=2 and ITB=1), cases when the fluid #1 is heavier than fluid #2 by at least a factor of 10.0, and the viscous boundary layer thickness at the interface between the two fluids is much smaller than a cell size. IFTHSLP 0 Flag for two-fluid interface temperature slip option =0, no-slip condition at the interface between liquid and gas =1, free-slip condition at the interface between liquid and gas The free slip should be used in two-fluid, sharp-interface (NMAT=2 and ITB=1) cases when the thermal mass of fluid #1 is larger than that of fluid #2 by at least a factor of 10.0, and the thermal boundary layer thickness at the interface between the two fluids is much smaller than a cell size. IMPADV 0 Advection explicit/implicit flag =0, explicit evaluation of advection terms =1, locally implicit evaluation of advection terms IORDER ... Momentum equation approximation flag =0, linear approximation =1, first order =2, second order =3, monotonicity-preserving second order Defaults to 1 if ISWAT=0 or IMPADV=1; otherwise defaults to 3. 
Collision Model Options 

Namelist XPUT NAME DEFAULT DESCRIPTION ICLID 0 Flag for the collision model. Only applied to the coupled-motion GMO components =0, no collisions  =1, activate collision model FRCMOB 0.0 Global coefficient of friction during collision between coupled-motion GMO components and other components and walls STRNGMOB 1.0 Global coefficient of Stronge’s restitution during collision between coupled-motion GMO components and other components and walls. Values should be between 0.0 and 1.0. 
Convergence Criteria Options 

Namelist XPUT 



NAME DEFAULT DESCRIPTION EPSADJ 1.0 Multiplier for the calculated pressure iteration convergence criterion  (Alternate: EPSI). The convergence criterion is set automatically at each time step using EPSADJ. = 1.0, standard convergence criterion > 1.0, coarser convergence < 1.0, finer convergence Used only when IFDYNCONV=1. EPSI -1.0 Constant pressure iteration convergence criterion Used only when IFDYNCONV=0. EPSFSI 1.0e-7 Fluid-structure interaction (FSI) and thermal stress evolution (TSE) convergence criterion. Used only when IFSI(m)=1 for any geometry component m, or ITHRMST=1. EPSHTC 1.0 Multiplier for temperature iteration convergence criterion >  1, coarser convergence < 1, finer convergence EPSVIS 1.0 Convergence adjustment for implicit viscous model > 1, coarser convergence < 1, finer convergence EPSI -1.0 Constant pressure iteration convergence criterion. (Alternate: EPSADJ). Used when EPSI > 0.0. If EPSI > 0.0, then the automatic convergence criterion selection, controlled by EPSADJ, is not used. EPSELS 1.0 Convergence adjustment for implicit elastic stress model > 1, coarser convergence < 1, finer convergence IFDYNCONV 1 Pressure iteration convergence criterion flag =0, use constant criterion EPSI =1, use dynamically computed criterion with EPSADJ as the multiplier OMEGA ... Relaxation factor used in pressure iteration solvers.  Default value is defined as follows (logic applied in this order): 1.0, if ICMPRS=1, or IMP=0, or IMPVIS=2 2.0, if IADIX=IADIY=IADIZ=1 1.7, for the SOR pressure solver 1.0, for the GMRES pressure solver, when IMPMOB=0 < 1.0 if IMPMOB=1, the actual values based on the GMO to fluid density ratio. OMEGHT 2.0 Relaxation factor for implicit heat transfer and conduction 



OMEGVS ... Relaxation factor used in velocity iteration for implicit viscous model Defaults to 0.9 if IMPVIS=1, and to 1.0 when IMPVIS=2. Not used when IMPVIS = 3. OMEGES 0.9 Relaxation factor used in iteration for implicit viscous model 
Core Gas Generation NAME DEFAULT DESCRIPTION IFCOR 0 Core gas model flag =0, core gas model is not activated =1, activate core gas model IPRTVNT 0 Print venting flag =0, no venting at print surfaces =1, vent at all print surfaces ISSDIMCG 4 Sub-scale dimension for binder concentration. Each computational cell within a core is subdivided into ISSDIMCG equal sub cells in each coordinate direction to store binder concentration. TAURLXCG 0.0 Time over which the metal pressure at core surface is averaged EPSADJCG 1.0 Multiplier for the convergence criterion for the implicit core gas pressure solver. 
Drag Coefficients and Options 

Namelist XPUT NAME DEFAULT DESCRIPTION ADRG 0.0 Constant in porous media drag formulation Used as the default value for all porous components when a drag model is turned on (IDRG>0). BDRG 0.0 Constant in porous media drag formulation Used as the default value for all porous components when a drag model is turned on (IDRG=4 or 5). IDRG 0 Drag function flag =0, no drag =1, Darcy (linear) porous media model =2, 3, not used =4, Forchheimer (quadratic) porous medial model =5, unsaturated flow in porous media See ADRG and BDRG above, OADRG, and OBDRG (namelist OBS), and namelist PCAP.  See the Model Reference chapter and the section, Auxiliary Models, in the 



Theory chapter for the use of these variables. 
Energy and Heat Transfer Options 
Energy Option 

Namelist XPUT NAME DEFAULT DESCRIPTION IFENRG ... Flag for internal energy evaluation =0, no energy solution =2, solve transport equation for internal energy (1st order advection) =3, solve energy transport equation using monotonicity preserving,  second order method Defaults to 0 if ICMPRS=0 and IHTC=0; defaults to 2 if ICMPRS=1 or IHTC>0. 
Heat Transfer Options NAME DEFAULT DESCRIPTION CGFOB 0.0 Coefficient of gravity effect on metal/foam heat transfer for the lost foam casting model (used in conjunction with foam component roughness). IHONLY  Heat transfer only option =0, solve all conservation equations =1, solve energy equation only in a constant velocity field (same as setting IFVELP = 1) =2, solve energy equation only in zero velocity flow (same as setting IFVELP = 2) =3, solve conduction and heat transfer in components only  (constant temperature fluid with zero velocity) Defaults to 0 unless ISHRNK=2; set to 2 if ISHRNK=2.  IHTC 0 Fluid/component heat transfer flag  =0, no heat transfer =1, uniform temperatures within each component =2, solve full energy equation within components =3, non-uniform, constant (“frozen”) temperature within components IMPHTC  Heat transfer and conduction explicit/implicit flag. =0, explicit evaluation of temperature terms =1, implicit evaluation of temperature terms Defaults to 1 for thermal die cycling model, 0 otherwise. 
Explicit/Implicit Options 

Namelist XPUT 



NAME DEFAULT DESCRIPTION ACCIMP 1.0  Coriolis acceleration explicit/implicit weighting parameter =0, for explicit =(0.5 to 1.0), for fraction of implicitness IMP 1 Pressure-velocity coupling Explicit/Implicit option =0, explicit coupling (incompatible with ICMPRS=0) =1, implicit coupling =2, automatic limited compressibility for improved pressure iteration convergence for incompressible flow IMPADV 0 Advection explicit/implicit flag.  =0, explicit evaluation of advection terms =1, locally implicit evaluation of advection terms IMPBUB 1 Flag to indicate implicit evaluation of bubble state. IMPBUB applies to both the adiabatic bubble model (GAMMA > 0, set in namelist PROPS) and the thermal bubble model. =0, explicit algorithm during pressure iteration =1, implicit algorithm during pressure iteration IMPHTC ... Heat transfer and conduction explicit/implicit flag =0, explicit evaluation of temperature terms =1, implicit evaluation of temperature terms Otherwise, defaults to 1 for thermal die cycling model. IMPMOB 0 Explicit/implicit flag for the couple-motion GMO coupling with fluid  =0, explicit evaluation of forces between GMO and fluid =1, implicit evaluation of forces between GMO and fluid. IMPVIS 0 Viscous stress calculation explicit/implicit flag =0, explicit algorithm =1, implicit algorithm, SOR method =2, implicit algorithm, ADI method =3, implicit algorithm, GMRES method IMPELS 0 Elastic stress calculation explicit/implicit flag =0, explicit algorithm =1, implicit algorithm, SOR method IMPSFT 0 Surface tension explicit/implicit flag =0, explicit evaluation of surface tension and capillary pressures =1, implicit evaluation of surface tension and capillary pressures 
File Control Options 

Namelist XPUT 



NAME DEFAULT DESCRIPTION FFEM … Finite element (FE) mesh file name for the solidified fluid region Defaults to solidified_fluid.prjext.FEmesh, where prjext is the project extension. Can include the full path, e.g., “c:\work\my_solidified_fluid.FEmesh” (up to 256 characters). Used only with thermal stress evolution model (TSE): ITHRMST=1 IFFEMF 0 Flag to use finite element (FE) mesh file for the thermal stress evolution (TSE) solver in the solidified fluid region =0, generate finite element (FE) mesh file for the solidified fluid region =1, use existing finite element (FE) mesh file for the solidified fluid region Used only with thermal stress evolution model (TSE): ITHRMST=1 IFLOPT 1 Output file compression flag. Used for compressing FLSGRF data file. =1, standard format, no compression =2, maximum compression. May slow down the speed of post-processing.  Also makes the output file not suitable for viewing in Tecplot 360®, Fieldview® and Ensight®. IFSIOUT 0 Flag to export Tecplot® compatible output file(s) for fluid-structure interaction (FSI) and thermal stress evolution (TSE) models =0, no Tecplot® compatible output file(s) =1, only Tecplot® compatible FSI/TSE finite element (FE) output file(s) =2, only Tecplot® compatible FSI/TSE finite element (FE) data output file(s) =3, both Tecplot® compatible FSI/TSE finite element (FE) mesh as well as data output files ITIMER 0 Flag to activate built-in wall clock timers in the solver =0, timers are switched off =1, activate timers There are several dozen timers that register the wall clock time for various sections of the solver. The output from all timers is written at the end of the calculation to the solver summary file hd3out. IBENCH 0 Flag to output history plot data in text format. The history variables that are output are the same that are automatically plotted and stored in the flsplt file at the end of each calculation. =0, do not produce text output =1, write history data as text output into the flslnk file 
Flow Mode Options 

Namelist XPUT NAME DEFAULT DESCRIPTION 



ICMPRS 0 Compressible flow option =0, incompressible flow =1, compressible flow NOTE: ONLY FLUID #2 CAN BE COMPRESSIBLE. IPOT 0 Flag for potential flow calculation =0, full flow equation =1, potential equation ITB ... Indicator for free surfaces or sharp interfaces =0, no free surface or sharp interface =1, free surface or sharp interface Defaults to 0 if IDRG≠ 5; defaults to 1 if IDRG=5. NMAT ... Number of materials Defaults to 1 if ICMPRS=0; defaults to 2 if ICMPRS=1. IFVELP 0 Fluid flow solver options =0, Solve all fluid transport equations =1, Assume velocities are fixed in time and skip fluid flow calculations (same as setting IHONLY = 1) =2, Assume zero velocities and skip fluid flow calculations  (same as setting IHONLY = 2)  
Gravity and Non-Inertial Reference Frame Options 

Namelist XPUT NAME DEFAULT DESCRIPTION IACCF 0 Non-inertial reference frame flag =0, not in a non-inertial reference frame =1, motion of non-inertial reference frame is prescribed GX 0.0  Gravity component in x-direction See GRAVX in namelist MOTN for time-varying gravity.  NOTE: FOR CYLINDRICAL COORDINATES, USE GRAVX, GRAVY. GY 0.0  Gravity component in y-direction See GRAVY in namelist MOTN for time-varying gravity.  NOTE: FOR CYLINDRICAL COORDINATES, USE GRAVX, GRAVY. GZ 0.0  Gravity component in z-direction See GRAVZ in namelist MOTN for time-varying gravity.  



Initialization and Restart Options 
Initialization Option 

Namelist XPUT NAME DEFAULT DESCRIPTION IPDIS 0     Flag for initial hydrostatic pressure distribution (negative IPDIS indicates consideration of blocked cell faces). The absolute value of IPDIS: =0, uniform pressure =1, hydrostatic pressure in z-direction =2, hydrostatic pressure in x-(or radial) direction =3, hydrostatic pressure in y-direction 
Restart Options NAME DEFAULT DESCRIPTION DELTR ... Initial time-step size for restart calculation Defaults to DELT from restart file. IACRST 0 Non-inertial reference frame restart options =0, restart with FLSGRF acceleration and velocity data =1, don't read FLSGRF acceleration and velocity data IFREST 0 Restart activation flag =0, not a restart calculation =1, activate restart data initialization IHTRST 0 Restart temperature options =0, restart with all FLSGRF data =1, restart with FLSGRF conditions except fluid/solid temperatures, which are reset with PREPIN data =2, restart using only FLSGRF solid temperatures, all other conditions from  PREPIN data =3, void data is reset with PREPIN data NOTE: IF IHTRST > 0, VOID DATA IS RESET WITH PREPIN DATA. IRESF1 0 Fluid condition restart flag =0, standard restart =1, fill every non-empty cell with fluid #1, i.e., set f=1.0 IRESV 0 Fluid velocity condition restart flag =0, standard restart =1, reset fluid velocities to 0.0 and pressure to PVOID IRSTOE … Flag for restart based on fluid temperature or energy =0, restart based on internal energy 



=1, restart based on temperature Defaults to 1 for compressible flow, otherwise, defaults to 0. ISCRST 0 Restart scalar transport options =0, restart with all FLSGRF scalar data (sclr1, sclr2, etc.) =1, restart conditions for scalar data are set in PREPIN ISOLID ... Controls use of optional solidification output data  (i.e., solidification time, cooling rate at solidification, etc.) =0, don't evaluate solidification output data =1, evaluate solidification data and write them to FLSGRF =2, also read solidification data from FLSGRF on restart Defaults to 1 if a solidification model is used, otherwise, defaults to 0.  ITRST 0 Restart time flag =0, do not reset time at restart =1, reset time to zero at restart ITURST 0 Restart turbulence options =0, restart with all FLSGRF turbulence data (mu, tke, dtke) as needed =1, do not use FLSGRF tke, dtke data for restart =2, do not use FLSGRF mu, tke, dtke data for restart TREST … Restart calculation time Data at the nearest available Restart data edit in the restart source file will be used to initialize the solution in a restart simulation. IFIED 1 Flag for writing the spatial data edit at the start of simulation.  1 = write and 0 = do not write. Not writing the data reduces the size of the FLSGRF data file. Having the initial data edit is useful when doing restart calculations. RESFILE “ “ Name of the restart source file Can include the full path e.g., “c:\work\flsgrf.dat” (up to 256 characters). 
Fluid Source Options 

Namelist XPUT NAME DEFAULT DESCRIPTION IQSR 0 Fluid mass source flag =0, source model is not activated =1, source model is activated 
Numerical Options 

Namelist XPUT 



NAME DEFAULT DESCRIPTION ALPHA 1.0  Controls weighting of upstream values in advection approximations when IORDER=1 =0.0, central differencing =1.0, upstream differencing  ALPHAMB 0.25  Controls weighting of Neumann- and Dirichlet-type boundary conditions for pressure at inter-block boundaries:  =0.0, pure Dirichlet-type =1.0, pure Neumann-type ALPHAMB should always be in the range between 0.0 and 1.0. CFPK 1.0 Multiplies F-packing term (for IFPK>0) FCLEAN 0.0 Fluid fraction cleanup flag. Throws away fluid "mist" regions where F is less than FCLEAN. IFPK  Flag for F-packing =0, no F-packing =1, close up interior voids in free-surface problems Defaults to 1 if ITB=1 and NMAT=1; defaults to 0 otherwise IFPK is set to 0 if IDRG=5. IFSTR 1 Unstructured memory allocation option flag =0, deactivate the UMA option, that is, do not deactivate mesh cells =1, activate the UMA option, that is, remove if possible cells that are fully blocked and cells covered by the Domain Removing components (IFOB(m)=5). IFVOF  Flag for F advection options =0, no F advection =2, monotonicity preserving, second-order advection =3, VOF interface tracking =4, VOF plus interior donor cell =5, Unsplit Lagrangian method =6, Split Lagrangian method. Defaults to 4 if ITB=1 and NMAT=1; defaults to 3 if ITB=1 and NMAT=2; defaults to 0 if ITB=0 and NMAT=1; defaults to 2 if ITB=0 and NMAT=2. IHELP 1 Flag for mentor help feature =0, no mentor help =1, mentor help offers helpful suggestions IHONLY  Heat transfer only option =0, solve all conservation equations =1, solve energy equation only in a constant velocity field =2, solve energy equation only in zero velocity flow 



=3, solve conduction and heat transfer in components only  (constant temperature fluid with zero velocity) Defaults to 0 unless ISHRNK=2; set to 2 if ISHRNK=2. IORDER 1 Momentum equation approximation flag =0, linear approximation =1, first order =2, second order =3, monotonicity-preserving second order Defaults to 1 if ISWAT=0 or IMPADV=1; otherwise defaults to 3. IELADV 0 Advection flag for elastic stress tensor components =0, no advection =1, second-order advection ISTDY 0 Steady state accelerator for compressible flow =0, normal transients =1, accelerate approach to steady state using non-physical transient 
Physical Model Options 

Namelist XPUT NAME DEFAULT DESCRIPTION BTMSHR 0.0026 Drag coefficient for bottom shear stress. Used when ISWAT=1 and IFVISWAT=2. IACCF 0 Non-inertial reference frame model flag =0, not in a non-inertial reference frame  =1, motion of a non-inertial reference frame is prescribed =2, evaluate reference frame motion using coupled rigid body dynamics model. ICAV  0 Cavitation option =0, no cavitation =1, activate cavitation. See PCAV in namelist PROPS. See also the Cavitation Potential model activated with IPCAV in namelist SCALAR. ICHM 0 Chemistry option =0, no chemistry calculations =1, read namelist CHM and do chemistry calculations ICLID 0 Flag for the collision model. Only applied to the coupled-motion GMO components =0, no collisions 



=1, activate collision model ICMPRS 0 Compressible flow option =0, incompressible flow =1, compressible flow NOTE: ONLY FLUID #2 CAN BE COMPRESSIBLE. IDFESP 0 Drift-flux free surface option =0, no gas escape at free surface =1, gas may escape at free surface IDPTH 0 Hydraulics output data flag =0, no additional hydraulics output =1, compute and output free-surface elevation, fluid depth, Froude number, depth-averaged velocity and velocity at a distance set by OFFSET above the bottom of the reservoir (see OFFSET). IDRG 0 Drag function flag =0, no drag =1, Darcy (linear) porous media model =2, 3, not used =4, Forchheimer (quadratic) porous medial model =5, unsaturated flow in porous media See ADRG and BDRG, OADRG and OBDRG (in namelist OBS), and namelist PCAP. See Model Reference and the section, Auxiliary Models in the Theory chapter for the use of these variables. IDRIFT 1 Flag for suspended sand drifting in sand core blowing model IFSFT 0 Surface tension flag = 0, deactivate surface tension model = 1, activate surface tension model IFDFT 0 Drift-flux model flag = 0 , deactivate drift-flux model = 1, activate drift-flux model IFDRYING 0 Moisture drying model flag =0, deactivate moisture drying model =1, isothermal moisture drying model (requires the solution of full energy equation in solids, IHTC=2) =2, two-phase moisture drying model (requires the solution of full energy equation in solids, IHTC=2, the two fluid phase change model, IPCHG=2, and the non-condensable gas model, INCG=1) IFGRN 0 Granular flow model flag =0, deactivate granular flow model 



=1, activate granular flow model IFMST 1 Initial moisture content flag =1, initial moisture content is defined as % of weight fraction of dry component weight =2, initial moisture content is defined as macroscopic moisture density (weight per unit bulk component volume). Requires the activation of a moisture drying model, IFDRYING=1 or 2. IFLFOAM 0 Lost foam model flag =0, deactivate lost foam model =1, full lost foam model, with heat transfer and flow =2, simple lost foam model, where only the metal/foam interface is tracked Requires the activation of a heat transfer model between fluid and components, IHTC=1 or 2. IFVISWAT 2 Flag for viscous flow for shallow water model. Used when ISWAT=1. =0, inviscid flow =1, laminar flow =2, turbulent flow ILIFT 1 Flag for packed sand lifting in sand core blowing model; 1 = on; 0 = off. IELAST 0 Elastic-plastic stress model flag =0, model not activated =1, model activated IELADV 0 Advection flag for elastic stress tensor components =0, no advection =1, second-order advection IFENRG … Flag for internal energy evaluation =0, no energy solution =2, solve transport equation for internal energy (1st order advection) =3, solve energy transport equation using monotonicity preserving,  second order method. Defaults to 0 if ICMPRS=0 and IHTC=0; defaults to 2 if ICMPRS=1 or IHTC>0. IFRHO  Flag for density evaluation =0, constant uniform density =1, evaluate density as function of fluid fraction and local temperature =2, solve transport equation for density (1st order advection) =3, solve density transport equation using monotonicity preserving, second order method. Defaults to 0 if NMAT=1; defaults to 1 if NMAT=2 and ICMPRS=0;  defaults to 2 if ICMPRS=1.  IFTHEXP 0 Thermal expansion flag for flow with density a function of temperature 



=0, no volume expansion =1, fluid volume expands in accordance with density changes Requires IFRHO=1 and IFENRG=2 or 3. IFSLD 0 Solidification model flag =0, no solidification =1, activate solidification IFIRON 0 Iron solidification model flag =0, deactivates cast iron solidification model =1, activates cast iron solidification model. Requires IFSLD=1. NOTE: VOLUME CHANGES COMPUTED BY THE IRON MODEL ARE COUPLED ONLY TO THE SIMPLE SOLIDIFICATION SHRINKAGE MODEL, ISHRNK=2. ITHRMST 0 Flag for the thermal stress evolution (TSE) model =0, deactivates thermal stress evolution in the solidified fluid region =1, activates thermal stress evolution in the solidified fluid region. Requires IFSLD=1. IFVIS 0 Viscosity evaluation flag =0, local viscosity evaluation (no turbulence model) =1, Prandtl mixing length =2, turbulent energy model =3, two-equation (k-ε) turbulence model =4, Renormalized Group Theory model (RNG) =-1, large eddy simulation model (this model is only valid for limited cases) IFVISC 0 Viscous flow flag =0, inviscid flow =1, Newtonian viscosity model =2, non-Newtonian viscosity model with viscosity coefficient as function of strain rate =3, non-Newtonian viscosity model with viscosity coefficient a function of strain rate and temperature. NOTE: ONE OF THE VISCOUS FLOW MODELS MUST BE ACTIVATED TO USE A TURBULENCE MODEL. IFMU … Force output of fluid dynamic viscosity =0, no output of fluid viscosity =1, output fluid viscosity Defaults to 0 for one-fluid, Newtonian, laminar flow problems, 1 otherwise. IHTC 0 Fluid/component heat transfer flag  =0, no heat transfer =1, uniform temperatures within each component =2, solve full energy equation within components =3, non-uniform, constant (“frozen”) temperature within components 



IMEMB 0 Deforming elastic membrane and wall model flag =0, deactivate the model =1, activate the model  IMOBS 0 General moving object (GMO) model flag  =0, deactivate the model =1, activate the model IMUT 0 Thixotropic viscosity flag =0, standard model, no thixotropy =1, thixotropic viscosity model with time-dependent flow thickening and thinning. NOTE: THE THIXOTROPIC VISCOSITY MODEL IS ONLY RELEVANT WHEN USED WITH A NON-NEWTONIAN VISCOSITY MODEL (IFVISC=2 OR 3). INCG 0 Non-condensable gas model flag =0, no non-condensable gas component in the gas phase =1, activate non-condensable gas model Only used in the compressible fluid model, ICMPRS=1 IPHCHG 0 Phase change and bubble model flag =0, constant pressure void regions =1, constant pressure void regions with vaporization, for use with one-fluid flow with free surfaces (NMAT=1, ITB=1) =2, two-fluid phase change model with fluid #1 representing the liquid and fluid #2 the compressible vapor phase. For use with two-fluid compressible flow (NMAT=2, ICMPRS=1) =3, adiabatic bubble model, for use with one-fluid flow with free surfaces     (NMAT=1, ITB=1) =4, thermal bubbles with heat transfer. Each bubble’s pressure and temperature are dynamically computed from equation of state for perfect gas. For use with one-fluid flow with free surfaces (NMAT=1, ITB=1) =5, thermal bubbles with heat transfer and phase change. Each bubble’s pressure and temperature are dynamically computed from equation of state for perfect gas. For use with one-fluid flow with free surfaces (NMAT=1, ITB=1). IQSR 0 Fluid mass source model flag =0, model is not activated =1, model is activated ICROTBC 0 Flag for adding counter rotating flow component at inlet mesh boundaries for non-inertial reference frame (RF) motion model (IACCF > 0) =0, do not add counter rotating flow component =1, add counter rotating flow component at inlet mesh boundaries based on the current RF motion. ISHRNK 0   Solidification shrinkage flag 



Shrinkage models may only be used for one-fluid problems (NMAT=1) with free surface (ITB=1) and solidification (IFSLD=1). =0, no shrinkage model =1, activate dynamic shrinkage model =2, activate simple shrinkage model, based only on heat transfer and solidification solution ISHRNK2 0   Type of feeding flag for the simple solidification shrinkage model =0, gravity feeding until maximum solid fraction in the mushy zone reaches the coherency point FSCO, after which switches to interdendritic feeding along the temperature gradient (FSCO is in namelist PROPS) =1, interdendritic feeding along the temperature gradient all the time – from hot zones to cold. Defaults to 1 when gravity is zero, GX=GY=GZ=0.0. ISTNR  Strain rate calculation flag =0, do not calculate strain rates =1, calculate strain rates Defaults to 1 if IFVIS=4 or IVISH>0 or MUC1>0; otherwise defaults to 0.  (MUC1 is in namelist PROPS.) ISWAT 0 Shallow water model flag =0, do not use shallow water model =1, use shallow water model ITB … Indicator for free surfaces or sharp interfaces =0, no free surface or sharp interface =1, free surface or sharp interface Defaults to 0 if IDRG≠ 5; defaults to 1 if IDRG=5. ITHEAD 0 Flag for the output of the total hydraulic head =0, no hydraulic head output =1, compute and output the total hydraulic head. The output includes a spatial variable and an average hydraulic head at each flux surface. IVISH 0 Viscous heating flag =0, no viscous heating =1, include viscous heating effects IVORT 0 Vorticity output flag =0, do not compute and store vorticity vector for post-processing -1, compute and store vorticity vector for post-processing IWSH 1 Wall shear stress flag Only used if MU1 > 0 or MU2 > 0, MU1 and MU2 are in namelist PROPS. =0, no wall shear stress =1, wall shear stress 



NMAT … Number of materials Defaults to 1 if ICMPRS=0; defaults to 2 if ICMPRS=1. OFFSET 0.0 Distance in z-direction above the bottom of a reservoir at which velocity is computed and stored as part of the Hydraulic data output (see IDPTH) RHOAIR … Air density for calculation of wind shear stress on horizontal fluid surfaces. Default of RHOAIR is 1.225 x 10-3 for CGS units; 1.225 for SI units; and 2.377 x 10-3 for engineering units. WNDSHR 0.003 Coefficient of wind shear stress on a horizontal fluid surface 
Plot Output Control 

Namelist XPUT 
n < 500, time index NAME DEFAULT DESCRIPTION APLTDT TWFIN/100. Time interval between selected spatial data dumps (Alternate: TAPLTD) HPLTDT TWFIN/100. History plot interval (Alternate: THPLTD) IEDT 1 Selects the basis for long print and spatial plot intervals =1, use time, PRTDT, PLTDT, APLTDT =2, use fill fraction, PRTFRC, PLTFRC, PLTAFRC =3, use solidified fraction, PRTFRC, PLTFRC, PLTAFRC IOVOID 0 Void ID tracking flag =0, do not track individual void ID's =1, track individual void ID's for void history data ISOLID ... Controls use of optional solidification output data  (i.e., solidification time, cooling rate at solidification, etc.) =0, don't evaluate solidification output data =1, evaluate solidification data and write them to FLSGRF =2, also read solidification data from HD3RST on restart Defaults to 1 if a solidification model is used, otherwise, defaults to 0 LPR 1 Debug level =0, minimal prints and output =1, standard prints and output >1, debug prints and output NCYCPT 1 Output control for thermal die cycling model; restart spatial data is written for the last NCYCPT die cycles, in addition to the other requested restart spatial data edits using PLTDT. PLTDT TWFIN/10. Time interval between restart spatial plots (Alternate: TPLTD) PLTFRC 0.1 Interval for restart spatial plots based on fill fraction (IEDT=2) or solid 



fraction (IEDT=3). PLTAFRC 0.01 Interval for selected spatial plots based on fill fraction (IEDT=2) or solid fraction (IEDT=3). SLDDT TWFIN Edit interval for writing spatial solidification data to FLSGRF TAPLTD(n) APLTDT Selected spatial data output interval from TEDIT(n-1) to TEDIT(n)  (Alternate: APLTDT) TEDIT(n) ... Ending time of edit interval n. Not used if unspecified. THPLTD(n) HPLTDT History plot interval from TEDIT(n-1) to TEDIT(n) (Alternate: PLTDT) TPLTD(n) PLTDT Restart spatial plot interval from TEDIT(n-1) to TEDIT(n) (Alternate: PLTDT). 
Pressure Iteration Options 

Namelist XPUT NAME DEFAULT DESCRIPTION EPSADJ 1.0  Multiplier for the calculated pressure iteration convergence criterion (Alternate: EPSI). When EPSADJ > 0, the convergence criterion, EPSI, is set automatically at each time step. =0, use constant EPSI set by user =1, standard convergence criterion >1, coarser convergence <1, finer convergence EPSI ... Constant pressure iteration convergence criterion. (Alternate: EPSADJ) IADIX 1 Pressure iteration option for x-direction =0, do not use line-implicit method =1, use line implicit method (ADI) Used when IGMRES=2. IADIY 1 Pressure iteration option for y-direction =0, do not use line-implicit method =1, use line implicit method (ADI) Used when IGMRES=2. IADIZ 1 Pressure iteration option for z-direction =0, do not use line-implicit method =1, use line implicit method (ADI) Used when IGMRES=2. IGMRES 1 Pressure iteration option =0 use SOR method =1 use generalized minimum residual method (GMRES) =2, use ADI method 



IPUN 1 Uniform pressure adjustment for compressible flows (if IPUN=0, there is no adjustment; if IPUN=1 adjust the pressure once at the end of each cycle). OMEGA ... Relaxation factor used in pressure iteration solvers Default value is defined as follows (logic applied in this order): =1.0, if ICMPRS=1, or IMP=0, or IMPVIS=2 =2.0, if IADIX=IADIY=IADIZ=1 =1.7, for the SOR pressure solver =1.0, for the GMRES pressure solver, when IMPMOB=0 <1.0 if IMPMOB=1, the actual values based on the GMO to fluid density ratio. 
Print Output Control 

Namelist XPUT 
n < 500, time index NAME DEFAULT DESCRIPTION IEDT 1 Selects the basis for long print and spatial plot intervals =1, use time, PRTDT, PLTDT, APLTDT =2, use fill fraction, PRTFRC, PLTFRC, PLTAFRC =3, use solidified fraction, PRTFRC, PLTFRC, PLTAFRC LPR 1 Debug level =0, minimal prints and output =1, standard prints and output >1, debug prints and output PRTDT TWFIN/10. Time interval between long prints in HD3OUT (Alternate: TPRTD). PRTFRC 0.1 Interval for long prints based on fill fraction (IEDT=2) or solid fraction (IEDT=3). SPRTDT TWFIN/100. Short print interval (Alternate: TSPRTD) TEDIT(n) ... Ending time of edit interval n. Not used if unspecified. TPRTD(n) PRTDT Long print interval from TEDIT(n-1) to TEDIT(n) (Alternate: PRTDT) TSPRTD(n) SPRTDT Short print interval from TEDIT(n-1) to TEDIT(n) (Alternate: SPRTDT) 

Termination Control 
Namelist XPUT NAME DEFAULT DESCRIPTION FRCFIN 1.0  Fill fraction (IFIN=2) or solid fraction (IFIN=3) for termination of the calculation IFIN 1 Selects the basis for termination of the calculation 



=1, terminate when t > TWFIN =2, terminate when fill fraction exceeds FRCFIN or no cells are empty or t >TWFIN =3, terminate when solidified fraction exceeds FRCFIN or t>TWFIN =4, terminate when steady ICHKSTDY(n)  1 Steady-state watch list =0, no steady-state tracking =1, track for steady-state condition n=1, total mass n=2, total fluid energy n=3, total solid energy n=4, average mean kinetic energy n=5, average mean turbulent energy n=6, average mean turbulent dissipation Used when IFIN=4 DLTSTDY 1.0 Variation threshold below which the flow is considered steady state (in percent) Used when IFIN=4 TSTDY 0.1 TWFIN Time window over which the steady-state check is performed (in time units) Used when IFIN=4 TWFIN ...  Time to end calculation Default is TWFIN=1.0 unless thermal cycling is activated See Thermal Cycling Options. 
Thermal Cycling Options 

Namelist XPUT 
n < 100, thermal cycle segment index NAME DEFAULT DESCRIPTION CYCDT(n) 0.0 Duration of segment n of a cycle CYCHT(n) ... Heat transfer coefficient between obstacles and ambient space at cycle segment n CYCT(n) ... Ambient temperature for cycling segment n CYCT (1) defaults to TEMPI (in namelist TEMP). CYCT(n > 1) defaults to 0.0 NCYC 0 Total number of thermal cycles NCYCPT 1 Output control for thermal die cycling model; spatial data is written for the last NCYCPT cycles. 



CYCSEGNAME(n) … Name of cycle segment n Defaults to “die closed, thermal die cycle segment 1” for n=1 and to “die open, thermal die cycle segment n” for n > 1. NOTE: IF TWFIN IS NOT SET OR IF IT IS LARGER THAN THE TOTAL DURATION OF ALL CYCLES, THEN TWFIN IS SET TO THE TOTAL DURATION OF ALL CYCLES. 
Time-Step Control 

Namelist XPUT 
n < 500, time index NAME DEFAULT DESCRIPTION AUTOT 1.0  Automatic time-step control flag =0.0, constant time-step size =1.0, time-step size controlled by stability and number of  pressure iterations (see ITDTMX in namelist LIMITS) =2.0, time-step size controlled by stability CON ... Safety factor for convective stability Defaults to 0.45 for IDRG≠ 5 and ICMPRS=0;  defaults to 0.225 for IDRG=5; defaults to 0.25 for ICMPRS=1. CONES 0.5 Safety factor for elastic stress stability CONFS 1.0  Safety factor for free-surface stability CONHT ... Safety factor for heat conduction/transfer stability Defaults to 0.45 for IMPHTC=0; defaults to 1.e20 otherwise. CONSFT 0.5 Safety factor for surface tension stability CONSHR 0.45 Multiplier for sub-time stepping in rapid shrinkage model and microporosity models when used together with the implicit heat transfer solver, IMPHTC > 0.  See NSTSHR in namelist LIMITS. DELT ... Initial time-step size Defaults to TWFIN/100 for IFIN=1;  defaults to 0.001 for IFIN=2; defaults to 0.1 for IFIN=3. DELTR ... Initial time-step size for restart calculation Defaults to DELT from restart file. DTIMPX 1.e10  Multiplier for the explicit convective stability limit, used to limit the time step size for the implicit advection method. DTMAX 1.e10  Maximum permitted time-step size DTMIN 0.00001•DELT Minimum permitted time-step size 



TDTMAX(n) DTMAX Time-dependent value of DTMAX between TEDIT(n-1) and TEDIT(n)  (Alternate: DTMAX) TEDIT(n) ... Ending time of edit interval n. Not used if not specified. 
Turbulence and Viscous Options 

Namelist XPUT NAME DEFAULT DESCRIPTION IFVIS 0 Viscosity evaluation flag =0, local viscosity evaluation (no turbulence model) =1, Prandtl mixing length =2, turbulent energy model =3, two-equation (k-ε) turbulence model =4, Renormalized Group Theory model (RNG) =-1, large eddy simulation model (this model is only valid for limited cases.) IMPVIS 0 Viscous stress calculation explicit/implicit flag =0, explicit algorithm =1, implicit algorithm, SOR method =2, implicit algorithm, ADI method =3, implicit algorithm, GMRES method IMUT 0 Thixotropic viscosity flag =0, standard model, no thixotropy =1, thixotropic viscosity model with time-dependent flow thickening and thinning NOTE: THE THIXOTROPIC VISCOSITY MODEL IS ONLY RELEVANT WHEN USED WITH A NON-NEWTONIAN VISCOSITY MODEL (IFVISC=2 OR 3). IVISH 0 Viscous heating flag =0, no viscous heating =1, include viscous heating effects IWSH 1 Wall shear stress flag  (Only used if MU1>0 or MU2>0, MU1 and MU2 are in namelist PROPS) =0, no wall shear stress =1, wall shear stress. RMVISZ 1.0 Vertical viscosity multiplier Only used with laminar shallow water. 
Turbulence Equation Coefficients and Diffusion Parameters 

Namelist XPUT 



NAME DEFAULT DESCRIPTION CDIS1 ... Coefficient of production in turbulent dissipation transport equation Defaults to 1.44 for k-ε model; defaults to 1.42 for RNG model. CDIS2 ... Coefficient of decay in turbulent dissipation transport equation. CDIS2 is a function of the shear rate for RNG model. Defaults to 1.92 for k-ε model. CDIS3 0.2 Coefficient of buoyancy in turbulent dissipation transport equation CNU ... Coefficient in turbulent viscosity evaluation. Defaults to 0.09 for k-ε model; defaults to 0.085 for RNG model. CRHO 0.0 Coefficient of buoyancy in turbulent production A value of 2.5 should be used for one-fluid flows with buoyancy (NMAT=1, IFRHO=1, THEXF≠0.0). CSPRO 1.0  Coefficient of turbulent shear production CMF 0.0 Fluid mass diffusion coefficient Used when NMAT=2 and ITB=0. ITLEN 0 Flag for the calculation of the maximum turbulent mixing length in the two-equation turbulence models (IFVIS=3 or 4) =0, dynamically compute the maximum turbulent mixing length =1, use a constant maximum turbulent mixing length defined by TLEN. RMDTKE ... Turbulent dissipation diffusion coefficient Defaults to 0.77 for k-ε model; defaults to 1.39 for RNG model. RMF 0.0  Fluid fraction diffusion coefficient multiplier For RNG model defaults to 1.0/0.7, otherwise the default is 0.0. RMK 1.0  Thermal conductivity diffusion coefficient multiplier Only used when thermal conductivities THC1 and THC2 are not set by the user. See THC1 and THC2 defaults in namelist PROPS. RMRHO ...  Density diffusion coefficient multiplier (inverse Schmidt number) For RNG model defaults to 1.0/ 0.7. For two-fluid cases (NMAT=2) RMRHO is set equal to the fluid fraction diffusion coefficient multiplier RMF. Otherwise the default is 0.0. RMRHOE ...  Energy diffusion coefficient multiplier (inverse Prandtl number). For RNG model defaults to 1.0/ 0.7. For two-fluid cases (NMAT=2) RMRHOE is set equal to the fluid fraction diffusion coefficient multiplier RMF. Otherwise the default is 0.0. RMTKE ...  Turbulent energy diffusion coefficient multiplier 



Defaults to 1.39 for RNG model; otherwise, defaults to 1.0. TLEN ... Turbulent mixing length Default turbulent mixing length is 7% of the smallest computational domain dimension. 
User Defined Variables 

Namelist XPUT 
n ≤ 1000 NAME DEFAULT DESCRIPTION DUMx 0.0  Extra dummy variables DUM1...DUM25 IDUMx 0 Extra dummy integer variables IDUM1...IDUM25 IFFOR 0 Flag indicating user-defined fluid forces =0, no user-defined forces =1, include user-defined forces in subroutine FORCAL IUSRD 0 Flag indicating user-defined namelist =0, ignore namelist USRDAT =1, read namelist USRDAT at end of PREPIN file =2, read namelist URSDAT before namelist BCDATA INTDUM(n) 0 Extra integer dummy array with a single index n FPDUM(n) 0.0 Extra floating point dummy array with a single index n REMARK “ ' Dummy character string for adding comments to XPUT 

Void Heat Transfer Coefficients 
Namelist XPUT See IVHT in namelist FL and ICCTYPE in namelist OBS. NAME DEFAULT DESCRIPTION HFLE1 0.0  Emissivity times Stefan-Boltzmann constant product for fluid #1 to type 1 void HFLE2 0.0  Emissivity times Stefan-Boltzmann constant product for fluid #1 to type 2 void HFLE3 0.0  Emissivity times Stefan-Boltzmann constant product for fluid #1 to type 3 void HFLV1 0.0  Heat transfer coefficient for fluid #1 to type 1 void HFLV2 0.0  Heat transfer coefficient for fluid #1 to type 2 void HFLV3 0.0  Heat transfer coefficient for fluid #1 to type 3 void 



Fluid/Wall Gap Heat Transfer Properties 
Namelist XPUT NOTE: USED BY THE THERMAL STRESS MODEL, ITHRMST=1 NAME DEFAULT DESCRIPTION EFE1GAP 0.0  Emissivity of fluid #1 SBCONST 5.67051.10-5 erg/s cm2 K4 Stefan-Boltzmann constant THCGAP 0.0  Thermal conductivity of the gas in the gap, e.g., air 

Computational and Print Limits (LIMITS)  
Computational Limits Namelist (LIMITS)  

Namelist LIMITS NAME DEFAULT DESCRIPTION EPS 0.01 Cutoff value for the evaluation of area and volume fractions Area and volume fractions are reset to 0.0 if less than EPS and to 1.0 if greater than 1-EPS. IITMX 1 Inner iteration count maximum for non-linear equation-of-state  NOTE:  ONLY FOR ICMPRS=1 (IN NAMELIST XPUT). ITDTMX ... Maximum number of pressure iterations before the time step is reduced.  The default is 50 / (1 + IADIX + IADIY + IADIZ). (IADIX, IADIY and IADIZ are in namelist XPUT). Defaults to 30 for IMPVIS=2 Defaults to 10 for IGMRES=1 and IMPMOB=0 ITMAXCG 1000 Maximum number of core gas pressure solver iterations ITFLMX 25 Maximum number of pressure iteration failures allowed IDTHT 20 Maximum number of temperature iterations before the time step is reduced IDTES 15 Maximum number of elastic iterations before the time step is reduced ITHTMX 500 Maximum number of temperature iterations per cycle  ITMAX ... Maximum number of pressure iterations per cycle ITMAX defaults to 1000 for SOR and to 200 for ADI. Defaults to 200 for IMPVIS=2. Defaults to 100 for IGMRES=1 ITESMX 30 Maximum number of implicit elastic stress iterations 



ITSHMX 100 Maximum number of volume iterations for the simple shrinkage model Used when ISHRNK=2. ITVSMX … Maximum number of implicit viscous stress iterations Defaults to 100 for IMPVIS=3 and to 20 otherwise. MRSTRT 15 Restart number for GMRES pressure solver. It is not allowed to be less than 6 or greater than 50. NCFLMX 2 Maximum number of consecutive convection or pressure convergence failures allowed NEGTMX 250 Maximum number of times negative RHOE is reset NSTSHR 10 Maximum number of sub-time steps for simple shrinkage and microporosity models Used when ISHRNK=2 or IMUPOR=1, and IMPHTC > 0 (ISHRNK and IMPHTC are in namelist XPUT, IMUPOR is in namelist SCALAR). 
Print Limits 

Namelist LIMITS NAME DEFAULT DESCRIPTION ILPR ... Print window minimum x cell index (Alternate: XLPR). Defaults to first real cell IRPR ... Print window maximum x cell index (Alternate: XRPR). Defaults to first real cell JBKPR ... Print window maximum y cell index (Alternate: YBKPR). Defaults to first real cell JFPR ... Print window minimum y cell index (Alternate : YFPR) Defaults to first real cell KBPR ... Print window minimum z cell index (Alternate: ZBPR) Defaults to first real cell KTPR ... Print window maximum z cell index (Alternate: ZTPR) Defaults to first real cell XLPR ... Print window minimum x-coordinate (Alternate: ILPR) XRPR ... Print window maximum x-coordinate (Alternate: IRPR) YBKPR ... Print window maximum y-coordinate (Alternate: JBKPR) YFPR ... Print window minimum y-coordinate (Alternate JFPR) ZBPR ... Print window minimum z-coordinate (Alternate: KBPR) ZTPR ... Print window maximum z-coordinate (Alternate: KTPR) 



Fluid Namelist (PROPS) 
Cavitation Properties 

Namelist PROPS NAME DEFAULT DESCRIPTION CAVRT 5.0 •δt Characteristic time for formation of cavitation bubbles  (requires ICAV=1, set in namelist XPUT). PCAV 0.0  Cavitation pressure, used in Cavitation (ICAV=1) and Cavitation Potential (IPCAV > 0) models. 
Density Properties 

Namelist PROPS NOTE: NON-ZERO DEFAULTS FOR DENSITY ARE WATER PROPERTIES. NAME DEFAULT DESCRIPTION RHOF 1.0  Density of fluid #1 RHOF2 1.0  Density of fluid #2 (incompressible flows only) RHOFS RHOF Density of solidified fluid #1 THEXF1 0.0  Volumetric thermal expansion coefficient for fluid #1 THEXF2 0.0  Volumetric thermal expansion coefficient for fluid #2 THEXS1 0.0 Volumetric thermal expansion coefficient of solidified phase of fluid #1 (used in elastic stress model). TSTAR 0.0 Reference temperature for temperature-dependent fluid properties If TS1 > 0, TSTAR=TL1; otherwise, TSTAR defaults to 373.15. 
Electrostatic Properties 

Namelist PROPS NAME DEFAULT DESCRIPTION DIELF1 1.0  Dielectric constant for fluid #1 DIELF2 1.0  Dielectric constant for fluid #2 CONDDER 0.0 Fluid electric conductivity derivative with respect to temperature 
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•   PERMDER 0.0 Fluid electric permittivity derivative with respect to temperature 
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•   FREQUEN 0.0 Angular frequency of external electric field ECOND1 0.0 Fluid #1 electric conductivity ECOND2 0.0 Fluid #2 electric conductivity EMOB1 0.0 Fluid #1 electric charge mobility EMOB2 0.0 Fluid #2 electric charge mobility 

Drift Flux Properties 
Namelist PROPS NAME DEFAULT DESCRIPTION DFCD 0.5 Reynolds number-dependent drag coefficient DFRAD 0.0 Average particle radius of the dispersed phase F1MX 1.0 Maximum volume fraction of phase #1 F1MN 0.0 Minimum volume fraction of phase #1 FDMAX … Phase inversion volume fraction: volume fraction of the second phase t inversion point. At concentrations below FDMAX, the second phase is dispersed; above FDMAX it is continuous. Defaults to 0.5 for two-fluid, diffuse interface problems, NMAT=2, ITB=0, with DFRAD=0.0. Defaults to 1.0 otherwise. RHOF 1.0 Density of the first phase RHOFD RHOF Density of the second phase in one-fluid problems, NMAT=1. For two-fluid problems use RHOF2 MUD1 MU1 Dynamic viscosity of the first phase in one-fluid problems, NMAT=1. For two-fluid problems use MU1 MUD2 MU1 Dynamic viscosity of the second phase in one-fluid problems, NMAT=1. For two-fluid problems use MU2 RZMLT 1.0 Richardson-Zaki coefficient 

Elastic and Plastic Properties 
Namelist PROPS NAME DEFAULT DESCRIPTION EMOD1 0.0  Shear elastic modulus for fluid #1 EMOD2 0.0  Shear elastic modulus for fluid #2 



EMODT1 0.0  Fluid #1 shear elastic modulus temperature sensitivity E(T) = EMOD1 –EMODT1•(T-TSTAR) EMODT2 0.0  Fluid #2 shear elastic modulus temperature sensitivity E(T) = EMOD2 –EMODT2•(T-TSTAR) BLKMODTS 0.0 Bulk modulus of solidified phase of fluid #1 Used only with thermal stress evolution (TSE) model: ITHRMST=1 ELASTMODTS 0.0 Elastic modulus of solidified phase of fluid #1 Used only with thermal stress evolution (TSE) model: ITHRMST=1 POISSONRTS 2.0 Poisson ratio of solidified phase of fluid #1 Used only with thermal stress evolution (TSE) model: ITHRMST=1 SHRMODTS 0.0 Shear modulus of solidified phase of fluid #1 Used only with thermal stress evolution (TSE) model: ITHRMST=1 THEXS1 0.0 Volumetric thermal expansion coefficient of solidified phase of fluid #1 YIELD1 -1.0  Yield stress limit for fluid #1. A negative value states that the yield stress is infinite (no yielding occurs). YIELD2 -1.0  Yield stress limit for fluid #2. A negative value states that the yield stress is infinite (no yielding occurs). YIELDT1 0.0 Fluid #1 yield stress temperature sensitivity Y(T) = YIELD1 –YIELDT1•(T-TSTAR) YIELDT2 0.0 Fluid #2 yield stress temperature sensitivity Y(T) = YIELD2 –YIELDT2•(T-TSTAR) 
Fluid Names and Units Identifiers 

Namelist PROPS NAME DEFAULT DESCRIPTION FLUID1 “ “ Character string allowing user to identify fluid #1 (up to 50 characters) FLUID2 “ “ Character string allowing user to identify fluid #2 (up to 50 characters) UNITS “Custom” Character string used by graphical interface to identify units (up to 10 characters) = “cgs”, CGS units, cm/gram/seconds = “si”, SI units, m/kg/seconds = “eng”, engineering units, ft/slug/seconds TUNITS “Undefined” Character string used by graphical interface to identify temperature units (up to 10 characters) = “c”, degrees Celsius = “k”, degrees Kelvin 



 = “f”, degrees Fahrenheit = “r”, degrees Rankine Degrees Celsius and Kelvin are not compatible with Engineering units, and degrees Fahrenheit and Rankine are not compatible with CGS and SI units.  
Granular Flow Properties 

Namelist PROPS NAME DEFAULT DESCRIPTION ANGREP 34° Angle of repose (in degrees) CVELGRN 1.0 Multiplier in threshold packing velocity DIAGRN 0.0 Average grain diameter DRGGRN 1.0 Multiplier in packing drag GASDEN 0.0 Gas density GASVIS 0.0 Gas viscosity FGRNJAM … Mechanical jamming volume fraction Defaults to 0.96825*FGRNMX FGRNMX 0.63 Close packing volume fraction RHOGRN 0.0 Grain density 
Moisture Fluid Properties for Isothermal Moisture Drying Model 

Namelist PROPS NAME DEFAULT DESCRIPTION CLHVMST 2.27e+10 Latent heat of vaporization Defaults to water in CGS units. CVMST 4.187e+07 Moisture specific heat Defaults to water in CGS units. RHOMST 1.0 Moisture fluid density Defaults to water in CGS units. TVMST 373.15 Evaporation temperature Defaults to water at 1 atm in degrees Kelvin. 
Phase Change Properties 

Namelist PROPS 



NAME DEFAULT DESCRIPTION CLHV1 0.0  Latent heat of vaporization/condensation CLHV1 is used when IPHCHG=1, 2 or 5. RSIZE 0.0 Dimensionless accommodation coefficient for the liquid/vapor phase change rate. RSIZE is used when IPHCHG=1, 2 or 5. TV1 0.0 Absolute temperature value on the saturation curve that corresponds to pressure PV1. The saturation curve defines a relationship between saturation pressure and temperature. When IPHCHG=1, TV1 defines the constant saturation temperature for the constant-pressure void model. TV1 is used when IPHCHG=1, 2 or 5. GAMMA 0.0  Exponent in void region equation of state, P∙VGAMMA =constant. Zero or negative value indicates constant pressure. GAMMA is used when IPHCHG=3, 4 or 5 CVVAP 0.0 Vapor specific heat at constant volume CVVAP is used when IPHCHG=4 or 5 PV1 0.0 Absolute pressure value on the saturation curve that corresponds to temperature TV1. The saturation curve defines a relationship between saturation pressure and temperature. PV1 is used when IPHCHG=2 or 5 TVEXP 0.0 Exponent in the relationship between saturation pressure and temperature. For perfect gas TVEXP is equal to (GAMMA -1.0)*CVVAP/CLHV1. The saturation curve is defined by the Clapeyron equation: 
P PV1*exp[(1/ T 1/ TVI) / TVEXP]= −= −= −= −  Other equations can be introduced through code customization. TVEXP is used when IPCHG=2 or 5. TV0 0.0 Superheat temperature. Liquid in the bulk is allowed to heat to TV0 degrees before it starts evaporating (or boiling). In one-fluid problems, if the liquid temperature is less than TV0 the vapor nucleation occurs on a time scale defined by the larger of five time steps and CAVRT. No nucleation occurs in two-fluid problems until the liquid temperature exceeds TV0 with the exception of cells located at existing vapor interfaces or adjacent to solid components with a non-zero roughness, ROUGH(m) > 0.0. When the liquid temperature reaches TV0 nucleation occurs on the time scale of five time steps. TV0 is used when IPHCHG=2, or when IPHCHG=5 and ICAV=1. CVNC 7.178 106 Specific heat for the non-condensable gas component (used when 



(air in CGS units) INCG=1). Units are energy/(mass temperature). RFNC 2.78 106 (air in CGS units) Gas constant for the non-condensable gas component (used when INCG=1). Units are energy/(mass temperature). 
Segregation Model Parameters 

Namelist PROPS NAME DEFAULT DESCRIPTION CEUT ... Eutectic concentration (Alternate: TEUT) If TEUT is set, then CEUT is defined from the phase diagram according to CEUT=CSTAR•(TMELT-TEUT) / (TMELT-TL1); otherwise, defaults to 0.0. CEXF1 0.0 Solute expansion coefficient CSTAR 0.0 Reference solute concentration for concentration-dependent density. CSTAR also corresponds to TS1 and TL1 on the phase diagram. DRATIO 0.0 Ratio of solute diffusion coefficients in solid and liquid phases. PCOEF ... Partition coefficient (Alternate: TMELT) If TMELT is set, then PCOEF defaults to PCOEF=(TMELT-TL1) / (TMELT-TS1); otherwise, defaults to 0.0. TEUT ... Eutectic temperature (Alternate: CEUT)  If CEUT is set, then TEUT defaults to TEUT=TMELT-(TMELT-TL1)•CEUT/CSTAR; otherwise, defaults to 0.0. TL1 0.0  Liquidus temperature of fluid #1 When the iron solidification model is activated, IFIRON=1, the default value is computed from the initial carbon and silicon concentrations. Otherwise, defaults to 0.0. TMELT ... Melting temperature of pure solvent (Alternate: PCOEF)  If PCOEF is set, then TMELT is defined from the phase diagram according to TMELT=(PCOEF•TS1-TL1) / (PCOEF-1.0). TS1 0.0  Solidus temperature of fluid #1 When the iron solidification model is activated, IFIRON=1, defaults to 1373 K. Otherwise, defaults to 0.0. 
Cast Iron Solidification Model Parameters 

Namelist PROPS NOTE: VOLUME CHANGES COMPUTED BY THE IRON MODEL ARE COUPLED ONLY TO THE SIMPLE SOLIDIFICATION SHRINKAGE MODE, ISHRNK=2. NAME DEFAULT DESCRIPTION 



CIRON 0.0 Initial carbon content, % weight SIIRON 0.0 Initial silicon content, % weight FSEUTE 0.95 Solid fraction at the end of eutectic reaction RHOCARBIDE … Density of the carbide formed during eutectic reaction Default value is set according to the unit system, i.e., 7100 kg/m3 in SI units. RHOGAMMA … Density of the γ-iron phase (austenite) Default value is set according to the unit system, i.e., 7170 kg/m3 in SI units. RHOGRAPHITE … Density of the graphite formed during the eutectic reaction Default value is set according to the unit system, i.e., 2200 kg/m3 in SI units. RHOENDIRON … Density of the solid phase formed after eutectic reaction Default value is set according to the unit system, i.e., 6400 kg/m3 in SI units. VEUTPHI 1.0 Chilling susceptibility coefficent Values must be between 0.0 and 1.0. 
Solidification Properties 

Namelist PROPS 
n < 1000, temperature / energy pair index NAME DEFAULT DESCRIPTION CLHT(n) 0.0  Specific energy of fluid #1 between temperatures CLTP(n-1) and CLTP(n) (Alternate: CLHT1). CLHT (1) is the specific energy at CLTP(1). CLTP(n) 0.0  Temperature point n for latent heat release specification. These temperatures may be equal for isothermal phase changes. The first and last entries are interpreted as the solidus and liquidus temperatures, respectively, overwriting TS1 and TL1. CLHT1 0.0  Latent heat of fusion in fluid #1 (Alternate: CLHT) CVS1 CV1 Specific heat of solidified fluid #1 If CLHT and CLTP arrays are specified, CVS1 is not used. FSCO 0.15 Fraction of solid at coherency point. When the value of the solid fraction is below FSCO, then the solidified material is assumed to increase the apparent viscosity. When solid fraction is above FSCO, the solidified material forms a coherent structure which is accounted for by using a drag force. FSCR 0.67 Critical solid fraction above which metal has no fluidity 



RHOFS RHOF Density of solidified fluid #1 THCS1 THC1 Thermal conductivity of solidified fluid #1 TL1 0.0  Liquidus temperature of fluid #1 Only used when TS1 > 0. TNIYAM TS1 Temperature at which solidification variables are calculated  (i.e., solidification time, temperature gradient, etc.). TS1 0.0  Solidus temperature of fluid #1 TSDRG 1.0  Coefficient of solidification drag TSTAR ... Reference temperature for temperature dependent fluid properties. If TS1 > 0, TSTAR=TL1; otherwise, TSTAR defaults to 373.15. 
State Equation Properties  

Namelist PROPS NOTE: NON-ZERO DEFAULT FOR GAS CONSTANT IS AIR PROPERTY. NAME DEFAULT DESCRIPTION RCSQL 0.0  Reciprocal (rho•c²) of fluid #1. Only used when ICMPRS=0, in namelist XPUT.  RCSQV 0.0  Reciprocal (rho•c²) of fluid #2. Only used when ICMPRS=0, set in namelist XPUT.  RF2 2.87e6 Gas constant of fluid #2 (RF2=(γ-1)•CV2 for a gamma-law gas) CV2 …. Specific heat to fluid #2 Defaults to 7.178e6 if NMAT=2; defaults to 0.0 if NMAT=1. (NMAT is in namelist XPUT). 
Surface Tension Properties 

Namelist PROPS NAME DEFAULT DESCRIPTION CANGLE +90º Static contact angle (in degrees) for fluid #1 wall adhesion 0 < CANGLE < 90 indicates wetting condition 90 < CANGLE < 180 indicates non-wetting condition CSIGMA 0.0 Surface tension coefficient temperature sensitivity  
σ(T) = SIGMA - CSIGMA•(T-TSTAR). SIGMA 0.0 Surface tension coefficient TSTAR ... Reference temperature for temperature-dependent fluid properties If TS1>0, TSTAR=TL1; otherwise, TSTAR defaults to 373.15. 



Thermal Properties 
Namelist PROPS NOTE: NON-ZERO DEFAULT FOR FLUID #1 SPECIFIC HEAT IS WATER; NON-ZERO DEFAULT FOR FLUID #2 SPECIFIC HEAT IS AIR. NAME DEFAULT DESCRIPTION CV1 4.187e7 Specific heat of fluid #1 CV2 ... Specific heat of fluid #2 Defaults to 7.178e6 if NMAT=2;  defaults to 0.0 if NMAT=1. (NMAT is in namelist XPUT.) CVS1 CV1 Specific heat of solidified fluid #1 If CLHT and CLTP arrays are specified, CVS1 is not used. POFL1 0.0  Uniform power source per unit mass for fluid #1. NOTE: POFL1 IS IGNORED FOR IHONLY=2 (NAMELIST XPUT). POFL2 0.0  Uniform power source per unit mass for fluid #2 NOTE: POFL2 IS IGNORED FOR IHONLY=2 (NAMELIST XPUT). THC1 RMK•MU1•CV1 Thermal conductivity of fluid #1. (RMK is in namelist XPUT.) THC2 RMK•MU2•CV2 Thermal conductivity of fluid #2. (RMK is in namelist XPUT.)  THCS1 THC1 Thermal conductivity of solidified fluid #1 

Viscous Properties 
Namelist PROPS NAME DEFAULT DESCRIPTION MU1 MUI Dynamic viscosity of fluid #1 MU2 MUI Dynamic viscosity of fluid #2 MUC00 0.0  Coefficient in strain rate-dependent viscosity model MUC0 1.0  Coefficient in strain rate-dependent viscosity model MUC1 0.0  Coefficient in strain rate-dependent viscosity model See Theory for the use of these variables and the shear dependent viscosity equation. MUC2 0.0  Coefficient in strain rate-dependent viscosity model MUC3 0.0  Coefficient in strain rate-dependent viscosity model MUC4 0.0 Coefficient in strain rate-dependent viscosity model 



MUCTST 1/(1000•TWFIN) Minimum fluid strain rate applied in strain rate-dependent viscosity model. (TWFIN is in namelist XPUT.) MUI 0.0  Coefficient of dynamic viscosity MULES 0.1 Coefficient in Large Eddy Viscosity model (IFVIS=-1, in namelist XPUT) MUS 0.0 Additional viscosity coefficient for density- or solid-fraction-dependent viscosity model. Only used when MUS>0.0. For the density-dependent viscosity MUS is used for one-fluid (NMAT=1), variable density (IFRHO>0) flow. MU1 corresponds to the fluid density RHOF, and MUS to the fluid density RHOFS. For solid fraction-dependent viscosity MUS corresponds to the solid phase and MU1 to the liquid phase. Activated when MUS>0.0 and solidification model is turned on (IFSLD=1). The mixture viscosity is calculated as an average when the solid fraction exceeds the coherency point FSCO. MUTHK 0.0 Rate of viscosity increase (flow thickening) in the thixotropic model MUTHN0 0.0 First coefficient in the strain rate-dependent rate of viscosity decrease (flow thinning) in the thixotropic model MUTHN1 0.0 Second coefficient in the strain rate-dependent rate of viscosity decrease (flow thinning) in the thixotropic model NOTE: THINNING RATE = MUTHN0 + MUTHN1•|EIJ| WHERE |EIJ| IS THE STRAIN RATE. MUTMP1 0.0  Coefficient in temperature dependent viscosity model See Theory  for the use of these variables and the temperature-dependent viscosity equation. MUTMP2 0.0  Coefficient in temperature dependent viscosity model MUTMP3 1.0  Coefficient in temperature dependent viscosity model TSTAR ... Reference temperature for temperature-dependent fluid properties If TS1>0, TSTAR=TL; otherwise, TSTAR defaults to 373.15. 
Wall Shear Properties NAME DEFAULT DESCRIPTION FRCOF -1.0 Coefficient of friction between fluid and solid walls for the partial slip model. A zero value corresponds to free slip and an infinite value to no-slip. A negative value turns off the partial slip model. Also see OFRCOF in namelist OBS. 
 Tabular Property Input 

Namelist PROPS 



NAME DEFAULT DESCRIPTION IRHOF 0 Flag for the definition of density of fluid #1 =0, constant or linear function of temperature =1, tabular function of temperature (not used in one-fluid, variable density flows, IFRHO>1 and NMAT=1) IRHOF2 0 Flag for the definition of density of fluid #2 =0, constant or linear function of temperature =1, tabular function of temperature (not used for compressible flows, ICMPRS=1) IMU1 0 Flag for the definition of viscosity of fluid #1 =0, constant =1, tabular function of temperature =2, tabular function of strain rate =3, analytical function of strain rate =4, analytical function of temperature =5, analytical function of strain rate and temperature =6, Carreau function of strain rate =7, power law function of strain rate IMU2 0 Flag for the definition of viscosity of fluid #2 =0, constant =1, tabular function of temperature =2, tabular function of strain rate ICV1 0 Flag for the definition of specific heat of fluid #1 =0, constant =1, tabular function of temperature ICV2 0 Flag for the definition of specific heat of fluid #2 =0, constant =1, tabular function of temperature ICVNC 0 Flag for the definition of specific heat of non-condensable gas component =0, constant =1, tabular function of temperature ITHC1 0 Flag for the definition of thermal conductivity of fluid #1 =0, constant =1, tabular function of temperature ITHC2 0 Flag for the definition of thermal conductivity of fluid #2 =0, constant =1, tabular function of temperature IFST 0 Flag for the definition of latent heat release during solidification of 



fluid #1 =0, linear with temperature =1, tabular definition of enthalpy as a function of temperature =2, tabular definition of solid fraction as a function of temperature IBLKMODTS 0 Flag for the definition of bulk modulus of solidified phase of fluid #1 =0, constant =1, tabular function of temperature IELASTMODTS 0 Flag for the definition of elastic modulus of solidified phase of fluid #1 =0, constant =1, tabular function of temperature IPOISSONRTS 0 Flag for the definition of Poisson ratio of solidified phase of fluid #1 =0, constant =1, tabular function of temperature ISHRMODTS 0 Flag for the definition of shear modulus of solidified phase of fluid #1 =0, constant =1, tabular function of temperature IYIELD2 0 Flag for the definition of yield stress limit of fluid #2 =0, constant or linear function of temperature =1, tabular function of temperature ISIGMA 0 Flag for the definition of surface tension coefficient =0, constant or linear function of temperature =1, tabular function of temperature 
Scalar Transport Namelist (SCALAR) 
General and Scalar Advection Parameters 

Namelist SCALAR 
ns < 99, scalar species index NOTE: SCALAR CONCENTRATIONS ARE DEFINED IN TERMS OF MASS/OPEN CELL VOLUME. ACTIVE SCALARS ARE THOSE THAT ARE USED IN STANDARD MODELS, E.G., DEFECT TRACKING, AIR ENTRAINMENT OR FLUID RESIDENCE TIMES. THESE SCALARS ARE DEFINED AUTOMATICALLY WHEN THEIR RESPECTIVE MODELS ARE ACTIVATED. PASSIVE SCALARS ARE NOT USED IN ANY STANDARD MODEL AND ARE DEFINED BY THE USER. NAME DEFAULT DESCRIPTION CMSC(ns) 0.0  Molecular diffusion coefficient (units are mass/(l•s)) 



ISCLR(ns) ... Scalar advection options =0, no advection =1, second-order advection, scalar in both fluids =3, second-order advection, scalar in fluid #1 =5, second-order advection, scalar in fluid #2 Defaults to 3 for passive scalars. For active scalars (scalars used in standard models like Defect Tracking) the default value is selected as appropriate for the model. NSC 0 Number of scalar species RMSC 0.0  Turbulent diffusion coefficient multiplier For two-fluid cases (NMAT=2) RMSC is set equal to the fluid fraction diffusion coefficient multiplier, RMF, defined in XPUT.  Otherwise the default is 0.0. SCLTIT(ns) ... Title for scalar variable ns. For scalar variables used in standard models, the default title corresponds to the physical meaning of the variable in the model. For all other scalars, the title card is blank. 
Fluid Properties Associated with Scalars 

Namelist SCALAR 
ns < 99, scalar species index NOTE: SCALAR CONCENTRATIONS ARE DEFINED IN TERMS OF MASS/OPEN VOLUME. NAME DEFAULT DESCRIPTION IRHOSC(ns) 0 Flag to include mass of scalar in fluid density. A value of 1 means the scalar concentration is considered to be the density per unit volume of that scalar.  MUSC(ns) -1.0 A positive value represents the viscosity of the scalar. The mixture viscosity becomes a weighted average of fluid and scalar mass fractions.  EMODSC(ns) -1.0 A positive value represents shear elastic modulus of the scalar. The mixture elastic modulus is a weighted average of fluid and scalar mass fractions. YIELDSC(ns) -1.0 A positive value represents yields stress limit of the scalar. A negative value does not make any impact. The mixture value is a weighted average of fluid and scalar mass fractions. 

Scalar Electrostatics, Electro-osmosis and Electromechanics Model 
Parameters 

Namelist SCALAR 



ns < 99, scalar species index NAME DEFAULT DESCRIPTION EPSELE 0.000001 Convergence criterion for electric (external) potential EPSPSI 0.000001 Convergence criterion for Zeta potential MAXPHIT 1000 Maximum iterations for electric (external) potential MAXPSIT 1000 Maximum iterations for Zeta potential IPHISOL 0 Electric potential solver flag. Forced to be equal to 0 if IEOF2>0. =0, GMRES solver =1, ADI solver ELPERM 8.854e-12 Permittivity of free space. The default value is in SI units. IEPOT 0 Electric potential model flag =0, no electric field =1, activate electric potential model IEOF2 0 Flag for Zeta potential model =0, no Zeta potential =1, activate Zeta potential model TEMPSOL 1 F · C , F is Faraday’s constant; C is ion concentration in bulk flow. CONCEN 1 F/RT, F is Faraday’s constant; R is gas constant; T is medium temperature. IDEP … Dielectrophoresis model flag  = 0 , model is turned off = 1, activate the model  Defaults to 1 if IEOF2=0, and to 0 otherwise. IECHRG 0 Electric charge model  =0, no free electric charge in fluid or solid components =1, activate electric charge model IETHERMO 0 Flag for electromechanical and electrothermal effects = 0, both models are off = 1, activate electrothermal model (Joule heating) = 2, activate both electrothermal and electromechanical models CMCHRG 0.0 Molecular diffusion coefficient of electric charge density RMCHRG 0.0 Turbulent diffusion coefficient multiplier for electric charge density 
Defect Tracking Parameters for Lost Foam and Free-Surface Models 

Namelist SCALAR 
ns < 99, scalar species index 



NAME DEFAULT DESCRIPTION DFCTW 0.5 Rate at which transportable foam-generated surface defects (scalar specified by IDFCT) are converted to non-transportable defects at mold walls (scalar specified by IDFCTW). DFTFOB 1.0 Coefficient of proportionality for foam-generated surface defects  (amount of foam residual per unit volume of foam that is degraded). DFTSRF 1.0 Coefficient of proportionality for free-surface-generated defects  (defects created per unit time per unit area). IDFCT 0 Surface defect tracking model flag =0, no surface defect tracking =1, activate surface defect tracking model Defaults to 1 for lost foam models, IFLFOAM=1 or 2, and to 0 otherwise. CMDFT 0.0 Molecular diffusion coefficient of surface defects RMDFT 0.0 Turbulent diffusion coefficient multiplier for surface defects IDFCTW 0 Flag to activate recording of foam-generated surface defects that wick into mold walls, and therefore, are not transported by metal flow.  =0, no wicking of foam-generated surface defects =1, activate wicking of foam-generated surface defects IFMDEN 0 Flag to activate variable density in foam patterns Foam density is multiplied by (D + 1.0), where D is the foam density function. 
Air Entrainment Model Parameters 

Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IDFAIR 0 Flag to activate air entrainment model. A non-zero value activates the model. Requires the one-fluid, sharp-interface model (NMAT=1, ITB=1). Surface tension coefficient SIGMA should also be defined in PROPS. CMAIR 0.0 Molecular diffusion coefficient of the entrained air RMAIR 0.0 Turbulent diffusion coefficient multiplier for the entrained air DFAIR 0.5 Air entrainment rate coefficient 

Dissolution Model Parameters 
Namelist SCALAR 



ns < 99, scalar species index NAME DEFAULT DESCRIPTION IDISSOLVE 0 Flag to activate dissolution model. A non-zero value activates the model. DISSALPHA 1.0 Mixture density coefficient: 1.0-RHOF/DISSDEN < DISSALPHA < 1.0 The maximum fluid volume displacement by dissolving solute is at the lower end of the range. There is no volume change in the fluid when DISSALPHA=1.0. DISSDEN RHOF Density of the solid solute DISSMTC 0.0 Mass transfer coefficient for solid solute components See IFOBDISS(m) variable in namelist OBS. DISSSAT 0.0 Solute concentration at saturation DISSSAT cannot be larger than DISSDEN. CMDISS 0.0 Molecular diffusion coefficient of the dissolved solute RMDISS 0.0 Turbulent diffusion coefficient multiplier for the dissolved solute 
Microporosity Model Parameters 

Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IMUPOR 0 Microporosity model flag =0, no microporosity is computed =1, activate microporosity model Requires RHOFS > RHOF and FSCR < 1.0 ASQR 0.0 Square of the sound speed in solidifying metal PGASMP 1.0e+20 Critical pressure below which pores can form PRESS 0.0 Uniform intensification pressure. Used only if positive. 

Filling Time 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IFILL1 0 Flag to activate the recording of the first and last time a cell fills with 



fluid #1 =0, no filling time is computed =1, compute filling times Defaults to 1 for the sand core gas model, IFCOR=1. 
Non-condensable Gas Model Parameters 

Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION CMNCG 0.0 Molecular diffusion coefficient of the non-condensable gas component in the gas phase. Only used when INCG=1. RMNCG 0.0 Turbulent diffusion coefficient multiplier for the non-condensable gas component on the gas phase. Only used when INCG=1. 

Cavitation Potential Model 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IPCAV 0 Cavitation potential model flag =0, cavitation potential model is not activated =1, activate cavitation potential model 

Binary Alloy Segregation Parameters 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION ISEG 0 Macro-segregation model flag =0, macro-segregation model is not activated =1, activate macro-segregation model Used only for one-fluid problems, NMAT=1. CMSEG 0.0 Molecular diffusion coefficient of the solute mass concentration. RMSEG 0.0 Turbulent diffusion coefficient multiplier for the solute mass concentration 



Fluid Residence Time 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IRESDT 0 Flag used to compute fluid residence time (the amount of time fluid is present in the flow domain) =0, fluid residence time is not computed =1, compute fluid residence time 

Tracers 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION ITRACER 0 Flag used to activate tracers at flux surfaces =0, tracers are disabled =1, flow tracers may be introduced at flux surfaces. See IFTRC in namelist BF. 

Distance Traveled by Fluid 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IPATH 0 Flag used to compute distance travelled by fluid from its initial location or from the inlet (mesh boundary or mass source) =0, do not compute distance travelled by fluid =1, compute distance travelled by fluid 

Vaporization Residue  Parameters 
Namelist SCALAR 
ns < 99, scalar species index NAME DEFAULT DESCRIPTION IRESID 0 Flag to activate the residue model. A non-zero value activates the model. RMXSC(ns) 1019 Maximum concentration of scalar #ns in fluid #1, after which a 



residue starts forming. 
Scalar Sedimentation & Scour Parameters 

Namelist SCALAR 
ns < 99, scalar species index k < 10, sediment 
species index NAME DEFAULT DESCRIPTION NSSPC 0 Number of sediment  species =0, sediment scour model is not activated ≥1, activate sediment scour model and set number of species (maximum 10) SCRFCR 0.64 Critical solid fraction. Represents the solid fraction when the sediment is completely packed. SSCRT(k) … Critical Shields number of sediment species k. If value is not specified, FLOW-3D will estimate value based on Shields-Rouse equation. SSDIA(k) ... Particle diameter of sediment species k. If species represents a range of particle sizes, it is the mean diameter of species k. SSENTRF(k) 0.018 Sediment entrainment parameter for sediment species k.  See Theory for details.  SSBDLF ... Sediment bed-load parameter for sediment species k.  See Theory for details. RHFSS(k) 2.65 Density of sediment species k. Default value is typical for CGS units. (mass/volume). SSDFCD(k) 1.0 Drag coefficient on sediment particles of species k SSANG(k) … Angle of repose of sediment species k. No value turns off angle of repose model. CMSCR 0.0 Molecular diffusion coefficient of the suspended sediment RMSCR 0.0 Inverse Schmidt number for turbulent diffusion for the suspended sediment SSNAME(k) … Descriptive name for sediment species k. (Optional) SSRZMLT 1.0 Richardson-Zaki coefficient 

Chemistry Namelist (CHM) 
Chemistry Parameters 

Namelist CHM 



n < 50, rate index number 
neq < 99,equation index number 
ns < 99, scalar species index 
ntrm < 10, term index number NOTE: THIS NAMELIST IS ONLY READ IF ICHM=1 IN XPUT. NAME DEFAULT DESCRIPTION ARATE(n) 0.0 Rate coefficients for kinetic equations DD(neq,ntrm,ns) 0.0 Exponent for term number ntrm of equation number neq for scalar species number ns. ICOEFF(neq,ntrm) 0 The index n for the rate coefficient ARATE(n) to be used for term ntrm in equation neq. Holds the sign appearing in the equation, e.g., if ICOEFF(neq,ntrm) is negative, its absolute value corresponds to the index n and the term ntrm is entered with a minus sign. 

Capillary Namelist (PCAP) 
Capillary Pressure (PCAP) 

Namelist PCAP NOTE: THIS NAMELIST IS ONLY READ IF IDRG=5 IN XPUT. NAME DEFAULT DESCRIPTION IVG 0 =0, simplified model for capillary pressure used =1, Van Genuchten model for capillary pressure FCMN 0.0  Irreducible saturation (minimum F value must be less than FPCMX). FCMX 1.0  Fully saturated F value. FPCMX ... F value corresponding to PCMX Used only for IVG=0 IDFIT 2 Drag function flag relationship between drag and saturation =1, power-law =2, exponential =3, Mualem’s model of permeability used IPCFD 0 Capillary pressure operation mode =0, use both filling and draining curves (2 pressure curves with hysteresis effects) =1, drive pressures to filling curve 



=2, drive pressures to draining curve PCMX ... Maximum capillary pressure at F=FPCMX Used only for IVG=0 PEXP ... Exponent for capillary pressure-saturation relationship Used only for IVG=0 
Rigid Body Namelist (RBDATA) 
Rigid Body Dynamics Numerical Options 

Namelist RBDATA NOTE: THIS NAMELIST IS ONLY READ IF IACCF=2 IN XPUT. NAME DEFAULT DESCRIPTION EPSIRB ... Convergence criterion for the coupled rigid body dynamics iterative algorithm. Only used if IRBACC=3. Default is 10 times the maximum pressure iteration convergence. See EPSI and EPSADJ in namelist XPUT. IRBACC 0  Option for the evaluation of rigid body linear and angular acceleration =0, ignore fluid in evaluating initial values of linear and angular accelerations  =1, assume fluid is frozen in place (does not move with respect to the mesh) for purpose of calculating initial values of linear and angular acceleration =2, initialize as for IRBACC=1, also, use the "frozen fluid" model during the transient =3, like IRBACC=2, but use the iterative implicit "frozen fluid" model during the transient Input data for ACXP, ACYP and ACZP override initial evaluation of linear acceleration. Input data for RBOMDX, RBOMDY and RBOMDZ override initial evaluation of angular acceleration. NCRBMX 100 Maximum permitted number of iterations for the coupled rigid body dynamics solution. Only used if IRBACC=3. OMDIMP 0.501 Averaging factor for mixing of explicit and implicit evaluation of rigid-body gyroscopic coupling terms in angular momentum equations. 
Rigid Body Dynamics Initial Conditions 

Namelist RBDATA NOTES: THIS NAMELIST IS ONLY READ IF IACCF=2 IN XPUT. 



THE INITIAL ANGULAR VELOCITY SHOULD BE SPECIFIED EITHER BY (OMXI, OMYI, OMZI) OR BY (OMXPI, OMYPI, OMZPI). THE 9 TRANSFORMATION MATRIX ELEMENTS IMPLY THE INITIAL ANGULAR ORIENTATION OF BODY-FIXED AND INERTIAL COORDINATE SYSTEMS. NAME DEFAULT DESCRIPTION ACXP ... Initial x' component of linear acceleration of the dry rigid body in the inertial (x',y',z') coordinate system.  Default value is based on input parameter IRBACC. ACYP ... Initial y' component of linear acceleration of the dry rigid body in the inertial (x',y',z') coordinate system.  Default value is based on input parameter IRBACC. ACZP ... Initial z' component of linear acceleration of the dry rigid body in the inertial (x',y',z') coordinate system.  Default value is based on input parameter IRBACC. OMXI 0.0  Initial x angular velocity component of the dry rigid body in the body-fixed (x,y,z) coordinate system. OMYI 0.0  Initial y angular velocity component of the dry rigid body in the body-fixed (x,y,z) coordinate system. OMZI 0.0  Initial z angular velocity component of the dry rigid body in the body-fixed (x,y,z) coordinate system. OMXPI 0.0  Initial x' angular velocity component of the dry rigid body in the inertial (x',y',z') coordinate system. OMYPI 0.0  Initial y' angular velocity component of the dry rigid body in the inertial (x',y',z') coordinate system. OMZPI 0.0  Initial z' angular velocity component of the dry rigid body in the inertial (x',y',z') coordinate system. RBAXXP 1.0  Initial direction cosine (X•X') relating the inertial and body-fixed coordinate systems. This is element A11 of the transformation matrix. RBAYYP 1.0  Initial direction cosine (Y•Y') relating the inertial and body-fixed coordinate systems. This is element A22 of the transformation matrix. RBAZZP 1.0  Initial direction cosine (Z•Z') relating the inertial and body-fixed coordinate systems. This is element A33 of the transformation matrix. RBAXYP 0.0  Initial direction cosine (X•Y') relating the inertial and body-fixed coordinate systems. This is element A12 of the transformation matrix. RBAYXP 0.0  Initial direction cosine (Y•X') relating the inertial and body-fixed coordinate systems. This is element A21 of the transformation matrix. RBAXZP 0.0  Initial direction cosine (X•Z') relating the inertial and body-fixed 



coordinate systems. This is element A13 of the transformation matrix. RBAZXP 0.0  Initial direction cosine (Z•X') relating the inertial and body-fixed coordinate systems. This is element A31 of the transformation matrix. RBAYZP 0.0  Initial direction cosine (Y•Z') relating the inertial and body-fixed coordinate systems. This is element A23 of the transformation matrix. RBAZYP 0.0  Initial direction cosine (Z•Y') relating the inertial and body-fixed coordinate systems. This is element A32 of the transformation matrix. RBOMDX ... Initial x-component of angular acceleration of the dry rigid body in the body-fixed (x,y,z) coordinate system.  Default value is based on input parameter IRBACC. RBOMDY ... Initial y component of angular acceleration of the dry rigid body in the body-fixed (x,y,z) coordinate system.  Default value is based on input parameter IRBACC. RBOMDZ ... Initial z' component of angular acceleration of the dry rigid body in the body-fixed (x,y,z) coordinate system.  Default value is based on input parameter IRBACC. RCXP 0.0  Initial x' coordinate of the dry rigid-body center of mass in the inertial (x',y',z') coordinate system. RCYP 0.0  Initial y' coordinate of the dry rigid-body center of mass in the inertial (x',y',z') coordinate system. RCZP 0.0  Initial z' coordinate of the dry rigid-body center of mass in the inertial (x',y',z') coordinate system. RRATE 0.0  Rotation rate of the gravitating body reference frame (radians/second). Optional input for evaluation of relative longitude. UCXP 0.0  Initial x' velocity component of the dry rigid-body center of mass in the inertial (x',y',z') coordinate system. UCYP 0.0  Initial y' velocity component of the dry rigid-body center of mass in the inertial (x',y',z') coordinate system UCZP 0.0  Initial z' velocity component of the dry rigid-body center of mass in the inertial (x',y',z') coordinate system XPLONG 0.0  Initial longitude of the inertial x' axis in the gravitating body reference frame (radians). Optional input for the evaluation of relative longitude. 
Rigid Body Dynamics Properties 

Namelist RBDATA NOTE: THIS NAMELIST IS ONLY READ IF IACCF=2 IN XPUT. NAME DEFAULT DESCRIPTION 



GBODY 0.0  Gravitational constant for the gravitating central body (GRAVITATIONAL FORCE = GBODY•RBMASS / R'CM•R'CM ) RBJXX 1.0  Diagonal (x,x) component of dry rigid-body inertia tensor Resolved in body-fixed coordinates. RBJYY 1.0  Diagonal (y,y) component of dry rigid-body inertia tensor Resolved in body-fixed coordinates. RBJZZ 1.0  Diagonal (z,z) component of dry rigid-body inertia tensor Resolved in body-fixed coordinates. RBJXY 0.0  Off-diagonal (x,y) component of dry rigid-body inertia tensor  Resolved in body-fixed coordinates. RBJXZ 0.0  Off-diagonal (x,z) component of dry rigid-body inertia tensor  Resolved in body-fixed coordinates. RBJYZ 0.0  Off-diagonal (y,z) component of dry rigid-body inertia tensor  Resolved in body-fixed coordinates. RBMASS 1.0  Mass of the dry rigid body 
Mesh Boundary Condition Namelist (BCDATA) 
Boundary Condition Types and Time Table  
Boundary Condition Types  

Namelist BCDATA 
n < 6, boundary index Left boundary  n=1, Right n=2 Front boundary  n=3 Back n=4 Bottom boundary n=5 Top n=6 NAME DEFAULT DESCRIPTION IBCT(n) … Boundary condition type at mesh block boundaries 1, = symmetry plane 2, = rigid wall 3, = continuative boundary 4, = periodic boundaries (must be applied at opposite sides of mesh) 5, = specified pressure boundary 6, = specified velocity boundary 7, = boundary values obtained from previous calculation using grid overlay (GO) procedure 8, = outflow boundary that minimizes wave reflections 9, = inter-block boundary 



10, = surface wave boundary (for n=1, 2, 3 and 4 only) 11, = specified flow rate boundary Defaults to 9 at nested and linked boundaries, and to 1 otherwise. 
Boundary Condition Time Table 

t < 500, time index NAME DEFAULT DESCRIPTION TIMBCT(t) 0.0  Time table for mesh boundary conditions 
 Boundary Nomenclature 

Boundary Elastic Stresses 
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index 
k < 6, elastic stress component Left boundary    n=1,   Right   n=2, Front boundary  n=3,   Back   n=4, Bottom boundary n=5,   Top   n=6 xx-component of elastic stress,   k=1 yy-component of elastic stress,   k=2 zz-component of elastic stress,   k=3 xy-component of elastic stress,   k=4 yz-component of elastic stress,   k=5 xz-component of elastic stress,   k=6 NAME DEFAULT DESCRIPTION ELSTBC(n,k) 0.0 Elastic stress component k at mesh boundary n  



(Alternate: ELSTBCT). Only used when IELAST=1. ELSTBCT(t,n,k) ELSTBC(n,k) Elastic stress component k at mesh boundary n at time TIMBCT(t). Only used when IELAST=1. TIMBCT(t) 0.0 Time table for mesh boundary condition 
Boundary Electric Charge Density 

Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6 NAME DEFAULT DESCRIPTION CHRGBC(n) 0.0 Electric charge density at mesh boundary n (Alternate: CHRGBCT). Only used when IECHRG=1. CHRGBCT(t,n) CHRGBC(n) Electric charge density at mesh boundary n at time TIMBCT(t).  Only used when IECHRG=1. TIMBCT(t) 0.0 Time table for mesh boundary conditions 

Boundary Entrained Air Volume Fraction 
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6 NAME DEFAULT DESCRIPTION AIRBC(n) 0.0 Volume fraction of entrained air at mesh boundary n (Alternate: AIRBCT). Only used when IDFAIR=1. AIRBCT(t,n) AIRBC(n) Volume fraction of entrained air at mesh boundary n at time TIMBCT(t). Only used when IDFAIR=1. TIMBCT(t) 0.0 Time table for mesh boundary conditions 

Boundary Dissolved Solute Concentration 
Namelist BCDATA 



t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6 NAME DEFAULT DESCRIPTION DISSBC(n) 0.0 Concentration of dissolved solute at mesh boundary n. (Alternate: DISSBCT).  Only used when IDISSOLVE=1. DISSBCT(t,n) DISSBC(n) Concentration of dissolved solute at mesh boundary n at time TIMBCT(t).  Only used when IDISSOLVE=1. TIMBCT(t) 0.0 Time table for mesh boundary conditions 

Boundary External Potential 
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6 NAME DEFAULT DESCRIPTION EOFTBC(n) 0.0 Zeta potential at mesh boundary n (Alternate: EPOTBCT) Only used when IEPOT=1 and IEOF2=1 EOFTBCT(t,n) EOFTBC(n) Zeta potential at mesh boundary n at time TIMBCT(t).  Only used when IEPOT=1 and IEOF2=1 EPOTBC(n) 0.0 Electric potential at mesh boundary n (Alternate: EPOTBCT) Only used when IEPOT=1 EPOTBCT(t,n) EPOTBC(n) Electric potential at mesh boundary n at time TIMBCT(t). Only used when IEPOT=1 TIMBCT(t) 0.0 Time table for mesh boundary conditions IPHIBC(n) 0 Electric field boundary condition type at mesh boundary n 1=specified potential 



0=insulation 
Boundary Fluid Fraction 

Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6 NAME DEFAULT DESCRIPTION FBC(n) 1.0 Fluid fraction at mesh boundary n. (Alternate: FBCT) FLHTBCT(t,n) -1.e10 Free-surface elevation at mesh boundary n at time TIMBCT(t). Not used for n=5 and 6. TIMBCT(t) 0.0  Time table for mesh boundary conditions 

Boundary Fluid Density 
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary   n=1, Right n=2 Front boundary  n=3, Back n=4 Bottom boundary n=5, Top n=6 NAME DEFAULT DESCRIPTION RHOBC(n) RHOF Fluid density at mesh boundary n (Alternate: RHOBCT). Only used when NMAT=1 and IFRHO ≥ 2. RHOBCT(t,n) RHOBC(n) Fluid density at mesh boundary n at time TIMBCT(t). Only used when NMAT=1 and IFRHO ≥ 2. TIMBCT(t) 0.0  Time table for mesh boundary conditions 

Boundary Non-condensable Gas Volume Fractions 
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index 



Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back  n=4 Bottom boundary  n=5,   Top   n=6 NAME DEFAULT DESCRIPTION CNCBC(n) 0.0 Volume fraction of the non-condensable gas component in the gas phase at mesh boundary n (Alternate: CNCBCT). Only used when INCG=1. CNCBCT(t,n) CNCBC(n) Volume fraction of the non-condensable gas component in the gas phase at mesh boundary n at time TIMBCT(t). Only used when INCG=1. TIMBCT(t) 0.0  Time table for mesh boundary conditions 
Boundary Pressure 

Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary    n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6  NAME DEFAULT DESCRIPTION IPBCTP(n) ...  Type of specified pressure boundary for boundary n =0, static  =1, stagnation Defaults to the integer value of PBCTYP. PBC(n) ... Pressure at mesh boundary n (Alternate: PBCT). If IPDIS=1, PBC is overridden by hydrostatic pressure if appropriate fluid elevation is set at boundary n (FLHTL, etc.). Defaults to 0.0 if ICMPRS=0; defaults to 1.013e6 if ICMPRS=1. (ICMPRS and IPDIS are in namelist XPUT) PBCT(t,n) PBC(n) Pressure at mesh boundary n at time TIMBCT(t). If IPDIS=1, PBCT may be overridden (See PBC above). PBCTYP 1.0  Type of specified pressure boundaries =0.0, static =1.0, stagnation TIMBCT(t) 0.0  Time table for mesh boundary conditions 



Boundary Scalar Concentration 
Namelist BCDATA 
t < 500, time index 
ns < 99, scalar index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary    n=3,   Back   n=4 Bottom boundary n=5,   Top   n=6  NAME DEFAULT DESCRIPTION SCLBC(n,ns) 0.0  Scalar magnitude of species ns at mesh boundary n  (Alternate: SCLBCT). Only used for NSC > 0. SCLBCT(t,n,ns) SCLBC(n,ns) Scalar magnitude of species ns at mesh boundary n at time TIMBCT(t). Only used for NSC > 0. TIMBCT(t) 0.0  Time table for mesh boundary conditions 

Boundary Sediment Concentration 
Namelist BCDATA 
t < 500, time index 
k < 10, sediment species index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary    n=3,   Back   n=4 Bottom boundary n=5,   Top   n=6 NAME DEFAULT DESCRIPTION SSBC(n,k) 0.0  Suspended sediment mass concentration of sediment species k at mesh boundary n (Alternate: SSBCT).  Only used when NSSPC > 0. SSBCT(t,n,k) SSBC(n) Suspended sediment mass concentration of sediment species k at mesh boundary n at time TIMBCT(t).  Only used when NSSPC > 1. TIMBCT(t) 0.0  Time table for mesh boundary conditions 



Boundary Segregation Solute Mass Concentrations  
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right  n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6  NAME DEFAULT DESCRIPTION SEGBC(n) 0.0 Concentration of solute mass at mesh boundary n (Alternate: SEGBCT).  Only used when ISEG=1. SEGBCT(t,n) SEGBC(n) Concentration of solute mass at mesh boundary n at time TIMBCT(t).  Only used when ISEG=1. TIMBCT(t) 0.0 Time table for mesh boundary conditions 

Boundary Temperature and Wall Power  
Boundary Temperature  

Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right  n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6  NAME DEFAULT DESCRIPTION TBC(n) TBCD Temperature at mesh boundary n (Alternate: TBCT). Values must be positive.  Only used for IHTC > 0. TBCD ... Default obstacle and mesh boundary surface temperature.  Values must be positive.  Only used for IHTC > 0. Defaults to 0.0 if ICMPRS=0; defaults to 373.15 if ICMPRS=1.  (ICMPRS is in namelist XPUT.) 



TBCT(t,n) TBC(n) Temperature at mesh boundary n at time TIMBCT(t). Values must not be negative. Values must be positive.  Only used for IHTC > 0. TIMBCT(t) 0.0  Time table for mesh boundary conditions 
Boundary Wall Power  NAME DEFAULT DESCRIPTION POBC(n) 0.0  Thermal power at mesh boundary n (Alternate: POBCT) POBCT(t,n) POBC(n) Thermal power at mesh boundary n at time TIMBCT(t). TIMBCT(t) 0.0  Time table for mesh boundary conditions. 
Boundary Thermal Properties and Heat Transfer Coefficients 
Thermal Properties 

Namelist BCDATA 
n < 6, boundary index NOTE:  FOR THERMAL PROPERTIES AND HEAT TRANSFER COEFFICIENTS TO APPLY, THE BOUNDARY MUST BE A WALL (TYPE 2, SEE NOTE FOR SPECIAL CASE FOR RWALL). Left boundary    n=1,   Right  n=2 Front boundary    n=3,   Back   n=4 Bottom boundary  n=5,   Top  n=6  NAME DEFAULT DESCRIPTION RWALL(n) 1.0  Roughness of mesh boundary n. This multiplies the cell-face area to give the effective heat transfer area for each cell. No heat transfer at mesh boundary n if RWALL(n)=0.0.  NOTE: FOR A FIXED PRESSURE OR FIXED VELOCITY BOUNDARY, NO FLUID CONDUCTION ACROSS BOUNDARY N IF RWALL(N)=0. ONLY USED FOR IHTC > 0. WBCL(n) ... Length scale for mesh boundary n Defaults to diagonal length of mesh boundary. Only used for IHTC > 0. 

Heat Transfer Coefficients NAME DEFAULT DESCRIPTION HWALL1(n) -1.0 Fixed heat transfer coefficient to fluid #1 from mesh boundary n If HWALL1(n)=-1.0, the code will evaluate a heat-transfer coefficient. Only used for IHTC > 0. 



HWALL2(n) -1.0  Fixed heat transfer coefficient to fluid #2 from mesh boundary n If HWALL2(n)=-1.0, the code will evaluate a heat-transfer coefficient. Only used for IHTC > 0 and NMAT=2. HWOBS(n) -1.0 Heat transfer coefficient between obstacles and wall mesh boundary If HWOBS(n)=-1.0, a zero thermal resistance is assumed. Only used for IHTC > 0. 
Boundary Turbulence and Dissipation 

Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary   n=3,   Back   n=4 Bottom boundary  n=5,   Top   n=6  NAME DEFAULT DESCRIPTION DTKEBC(n) ... Turbulent dissipation at mesh boundary n (Alternate: DTKBCT) Default dissipation is evaluated from TKEBCT and TLEN (TLEN is in namelist XPUT). Only used for IFVIS ≥ 3. DTKBCT(t,n) DTKEBC(n) Turbulent dissipation at mesh boundary n at time TIMBCT(t) Only used for IFVIS ≥ 3. TKEBC(n) TKEI Turbulent energy at mesh boundary n (Alternate: TKEBCT).  (TKEI is in namelist FL.)  Only used for IFVIS ≥ 2. TKEBCT(t,n) TKEBC(n) Turbulent energy at mesh boundary n at time TIMBCT(t) Only used for IFVIS ≥ 2. TIMBCT(t) 0.0  Time table for mesh boundary conditions 

Boundary Velocity 
Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top  n=6  



NAME DEFAULT DESCRIPTION UBC(n) 0.0  X-velocity at mesh boundary n (Alternate: UBCT) UBCT(t,n) UBC(n) X-velocity at mesh boundary n at time TIMBCT(t) VBC(n) 0.0  Y-velocity at mesh boundary n (in cylindrical geometry, units are radians/s) (Alternate: VBCT) VBCT(t,n) VBC(n) Y-velocity at mesh boundary n at time TIMBCT(t)  (in cylindrical geometry, units are radians/s). WBC(n) 0.0  Z-velocity at mesh boundary n (Alternate: WBCT) WBCT(t,n) WBC(n)  Z-velocity at mesh boundary n at time TIMBCT(t) TIMBCT(t) 0.0  Time table for mesh boundary conditions 
Outflow Boundary Options 

Namelist BCDATA 
t < 500, time index 
n < 6, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top  n=6  NAME DEFAULT DESCRIPTION IOBCTP(n) 0  Reverse flow option at outflow mesh boundary #n (of type 8) =0, do not allow fluid to enter the domain at the boundary =1, allow fluid to enter the domain at the boundary (useful when modeling linear surface waves exiting at this boundary) 

Linear Surface Wave Boundary 
Namelist BCDATA  
t ≤ 500, time index  
m ≤ 1000, linear wave index 
n ≤ 4, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 NOTE: A LINEAR WAVE BOUNDARY CONDITION CAN ONLY BE APPLIED AT LEFT, RIGHT, FRONT AND BACK MESH BOUNDARIES OF TYPE 10. 



NAME DEFAULT DESCRIPTION FLHTBCT(t,n) -1.e10 Free-surface elevation at mesh boundary n at time TIMBCT(t) Not used for n=5 and 6. INWAVE(n) 3 Indicator of wave type at mesh boundary n =1, Linear wave =2, Stoke’s wave (Fenton’s 5th-order theory) =3, Stokes and Cnoidal waves (Fenton’s Fourier series method) =4, Solitary wave =5, Random wave IWAVEBC(n) 0 Total number of linear wave components entering computational domain from mesh boundary n. Not used for n=5 and 6. WAVEAMP(n,m) 0.0 Wave height amplitude of wave component m at mesh boundary n. UBC(n) 0.0 X-velocity of undisturbed constant uniform current at mesh boundary n. Must be slower than wave speed if n=1 or 2. Alternate: UBCT(1,n). UBCT(1,n) UBC(n) X-velocity of undisturbed constant uniform current at mesh boundary n. Must be slower than wave speed if n=1 or 2.  VBC(n) 0.0 Y-velocity of undisturbed constant uniform current at mesh boundary n. Must be slower than wave speed if n=1 or 2. Alternate: VBCT(1,n). VBCT(1,n) VBC(n) Y-velocity of undisturbed constant uniform current at mesh boundary n. Must be slower than wave speed if n=1 or 2.  WAVEPER(n,m) … Period of wave component m at mesh boundary n. If WAVELEN(n,m) is defined, the wave period is computed from the Airy solution for a linear wave. Otherwise, defaults to 0.0. WAVELEN(n,m) … Wave length of wave component m at boundary n. If WAVEPER(n,m) is defined, the wave length is computed from the Airy solution for a linear wave, overwriting user input for WAVELEN(n,m). Otherwise, defaults to 0.0 WAVEPHS(n,m) 0.0 Phase shift in degrees of wave component m at mesh boundary n. WAVEH(n) … Mean fluid depth for all wave components at mesh boundary n. Defaults to the fluid elevation relative to the bottom of the computational domain, using the user-defined mean free surface elevation (e.g., FLHTL or FLHTLT(1) for the left boundary). WBC(n) 0.0 Z-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2. Alternate: WBCT(1,n) 



WBCT(1,n) WBC(n) Z-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2.  
Non-linear Surface Wave Boundary 

Namelist BCDATA  
t ≤ 500, time index  
n ≤ 4, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 NOTE: A NON-LINEAR WAVE BOUNDARY CONDITION CAN ONLY BE APPLIED AT LEFT, RIGHT, FRONT AND BACK MESH BOUNDARIES OF TYPE 10. NAME DEFAULT DESCRIPTION DISPEAK(n) … Initial distance from the solitary wave crest to the wave boundary (the solitary wave is initially located outside the computational domain). Default of DISPEAK is half of the solitary wave’s wavelength so that the initial surface displacement at the wave boundary is 1% of the wave height. The wavelength of a solitary wave is the horizontal distance in the wave propagation direction between two locations where the surface displacement is 1% of the wave height. Used when INWAVE(n)=4. FLHTBCT(t,n) -1.e10 Free-surface elevation at mesh boundary n at time TIMBCT(t) Not used for n=5 and n=6. HNWAVE (n) 0.0 Wave elevation of non-linear wave at mesh boundary n Measured from trough to crest. Used when INWAVE(n)=2, 3 or 4. INWAVE(n) 3 Indicator of wave type at mesh boundary n =1, Linear wave =2, Stoke’s wave (Fenton’s 5th-order theory) =3, Stokes and Cnoidal waves (Fenton’s Fourier series method) =4, Solitary wave =5, Random wave LNWAVE(n) ... Wave length of nonlinear wave at mesh boundary n Used when INWAVE(n) =2 or 3. If wave length is defined, then wave period is calculated by the solver. TNWAVE(n) 0 Period of nonlinear wave at mesh boundary n Used when INWAVE(n) =2 or 3. If wave period is defined, then wave length is calculated by the solver. 



WAVEH(n) … Mean fluid depth for all wave components at mesh boundary n Defaults to the fluid elevation relative to the bottom of the computational domain, using the user-defined mean free surface elevation (e.g., FLHTL or FLHTLT(1) for the left boundary). UBC(n) 0.0 X-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2. Alternate: UBCT(1,n). UBCT(1,n) UBC(n) X-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2.  VBC(n) 0.0 Y-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2. Alternate: VBCT(1,n). VBCT(1,n) VBC(n) Y-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2.  WBC(n) 0.0 Z-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2. Alternate: WBCT(1,n). WBCT(1,n) WBC(n) Z-velocity of undisturbed constant uniform current at mesh boundary n Must be slower than wave speed if n=1 or 2.  
Random Wave Boundary Condition 

Namelist BCDATA 
n ≤ 6, boundary index NAME DEFAULT DESCRIPTION FEDS(n) … Name of user-provided data file for wave energy spectrum. Used when INWAVE(n)=5 and ISPECT(n)=0. FETCH(n) … Fetch length in JONSWAP spectrum. Used when ISPECT(n)=5 and ISPECT(n)=2. GAM(n) 3.3 Peak enhancement factor in JONSWAP spectrum. Used when INWAVE(n)=5 and ISPECT(n)=2. INWAVE(n) 3 Indicator of wave type at mesh boundary n =1, Linear wave =2, Stoke’s wave (Fenton’s 5th-order theory) 



=3, Stokes and Cnoidal waves (Fenton’s Fourier series method) =4, Solitary wave =5, Random wave ISPECT(n) 1 Type of wave energy spectrum. Used when INWAVE(n)=5. =0, user-provided data file for wave energy spectrum (the first and second columns are angular frequency and spectrum density, respectively) =1, Person-Moskowitz (P-M) spectrum =2, JONSWAP spectrum UW(n) … Wind speed at 10m above water surface. Used when INWAVE(n)=5 and ISPECT(n)=1 or 2. 
Boundary Flow Rate 

Namelist BCDATA 
t ≤ 500, time index 
n ≤ 4, boundary index Left boundary    n=1,   Right   n=2 Front boundary  n=3,   Back   n=4 Bottom boundary  n=5,   Top  n=6 NAME DEFAULT DESCRIPTION FLRBC(n) 0.0  Volume flow rate at mesh boundary n. Alternate: FLRBCT. The flow rate is converted to a uniform velocity across the wetted part of the boundary, that is, where fluid (#1 or #2) is present. For one-fluid flow with free-surface elevation defined, the flow rate is applied only below free surface. Must be a positive quantity. FLRBCT(t,n) FLRBC(n) Volume flow rate at mesh boundary n at time TIMBCT(t). The flow rate is converted to a uniform velocity across the wetted part of the boundary, that is, where fluid (#1 or #2) is present. For one-fluid flow with free-surface elevation defined, the flow rate is applied only below free surface. Must be a positive quantity. FNX(n) …  X-component of the flow direction vector at mesh boundary n.  Defaults 1.0 at left boundary (X_min), to -1.0 at right boundary (X_max), to 0.0 at all other boundaries. FNY(n) …  Y-component of the flow direction vector at mesh boundary n.  Defaults 1.0 at front boundary (Y_min), to -1.0 at back boundary (Y_max), to 0.0 at all other boundaries. 



FNZ(n) …  Z-component of the flow direction vector at mesh boundary n.  Defaults 1.0 at bottom boundary (Z_min), to -1.0 at top boundary (Z_max), to 0.0 at all other boundaries. TIMBCT(t) 0.0  Time table for mesh boundary conditions 
Mesh Namelist (MESH) 
Mesh Generator (MESH)  

Namelist MESH 
n < 500, grid location index NAME DEFAULT DESCRIPTION ICYL 0  Mesh coordinate type indicator =0, plane coordinates (Cartesian) =1, cylindrical coordinates. MESHNAME ‘mesh block no. ##’ Mesh block name (up to 256 characters) 

Uniform Mesh Specifications NAME DEFAULT DESCRIPTION NTOTAL 0 Approximate total number of real cells to be generated. NTOTAL is used for directions for which a domain has been specified by PX, PY, and/or PZ, but not the number of cells (NXCELT, NYCELT, or NZCELT). SIZE 0.0 Cell size to be approximated for a uniform mesh. SIZE is used for directions for which a domain has been specified by PX, PY, and/or PZ, but not the number of cells (NXCELT, NYCELT, or NZCELT). 
Number of Cells in Specified Directions NAME DEFAULT DESCRIPTION NXCELT 1 Total number of real cells in x-direction NYCELT 1 Total number of real cells in y-direction NZCELT 1 Total number of real cells in z-direction 
Grid Plane Location NAME DEFAULT DESCRIPTION PX(n) ... nth location in x-direction for a mesh plane. 



PX(2) defaults to PX(1)+1.0; otherwise all PXs default to 0.0. PY(n) ...  nth location in y-direction for a mesh plane. PY(2) defaults to PY(1)+1.0 (Cartesian Mesh); otherwise all PYs default to 0.0. PYA(n)  … nth location angle (in degrees) in y-direction for a cylindrical coordinate mesh (used for ICYL=1 only). PYA(2) defaults to PYA(1) + 30°, otherwise all PYAs default to 0.0. PZ(n)  … nth location in Z-direction for a mesh plane. PZ(2) defaults to PZ(1)+ 1.0, otherwise all PZs default to 0.0. 
Grid Location Specifications NAME DEFAULT DESCRIPTION NXCELL(n) ... Number of cells between PX(n) and PX(n+1). NYCELL(n) ... Number of cells between PY(n) and PY(n+1). NZCELL(n) ... Number of cells between PZ(n) and PZ(n+1). SIZEX(n) ...  Size of mesh cells at PX(n) in x-direction. SIZEY(n) ...  Size of mesh cells at PY(n) in y-direction. SIZEYA(n) ...  Size of mesh cells at PY(n) in y-direction for a cylindrical coordinate mesh (used for ICYL=1 only).  NOTE: UNITS ARE DEGREES. SIZEZ(n) ...  Size of mesh cells at PZ(n) in z-direction.  
Component Setup (OBS) 
Component: General Parameters 

Namelist OBS 
m < 500, component index 
n < 500, subcomponent index NAME DEFAULT DESCRIPTION AVRCK -3.1  AVRCK > 0, mesh cells with area/volume ratios exceeding this value are listed in pre-processor output. AVRCK < 0, a negative value flags pre-processor to adjust cell volume fractions so ratio does not exceed magnitude of AVRCK. (This option allows larger fluid convective time steps for 



certain situations.) CCOLOR(m)  0 Component m RGB color value for display in the Graphical User Interface IAVRCK 1 FAVOR™ volume adjustment for stability with larger time-step limit (see AVRCK) =0, no adjustment =1, maximum adjustment for maximum time-step limit =2, smaller adjustment for improved time-step limit IFCOMPENABLED(m) 1 Activation flag for component m =0, component disabled =1, component enabled IFRCO(m) 0 Component m pressure and shear force output flag =0, do not evaluate component forces on component m =1, evaluate and plot forces on component m IFWETAR(m) 0 Flag for wetted area output for component m =0, no wetted area output =1, component surface area wetted by fluid #1 is computed and output to General History data catalogue MATERIAL(m)  “ “ Character string allowing user to identify the material of component m (up to 256 characters). NOBR(m) ... Component identifier for restarts; used to identify the old component number if components have been changed for restart runs.  =0, for a newly added component Defaults to the current component number. NOBS 0  Number of components OBSID(m) “ “ Character string allowing user to identify component m (up to 50 characters) SUBCMPID(n) “ “ Character string allowing user to identify subcomponent n (up to 256 characters) 
Subcomponents: General Parameters 

Namelist OBS 
m < 500, component index 
n < 500, subcomponent index NAME DEFAULT DESCRIPTION FANSEL(n) cadenn.inp File name for ANSYS element connectivity data file, where 



"nn"=n. FANSND(n) cadnnn.inp File name for ANSYS nodal coordinate data file, where "nn"=n. FIDEAS(n) cadfnn.inp File name for I-DEAS CAD data file, where "nn"=n. FSTL(n) stlfnn.inp File name for stereolithography (STL) CAD data file, where "nn"=n. FTOPO(n) topofnn.inp File name for topographic file, where "nn"=n. FFAVOR(n) favdnn.inp File name for FAVOR™ fractions in external data file, where "nn"=n. ICONV(n) 1 Flag for conversion of CAD data (I-DEAS or ANSYS) to STL data =0, do not convert data =1, convert data to STL data and generate STL file stlfnn.inp where"nn"=n. IFSUBCOMPENABLED(n) 1 Activation flag for subcomponent n =0, subcomponent disabled =1, sub component enabled IGEN(n) 0 Subcomponent generation flag, indicates source of geometric data for region n =0, FLOW-3D component generator =1, FAVOR™ fractions in external data file =2, I-DEAS CAD data file =3, stereolithography (STL) CAD data file  =4, ANSYS tetrahedral or surface triangle geometric data files =5, topographic file IOB(n) ... Associates subcomponent n with a particular component Default is IOB (n)=n.  (Usage: IOB(n)=m; region n is part of component m.) IOH(n) 1 Subcomponent type =0, hole =1, solid =-1, complement (CAD data and FAVOR™ data file only). 
Subcomponents: Limiters 

Namelist OBS 
n < 500, subcomponent index NOTES: ALL SUBCOMPONENTS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. 



ALL SUBCOMPONENT LIMITER DEFAULTS INCLUDE THE ENTIRE MESH. NAME DEFAULT DESCRIPTION ANGLH(n) ... Upper cylindrical angle limit for subcomponent n (measured in the x-y plane from the x-axis, in degrees). ANGLL(n) ... Lower cylindrical angle limit for subcomponent n (measured in the x-y plane from the x-axis, in degrees). CONEH(n) ... Upper conical angle limit for subcomponent n (measured from the z-axis in degrees). CONEL(n) ... Lower conical angle limit for subcomponent n (measured from the z-axis in degrees). RAH(n) ... Upper cylindrical-radius limit for subcomponent n RAL(n) ... Lower cylindrical-radius limit for subcomponent n RSH(n) ... Upper spherical-radius limit for subcomponent n RSL(n) ... Lower spherical-radius limit for subcomponent n RTORIN(n) -1.0 Minor toroid radius RTOROUT(n) -1.0 Major toroid radius XH(n) ... Upper x-coordinate limit for subcomponent n XL(n) ... Lower x-coordinate limit for subcomponent n YL(n) ... Lower y-coordinate limit for subcomponent n  ZH(n) ... Upper z-coordinate limit for subcomponent n  ZL(n) ... Lower z-coordinate limit for subcomponent n 
Subcomponents: Function Coefficients 

Namelist OBS 
n < 500, subcomponent index NOTE: ALL SUBCOMPONENTS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. NAME DEFAULT DESCRIPTION CC(n) 0.0  Function constant coefficient for subcomponent n CDUM(n) 0.0 Dummy function coefficient for subcomponent n for customizing functions CRXY(n) 0.0  Function coefficient of 2 2x y+  for subcomponent n CX(n) 0.0  Function coefficient of x for subcomponent n 



CX2(n) 0.0  Function coefficient of x² for subcomponent n CXY(n) 0.0  Function coefficient of xy for subcomponent n CXZ(n) 0.0  Function coefficient of xz for subcomponent n CY(n) 0.0  Function coefficient of y for subcomponent n CY2(n) 0.0  Function coefficient of y² for subcomponent n CYZ(n) 0.0  Function coefficient of yz for subcomponent n CZ(n) 0.0  Function coefficient of z for subcomponent n CZ2(n) 0.0  Function coefficient of z² for subcomponent n 
Subcomponents: Transformations 

Namelist OBS 
n < 500, subcomponent index NOTES: ALL SUBCOMPONENTS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM.  MAGNIFICATIONS ARE PERFORMED BEFORE ROTATIONS, WHICH ARE PERFORMED BEFORE REFLECTIONS, WHICH ARE PERFORMED BEFORE TRANSLATIONS.  X-ROTATIONS ARE PERFORMED BEFORE Y-ROTATIONS, WHICH ARE PERFORMED BEFORE Z-ROTATIONS. NAME DEFAULT DESCRIPTION MAGN(n) 1.0  Magnification (scaling) factor for subcomponent n MAGNX(n) 1.0  Scaling factor in x-direction for subcomponent n MAGNY(n) 1.0  Scaling factor in y-direction for subcomponent n MAGNZ(n) 1.0  Scaling factor in z-direction for subcomponent n ROTX(n)) 0°  Subcomponent n rotation about x-axis in degrees, positive in right hand sense ROTY(n) 0°  Subcomponent n rotation about y-axis in degrees ROTZ(n) 0°  Subcomponent n rotation about z-axis in degrees TRNX(n) 0.0  Subcomponent n translation in x-direction TRNY(n) 0.0  Subcomponent n translation in y-direction TRNZ(n) 0.0  Subcomponent n translation in z-direction XTRFC(n) 0.0 x-coordinate of transformation center for subcomponent n Magnification and rotation are made about the transformation center. YTRFC(n) 0.0 y-coordinate of transformation center for subcomponent n 



Magnification and rotation are made about the transformation center. ZTRFC(n) 0.0 z-coordinate of transformation center for subcomponent n Magnification and rotation are made about the transformation center. 
Component Copy: Parameters 

Namelist OBS 
t < 500, time index 
n < 500, copy index 
m < 500, component index NOTES:  ALL SUBCOMPONENTS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. MAGNIFICATIONS ARE PERFORMED BEFORE ROTATIONS, WHICH ARE PERFORMED BEFORE REFLECTIONS, WHICH ARE PERFORMED BEFORE TRANSLATIONS.  X ROTATIONS ARE PERFORMED BEFORE Y ROTATIONS, WHICH ARE PERFORMED BEFORE Z ROTATIONS.  CAD DATA CANNOT BE COPIED. NAME DEFAULT DESCRIPTION CMAGN(n) 1.0  Magnification (scaling) factor for component copy n CMAGNX(n) 1.0  Scaling factor in x-direction for component copy n CMAGNZ(n) 1.0  Scaling factor in z-direction for component copy n CRFLX(n) ... Component copy n x-reflection location.  Defaults outside mesh for no reflection. CRFLY(n) ... Component copy n y-reflection location.  Defaults outside mesh for no reflection. CRFLZ(n) ... Component copy n z-reflection location.  Defaults outside mesh for no reflection. CROTX(n) 0° Component copy n rotation about x-axis in degrees, positive in right-hand sense.  CROTY(n) 0°  Component copy n rotation about y-axis (degrees) CROTZ(n) 0° Component copy n rotation about z-axis (degrees) CTRNX(n) 0.0  Component copy n translation in x-direction 



CTRNY(n) 0.0  Component copy n translation in y-direction CTRNZ(n) 0.0  Component copy n translation in z-direction ICPY(n) 0 Number for component that is template for copy n (Usage: ICPY(n)=m; copy n uses the subcomponents defined for component m). IVRT(m) 0 Virtual component flag for component m =0, construct component =1, use defined subcomponents only as template for making copies Do not construct component as defined by subcomponents. OSPIN(t,m) 0.0 Spin rate for rotating component m (rad/s) at time TOBS(t). Component must be axisymmetric about axis of spin. The spinning object must be a copy of a virtual component (only one copy is allowed). The original object must be defined to rotate about the z-axis. The spinning object location and spin axis are determined by the copy rotations and translations. 
Component Properties: Contact Angle and Roughness 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION OCANG(m) CANGLE Static contact angle (in degrees) for fluid #1 wall adhesion for component m. (CANGLE is set in namelist PROPS). 0 < OCANG < 90 indicates wetting condition 90 < OCANG < 180 indicates non-wetting condition See also CANGSUB(n). OFRCOF(m) -1.0 Coefficient of friction between fluid and solid walls for the partial slip model for component m. A zero value corresponds to free slip and an infinite value to no-slip. A negative value turns off the partial slip model.  See FRCOFin namelist PROPS.  ROUGH(m) ...  Wall roughness for component m for wall shear stress calculations. A roughness of 0.0 corresponds to a smooth surface. ROUGH < 0 indicates free-slip surfaces for component m. A positive value of ROUGH should correspond to the average height of surface imperfections like bumps and pits. A positive value of ROUGH also induces boiling in one- and two-fluid phase change models (IPHCHG=2 or 5), irrespective of the value of the superheat temperature TV0. 



For lost foam components with gravity effects (CGFOB> 0.0), ROUGH defaults to 0.1 for all foam components. Otherwise, defaults to 0.0.  
Component Properties: Electrostatic and Electroosmotic Potential, Joule 
Heating 

Namelist OBS 
m < 500, component index 
t < 500, time index NAME DEFAULT DESCRIPTION OEPOT(t,m) 0.0 Electrostatic potential of component m at time TOBS(t) OEPOTZT(m) 0.0 Zeta potential of component m ODIEL(m) 0.0 Dielectric constant for component m OECOND(m) 0.0 Electric conductivity for component m OECHRG(m) 0.0 Initial uniform electric charge density in component m 

Component Properties: Heat Transfer Coefficients 
Namelist OBS 
m < 500, component index 
t < 500, time index NOTES: RADIATION IS NOT ALLOWED WITH POROUS COMPONENTS.  For heat transfer to voids, see IVHT in namelist FL and ICCTYPE in namelist OBS. NAME DEFAULT DESCRIPTION HOBE1(m) 0.0  Component m radiation to void emissivity times Stefan-Boltzmann constant product HOBE2(m) 0.0  Component m radiation to void emissivity times Stefan-Boltzmann constant product HOBE3(m) 0.0  Component m radiation to void emissivity times Stefan-Boltzmann constant product HOBS1S(m) … Heat-transfer coefficient for solid fraction in fluid/component interfacial cells Defaults to HOBS1(m). HOBS1(m) -1.0  Heat-transfer coefficient to fluid #1 for component m. 



If HOBS1(m)=-1.0, the solver will calculate a heat-transfer coefficient. If HOBS1(m) =0.0, then no heat transfer to components occurs. For a lost foam component (IFOB(m)=1), HOBS1(m) is the foam/metal heat transfer coefficient and must be specified. HOBS2(m) -1.0  Heat-transfer coefficient to fluid #2 for component m.  If HOBS2(m)=-1.0, the solver will calculate a heat-transfer coefficient.  HOBV1(m) 0.0  Component m heat transfer to void See IVHT in namelist FL and ICCTYPE in namelist OBS. HOBV2(m) 0.0  Component m heat transfer to void See IVHT in namelist FL and ICCTYPE in namelist OBS. HOBV3(m) 0.0  Component m heat transfer to void See IVHT in namelist FL and ICCTYPE in namelist OBS. HOBVT1(t,m) 0.0  Time-dependent component m heat transfer to void See IVHT in namelist FL and ICCTYPE in namelist OBS. HOBVT2(t,m) 0.0  Time-dependent component m heat transfer to void See IVHT in namelist FL and ICCTYPE in namelist OBS. HOBVT3(t,m) 0.0  Time-dependent component m heat transfer to void See IVHT in namelist FL and ICCTYPE in namelist OBS. HTCOB(m1,m2) -1.0 Heat transfer coefficient between component m1 and component m2 If HTCOB(m1,m2) < 0.0, the interface between the two components is assumed to have no thermal resistance. If HTCOB(m1,m2)=0, a fully insulated interface is assumed between the two components. TOBS(t) 0.0  Times for time-dependent component arrays 
Component Properties: Lost Foam Casting Model Parameters 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION IFOB(m) 0 "Free" (or phantom) component flag =-2, core gas component =-1, porous component =0, regular component =1, lost foam component 



=2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. HOBS1(m) 0.0  Heat-transfer coefficient between fluid #1 and foam component m (IFOB(m)=1) HOBS1(m) must be positive for the metal to advance into foam. RCOBS(m) 0.0  Density times specific heat product for component m. If RCOBS(m) > 0.0, a dynamic equation is solved for the heat transfer surface temperature. Alternate: MOBS(m) RCOBS(m) is required input for lost foam components. For GMO components RCOBS(m) should be used in place of MOBS(m). REMFOB(m) 0.0  Density times melting-energy product for foam REVFOB(m) 0.0  Density times vaporization-energy product for foam TMFOB(m) 0.0  Foam melting temperature TVFOB(m) 0.0  Foam vaporization temperature 
Component Properties: Dissolving Components 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION IFOBDISS(m) 0 Dissolving component flag =0, regular component =1, dissolving component Requires the activation of the dissolution model, IDISSOLVE=1. 

Component Properties: Vents 
Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION IFOB(m) 0 “Free” (or phantom) component flag 



=-2, core gas component =-1, porous component =0, regular component =1, lost foam component =2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component; may include many individual vent channels, all with the same properties and external pressure. NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. VTAREA(m) 0.0 Open area of each individual vent defined by vent component m VTDIAM(m) 0.0 Diameter of an individual vent channel VTPRES(m) 0.0 External vent pressure 
Component Properties: Mass Sources 

Namelist OBS 
t < 500, time index 
m < 500, component index 
ns < 99, scalar index 
k ≤ 10, sediment species index Note: The mass source model requires the setting of IQSR=1 in XPUT. See IQSR in namelist XPUT. NAME DEFAULT DESCRIPTION IAQSRB(m) 0 Activation flag for individual mass source (when flow rate is negative) for geometry component m. =0, source is deactivated =1, source is activated IFQSRB(m) 1 Index of fluid released by mass source (when flow rate is positive) for geometry component m. =1,fluid #1  =2, fluid #2 (or void) IFSNKB(m) 1 Index of fluid removed by mass source (when flow rate) is negative) for geometry component m. 



=1, fluid #1 =2, fluid #2 (or void) =3, mixture of fluids #1 and #2 (or void) in proportion to their volume fractions in the mesh cells adjacent to source. IOQSRT(m) 1 Mass source type  =0, static pressure source (e.g., flow out of a pipe)  =1, stagnation pressure source (e.g., flow out of a rocket) This option is only used when the mass source is positive. It does not apply to mass sinks. Generally, this option is most useful when applied to coupled-motion GMO components with mass sources. ITQSRB(m) 1 Indicator of fluid flow rate of mass source for geometry component m.  =1, total flow rate is defined (QSROBS(t,m)) =2, flow rate per unit component surface area is defined (SQSROBS(t,m)) IVQSRB(m) 2 Indicator of volume or mass flow rate for fluid from mass source for geometry component m. =1, volume flow rate (QSROBS(t,m) or SQSROBS(t,m) defines volume flow rate) =2, mass flow rate defined (QSROBS(t,m) or SQSROBS(t,m) defines mass flow rate) QSROBS(t,m) 0.0  Total flow rate from mass source at time TOBS(t) for geometry component m, where t is index of time. Positive if fluid is released; negative if fluid is removed. Can change sign with time. If IVQSRB(m)=1, it is volume flow rate. If IVQSRB(m)=2, it is mass flow rate. RHOQSRB(m) … Density of fluid released by mass source for geometry component m For variable density problems only. Used when mass (or volume) flow rate from source is positive. For a one-fluid problem with fluid #1 release, defaults to RHOF. For a compressible flow problem, defaults to RHOF2. RHOSNKB(m) … Density of gas in voids Used to convert mass flow rate to volume flow rate at void sinks in one-fluid problems, IVQSRB(m)=2, IFSNKB(m)=2 or 3, and NMAT=1. ROBS(m) 1.0  Roughness of component m. This multiplies the cell-face area to give the effective heat transfer area for each cell. No heat transfer at component m if ROBS(m)=0.0.  Also, no mass sources are applied for component m if ROBS(m)=0.0. 



SCLQSR(ns,m) 0.0 Scalar magnitude of species ns in fluid added by mass source m SQSROBS(t,m) 0.0 Flow rate per unit surface area from mass source at time TOBS(t) for geometry component m, where t is index of time. Positive if fluid is released; negative if fluid is removed. Can change sign with time. If IVQSRB(m)=1, it is volume flow rate. If IVQSRB(m)=2, it is mass flow rate. TOBS(t) 0.0  Times for time-dependent component arrays QSRAIR(m) 0.0 Volume fraction of entrained air at mass source m Only used when IDFAIR=1. QSRCHRG(m) 0.0 Electric charge density at mass source m Only used when IECHRG=1. QSRDISS(m) 0.0 Concentration of dissolved air at mass source m Only used when IDISSOLVE=1. QSRNCG(m) 0.0 Volume fraction of the non-condensable gas component in the gas phase at mass source m Only used when INCG=1 and IQSR=2. QSRSS(m,k) 0.0 Suspended sediment mass concentration of sediment species k at mass source m Only used when NSSPC > 0. QSRSEG(m) 0.0 Solute mass concentration at mass source m Only used when ISEG=1. 
Component Properties: Moisture Drying Model 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION IFOBSMST(m) 0 Moisture flag for component m =0, no moisture inside component =1, component contains moisture Requires the activation if a moisture drying model, IFDRYING=1 or 2. OBSMST(m) 0.0  Initial uniform moisture content in component m defined as: % weight fraction of the dry component when IFMST=1, or macroscopic concentration (weight per unit bulk component volume) when IFMST=2. RHOBS(m) -1.0 Dry component m microscopic density (weight per unit solid 



volume in mesh) 
Component Properties: Fluid-Structure Interaction (FSI) model 

Namelist OBS 
m ≤ 500, component index NAME DEFAULT DESCRIPTION IFSI(m) 0 Fluid-structure interaction (FSI) flag for component m =0, deactivates the fluid-structure interaction model =1, activates the fluid-structure interaction model IFFEM(m) 0 Flag to use finite element (FE) mesh file for the fluid-structure interaction solver for component m =0, generate finite element (FE) mesh file for the component =1, use existing finite element (FE) mesh file for the component FFEM(m) … Finite element (FE) mesh file name for component m Defaults to compm.prjext.FEmesh, where prjext is the project extension and m is the component number. Can include the full path, e.g., “c:\work\my_comp1.FEmesh” (up to 256 characters). RHOBS(m) -1.0 Density of component m BLKMOD(m) 0.0 Bulk modulus of component m ELASTMOD(m) 0.0 Elastic modulus of component m  POISSONR(m) -2.0 Poisson ratio of component m SHRMOD(m) 0.0 Shear modulus of component m THEXOBS(m) 0.0 Thermal expansion coefficient of component m 

Component Properties: Thermal Stress Evolution (TSE) Model 
Namelist OBS 
m ≤ 500, component index NOTE: USED BY THE THERMAL STRESS MODEL, ITHRMST. NAME DEFAULT DESCRIPTION IFSOFT(m) 0 Flag to determine the stiffness of non-FSI component m adjacent to solidified fluid region. =0, constraining component—does not deform with solidified fluid =1, non-constraining component—deforms with solidified fluid 



(i.e., represents sand mold) 
Component Properties: General Moving Objects (GMO) 

Namelist OBS 
m ≤ 500, component index 
mf = 1,2,3, control force index 
n ≤ 500, subcomponent index  
t ≤ 500, time index VARIABLE DEFAULT DESCRIPTION ANGLMIN(m) 1.0 x 1019 Maximum angular displacement from the initial position, in degrees, in the negative rotational direction for fixed-axis rotation. Used when IMOAXS(m)=1, 2, 3. ANGLMAX(m) 1.0 x 1019 Maximum angular displacement from the initial position, in degrees, in the positive rotational direction for fixed-axis motion. Used when IMOAXS(m)=1, 2, 3. CANGSUB(n) OCANG(m) Static contact angle (in degrees) for fluid #1 wall adhesion for subcomponent n of component m 0 < CANGSUB < 90 indicates wetting condition 90 < CANGSUB < 180 indicates non-wetting condition CFRC(m) FRCMOB Coefficient of friction during collision for component m. Used in the GMO collision model. The smallest value is used for two colliding components, one of which must be a coupled-motion component. FRCMOB is defined in XPUT. CRSTRGN(m) STRNGMOB Coefficient of Stronge’s restitution for component m. Used in the GMO collision model. The smallest value is used for two colliding components, one of which must be a coupled-motion component. Values should be between 0.0 and 1.0. STRNGMOB is defined in XPUT. DXMCMIN(m) 1.0 x 1019 Maximum allowed displacement from the initial position in the negative x-direction Used when IMOAXS(m)=0 DXMCMAX (m) 1.0 x 1019 Maximum allowed displacement from the initial position in the positive x-direction Used when IMOAXS(m)=0 



DYMCMIN(m) 1.0 x 1019 Maximum allowed displacement from the initial position in the negative y-direction Used when IMOAXS(m)=0 DYMCMAX(m) 1.0 x 1019 Maximum allowed displacement from the initial position in the positive y-direction Used when IMOAXS(m)=0 DZMCMIN(m) 1.0 x 1019 Maximum allowed displacement from the initial position in the negative z-direction Used when IMOAXS(m)=0 DZMCMAX(m) 1.0 x 1019 Maximum allowed displacement in the positive z-direction  Used when IMOAXS(m)=0 FXTOBS(t,m) 0.0 Time-dependent control force component at time TOBS(t) When IREFGF(m)=1, it is in x-direction of space system. When IREFGF(m)=0, it is in x'-direction of body system.  Used when IMO(m)=4, IMOAXS(m)=0 and IUMCAL(m)=1, and applied at the mass center. FXTOBSM(t,m,mf) 0.0 x-component of control force mf at time TOBS(t). When IREFGFM(m,mf)=1, it is in x-direction of the space system. When IREFGFM(m)=2, it is in x'-direction of the body system.  Used when IGF(m)=2. FYTOBS(t,m) 0.0 Time-dependent control force component at time TOBS(t). When IREFGF(m)=1, it is in y-direction of space system. When IREFGF(m)=0, it is in y'-direction of body system.  Used when IMO(m)=4, and IVMCAL(m)=1, and applied at the mass center. FYTOBSM(t,m,mf) 0.0 y-component of control force mf at time TOBS(t) When IREFGFM(m,mf)=1, it is in y-direction of the space system. When IREFGFM(m)=2, it is in y'-direction of the body system.  Used when IGF(m)=2. FZTOBS(t,m) 0.0 Time-dependent control force component at time TOBS(t).  When IREFGF(m)=1, it is in z-direction of space system. When IREFGF(m)=0, it is in z'-direction of body system.  Used when IMO(m)=4, IMOAXS(m)=0 and IWMCAL(m)=1, and applied at the mass center. FZTOBSM(t,m,mf) 0.0 z-component of control force mf at time TOBS(t) When IREFGFM(m,mf)=1, it is in z-direction of the space system. When IREFGFM(m,mf)=2, it is in z'-direction of the body system.  Used when IGF(m)=2. 



IBUOYO(m) 0 Flag for the output of buoyancy center and metacentric height Used when IMO(m)=4. =0, do not evaluate and output buoyancy center and metacentric height =1, evaluate and output buoyancy center and metacentric height. ICLIDOB(m1,m2) ICLID Collision flag for components m1 and m2, one of which is a coupled-motion GMO component. =1, calculate collision between components m1 and m2 =0, no collision between components m1 and m2; if m1=m2, then component m1 does not collide with any other components and symmetry- and wall-type mesh boundaries. In this case the moving components can move through other components and walls. ICLID is defined in XPUT. IGF(m) 0 Type of input data for control force and torque. Used when IMO(m)=4. =0, no control force and torque are defined =1, define total control force and total control torque =2, define multiple control forces and their application points IMO(m) 0 Type of moving object =0, stationary component =3, prescribed-motion of general moving object =4, coupled-motion of general moving object IMOAXS 0 Specifies how a component’s motion is to be constrained =0, 6 degrees of freedom =1, fixed x-axis rotation =2, fixed y-axis rotation =3, fixed z-axis rotation =4, fixed point rotation IOMXCAL(m) 1 Flag for rotational component in x'-direction of body system Used when IMO(m)=4. =1, coupled motion =0, prescribed motion IOMXPRE(m) 0 Type of time-dependent x'- angular velocity in body system Used when IMO(m)=3 or 4, and IMOAXS(m)=0, 1, or 4. = 0, constant or tabular data = 1, sinusoidal function of time IOMYCAL(m) 1 Flag for rotational component in y'-direction of body system Used for IMO(m)=4. 



=1, coupled motion =0, prescribed motion IOMYPRE(m) 0 Type of time-dependent y'- angular velocity in body system Used when IMO(m)=3 or 4, and IMOAXS(m)=0, 2, or 4. = 0, constant or tabular data =  1, sinusoidal function of time IOMZCAL(m) 1 Flag for rotational component in z'-direction of body system Used for IMO(m)=4. =1, coupled motion =0, prescribed motion IOMZPRE(m) 0 Type of time-dependent z'- angular velocity in body system Used when IMO(m)=3 or 4, and IMOAXS(m)=0, 3, or 4. = 0, constant or tabular data = 1, sinusoidal function of time IPRPMVB(m) 0 Flag for mass property input =1, If IMOAXS(m)=0 or 4, then mass, MASSMVB(m), initial coordinates of mass center in space system, XMCMVB0(m), YMCMVB0(m), ZMCMVB0(m), and moment of inertia tensor, TJMVB(m,i,j), are required input data. If IMOAXS(m)=1, 2, or 3, then mass, MASSMVB(m), initial coordinates of mass center in space system, XMCMVB0(m), YMCMVB0(m), ZMCMVB0(m), and moment of inertia about the fixed axis, TJAXS(m), are required input data. =0, Uniform mass density, RHOMVB(m), is required input data.  NOTE: MASS PROPERTIES OF MOVING OBJECT IS REQUIRED INPUT IF IMO(M)=4 AND OPTIONAL IF IMO(M)=3. IF MASS PROPERTIES ARE DEFINED WHEN IMO(M)=3, THEN CONTROL FORCES AND TORQUES WILL BE COMPUTED AND STORED AS HISTORY DATA IN BOTH SPACE AND BODY COORDINATE SYSTEMS. IREFGF(m) 1 Indicator of reference system in which control forces and torques are prescribed. Used when IMO(m)=4. =1, space system =2, body system IREFGFM(m,mf) 1 Indicator of the reference system in which control force mf exerting on component m is defined Used when IGF(m)=2. =1, space system =2, body system IUMCAL(m) 1 Flag for translational component in x-direction of space system Used for IMO(m)=4. 



=1, coupled motion =0, prescribed motion IUPRE(m) 0 Type of time-dependent translational x-velocity in space system Used when IMO(m)=3 or 4 and IMOAXS(m)=0. = 0, constant or tabular data  = 1, sinusoidal function of time IVMCAL(m) 1 Flag for translational component in y-direction of space system Used for IMO(m)=4. =1, coupled motion =0, prescribed motion IVPRE(m) 0 Type of time-dependent translational y-velocity in space system Used when IMO(m)=3 or 4, and IMOAXS(m)=0. = 0, constant or tabular data = 1, sinusoidal function of time IWMCAL(m) 1 Flag for translational component in z-direction of space system  Used for IMO(m)=4. =1, coupled motion =0, prescribed motion IWPRE(m) 0 Type of time-dependent translational z-velocity in space system Used when IMO(m)=3 or 4, and IMOAXS(m)=0. = 0, constant or tabular data = 1, sinusoidal function of time MASSMVB(m) … Total mass of moving object Used when IPRPMVB(m)=1 and IMO(m)=3 or 4. OMXAMP(m) 0.0 Amplitude of sinusoidal x'- angular velocity in body system, in rad/s Used when IOMXPRE(m)=1. OMXFRE(m) 0.0 Frequency of sinusoidal x'- angular velocity in body system, in Hz Used when IOMXPRE(m)=1. OMXPHS(m) 0.0 Initial phase of sinusoidal x'- angular velocity in body system, in degrees Used when IOMXPRE(m)=1. OMXTOBS(t,m) 0.0 Time-dependent angular velocity component in x'-direction of body system at time TOBS(t) Used when IMO(m)=3 or 4 and IMOAXS(m)=0, 1, or 4. Applied at the reference point for IMO(m)=3, and at the mass center for IMO(m)=4. 



OMYAMP(m) 0.0 Amplitude of sinusoidal y'- angular velocity in body system, in rad/s Used when IOMYPRE(m)=1. OMYFRE(m) 0.0 Frequency of sinusoidal y'- angular velocity in body system, in Hz Used when IOMYPRE(m)=1. OMYPHS(m) 0.0 Initial phase of sinusoidal y'- angular velocity in body system, in degrees Used when IOMYPRE(m)=1. OMYTOBS(t,m) 0.0 Time-dependent angular velocity component in y'-direction of body system at time TOBS(t). Used when IMO(m)=3 or 4 and IMOAXS( m)=0, 2, or 4. Applied at the reference point for IMO(m)=3, and at the mass center for IMO(m)=4. OMZAMP(m) 0.0 Amplitude of sinusoidal z'- angular velocity in body system, in rad/s Used when IOMZPRE(m)=1. OMZFRE(m) 0.0 Frequency of sinusoidal z'- angular velocity in body system, in Hz Used when IOMZPRE(m)=1. OMZPHS(m) 0.0 Initial phase of sinusoidal z'- angular velocity in body system, in degrees Used when IOMZPRE(m)=1. OMZTOBS(t,m) 0.0 Time-dependent angular velocity component in z'-direction of body system at time TOBS(t) Used when IMO(m)=3 or 4 and IMOAXS( m)=0, 3, or 4. Applied at the reference point for IMO(m)=3, and at the mass center for IMO(m)=4. RHOMVB(m) … Global mass density of moving object Used when IPRPMVB (m)=0 and IMO(m)=3 or 4. RHOSUB(n) RHOMVB(m) Uniform mass density of subcomponent n of moving component m Used when IPRPMVB (m)=0 and IMO(m)=3 or 4. TJAXS(m)  … Moment of inertia about fixed axis for component m  Used when IPRPMVB(m)=1, IMOAXS( m)=1, 2, or 3 and IMO(m)=3 or 4. TJMVB(m,i,j) … Moment of inertia tensor in body system Used when IPRPMVB (m)=1, IMOAXS(m)=0 or 4, and IMO(m)=3 or 4. TOBS(t) 0.0 Times for time-dependent component arrays 



TXTOBS(t,m) 0.0 Time-dependent control torque component at time TOBS(t). When IREFGF(m)=1, it is in x-direction of space system. When IREFGF(m)=2, it is in x'-direction of body system.  Used when IMO(m)=4, IOMXCAL(m)=1 and IMOAXS( m)=0, 1, or 4. Applied at the mass center for IMOAXS(m)=0, and at the rotation axis or point for IMOAXS(m)=1 or 4. TYTOBS(t,m) 0.0 Time-dependent control torque component at time TOBS(m). When IREFGF(m)=1, it is in y-direction of space system. When IREFGF(m)=2, it is in y'-direction of body system.  Used when IMO(m)=4, IOMYCA(m)=1 and IMOAXS( m)=0, 2, or 4. Applied at the mass center for IMOAXS(m)=0, and at the rotation axis or point for IMOAXS(m)=1 or 4. TZTOBS(t,m) 0.0 Time-dependent control torque component at time TOBS(t). When IREFGF(m)=1, it is in z-direction of space system. When IREFGF(m)=2, it is in z'-direction of body system.  Used when IMO (m)=4, IOMZCAL(m)=1 and IMOAXS( m)=0, 3, or 4. Applied at the mass center for IMOAXS(m)=0, and at the rotation axis or point for IMOAXS(m)=1 or 4. UAMP(m) 0.0 Amplitude of sinusoidal translational x-velocity in space system Used when IUPRE(m)=1. UFRE(m) 0.0 Frequency of sinusoidal translational x-velocity in space system, in Hz Used when IUPRE(m)=1. UPHS(m) 0.0 Initial phase of sinusoidal translational x-velocity in space system, in degrees Used when IUPRE(m)=1. UTOBS(t,m) 0.0 Time-dependent velocity component in x-direction at time TOBS(t) Used when IFOB(m)=4 or IMO(m)=2, 3, or 4.  For IMO(m)=4, UTOBS(1,m) is the initial velocity of the mass center; for IMO(m)=3, UTOBS(t,m) is the velocity of the reference point. VAMP(m) 0.0 Amplitude of sinusoidal translational y-velocity in space system Used when IVPRE(m)=1. VFRE(m) 0.0 Frequency of sinusoidal translational y-velocity in space system, in Hz Used when IVPRE(m)=1. VPHS(m) 0.0 Initial phase of sinusoidal translational y-velocity in space system, in degrees 



Used when IVPRE(m)=1. VTOBS(t,m) 0.0 Time-dependent velocity component in y-direction at time TOBS(t) Used when IFOB(m)=4 or IMO(m)=2, 3, or 4.  For IMO(m)=4, UTOBS(1,m) is the initial velocity of the mass center; for IMO(m)=3, UTOBS(t,m) is the velocity of the reference point. WAMP(m) 0.0 Amplitude of sinusoidal translational z-velocity in space system Used when IWPRE(m)=1. WFRE(m) 0.0 Frequency of sinusoidal translational z-velocity in space system, in Hz Used when IWPRE(m)=1. WPHS(m) 0.0 Initial phase of sinusoidal translational z-velocity in space system, in degrees Used when IWPRE(m)=1. WTOBS(t,m) 0.0 Time-dependent velocity component in z-direction at time TOBS(t) Used when IFOB(m)=4 or IMO(m)= 2, 3, or 4.  For IMO(m)=4, UTOBS(1,m) is the initial velocity of the mass center; for IMO(m)=3, UTOBS(t,m) is the velocity of the reference point. XAXS(m) 0.0 X-coordinate of fixed point or fixed axis in space system Used when IMOAXS(m)>0. XFPNT(m,mf) XMCMVB0(m) Initial x-coordinate (in space system) of the application point of control force mf.  The application point is fixed on geometry component m (a moving object) Used when IGF(m)=2. XMCMVB0(m) … Initial x-coordinate of mass center in space system. Required when integrated mass properties are defined for moving component m under coupled or prescribed motion (IPRPMVB(m)=1 and IMO(m)=3 or 4). XREF0(m) … Initial x-coordinate of the reference point in space system. Required for prescribed motion with 6 degrees of freedom (IMO(m)=3 and IMOAXS(m)=0). If mass properties are defined, defaults to x-coordinate of the mass center; otherwise, defaults to x-coordinates of the geometric center. YAXS(m) 0.0 Y-coordinate of fixed point or fixed axis in space system.  Used when IMOAXS(m) > 0. YFPNT(m,mf) YMCMVB0(m) Initial y-coordinate (in space system) of the application point of 



control force mf. The application point is fixed on geometry component m (a moving object).  Used when IGF(m)=2. YMCMVB0(m) … Initial y-coordinate of mass center in space system Required when integrated mass properties are defined for moving component m under coupled or prescribed motion (IPRPMVB(m)=1 and IMO(m)=3 or 4). YREF0(m) … Initial y-coordinate of the reference point in space system Required for prescribed motion with 6 degrees of freedom (IMO(m)=3 and IMOAXS(m)=0). If mass properties are defined, defaults to x-coordinate of the mass center; otherwise, defaults to x-coordinates of the geometric center. ZAXS(m) 0.0 Z-coordinate of fixed point or fixed axis in space system Used for IMOAXS(m) > 0. ZFPNT(m,mf) ZMCMVB0(m) Initial z-coordinate (in space system) of the application point of control force mf The application point is fixed on geometry component m (a moving object).  Used when IGF(m)=2. ZREF0(m) … Initial z-coordinate of the reference point in space system Required for prescribed motion with 6 degrees of freedom (IMO(m)=3 and IMOAXS(m)=0). If mass properties are defined, defaults to x-coordinate of the mass center; otherwise, defaults to x-coordinates of the geometric center. 
Elastic Springs and Ropes  

Namelist OBS 
m ≤ 500, component index 
nsp  ≤ 100, elastic spring/rope index VARIABLE DEFAULT DESCRIPTION ASP(nsp)  Free length of spring/rope nsp Used if IFSP(nsp) = 1, 2, 3 or 4.  Default to the initial distance between two ends of the spring/rope. BSP (nsp) 10%×ASP(nsp) Block length of spring nsp. Used if IFSP(nsp) = 2 or 3. CSP(nsp) ... Spring coefficient of spring/rope nsp. Units in [force]/[length] if IFSP(nsp) ≠ 5 and [torque]/degree if IFSP(nsp) = 5. 



IFSP(nsp) 2 Type of elastic spring/rope nsp =1, elastic rope. Used when IMO(m)=4, where m = IOBSP1(nsp) or IOBSP2(nsp).   =2, compression-extension spring. Used when IMO(m)=4, where m = IOBSP1(nsp) or IOBSP2(nsp).   =3, compression spring. Used when IMO(m)=4, where m = IOBSP1(nsp) or IOBSP2(nsp).   =4, extension spring. Used when IMO(m)=4, where m = IOBSP1(nsp) or IOBSP2(nsp).   =5, torsion spring. Used when IMO(m)=4 and IMOAXS(m)=1, 2 or 3, where m = IOBSP1(nsp). IOBSP1(nsp) 0 Index of the geometry component which end 1 of the spring/rope nsp is attached to. Equal to 0 if fixed at a stationary point in space.  Used when IFSP(nsp) =1, 2, 3, 4 or 5. IOBSP2(nsp) 0 Index of the geometry component which end 2 of the spring/rope nsp is attached to. Equal to 0 if fixed at a stationary point in space.  Used when IFSP(nsp) ≠ 5. NSPRP 0 Total number of elastic springs and ropes SPRINGNAME(nsp) ‘  ‘ Spring nsp name (up to 256 characters) TSP0(nsp) 0.0 Initial torque of torsion spring nsp. Used if IFSP(nsp) = 5. XSP01(nsp) ... Initial x-coordinate of end 1 of the spring/rope nsp XSP02(nsp) ... Initial x-coordinate of end 2 of the spring/rope nsp YSP01(nsp) ... Initial y-coordinate of end 1 of the spring/rope nsp YSP02(nsp) ... Initial y-coordinate of end 2 of the spring/rope nsp ZSP01(nsp) ... Initial z-coordinate of end 1 of the spring/rope nsp ZSP02(nsp) ... Initial z-coordinate of end 2 of the spring/rope nsp 
Component Properties: Sediment Scour Component Parameters 

Namelist OBS 
m < 500, component index 
k ≤ 10, sediment species index NAME DEFAULT DESCRIPTION IFOB(m) 0 "Free" (or phantom) component flag =-2, core gas component =-1, porous component 



=0, regular component =1, lost foam component =2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component =7, domain-removing component for thermal stress evolution (TSE) model NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. SSOBS(m,k) for k=1, 0.0 for k > 1 Sets the relative amounts of each sediment species k It is a dimensionless fractional value, and FLOW-3D automatically normalizes values such that values sum to 1.0. Valid only when sediment & scour model is turned on (NSSPC > 0) and component flag IFOB(m)=3 is specified. 
Component Properties: Simple Moving Objects 
Moving Web Components 

Namelist OBS 
t < 500, time index 
m < 500, component index NAME DEFAULT DESCRIPTION IMO(m) 0 Component m linear motion type indicator =0, stationary component =2, user-defined sliding or web component where the component surface tangential velocity is specified in subroutine VELOBS (the component geometry does not change with time). =3, prescribed-motion of general moving object =4, coupled-motion of general moving object NOTE: IMOBS=1 MUST BE SET IN NAMELIST XPUT FOR IMO(M)=3, OR 4. TOBS(t) 0.0  Times for time-dependent component arrays UTOBS(t,m) 0.0  Time-dependent component m velocity in x-direction at time TOBS(t) Only used when IFOB(m)=4 or IMO(m)=2, 3, or 4. VTOBS(t,m) 0.0  Time-dependent component m velocity in y-direction at time 



TOBS(t)  Only used when IFOB(m)=4 or IMO(m)=2, 3, or 4. WTOBS(t,m) 0.0  Time-dependent component m velocity in z-direction at time TOBS(t) Used when IFOB(m)=4 or for moving components (IMO(m)=2, 3 or 4). 
Spinning Components NAME DEFAULT DESCRIPTION OSPIN(t,m) 0.0 Spin rate for rotating component m (rad/s) at time TOBS(t). Component must be axisymmetric about axis of spin. The spinning object must be a copy of a virtual component (only one copy is allowed). The original object must be defined to rotate about the z-axis. The spinning object location and spin axis are determined by the copy rotations and translations. 
Fan or Impeller Components NOTE: A NON-ZERO VISCOSITY IS REQUIRED FOR THE FAN/IMPELLER MODEL. NAME DEFAULT DESCRIPTION IFOB(m) 0 "Free" (or phantom) component flag =-2, core gas component =-1, porous component =0, regular component =1, lost foam component =2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. OADRG(m) ADRG  For porous component, a constant used in porous component drag formulation (used if IDRG > 0; IDRG is in namelist XPUT, See Theory and Model Reference for the use of OADRG.  For fan component, the accommodation coefficient for rotational velocity. OBDRG(m) BDRG For porous component, a constant used in porous component drag formulation (used if IDRG=4 or 5; IDRG is set in namelist XPUT) 



See Theory and Model Reference for the use of OBDRG. For fan component, the accommodation coefficient for axial velocity. A negative axial velocity is generated by OBDRG < 0. OSPIN(t,m) 0.0 Spin rate for rotating component m (rad/s) at time TOBS(t) Component must be axisymmetric about axis of spin. The spinning object must be a copy of a virtual component (only one copy is allowed). The original object must be defined to rotate about the z-axis. The spinning object location and spin axis are determined by the copy rotations and translations. NOBLDS(m) 0 Number of blades for added bladed effects OBLTHK(m) 0.0 Blade tip thickness in the azimuthal direction (in units of length) 
Linear Motion for Continuous Casting NAME DEFAULT DESCRIPTION IFOB(m) 0 "Free" (or phantom) component flag =-2, core gas component =-1, porous component =0, regular component =1, lost foam component =2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. UTOBS(t,m) 0.0  Time-dependent component m velocity in x-direction at time TOBS(t). Only used when IFOB(m)=4 or IMO(m)=2. VTOBS(t,m) 0.0  Time-dependent component m velocity in y-direction at time TOBS(t). Only used when IFOB(m)=4 or IMO(m)=2. WTOBS(t,m) 0.0  Time-dependent component m velocity in z-direction at time TOBS(t). Only used when IFOB(m)=4 or for moving components (IMO(m)≠0). 
Component Properties: Deforming Components NOTE:  IMEMB=1 MUST BE SET IN NAMELIST XPUT TO USE THE DEFORMING COMPONENT MODEL. 
Elastic Membrane 

Namelist OBS 



m ≤ 500 component index 
t ≤ 500, time index VARIABLE DEFAULT DESCRIPTION EMBW(m) … Young's modulus FAMP(m) 0.0 Amplitude of sinusoidal actuator force Used when NFMBW(m)=1. FMBW(t,m) 0.0 Actuator force at time TOBS(t). Used when NFMBW(m)=2. FREQ(m) 0.0 Frequency of sinusoidal actuator force Used when NFMBW(m)=1. Units are Hertz. FPHS(m) 0.0 Initial phase of sinusoidal actuator force Used when NFMBW(m)=1. Units are degrees.  IMB(m) 0 Type of deforming object =0, not a deforming object =1, rectangular elastic membrane =2, circular elastic membrane =3, elastic wall IMBE(m) 1 Type of membrane edge =1, clamped edge =2, simply supported edge IMBN(m) 3 Normal direction of membrane =1, in x-direction =2, in y-direction =3, in z-direction NFMBW(m) 1 Type of actuator force (always along the membrane’s normal and positive in the positive direction of the coordinate axis) =1, sinusoidal force, )sin( 0φω += tAF  =2, tabular values of force vs. time are provided PREFMBW(m) PVOID Reference pressure RAMBW(m) … Radius of the circular membrane Used when IMB(m)=2. RFMBW(m) 0.0 Radius of the circular distribution area of actuator force Used when IMB(m)=2. RHOMBW(m) … Mass density of the membrane RPMBW(m) … Poisson’s Ratio of the membrane TOBS(m) 0.0 Time for time-dependent component arrays 



XCMBW(m) … x-coordinate of the membrane center XFMBW(m) 0.0 x-length of the rectangular distribution area of actuator force Used when IMB(m)=1. 
Elastic Wall VARIABLE DEFAULT DESCRIPTION IMB(m) 0 Type of deforming object =0, not a deforming object =1, rectangular elastic membrane =2, circular elastic membrane =3, elastic wall PREFMBW(m) PVOID Reference pressure CSPMBW(m) 1.0×1019 Stiffness coefficient per unit area. Deformation of elastic wall is negligible at the default value of CSPMBW.  
Component Properties: Porous Components 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION IFOB(m) 0 “Free” (or phantom) component flag =-2, core gas component =-1, porous component =0, regular component =1, lost foam component =2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. OADRG(m) ADRG  For porous component, a constant used in porous component drag formulation (used if IDRG > 0; IDRG is in namelist XPUT) See Theory and Model Reference for the use of OADRG. For fan component, the accommodation coefficient for rotational velocity. OBDRG(m) BDRG For porous component, a constant used in porous component 



drag formulation (used if IDRG=4 or 5; IDRG is set in namelist XPUT. See Theory and Model Reference for the use of OBDRG. For fan component, the accommodation coefficient for axial velocity. A negative axial velocity is generated by OBDRG < 0. OPCAP(m) 0.0 Capillary pressure for component m OPCAP > 0 indicates a wetting condition. OPCAP < 0 indicates a non-wetting condition. NOTE: USED ONLY FOR SATURATED POROUS MEDIA, 0 > IDRG < 5. OPOR(m) ... Component porosity (open volume fraction) Defaults to the maximum of OPORX(m), OPORY(m), or OPORZ(m) if they have been set; otherwise defaults to 0.0. OPORX(m) ... Open area per unit area in x-direction Defaults to OPOR(m) if no area porosities (OPORY(m), OPORZ(m)) are specified; otherwise defaults to 0.0. OPORY(m) ... Open area per unit area in y-direction Defaults to OPOR(m) if no area porosities (OPORX(m), OPORZ(m)) are specified; otherwise defaults to 0.0. OPORZ(m) ... Open area per unit area in z-direction Defaults to OPOR(m) if no area porosities (OPORX(m), OPORY(m)) are specified; otherwise defaults to 0.0. OSPOR(m) 0.0 Surface area per unit bulk volume for porous component m (used for heat transfer only).  OFCMN(m) FCMN Irreducible saturation for component m (value must be less than OFPCMX(m)).  Default value FCMN is set in PCAP namelist. Only used if IDRG=5 in XPUT. OFCMX(m) FCMX Fully saturated F value for component m Default value FCMX is set in PCAP namelist. Only used if IDRG=5 in XPUT. OFPCMX(m) FPCMX F value corresponding to end of capillary pressure curve at lowest saturation for component m. For F values less than OFPCMX, capillary pressure assumed constant.  Default value FPCMX is set in PCAP namelist. Only used if IDRG=5 in XPUT.  Used only for IVG=0. OPCMX(m) PCMX Maximum capillary pressure at F=FPCMX Default value PCMX is set in PCAP namelist. Only used if IDRG=5 



in XPUT. Used only for IVG=0. IODFIT(m) IDFIT Drag function flag relationship between drag and saturation for component m =1, power-law =2, exponential =3, Mulaen’s model of permeability is used. Default value IDFIT is set in PCAP namelist. Only used if IDRG=5 in XPUT. IOPCFD(m) IPCFD Capillary pressure operation mode =0, use both filling and draining curves (2 pressure curves with hysteresis effects) =1, drive pressures to filling curve =2, drive pressures to draining curve Default value IPCFD is set in PCAP namelist. Only used if IDRG=5 in XPUT. OPEXP(m) PEXP Exponent for capillary pressure-saturation relationship Default value PCMX is set in PCAP namelist. Only used if IDRG=5 in XPUT. Used only for IVG=0. XNWOBS 1.0 Outer exponent for wetting (filling) capillary pressure curve used in Van Genuchten unsaturated porous media model (dimensionless) Used only for IVG=1. XNDOBS 1.0 Outer exponent for draining capillary pressure curve used in Van Genuchten unsaturated porous media model (dimensionless). Used only for IVG=1. XMWOBS 1.0 Inner exponent for wetting (filling) capillary pressure curve used in Van Genuchten unsaturated porous media model (dimensionless). Used only for IVG=1. XMDOBS 1.0 Inner exponent for draining capillary pressure curve used in Van Genuchten unsaturated porous media model (dimensionless). Used only for IVG=1. ALPHWOBS 0.0 Coefficient for Van Genuchten wetting (filling) capillary pressure curve (units are in units of pressure) Used only for IVG=1. ALPHDOBS 0.0 Coefficient for Van Genuchten draining capillary pressure curve 



(units are in units of pressure) Used only for IVG=1. 
Component Properties: Temperature and Power 

Namelist OBS 
t < 500, time index 
m < 500, component index NAME DEFAULT DESCRIPTION ITPOBS(m) 0 Power source flag for component m =0, no power source =1, power source is defined by POBS(t,m) =2, power source is defined by SPOBS(t,m) POBS(t,m) 0.0  Total power for component m at time TOBS(t) (energy/time). POBS(t,m) is converted to heat flow per unit surface area for component m if RCOBS(m)=0.0 and to heat source per unit volume inside the component otherwise. SPOBS(t,m) 0.0 Heat flow per unit surface area (energy/time/area) or heat source per unit volume (energy/time/volume) for component m at time TOBS(t). SPOBS(t,m) defines the heat flow per unit surface area of component m if RCOBS(m)=0.0 and the heat source per unit volume inside the component otherwise. TOBI(m) -1.0  Override temperature for restart calculations. If TOBI(m) > 0, HYDR3D will initialize the cell temperatures in conducting component m to TOBI(m) upon restart. Values must be positive. TOBS(t) 0.0  Times for time-dependent component arrays TWOBS(t,m) TBCD Uniform temperature for component m If RCOBS(m) > 0, then TWOBS(1,m) is used as the initial temperature. Otherwise, TWOBS(t,m) defines the uniform, time-dependent, prescribed temperature of component m. TWOBS(t,m) cannot be negative. For a GMO component TWOBS(t,m) also defines the temperature of the parts of the component that move into the mesh from outside during the calculation. If TWOBS(t,m) defines a time-dependent temperature, then its value is taken at the appropriate time. 

Tabular Property Input 
Namelist OBS 



m < 500, component index NAME DEFAULT DESCRIPTION IRHOBS(m) 0 Flag for the definition of density of component m =0, constant =1, tabular function of temperature IBLKMOD(m) 0 Flag for the definition of bulk modulus of component m =0, constant =1, tabular function of temperature IELASTMOD(m) 0 Flag for the definition of elastic modulus of component m =0, constant =1, tabular function of temperature IPOISSONR(m) 0 Flag for the definition of Poisson ratio of component m =0, constant =1, tabular function of temperature ISHRMOD(m) 0 Flag for the definition of shear modulus of component m =0, constant =1, tabular function of temperature IRCOBS(m) 0 Flag for the definition of density times specific heat product for component m  =0, constant =1, tabular function of temperature IKOBS(m) 0 Flag for the definition of thermal conductivity for component m =0, constant =1, tabular function of temperature IHOBS1(m) 0 Flag for the definition of heat-transfer coefficient to fluid #1 for component m =0, constant or linear function of solid fraction =1, tabular function of temperature IHOBS2(m) 0 Flag for the definition of heat-transfer coefficient to fluid #2 for component m =0, constant =1, tabular function of temperature 
Component Properties: Thermal and Heat Transfer 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION 



KOBS(m) 0.0  Thermal conductivity of component m MOBS(m) 0.0  Mass times specific heat product for component m If MOBS(m) is greater than 0.0, a dynamic equation is solved for the heat transfer surface temperature. Alternate: RCOBS(m), the value of MOBS(m) is ignored if RCOBS(m) > 0. For GMO components use RCOBS(m). OBSL(m) 0.0 Length scale of component m If HOBS < 0 or NMAT=2 and HOBS2 < 0, then the default is the square root of the surface area of the component. OSPOR(m) 1.0 Surface area per unit bulk volume for porous component m (used for heat transfer and mass sources).  RCOBS(m) 0.0  Density times specific heat product for component m If RCOBS(m) > 0.0, a dynamic equation is solved for the heat transfer surface temperature. Alternate: MOBS(m) RCOBS(m) is required input for lost foam components. For GMO components, RCOBS(m) should be used in place of MOBS(m). ROBS(m) 1.0  Roughness of component m This multiplies the cell-face area to give the effective heat transfer area for each cell. No heat transfer at component m if ROBS(m)=0.0.  Also, no mass sources are applied for component m if ROBS(m)=0.0. SAOBS(m) 0.0  Total surface area for heat transfer for component m, including roughness effects defined by the area multiplier ROBS(m). If SAOBS(m) > 0, the surface area in each cell associated with component m is adjusted to make the component’s total surface area equal to SAOBS(m). Not used for GMO components. IVR(n) 0 Cooling channel flag =0, subcomponent n is not a cooling channel =1, subcomponent n defines a cooling channel CCTEMP(n) -1.0 Temperature of cooling channel defined by subcomponent n Requires IVR(n)=1. ICCTYPE(n) 1 Type of cooling channel defined by subcomponent n =1, uses heat transfer coefficients that end with a 1, i.e., HFLV1, etc. 



=2, uses HFLV2, etc. =3, uses HFLV3, etc. Requires IVR(n)=1. LTHOBS(m)  1019 The thickness of the thermally active layer along the surface of geometry component m Conductive heat transfer is calculated only in computational cells within this layer. Component volume outside this layer is replaced by an adiabatic boundary condition. LTHOBS(m) can be estimated from the maximum thermal penetration depth based on the properties of the thermal component and the heat transfer coefficient at the mold-metal interface. By default, the entire component is included in the thermally active layer. If LTHOBS(m)=0.0, only the component surface elements are included in heat transfer with fluid. 
Component: Sand Core Gas 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION IFOB(m) 0 “Free” (or phantom) component flag =-2, core gas component =-1, porous component =0, regular component =1, lost foam component =2, fan/impeller component =3, sediment scour component =4, specified velocity phantom component for continuous casting =5, domain removing component =6, vent component NOTE: FOR IFOB > 0, COMPONENTS DO NOT CONTRIBUTE TO AREA AND VOLUME BLOCKAGES, SO THE COMPONENT WILL NOT BE VISIBLE IN COMPONENT PLOTS, EXCEPT FOR THE IFOB(M)=5 TYPE. PORCG(m) 0.0 Core porosity Values must be between 0.0 and 1.0. 



GRAINDIAM(m) 0.0 Average sand grain diameter RHOCOR(m) 0.0 Core density BNDRFR(m) 0.0 Binder weight fraction of core total weight EB1(m) 0.0 Binding energy, energy/mole DCMPR1(m) 0.0 Decomposition rate, 1/time RFCOR(m) 0.0 Binder gas constant MUCG(m) 0.0 Core gas dynamic viscosity FRES(m) 0.0 Residue mass fraction of the initial binder (currently not used in the sand core gas model) ISHELLM(m) 0 Shell mold flag =0, when thermally active layer LTHOBS(m) is defined for the core component m, the component volume outside the thermal layer is treated as an impenetrable wall. =1, treat the thermal shell layer defined with LTHOBS(m) as an actual shell mold with full core gas venting at the shell exterior boundary (for modeling gas flow in porous molds). 
Component: Permeable Mold 

Namelist OBS 
m < 500, component index NAME DEFAULT DESCRIPTION GRAINDIAM(m) 0.0 Average sand diameter for permeable mold component m IOBSVENT(m) 0 Permeable mold flag =0, component m is not a permeable mold =1, component m is a permeable mold 



LPRMOBS(m) 0.0 Average permeable mold thickness, which is a measure of the distance that the gas in the cavity needs to travel through the mold to escape. Must be positive for the model to work for component m. Input variable PVOID in namelist FL defines the ambient gas pressure. PORCG(m) 0.0 Mold porosity for permeable mold component m Values must be between 0.0 and 1.0. MUCG(m) 0.0 Cavity gas dynamic viscosity for permeable mold component m 
Initial Fluid Conditions (FL) 
Initial Conditions: Uniform 

Namelist FL 
ns < 99, scalar species index 
m < 10, sediment species index xx-component of elastic stress,   k=1, yy-component of elastic stress,   k=2, zz-component of elastic stress,   k=3, xy-component of elastic stress,   k=4, yz-component of elastic stress,   k=5, xz-component of elastic stress,   k=6 NAME DEFAULT DESCRIPTION AIRI 0.0 Initial uniform volume fraction of entrained air in the fluid Only used when IDFAIR=1. CHRGI 0.0 Initial uniform electric charge density in the fluid Only used when IECHRG=1. CNCI 0.0 Initial volume fraction of the non-condensable gas component 



in the gas phase Only used when INCG=1. DISSI 0.0 Initial uniform concentration of dissolved solute in the fluid Only used when IDISSOLVE=1. ELSTI(k) 0.0 Initial uniform value of elastic stress component k Only used when IELAST=1. FLHT ... Initial fluid elevation in z-direction If ICMPRS=0 and ITB=1, defaults to empty (F=0 everywhere);  If ICMPRS=0 and ITB=0, defaults to full (F=1 everywhere).  If ICMPRS=1, defaults to all compressible fluid (F=0 everywhere).  Only used when IFLINITTYP=1 (ICMPRS and ITB are in namelist XPUT.) FMDENI 0.0 Uniform foam density function Only used when IFMDEN=1. IFLINITTYP 0 Fluid initialization flag =0, use only fluid regions =1, use FLHT to set initial fluid #1 elevation in z-direction =2, use VLIN to set initial fluid #1 volume =3, use a wave profile to set the initial fluid volume and free-surface shape. NBCWAVE 0 Reference mesh boundary index (1, 2, 3 or 4) in mesh block NBLWAVE specified as type ‘surface wave’ to be used for fluid initialization. Used only when IFLINITTYP=3. Required only if there are multiple wave boundaries. NBLWAVE 0 Reference mesh block number containing the surface wave boundary condition (see NBCWAVE) to be used for fluid initialization. 



Required only if there are multiple wave boundaries. Used only when IFLINITTYP=3. PRESI ... Uniform initial pressure If ICMPRS=0, PRESI defaults to PVOID.  If ICMPRS=1, PRESI defaults to 1.013e6 (1 atm in CGS units).  (ICMPRS is set in namelist XPUT.)  PVOID ... Default void initial vapor pressure If ICMPRS=0, PVOID defaults to 0. If ICMPRS=1, PVOID defaults to 1.013e6 (1 atm in cgs units).  (ICMPRS is set in namelist XPUT.) RPSI 0.0  Initial rotation rate of fluid around z-axis in radians per unit time SCLRI(ns) 0.0  Initial uniform scalar species ns magnitude SSSI(m) 0.0 Initial uniform suspended sediment mass concentration of sediment species m Only used when NSSPC > 1. SEGI 0.0 Initial uniform segregation solute mass concentration Only used when ISEG=1. TKEI ... Initial uniform turbulent energy Default turbulent energy is a very small positive number based on problem specifications. UI 0.0  Initial uniform fluid velocity in x-direction VI 0.0  Initial uniform fluid velocity in y-direction VLIN 0.0 Initial volume of fluid #1 in mesh If VLIN is positive and no other fluid subcomponents are initialized in the domain (NFLS=0), fluid will be initialized with the free surface normal to the gravity vector (GX, GY, GZ in 



XPUT). If VLIN is greater than the total open volume in the mesh, VLIN will be reset to the open volume.  Used only when IFLINITTYP=2. NOTE: VLIN IS ONLY FOR ONE-FLUID, FREE-SURFACE PROBLEMS. WI 0.0  Initial uniform fluid velocity in z-direction. 
Initial Conditions: General Region Parameters 

Namelist FL 
n < 30, region index NAME DEFAULT DESCRIPTION FIOH(n) 1 Fluid region type =0, hole =1, fluid FFSTL(n) fstlnn.inp File name for stereolithography (STL) data file for defining initial conditions (IFDIS(n)=-1), where "nn"=n. IFDIS(n) 0 Region type =-1, use stereolithography (STL) CAD data file to define a region =0, use function to define a region (i.e., FCX2, FCX, FCC, etc.) =1, set F equal to function =2, set P equal to function =3, set TKE equal to function =4, set U equal to function =5, set V equal to function =6, set W equal to function =7, set RHO equal to function =8, set scalar species magnitude to function (see ISCTYP). NOTE: STL INPUT FILE NAME IS FSTLNN.INP WHERE “NN”=N. NFLS 0 Number of fluid regions 



Initial Conditions: Region Values 
Namelist FL 
n < 30, region index 
ns < 99, scalar species index 
m < 10, sediment species index xx-component of elastic stress,   k=1, yy-component of elastic stress,   k=2, zz-component of elastic stress,   k=3, xy-component of elastic stress,   k=4, yz-component of elastic stress,   k=5, xz-component of elastic stress,   k=6 NAME DEFAULT DESCRIPTION AIRREG(n) 0.0 Initial volume fraction of entrained air in region n Only used when IDFAIR=1. CHRGREG(n) 0.0 Initial electric charge density in region n Only used when IECHRG=1. CNCREG(n) 0.0 Initial volume fraction of the non-condensable gas component in the gas phase in region n Only used when INCG=1. DISSREG(n) 0.0 Initial concentration of dissolved solute in region n Only used when IDISSOLVE=1. ELSTREG(n,k) 0.0 Initial value if elastic stress component k in region n Only used when IELAST=1. FMDENREG(n) 0.0 Foam density function in region n Only used when IFMDEN=1. FREG(n) 1.0 Initial fluid fraction in region n 



Only used when FIOH=1. ISCTYP(n) 0 Scalar species identifier when IFDIS(n)=8 PREG(n) PRESI Initial pressure in region n RHOREG(n) RHOF Initial density in region n (when IFRHO > 2 and NMAT=1).  (IFRHO and NMAT are in namelist XPUT.) SCLREG(n,ns) 0.0  Initial scalar species ns magnitude in region n SEGREG(n) 0.0 Initial segregation solute mass concentration in region n Only used when ISEG=1. SSSREG(n,m) 0.0 Initial suspended sediment mass concentration of sediment species m in region n Only used when NSSPC=1. TKEREG(n) TKEI Initial turbulent energy in region n UREG(n) UI Initial velocity (x-direction) in region n VREG(n) VI Initial velocity (y-direction) in region n WREG(n) WI Initial velocity (z-direction) in region n 
Initial Conditions: Region Limiters 

Namelist FL 
n < 30, region index NOTE:  ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM.  ALL REGION LIMITER DEFAULTS INCLUDE THE ENTIRE MESH. NAME DEFAULT DESCRIPTION FANGLH(n) ... Upper cylindrical angle limit for region n (measured in the x-y plane from the x-axis, in degrees) 



FANGLL(n) ... Lower cylindrical angle limit for region n (measured in the x-y plane from the x-axis, in degrees) FCONEH(n) ... Upper conical angle limit for region n (measured from the z-axis in degrees) FCONEL(n) ... Lower conical angle limit for region n (measured from the z-axis in degrees) FLUIDREGIONNAME(n) ‘   ‘ Fluid region n name (up to 256 characters) FRAH(n) ... Upper cylindrical-radius limit for region n FRAL(n) ... Lower cylindrical-radius limit for region n FRSH(n) ... Upper spherical-radius limit for region n FRSL(n) ... Lower spherical-radius limit for region n FXH(n) ... Upper x-coordinate limit for region n  FXL(n) ... Lower x-coordinate limit for region n FYH(n) ... Upper y-coordinate limit for region n FYL(n) ... Lower y-coordinate limit for region n FZH(n) ... Upper z-coordinate limit for region n FZL(n) ... Lower z-coordinate limit for region n 
Initial Conditions: Region Function Coefficients 

Namelist FL 
n < 30, region index NOTES: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM.  ALL REGION LIMITER DEFAULTS INCLUDE THE ENTIRE MESH. 



NAME DEFAULT DESCRIPTION FCC(n) 0.0 Function constant coefficient for region n FCDUM(n) 0.0 Dummy function coefficient for region n for customizing functions FCRXY(n) 0.0 Function coefficient 2 2x y+  for region n FCX(n) 0.0 Function coefficient of x for region n FCX2(n) 0.0 Function coefficient x² for region n FCXY(n) 0.0 Function coefficient of xy for region n FCXZ(n) 0.0 Function coefficient of xz for region n FCY(n) 0.0 Function coefficient of y for region n FCY2(n) 0.0 Function coefficient y² for region n FCYZ(n) 0.0 Function coefficient of yz for region n FCZ(n) 0.0 Function coefficient of z for region n FCZ2(n) 0.0 Function coefficient z² for region n 
Initial Conditions: Region Transformations 

Namelist FL 
n < 30, region index NOTES: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. MAGNIFICATIONS ARE PERFORMED BEFORE ROTATIONS, WHICH ARE PERFORMED BEFORE REFLECTIONS, WHICH ARE PERFORMED BEFORE TRANSLATIONS. X ROTATIONS ARE PERFORMED BEFORE Y ROTATIONS, WHICH ARE PERFORMED BEFORE Z ROTATIONS. 



NAME DEFAULT DESCRIPTION FMAGN(n)  1.0 Magnification (scaling) factor for region n FMAGNX(n) 1.0 Scaling factor in x-direction for region n FMAGNY(n) 1.0 Scaling factor in y-direction for region n FMAGNZ(n) 1.0 Scaling factor in z-direction for region n FROTX(n) 0° Region n rotation about x-axis in degrees, positive in right hand sense FROTY(n) 0° Region n rotation about y-axis in degrees FROTZ(n) 0° Region n rotation about z-axis in degrees FTRNX(n) 0.0 Region n translation in x-direction FTRNY(n) 0.0 Region n translation in y-direction FTRNZ(n) 0.0 Region n translation in z-direction 
Initial Conditions: Pointers 
Pointer Locations 

Namelist FL 
k < 1000, pointer index NOTE: ALL POINTER LOCATIONS ARE DEFINED IN CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. NAME DEFAULT DESCRIPTION POINTERNAME(k) ‘  ‘ Pointer k name (up to 256 characters) XVR(k) ... X location in connected region k Default value is outside mesh 



YVR(k) ... Y location in connected region k Default value is outside mesh ZVR(k) ... Z location in connected region k Default value is outside mesh 
Initial Conditions NAME DEFAULT DESCRIPTION FVRD(k) ...  Fluid fraction assigned to connected region k (located by XVR(k), YVR(k), ZVR(k)).  If FVRD(k) is specified, F will be set to FVRD(k) in all open cells connected to the cell specified by XVR(k), YVR(k), ZVR(k).  If FVRD(k) is not specified, F values are not set this way. CNCVRD(k) 0.0 Volume fraction on the non-condensable gas component in the gas phase assigned to input-void region k. Only used when INCG=1. PVRD(k) PVOID Total pressure assigned to input-void region k 
Void Properties / Heat Transfer NAME DEFAULT DESCRIPTION IVHT(k) 0 Heat transfer void identifier for input-void region k; indicates which heat transfer coefficients will be used for this void.  (Heat transfer coefficients are in namelists XPUT, BCDATA, OBS and BF.) =0, no heat transfer to void =1, heat transfer void identifier 1  (uses heat transfer coefficients that end with a 1, i.e., HFLV1, etc.) =2, heat transfer void identifier 2 (HFLV2, etc.) =3, heat transfer void identifier 3 (HFLV3, etc.) 



Initial Conditions: Valves 
Namelist FL 
k < 1000, valve index NOTES: ALL VALVE LOCATIONS ARE DEFINED IN CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. THE VALVE MODEL MAY BE USED TO VENT OR CHARGE ADIABATIC BUBBLES.  NAME DEFAULT DESCRIPTION VALC(k) 0.0 Valve pressure loss coefficient for valve k A negative value for VALC changes VALP to a flow rate rather than a pressure. Rate can be positive or negative. VALCGX 0.02 Global vent coefficient Used in granular flow model, IFGRN=1. VALP(k) PVOID External pressure for valve k VALVENAME(k) ‘   ‘ Valve k name (up to 256 characters) VALX(k) ... X location for valve k Default value is outside mesh. VALY(k) ... Y location for valve k Default value is outside mesh. NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. VALZ(k) ... Z location for valve k Default value is outside mesh. 

Wind Shear 
Namelist FL 



NAME DEFAULT DESCRIPTION IWND 0 Flag for wind shear at horizontal fluid surface (wind in x-y plane only). =0, no wind =1, wind is constant in time and uniform over fluid surface =2, wind varies with time and is uniform over fluid surface FWNDNAM … Name of wind data file Used when IWND=2.  In the file, the first, second and third columns are time, x-velocity, and y-velocity of wind at 10 meters above fluid surface, respectively. The columns are separated by white space or tabs. The maximum file size is 5000 lines. UWND 0.0 x-velocity of wind at 10 meters above fluid surface VWND 0.0 y-velocity of wind at 10 meters above fluid surface 
Fluid Droplet/Bubble Sources 

Namelist FL 
n < 2000, region index NAME DEFAULT DESCRIPTION NDROP 0 Number of droplet sources XDROP(n) 0.0 Initial x-coordinate of droplet’s center at source #n YDROP(n) 0.0 Initial y-coordinate of droplet’s center at source #n ZDROP(n) 0.0 Initial z-coordinate of droplet’s center at source #n UDROP(n) 0.0 Initial x-velocity of droplet at source #n  Does not apply to bubbles 



VDROP(n) 0.0 Initial y-velocity of droplet at source #n Does not apply to bubbles WDROP(n) 0.0 Initial z-velocity of droplet at source #n Does not apply to bubbles IFDROP(n) 1 Type of fluid at source #n: =1 – fluid #1 =2 – fluid #2 or void RHODROP(n) … Fluid density in the droplet at source #n. Can only be set for one-fluid, variable-density problems, NMAT=1 and IFRHO > 1. Defaults to RHOF for IFDROP(n)=1, and to RHOF2 for IFDROP(n)=2.  TIMDROP(n) 1.0 Time interval between droplets at source #n SDROP(n) 0.0 Starting time for droplet generation at source #n EDROP(n) 2*TWFIN Ending time for droplet generation at source #n RDROP(n) 1.0 Initial droplet radius at source #n PDROP(n) … Initial droplet pressure at source #n Defaults to PRESI for IFDROP(n)=1 or NMAT=2, and to PVOID for IFDROP(n)=2 and NMAT=1. 
Baffle Setup (BF) 
Baffle Namelist (BF) 
Baffle Properties: Heat Transfer Coefficients 

Namelist BF 
m < 500, baffle index 



NAME DEFAULT DESCRIPTION HBAF1(m) 0.0  Effective heat-transfer coefficient for fluid #1 HBAF2(m) 0.0  Effective heat-transfer coefficient for fluid #2 HBFV1(m) 0.0  Cross-baffle heat transfer coefficient to type 1 void See IVHT in namelist FL and ICCTYPE in namelist OBS. NOTE: HBAF1 MUST ALSO BE SPECIFIED. HBFV2(m) 0.0  Cross-baffle heat transfer coefficient to type 2 void  See IVHT in namelist FL and ICCTYPE in namelist OBS. NOTE: HBAF1 MUST ALSO BE SPECIFIED. HBFV3(m) 0.0  Cross-baffle heat transfer coefficient to type 3 void  See IVHT in namelist FL and ICCTYPE in namelist OBS. NOTE: HBAF1 MUST ALSO BE SPECIFIED. 
Baffle Properties: Porous Properties 

Namelist BF 
m < 500, baffle index NAME DEFAULT DESCRIPTION KBAF1(m) 0.0  Linear coefficient for baffle pressure drop KBAF2(m) 0.0  Quadratic coefficient for baffle pressure drop PBAF(m) …  Baffle porosity (open area fraction) Defaults 0.0 if IFBAF(m)=0, 1.0 otherwise. 

Baffle Properties: Flux Surfaces 
Namelist BF 
m < 500, baffle index 



NAME DEFAULT DESCRIPTION IFBAF(m) 0 Flux surface flag = 0, regular baffle = 1, use this baffle as flux surface IFTRC(m) 0 Tracer flag =0, no tracer is introduced at flux surface m =1, tracers are introduced at flux surface m FPTITL(m) “flux surfc m” Flux surface title (up to 256 characters) 
Baffle Regions: Baffle Location 

Namelist BF 
n < 500, baffle region index NOTES:  ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM.  ALL BAFFLE LOCATION PARAMETERS DEFAULT OUTSIDE OF THE MESH. NAME DEFAULT DESCRIPTION BAFFLEREGIONNAME(n) ‘  ‘ Baffle region n name (up to 256 characters) BANGL(n) ... Baffle cylindrical angle for region n (measured in the x-y plane from the x-axis, in degrees). BCONE(n) ... Baffle cone angle for region n (measured from the z-axis in degrees). BRA(n) ...  Baffle cylindrical radius for region n BRS(n) ...  Baffle spherical radius for region n BX(n) ... X-coordinate for region n BY(n) ... Y-coordinate for region n 



BZ(n) ... Z-coordinate for region n 
Baffle Regions: Function Coefficients 

Namelist BF 
n < 500, baffle region index NOTE: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. NAME DEFAULT DESCRIPTION BCC(n) 0.0  Function constant coefficient for region n  BCDUM(n) 0.0 Dummy function coefficient for region n for customizing functions BCRXY(n) 0.0  Function coefficient of 2 2x y+  for region n BCX(n) 0.0  Function coefficient of x for region n BCX2(n) 0.0  Function coefficient of x² for region n BCXY(n) 0.0  Function coefficient of xy for region n BCXZ(n) 0.0  Function coefficient of xz for region n BCY(n) 0.0  Function coefficient of y for region n BCY2(n) 0.0  Function coefficient of y² for region n BCYZ(n) 0.0  Function coefficient of yz for region n BCZ(n) 0.0  Function coefficient of z for region n BCZ2(n) 0.0  Function coefficient of z² for region n 

Baffle Regions: General Parameters 
Namelist BF 



k < 500, baffle region index 
m < 500, baffle index 
n < 500, region index NAME DEFAULT DESCRIPTION BIOH(n) 1 Baffle region type =0, hole =1, baffle FSTLBF(n) … Name of STL file for baffle region n. Used when ISTLBF(n)=1. The file can be either in ASCII or in binary format. IBAF(n) ... Associates region n with a particular baffle Default is IBAF(n)=n (Use: IBAF(n)=m; region n is part of baffle m.) ISTLBF(n) 0 Flag for STL input for baffle region n =0, region n is defined using quadratic method or primitive shape =1, region n is defined using STL file 

Baffle Regions: Limiters 
Namelist BF 
n < 500, region index NOTES:  ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. ALL REGION LIMITER DEFAULTS INCLUDE THE ENTIRE MESH. NAME DEFAULT DESCRIPTION BANGLH(n) ... Upper cylindrical angle limit for region n (measured in the x-y plane from the x-axis, in degrees). BANGLL(n) ... Lower cylindrical angle limit for region n (measured in the x-y 



plane from the x-axis, in degrees). BCONEH(n) ... Upper conical angle limit for region n (measured from the z-axis in degrees). BCONEL(n) ... Lower conical angle limit for region n (measured from the z-axis in degrees). BRAH(n) ... Upper cylindrical-radius limit for region n BRAL(n) ... Lower cylindrical-radius limit for region n BRSH(n) ... Upper spherical-radius limit for region n BRSL(n) ... Lower spherical-radius limit for region n BXH(n) ... Upper x-coordinate limit for region n BXL(n) ... Lower x-coordinate limit for region n BYH(n) ... Upper y-coordinate limit for region n  BYL(n) ... Lower y-coordinate limit for region n BZH(n) ... Upper z-coordinate limit for region n BZL(n) ... Lower z-coordinate limit for region n 
Baffle Regions: Transformations 

Namelist BF 
n < 500, region index NOTES: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM.  MAGNIFICATIONS ARE PERFORMED BEFORE ROTATIONS, WHICH ARE PERFORMED BEFORE REFLECTIONS, WHICH ARE PERFORMED BEFORE TRANSLATIONS.  X-ROTATIONS ARE PERFORMED BEFORE Y-ROTATIONS, WHICH ARE PERFORMED BEFORE Z-ROTATIONS. 



NAME DEFAULT DESCRIPTION BMAGN(n) 1.0  Magnification (scaling) factor for region n BMAGNX(n) 1.0  Scaling factor in x-direction for region n BMAGNY(n) 1.0  Scaling factor in y-direction for region n BMAGNZ(n) 1.0  Scaling factor in z-direction for region n BROTX(n) 0° Region n rotation about x-axis in degrees, positive in right-hand sense. BROTY(n) 0° Region n rotation about y-axis in degrees BROTZ(n) 0° Region n rotation about z-axis in degrees BTRNX(n) 0.0  Region n translation in x-direction BTRNY(n) 0.0  Region n translation in y-direction BTRNZ(n) 0.0  Region n translation in z-direction 
Baffles: General Parameters 

Namelist BF NAME DEFAULT DESCRIPTION NBAFS 0 Number of baffles IFRCBF 0  Baffle force calculation flag =0, do not calculate forces on baffles =1, calculate forces on baffles 
Initial Fluid and Solid Temperature Setup (TEMP) 
Temperature: Uniform Initial Conditions 

Namelist TEMP 



NOTE: UNIFORM COMPONENT TEMPERATURES ARE SET IN NAMELIST OBS, BOUNDARY TEMPERATURES IN NAMELIST BCDATA. NAME DEFAULT DESCRIPTION TEMPI ... Uniform initial temperature TEMPI must be positive if ICMPRS=1. TEMPI defaults to 373.15 if ICMPRS=1; TEMPI defaults to 0.0 if ICMPRS=0.  (ICMPRS is in namelist XPUT.) TVOID TEMPI Constant uniform void-region temperature 
Temperature Regions: Settings 

Namelist TEMP 
n < 30, region index NAME DEFAULT DESCRIPTION ITDIS(n) 0 Distribution type =0, use function to define a region (i.e.,TCX2,TCX,TCC, etc.) =1, set fluid temperature equal to function =2, set solid temperature equal to function NTMP 0 Number of temperature regions TEMPREGIONNAME(n) ‘  ‘ Temperature region n name (up to 256 characters) TREG(n) TEMPI Region n fluid temperature TWREG(n) -1.0  Region n solid temperature 

Temperature Regions: Limiters 
Namelist TEMP 
n < 30, region index 



NOTES: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. ALL REGION LIMITER DEFAULTS INCLUDE THE ENTIRE MESH. NAME DEFAULT DESCRIPTION TANGLH(n) ... Upper cylindrical angle limit for region n (measured in the x-y plane from the x-axis, in degrees) TANGLL(n) ... Lower cylindrical angle limit for region n (measured in the x-y plane from the x-axis, in degrees) TCONEH(n) ... Upper conical angle limit for region n (measured from the z-axis in degrees) TCONEL(n) ... Lower conical angle limit for region n (measured from the z-axis in degrees) TRAH(n) ... Upper cylindrical-radius limit for region n TRAL(n) ... Lower cylindrical-radius limit for region n TRSH(n) ... Upper spherical-radius limit for region n TRSL(n) ... Lower spherical-radius limit for region n TXH(n) ... Upper x-coordinate for region n TXL(n) ... Lower x-coordinate for region n TYH(n) ... Upper y-coordinate for region n TYL(n) ... Lower y-coordinate for region n TZH(n) ... Upper z-coordinate for region n TZL(n) ... Lower z-coordinate for region n 
Temperature Regions: Function Coefficients 

Namelist TEMP 



n < 30, region index NOTE: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. NAME DEFAULT DESCRIPTION TCC(n) 0.0  Function constant coefficient for region n TCDUM(n) 0.0 Dummy function coefficient for region n for customizing functions TCRXY(n) 0.0  Function coefficient of 2 2x y+   for region n TCX(n) 0.0  Function coefficient of x for region n TCX2(n) 0.0  Function coefficient of x² for region n TCXY(n) 0.0  Function coefficient of xy for region n TCXZ(n) 0.0  Function coefficient of xz for region n TCY(n) 0.0  Function coefficient of y for region n TCY2(n) 0.0  Function coefficient of y² for region n TCYZ(n) 0.0  Function coefficient of yz for region n TCZ(n) 0.0  Function coefficient of z for region n TCZ2(n) 0.0  Function coefficient of z² for region n 
Temperature Regions: Transformations 

Namelist TEMP 
n < 30, region index NOTES: ALL REGIONS AND FUNCTIONS ARE DEFINED IN TERMS OF CARTESIAN COORDINATES IRRESPECTIVE OF THE MESH COORDINATE SYSTEM. 



MAGNIFICATIONS ARE PERFORMED BEFORE ROTATIONS, WHICH ARE PERFORMED BEFORE REFLECTIONS, WHICH ARE PERFORMED BEFORE TRANSLATIONS.  X-ROTATIONS ARE PERFORMED BEFORE Y-ROTATIONS, WHICH ARE PERFORMED BEFORE Z-ROTATIONS. NAME DEFAULT DESCRIPTION TMAGN(n) 1.0  Magnification (scaling) factor for region n TMAGNX(n) 1.0  Scaling factor in x-direction for region n TMAGNY(n) 1.0  Scaling factor in y-direction for region n TMAGNZ(n) 1.0  Scaling factor in z-direction for region n TROTX(n) 0° Region n rotation about x-axis in degrees, positive in right-hand sense TROTY(n) 0° Region n rotation about y-axis in degrees TROTZ(n) 0° Region n rotation about z-axis in degrees TTRNX(n) 0.0  Region n translation in x-direction TTRNY(n) 0.0  Region n translation in y-direction TTRNZ(n) 0.0  Region n translation in z-direction 
Non-Inertial Reference Frame (MOTN) 
Non-Inertial Reference Frame: General Parameters 
Center of Rotation 

Namelist MOTN NOTE: THIS NAMELIST IS ONLY READ IF IACCF>0 IN XPUT. NAME DEFAULT DESCRIPTION RCX 0.0  X-coordinate point about which angular velocities are given 



RCY 0.0  Y-coordinate point about which angular velocities are given RCZ 0.0  Z-coordinate point about which angular velocities are given 
Non-Inertial Reference Frame Type 

(IACCF=1 in XPUT) NAME DEFAULT DESCRIPTION IATYPE 0 Reference frame motion specification flag =0, sinusoidal acceleration in x-direction plus rotation about x and z =1, sinusoidal six degree of freedom model =2, table-driven motion, evaluate angular velocity from acceleration by  numerical integration, smooth variation only =3, table-driven motion, evaluate angular acceleration from velocity by numerical differentiation, smooth variation only =4, same as 2, but impulsive intervals are permitted =5, same as 3, but impulsive intervals are permitted =6, geophysical fluid flow Control of time-step size is possible through tabular input. 
Rigid Body Dynamics Force Flag 

(IACCF=2 in XPUT) NAME DEFAULT DESCRIPTION IATYPE 0 Rigid body dynamics control force flag =0, no control forces or torques =1, radial oscillator control force =2, angular oscillator control torque =3, table driven control torques and forces Control of time-step size is possible through tabular input  



Non-Inertial Reference Frame: Simple Spin and Shake Model 
Namelist MOTN NOTE: THIS NAMELIST IS ONLY READ IF IACCF > 0 IN XPUT. THIS MODEL IS USED IF IACCF=1 AND IATYPE=0. NAME DEFAULT DESCRIPTION A0 0.0  Acceleration of magnitude of sinusoidal shake in x-direction OMG0 0.0  Acceleration frequency for sinusoidal shake in x-direction RPS 0.0  Rotation rate of mesh about z-axis in revolutions per unit time  SPIN 0.0  Spin rate about x-axis for acceleration calculation (rad/s) 

Non-Inertial Reference Frame: Gravity Field 
Namelist MOTN NOTES: THIS NAMELIST IS ONLY READ IF IACCF > 0 IN XPUT. THE GRAVITY FIELD IS USED IF IATYPE > 0. NAME DEFAULT DESCRIPTION GRAVX 0.0  Initial x-direction component of gravity GRAVY 0.0  Initial y-direction component of gravity GRAVZ 0.0  Initial z-direction component of gravity 

Non-Inertial Reference Frame: Sinusoidal 6 Degree-of-Freedom Model 
Namelist MOTN NOTES: THIS NAMELIST IS ONLY READ IF IACCF > 0 IN XPUT.  THIS MODEL IS USED IF IACCF=1 AND IATYPE=1. NAME DEFAULT DESCRIPTION RFREQX 0.0  Frequency of angular displacement in the x-direction 



RFREQY 0.0  Frequency of angular displacement in the y-direction RFREQZ 0.0  Frequency of angular displacement in the z-direction RMAGX 0.0  Magnitude of angular displacement in the x-direction RMAGY 0.0  Magnitude of angular displacement in the y-direction RMAGZ 0.0  Magnitude of angular displacement in the z-direction RPHIX 0.0  Phase angle of angular displacement in the x-direction RPHIY 0.0  Phase angle of angular displacement in the y-direction RPHIZ 0.0  Phase angle of angular displacement in the z-direction TFREQX 0.0  Frequency of linear displacement in the x-direction TFREQY 0.0  Frequency of linear displacement in the y-direction TFREQZ 0.0  Frequency of linear displacement in the z-direction  TMAGX 0.0  Magnitude of linear displacement in the x-direction TMAGY 0.0  Magnitude of linear displacement in the y-direction TMAGZ 0.0  Magnitude of linear displacement in the z-direction TPHIX 0.0  Phase angle of linear displacement in the x-direction TPHIY 0.0  Phase angle of linear displacement in the y-direction  TPHIZ 0.0  Phase angle of linear displacement in the z-direction 
Non-Inertial Reference Frame: Tabular Data 
Tabular Data Input 

Namelist MOTN NOTES: THIS NAMELIST IS ONLY READ IF IACCF>0 IN XPUT. 



TABULAR DATA IS USED IF IATYPE>2 FOR IACCF=1 (NON-INERTIAL REFERENCE FRAME) OR IATYPE=3 FOR IACCF=2 (RIGID BODY DYNAMICS). NAME DEFAULT DESCRIPTION IMOTRD 2  Format indicator for acceleration input file (movin.inp) or force input file (thrust.inp for IACCF=2). Values of IMOTRD other than 2 can be used for user-customized formats.  FMOVIN movin.inp The name of the tabular data input file for linear and angular velocities and accelerations of the non-inertial reference frame. Used for IACCF=1. 
Tabular Data Conversion Factors NAME DEFAULT DESCRIPTION ACONV 1.0  Conversion factor for linear acceleration data or force data in tabular input OMCONV 1.0  Conversion factor for angular velocity and acceleration or torque data in tabular input 
Non-Inertial Reference Frame: Rigid Body Control Forces 
Radial Oscillator Control Forces (IATYPE=1) 

Namelist MOTN NOTE: THIS NAMELIST IS ONLY READ IF IACCF=2 IN XPUT. NAME DEFAULT DESCRIPTION RADKRB 0.0  Spring constant for radial oscillator model RDMPRB 0.0  Damping constant for radial oscillator model REQRB 0.0  Equilibrium radial distance for radial oscillator model 



Angular Oscillator Control Forces (IATYPE=2) NAME DEFAULT DESCRIPTION TDMPRB 0.0  Damping constant for angular oscillator model THEKRB 0.0  Spring constant for angular oscillator model 
Non-Inertial Reference Frame: Geophysical Fluid Flow 

Namelist XPUT NAME DEFAULT DESCRIPTION ANGLAT 0.0 Latitude (in degrees) between -90° and 90°. Positive in the northern hemisphere and negative in the southern hemisphere. Used when IACCF=1 and IATYPE=6. 
Graphic Output (GRAFIC) 
Graphic Output: Default Color Flag and Symmetry Reflections 

Namelist GRAFIC NOTE: INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. NAME DEFAULT DESCRIPTION ICOLOR 1 Default color plot indicator =0, no color plots unless specified =1, 2-D spatial plots and 3-D plots will be generated as color plots =2, all plots will be generated as color plots ISYMX 0 Symmetry reflection flag =0, do not reflect plots =1, show symmetry reflections across x=0 for all 2-D spatial plots For this option, WL (namelist BCDATA) must be 1, and the left 



edge of the mesh must be at x=0.  ISYMY 0 Symmetry reflection flag =0, do not reflect plots =1, show symmetry reflections across y=0 for all 2-D spatial plots For this option, WF (namelist BCDATA) must be 1, and the front edge of the mesh must be at y=0. ISYMZ 0 Symmetry reflection flag =0, do not reflect plots =1, show symmetry reflections across z=0 for all 2-D spatial plots For this option, WB (namelist BCDATA) must be 1, and the bottom edge of the mesh must be at z=0. 
Graphic Output: Selected Data 

Namelist GRAFIC 
n < 100, selected data index NOTE: SELECTED DATA INCREASE THE SIZE OF THE FLSGRF FILE. THE ENTIRE MESH IS ALWAYS INCLUDED FOR SELECTED DATA. NAME DEFAULT DESCRIPTION ANMTYP(n) “ “ Quantity to be stored as selected data ='dfair', volume fraction of entrained air ='dfct', surface defect concentration ='dfctw', wicked defect concentration ='dke', turbulent dissipation rate =’disslv’, dissolved solute concentration ='dpth', hydraulics data: free-surface elevation, fluid depth and the Froude Number 



='drg', drag function ='echrg', electric charge density ='elast', elastic stresses and deformations ='eof2', Zeta potential ='epot', electric potential and electric field magnitude ='f', fluid fraction ='fill1', filling times ='fsi' - FSI/TSE model output ='memb' - deflection of membranes and flexing walls ='mupor', percent microporosity ='mu', dynamic viscosity ='ncg', non-condensable gas density ='p', pressure ='part', particle locations, and velocities and sizes (mass particles) ='path', distance travelled by fluid ='pcav', cavitation potential ='phchm', phase change mass flux ='qsr', mass source rate per unit volume =’qw’, heat flux ='resdt', fluid residence time ='rho', macroscopic density ='rhoe', macroscopic internal energy ='rhosir' - iron solidification model output ='sclr1', 'sclr2', etc., scalar species magnitude ='scour' - sediment scour model output 



='scrpot' - excess shear stress ='seg', solute concentration =“sldfrc', solidified fraction ='stnr', fluid strain rate ='thead' - total hydraulic head ='tke', specific turbulent energy ='tn', fluid temperature ='tracer' - tracers ='tw', wall temperature ='vel', fluid velocities ='vfob', foam or phantom component volume fraction =“vmobs', component moisture content ='vort', vorticity vector 
Graphic Output: Contour Plots 
Variable Specification 

Namelist GRAFIC 
n < 21, contour plot index NAME DEFAULT DESCRIPTION CONTYP(n) “p” Quantity to be contoured ='drg', Drag-related function ='dtke', Turbulence dissipation rate ='f', Fluid fraction ='mu', Dynamic viscosity ='p', Pressure ='qsr', Mass source rate ='qw', Heat flux ='rho', Macroscopic density ='rhoe', Macroscopic internal energy 



='sclr1', 'sclr2', etc., Scalar species magnitude ='sldcf1', Niyama defect criterion ='sldcf2', Feeding efficiency index ='sldcf3', LCC porosity criterion ='sldcf4', Primary dendrite arm spacing ='sldcf5', Secondary dendrite arm spacing ='sldcfn', User defined functions (see SLDCFC) ='sldclr', Cooling rate at solidification ='sldeut', Eutectic mass fraction ='sldfrc', Solidified fraction ='sldgrd', Temperature gradient at solidification ='sldlst', Local solidification time ='sldtim', Solidification time ='sldvel', Solidus velocity ='stnr', Fluid strain rate ='tke', Specific turbulent energy ='tn', Fluid temperature ='tw', Wall temperature ='vel', Fluid velocity magnitude ='vfob', Foam or phantom component volume fraction ='vmobs', Component moisture content IDATYP(n) 0 Data source flag for contour plots. =0, use standard spatial data =1, use selected data 
Plot Specification NAME DEFAULT DESCRIPTION ICTYP(n) ... Contour type: =0, standard black and white (B/W) plot =1, color-shaded contour plot =2, color-shaded plot with black contour lines =3, both color-shaded and B/W plots =4, both color-shaded with contour lines and B/W plots =5, color contour lines Default=0 if ICOLOR=0; default=2 if ICOLOR > 0. 



IPERC(n) ... Indicator for type of plot: =1, for 2-D x-y slice =2, for 2-D y-z slice =3, for 2-D x-z slice Default determined by spatial limits specified for the plot. NC(n) 10 Number of contours to be plotted for line contour plots. NCC(n) 5 Number of contour lines laid over color-shaded plots. NCPLTS 0 Number of contour plots. QMN(n) ... If specified, QMN(n) is the minimum contour value for all plots generated for contour plot n. If QMN(n) is not specified, the minimum contour for each plot will be the minimum data value for that individual plot.  If both QMN(n) and QMX(n) are specified, all plots generated will have the same contour scale. However, if both QMN(n) and QMX(n) are specified as zero, all plots generated for contour plot n will use the same contour scale, with the minimum and maximum determined by the minimum and maximum of the accumulated data.  QMX(n) ... If specified, QMX(n) is the maximum contour value for all plots generated for contour plot n. If QMX(n) is not specified, the maximum contour for each plot will be the maximum data value for that individual plot.  If both QMN(n) and QMX(n) are specified, all plots generated will have the same contour scale. However, if both QMN(n) and QMX(n) are specified as zero, all plots generated for contour plot n will use the same contour scale, with the minimum and maximum determined by the minimum and maximum of the accumulated data. 
Data Limits NOTE: INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. 



NAME DEFAULT DESCRIPTION IPERC(n) ... Indicator for type of plot: =1, for 2-D x-y slice =2, for 2-D y-z slice =3, for 2-D x-z slice Default determined by spatial limits specified for the plot.  IC1(n) ... Minimum I index for plot n. Alternate: XC1 Default is first real cell. IC2(n) ... Maximum I index for plot n. Alternate: XC2 Default is last real cell. JC1(n) ... Minimum J index for plot n. Alternate: YC1 Default is first real cell. JC2(n) ... Maximum J index for plot n. Alternate: YC2 Default is last real cell. KC1(n) ... Minimum K index for plot n. Alternate: ZC1 Default is first real cell. KC2(n) ... Maximum K index for plot n. Alternate: ZC2 Default is last real cell. XC1(n) ... Minimum x-coordinate for plot n. Alternate: IC1 XC2(n) ... Maximum x-coordinate for plot n. Alternate: IC2 YC1(n) ... Minimum y-coordinate for plot n. Alternate: JC1 NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. 



YC2(n) ... Maximum y-coordinate for plot n. Alternate: JC2 NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZC1(n) ... Minimum z-coordinate for plot n. Alternate: KC1 ZC2(n) ... Maximum z-coordinate for plot n. Alternate: KC2 
Graphic Output: Export Data  
Variable Specification 

Namelist GRAFIC 
n < 26, export data index NAME DEFAULT DESCRIPTION EXPTYP(n) ... Quantity specified to be written to export data files. ='drg', Drag-related function = 'dtke', Turbulence dissipation rate ='f', Fluid fraction ='momen', Fluid momentum ='mu', Dynamic viscosity ='p', Pressure ='qsr', Mass source rate ='qw', Heat flux ='rho', Macroscopic density ='rhoe', Macroscopic internal energy ='sclr1', 'sclr2', etc., Scalar species magnitude ='sldcf1”, Niyama defect criterion ='sldcf2', Feeding efficiency index ='sldcf3', LCC porosity criterion ='sldcf4', Primary dendrite arm spacing ='sldcf5', Secondary dendrite arm spacing ='sldcfn', User defined functions (see SLDCFC) ='sldclr', Cooling rate at solidification ='sldeut', Eutectic mass fraction ='sldfrc', Solidified fraction ='sldgrd', Temperature gradient at solidification ='sldlst', Local solidification time 



='sldtim', Solidification time ='sldvel', Solidus velocity ='stnr', Fluid strain rate ='tke', Specific turbulent energy ='tn', Fluid temperature ='tw', Wall temperature ='vel”, Fluid velocity magnitude ='vf', Component volume fraction ='vfob', Foam or phantom component volume fraction Default is no export data. IDATEX 0 Data source flag for export data =0, use standard spatial data =1, use selected data 
Format Specification NOTE: FIELDVIEW®, ENSIGHT® AND TECPLOT360® CAN INTERFACE WITH THE FLSGRF FILE DIRECTLY, SO USING EXPORT DATA IS NOT NECESSARY FOR USING THESE PROGRAMS. NAME DEFAULT DESCRIPTION IBIN 0 Binary data flag for ENSIGHT® data =0, ASCII data files =1, binary data files. IPLT3D 0 Data export flag  =0, no export data; or data specified by EXPTYP (n) =1, export 'f', 'vel', 'vf' =2, export 'f ', 'vel', 'vf', and 'f', 'p', 'tn', 'rho', 'vf' =3, export 'rho', 'momen', 'rhoe', (standard PLOT3D file) If 'rhoe' not available, export 'vf'. ITRANP 1 Indicates format of export data for visualization programs =0, PLOT3D Q files. Only used when IPLT3D > 0. =1, PLOT3D Function Files / FIELDVIEW® Function Files =2, ENSIGHT® data files 



Data Limits NOTES: THE DEFAULT FOR EXPORT DATA INCLUDES THE ENTIRE MESH. INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. NAME DEFAULT DESCRIPTION IEXH ... Maximum I index for graphics export data. Alternate: XEXH IEXL ... Minimum I index for graphics export data. Alternate: XEXL JEXH ... Maximum J index for export data.  Alternate: YEXH JEXL ... Minimum J index for export data.  Alternate: YEXL KEXH ... Maximum K index for export data. Alternate: ZEXH KEXL ... Minimum K index for export. Alternate: ZEXL XEXH ... Maximum x-coordinate for export data. Alternate: IEXH XEXL ... Minimum x-coordinate for export data. Alternate: IEXL YEXH ... Maximum y-coordinate for export data. Alternate: JEXH NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. YEXL ... Minimum y-coordinate for export data. Alternate: JEXL NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZEXH ... Maximum z-coordinate for export data. Alternate: KEXH ZEXL ... Minimum z-coordinate for export data. Alternate: KEXL 
Graphic Output: Sampling Volumes 

Namelist GRAFIC 



n < 500, sampling volume index NOTES: SAMPLING VOLUMES ADD DATA TO FLSGRF. PRESSURE FORCES ON INDIVIDUAL COMPONENTS ARE REQUESTED IN NAMELIST OBS. THE DEFAULT FOR SAMPLING VOLUMES INCLUDES THE ENTIRE MESH. INDEXES LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES.    NAME DEFAULT DESCRIPTION FORTL(n) “sampling volume n” Identifier for sampling volume n (up to 256 characters) IFXL(n) ... Minimum x cell for sampling volume n. Alternate: XF1 JFYBK(n) ... Maximum y cell for sampling volume n. Alternate: YF2 JFYF(n) ... Minimum y cell for sampling volume n. Alternate: YF1 KFZB(n) ... Minimum z cell for sampling volume n. Alternate: ZF1 KFZT(n) ... Maximum z cell for sampling volume n. Alternate: ZF2 NWINF 0 Number of sampling volumes. XF1(n) ... Minimum x-coordinate for sampling volume n. Alternate: IFXL XF2(n) ... Maximum x-coordinate for sampling volume n. Alternate: IFXR YF1(n) ... Minimum y-coordinate for sampling volume n. Alternate: JFYF NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. YF2(n) ... Maximum y-coordinate for sampling volume n. Alternate: JFYBK NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZF1(n) ... Minimum z-coordinate for sampling volume n. Alternate: KFZB 



ZF2(n) ... Maximum z-coordinate for sampling volume n. Alternate: KFZT 
Graphic Output: History Probes 

Namelist GRAFIC 
n < 200, history probe index NOTES: HISTORY PROBE REQUESTS ADD DATA TO FLSGRF.  INDEXES LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL.  ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. NAME DEFAULT DESCRIPTION ILOC(n) ... x cell index for history probe n (Alternate: XLOC) JLOC(n) ... y cell index for history probe n (Alternate: YLOC) KLOC(n) ... z cell index for history probe n (Alternate: ZLOC) LOCOBS(n) 0 Moving component index that history probe n moves with LOCOPT(n) 0 Option flag for probe n moving with a GMO component defined by LOCOBS(n) =0, use the full velocity of the GMO component to move the probe, as if the probe is rigidly attached to it, irrespective of the probe’s proximity to the component. =1, use only the translational velocity of the GMO component to move the probe. NPMOV(n) ... Flag for history probe type =0, stationary interpolated =1, moving interpolated (moves with fluid like a marker particle) See History Point Particles in namelist PARTS. WINTL(n) ... Title for history probe n (up to 256 characters) Default titles identify history location coordinates or indexes. 



XLOC(n) ... X-coordinate for history probe n (Alternate: ILOC) YLOC(n) ... Y-coordinate for history probe n (Alternate: JLOC) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZLOC(n) ... Z-coordinate for history probe n (Alternate: KLOC) 
History Data Co-plotting NAME DEFAULT DESCRIPTION CPLTYP(n) ... History variables to be co-plotted as requested by NCOPLT ='dtke', turbulence dissipation rate  ='f', fluid fraction ='mu', dynamic viscosity ='p', pressure ='qsr', mass source rate  ='qw', heat flux ='rho', macroscopic density ='sclr1', 'sclr2',etc, scalar species magnitude ='tke', specific turbulent energy ='tn', fluid temperature ='tw', wall temperature ='u', x-component of velocity ='v', y-component of velocity ='w', z-component of velocity Default is to plot each quantity separately. NCOPLT(n) 0 Co-plotting index for history probe n Setting NCOPLT values equal for different history probes results in co-plotting of all variables specified by CPLTYP at these locations. NCOPLT(n)=0 indicates that variables at each location are to be plotted separately.  



Graphic Output: Iso-Surface Plots 
Variable Specification 

Namelist GRAFIC 
n < 21, surface plot index NOTE: BY DEFAULT, ISO-SURFACE PLOTS INCLUDE THE ENTIRE MESH. NAME DEFAULT DESCRIPTION CONTPS(n) “f “ Quantity to be contoured for iso-surface n ='cf', Complement of fluid fraction ='cvf', Complement of volume fraction ='drg', Drag-related function ='dtke', Turbulence dissipation rate ='f', Fluid fraction ='mu', Dynamic viscosity ='p', Pressure  ='rho', Macroscopic density ='rhoe', Macroscopic internal energy ='sclr1', 'sclr2',etc., Scalar species magnitude ='sldcf1', Niyama defect criterion ='sldcf2', Feeding efficiency index ='sldcf3', LCC porosity criterion ='sldcf4', Primary dendrite arm spacing ='sldcf5”, Secondary dendrite arm spacing ='sldcfn', User defined functions (see SLDCFC) ='sldclr', Cooling rate at solidification ='sldeut', Eutectic mass fraction ='sldfrc', Solidified fraction ='sldgrd', Temperature gradient at solidification ='sldlst', Local solidification time ='sldtim', Solidification time ='sldvel', Solidus velocity ='stnr', Fluid strain rate ='tke', Specific turbulent energy ='tn', Fluid temperature  ='vel', Fluid velocity magnitude ='vf', Component volume fraction ='vfob', Foam or phantom component volume fraction 



CLRTPS(n) ... If specified, this quantity is used to color the iso-surface ='drg', Drag-related function ='dtke', Turbulence dissipation rate ='f', Fluid fraction ='mu', Dynamic viscosity ='p', Pressure ='qsr', Mass source rate ='qw', Heat flux ='rho', Macroscopic density ='rhoe', Macroscopic internal energy ='sclr1', 'sclr2',etc., Scalar species magnitude ='sldcf1', Niyama defect criterion ='sldcf2', Feeding efficiency index ='sldcf3', LCC porosity criterion ='sldcf4', Primary dendrite arm spacing ='sldcf5', Secondary dendrite arm spacing ='sldcfn', User defined functions (see SLDCFC) ='sldclr', Cooling rate at solidification ='sldeut', Eutectic mass fraction ='sldfrc', Solidified fraction ='sldgrd', Temperature gradient at solidification ='sldlst', Local solidification time ='sldtim', Solidification time ='sldvel', Solidus velocity ='stnr', Fluid strain rate ='tke', Specific turbulent energy ='tn', Fluid temperature ='tw', Wall temperature ='vel', Fluid velocity magnitude ='vfob', Foam or phantom component volume fraction ='vmobs', Component moisture content IDATPS(n) 0 Data source flag for iso-surface plot n =0, use standard spatial data =1, use selected data QVAL(n) ... Iso-surface value Default is the average of the minimum and maximum values in 



the data. 
Plot Specification NAME DEFAULT DESCRIPTION ICTPS(n) ... Iso-surface type flag =0, show wireframe  =1, show solid iso-surface =2, show solid iso-surface and transparent component =3, show solid iso-surface and transparent component complement =4, show solid iso-surface and solid component =5, show solid iso-surface and solid component complement Defaults to type 2, unless ISWAT=1 (shallow water model, in XPUT) which defaults to type 5. IHIDE(n) ... Hidden surface indicator for wireframe plots =-1, remove hidden surfaces using orientation test and blockage and taking into account blanking =0, plot all surfaces =1, remove hidden surfaces using orientation test and blockage =2, remove hidden surfaces using only surface orientation test Defaults to 0 for plots of fluid fraction and its complement, to 1 for plots of volume fraction and its complement, and to -1 for all other plots.  IPASN(n) 1 Iso-surface contour flag for wireframe plots =0, use three-dimensional shifted points for surface contours =1, surface in all coordinate planes =2, plot contours in x planes =3, plot contours in y planes =4, plot contours in z planes =5, use 4-sided surface elements but only plot edges ISVEW(n) 1 Viewpoint for iso-surface plot n 



NSPLTS 0 Number of iso-surface plots SQMN(n) ... If specified, SQMN(n) is the minimum contour value for the coloring variable CLRTPS for all plots generated for iso-surface plot n. If SQMN(n) is not specified, the minimum contour for each plot will be the minimum data value for that individual plot. If both SQMN(n) and SQMX(n) are specified, all plots generated will have the same contour scale. However, if both SQMN(n) and SQMX(n) are specified as zero, all plots generated for iso-surface plot n will use the same contour scale, with the minimum and maximum determined by the minimum and maximum of the accumulated data. SQMX(n) ... If specified, SQMX(n) is the maximum contour value for the coloring variable CLRTPS for all plots generated for iso-surface plot n. If SQMX(n) is not specified, the maximum contour for each plot will be the maximum data value for that individual plot.  If both SQMN(n) and SQMX(n) are specified, all plots generated will have the same contour scale. However, if both SQMN(n) and SQMX(n) are specified as zero, all plots generated for iso-surface plot n will use the same contour scale, with the minimum and maximum determined by the minimum and maximum of the accumulated data. 
Data Limits NOTE: INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. NAME DEFAULT DESCRIPTION IS1(n) ... Minimum I index for plot n (Alternate: XS1) IS2(n) ... Maximum I index for plot n (Alternate: XS2) JS1(n) ... Minimum J index for plot n (Alternate: YS1) 



JS2(n) ... Maximum J index for plot n (Alternate: YS2) KS1(n) ... Minimum K index for plot n (Alternate: ZS1) KS2(n) ... Maximum K index for plot n (Alternate: ZS2) XS1(n) ... Minimum x-coordinate for plot n (Alternate: IS1) XS2(n) ... Maximum x-coordinate for plot n (Alternate: IS2) YS1(n) ... Minimum y-coordinate for plot n (Alternate: JS1) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. YS2(n) ... Maximum y-coordinate for plot n (Alternate: JS2) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZS1(n) ... Minimum z-coordinate for plot n (Alternate: KS1) ZS2(n) ... Maximum z-coordinate for plot n (Alternate: KS2) 
Graphic Output: Particle Plots 
Variable Specification 

Namelist GRAFIC 
n < 21, particle plot index NAME DEFAULT DESCRIPTION CONTPP(n) ... Quantity for color contours under particles (for 2-D plots) ='drg', Drag-related function ='dtke', Turbulence dissipation rate ='f', Fluid fraction ='mu', Dynamic viscosity ='p', Pressure ='qsr', Mass source rate ='qw', Heat flux 



='rho', Macroscopic density ='rhoe', Macroscopic internal energy ='sclr1', 'sclr2', etc., Scalar species magnitude ='sldcf1', Niyama defect criterion ='sldcf2', Feeding efficiency index =' sldcf3', LCC porosity criterion ='sldcf4', Primary dendrite arm spacing ='sldcf5', Secondary dendrite arm spacing ='sldcfn', User defined functions (see SLDCFC) ='sldclr', Cooling rate at solidification ='sldeut', Eutectic mass fraction ='sldfrc', Solidified fraction ='sldgrd', Temperature gradient at solidification ='sldlst', Local solidification time ='sldtim', Solidification time ='sldvel', Solidus velocity ='stnr', Fluid strain rate ='tke', Specific turbulent energy ='tn', Fluid temperature ='tw', Wall temperature ='vel', Fluid velocity magnitude ='vfob', Foam or phantom component volume fraction ='vmobs', Component moisture content Default is no contours. IDATPP(n) 0 Data source flag for particle plots. =0, use standard spatial data =1, use selected data 
Plot Specification NAME DEFAULT DESCRIPTION IPERP(n) ... Indicator of type of plot  =1, 2-D x-y slice =2, 2-D y-z slice =3, 2-D x-z slice =4, for perspective 3-D 



Default determined by spatial limits specified for the plot. IPTYP(n) 0 Particle plot type: =0, standard black and white plot =1, 2-D plot where particle color denotes position in the third direction.  (All particles are projected onto a 2-D plane.) =2, color particles according to diameter or density  (See IPFLAG in namelist PARTS) =3, color particles according to particle u-velocity =4, color particles according to particle v-velocity =5, color particles according to particle w-velocity =6, color particles according to particle velocity magnitude IPVEW(n) 1 Viewpoint for 3-D perspective particle plot n NPPLTS 0 Number of particle plots 
Data Limits NOTE: INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. NAME DEFAULT DESCRIPTION IPERP(n) ... Indicator of type of plot =1, 2-D x-y slice =2, 2-D y-z slice =3, 2-D x-z slice =4, for perspective 3-D Default determined by spatial limits specified for the plot. IP1(n) ... Minimum I index for plot n (Alternate: XP1) Default is first real cell. IP2(n) ... Maximum I index for plot n (Alternate: XP2)  Default is last real cell. 



JP1(n) ... Minimum J index for plot n (Alternate: YP1) Default is first real cell. JP2(n) ... Maximum J index for plot n (Alternate: YP2)  Default is last real cell. KP1(n) ... Minimum K index for plot n (Alternate: ZP1)  Default is first real cell. KP2(n) ... Maximum K index for plot n (Alternate: ZP2) Default is last real cell. XP1(n) ... Minimum x-coordinate for plot n (Alternate: IP1) XP2(n) ... Maximum x-coordinate for plot n (Alternate: IP2) YP1(n) ... Minimum y-coordinate for plot n (Alternate: JP1) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. YP2(n) ... Maximum y-coordinate for plot n (Alternate: JP2) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZP1(n) ... Minimum z-coordinate for plot n (Alternate: KP1) ZP2(n) ... Maximum z-coordinate for plot n (Alternate: KP2) 
Graphic Output: Pre-processor Geometry Plots 

Namelist GRAFIC NOTE: DEFAULT PRE-PROCESSOR PLOTS ARE SINGLE SLICE IN EACH PLANE AT CENTER OF MESH. INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED COORDINATES. NAME DEFAULT DESCRIPTION 



IOBSL ... Minimum x cell for pre-processor plots (Alternate: XOBSL)  IOBSR ... Maximum x cell for pre-processor plots (Alternate: XOBSR) JOBSBK ... Maximum y cell for pre-processor plots (Alternate: YOBSBK) JOBSF ... Minimum y cell for pre-processor plots (Alternate: YOBSF) KOBSB ... Minimum z cell for pre-processor plots (Alternate: ZOBSB) KOBST ... Maximum z cell for pre-processor plots (Alternate: ZOBST)  XOBSL ... Minimum x-coordinate for pre-processor plots (Alternate: IOBSL) XOBSR ... Maximum x-coordinate for pre-processor plots (Alternate: IOBSR) YOBSBK ... Maximum y-coordinate for pre-processor plots (Alternate: JOBSBK) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. YOBSF ... Minimum y-coordinate for pre-processor plots (Alternate: JOBSF) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZOBSB ... Minimum z-coordinate for pre-processor plots (Alternate: KOBSB) ZOBST ... Maximum z-coordinate for pre-processor plots (Alternate: KOBST) 
Graphic Output: Solidification Criterion Functions 

Namelist GRAFIC 
n < 9, criterion function index 



NAME DEFAULT DESCRIPTION SLDCFC(1,n) 1.0  Multiplier for criterion function n SLDCFC(2,n) ... Exponent for cooling rate, SLDCLR SLDCFC(3,n) ... Exponent for temperature gradient, SLDGRD SLDCFC(4,n) ... Exponent for solidus velocity, SLDVEL SLDCFC(5,n) ... Exponent for local solidification time, SLDLST SLDCFT(n) ... Criterion function name 
Criterion Function Input Defaults N SLDCFC(1,n) SLDCFC(2,n) SLDCFC(3,n) SLDCFC(4,n) SLDCFC(5,n) SLDCFT(n) 1 1.0  -0.5 1.0  0.0  0.0  'Niyama porosity criterion' 2 1.0  0.0  1.0  0.0  -1.0  'feeding efficiency index' 3 1.0  0.0  1.0  -1.0  0.667 'LCC porosity criterion' 4 1.0  0.0  -0.5 -0.25 0.0  'primary dendrite arm spacing' 5 1.0  0.0  -0.417 -0.417 0.0  'secondary dendrite arm spacing' 6 1.0  -0.5 1.0  0.0  0.0  ' ' 7 1.0  -0.5 1.0  0.0  0.0  ' ' 



8 1.0  -0.5 1.0  0.0  0.0  ' ' 9 1.0  -0.5 1.0  0.0  0.0  ' ' 
Graphic Output: Velocity Vector Plots 
Variable Specification 

Namelist GRAFIC 
n < 21, vector plot index NAME DEFAULT DESCRIPTION CONTPV(n) ... Quantity to be contoured under the vectors (cannot be used with CLRTPV) Default=no contours if ICOLOR=0; default ='f ' if ICOLOR > 0. =' ', no contour shading ='drg', Drag-related function ='dtke', Turbulence dissipation rate ='f ', Fluid fraction ='mu', Dynamic viscosity ='p', Pressure ='qsr', Mass source rate ='qw', Heat flux ='rho', Macroscopic density ='rhoe', Macroscopic internal energy ='sclr1','sclr2',etc, Scalar species magnitude ='sldcf1', Niyama defect criterion ='sldcf2', Feeding efficiency index ='sldcf3', LCC porosity criterion ='sldcf4', Primary dendrite arm spacing ='sldcf5', Secondary dendrite arm spacing ='sldcfn', User defined functions (see SLDCFC) ='sldclr', Cooling rate at solidification ='sldeut', Eutectic mass fraction ='sldfrc', Solidified fraction ='sldgrd', Temperature gradient at solidification ='sldlst', Local solidification time ='sldtim', Solidification time ='sldvel', Solidus velocity 



='stnr', Fluid strain rate ='tke', Specific turbulent energy ='tn', Fluid temperature ='tw', Wall temperature ='vel', Fluid velocity magnitude ='vfob', Foam or phantom component volume fraction ='vmobs', Component moisture content CLRTPV(n) ... If specified, this quantity is used to color the vectors in both 2-D and 3-D vector plots. The color used for each vector is determined by the value of this quantity at the vector location. The quantities that can be specified are the same as those for CONTPV(n). (Cannot be used with CONTPV.) IDATPV(n) 0 Data source flag for vector plots =0, use standard spatial data =1, use selected data 
Plot Specification NAME DEFAULT DESCRIPTION IPERV(n) ... Indicator for type of plot =1 for 2-D x-y slice =2 for 2-D y-z slice =3 for 2-D x-z slice =4 for perspective 3-D Default determined by spatial limits specified for the plot. IV3OPT(n) 1 3-D vector option =0, plot all vectors in the specified region =1, only plot vectors on the front faces of the specified region =2, only plot vectors on the back faces of the specified region =3, only use the vector components that lie on the back faces to draw the vectors on those faces =4, only use the vector components that lie on the front faces to draw the vectors on those faces 



IVTYP(n) 0 Vector plot type =0, do not color vectors =1, 2-D plots where the vector is colored by 2-D velocity magnitude =2, 2-D plots where the vector is colored by the third component of velocity =3, color vectors where the color of the vector is determined by CLRTPV IVVEW(n) 1 Viewpoint for 3-D perspective velocity vector plot n NVPLTS 0 Number of velocity vector plots VELMX 1.0  Scaling multiplier for velocity vectors VMAX(n) ... If specified as a positive value, VMAX(n) is the maximum velocity for scaling vector lengths for all plots generated for vector plot n (all plots would use the same vector length scale making comparison between plots easier). However, if VMAX(n) is a negative value, all plot n vector plots would use the same vector length scale, determined by the maximum velocity in the accumulated data.  If VMAX(n) is not specified, the vectors for each plot are scaled independently based on the maximum velocity for each plot. VQMN(n) ... If specified, VQMN(n) is the minimum contour or coloring value for all plots generated for vector plot n. If VQMN(n) is not specified, the minimum value for each plot will be the minimum data value for that individual plot.  If both VQMN(n) and VQMX(n) are specified, all plots generated will have the same contour or coloring scale. However, if both VQMN(n) and VQMX(n) are specified as zero, all plots generated for vector plot n will use the same contour or coloring scale, with the minimum and maximum determined by the minimum and maximum of the accumulated data. VQMX(n) ... If specified, VQMX(n) is the maximum contour or coloring value for all plots generated for vector plot n. If VQMX(n) is not specified, the maximum value for each plot will be the 



maximum data value for that individual plot.  If both VQMN(n) and VQMX(n) are specified, all plots generated will have the same contour or coloring scale. However, if both VQMN(n) and VQMX(n) are specified as zero, all plots generated for vector plot n will use the same contour or coloring scale, with the minimum and maximum determined by the minimum and maximum of the accumulated data. VSCALE(n) 1.0  Scaling multiplier for velocity vectors 
Data Limits NOTE:  INDEX LOCATIONS ARE NOT APPLICABLE WHEN USING THE MULTI-BLOCK MODEL. ALL LOCATIONS MUST BE SPECIFIED AS COORDINATES. NAME DEFAULT DESCRIPTION IPERV(n) ... Indicator for type of plot =1 for 2-D x-y slice =2 for 2-D y-z slice =3 for 2-D x-z slice =4 for perspective 3-D Default determined by spatial limits specified for the plot. IV1(n) ... Minimum I index for plot n (Alternate: XV1) Default is first real cell. IV2(n) ... Maximum I index for plot n (Alternate: XV2) Default is last real cell. JV1(n) ... Minimum J index for plot n (Alternate: YV1) Default is first real cell. JV2(n) ... Maximum J index for plot n (Alternate: YV2) Default is last real cell. 



KV1(n) ... Minimum K index for plot n (Alternate: ZV1) Default is first real cell. KV2(n) ... Maximum K index for plot n (Alternate: ZV2).  Default is last real cell. XV1(n) ... Minimum x-coordinate for plot n (Alternate: IV1) XV2(n) ... Maximum x-coordinate for plot n (Alternate: IV2) YV1(n) ... Minimum y-coordinate for plot n (Alternate: JV1) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. YV2(n) ... Maximum y-coordinate for plot n (Alternate: JV2) NOTE: LOCATION IS IN DEGREES WHEN USING CYLINDRICAL COORDINATES. ZV1(n) ... Minimum z-coordinate for plot n (Alternate: KV1) ZV2(n) ... Maximum z-coordinate for plot n (Alternate: KV2) 
Graphic Output: Viewpoint Specification 

Namelist GRAFIC 
n < 21, viewpoint index NAME DEFAULT DESCRIPTION NVEWS 1 Number of viewpoints XEA(n) ... X-coordinate eye point for viewpoint n Default viewpoint is chosen to present a pleasing perspective YEA(n) ... Y-coordinate eye point for viewpoint n Default viewpoint is chosen to present a pleasing perspective. 



ZEA(n) ... Z-coordinate eye point for viewpoint n Default viewpoint is chosen to present a pleasing perspective. 
Particle Setup (PARTS) 
Particle Setup: General Particle Data 

Namelist PARTS NAME DEFAULT DESCRIPTION DIELPR 1.0 Dielectric constant for particles ECHRG 0.0 Particle electric charge FSRST 0.0 Flag for particle-free surface interaction =-1.0, Particles can escape from fluid to voids and are then deleted (e.g., gas bubbles escaping into atmosphere). Particles initialized in voids are deleted. =0.0, Particles cannot escape from fluid to voids (e.g., small particulate contaminants). Particles initialized in voids are deleted. =1.0, Particles can move in fluid and in void regions (e.g., large solid particles). Marker particles remain stationary in voids until submerged in fluid. IMPPRT 0 Flag for implicit particle/fluid coupling for mass particles IMPPRT=1 activates the model. IPONLY 0 Indicator for fluid dynamics and/or particle motion =0, fluid dynamics calculations and particle transport =1, for restarts (IFREST=1) use particle definitions from PREPIN rather than particle data from FLSGRF. IPFLAG ... Flag for particle species type =0, only marker particles =1, particles with variable diameter, but constant density 



=2, particles with variable density, but constant diameter Defaults to 0 if no mass particles are specified, and to 1 for mass particles. IPSET 0 Particle generation flag =0, particles re-initialized randomly in space within the initial rectangular block and are also initialized randomly in time at each particle source =1, particles are initialized in a regular manner in space within the initial block =2, particles are initialized in a regular manner in time at particle sources (requires the particle generation rate to be larger than the reciprocal time-step size) =3, option 1 and 2 at the same time NUP 0.0 Constant particle diffusion coefficient (see RMPART below). PCRST 1.0 Particle coefficient of restitution < 0, particles stick when they first come in contact with walls  =0, no particle reflection =1, full specular particle reflection PDIAM 1.0 Particle diameter (Alternate: PVOL) PDRG3 1.0 Multiplier for coefficient of particle drag, which is a function of Reynolds number of the fluid flow around the particle. PRHO 1.0 Particle density PVOL 0.0 Particle volume (Alternate: PDIAM) RMPART 0.0 Inverse Schmidt number for particle diffusion; multiplies kinematic viscosity and is added to NUP. NPMAX 10,000 The maximum allowed number of particles IACDEP 0 Dielectrophoresis model flag = 0, DC particle dialectrophoresis model 



= 1, AC particle dialectrophoresis model FREVAL 0.0 Coefficient in AC particle dielectrophoresis model. Equal to  
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fp , where ω is the frequency of the external electric field, and εp and εf are the complex permittivities of the particles and fluid. Used with the AC particle dielectrophoresis model, IACDEP=1. 
Particle Setup: Block Initialized Particles 

Namelist PARTS NOTE: BLOCK DEFAULTS TO ENTIRE MESH. NAME DEFAULT DESCRIPTION NPX 0 Number of particles in x-direction in initial block NPY 0 Number of particles in y-direction in initial block NPZ 0 Number of particles in z-direction in initial block NSPEC 1 Number of particle species in initial particle block PPMIN ... Lower limit for particle diameter (IPFLAG=1) or density (IPFLAG=2) in initial particle block. Used for multi-species particle flows. Defaults to PDIAM if IPFLAG=1 and to PRHO if IPFLAG=2. PPMAX ... Upper limit for particle diameter (IPFLAG=1) or density (IPFLAG=2) in initial particle block. Used for multi-species particle flows. If PMAX < PMIN, then PMAX=PMIN. Defaults to PDIAM if IPFLAG=1 and to PRHO if IPFLAG=2. XPL ... Minimum x-coordinate of initial rectangular particle block XPR ... Maximum x-coordinate of initial rectangular particle block 



YPBK ... Maximum y-coordinate of initial rectangular particle block For a cylindrical mesh (ICYL=1 in MESH), YPBK is in degrees. YPF ... Minimum y-coordinate of initial rectangular particle block For a cylindrical mesh (ICYL=1 in MESH), YPF is in degrees. ZPB ... Minimum z-coordinate of initial rectangular particle block ZPT ... Maximum z-coordinate of initial rectangular particle block UPI 0.0 Initial particle velocity in the x-direction VPI 0.0 Initial particle velocity in the y-direction WPI 0.0 Initial particle velocity in the z-direction 
Particle Setup: Source Initialized Particles 

Namelist PARTS 
n < 100, particle source index NAME DEFAULT DESCRIPTION IPPKT 0 Number of particle sources NSSPEC(n) 1 Number of particle species at source n PARTICLESOURCENAME (n) ‘   ‘ Particle source n name (up to 256 characters) RATE(n) 0.0  Rate of particle creation at source n (Alternate: RATET(t,n)) RATET(t,n) RATE(n)  Time-dependent rate of particle creation at source n at time TMS(n) SPMIN(n) ... Lower limit for particle diameter (IPFLAG=1) or density (IPFLAG=2) at particle source n. Used for multi-species particle flows. 



Defaults to PDIAM if IPFLAG=1 and to PRHO if IPFLAG=2. SPMAX(n) ... Upper limit for particle diameter (IPFLAG=1) or density (IPFLAG=2) at particle source n. Used for multi-species particle flows. If SPMAX (n) < SPMIN(n), then SPMAX(n)=SPMIN(n). Defaults to PDIAM if IPFLAG=1 and to PRHO if IPFLAG=2. UPP(n) 0.0  Particle initial u-velocity at source n VPP(n) 0.0  Particle initial v-velocity at source n WPP(n) 0.0  Particle initial w-velocity at source n XPP(n) ... X location of particle source n Default is outside mesh. XPPL(n) ... Lower x-coordinate limit for volumetric particle source n Default value includes whole mesh, or equals XPP(n) if XPP(n) is specified. XPPR(n) ... Upper x-coordinate limit for volumetric particle source n Default value includes whole mesh, or equals XPP(n) if XPP(n) is specified. YPP(n) ... Y location of particle source n. For a cylindrical mesh (ICYL=1 in MESH), YPPF is in degrees.  Default is outside mesh. YPPF(n) ... Lower y-coordinate limit for volumetric particle source n. For a cylindrical mesh (ICYL=1 in MESH), YPPF is in degrees.  Default value includes whole mesh, or equals YPP(n) if YPP(n) is specified. YPPBK(n) ... Upper y-coordinate limit for volumetric particle source n. For a cylindrical mesh (ICYL=1 in MESH), YPPBK is in 



degrees.  Default value includes whole mesh, or equals YPP(n) if YPP(n) is specified. ZPP(n) ... Z location of particle source n Default is outside mesh. ZPPB(n) ... Lower z-coordinate limit for volumetric particle source n Default value includes whole mesh, or equals ZPP(n) if ZPP(n) is specified. ZPPT(n) ... Upper z-coordinate limit for volumetric particle source n Default value includes whole mesh, or equals ZPP(n) if ZPP(n) is specified. 
Particle Setup: History Point Particles 

Namelist PARTS 
n < 200, particle associated history locations NOTE: DEFAULT LOCATION IS OUTSIDE OF MESH. NAME DEFAULT DESCRIPTION PLOCTL(n) ... Title for particle associated moving history location n (50 characters maximum) Default titles identify history location. SIZLOC(n) 0 Particle diameter (IPFLAG=1) or density (IPFLAG=2) at particle associated moving history point n ULOCP(n) 0.0  Initial u-velocity at particle associated moving history point n VLOCP(n) 0.0  Initial v-velocity at particle associated moving history point n WLOCP(n) 0.0  Initial w-velocity at particle associated moving history point n 



XLOCP(n) ... Initial x-coordinate for particle associated moving history point n YLOCP(n) ... Initial y-coordinate for particle associated moving history point n ZLOCP(n) ... Initial z-coordinate for particle associated moving history point n 
Particle Setup: Flux Surface and Sampling Volume Data 

Namelist PARTS 
n < 10, particle group index NAME DEFAULT DESCRIPTION NSPCS 1 Number of particle groups to be counted at flux surfaces and in sampling volumes. Maximum is 10. RSP1(n) 0.0 Lower limit for particle diameter (IPFLAG=1) or density (IPFLAG=2) for particle group n RSP2(n) 1.0e+20  Upper limit for particle diameter (IPFLAG=1) or density (IPFLAG=2) for particle group n  

Particle Setup: Mass-Momentum Sources 
Namelist PARTS 
m < 100, index of mass-momentum source  
t < 500, time index 
ns < 99, scalar species index 
k ≤ 10, sediment species index NOTES: THE MASS MOMENTUM SOURCE MODEL REQUIRES THE SETTING OF IQSR=1 IN XPUT. EACH MASS-MOMENTUM SOURCE IS INITIALIZED IN THE X-Y PLANE AND CENTERED AT THE ORIGIN, WITH THE FLOW DIRECTION VECTOR POINTING ALONG THE POSITIVE Z-AXIS. THE FINAL LOCATION IS THEN DEFINED BY TRANSFORMATION INCLUDING TRANSLATIONS AND ROTATIONS. ROTATIONS ARE DONE IN THE ORDER OF X-AXIS, Y-AXIS AND Z-AXIS AND ARE PERFORMED BEFORE THE TRANSLATIONS.  



ALL TIME-DEPENDENT VARIABLES DEFAULT TO ZERO FOR TIME INDEX T = 1. FOR THE TIME INDEX T > 1, THE VARIABLE VALUE DEFAULTS TO THE VALUE AT THE PREVIOUS TIME INDEX. FOR A CONSTANT VALUE OF A TIME-DEPENDENT VARIABLE, SET THE VARIABLE FOR TIME INDEX T = 1. NAME DEFAULT DESCRIPTION IAQSRP(m) 1 Activation flag for mass-momentum source m =0, deactivated =1, activated IFQSRP(m) 1 Index of fluid released by source m (when flow rate is positive) =1, fluid #1 =2, fluid #2 (or void) IFSNKP(m) 1 Index of fluid removed by mass source m (when flow rate is negative) =1, fluid #1 =2, fluid #2  (or void) =3, mixture of fluids #1 and #2 (or void) in proportion to their volume fractions in the mesh cells adjacent to source. IVQSRP(m) 2 Indicator of volume of mass flow rate for source (m) =1, volume flow rate is defined (i.e., TVFR(t,m) is volume flow rate). =2, mass flow rate is defined (i.e., TVFR(t,m) is mass flow rate). MASSMOMENTUMNAME(m) ‘   ‘ Mass/momentum source m name (up to 256 characters) NVNTS 0 Total number of mass/momentum sources NVTYP(m) 1 Shape of source surface = 1, square = 2, rectangular = 3, circular 



= 4, elliptical RHOQSRP(m) … Density of fluid released from source m For variable density problems only. Used when flow rate from source is positive. For a one-fluid problem with fluid #1 released, defaults to RHOF2. RHOSNKP(m) … Density of gas in voids Used to convert mass flow rate to volume flow rate at void sinks in one-fluid problems, IVQSRP(m)=2, IFSNKP(m)=2 or 3, and NMAT=1. TQSRP(m) TSTAR Temperature of fluid released from source m TVFR(t,m) 0.0 Total flow rate from source m at time TMS(t), where t is the index for time If IVQSRP(m)=1, it is volume flow rate. If IVQSRP(m)=2, it is mass flow rate. TVFR(t,m) is positive if fluid is released, and negative if fluid is removed. Can change sign with time. XV(m)  0.0 Translation along the x-coordinate of the center of source m YV(m) 0.0 Translation along the y-coordinate of the center of source m ZV(m) 0.0 Translation along the z-coordinate of the center of source m XSIZE(m) 0.0 Size of source m along the x-direction For square, defines the square edge in both directions, for circular sources, defines the diameter. YSIZE(m) 0.0 Size of a rectangular or elliptical source m along the y-direction VNX(m) 0.0 Rotation around x-axis of source m 



VNY(m) 0.0 Rotation around y-axis of source m VNZ(m) 0.0 Rotation around z-axis of source m TMS(m) 0.0 Time table for time-dependent mass momentum source parameters UV(t,m)  … x-component of fluid velocity at source m at time TMS(t) The velocity component tangential to the source’s outlet surface defaults to 0.0. The normal component is computed from the value of mass flow rate TVFR(t,m) and density RHOQSR. VV(t,m) … y-component of fluid velocity at source m at time TMS(t) The velocity component tangential to the source’s outlet surface defaults to 0.0. The normal component is computed from the value of mass flow rate TVFR(t,m) and density RHOQSR. WV(t,m) … z-component of fluid velocity at source m at time TMS(t) The velocity component tangential to the source’s outlet surface defaults to 0.0. The normal component is computed from the value of flow rate TVFR(t,m) and density RHOQSR. USOU(t,m) 0.0 x-component of the velocity of source m at time TMS(t) VSOU(t,m) 0.0 y-component of the velocity of source m at time TMS(t) WSOU(t,m) 0.0 z-component of the velocity of source m at time TMS(t) TVFR(t,m) 0.0 Total mass flow rate of source m at time TMS(t) 



SCPQSR(t,m,ns) 0.0 Scalar ns concentration at source m at time TMS(t) PQSRAIR(t,m) 0.0 Concentration of air at source m at time TMS(t) Used only with the air entrainment model (IDFAR=1). PQSRDISS(t,m) 0.0 Concentration dissolved solute at source m at time TMS(t) Used only with the air entrainment model. Used when IDISSOLVE=1. PQSRNCG(t,m) 0.0 Volume fraction of non-condensable gas at source m at time TMS(t) Used only with the two-component gas model and two-fluid phase change model (IPHCHG=2 and INCG=1). PQSRCHRG(t,m) 0.0 Electric charge density at source m at time TMS(t). Used only with the electric charge density model (IECHRG=1). PQSRSEG(t,m) 0.0 Concentration of solute at source m at time TMS(t). Used only with the segregation model and solidification model (IESEG=1 and IFSLD=1). PQSRSS(t,m,k) 0.0 Concentration of suspended sediment species k at a mass momentum source m at time TMS(t) Used only with the sedimentation & scour model (NSSPC > 0). IPQSR  0 Flag for user-customized mass/momentum source model Only used when the solver subroutine PARQSR is modified by the user: =0, no user-customized mass/momentum sources =1, stationary user-customized mass/momentum sources 



=2, moving user-customized mass/momentum sources  
User Defined Namelist (USRDAT) 

Namelist USRDAT NOTE: THIS NAMELIST MAY BE CUSTOMIZED BY SOURCE USERS AND IS ONLY READ IF IUSRD > 0 IN XPUT. NAME DEFAULT DESCRIPTION CDUMVR ... Character dummy variable IUDUMV ... Integer dummy variable REMARK ... Dummy character string for adding comments to URSDAT UDUMVR ... Real dummy variable  



Chapter 11 - Units and Conversion Factors 
Overview FLOW-3D does not favor any specific system of units. However, it does require the use of a consistent set of units. Some of the default quantities in FLOW-3D have dimensions, and these have been chosen as typical values in CGS units. These should be specified by the user when using a different unit system. The four most consistent sets of consistent units are: Property Units  SI CGS English Inch-lbf-s Length m cm ft inch Time s s s s Force N dyne lbf lbf Mass kg gm slug lbf-s²/inch Pressure Pa dynes/cm² lbf/ft² lbf/in² Density kg/m³ gm/cm³ slug/ft³ lbf-s²/in4 Dynamic Viscosity Pa-s Poise = 0.1 Pa-s slug/ft/s lbm/in/s Acceleration m/s2 cm/s2 ft/s² in/s² Temperature K K °R °R Specific Heat Joule/kg/K erg/gm/K ft-lbf/slug/R in²/s²/R Thermal Conductivity Watt/m/K erg/s/cm/K slug-ft/s³/R lbf/s/R Power Watt 10-7 Watt ft-lbf/s in-lbf/s Heat Flux Watt/m² erg/s/cm² ft-lbf/s/ft² lbf/in/s Each dimensional grouping of importance to FLOW-3D is summarized in this section. An index of the catalogued dimensional groups is provided following the listings. The description begin with a line containing a title for the quantity, a typical symbol (if appropriate) in parentheses, and the dimensions of the group enclosed within square brackets. The dimensions are expressed in terms of the following fundamental quantities: t – time, l – length, m – mass, T – temperature Following this headline is a list of FLOW-3D input variables that are defined by the dimensional grouping.  See the Input Variable Summary chapter for descriptions of these variables. 



The fundamental units follow for the CGS, MKS, and Engineering systems of units. The slug has been chosen as the fundamental mass unit for the Engineering Units system, resulting in forces expressed in pounds, indicated by lbf. Other permissible (consistent) Engineering units may be used in FLOW-3D. Conversion factors relating MKS to CGS and Engineering to MKS are provided as are alternative names (aliases) commonly used for the same units. Selected alternative units are next exhibited with conversion factors to fundamental units. Most of the selected alternatives are closely related to Engineering system units. There are some slight variations in the definitions of some of these units. If you require great precision, consult a standard reference. Typical values are given for the dimensional group when possible. Values in all three systems of units are provided.  NOTE: TYPICAL VALUES ARE PROVIDED AS A ROUGH GUIDE; MEASURED QUANTITIES OFTEN VARY SIGNIFICANTLY. 
Units and Conversion Factors 
Acceleration Units Quantity:  Acceleration (g) [l/t²] Input Variables XPUT GX, GY, GZ MOTN: A0, GRAVX, GRAVY, GRAVZ  CGS: cm/s²   MKS: m/s² 1 m/s²=100 cm/s² Engineering: ft/s² 1 ft/s²=0.3048 m/s²  Frequently Used Alternatives: 1 in/s² =.08333 ft/s² Typical Values:  Gravity at Earth's Surface Low-G Drop Tower CGS (cm/s²) 980 1.0 x 10-² MKS (m/s²) 9.8 1.0 x 10-4 Engineering (ft/s²) 32.2 3.0 x 10-4 
Angle Units Quantity:  Angle (Ѳ) Input Variables 



PROPS: CANGLE MESH: PYA, SIZEYA OBS: ANGLL, ANGLH, CONEL, CONEH, CROTX, CROTY, CROTZ, OCANG, ROTX, ROTY, ROTZ FL: FANGLL, FANGLH, FCONEL, FCONEH, FROTX, FROTY, FROTZ BF: BANGL, BANGLL, BANGLH, BCONE, BCONEL, BROTX, BROTY, BROTZ TEMP:  TANGLL, TANGLH, TCONEL, TCONEH, TROTX, TROTY, TROTZ MOTN:   RMAGX*, RMAGY*, RMAGZ* RPHIX*, RPHIY*, RPHIZ*, TPHIX*, TPHIY*, THPIZ* PARTS:   YPBK**, YPF**, YPP**, YPPBK**, YPPF**  CGS: Radians, Degrees MKS: Radians, Degrees Engineering: Radians, Degrees NOTES: * ALL VARIABLES LISTED ARE SPECIFIED IN DEGREES, NOT RADIANS, EXCEPT THOSE INDICATED BY *, WHICH ARE RADIANS.  ** VARIABLES INDICATED BY ** ARE ANGULAR MEASUREMENTS (DEGREES) ONLY FOR CYLINDRICAL COORDINATE SYSTEMS (ICYL=1) IN NAMELIST MESH); OTHERWISE, THEY ARE LINEAR LENGTH MEASUREMENTS.  Frequently Used Alternatives: 1 degree = π/180 radians = 1.74x10-² radians Typical Values: None 
Angular Velocity Units Quantity: Angular Velocity (ω)[t-1] Input Variables:  BCDATA: VBC*, VBCT* OBS:   OSPIN FL:   RPSI** MOTN:   OMG0, RFREQX, RFREQY, RFREQZ, RPS**, SPIN, TFREQZ, TFREQY, TFREQZ    CGS: Radian/s 



MKS: Radian/s Engineering: Radian/s NOTES: * THESE ARE ONLY ANGULAR VELOCITIES WHEN USING CYLINDRICAL COORDINATES. ** INPUT QUANTITIES ARE SPECIFIED IN REVOLUTIONS/SEC, NOT RADIAN/SEC. Frequently Used Alternatives: 1 Degree/s = 1.74533x10-² radian/s 1 RPS = 6.283185 radian/s 1 RPM = 0.104720 radian/s Typical values: None 
Area Units Quantity: Area (A) [l2] Input Variables:  OBS: SAOBS  CGS: cm²  MKS: m² 1 m² = 1.0 x 104 cm² Engineering: ft² 1 ft² = 0.0929 m²  Frequently Used Alternatives: 1 in² = 6.4516 cm² 1 acre = 4046.9 m² I acre = 43,560 ft² Typical Values: None 
Density Units Quantity: Density  (ρ) [m/l³] Input Variables:  XPUT: RHOSQR, WNDSHR PROPS:   RHOF, RHOF2, RHOFS BCDATA: SELBE, SCLBCT FL: RHOREG, SCLRI, SCLREG PARTS:   PRHO 



     CGS: gm/cm³  MKS: kg/m³ 1 kg/m³ = 10-³ gm/cm³ Engineering: slug/ft³ 1 slug/ft³ = 515.4 kg/m³  Frequently Used Alternatives: 1 lbm/ft³ = 3.108x10-² slug/ft³ 1 lbm/in³ = 53.71 slug/ft³ Typical Values:   Water Air CGS (gm/cm³) 1.0 1.2x10-³ MKS (kg/m³) 1000 1.2 Engineering (slug/ft³) 1.94 2.33x10-³ 
Electric Charge Units Quantity: Electric Charge (q) [e] Input Variables:  PARTS: ECHRG  CGS: Statcoulumb  MKS: Coulomb 1 coulomb = 2.998 x 109 statcoulomb Frequently Used Alternatives: None Typical Values: None NOTE:  MOST PEOPLE USE THE MKS SYSTEM OF UNITS FOR ELECTROSTATIC AND ELECTROMAGNETIC PROBLEMS. IN THIS SYSTEM, THE STANDARD UNIT OF CHARGE IS THE COULOMB AND THE UNIT OF POTENTIAL IS THE VOLT. ELECTRIC FIELD INTENSITIES ARE MEASURED IN NEWTONS/COULOMB IN THE MKS SYSTEMS. When using the CGS systems of units, it is customary to express charge and potential in the “electrostatic” units of statvolt and statcoulumb, where 

1 coulumb = 2.998 * 10
9
 statcoulumb 

1 volt = 3.336*10
-
³ statvolt Electric forces are then, 

1 newton = 1 coulomb * volt/m = 10
5
 dyne 

1 dyne = 1 statcoulumb * statvolt/cm = 10
-5
 newton 



Electric Potential Units Quantity: Electric Potential (φ) [m•l²/t²/e] CGS: Statvolt  MKS: Volt 1 volt = 3.336 * 10-³ statvolt Frequently Used Alternative: None Typical Values: None NOTE: MOST PEOPLE USE THE MKS SYSTEM OF UNITS FOR ELECTROSTATIC AND ELECTROMAGNETIC PROBLEMS. IN THIS SYSTEM, THE STANDARD UNIT OF CHARGE IS THE COULOMB AND THE UNIT OF POTENTIAL IS THE VOLT. ELECTRIC FIELD INTENSITIES ARE MEASURED IN NEWTONS/ COULOMB IN THE MKS SYSTEMS.  When using the CGS systems of units, it is customary to express charge and potential in the “electrostatic” units of statvolt and statcoulumb, where 
1 coulumb = 2.998 * 10

9
 statcoulumb 

1 volt = 3.336*10
-3
 statvolt Electric forces are then, 

1 newton = 1 coulomb * volt/m = 10
5
 dyne 

1 dyne = 1 statcoulumb * statvolt/cm = 10
-5
 newton 

Energy Per Unit Volume Units Quantity: Energy per Unit Volume [m/l/t²] Input Variables:  OBS: OBSMRL, REMFOB, REVFOB  CGS: gm/cm/s² (Alias: erg/cm3)  MKS: kg/m/s² (Alias: Joule/m3) 1 kg/m/s² = 10 gm/cm/s² Engineering: slug/ft/s² 1 slug/ft/s² = 47.867 kg/m/s² Frequently Used Alternatives: None Typical Values: None 
Energy Units Quantity: Energy or Force Moment [m•l²/t²] Input Variables: None CGS: gm-cm²/s² (Alias: erg or dyne-cm)  MKS: kg-m²/s² (Alias: Joule or Newton-m) 1 kg-m²/s² = 1.0 x 1e7 gm-cm²/s² Engineering: slug-ft²/s² (Alias: ft-lbf) 1 slug-ft²/s² = 1.35546 kg-m²/s² 



 Frequently Used Alternatives: 1 BTU = 1055 Joule 1 BTU = 778.2 ft-lbf 1 calorie = 4.186 Joule 1 kilowatt-hr = 3.6 x 106 Joule Typical Values: None 
Force Units Quantity: Force (F)[m•l/t²] Input Variables: None CGS: gm-cm/s² (Alias: dyne)  MKS: kg-m/s² (Alias: Newton) 1 kg-m/s² = 1.0 x 105 gm-cm/s² Engineering: slug-ft²/s² 1 slug-ft/s2 = 4.448 kgm/s²  Frequently Used Alternatives: 1 poundal = 0.03108 lbf Typical Values: None 
Friction Coefficient Units Quantity: Friction Coefficient (μ/l) [m/l²/t] Input Variables:  PROPS: FRCOF OBS: OFRCOF  CGS: gm/cm²/s (Alias: poise/cm)  MKS: kg/m²/s (Alias: pa-s/m) 1 kg/s3 = 103 gm/s3 Engineering: slug/ft²/s 1 slug/s3 = 14.59 kg/s3 Frequently Used Alternatives: None Typical Values: None 
Heat Flux Units Quantity: Heat Flux (Φq) [m/t3] Input Variables: None 



CGS: gm/s3 (Alias: erg/s/cm²)  MKS: kg/s3 (Alias: Watt/m²) 1 kg/s3 = 103 gm/s3 Engineering: slug/s3 (Alias: ft-lbf/s/ft2) 1 slug/s3 = 14.59 kg/s3  Frequently Used Alternatives: 1 BTU/hr/ft² = 3.152 kg/s3 1 calorie/s/cm²= 4.184e4 kg/s3 Typical Values: None 
Heat Transfer Coefficient Units Quantity: Heat Transfer Coefficient (h) [m/t3/T] Input Variables:  XPUT:   CYCHT, HFLV1, HFLV2, HFLV3 BCDATA: HWALL1, HWALL2, HWAV1, HWAV2, HWAV3 OBS: HOBS1, HOBS2, HOBV1, HOBV2, HOBV3, HOBVT1, HOBVT2, HOBVT3, HTCOB BF: HBAF1, HBAF2, HBVF1, HBVF2, HBVF3  CGS: gm/s3/K (Alias: erg/s/cm²/K)  MKS: kg/s3/K  (Alias: Watt/m²/K) 1 kg/s3/K = 103 gm/s3/K Engineering: slug/s3/R  (Alias: ft-lbf/s/ft2/R) 1 slug/s3/R = 26.26 kg/s3/K  Frequently Used Alternatives: 1 BTU/hr/ft²/R = 5.678 kg/s3/K 1 calorie/s/cm²/K = 4.186e4 kg/s3/K Typical Values: None 
Length or Position Units Quantity: Length or Position [l] Input Variables: XPUT: TLEN LIMITS: XLPR, XRPR, YBKPR, YFPR, ZBPR, ZTPR PROPS: RSIZE BCDATA: FLHTBK, FLHTF, FLHTL, FLHTR, WBCL 



MESH: PX, PY, PZ, SIZE, SIZEX, SIZEY, SIZEZ OBS: OBSL, RAH, RAL, ROUGH, RSH, RSL, XH, XL, YH, YL, ZH, ZL, CTRNX, CTRNY, CTRNZ, CRFLX, CRFLY, CRFLZ, CRFLY, CRFLZ, TRNX, TRNY, TRNZ FL: FLHT, FRAH, FRAL, FRSH, FRSL, FXH, FXL, FYH, FYL, FZH, FZL, FTRNX, FTRNY, FTRNZ, XVR, YVR, ZVR, VALX, VALY, VALZ BF: BRA, BRAH, BRAL, BRS, BRSH, BRSL, BX, BXH, BXL, BY, BYH, BYL, BZ, BZH, BZL, BTRNX, BTRNY, BTRNZ TEMP: TRAH, TRAL, TRSH, TRSL, TXH, TXL, TYH, TYL, TXH, TXL, TTRNX, TTRNY, TTRNZ MOTN: RCX, RCY, RCZ, TMAGX, TMAGY, TMAGZ GRAFIC: XEA, YEA, ZEA, XAH, XAL, YAH, YAL, ZAH, ZAL, XC1, XC2, YC1, YC2, ZC1, ZC2, XS1, XS2, YS1, YS2, ZS1, ZS2, XP1, XP2, YP1, YP2, ZP1, ZP2, XV1, XV2, ZV1, ZV2, XF1, XF2, YF1, YF2, ZF1, ZF2, XLOC, YLOC, ZLOC, XEXL, XEXH, YEXL, YEXH, ZEXL, ZEXH, XOBSL, XOBSR PARTS: PDIAM, XLOCP, XPL, XPR, XPP, XPPL, XPPR, YLOCP, YPBK, YPF, YPP, YPPF, YPPBK, ZLOCP, ZPB, ZPT, ZPP, ZPPG, ZPPT  CGS: cm  MKS: m 1 m=100 cm Engineering: ft 1 ft=0.3048 m  Frequently Used Alternatives: 1 in = 0.08333 ft 1 yard = 0.9144 m 1 mile = 1609.3 m 1 mil = 10-3 i 1 micron = 1.0 x 10-6 m Typical Values: None 
Mass Flow Rate Units Quantity: Mass Flow Rate  [m/t] Input Variables: OBS: QSROBS  CGS: gm/s  MKS:  kg/s 1 kg/s=1000 gm/s Engineering: slug/s 1 slug/s=14.59 kg/s  



Frequently Used Alternatives: 1 kg/hr = 0.27778 gm/s 1 lbm/s = 0.45359 kg/s Typical Values: None 
Mass Source Per Unit Area Units Quantity: Mass Source per Unit Area [m/l²/t] Input Variables:  SCALAR: DFTSRF  CGS: gm/cm²/s  MKS: kg/m²/s 1 kg/m²/s = 10-3 gm/cm²/s Engineering: slug/ft²/s 1 slug/ft²/s = 157.045 kg/m²/s Frequently Used Alternatives: None Typical Values: None 
Mass Source per Unit Volume Units Quantity: Mass Source per Unit Volume [m/l3/t] Input Variables:  SCALAR: DFTFOB  CGS:  gm/cm3/s  MKS:  kg/m3/s 1 kg/m³/s = 10-3 gm/cm3/s Engineering:  slug/ft3/s 1 slug/ft3/s = 515.24 kg/m3/s Frequently Used Alternatives: None Typical Values: None 
Mass Units Quantity: Mass (m) [m] Input Variables: None CGS: gm  MKS: kg 1 kg=103 gm Engineering: slug 1 slug=14.59 kg 



 Frequently Used Alternatives: 1 lbm= 0.454 kg 1 oz = 0.0625 lbm Typical Values: None 
Momentum or Force Impulse Units Quantity: Momentum of Force Impulse [m•l/t] Input Variables: None CGS: gm-cm/s  (Alias: dyne-s)  MKS: kg-m/s  (Alias: Newton-s) 1 kg-m/s=1.e5 gm-cm/s Engineering: slug-ft/s  (Alias: lbf-s) 1 slug-ft/s=4.448 kg-m/s Frequently Used Alternatives: None Typical Values: None 
Power per Unit Mass Units Quantity: Power per Unit Mass [l²/t3] Input Variables: PROPS:  POFL1, POFL2  CGS:  cm²/s3 (Alias: erg/s/gm)  MKS:  m²/s3   (Alias: Watt/kg) 1 m²/s3 = 1.e4 cm²/s3 Engineering:  ft²/s3   (Alias: ft-lbf/s/slug) 1 ft²/s3 = .09290 m²/s3 Frequently Used Alternatives: None Typical Values: None 
Power Units Quantity: Power [m•l²/t3] Input Variables: BCDATA: POBC, POBCT OBS: POBS  CGS: gm-cm²/s3 (Alias: erg/s)  MKS: kg-m²/s3  (Alias: Joule/s or Watt) 1 kg-m²/s3 = 1.e7 gm-cm²/s3 



Engineering: slug-ft²/s3 (Alias: ft-lbf/s) 1 slug-ft²/s3 = 1.35546 kg-m²/s3  Frequently Used Alternatives: 1 BTU/hr = 0.293 kg-m²/s3 1 horsepower = 745.7 kg- m²/s3 1 calorie/s = 4.186 kg- m²/s3 Typical Values: None 
Pressure Units Quantity: Pressure (p) [m/l/t²] Input Variables: PROPS: PCAV, RCSQL*, RCSQV* BCDATA: PBC, PBCT PCAP: PCMX OBS: OPCAP FL: PREG, PRESI, PVOID, PVRD, VALP  CGS: gm/cm/s²  (Alias: dyne/cm²)  MKS: kg/m/s²    (Alias: N/m²or Pa) 1 kg/m/s² = 10 gm/cm/s² Engineering: slug/ft/s²   (Alias: lbf/ft²) 1 slug/ft/s² = 478.8 dyne/cm² 1 slug/ft/s² = 47.88 Pa  Frequently Used Alternatives: 1 psi = 1 lbf/in² = 144 lbf/ft² 1 bar = 1.0 x 106 dyne/cm² 1 Torr = 133.3 Pa 1 ft (H2O) = 2989 Pa 1 cm (mercury) = 1333 Pa NOTE: * RECIPROCAL PRESSURES [L•T2/M]. Typical Values:  1 Atmosphere CGS (dyne/cm2) 1.013 x 106 MKS (Pa) 1.013 x 105 Engineering (lbf/ft2) 2116 



Radiation Heat Transfer Coefficient Units Quantity: Radiation Heat Transfer Coefficient [m/t3/T4] Input Variables: XPUT: HFLE1, HFLE2, HFLE3 OBS: HOBE1, HOBE2, HOBE3  CGS: gm/s3/K^4  (Alias: erg/s/cm²/K^4)  MKS: kg/s3/K^4  (Alias: Watt/m²/K^4) 1 kg/s3/K^4 = 103 gm/s3/K^4 Engineering: 1 slug/s3/R^ 4 1 slug/s3/R^4 = 153.2 kg/s3/K^4 Frequently Used Alternatives: None Typical Values: None 
Rate Units Quantity: Rate [1/t] Input Variables: XPUT: EPSI PROPS:   MUC1, MUCTST, MUTHK, MUTHN0, TSDRG SCALAR: DFCTW CHM:   ARATE PARTS:   RATE   CGS: 1/s MKS: 1/s Engineering: 1/s Frequently Used Alternatives: None Typical Values: None 
Reciprocal Length Units Quantity: Rate [1/l] Input Variables: OBS:   OSPOR    CGS: 1/cm 



MKS: 1/m Engineering: 1/ft Frequently Used Alternatives: None Typical Values: None 
Specific Energy Dissipation Rate Units Quantity: Specific Energy Dissipation Rate (ε) [l²/t3] Input Variables: BCDATA: DRKEBC, DTKBCT   CGS: cm²/s3 (Alias: erg/gm/s)  MKS: m²/s3  (Alias: Joule/kg/s) 1 m²/s³ = 1.e4 cm²/s3 Engineering: ft²/s3 1 ft²/s3 = 0.0929 m²/s3  Frequently Used Alternatives: 1 BTU/lbm/hr = 0.6461 m²/s3 1 ft-lbf/lbm/s = 2.989 m²/s3 1 calorie/gm/s = 4.186 x 103 m²/s3 Typical Values: None 
Specific Energy Units Quantity: Specific Energy [l2/t2] Input Variables: PROPS:   CLHT, CLHT1, CLHV1 BCDATA: TKEBC, TKEBCT FL:   TKEI, TKEREG  CGS:  cm²/s² (Alias: erg/gm)  MKS:  m²/s²  (Alias: Joule/kg) 1 m²/s² = 1.e4 cm²/sv Engineering:  ft²/s²    (Alias: ft-lbf/slug) 1 ft²/s² = 0.0929 m²/s²  Frequently Used Alternatives: 1 BTU/lbm = 2326 m²/s² 



1 ft-lbf/lbm = 2.989 m²/s² 1 calorie/rm = 4.186 x 103 m²/s² Typical Values: Latent Heat of Water  Fusion Evaporation CGS (cm²/s²) 3.35 x 109 2.50 x 1010 MKS (m²/s²) 3.35 x 105 2.50 x 106 Engineering (ft²/s²) 3.60 x 106 2.691 x 107 
Specific Heat Units Quantity: Specific Heat (Cv) [l²/t²/T] Input Variables: PROPS:  CV1, CVS1, CV2, RF2 CGS: cm²/s²/K (Alias: erg/gm/K)  MKS: m²/s²/K  (Alias: Joule/kg/K) 1 m²/s²/K = 1.e4 cm²/s²/K Engineering: ft²/s²/R   (Alias: ft-lbf/slug/R) 1 ft²/s²/R = 0.16721 m²/s²/K  Frequently Used Alternatives: 1 BTU/lbm/R = 4187 m²/s²/K 1 calorie/gm/K = 4186 m²/s²/K Typical Values:   Water Air CGS (cm²/s²/K) 4.187 x 107 7.18 x 106 MKS (m²/s²/K) 4187 718 Engineering (ft²/s²/R) 2.504 x 104 4294 
Speed Units Quantity: Speed (u) [l/t] Input Variables: BCDATA: UBC, UBCT, VBC*, VBCT*, WBC, WBCT OBS: UTOBS, VTOBS, WTOBS FL: UI, UREG, VI, VREG, WI, WREG BF: KBAF1** GRAFIC: VMAX PARTS:   ULOCP, UPP, VLOCP, VPP, WLOCP, WPP 



  CGS: cm/s  MKS: m/s 1 m/s = 100 cm/s Engineering: ft/s 1 ft/s = 0.3048 m/s *NOTE: VBC AND VBCT ARE ANGULAR VELOCITIES IF USING CYLINDRICAL COORDINATES. **NOTE: KBAF2 IS DIMENSIONLESS. Frequently Used Alternatives: 1 in/s = 2.54 cm/s 1 km/hr = 0.2778 m/s 1 mi/hr = 1.467 ft/s = 0.447 m/s 1 knot = 0.5144 m/s Typical Values: None 
Surface Tension Coefficient Units Quantity: Surface Tension Coefficient (σ) [m/t2] Input Variables: PROPS: SIGMA   CGS: gm/s²  (Alias: dyne/cm or erg/cm²)  MKS: kg/s²   (Alias: Newton/m or Joule/m²) 1 kg/s² = 10³ gm/s² Engineering: slug/s²  (Alias: lbf/ft) 1 slug/s² = 14.59 kg/s² Frequently Used Alternatives: None Typical Values:  Air-Water Water-Oil CGS (gm/s²) 73 20 MKS (kg/s²) 7.3 x 10-² 2.0 x 10-² Engineering (slug/s²) 5 x 10-3  1.37 x 10-3 
Temperature Units Quantity: Temperature (T) [T] Input Variables: XPUT:   TQSR, CYCT PROPS: CLTP, MUTMP2, TEUT, THEXF*, THEXF2*, TL1, TMELT, TNIYAM, TS1, TSTAR, TV1 



BCDATA: TBCD, TBC, TBCT OBS: OBSMT, TMFOB, TOBI, TVFOB, TWOBS FL: TVRD TEMP: TEMPI, TREG, TVOID, TWREG   CGS: Degrees Kelvin (K)**  MKS: Degrees Kelvin (K)**  Engineering: Degrees Rankine (R)** 1° Rankine = 0.5556° Kelvin TK = 0.5556 TR NOTES: *QUANTITIES ARE RECIPROCAL TEMPERATURES. **FOR INCOMPRESSIBLE FLOW PROBLEMS ONLY TEMPERATURE DIFFERENCES FROM A REFERENCE TEMPERATURE HAVE MEANING, AND CENTIGRADE (CELSIUS) OR FAHRENHEIT MAY BE USED IN PLACE OF KELVIN OR RANKINE. Frequently Used Alternatives: Centigrade or Celsius 1° Celsius = 1° Kelvin  TC = TK – 273.15 Fahrenheit 1° Fahrenheit = 0.5556° Kelvin  1° Rankine = 1° Fahrenheit  TF = 1.8 TK – 459.7  TF = TR – 459.7  TF = 1.8 TC + 32 Typical Values:  Water at 1 Atmosphere  Melting Point Boiling Point Kelvin 273.15 373.15 Rankine 491.7 671.1 Celsius 0 100 Fahrenheit 32 212 
Temperature-Dependent Surface Tension Coefficient Units Quantity: Temperature-Dependent Surface Tension Coefficient [m/t²/T] Input Variables: PROPS:   CSIGMA  CGS: gm/s²/K   (Alias: dyne/cm/K or erg/cm²/K)  MKS: kg/s²/K    (Alias: Newton/m/K or 1 kg/s²/K = 103gm/s²/K 



Joule/m²/K) Engineering: 1 slug/s²/R   (Alias: lbf/ft/R) 1 slug/s²/R = 26.26 kg/s²/K Frequently Used Alternatives: None Typical Values: None 
Thermal Capacity per Unit Volume Units Quantity: Thermal Capacity per Unit Volume [m/l/t²/T] Input Variables: OBS:  OBSMRC, RCOBS   CGS: gm/cm/s²/K   (Alias: erg/cm3/K)  MKS: kg/m/s²/K     (Alias: Joule/m3/K) 1 kg/m/s²/K = 10 gm/cm/s²/K Engineering: slug/ft/s²/R    (Alias: ft-lbf/ft3/R) 1 slug/ft/s²/R = 86.18 kg/m/s²/K  Frequently Used Alternatives: 1 BTU/ft3/R = 778.2 lbf/ft²/R 1 BTU/ft3/R = 6.706 x 104 kg/m/s²/K 1 calorie/cm3/K = 4.186 x 106 kg/m/s²/K Typical Values:   Aluminum Steel Sand CGS (gm/cm/s2/K) 2.425 x 107 3.689 x 107 1.1 x 107 MKS (kg/m/s2/K) 2.425 x 106 3.689 x 106 1.1 x 106 Engineering ( slug/ft/s2/R) 2.814 x 104 4.280 x 104 1.3 x 104 
Thermal Capacity Units Quantity: Thermal Capacity [m•l²/t²/T] Input Variables: OBS:  MOBS  CGS: gm-cm²/s²/K  (Alias: erg/K)  MKS: kg-m²/s²/K    (Alias: Joule/K) 1 kg-m²/s²/K = 1.e7 gm-cm²/s²/K Engineering: slug ft²/s²/R   (Alias: ft-lbf/R) 1 slug-ft²/s²/R = 2.440 kg-m²/s²/K  



Frequently Used Alternatives: 1 BTU/R = 778.2 ft-lbf/R 1 BTU = 1899 kg=m²/s²/K 1 calorie/K = 4.186 kg-m²/s²/K 
Thermal Conductivity Units Quantity: Thermal Conductivity (K) [m•l/t3/T] Input Variables: PROPS: THC1, THCS1, THC2 OBS:   KOBS  CGS: gm-cm/s3/K   (Alias: erg/s/cm/K)  MKS: kg-m/s3/K    (Alias: Watt/m/K) 1 kg-m/s3/K = 1.e5 gm-cm/s3/K Engineering: slug-ft/s3/R 1 slug-ft/s3/R = 8.005 kg-m/s3/K  Frequently Used Alternatives: 1 BTU/hr/ft/R = 1.7305 kg-m/s3/K 1 calorie/s/cm/K = 418.4 kg-m/s3/K 1 calorie/K = 4.186 kg-m²/s²/K Typical Values:  Air Water Aluminum CGS (gm-cm/s3/K) 3000 6.5 x 104 2.04 x 107 MKS (kg-m/s3/K) .03 0.65 204.2 Engineering (slug-ft/s3/R) 3.8 x 10-3 8.12 x 10-3 25.5 
Time Units Quantity: Time [t] Input Variables: XPUT: APLTDT, CYCDR, DELT, DELTR, DRMAN, DTMIN, HPLTDT, PLTDT, SLDDT, SPRTDT, TEDIT, TAPLTD, TDTMAX, THPLTD, TPLTD, TREST, TSPRTD, TWFIN PROPS: CAVRT, DFCOF BCDATA: TIMBCT OBS: TOBS  



CGS: second(s) MKS: second(s) Engineering: second(s)  Frequently Used Alternatives: 1 minute = 60 seconds 1 hour = 3600 seconds 1 day = 8.64 x 104 seconds 1 year = 3.1536 x 107 seconds Typical Values: None 
Valve Coefficient Units Quantity: Valve Coefficient (C) [ 7

2

1

2

l

m ] Input Variables: FL: VALC      CGS: cm3 /cm gm  (Alias: cm3/s/ 2/dyne cm   ) MKS: m3 /m kg  (Alias: m3/s/ Pa ) Engineering: ft3 /ft slug   (Alias: ft3/s/ 21 /fb ft   ) Frequently Used Alternatives: None Typical Values: None 
Viscosity Units 
Dynamic Viscosity Units Quantity: Viscosity (Dynamic) (μ) [m/l/t] Input Variables: PROPS: MUI, MU1, MU2, MUC3, MUS, CMF SCALAR: CMSC  



CGS: gm/cm/s (Alias: poise) 1 kg/m/s = 10 gm/cm/s MKS: kg/m/s (Alias: Pa-s) 1 slug/ft/s = 478.802 gm/cm/s Engineering: slug/ft/s 1 slug/ft/s = 47.8802 kg/m/s  Frequently Used Alternatives: 1 lbf-s/ft² = 1slug/ft/s 1 lbm/ft/hr = 8.6336 x 10-6 slug/ft/s Typical Values:  Water Air CGS (gm/cm/s) 10-² 1.7 x 10-4 MKS (kg/m/s) 10-3 1.7 x 10-5 Engineering (slug/ft/s) 2.1 x 10-5 3.6 x 10-7 
Kinematic Viscosity Units Quantity: Viscosity (Kinematic)  (ν) [l²/t] Input Variables: PARTS:   NUP Input Variables: CGS: cm²/s  MKS:  m²/s 1 m2/s = 1.e4 cm²/s Engineering:  Ftv/s 1 ft²/s = 0.0929 m²/s  Frequently Used Alternatives: 1 in²/s = 6.4516 cm²/sec Typical Values:  Water Air CGS (cmv/s) 10-² 0.15 MKS (m²/s) 1.0 x 10-6 1.5 x 10-5 Engineering (ft²/s) 1.1 x 10-5 1.6 x 10-4 
Volume Flow Rate Units Quantity: Volume Flow Rate (Q) [l3/t] 



Input Variables: None CGS: cm3/s  MKS: m3/s 1 m3/s = 1.e6 cm3/s Engineering: ft3/s 1 ft3/s = 2.83x10-² m3/s  Frequently Used Alternatives: 1 U.S. gal/min = 6.309 x 10-5 m3/s 1 U.S. gal/hr = 1.052 cm3/s 1 in3/s = 16.39 cm3/s Typical Values: None 
Volume Units Quantity: Volume (V) [l3] Input Variables: FL: VLIN PARTS:  PVOL   Frequently Used Alternatives: 1 in3 = 5.787 x 10-4 ft3 1 in3 = 16.39 cm3 1 U.S. gal = 3.785 x 10-3 m3 1 U.S. gal = 231 in3 1 Imperial gallon = 4.546 x 10-3 m3 1 Imperial gallon = 277.42 in3 Typical Values: None 
Units Summary The table below gives a summary of unit values: Quantity Dimensional Group Common CGS Units Acceleration (g) [l/t²] cm/s² Angle (θ) [] radian Angular Velocity (ω) [t-1] radian/s Area (A)  [l²]  cm² Density (ρ) [m/l3] gm/cm3 



Electric Charge [e] statcoulomb Electric Potential [m•l²/t²/e] statvolt Energy or Force Moment [m•l²/t²] erg Energy per Unit Volume [m/l/t²] erg/cm3 Force (F) [m•l/t²] dyne Friction Coefficient (μ/l) [m/l²/t] poise/cm Heat Flux (Φq) [m/t3] erg/s/cm² Heat Transfer Coefficient (h) [m/t3/T] erg/s/cm²/K Length or Position [l] cm Mass (m) [m] gm Mass Flow Rate ( ) [m/t] gm/s Mass Source per Unit Area [m/l²/t] gm/cm²/s Mass Source per Unit Volume [m/l3/t] gm/cm3/s Momentum or Force Impulse [m•l/t] dyne-s Power [m•l²/t3] erg/s Power per Unit Mass [l2/t3] erg/s/gm Pressure (p) [m/l/t²] dyne/cm² Radiation Heat Transfer Coefficient [m/t3/T4] erg/s/cm²/K4 Specific Energy [l²/t²] erg/gm Specific Energy Dissipation Rate (ε) [l²/t3] erg/gm/s Specific Heat (Cv) [l²/t²/T] erg/gm/L Speed (u) [l/t] cm/s Surface Tension Coefficient (σ) [m/t²] dyne/cm Temperature (T) [T] °K Temperature-Dependent Surface Tension Coefficient [m/t2/T] dyne/cm/K Thermal Capacity [m•l²/tr²/T] erg/K Thermal Capacity per Unit Volume [m/l/t²/T] erg/cm3/K 
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Chapter 12 - Troubleshooting 
Diagnostic Messages This section includes descriptions of the most common diagnostic messages produced by FLOW-3D. It also includes suggestions for dealing with common difficulties that you may encounter. Error and warning messages from the preprocessor are written into the files prperr and prpout. Both files are accessible through the GUI’s Diagnostics menu. Preprocessor Errors (prperr file) contains a listing of only error and warning messages; it is empty if none have been generated. Preprocessor Summary (prpout file) contains a complete listing of the model setup data, including the error and warning messages, variable names (including those not explicitly defined in the prepin file), and various diagnostics like open areas at mesh boundaries, initial open and fluid volumes in mesh and so on. The solver creates two diagnostics files, hd3msg and hd3out. The former is a concise description of the progress of the solution and can be viewed through Diagnostics > Solver Messages. The latter is a more detailed listing of various quantities, accessible via Diagnostics > Solver Summary. When a problem occurs during the simulation, a brief message is written into the solver message file and more descriptive information written into the solver summary file. 
The Mentor The Mentor is a run-time diagnostic feature that watches the progress of the solution and advises users of ways in which the solution efficiency might be improved. A simple type of fuzzy logic is used by the Mentor to sense when certain patterns occur in the solution process. The patterns it looks for are based on information already made available by the solver, so the Mentor requires very little overhead to do its job. When the Mentor detects a situation that might be improved with a change in one or more parameters it informs the user with a message having the title "Mentor Tip." These messages appear in the solver window of the GUI, as well as in the hd3msg and hd3err files. Considerable care has been taken to insure that the number of messages is kept to a minimum. Mentor Tips may consist of a single suggestion or a set of several suggestions. Users may choose to ignore the suggestions, however, they are based on a large body of experience and in most cases it would be to the user's advantage to act on the suggestions presented. The Mentor is controlled by the Mentor options provided in the Global tab. As the name suggests the No Mentor Help option disables the Mentor. Choosing the Offer suggestion option merely provides writes out Mentor tips. Finally, selecting the Offer suggestions and take action option will cause the Mentor to write out Mentor tips as well as implement some of its tips. 
Preprocessor Messages Preprocessor messages are as follows: 
Message: Open areas mismatch at inter-block boundaries of all blocks Message Text: Open area mismatch at inter-block boundaries of all blocks as % of total open area at these mesh boundaries = AreaErr 



Status: Informative Explanation: The preprocessor calculates the value of open area at the inter-block boundaries. If both the mesh blocks do not have the same cell size, then the open area that is resolved by each mesh block may be different. This difference in the resolved open area for each mesh block is printed out. However, this difference is printed out as a percentage of the total open area at that boundary. Suggested Actions: None needed 
Message: Open areas between blocks differ by more than 5% Message Text: Open areas between blocks B1, B2 differ by more than 5% area_diff = ADIFF percent. Try improving resolution or reduce the number of blocks. Status: Warning Explanation: Preprocessor prints a warning message if the difference between the calculated open areas at an inter-block boundary from two different mesh blocks is more than 5% of the total open area at the inter-block boundary.  Suggested Actions: Try to reduce the difference between the cell sizes of each block. Ideally the same cell size across the mesh blocks would give minimum open area error. One can also try to resolve the open area with grid lines. 
Message: No open area at boundary Message Text: Warning: No open area at B boundary Status: Warning Explanation: If the boundary condition is set to either pressure or velocity, and the preprocessor does not recognize the presence of open area at the boundary, then it prints the above warning message. Suggested Actions: First check the geometry to see if there is any obvious obstruction to the inlet. The preprocessor results file (prpgrf) can be used for this purpose. If a hole is cut to create an inlet at a boundary, the dimensions of the hole should go beyond the boundary. For example, if the hole is cut in X-MIN boundary then it should be extended at least 2 cells distance along the negative-x direction. This is because FLOW-3D creates extra layer of cells beyond the boundary, called the ghost cell. The hole should extend through these ghost cells in order for the boundary condition to be imposed. 
Message: Rapid shrinkage model is incompatible with multiple mesh blocks Message Text: Rapid shrinkage model is incompatible with multiple grids ISHRNK reset to 0 Status: Warning Explanation: A warning message is printed if the rapid shrinkage model is activated (ISHRNK=2) in a problem containing more than one mesh block. The rapid shrinkage model is then turned off and the calculation continues. Suggested Actions: Switch to a single mesh block 



Solver Messages Solver messages are as follows: 
Message: Convective flux exceeded stability limit Message Text: Convective flux exceeded stability limit. At t=T, cycle = C, iter=I, delt=DT. Restarting cycle with smaller time step  Status: Warning Explanation: Fluid fraction advection exceeded the Courant stability limit at the end of cycle C, i.e., the fluid was advected through a distance greater than CON•Δx, where CON is a safety factor, usually 0.45, and Δx is the cell size. This occurs when fluid undergoes a large acceleration during the cycle, for example, when fluid jets after hitting a wall. FLOW-3D corrects for this by backing up and repeating the time cycle with a smaller time-step size, and therefore, there is no loss of accuracy. After reducing the time-step, the calculation usually progresses without difficulty. Suggested Actions: Don't worry if a few of these messages occur. If the message appears repeatedly and there is no explainable acceleration going on, make sure the AVRCK is set to a negative number, e.g., -2.1. Check your boundary and initial conditions for any obvious physical inconsistencies. Multiple convective failures may happen in poorly resolved flows and/or in cells with bad aspect ratios, especially in flows that involve free surfaces. If nothing helps, please contact Flow Science. Related Messages: F convection stability limit exceeded x F convection stability limit exceeded y F convection stability limit exceeded z Other Comments: These related messages indicate the direction for the advection failure. They also indicate the cell face where the failure occurred, along with the area at the face and the adjacent volume fractions. This information can help you determine if the area-to-volume ratio is contributing to the problem. You should also check the mesh for bad aspect ratios where the problem is occurring. 
Message: Excessive Convection Failures - Calculation Terminated Message Text: Excessive convection failures - calculation terminated Status: Fatal Explanation: The solver quits because of too many convective flux stability limit failures. The maximum allowable number of failures is set by variable NCFLMX in namelist LIMITS. Suggested Actions: Look at the individual failure messages to determine the cause of the convective failures (also see suggested actions for Convective flux exceeded stability limit). If problems persist, please contact Flow Science.  
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Message: Pressure Iteration did not Converge in ITMAX = IMAX Iterations Message Text: Pressure iteration did not converge in Itmax=IMAX, iterations  at t=T, cycle=C, block=B, epsi=E, resid=R, delt=DT, nocon=N or Pressure iteration did not converge in Itmax=IMAX, iterations  at t=T, cycle=C, block=B, epsi=E resid=R, delt=DT Restarting cycle with smaller time step Status: Warning Explanation: At cycle C, the pressure did not converge to the current value of the convergence criterion EPSI after the Maximum allowable number of iterations.  Depending on the situation, the solver may take different actions. 1. If the maximum residual R is greater than twice the value of the convergence criterion E, then a cycle restart is performed with the time-step size cut in half. If pressure convergence is still not reached within ITMAX iterations then another cycle restart with the time step size cut in half is attempted if: 
� the maximum residual R is still greater than 2.0.E.  
� the new residual is less than 90% of the residual in the previous attempt. Consecutive cycle restarts may occur only three times in a given time step, after which the simulation proceeds to the next time step. Three cycle restarts result in the time step reduced from its value during the first failure by a factor of eight, and is usually sufficient for the solution to recover from a difficult situation. 2. When pressure convergence fails in ITMAX iterations but the maximum residual is less than 2.0.E, then no cycle restart is done; the simulation proceeds to the next time step. In either case, when convergence is not reached in ITMAX iterations, the convergence failure counter NOCON is incremented by one only if the residual R is greater than 2.0.E. Suggested Actions: This situation can occur at the beginning of a run because of unrealistic initial conditions. If convergence failures happen and the solution later recovers, there usually is nothing to worry about. If the solution is not able to recover, try adjusting your initial conditions to help the solver get started. If convergence problems happen during the middle of the run, it may indicate that the flow field is undergoing a substantial change in a short period of time (for example, if the flow field was reversing in a shaking tank, or entering a narrow passage). The convergence criterion (epsi) and the maximum residual (max resid) are plotted in the Simulate tab of the GUI (these are also listed in file hd3err.dat). If these values are close, even though the solution did not converge, most likely there is no serious loss of accuracy. If the residual is not close to the convergence criterion or if the solution is not able to recover, it indicates that some action is needed. First, check to see that the convergence parameter Multiplier for dynamically adjusted convergence criteria (Model Setup > Numerics > Pressure iteration > Convergence Controls > Multiplier for dynamically adjusted convergence criteria) is not too small. Typically, its value is 1.0. Second, if the flow field is undergoing rapid change, it 



may be necessary to increase the Maximum allowable number of iteration (Model Setup > Numerics > Pressure iteration > Convergence Controls > Maximum number of iteration). Pressure iteration problems can result from cells with large area/volume ratios, so setting AVRCK to a negative number (e.g., -2.1) in OBS may help. Pressure iteration problems also arise from bad cell aspect ratios. Correct these if possible. Using a Line implicit pressure iteration option (Model Setup > Numerics > Pressure iterations > Implicit solver options > line implicit) may help if the mesh has bad cell aspect ratios (use x-direction line implicit for cells narrow in the x-direction, etc.).  If problems persist, please contact Flow Science. 
Message: Excessive Iteration Failures - Calculation Terminated Message Text: Excessive Iteration Failures - Calculation Terminated Status: Fatal Explanation: The solver quits because there were too many pressure iteration failures. The maximum allowable number of iteration failures is set by Model Setup > Numerics > Pressure iterations > Convergence Controls > Maximum number of iteration failures allowed. Suggested Actions: Try to determine what is causing the pressure iteration failures. If they are happening at the beginning of the solution, modify the initial conditions, increase Maximum allowable number of iterations (Model Setup > Numeric > Pressure iteration > Convergence Controls > Maximum number of iteration), or increase Maximum number of allowable iteration failures (Model Setup > Numerics > Pressure iterations > Convergence Controls > Maximum number of iteration failures allowed). If they are happening when there is dramatic change in the flow field, increase Maximum allowable number of iterations or Maximum number of allowable iteration failure, or restart the calculation to reset the iteration failure counter. Otherwise, evaluate the mesh for large area/volume ratios or bad aspect ratios. Also, some geometry configurations are difficult for the pressure iteration solver (for example, a serpentine geometry where adjacent cells are not necessarily connected), and in these cases, it is necessary to increase ITMAX. Using a limited compressibility model by setting Compressibility in the Model Setup > Props > Compressibility > fluid1 table. It may help reduce convergence problems (as a guideline, use the minimum of (.1/Pmax) or (.1/(density•Umax²)) as the value for Compressibility, where Pmax is the maximum pressure in the solution and Umax is the maximum velocity). If problems persist, please contact Flow Science. 
Message: Pressure Iteration Diverging - Restarting Cycle with Smaller Omega and Time-
Step Size Message Text: Pressure Iteration Diverging - Restarting Cycle With Smaller Omega and Time-Step Size  Present over-relaxation factor omega=Ω Present time-step size delt=DT Status: Warning 
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Explanation: The pressure iterations are diverging due to excessive over-relaxation. The solver detects this situation, and if it occurs, OMEGA (Model Setup > Numerics > Pressure iterations > Convergence Controls > Over relaxation factor) is reduced to an average of 1.0 and the current value, if OMEGA > 1.0 or IMPMOB=0, and to an average of 0.1 and the current value, if IMPMOB=1. The cycle is then repeated, so there is no loss of accuracy. Suggested Actions: None needed 
Message: Excessive Pressure Convergence Failures - Calculation Terminated Message Text: Excessive Pressure Convergence Failures - Calculation Terminated Status: Fatal Explanation: The solver quits because of too many consecutive over-relaxation failures. The maximum allowable number of consecutive over-relaxation failures is set by variable NCFLMX in LIMITS. Consecutive over-relaxation failures usually indicate that the solution is becoming unstable. Suggested Actions: Check your initial and boundary conditions for physical inconsistencies. Also, make sure fluid properties are consistent. If problems persist, please contact Flow Science. 
Message: Time-step size < dtmin Message Text: Time-step size < dtmin Status: Fatal Explanation: The solver quits because the time-step size fell below the Minimum time step. The Minimum time step defaults to 1.e-4 times the initial time-step size, but it can also be set in the GUI (Model Setup > Numerics > Time-step control > Minimum time step). The time-step size during the run is set by the solver in one of two ways. First, the time-step size must always satisfy stability. Second, if the time-step control is set to Stability and Convergence (the default), the time-step size is cut if the number of pressure iterations exceeds Maximum number of iterations before time step is reduced (Model Setup > Numerics > Pressure iterations > Convergence Controls > Maximum number of iterations before time step is reduced). This is done in an attempt to optimize the runtime by balancing time-step size and pressure iteration count; however, sometimes the time-step size is cut excessively. Suggested Actions: First of all, look at the "stability limit & time-step size" run time plot in the Simulate tab (also listed in the solver message file hd3msg.dat). If the time-step size is consistently smaller then the stability limit and the solver is iterating a lot, it may be that the AUTOT setting is reducing the time step. Your options are to set time step control to Stability, or to increase Maximum number of iterations before time step is reduced, or to ease up on the convergence criterion Maximum allowable number of iterations or Maximum number of allowable iteration failures. If the stability limit is small, it may be that the value of Minimum time step is not reasonable. If the initial time-step size is too large, sometimes the value of Minimum time step is simply too large. Reset Minimum time step if necessary. If the stability limit is so small that the problem will not run in a reasonable time, it may be necessary to make modifications to run the problem more efficiently, for example by switching to an implicit solver. Most of the explicit 

mailto:support@flow3d.com?subject=FLOW-3D%20Tech%20Support


stability limits are proportional to the cell size (the smaller the cell size, the smaller the stability limit), but some stability limits are proportional to the square of the cell size. The solver output file (hd3out.dat) indicates the cell where the minimum stability limit occurs. If possible, modify the mesh to ease up on the stability limit. Also, make sure that AVRCK is set to a negative number (e.g., -2.1) in OBS. If heat transfer or viscous stresses are limiting the stability limit, and that stability limit is much smaller than the others (listed in hd3out.dat), consider using an implicit solution method (Heat Transfer, Viscous stress, Surface tensions). (See also the list of stability codes below). 
Common Problems Descriptions of common problems are as follows: 
Problem: My results are not symmetric and I think they should be Explanation: Some problems seem like they should be symmetric, but in reality are physically unstable, for example, flow over a cylinder at high values of the Reynolds number or a vertical jet as in a fountain. In these cases, the slight asymmetry in the standard pressure iteration scheme (which processes left to right, bottom to top) may set off the physical instability. If the convergence criterion were infinitely small, this would not happen. This problem is exacerbated by coarse resolution. To help eliminate numerical asymmetry tighten the convergence criterion, improve resolution, or use the line implicit pressure iteration scheme (Model Setup > Numerics > Pressure iterations > implicit solver options > line implicit) in the direction for which you wish to maintain symmetry. 
Problem: My job is still running, but I need information now Explanation: While the solver is running, you can click on the Analyze tab and generate custom plots. Before doing this, click the Spatial Data button in the Simulate tab, which will write the current solution data to the solution file (flsgrf.dat). 
Problem: The tips and corners of my obstacles have been cut off in my plots Explanation: This is a consequence of how plotted obstacles are reconstructed from area and volume fractions. For example, at a closed mesh boundary the drawing routine can't distinguish between obstacle areas and wall areas. In such cases, the obstacle surface is drawn normal to the wall boundary. This can be visually improved by adjusting the grid so that cells containing obstacle-wall intersections contain a very small volume of obstacle. If obstacle corners are clipped in the interior of the grid, it is usually because the corner does not intersect a grid line. Here again, the remedy for better looking plots is to make small adjustments in the location of the grid lines (or obstacles). Finally, strong three-dimensional variations in area fractions can confuse the two-dimensional obstacle drawing algorithm. There is little remedy for these cases, short of increased grid resolution. However, these plotting problems are only cosmetic; the solution algorithm uses the actual area/volume fractions. 
What Do the Stability Codes Mean? These codes are listed after the stability time-step limit in the Simulate tab and the solver message and summary files, hd3msg and hd3out, respectively. 



See Theory Chapter, Section Stability Considerations for a detailed explanation on how stability criteria are calculated. Explanation: The stability codes used by the solver are listed below. These stability codes inform the user about which physical model is controlling the size of the time step. A limit on the maximum size of the time step is typically required by explicit numerical approximations of the respective terms in the dynamic equations to maintain accuracy of the solution. 
Stability Codes Code Description cd Thermal conduction in fluid and in solid components cr Coriolis force terms in the fluid momentum equations, used by the non-inertial reference frame model cx Explicit fluid convection in the x-direction cy Explicit fluid convection in the y-direction cz Explicit fluid convection in the z-direction sx Implicit fluid convection in the x-direction, defined by the motion of free surface sy Implicit fluid convection in the y-direction, defined by the motion of free surface sz Implicit fluid convection in the z-direction, defined by the motion of free surface df Mass fluxes computed in the drift-flux model es Elastic stress model fd Diffusion of two fluids, used in two-fluid flows without sharp interfaces fs Gravity waves on free surface. ht Heat transfer between fluid and walls and voids pr Particle transport model rb Used to maintain stability of the coupling of the fluid flow and rigid body motion, used by the rigid body dynamics model sc Scalar diffusion ss Sediment scour model st Used to maintain stability of the capillary waves in the surface tension model vs Viscous and turbulent diffusion na None of the above limits apply 
Frequently Asked Questions - FAQs The FAQs in this chapter are organized by topic. For additional information about using FLOW-3D, users can view the Hints & Tips and Tutorials & Workshops sections on the Users Site, refer to the rest of the FLOW-3D Users Manual or download PDF files of Technical Notes and Technical Papers from the main FLOW-3D website. 
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Installation and Licensing Questions 
Missing library error messages on LINUX FLOW-3D requires a number of runtime libraries on Linux. Most of these libraries will be present on your system but, depending on the options selected when installing Linux, some may not be present or may not be the correct version. The FLOW-3D installation installs the required libraries in the /flow3d/vx.s/gui/lib folder. However, preference is given to the system libraries, if present. If the installation detects that required libraries are not present, it sets the environment variable LD_LIBRARY_PATH in the FLOW-3D startup scripts flow3dvars.sh (for BASH shells) and flow3dvars.csh (for C shells), located in the ../flow3d/vx.x/local directory, to the installed libraries. If error messages indicating missing or incorrect libraries appear while running FLOW-3D, be sure to first execute either the flow3dvars.sh (Bash shells) or flow3dvars.csh (C shells) script before running FLOW-3D. We recommend that the contents of flow3dvars.sh or flow3dvars.csh be added to the .bashrc file so that it is run on system startup.  
Display issues on Linux By default, generic graphics drivers are installed during the installation of Linux operating systems. While these drivers work well for simple applications, they can cause strange display issues for OpenGL-based applications such as FLOW-3D. These issues include incomplete graphical display of geometry and results. A common issue with older NVIDIA drivers appears as a ‘sliced’ three-dimensional plot on the Display tab. Fortunately, most common display issues on Linux can be solved by installing the latest native drivers for your graphics card.  Another common issue is the legibility of buttons in the GUI. The recommended monitor resolution is at least 1280 x 1024, with at least 24-bit color depth. It is best to use the native resolution of LOCD panels as the display resolution. Native drivers usually resolve this issue as well. 
I’ve received a new license file. How do I restart the license server with my new 
license? Ensure the required license daemons are installed in the ../flow3d/vx.x/licenses directory. For example, a v9.4 license file requires the license daemons installed from the v9.4 installation CD. Daemons from earlier versions will not be able to start or reread a v9.4 license file. Copy the new license file flow3d.lic to the ../flow3d/vx.x/licenses directory. Ensure that the host name on the first line of the license file matches the host name of the computer where the server is being started. If it does not, change it using a text editor. Windows: Double-click the lmtools.exe icon on your Desktop. Select the Start/Stop/Reread tab. If the server is not currently running, click on Start Server. You should receive a message saying “Server Started Successfully.” If you do not get the above message try stopping the server by clicking the Stop Server button and restart the server by clicking the Start Server button.  Click on the Server Status tab and select Perform Status Enquiry to verify that the license server has started.  



More detail on installing and troubleshooting license server and client installations is available in the FLOW-3D Installation and Licensing Guide. Linux: Open a command prompt and change to the directory /flow3d/vx.x/licenses/. Make sure that the license file (flow3d.lic) is in this directory. Start the license server by entering the following at the command prompt: 
 % ./lmgrd -d <full license file path> -l lmgrd.log& In the command shown above, <full license file path> should be replaced by the appropriate path to the license file. In most cases the default path is: /home/flow3d/vx.x/licenses/flow3d.lic. To reread a license file, enter the following at a command prompt:  
% ./lmreread License files can only be reread if the license file is currently running. More detail on installing and troubleshooting license server and client installations is available in the FLOW-3D Installation and Licensing Guide. There’s a firewall running on the license server. Will this interfere with the FLOW-3D license server? Yes, probably. There are two executables, lmgrd.exe and f3dtknux.exe, which must be allowed access through firewalls. These instructions are specific to Windows Firewall; if you are using a different firewall program, note the two programs you will grant exceptions to (see below) and refer to the firewall manufacturer documentation for instructions on how to do so. You can find out what firewall you’re using by first opening the Start Menu at the lower left of the screen. Navigate to the Control Panel > Security Center (renamed Action Center in Windows 7). In the dialog that opens you should be able to identify the manufacturer of your firewall in a dropdown menu labeled Firewall. If you are using Windows Firewall, you can add exceptions by clicking on Windows Firewall at the left of the screen, and then Allow a Program Through Windows Firewall. Use the Add Program… button and then the Browse… button to add the following two programs (which each must be added, browsed to and selected separately): 
C:\flow3d\v9.x.x\licenses\lmgrd.exe 

C:\flow3d\v9.x.x\licenses\f3dtknux.exe If you have specified a port in the license file, and depending on the firewall software you are using, you may also need to add an exception for the port itself. This is not recommended (for network security) unless it is absolutely necessary. Each program should then appear in the list of Exceptions (the name may reflect the manufacturer of the license server software, Acresso Software or Flexera Software) with a check mark. Note that every new installation of a FLOW-3D server needs to have exceptions granted anew for the two programs: the file names are identical with each installation, but the programs themselves are in different hard drive locations (v9.x.x\licenses). 
My license file (flow3d.lic) was emailed to me configured with "this_host" as the 
Server name. What does this mean? If you did not specify the host name of the computer that you intend to use as your license server, your license file will be generated using this host name: "this_host." 
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Running the license server with the name "this_host" is not a problem if FLOW-3D is only being run on that server machine. But if you intend to run FLOW-3D on client computers as well, those other computers will not be able to check out licenses from the server because the name "this_host" is ambiguous and does not enable the clients to locate the server. It is recommended that the host name "this_host" be changed to either the IP address or the name of the license server. To retrieve the IP address or the computer name on a Windows computer, open a command prompt and enter IPCONFIG /ALL. On Linux, the IP address can be retrieved by opening a command prompt and typing /sbin/ifconfig. The computer name can be retrieved by typing hostname from a command prompt. NOTE: THE HOST NAME IS THE ONLY PORTION OF A LICENSE FILE THAT USERS CAN SAFELY MODIFY WITHOUT CORRUPTING. 
Can I change my license file? There are two details in the license file that may be changed: 1. Server Name 2. Port Number The first line of every license file has the following format: 

SERVER <this_host> FLEXID=********** <port number> Typically, a license file will be issued with the server name specified according to what was requested by the user. However, sometimes the license is issued using the name "this_host." In either case, the server name can be changed if you are running Windows and using a hardware key (USB dongle), and you wish to make another machine your license server by moving the hardware key. In Flow Science's implementation of FLEXlm licensing, the default port number is 27000. If, because of a firewall or other license servers, you cannot use this port, you can specify your own port number by adding it after the FLEXID number in the first line. Details on checking and changing license files are available in the FLOW-3D Installation and Licensing Guide. 
Physical Modeling Questions 
How do I implement thixotropic fluids in FLOW-3D? There are several approaches to modeling thixotropic flows. One approach is to select constant or strain-dependent thinning and thickening rates on the Model Setup > Fluids tab, Properties > Fluid 1 > Viscosity > Thixotropic tree, after activating thixotropic viscosity on the Model Setup > Physics > Viscosity and turbulence dialog. A second approach is to specify a non-constant viscosity method on the Model Setup > Fluids tab, Properties > Fluid # > Viscosity> Viscosity Function dropdown menu. In order to implement the correct parameters for thixotropic fluids you need to obtain the material properties and decide which variables to set the dependency on. The following is an example of how to implement constant and strain-rate-dependent viscosity using measured viscosity data (SI units). Read more about modeling thixotropic fluids (PDF). A discussion of how to set equivalent parameters for known Herschel-Bulkley model data can be downloaded here (PDF). 
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When can a fluid be considered incompressible?  All materials exhibit some change in volume when subjected to a pressure. The degree of compressibility is usually measured by the bulk modulus of elasticity E defined by the relation dp=Edr/r. That is, E measures the pressure change dp needed to make a change in relative density dr/r. For small density changes, E can be approximated as E=rc2, where c is the speed of sound in the material. In liquids and solids, E is typically a very large number so that density changes are generally small unless exceptionally large pressures are applied.  By an “incompressible” fluid we mean one in which changes in density, dr/r, remain small everywhere at all times. Density can change in two ways, so there are two conditions that must be satisfied before a fluid can be treated as incompressible. Condition One: In steady or slow flows, pressure variations can be estimated from Bernoulli’s equation, which leads to the relation dr/r ~ (u/c)2. This is the well-known condition that fluid speeds must be much less than the speed of sound for a fluid to be treated as incompressible. A rule of thumb is that the Mach number (u/c) should remain below 0.1 for a gas to be considered incompressible. To specify a gas as fully compressible, select the Compressible radio button in the Flow Mode group on the Model Setup > Global tab. Condition Two: When a flow is unsteady, the rate of change of velocity is accompanied by pressure and density changes. Consider a region of fluid whose size is characterized by the length L that is subjected to a change in velocity u over a time interval t. Momentum considerations require a pressure change of magnitude dp=ruL/t. This leads to the second condition for incompressibility, dr/r ~ (u/c)L/(ct)<<1 or that L<ct. Physically, this means the distance traveled by a sound wave during time interval t must be larger than L. The collapse of a vapor bubble offers an example of why both conditions are required. During the collapse process, the surrounding liquid moves slowly enough for the liquid to be treated as incompressible. However, following the instant of implosion, the liquid momentum rushing toward the point of collapse must be stopped. If the fluid was treated as incompressible, the fluid must decelerate instantaneously and the peak collapse pressure would be predicted to be much higher than is actually observed. In reality, a sound signal moves out from the point of implosion, signaling the incoming liquid to stop. In order to predict the pressures due to bubble collapse correctly, the incompressible fluid should be modeled with an acoustic limited compressibility; that is, by allowing large pressure changes to propagate according to the compressibility of the real fluid. Limited compressibility can be applied to a liquid by specifying its Compressibility in the Properties tree on the Model Setup > Fluids tab. Additionally, the mesh size must be chosen so that the acoustic wave travels only one cell per time step to reduce dissipation. 



I’ve initialized the fluid pressure to hydrostatic in the z-direction, but the 
pressure is not initialized correctly beneath components. What do I do?  

 Initial hydrostatic pressure distribution with IPDIS = 1 (top-down distribution) Hydrostatic pressure is initialized by starting at the top of the domain and adding density*gravity*dz to the pressure as it moves down in the fluid. The free surface (upper limit of fluid) automatically is assigned the void pressure. When components are encountered, a non-hydrostatic pressure distribution will result. While this discrepancy in the pressure distribution is usually resolved in the first time step of the simulation, it usually requires a large number of pressure iterations. However, if a large number of pressure iteration failures occur, undesirable flow may result. It is preferable to have the correct distribution immediately. A bottom-up pressure distribution (in the z-direction only) can be set by manually editing the prepin file (press Ctrl+E anywhere in the GUI when the current simulation is selected in the Navigator pane) and setting the flag IPDIS = -1 in namelist &XPUT.  
When I have a shallow flow covering a large area, it’s difficult to define a three-
dimensional grid of manageable size. Is there an alternative? When the depth of a fluid is small compared to its lateral extent, it is often a good approximation to assume the flow velocities are independent of depth and treat the flow as two dimensional rather than three dimensional. Examples of shallow flows are painting, floods, estuary circulation, and liquid coatings. In FLOW-3D these types of flows are best treated using the shallow-water “depth-averaged” model option. The Shallow Water model can be activated via the Model Setup > Physics panel by selecting the Shallow Water button and then checking the Activate Shallow Water model.  With this option, all flow is restricted to a single layer of grid elements in the z direction. This greatly reduces the computational resources needed to obtain solutions. Ground topography can be defined within this layer using the FAVOR™ method; and fluid surfaces, tracked with the VOF method, allow for the treatment of surface waves or other variations in fluid depth. Coriolis forces, surface tension, heat transfer, surface evaporation, and most other physical models in FLOW-3D can be used in connection with the shallow-water model. 
How can I control the size of the results from my FLOW-3D simulation? The estimated size of the results file is displayed on the Model Setup > Output tab. There are a number of approaches to reducing the size of the results file. You can reduce the size of the results file by reducing the frequency of data output. Also, only data of interest can be output by choosing Selected Data directly from the Output tab. The results file can be significantly reduced by setting the time interval for restart data to the finish time and using Selected Data for creating graphics and analysis. 



How do I boil water (or any fluid) with heat? Boiling is a complex phenomenon involving liquid-vapor phase change, bubble dynamics, and heat transfer. There are several ways to approach thermal boiling, as well as several ways to approach boiling as a function of pressure (also called cavitation). This FAQ discusses boiling fluid as a function of heating. The simplest approach to simulating boiling fluid is to set up a one-fluid, free-surface simulation and activate the heat transfer physics model, the thermal bubbles with phase change model on the Bubble and Phase Change physics dialog, as well as selecting activate cavitation model and specifying a characteristic time for formation of cavitation bubbles (CAVRT) (cavitation pressure PCAV does not need to be defined for thermal boiling). Now add values that specify the saturation pressure/temperature curve for the fluid on the Model Setup > Fluids tab > Thermal Properties and Phase Change sub-trees. The following fluid properties must be defined: PROPERTY NAME CODE DESCRIPTION TYPICAL SI VALUE FOR H2O @ 1 ATM Saturation Pressure PV1 Matching pressure and temperature defining a single point on the fluid saturation curve. Generally PV1 and TV1 should be selected close to the actual boiling point expected for the simulation. 104,533 Pa Saturation Temperature TV1 374 K Latent Heat of Vaporization CLHV1 Specific energy required to convert liquid to steam. Assumed to be constant. 2,256,700 J/kg Gamma GAMMA Ratio of vapor-phase specific heats Cp/Cv. Assumed to be constant. 1.329 Accommodation Coefficient RSIZE The accommodation coefficient represents a multiplier on the phase change rate predicted by kinetic theory. Its value depends primarily on the scale of the bubble and other factors including fluid impurities. It is often necessary to calibrate RSIZE through experiments. ~0.01 for micro-scale bubbles. ~1.0 for bubbles on the scale of meters. Vapor specific heat CVVAP Constant-volume specific heat cv of vapor phase. Assumed to be constant. 1402 J/kg/K Exponent for T-P Curve TVEXP Exponent in the Clausius-Clapeyron relation.  Can be approximated as TVEXP = (GAMMA - 1)*CVVAP/CLHV1 but it is best to compute it from T-P data on the saturation line. 2.04e-4 K-1 Superheat Temperature TV0 Delays the onset of bubble nucleation due to lack of nucleation sites until fluid temperature exceeds TV0: causes very rapid (high-energy) bubble expansion once temperature is reached. Only active in the bulk liquid and at smooth surfaces with surface roughness (ROUGH) = 0. Reflects the number of nucleation sites in the fluid and on the surface. Specific Heat CV1 Constant-volume specific heat of the liquid phase. Assumed to be constant, although as noted the value is significantly temperature-dependent. 3769 J/kg/K @ 100°C, 4157 J/kg/K @ 20°C 



Thermal conductivity THC1 Liquid-phase thermal conductivity. Can be specified as constant or temperature-dependent for a constant assumed pressure. 0.6 W/m/K Characteristic time of formation CAVRT Typical time-of-formation for a bubble when normal boiling point is exceeded (assuming nucleation sites are available). Located on the Physics > Cavitation dialog. 0.001 sec Remember that, in order for bubbles to form, the mesh must be fine enough that a typical bubble is resolved by at least one cell, and preferably by at least three cells in the shortest direction of the bubble. A more detailed discussion of the bubble models and bubble dynamics is available in Flow Science Technical Note 57. A discussion of how to implement a 2-component boiling problem (with air, water vapor, and liquid water) using the 2-Fluid and non-condensable gas models is available in Flow Science Technical Note 78. 
How do I model cavitation (boiling as a function of pressure)? The formation of bubbles in low-pressure regions is of great interest in hydraulic and casting design. While it is possible to thoroughly model boiling as a function of pressure and temperature (see How do I boil water (or any fluid) with heat?), FLOW-3D offers several options for simulating pressure-based bubble formation without the added computational expense of modeling thermal energy transfer. Set up a one-fluid, free surface model and activate the cavitation model on the Model Setup > Physics tab. To output cavitation potential without actually allowing bubbles to form in the simulation, select Activate cavitation potential model. To simulation resolvable cavitation bubbles, select Activate cavitation model. Both models require a cavitation pressure PCAV (unless you’re also using the thermal bubbles with phase change bubble model). PCAV is typically the pressure on the fluid saturation curve corresponding to the constant assumed temperature of the fluid (for example, 2340 Pa @ 20°C for water). A characteristic time of formation CAVRT is also required (e.g., 0.001 seconds for water). Background, theory, and validation of this model are discussed in Flow Science Technical Note 21. Additional models may be used to further model the transport and break-up of vapor bubbles. By default the bubbles formed will be of constant pressure (the cavitation pressure) with no phase change, and will expand and compress as a function of the surrounding fluid pressure. The adiabatic bubbles model will allow the bubbles to compress and expand with variable internal pressure to match the fluid pressure. The constant pressure bubbles with vaporization model also requires the heat transfer model and keeps the pressure constant but permits phase change as a function of temperature and pressure. The thermal bubble models (with or without phase change) also require the heat transfer model, and solve heat transfer within and between the bubbles and the fluid.  To model the breakup and transport of bubbles that are much smaller than a mesh cell, consider activating the air entrainment model with density evaluation (full transport equation), and drift-flux (with gas escape at free surface) options on the Model Setup > Physics tab, with appropriate coefficients. The assumption in these additional models is that the very small bubbles behave as if they had constant density and constant size, which means that the broken-up bubbles will not collapse further or revert to the liquid phase. This approach allows the volume of cavitated gas to remain in the fluid even when the bubbles have collapsed past the point of resolution. This is useful if tracking the bulking of the fluid and the volume of gas is of interest. 

http://www.flow3d.com/pdfs/tn/FloSci-TN57.pdf
http://www.flow3d.com/pdfs/tn/FloSci-TN57.pdf
http://www.flow3d.com/pdfs/tn/FloSci-TN78.pdf
http://www.flow3d.com/pdfs/tn/FloSci-TN21.pdf


I want to have fluid move smoothly out of a computational boundary. How can I 
choose the boundary condition that will do this best?  There are a number of boundary condition choices which allow fluid to move out of the computational domain, including Continuative, Specified Pressure and Outflow. The best choice depends on the physical conditions of the overall problem. One thing to consider is whether or not it's possible to realize a particular boundary condition in a laboratory experiment. If the answer is "no, the condition cannot be physically realized," then that is a good indication that it is also unlikely to work in a computation. At a Continuative boundary all flow quantities are assigned a zero normal derivative. This is not a realizable physical condition and should only be used when there is no other option. A Specified Pressure condition is a well-defined physical state that can often be closely approximated in an experiment. This boundary condition, however, does not always work in the presence of waves on the free surface since reflections back into the domain occur. The Outflow boundary condition was designed to pass waves (surface or internal) through a boundary with a minimum of wave reflection back into the computational region. Recently, improvements have been made to this condition to also permit outflow of material in addition to waves, so this may be a good choice for many problems. In most cases, when the flow across a boundary is predominantly out of the domain, and the boundary is far from regions of high gradients, there is a good chance that an outflow boundary condition will perform properly. The greatest difficulty associated with outflow boundaries occurs when they also allow fluid back into the simulation (a user-specified option). When inflow is present, it is very important to assess whether or not the inflow could be adversely affecting the results. Also, keep in mind that the state (i.e., temperature, pressure) of fluid coming into the simulation from an outflow boundary condition will be an approximation since the conditions outside the domain are not known. It is best to move an outflow boundary far away from recirculating flow. 
There are several options for modeling gas bubbles. How can I decide which, if 
any, of the models to use for my applications? A bubble in FLOW-3D is defined as a gas region large enough to be resolved by at least one computational cell. In most cases bubbles encompass many computational cells, which is why they are useful computational objects for modeling large vapor regions.  Many two-phase flows don't consist of a homogenous mixture of the phases, but instead consist of large regions of either gas or liquid. This is why a capability to model large bubbles is important. In these cases, a discrete bubble model, such as the adiabatic bubble model is necessary. Constant pressure, adiabatic, and one-fluid bubble models all make two assumptions. The first assumption is that the inertia of the gas is negligible relative to the inertia of the liquid phase. The second assumption is that the bubble pressure and temperature are uniform within each bubble. Based on these two assumptions, no velocity or temperature computations are performed in bubble regions. This leads to a considerable savings in computational effort since accuracy and numerical stability issues associated with a low density gas/high density fluid combinations are eliminated. Ignoring the inertia of the gas is usually a good approximation since gas densities are typically orders of magnitude smaller that the liquid density. The physical requirement for a uniform bubble pressure is that sound waves in a bubble are able to smooth out variations in a time that is short compared to the 



characteristic time for changes in the surrounding liquid. (e.g., changes in the shape and/or volume of the bubble.) Essentially, a sound wave should have time to make several passes across a bubble before its shape or size changes appreciably. For most applications where the surrounding liquid can be treated as incompressible, this condition is relatively easy to meet. The physical requirement to satisfy the uniform temperature assumption is that the bubble must be relatively small. Large (~1 m) bubbles typically require a two-fluid approach to resolve the temperature gradients within the bubbles. 
How do I use grid-overlay boundaries to prescribe fully developed flow profiles 
at inlets?  The art of successful simulation often boils down to choosing a reasonable computational domain and meaningful boundary conditions. Modeling a domain that is unnecessarily large will increase the runtime unnecessarily. Setting boundary conditions to represent the actual physical situation as closely as possible is also desirable. Grid-overlay restarts help users design simulations which accomplish both of these goals.  Grid-overlay (GO) restart boundaries allow users to restart a simulation with the flow variables on boundaries set to the flow variables from the restarted simulation at that mesh plane location. Boundaries selected as grid overlay inherit their boundary conditions from the previous solution. These conditions—pressures, temperatures, velocities, etc.—are held constant during the restarted computation but vary spatially across the GO boundary as determined from the restarted simulation. The flow at the GO boundary location in the restarted simulation should be steady in order to represent a meaningful situation.  For example, a good use of grid overlay restart is a situation where fully developed pipe flow enters a domain. It is preferable to avoid modeling the flow in the pipe, since it adds to the runtime without providing a significant amount of information. Instead, it is preferable to simulate the pipe flow until it is steady and then restart the simulation with only a portion of the pipe in the model. The boundary conditions for the GO boundary would retain the fully developed profile in the pipe. 
How do I select a surface roughness that correlates with Manning’s n? Flows in rivers, pipes and irrigation channels encounter resistance that depends upon the roughness of the bounding surfaces. The roughness of a surface can vary dramatically. For instance, a steel surface may be considered relatively smooth, while large boulders in a river bottom are extremely rough. A roughness variable in FLOW-3D can be selected to account for any type of surface. To calculate the mean flow velocity, V, in a channel, it is customary to use a table of values for various surface types (available in many hydraulics handbooks) that assign a roughness in terms of Manning’s n and apply it to Manning’s formula shown in Equation 1, where S is the slope of the channel and Rh is the hydraulic radius (fluid cross sectional area divided by the wetted perimeter). Values can range from 0.009 for a smooth metal to 0.5 for heavy vegetation. Equation 1 In FLOW-3D, the roughness variable is specified as the average height of uniformly-distributed surface roughness elements, such as the roughness referenced in Moody diagrams. If the actual surface is uniformly rough, this height can be applied directly. For non-uniform surfaces, the equivalent uniform roughness can be computed from Manning’s n and an estimated hydraulic radius or diameter as shown in Equations 2 and 



3 in which k is the roughness variable ROUGH used in FLOW-3D. Both k (roughness height) and Rh (hydraulic radius) must be expressed in feet in Equation 2, while Equation 3 assumes SI units (meters) for rough and hydraulic diameter DH.   
Equation 2  
Equation 3 In the book, “Open Channel Hydraulics” by Ven Te Chow, 1988, a typical value of n for mortar concrete is 0.013. If a channel had a hydraulic radius of 1.25 feet (hydraulic diameter of 5 ft), the roughness, k is 0.0033 feet, or about 1 mm, a reasonable value for mortar cement. 

Tips for meshing complements formed by stereolithography (STL) components 

 Figure 1. STL file imported directly as a complement. 



 

 Figure 2. STL file displayed as a solid. STL files are the standard for importing solids models into FLOW-3D. STL files describe a solid object as a collection of triangles that make up the surface of the solid. The convention of STL files is that the vertices of the triangles are output in a clockwise direction around the triangle’s unit normal, which points away from the solid surface. Frequently, designers will generate solids models of components which modelers are then required to model the flow inside of. For example, a designer may generate a solid model of the flow path through a nozzle rather than the nozzle body. To model the flow through the nozzle, the STL file would be imported as a complement rather than a solid, i.e., flip the surface normals. However, a complement of an STL file appears as a solid block in the FLOW-3D GUI, so the internals of the part are hidden, making the meshing operations more challenging. One solution is to apply transparency (select the sub-component), in the Geometry tree, right-click and select Properties, and then move the slider to make it partially transparent). Now the open regions of the part should become visible. However, it is often difficult to achieve a good balance between transparency and the ability to see regions well enough to mesh them. A better option is to import the STL as a Solid initially, apply a mesh to it, and then switch it to Complement. Switching a part between solid and complement is straightforward in the Geometry tree. Figure 1 shows the STL file NOZZLE.STL imported into the project as a Complement. To the right, the part appears as an opaque box. To change the part to a solid (i.e., flip the normals), click on Complement in the tree and select Solid. The display now shows the flow path which will be modeled and is shown in Figure 2. 
I have very thin vents in my casting requiring a very fine mesh…what can I do? 

 



Figure 1. Simple cylindrical casting with overrun and thin vent 

 Figure 2. Two dimensional cross-section of mesh and open volume with thin vent  

 Figure 3. Two dimensional cross-section of mesh and open volume with larger vent In many designs for high pressure die castings, the dies have vents attached to overrun chambers. These vents are intended to allow air to escape the cavity during the short duration of the filling process. Since these vents are only intended for the release of air, they are typically extremely thin. Moreover, they may have odd shapes or follow a circuitous path, in order to avoid cooling channels. Trying to resolve these very thin vents in a computational mesh may require a very large number of cells. It’s useful to remember that the vents are only there for the escape of trapped air. It is not necessary to model their exact shape or size. All that is necessary is to create an open channel from the overrun to the boundary of the mesh, where you will specify a pressure boundary condition and a fluid fraction of 0. This channel can have any shape. Moreover, it is not necessary to match the cross-sectional areas. This is because when you are modeling castings in FLOW-3D you are using its one-fluid model, which does not simulate the air movement. A simple example helps demonstrate the benefits of this approach. Figure 1 shows a simple cylinder with an attached overrun and vent. The cylinder is 4 cm in radius and the vent is 0.7 mm thick. Figure 2 shows a 2-D cross-section through the cylinder and overrun with the vent exactly represented. A fixed point is defined in the middle of the vent to resolve the vent. Without the fixed point, even smaller cells would be required. Figure 3 shows a two dimensional cross-section of mesh and open volume with a larger vent. 



Another option available to users is to model the vents using a valve with a specified loss coefficient in place of the vent. In this case, at the location of the vent in the die, the user would specify a valve using the Initial tab in the GUI's Model Setup tab and provide a loss coefficient based on the diameter and length of the valve (see the “How do I Model Valves?” section of the User Manual). With this approach, the user doesn’t need to mesh the vent at all. Finally, by assuming that the flow of air through the vent and the presence of air in the die cavity are not important, all air space can be treated as a constant pressure. This approximation makes it possible to reduce the resolution of the mesh (or eliminate the channel entirely), decrease run time and solve your die casting problem more quickly. 
Does grid uniformity have any effect on surface tension modeling? A very useful and powerful capability in FLOW-3D is the ability to use non-uniform or stretched computational grids. Stretching the grid allows resolution to be reduced in a particular direction when gradients in that direction are small. Conversely, the resolution can be increased in regions with high gradients. This stretching of the grid may reduce runtime and memory usage when used appropriately. While there is no limit to the cell aspect ratio, high cell aspect ratios can create convergence problems. Stretched grids are generally not recommended when surface tension is activated and the free surface moves through the non-uniform regions of the grid. As a rule of thumb, cell aspect ratios should be limited to about 1.5 in these cases. The more uniform the grid, the more accurately the free surface curvature can be computed. The following example demonstrates this. Let’s say we are simulating a droplet of water that is 1 mm in diameter moving at 100 cm/sec. To determine the importance of surface tension in the simulation, we evaluate the Weber number, which represents the ratio of inertia to surface tension. The Weber number is approximately 10, so surface tension forces are significant. In the first simulation, use a uniform grid with a spacing of 0.01 cm. The droplet will move through the grid relatively smoothly. In the second simulation, stretch the grid by a factor of 3 in the direction of motion. You will see how the droplet quickly becomes distorted and breaks up. The distortion is primarily due to surface perturbations created by inaccuracies in surface curvature calculation on a coarse, non-uniform grid. Increasing the resolution significantly while maintaining the stretching delays the distortion but, eventually, the droplet breaks up. The calculation of surface tension curvature is most accurate when a uniform mesh is used. An easy way to add a uniform grid to a simulation without re-meshing is to place a Nested Grid over the region where the free surface passes. Try overlaying a uniform nested grid on a portion of the droplet’s path. You will see that while the droplet is moving through the nested grid, its motion is smooth and its shape is maintained well. Once the droplet leaves the nested grid and begins moving through the stretched mesh, it becomes distorted. Clearly, a uniform grid provides the most accurate results when surface tension is significant. An easy way to selectively add a uniform grid is by using a nested mesh block. 



When is a continuative mesh boundary condition applicable? When there is a need to have fluid flow out one or more of the boundaries of a computational domain, the question arises: what is the right boundary condition? Several mesh boundary conditions can serve as outflow boundaries in FLOW-3D: specified pressure, continuative and outflow. The simplest outflow condition is the continuative boundary. A continuative boundary condition consists of zero normal derivatives at the boundary for all flow quantities. The zero-derivative condition represents a smooth continuation of the flow through the boundary. Therefore, using the continuative boundary condition is most suitable when the flow upstream from the boundary exhibits little variation in space and time. This condition requires the continuative boundaries to be placed far downstream from any disturbances in the flow like constrictions or submerged bodies. The continuative boundary condition has little physical basis. Rather, it is a mathematical statement that may or may not provide the desired flow behavior. In particular, if flow is observed to enter the computational region across such a boundary, then the computations may be wrong because nothing has been specified about flow conditions existing outside the boundary. The entering flow is forced to do so from the condition of rest. This practice helps to reduce inflow and often results in a more reasonable approximation of a smooth outflow condition. The zero-derivative condition at continuative boundaries implies that there is no acceleration or deceleration of the flow as it crosses the boundary. Therefore, the continuative boundary condition is not consistent with a significant non-zero force component normal to the boundary, for example, gravity. In conclusion, a continuative boundary employs a very simple algorithm, but the results should be viewed with a good degree of suspicion when the flow has significant acceleration near the continuative boundary. As a general rule, more physically meaningful boundary conditions, such as a specified pressure condition or an outflow boundary, should be used at outflow boundaries whenever possible.  
How can solidified fluid move in a filling simulation? Set TSDRG=0.0 in the PROPS namelist. This is the coefficient of solidification drag. By default TSDRAG=1 which means infinite drag on the solidified fluid. In the PROPS namelist set MUS, the viscosity of solidified fluid. Typically MUS can be about 1000 times that of MU1 (viscosity of fluid 1). The result of this is that the solidified fluid will be approximated as a very viscous fluid. 
What are the reasons to select single vs. double precision versions? The FLOW-3D installation includes two versions of the preprocessor and solver executables – a single precision version and a double precision version. Users can choose which version to run through the Preference > Runtime menu of the GUI, or by setting the F3D_VERSION environment variable to “single” or “double” when running in a command window. The double precision version is the default selection because it is more accurate in representing floating point variables. The postprocessor is only available in single precision. A floating point single precision value is comprised of 4 bytes, while a floating point double precision value is comprised of 8 bytes. What this ultimately leads to is a typical accuracy of seven significant digits in single precision and an accuracy of about 15 significant digits in double precision. The remaining digits are called 



the round-off error. Round-off errors are handled differently by different compilers and hardware platforms, and may be random numbers or all zeros. In a single arithmetic operation the round-off error is usually insignificant. But after millions of operations, the errors may accumulate and affect the numerical solution. These errors are larger and can accumulate faster when the single precision code is used. The effect of these errors on the solution depends on the problem at hand. For instance, a jet of water sprayed upward against gravity has an inherent physical instability, which can be triggered unphysically by round-off errors. So when would a user employ the single precision version of FLOW-3D? The advantage of the single precision version is that larger simulations, roughly 40% more computational cells, can be run in single precision vs. double precision. This can be greatly beneficial for problems requiring very large meshes like in high pressure die casting and rivers. However, if mesh size is not a problem, the double precision version is recommended. The size of the output files is the same for either version. The speed of the execution is not significantly affected by your selection of single or double precision. 
How do I inject or remove fluid into a simulation at a location away from a mesh 
boundary? Fluid doesn’t have to only enter the simulation at boundaries. It can also be introduced within the mesh through the use of two different types of sources: mass sources and mass-momentum sources. A mass source is introduced into the simulation from the surfaces of components. The component can be a FLOW-3D primitive (box, cylinder, cone, etc.) or an STL object. A mass-momentum source is a two-dimensional plane from which fluid and momentum enters the simulation. Mass-momentum sources can be defined as circles, squares, rectangles, or ellipses. Both kinds of sources can also act as mass sinks and remove fluid from the simulation (for example, a pump intake), and both can have specified time-dependent flow rates.  Both types of sources are created on the Model Setup > Physics tab > Mass Sources dialog. Mass sources are specified by selecting an existing component, while the shape and size of mass-momentum sources are defined in the dialog, and need to be rotated and translated from the origin to the desired location and orientation. Both types of sources can have a specified motion (constant or time-dependent), density, temperature, and scalar concentration, as well as mass flow rate (divide by density to find the volumetric flow rate). 
Why am I seeing unexpected waves (oscillations) at my free surface? The most likely cause of unphysical oscillations on the free surface is a horizontal fixed point that lies exactly on a large stretch of free surface. Fixed points should be used only to resolve flat geometry component surfaces, and never be deliberately placed at a fluid surface. The solver will track the fluid surface accurately regardless of the cell size, but must decide which cell the surface is in. Forcing a fixed point onto a continuous fluid surface creates numerical noise that amplifies an oscillating signal (as the surface alternates between the upper and lower cells) in the free surface solution, making waves which become larger as the simulation time increases. Additional approaches to reducing free surface oscillations might include adding limited compressibility, and checking to ensure that, if a wave generator is being used, select the “Allow fluid to enter at outflow boundary” radio button is active for all outflow-type boundaries. 



What is limited compressibility, why would I want it, and how do I add it? Acoustic waves propagate naturally in so-called incompressible fluids, and it is often desirable to have these waves modeled without the computational expense of a fully-compressible simulation. Some physical examples of pressure wave propagation include water-hammer, cavitation, and bubble collapse. Another reason to model acoustic waves is that they help reduce the stiffness of the pressure solution, and so can speed up and improve convergence of the pressure solver. Limited compressibility is one way to simulate acoustic waves and also reduce the stiffness problem associated with small bubbles. Limited compressibility in an incompressible-flow model will not change the volume of water in a cell as a function of compression (since the fluid is nearly incompressible), but will accurately model propagation of pressure waves when an approximately small time step is selected. This in turn can significantly reduce numerical noise and difficulty (stiffness) experienced by the pressure solver.  Limited compressibility is activated by supplying a compressibility coefficient RCSQL on the Fluids tab. The formula to determine this coefficient is the inverse of the bulk modulus of elasticity: that is, RCSQL = 1/(rho*w^2) where rho is the fluid density and w is the adiabatic speed of sound. For pure water and seawater, an equation of state to determine both density and speed of sound (or bulk modulus of elasticity) may be used for an assumed constant temperature and pressure. Some interactive calculators and discussion of methods for speed of sound in water and seawater are available at: http://resource.npl.co.uk/acoustics/techguides/soundpurewater/ ttp://resource.npl.co.uk/acoustics/techguides/soundseawater/  A second option is to use the Implicit with automatic limited compressibility option in the Model Setup > Numerics > Pressure solver options selection pane. This option activates a dynamically-computed limited compressibility that only aids the pressure solution. If physical acoustic waves are required, using RCSQL is more appropriate, and will still reduce the stiffness of the pressure solution. 
What is the friction coefficient and how do I get a no-slip boundary condition? The friction coefficient can be set two places, and defaults to -1 (no-slip condition): The global friction coefficient FRCOF (for all components and wall-type boundaries) is set on the Model Setup > Physics > Viscosity and turbulence dialog, or  The component-specific friction coefficient OFRCOF (for individual geometry components) is set in the Meshing & Geometry > Geometry > Component # > Surface Properties tree. Any specified OFRCOF overrides FRCOF. The value of the friction coefficient controls the degree of fluid slip at the surface. For almost all solid objects and fluids, the default no-slip condition (FRCOF = -1) is the most physical. Friction coefficient = 0: free-slip. Friction coefficient > 0: partial-slip. Friction coefficient = ∞ OR <0: no-slip. The concept of free-slip surfaces is often used to describe the interface between two fluids with very different densities (by a factor of 10 or more), like water and air. 

http://resource.npl.co.uk/acoustics/techguides/soundpurewater/
http://resource.npl.co.uk/acoustics/techguides/soundseawater/


Partial-slip boundaries occur frequently whenever two fluids are in contact: an example is in oil pipelines with surfactant injection. Emulsion forms against the pipe walls, and the pipe wall behaves as a partial slip boundary. The reduction in friction can result in significant cost savings for the operator. No-slip conditions are generally taken to be the most physical description of fluid/solid interaction: shear stress theory assumes that the velocity profile at the boundary is opposed by shear stress in the opposite direction, and this forces the velocity to zero relative to the wall velocity. The no-slip boundary condition is correct for nearly all situations, notable exceptions being flows comprised of superheated helium or rarified gases. 
Postprocessing Questions 
Is there a way to display the structure of a complex three-dimensional flow using 
streamlines? FLOW-3D offers a streamline plot option in the Streamlines tab under Analyze in the GUI. Streamlines are the paths that massless markers trace as they move through a stationary flow field. They can reveal the location and extent of recirculation or reverse flow regions, flow bifurcations, stagnation regions, and other flow structures.  Users define the starting location for one or more streamlines, set the number of steps (travel time) used in constructing the lines, and select the data output times for the displays. To make these lines more useful, there are options to color them by the local value of any flow variable (e.g., pressure, velocity, or temperature), travel time, or simply a unique color to distinguish one line from another. This new option has unlimited possibilities. For example, in a steady flow, streamlines offer an interactive alternative to the program's particles-only option. The travel-time option could be used to determine the minimum and maximum retention time of fluid particles in a water treatment tank. In a mixing tank, streamlines show the degree of mixing and locate regions of stagnation that resist complete mixing. 
How can I get a printout of quantities computed from the primary variables, and 
can I limit these quantities to regions such as obstacle or fluid surfaces? An easy way to store quantities computed from the primary variables is to use a scalar array. From the Model Setup, Physics, Scalars button, request the number of scalar arrays needed to store the computed quantities and set their advection flags, isclr(n), equal to zero to specify that they are fixed quantities that do not diffuse or advect with the flow. Then, in the user customizable subroutine qsadd, add a loop over all the grid cells to compute the values to be stored in these arrays. It is easy to insert a test to identify those grid cells that are located at solid boundaries or free surfaces.  The modified qsadd routine must be recompiled and linked to the remainder of the program (see Chapter 9 "Customization" in the FLOW-3D User's Manual). Also, be sure to select a custom version of the program on the Model Setup > General tab in the main menu bar of the GUI. To display the data stored in these scalars, open the results on the Analyze tab in the GUI and select the scalar variable of interest. 



How can I compare results from different simulations? Read the Hint's & Tips article: Combining Results Files to Obtain a Single Animation 
3D displays of the fluid surface in a filling simulation of a die casting show some 
gaps in the fluid surface but I know fluid is there...what is wrong?  

 Iso-surface contour values of 0.50 and 0.15 This is a common issue with the display of 3D iso-surfaces in thin-walled die casting parts. The gaps in the iso-surface are appearing because the fluid surface is being created based on a cell fill fraction of 0.5, by default. Cells which have a fluid fraction of less than 0.5 will not be displayed. To display cells with a very small fill fraction in the display, lower the iso-surface value until the gaps disappear. Depending on how thin these fluid regions are, a value from 0.4 down to 0.1 may be necessary. The iso-surface value is set in the Iso-Surface Options > Contour Value box on the 3D tab of Analyze panel. In the two examples given below, the display with the default iso-surface value, show on the left, indicates obvious gaps between the spokes and the outer rim. At the right hand above is the display after the iso-surface contour value has been changed to 0.15. 
How do I output void data? There are various methods for displaying simulation flow variables. These methods include 1D spatial and temporal plots, 2D contour plots, and 3D iso-surface plots. Void data, which represents quantities such as void pressure, void temperature, and void volume center, present a challenge since it is not stored spatially as flow variables are but instead is stored based on the void number. Also, the number of voids in a simulation may change with time, so it will be necessary to know how void regions are numbered in order to properly request their information. Since void data cannot be requested directly from the Analyze tab, the data must be requested using the Custom Plotting feature. The default method of numbering voids starts at the bottom (z-min) of the computational mesh and numbers the first void it encounters as number 8. This numbering sweep is done at the beginning of each time step. The void numbering increments by 1 as the sweep continues in the +z direction. As voids move they may be renumbered according to their location relative to the bottom of the computational mesh. This renumbering makes it difficult to create a plot of a particular void’s pressure, for example. To prevent voids from being renumbered, add the parameter IOVOID=1 manually to the XPUT namelist in the simulation input file (PREPIN). This will result in a void with the number 8, for example, to always be labeled as number 8 throughout the simulation. If void number 8 splits into two voids, one void will be numbered 8 and the other will be numbered as the next available number. To determine the void number of a particular void, create a 2D contour plot of the contour variable NF VALUES. The NF value represents the void number and will be used to request data in the next step. Once 
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the NF value for a void of interest has been identified, the next step will be to create a plot request file which will instruct the post-processor which data to extract in order to plot the data. The data available for voids is shown below. The variable name, shown in the first column below is the name used by the post-processor to reference this data. VARIABLE NAME DESCRIPTION vrp: Void Pressure xvoid:  Void region volume center - x coordinate yvoid: Void region volume center - y coordinate zvoid:  Void region volume center - z coordinate arvoid: Surface area of the void vrvol:  Volume of the void tvr: Void temperature The example below demonstrates how to create plots of void region pressure for void regions 8 and 9 (assuming the simulation has at least two void regions). Select the Analyze > Custom tab. Enter the text shown below into the text window on the Custom tab. The pressure (VRP) in void region number 8 is requested in the first plot request name list PLTREQ. The void number is requested by the variable NOFF which is an offset of NF. To request region number 8, NOFF = NF -1. 

 Click Render and select the 2D button on the Custom Render dialog. A 2D plot of the pressures in void regions 8 and 9 will appear. 



What’s the difference between 3D iso-surface options and color variable options? 3D displays of simulation results typically consist of an iso-surface contour of the fluid surface colored by a flow variable. The iso-surface variable is the data used to plot the three-dimensional surface contour. This is almost always going to be fraction of fluid, since typically you want to see output that corresponds spatially to your fluid. The color variable, on the other hand, is the data that colors the iso-surface. The color variable can be pressure, velocity magnitude, viscosity, etc. The colors plotted represent the value of the selected flow variable at the surface. To see the interior of a 3-D fluid bulk, either use the Mesh Slice option on the Display tab visualization menu, or select 2-D plots of the region of interest on the Analyze > 2D tab. 
I don’t understand the way hydraulic data is output. How is it recorded? Output variables are defined at every cell, and almost all of them are unique only for that cell. Examples of cell-unique values include pressure, velocity (components and magnitude), density, viscosity, turbulent kinetic energy, scalars, entrained air fraction, etc. The exceptions are some of the optional hydraulic data output and sediment concentration outputs. For example, depth-averaged velocity values are unique for each column of cells (in the z-direction), that is, for every x-y point. All cells with the same x-y coordinate will have the same depth-averaged-velocity value. The same is true of fluid elevation and fluid depth - the values are unique in the x-y plane, but are the same for every column of cells, since they share the same surface when looking upward. 
Runtime Errors and Questions 
Why am I receiving the error message “segmentation fault” when executing the 
FLOW-3D pre-processor? Using the default stacksize on Linux systems may cause a fatal error message (“segmentation fault”) when executing the FLOW-3D pre-processor. For the double precision version, the minimum stack size requirement is 50 Mb. For the single precision version, the minimum requirement is 30 Mb. Change your log-in script to increase the stack size to at least 50 Mb to avoid this problem. It is usually the most convenient to simply set the stacksize to unlimited. This can be done using the following commands Use the “limit’ command to check and set stack size in the C shell: 

“limit stacksize” (returns the current stack size limit) 

“limit stacksize unlimited” (sets stack size to maximum allowable limit) Use the “unlimit” command to check and set stack size in all of the other shells: 
“ulimit –s” (returns the current stack size limit) 
“ulimit –s unlimited” (sets stack size to maximum allowable limit) A numeric value can be used for stack size if “unlimited” is not allowed by your system administrator. It is recommended that the flow3dvars.sh (bash shells) or the flow3dvars.csh (c shells) be sourced or added to your .bashrc or .cshrc files, respectively, in order to assure that all necessary environment variables be set for FLOW-3D. 

Is there a way to determine the relative importance of different physical 
processes involved in a simulation? A simple way to answer this question is to look at the file "Solver Summary" listed in the Diagnostics menu in the main menu bar of the FLOW-3D GUI. The information to look at follows the comment, "short print of 



time step stability limits." The search feature can be used to find these comments or they can be located by scrolling through the file. A time-step stability limit is the maximum time-step size that is computationally stable for the process associated with that limit, e.g., advection, viscous stress, surface tension, heat conduction, etc. The smallest time-step limit controls the simulation time advancement. If a process has a time-step limit smaller than another, it indicates that the process is more important in the simulation. For example, if the viscous stability limit is smaller than the advection stability limit, then viscosity is more dominant than inertia. In fact, the ratio of these time steps is a kind of computational Reynolds number. Depending on the problem, similar ratios could be formed for such quantities as a Froude number, a Weber number, or other common non-dimensional numbers. Care must be exercised in using this information for two reasons. First, the locations where the individual time-step limits are recorded are typically not the same, so that comparisons are between processes at different locations. Second, the time-step stability limits vary with time. This limitation, however, can actually be useful because it offers a means for tracking what physical process is limiting the runtime of a simulation at any given time. Finally, if an implicit option, such as heat conduction is used, then it has no time-step stability limit, and none is reported in the Solver Summary file. An implicit option should not be used unless its explicit time-step size is limiting solution advancement, in which case the process would be the dominant one. When more than one implicit option is used, there is no output information available to indicate which process is most important. 



 

 

GLOSSARY Term Definition Baffles Plate-like objects that can be placed on cell faces and act to partially, or completely block the flow of fluid. Baffles can also have heat transfer coefficients specified. Boundaries Control the fluid at the extents of the domain. It is important to choose boundaries that most realistically represent the condition of the flow at the boundary location. CFD Computational Fluid Dynamics (CFD), the branch of fluid mechanics dedicated to simulating the flow of fluid on a computer via numerical solutions. Complements The complement of a region is the inverse. For instance, if a component is created during geometry generation, such as an imported STL geometry file, the inverse of the becomes the solid material when meshed. Components Components make up regions in spaces and are comprised of subcomponents. A component can have material properties such as thermal conductivity, specific heat and surface roughness. custom result Graphical displays of data generated by the user during the simulation or after it has completed. To generate, the user must open an flsgrf results file and then select the plotting parameter (e.g., portion of domain to plot, quantity to plot, etc.). Diagnostics A suite of files that contain information on the progress of the preprocessor and solver as well as errors and warnings. EPSI The convergence criteria used to determine at what point the pressure/continuity iterations have converged. This value is automatically computed by FLOW-3D and becomes smaller as the time step increases. existing result A plot file that is automatically created, either at the end of preprocessing or the end of the solver run– prpplt.* or flsplt.*. F3D_HOME Environment variable that defines the directory where the FLOW-3D program files are located. floating license A license that allows FLOW-3D to be run on a network of computers. The maximum number of concurrent simulations is limited by the number of solver tokens purchased. flsgrf file Results file produced by the solver. This file contains information produced at predefined time intervals and is used to produce graphical displays. Used by the postprocessor during custom plotting. flsplt file Plot file produced automatically by the solver. This file contains basic information on history data, mesh, etc. from the simulation as well as any pre-defined graphics requests in the $GRAFIC namelist in prepin.inp. fluid #1 surface area The free-surface area in the chosen length units squared. This is only relevant for problems with a sharp interface. fluid thermal energy The total thermal energy contained by all the fluid present in the domain (relevant only for simulations with energy transport turned on). free surface The interface between fluid and void. In FLOW-3D, this interface is assumed to be 



 

 

shear-free, meaning that any gas in the void space exerted negligible traction on the fluid. GUI “Graphical User Interface.” The GUI presents the graphical panels, dialog boxes and windows that allow the user to control FLOW-3D. iteration count The number of pressure/continuity iterations required at each time step. The pressure/continuity iterations are necessary to ensure that the fluid volume is maintained and to compute the correct pressure throughout the fluid. license file Electronic file provided by Flow Science that contains encrypted information enabling the user to run FLOW-3D. license server Computer on which the FLEXlm licensing software is installed to enable the operation of a floating license system. FLOW-3D does not need to be installed on the license server. Licensing FLEXlm software that controls the running of FLOW-3D. max. residual The actual divergence of the continuity equation on the final iteration of the pressure/continuity iterations. This value is usually smaller than epsi unless the message, “pressure iteration did not converge in xxxx iterations” appears. mean kinetic energy The sum of kinetic energy of all the computational cells, divided by the total mass of fluid present in the domain. When this quantity ceases to change over time, it is a good indicator that steady-state has been reached. node-locked license A license that is locked to a particular computer. A node-locked license cannot be accessed across a network, and so is typically only used when all work is to be done on one computer. non-inertial reference frame A frame of reference that is accelerating. A non-inertial reference frame can be used to mimic a moving container. Pltfsi Graphics display program included with FLOW-3D that produces 1D and 2D plots. Postprocessor The program within FLOW-3D that processes the solver output data to produce data files that can be read by FLOW-3D’s or third-party’s visualization programs, or produce text data to be read by third party software programs. prepin file Text file that contains all of the information necessary to create a FLOW-3D simulation. It can be created using the GUI or manually with a text editor. Preprocessor The program within FLOW-3D that generates the mesh and initial conditions based on the input file in preparation for the running of the solver. prpgrf file Results file produced by the preprocessor. Contains information from the preprocessor and can be used by the postprocessor to create custom plots. This file is produced only when the Preview button is selected or if IPREVU=1 is set in the $XPUT namelist in the prepin.inp file. prpplt file Plot file produced automatically by the preprocessor. Contains information on meshing, components, initial conditions and material properties. restart simulation A simulation which continues from a previous simulation. The results from the previous simulation are used to generate the initial conditions and (optionally) boundary conditions for the restart simulation.  solid fraction The fraction of fluid in the domain that has become solidified (relevant only for simulations where the solidification model has been turned on). 



 

 

Solver The program within FLOW-3D that solves the system of equations that simulate the flow problem defined in the input file. stability limit The maximum time step that can be used during each time step. A larger time step will lead to numerical instabilities and nonphysical results. STL File The .STL file format is a standard data transmission format. This format approximates the surfaces of a solid model with triangles. STL Viewer A special utility that displays stereolithography (STL) files. STL files are produced by CAD software and are composed of many triangles that form the surface of a three-dimensional object. The STL Viewer in FLOW-3D is accessible via the GUI by clicking Utilities/STL Viewer in the main menu. This causes the viewer to open in a separate window. STL files can also be opened and viewed in the Meshing and Geometry tab. Subcomponents Subcomponents are combined as solids, holes and/or complements to make up regions on space called Components. time-step size The actual time step used in the computation. This value can be equal to or less than the stability limit. Units Units are based upon the values set for the physical properties. Items such as mesh block extents and cell lengths automatically conform to the units used for setting these physical properties. volume error (%) The percentage of fluid volume not accounted for as a percentage of the total fluid present in the domain at a given time. Therefore, a large percentage volume error can occur for simulations where fluid is draining out of the system simply because the total volume present is small. volume of fluid #1 The total volume of fluid #1 present in the system, in the chosen length units cubed. For two-fluid problems, the volume of fluid #2 is always the domain volume minus the volume of fluid #1. wall shear stress The FLOW-3D option that allows the user to turn on or off the computation of shear stress at wall and object interfaces. Wall shear stress must be turned on to model the effect of “no-slip” interfaces. Workspace A workspace is a file container for simulation projects. Workspaces help the user organize his work, not only within FLOW-3D, but also on his hard drive.   
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